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Module 1 

Fundamentals of the DCPDS 

  
Purpose The purpose of this module is to familiarize you with the DCPDS and how to 

use it.  It covers the basics of how to move around in (or “navigate”) the 
system to perform your work.  It also explains the tools and functionality 
common to all users of the system. 
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Module 1 

Chapter 1 

What is the DCPDS? 

Chapter Overview 

  
Introduction Before you learn how to use the Defense Civilian Personnel Data System 

(DCPDS), you may find it helpful to understand why we have it, how it 
operates, and its features and benefits. 

  
Chapter Contents  
 

Topic Page 
Chapter Overview 1 
What is the DCPDS? 2 
Why Build the DCPDS? 5 
How Does the DCPDS Work? 6 
Benefits to the User 8 
Data and Task Flow in the DCPDS 9 
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What is the DCPDS?  
What Is It? The DCPDS is a human resources information system that will support 

civilian personnel operations in the Department of Defense (DoD). 

The DCPDS allows the Department to move from multiple systems to a 
single information system for DoD civilian employees. 

  
Who Does It 
Support? 

The system is being designed to support appropriated fund, non-appropriated 
fund, and local national human resources operations.   

  
What has taken 
place? 

The DCPDS supports multiple human resource applications and was designed 
to replace a number of information systems used throughout the Department 
to manage civilian human resources.   

The system has been upgraded from Oracle 10.7, a client-server based 
architecture, to Oracle Release 12 (R12), a web based architecture.  
Additionally, the Corporate Management Information System (CMIS), a part 
of the DCPDS will also upgrade to R12.  

 
Terminology Many of the terms used in explaining the DCPDS may be unfamiliar to you.  

The tables that follow define a number of terms associated with DoD 
personnel systems, regionalization of personnel operations, and computer 
systems terminology.   

  
 

DoD System 
Terms 

The following are terms associated with Department of Defense civilian 
personnel systems. 

Term Meaning 
Defense 
Civilian 
Personnel 
Data system 
(DCPDS) 

The civilian personnel data system that has been developed 
to replace other civilian personnel data systems, including 
the legacy system. 

  
Continued on next page 
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What is the DCPDS?, Continued 

  
Computer 
System Terms 

The following are computer system terms that will help you understand the 
DCPDS 

 
Term Meaning 

Open System Refers to the physical and logical organization of system 
functions, structures, and operations based upon commercial 
and federal government standards.  An open system is a 
collection of interacting software, hardware, and human 
components. 

Network This is a system composed of hardware and software 
communications systems.  It can be classified as Local Area 
Network, Metropolitan Area Network, or Wide Area 
Network.  The classifications are based on how far the 
network reaches, or its geographical extensions.  It can also 
be classified according to the protocols that are used.   

Server In a network, a server is the computer that acts as the central 
machine to provide resources such as communications, 
printers, and software applications.  The server may store 
user information and files that may be used by more than one 
machine or in more than one location.  

Client-Server A client-server system is based on the principle that most of 
the resources of a network are centralized and can be 
accessed through a server.  In a network, a client is a 
workstation that is used to access the server (e.g., the 
computer on your desk).  Client software has to be installed 
on the client PC in a client-server environment. 

Web-based 
Architecture 

Client users connect to a data system via the World Wide 
Web from the browser on their desktop computer (such as 
Internet Explorer).  No client software needs to be installed 
on the PC, making system administration much easier. 

Local Area 
Network 
(LAN) 

A computer network that is centered at one location.  It can 
range from two or three workstations to hundreds. 

Wide Area 
Network 
(WAN) 

Several local area networks tied together at different 
locations. 
 

 
Continued on next page 
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What is the DCPDS?, Continued 

  
Computer System Terms (continued) 
 

Term Meaning 
Relational 
Database 

A database management system with the ability to access 
data organized in tabular files that may be related by a 
common "key" item, data field, or column.  A relational 
database has the capability to merge the data items from 
different files, thus providing powerful tools for data usage 
and reducing data entry. 

Graphical 
User 
Interface 
(GUI) 

An interface or menu system, such as Microsoft Windows, 
that uses a series of icons or other visual objects to assist the 
user in operating the software. 

 
Regionalization 
Terms 

The following are terms associated with the DoD regionalization effort. 

 
Term Meaning 

Regional 
Service 
Center 
(RSC) 

Regionalization is a Department-wide effort that 
consolidates civilian personnel operations into Regional 
Service Centers.  A Regional Service Center provides 
centralized processing operations.  

Customer 
Support Unit 
(CSU) 

In Regionalization, the Customer Support Unit is the on-site 
personnel office that handles the face-to-face customer 
activities for civilian personnel operations.   
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Why Build the DCPDS? 

  
Reasons for 
Building the 
DCPDS 

There are many good reasons for building a new human resources 
information system to support the DoD civilian personnel programs.  Below 
are the major reasons. 

 
Reason Explanation 

To reduce multiple 
systems 

In the past the DoD Components developed and used 
multiple and duplicative human resources information 
systems to accomplish the same type of work.  The 
DCPDS is a single, integrated system to be used by all 
DoD organizations. 

To reduce costs Elimination of multiple data systems with varying 
requirements to accomplish similar tasks will reduce 
costs to DoD. 

To support 
Regionalization 

The DCPDS will meet the dynamic needs of the 
Department with fewer personnelists while responding 
to increased needs for HR information.  
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How Does the DCPDS Work? 

  
Network 
Environment 

The DCPDS will operate via a network environment.   
 

  
Information 
Flow 

Information will flow between CSUs and their respective RSCs via servers 
located at each CSU and RSC.  There will be regional databases across the 
Department -- one for each RSC.    

    
Illustration of 
Operating 
Environment 

This is an illustration of the DCPDS operating environment. 

 

  
RSC Database The RSC will house a database that will have information for all employees 

serviced by the Region.  Data for the entire RSC, or each serviced CSU, can 
be accessed at the Region.   

   
Continued on next page 
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How Does the DCPDS Work?, Continued 

 
Corporate 
Management 
Information 
System 

Regional servers will link the regional databases to the DoD Corporate 
Management Information System (CMIS), where information on all DoD 
employees will be maintained.  
 
The CMIS will provide Component Headquarters access to Component 
information and the Department access to DoD-wide human resources 
information. 

   
System Access Access to the system, at all levels within the Department, will be based on an 

individual’s official need for information.  Each Component has 
responsibility for granting access privileges.   
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Benefits to the User 

   
Introduction Using the DCPDS will take a period of adjustment, but ultimately you, the 

user, will appreciate the benefits of increased access to information, enhanced 
productivity, reduced redundancy, and improved operations. 

   
Easier to Use The DCPDS features a standard Windows format with easy point-and-click 

maneuvering.  Words, lists of values, edits, and on-line help replace the 
codes, manual table look-ups, and guess-work of legacy systems. 

  
Better Access to 
Information 

From your desktop, you will be able to track the status of personnel actions 
and access up-to-date information about employees, positions, and 
recruitment activities (from individual queries to workforce reports).  

  
Reduced 
Reliance on 
Paperwork 

Electronic routing and instant on-line access to up-to-date information will 
reduce reliance on paperwork.  The data in the system will be available to you 
when you need it – so you won’t have to search for documents or wait for 
reports that only system support people can give you.  Electronic data, unlike 
paper documents, cannot get lost amongst paperwork.  You will spend less 
time tracking down papers and personnel folders because much of the data 
you need to do your work will be on your desktop in the system.    

  
Reduced 
Redundant 
Operations 

Redundant operations and duplicate data entry will decrease dramatically. 
With its relational database, data already input (manually or electronically 
scanned, as in the case of resumes) will flow and display wherever it is used, 
and multiple systems will be updated automatically.  Tracking of actions will 
be done electronically. 

    
Reduced 
Inquiries from 
Managers 

Managers will be able to directly access information about their employees 
and positions, run reports, and track the status of personnel actions.  
Automation will also assist in rating and ranking job candidates. 
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Data and Task Flow in the DCPDS 

  
Introduction The DCPDS supports the full range of requirements for processing personnel 

actions and maintaining workforce data, including: 

• Creating and maintaining work structures and position data. 

• Applicant rating and referral processes and data. 

• Employee appointment, reassignment, promotion, and other 
assignment actions. 

• Administration and maintenance of employee benefits, training, 
and performance management. 

• Viewing, tracking, and reporting data. 

• Electronic routing of personnel actions between managers, local 
personnel offices, and regional servicing centers. 

   
Data Flow The DCPDS is a system of integrated applications; at its core is a relational 

database.  Data is entered into the database from a variety of points within the 
system, and then it is shared across the system electronically (so you do not 
need to enter the same data more than once).   

Examples:   

• When you process a Request for Personnel Action (RPA) 
in the DCPDS, data that is already in the database (e.g., 
position data) is automatically inserted into the online RPA 
form. 

• When you process a recruitment action using Resumix (an 
automated applicant rating and referral system), data 
gathered through Resumix on the selectee flows to your 
appointment Request for Personnel Action and the DCPDS 
database. 

• If you classify a position using COREDOC, that position 
information flows to your fill action and the DCPDS 
database. 

• If you enroll an employee in a training Event in Oracle 
Training Administration (OTA), and the employee 
completes the training, the information flows to the 
DCPDS database. 

 
Continued on next page 
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Data and Task Flow in the DCPDS, Continued 

  
Illustration 

 

  
Data Flow The major components of the DCPDS are:  Oracle HR, Resumix, 

COREDOC, and Oracle Training Administration (OTA). The chart below 
identifies some of the major flows of data between the different parts of the 
DCPDS. 

 
Data Flow Type of Data 

COREDOC to Oracle HR • Position data 
COREDOC to Resumix • KSAs 
Resumix to Oracle HR • Applicant data 
Oracle HR to Resumix • Position data 

• Employee data 
Oracle HR to OTA • Position data 

• Employee data 
OTA to Oracle HR • Completed Training data 

  
Continued on next page 



                                                                                                       R12                                                                          March 2012 
 

Fundamentals:  What is the DCPDS?                                            Mod 1, Chap 1, Page 11 

Data and Task Flow in the DCPDS, Continued 

 
Task Flow There are some basic task flow business rules in the DCPDS.  The chart 

below shows the sequence in which data must be entered.   

 
 
While data must be entered in a particular sequence, you can process actions 
before their effective dates through a feature called DateTrack.  Specific 
business rules and how to use DateTrack to process actions are explained later 
in the User Guide.   
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Module 1 

Chapter 2 

Logging On and Access 

Chapter Overview 

  
Introduction This chapter explains how to log on to the DCPDS and gain access to the 

functions, forms, and data necessary to do your job. 

  
Chapter Contents  
 

Topic Page 
Logging On 2 
Navigator Window 6 
Roles and Responsibilities 12 
Switching Your User Responsibility 18 
Exiting the DCPDS 20 
Security in the DCPDS 21 
Routing Lists 23 
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Logging On 

  
Purpose To use the DCPDS, you will need Internet Access: 

• Open the DCPDS application, 
• Sign on, and 
• Select a “responsibility” if you have been assigned more than one. 

  
Before You 
Begin 

You will need a user account and a personal password to gain access to and 
use the DCPDS.  A system administrator sets up your account and access 
privileges (“responsibility” categories). 

  
Terms 
 
 

Responsibility:  A set of access privileges for using the DCPDS.  When a 
system administrator establishes your user account, you will be assigned one 
or more “responsibilities” so that you can access only those functions, forms, 
and data appropriate to do your job. 

    
Categories of 
Responsibilities 

Categories of responsibilities include (but are not limited to): 
• HR Generalist 
• HR Specialist (by function) 
• Civilian HR Manager 
• Manager or Supervisor (non-HR) 
• Non-Appropriated Fund (NAF) HR Manager 
• System Administrator 

  
Access to 
Employee Data 

Your access to employee data will be restricted based on your role and 
responsibility in your organization. 

  
How to Log 
On 

To log on to the DCPDS: 
 

Step Action 

1 Start up your computer and log on to your local network, 
according to local procedures. 

2 Double-click the DCPDS icon that is displayed on your 
computer’s program manager screen or follow local procedures if 
an icon has not been created. 

 
Continued on next page 
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Logging On, Continued 

  
How to Log On (continued) 
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Step Action 

3  

 

 

 

 

 

 

 

 

 

 

 

 

A log on window opens and your cursor is in the  
User Name data field. 

Type in your user name (as assigned by the local system 
administrator). 

♦ Example:   

 
                                 

4 

 

 

 

 

 
 

 

 

 

 

 
 

Press [Tab] once to move your cursor to the Password data field 
(or use your mouse to place your cursor in the Password data 
field).   

Type in your password and click <Connect>.  

♦ Example:      
                                  

Note:   

• Your password will not display as you type it; this prevents 
others from seeing it.  

• If you incorrectly type in your password, you can re-type it, 
but after a third try the DCPDS will close down and you 
will need to re-enter the application. 

Caution:  Keep your password confidential to prevent 
unauthorized users from gaining access to the system. 
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Logging On, Continued 

  
How to Log On (continued) 
 

Step Action 

5 

 

 

 

 

 

 

 
 

 
 
 

If you have been assigned more than one responsibility, a 
Responsibilities window will display. 

Click a responsibility from the choices provided and click <OK>. 

♦ Example:   
                                          
Note:  The responsibility you select will determine the specific set 
of data, menus, and forms to which you will have access.  You will 
only be able to select responsibilities that have been assigned to 
you by your system administrator (based on your job 
responsibilities).   

 
 

Continued on next page 
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Logging On, Continued 

  
How to Log On (continued) 
 

Step Action 

6 The Navigator window opens.  You are now ready to begin using 
the DCPDS.  

♦ Example (for US Federal HR Manager responsibility): GET A 
DIFFERENT VIEW IF USING THE HAT TO 
NAVIGATE. 
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The Navigator Window 

  
 Purpose  You begin working in the DCPDS by choosing an option from the Navigator 

window.  The Navigator window opens a list of categories for the tasks you 
can perform in the DCPDS, based on the access privileges (“responsibility”) 
you have been assigned in a list called the Navigator.  If you have been 
assigned more than one responsibility, the Navigator List displayed will be 
for the responsibility you selected in the Responsibilities window.   
 
At the top of the Navigator window you will see the name of the 
responsibility which you have logged on to (e.g., “CIVDOD Personnelist”). 
 
The Navigator window is always open when you are using the DCPDS. 
 
 

 
 

Continued on next page 
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The Navigator Window, Continued 

  
Illustration Below is the Navigator List which is displayed if you log on under the 

“Federal HR Manager” responsibility: 

 
 

On the tool bar,  if you 
select ‘hat’ icon, you can select which responsibility you want to switch to. 

 

 
 

 
Continued on next page 
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The Navigator Window, Continued 

 
In This Section This section explains: 

• How to find what you need from the Navigator window. 

• How to open windows from the Navigation List. 

• How to create a Top-Ten List to quickly access frequently used 
windows. 

How the 
Navigation List 
is Organized 

Within the Navigator window you will see a Navigation List.  The 
Navigation List is organized much like the hierarchy of a file system:  
with main categories (levels) and subcategories (sub-levels).  You will 
see only main category items on the Navigation List.  You can then 
expand items that begin with a plus sign (+) to search sub-levels until 
you find the area you need. 
 
Sub-levels will display indented below the items from which they are 
expanded.  When an item is expanded, a minus sign (-) will display 
next to it.  You can expand an item no further if there is no plus or 
minus sign beside it. 
 

 
 

 
 

 
Continued on next page 
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The Navigator Window, Continued 

 
Terms: Below are definitions for terms associated with the Navigator Window: 
 

Term Definition 

Navigate Describes the way users move around in the DCPDS: 
e.g., move from one place in the application (window, 
data field, etc.) to another. 

♦ Examples:  “From the Navigation List, you 
can navigate (e.g., go) to any window you need 
to do your task” or “By navigating around the 
DCPDS, you can see where different data fields 
are located and become more comfortable with 
using the new system.” 

Navigation List The list of items located in the Navigator window.  The 
Navigation List is the starting point for everything you 
do in the DCPDS.  

Expand Some items in the Navigation List -- those proceeded 
by a plus sign (+) - can be “expanded” to display 
additional items that fall under the same category. 

Collapse Expanded items may be “collapsed” to view only the 
main category. 

Top-Ten List To quickly find and open items on the Navigation List 
that you use frequently, you can create your own 
navigation Top-Ten List.  The Top-Ten List you create 
will be located on the right side of the Navigator 
Window. 

 
Continued on next page 
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The Navigator Window, Continued 

  
Expanding 
Items on the 
Navigation List 

Choose one of the following methods to expand items on the Navigation List 
(to see the items listed in sub-levels): 
 

 
 To... Do this... 

Expand one item 
to its next sub-
level: 

• Double-click the item 
Or 

• Click the item, then click <Open>  
   Or 
• Click the item, then click the Expand button:  

                                                                                                   
   Or 
• Click the item, and then click Special  →  Expand 

on the Main Menu Bar. 
Expand all sub-
levels of one item 

Click the item once and then click the Expand All 
Children button:  

                                               
Expand all sub-
levels of all 
expandable items 
in the navigation 
list 

Click the Expand All button:    

                                                                                                

 
Collapsing an 
Expanded Item 
on the 
Navigation List 

You may find it easier to locate the item you need on the Navigation List by 
collapsing expanded items (so you do not have to scroll through lists you do 
not need).  To collapse an expanded item: 

 
To... Do this... 

Collapse one 
expanded item 

Click the item, then click the Collapse button:   

                                                                                                        
Collapse all 
currently 
expanded items 

Click the item once, then click the Collapse All 
button: 

                   
 

Continued on next page 
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The Navigator Window, Continued 

   
Opening an 
Item from the 
Navigation List 

Follow the steps below to open an item from the Navigation List and begin 
using the DCPDS: 
 

 
Step Action 

1 Select Window you wish to work in from the Navigation List. 

2 Double Click on the item, or click <Open>. 

  
Creating a 
Navigation 
Top-Ten List 

To quickly find and open navigation list items you use frequently, you can 
create your own navigation Top-Ten List.  The Top-Ten List you create will 
be located on the right side of the Navigator window, opposite the 
Navigation List.  
If you have access to more than one responsibility, you can create a different 
Top-Ten List for each responsibility.  

 
 
To create a navigation Top-Ten List: 
 

Step Action 

1 Click an item from the Navigation List you use frequently. 

2 
Click the Add arrow.  

The item is now displayed in the navigation Top-Ten List, with a 
Top-Ten List number beside it. 

3 Repeat steps 1 and 2 for the other items you want to put on your 
list (up to ten items). 

  
Continued on next page 
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The Navigator Window, Continued 

 
 
Removing Items  
from the  
Navigation   
Top-Ten List 
 

 
 
 
To remove an item from the navigation Top-Ten List:   

Step Action 

1 Select the item on the Top-Ten List you wish to remove. 

2 
Select the Remove arrow.  

 
 
 
 

  
Opening an 
Item from the 
Top-Ten List 

To open an item from the navigation Top-Ten List and begin using the 
DCPDS:  

1. On your keyboard, press the number key that corresponds with the Top-
Ten List number of the item you want to open. 

OR 

2. Highlight the item with your cursor and double-click. 

OR 

3. Highlight the item with your cursor and select <Open>. 
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Roles and Responsibilities 

  
Introduction DCPDS user roles and responsibilities are key to levels of access in the system 

for security purposes.  Security within the system controls what menus, forms, 
data, and reports you can create, view, and update.  Security access is set based 
on your role in human resource management and your responsibility for 
certain actions, and the records you are authorized to access.  This section 
applies to all system users.  A responsibility is basically a menu or a collection 
of functions the user can perform.  A role is a capability, such as Request for 
Personnel Action approver vs. initiator or requestor. 

 
Human Resource 
Management 
Responsibilities 

There are a number of human resource management responsibilities 
identified in the DCPDS.  
 

 
 

 
Continued on next page 
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Roles and Responsibilities, Continued 

  
Personnelist Personnelists are individuals with human resource management 

responsibilities, such as a classifier, personnelist, or OTA personnelist. 

  
Access Personnelists: 

• At a Regional Service Center (RSC), will normally be given access to 
records of all employees serviced by their Regional Center or for their 
own servicing assignment.  

• At a Customer Service Unit (CSU), will normally be given access to only 
those records of employees at their installation or serviced by their CSU. 

• Will normally be given access to all parts of the DCPDS.  Some RSCs 
and CSUs may limit access to menus, forms, reports, and data by 
personnel specialization. 

• May approve an RPA, while others may not.  It depends on each 
Component’s business practices.  This role, or level of permission, is 
independent of the responsibility the individual uses. 

  
Personnel Speciality Access  
 

Specialty Area Access 
Classification Position areas related to building positions and 

COREDOCs, and other position management 
tasks. 

Employee Development and 
Training 

Oracle Training Administration (OTA) and 
Special Information (SIT). 

Employee Management 
Relations 

Benefits area related to performance 
management, pay, benefits and entitlements, 
hours of work, work schedules, leave and 
absences, discipline and adverse actions, and 
injury and unemployment compensation.  This 
includes dues withholding, Bargaining Unit 
Status (BUS) codes, Union time reporting, and 
Complaints Tracking (if located in HR).  May 
have Special Information (SIT) and 
Person/Extra Information. 

Staffing Areas related to filling positions, Resumix, 
and completion of Requests for Personnel 
Actions (RPAs). 

 
Continued on next page 
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Roles and Responsibilities, Continued 

  
Personnel Speciality Access (continued) 
 

Specialty Area Access 
Personnelist A generalist who has a combination 

of Classification, EMR, and/or 
Staffing functions. 

System Administrator Provides appropriate system 
capability to include creation of user 
accounts and assignment of 
responsibilities (menus). 

Local Nationals (LN) Areas related to LN positions and 
employees under the LN system. 

National Guard Bureau (NGB) Areas related to NGB positions and 
employees under the NGB system. 

Non-Appropriated Fund (NAF) Areas related to NAF positions and 
employees under the NAF system. 

  
Combination of 
Specialties 

Personnelists with responsibilities under several specialties may be given 
access to areas and records (in the case of NAF or Generalists) that apply to 
all their specialties.  This may involve such persons having more than one 
responsibility (menu) assigned to them. 

 
Continued on next page 
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Roles and Responsibilities, Continued 

  
Manager/ 
Supervisor 

Managers and supervisors are individuals who manage or supervise civilian 
employees.  In some organizations, this responsibility may include 
administrative staff that supports management. 

  
Access Based on their role, managers and supervisors can: 

• View portions of records for their own and subordinate employees 
within their hierarchical chain (including their own record). 

• View Payroll and leave data from DFAS. 
• View Appraisals, current and historical. 
• View Education, Licenses, Completed Training, etc. 
• Initiate and authorize RPAs for positions and employees within their 

hierarchical chain for actions such as: 
• Promotions 
• Changes to lower grade 
• Awards 

• Initiate and authorize Training Request Forms (TRFs) for employees. 
 

  
Other Users  
 

Specialty Area Access 
Resource Manager Ability to view basic data about the employee, 

view current and historical budget-related data, 
and have restricted viewing capability for a group 
of resource items.  May also be given RPA role 
such as requestor. 

Fiscal Officer Access to all cost information on individual, 
group, and total training costs.  Does not have 
access to employee records.  This could be a 
resource manager in the organization or an 
individual in the accounting and finance office.   

EEO Official Ability to enter and update in the EEO Complaints 
Tracking application and view only capability for 
People - Enter and Maintain. 

EEO Management 
Representative 

View only capability for the EEO Complaints 
Tracking application and People-Enter and 
Maintain. 

 
Continued on next page 
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Roles and Responsibilities, Continued 

  
Other Users (continued) 
 

Specialty Area Access 
External User Access for a military supervisor of civilian 

employees or a personnelist located at a region 
that performs personnel servicing duties for a 
region other than the one which assigned as an 
employee.  Access for a military supervisor would 
be the same as manager/supervisor. 
 

HR-Training  Monitor Access to training records and reports for their 
assigned organization.  Access to the Bulletin 
Board and Course Evaluations.  Capability of 
completing the Training Request Forms, Printing 
DD Forms 1556, and accessing the Enrollment 
Window. 
 

VSB Reports Ability to request a large variety of user-requested 
reports.  Normally given as an additional 
responsibility. 
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Switching Your User Responsibility 

  
Purpose If you have been assigned more than one user responsibility and, while you 

are logged on to the DCPDS, you wish to work under a different 
responsibility, you can do so without exiting the DCPDS and logging on 
again.  

   
Term Responsibility:  A set of access privileges for using the DCPDS.  When a 

system administrator establishes your user account, you will be assigned one 
or more “responsibilities” so that you can access only those functions, forms, 
and data appropriate to do your job. 

  
How to Switch 
Your User 
Responsibility  

Follow the procedures below to switch your user responsibility after you have 
logged on under a different responsibility: 

 
 

Step Action 
1 • Click File from the Main Menu Bar then select switch 

responsibility. 

υ Example:    
Or  

• Select the  Switch Responsibility button on the Toolbar. 
If you have other windows open that have unsaved changes, 
a Save Changes window will display, asking you if you 
want to save the changes you have made.   

All open windows will close except the Navigator window, and a 
list of the responsibilities to which you have access will display. 

 
 

Continued on next page 
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Switching Your User Responsibility, Continued 

  
How to Switch Your User Responsibility (continued) 
 

Step Action 
2 Select the responsibility you wish to switch to, and then select OK. 

Example:   
 

The Navigator window title and contents will now reflect the new 
responsibility. 
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Exiting the DCPDS  

  
Purpose When you have finished working in the DCPDS, you will need to follow a 

simple procedure to exit the application.  If you have any unsaved work, the 
system will prompt you to save or discard the changes. 

  
How to Exit the 
DCPDS 

• Select File then Exit Oracle Applications from the Main Menu Bar.   

− If there is no unsaved work, the DCPDS exits and returns you to your 
desktop. 

− If there is unsaved work, then a dialog box will display: 

                       
• Select <Save> button to save the changes before exiting. 
      Or 

• Select <Discard> button to exit without saving any 
changes.  

Or 

• Select <Cancel> button to close this window and cancel 
the exit. 
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Security in the DCPDS 

    
Introduction Security for the DCPDS is the responsibility of each user authorized to access the 

system.  The Oracle Human Resources (HR) application has inherent security 
within the application in addition to the mandatory security requirements of DoD.  
Security is a major responsibility of the system administrator at the RSC and CSU, 
as well as security personnel at all levels within a Component.  Additionally, 
security uses “roles and responsibilities” to limit your access to the DCPDS.  DoD, 
Components, and local installations issue security policy and guidance.  It is your 
responsibility to provide the necessary security to protect the DCPDS information 
in accordance with current regulations and guidance. 

  
Privacy 
Information 

Information created and stored within the DCPDS is UNCLASSIFIED FOR 
OFFICIAL USE ONLY and is subject to the Privacy Act of 1974.  Every user of 
the DCPDS must adhere to the Privacy Act when working with any information 
that relates to the data contained in the DCPDS.  The following warning screen on 
unauthorized use of your computer opens once you access the DCPDS from your 
workstation.  By signing on with your User Name and Password, you 
acknowledge your consent to security testing and monitoring of your computer. 
 

 
 

Continued on next page 
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Security in the DCPDS, Continued 

  
Importance of 
Security 

Security is important to you as the user because the DCPDS database contains 
personal data on DoD personnel that, according to Operational Requirements 
and DoD Directives, must be safeguarded at all times.  Unlawful use of the 
information contained in the database by you or an unauthorized user is a 
crime and punishable to the full extent of the law.  Therefore, safeguarding 
information and access to the DCPDS database is of paramount importance. 

  
Controlling 
Access 

Management and the Information System Security Officer (ISSO) or the HR 
system administrator at the RSC or CSU determines access to the DCPDS 
based on your role and responsibilities within the organizational hierarchy 
and “need to know.”  A unique Username and Password is assigned to you 
based on your role and responsibility within the organization.  

 
Secure Users The Systems Administrator is responsible for establishing a Secure User ID 

for each person that needs access to specific Oracle forms with the DCPDS 
application.  The Secure User View will allow viewing of only those records 
based on organization or position hierarchy within one’s assignment. 

 
Individual 
Responsibility 

You, as a DCPDS user, must protect your individual User Name and 
Password to prevent any unauthorized access.  It is your responsibility to 
attend security training, report changes in your user status; any suspected 
security violations, etc., to the designated management authority, ISSO, or 
HR system administrator.  You may be required to sign a statement to 
acknowledge your understanding of these responsibilities and the 
consequences.   

 
Changing 
Passwords 

As a continuing security measure, Passwords must be changed on a periodic 
basis to help prevent the possibility of undetected password compromise.  The 
maximum time limit established by the system is 90 days.  Prior to the 
expiration date you will be notified automatically by the application to change 
your Password.  At that time, simply follow instructions on the monitor to 
execute a new Password.   

  
Log on 
Attempts 

The DCPDS will allow you three attempts to successfully log on.  If three 
attempts result in an unsuccessful log on, the application will automatically 
terminate.  You will need to re-access the system. 
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Routing Lists 

 
Purpose 
 
 
 
 
 
 
 
 

A Routing List: 
• Is a predefined list of routing destinations for sending notifications to 

Workflow Inboxes.  
• Defines the order in which a personal inbox or Groupbox receives a 

workflow notification.  
• Expedites routing HR windows by automatically forwarding a form from 

one routing destination to the next.  
 
Workflow allows you to route forms to either groups or individuals who need 
to approve, modify, or review the forms; e.g., Request for Personnel Actions 
(RPAs) (including those with Core Documents attached). 
   
Note:  Training Requests Forms (TRFs) are not routed to Workflow Inboxes 
in the same method as HR forms.  There is no routing list for Training.  You 
must select the name of the person and route to their Workflow Inbox.   
 
Workflow features include: 

• A flexible routing mechanism. 
• A flexible notification system. 
• Powerful Inbox and Groupbox capabilities. 
• A complete tracking history of an RPA and TRF during the 

routing process. 
 

Continued on next page 
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Routing Lists, Continued 

  
Before you 
Begin 

Components will determine procedures for each Region in establishing 
Routing Groups.  The following is information on the process. 

• A Routing Group is set up at each region when the DCPDS deploys.   
• A Routing List is created for a Routing Group in the Routing Group 

and Routing List Details window.   
• Before adding a user to a Routing List, the user must have system 

access and belong to a Routing Group. 
• Multiple Routing Lists for a Routing Group may be created. 
• Users may belong to more than one Routing List. 

 
Note:  You must be assigned the role of a Systems Administrator on the 
Responsibilities Menu to create Routing Lists.  You can also create a 
Routing List if you are assigned the CIVDOD MANAGER responsibility.  
Click Routing Lists on the Navigation List and follow the procedures below. 

  
Creating a 
Routing List  

Follow the procedures below to create a Routing List, if you are assigned this 
responsibility. 

 
Step Action 

1 Navigation Path → Federal Maintenance Forms → Routing List 
<Open>.  The Routing Group and Routing List Details window 
opens. 

 
 

 
Continued on next page 
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Routing Lists, Continued 

  
Creating a Routing List (continued) 
 

Step Action 
2 
 
 
 
 
 

 

Place your cursor in the Name data field of the Routing Group 
Region execute a query by selecting F11 key followed by selecting  
Ctrl button plus the F11 keys together.  This opens the Routing 
Group in the Name data field.  Use up and down arrow keys to 
review the lists of Routing Groups.  Select the Routing Group that 
you want to create a Routing List for or to add new users. 
 

 
 

 
Continued on next page 
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Routing Lists, Continued 

  
Creating a Routing List (continued) 
 

Step Action 
2 

(cont) 
If you previously created a Routing List for the Routing Group, the 
system opens that information with specific user names listed. 
 

 
 

3 
 
 
 
     
 

Place your cursor in the Routing List Region, Name data field and 
type in the name of your Routing List, if known or type in the 
name of a new Routing List that you want to create. 

 

4 Place an “X” in the Primary Routing List check box if this is to be 
the Primary Routing List.  Normally, you will leave this box 

unchecked.   
 

Continued on next page 
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Routing Lists, Continued 

  
Creating a Routing List (continued) 
 

Step Action 
5 
 

In the Routing List Members Region, input a number in the first 
Sequence (Seq) Column; e.g., 1, 2, 3, etc.  You can change the 
sequence numbers later, if necessary. 
 
Note:  The sequencing numbers represent the order for routing an 
RPA. 

6 

 

 

 

 
 

 

Tab to the User Name Column.  Input the user names, or use the 
List of Values (LOV) to select the names.  If you use the LOV, the 
Users Window will display.  Select the name and select <OK>. 
 

 

 
 

Continued on next page 
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Routing Lists, Continued 

  
Creating a Routing List (continued) 
 

Step Action 
7 The name selected populates the User Name column. 

 

 
 

 
Continued on next page 
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Routing Lists, Continued 

  
Creating a Routing List (continued) 
 

Step Action 
8 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Continue with new sequence numbers and additional users until 
you are finished. 

 
Note:  If you do not enter a user name in the second column, you 
may enter a Groupbox name in the third column.  You may enter a 
Groupbox name or a user name in each row, but not both. 

10 Save the Routing List.    
 
Note:  You may want to only include Groupboxes as members of a 
Routing List.  If a user ceases employment and their User Name is 
not removed from the Routing List, RPA’s will still go to that 
User’s Inbox and not to the next person’s on the Routing List.  
This is true even if the former employee’s User Account has been 
inactivated. 

 
Continued on next page 
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Routing Lists, Continued 

 
Removing a User 
from the Routing List 

 

 
Step Action 

1 In the Routing Group and Routing List Details window, in the 
Routing List Members Region,  

 

Select a user and click Delete Record    on the Toolbar.  The 
user name is deleted. 

2 Select Save. 
 

Continued on next page 
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Routing Lists, Continued 

 
Adding 
Multiple 
Routing Lists to 
a Routing 
Group 

Components with only one Routing Group at the Region may need to add 
more than one Routing List to their Routing Group.  Use the following 
procedures to add additional Routing Lists to the Routing Group. 

 
Step Action 

1 In the Name data field of the Routing List Name Region, click 

 New Record icon on the Toolbar. 
2 Enter the name of the new Routing List.  Check the primary 

routing list box, if this will be a primary routing list. 

 
3 Enter the user names. 
4 

Select Save  icon after all users and Groupboxes have been 
added. 

5 Repeat this process for each Routing List required.  Additional 
Routing Lists may be added to the Routing Group at any time. 

6 
 

Close the Routing List window and return to the Navigation List.   
 
Note:  For additional information, click Help on the Main Tool 
Bar then select Contents.  You can also do a search by selecting 
the ‘Search’ tab, or if you wish to view by topic, select the ‘View 
Topic’ tab.    
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Module 1 

Chapter 3 

Navigating the DCPDS 

Chapter Overview 

  
Introduction This chapter explains the basics of how to move around in (or “navigate”) the 

DCPDS to perform your work, including common windows terminology and 
the menus and tools you will see displayed on the DCPDS windows. 

  
Chapter Contents  
 

Topic Page 
Windows Terminology 2 
Enter Dates Using the Calendar 8 
New Record 10 
Delete Record 11 
Copying and Moving Data 12 
Clear Data 14 
Duplicating a Data Field 15 
Editing a Data Field Using the Editor Window 16 
Direct Data Updates 18 
Saving Your Work 20 
Printing a Window 21 
Attaching a Document 22 
Viewing and Printing the Attachment 27 
Deleting an Attachment 30 
Copying an Attachment from Another Record 32 

 
 

  



                                                                                                 R12                                                                              March 2012 

Fundamentals:  Navigating the DCPDS                                        Mod 1, Chap 3, page 2 

Windows Terminology 

  
Purpose The DCPDS is a “windows” application.  This section describes and defines 

the windows terminology. 
  

 

 
 

  
Terms Below is a list of basic windows terms and their definitions. 
 

Term Definition 

Application A computer software program.  The DCPDS is an 
application.  Another example of an application is Microsoft 
Word for Windows. 

 
Continued on next page 
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Windows Terminology, Continued 

  
Terms (continued) 
 

Term Definition 

Button A graphic element that initiates a predefined action when you 
choose it.  In the examples below, the button with the picture 
of a diskette on it initiates the “save” function.  

♦ Examples:       

Check Box A box in which you can toggle between an “on/off” or 
“yes/no” state for a value.   

♦ Example:  

Clipboard A temporary storage area that holds objects (e.g., data) that 
you “cut” or “copy” (see Main Menu Bar, Edit Menu in this 
User Guide for more information about the cut and copy 
functions in the DCPDS). 

Current 
Record 
Indicator 

Multi-record blocks often display a current record indicator 
to the left of each record.  A current record indicator, when 
filled in, identifies a record as being the current or “active” 
record.   

Desktop 
 

The screen background on your computer monitor, where you 
view and access all information. 

 
Continued on next page 
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Windows Terminology, Continued 

  
Terms (continued) 
 

Term Definition 

Dialog Box A window that requires you to act on its contents before 
continuing.   

♦ Example:   

Field Also referred to as a “data field.”  An area in a window that 
opens data or allows you to enter data.   

♦ Example:  
 

Flexfield A data field that is made up of sub-fields, or segments.  That 
is, a flexfield contains a number of data fields (or separate 
pieces of data) within itself.  In contrast, regular information 
fields hold just one unit of information.  (See the section on 
Flexfields in this User Guide for more information). 

Form An organized display of data fields through which you can 
access and enter information to complete a business task.  
When you use the Navigation List on the Navigator 
window, you navigate to a form. 

♦ Examples of forms:   

• “Request for Personnel Action  Appointment” 
• “Workflow Inbox” 
• “Position”  

Each form opens one or more windows that link to a task 
flow. 

A given window can appear in more than one form if it 
accomplishes a task that is part of more than one task flow. 

A form in one responsibility may vary from the same form in 
another responsibility, in that certain windows or buttons may 
exist in one but not the other.  What you see depends upon 
your responsibility. 

 
Continued on next page 
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Windows Terminology, Continued 

  
Terms (continued) 
 

Term Definition 

Icons Small pictures that represent various applications, files, 
folders, or commands.  

♦ Example:   

List of 
Values 
(LOV) 

A List of Values (LOV) (possible data choices) for the 
current data field. LOVs are available for most data fields.  If 
a list is available, <List> will appear on the message line at 
the bottom of the window.    

♦ Example:   

                       

 
Message 
Line 

A line of text that is displayed near the bottom of your 
window that opens hints, warnings, error information and 
status information about the current window or data field, 
such as query-mode and record-count information. 

 
 

 
Continued on next page 

    List of values 
    

 Message line   
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Windows Terminology, Continued 

  
Terms (continued) 
 

Term Definition 

Menu A list (“menu”) of choices used to perform a variety of 
functions.  The Main Menu Bar provides menus for functions 
needed throughout the DCPDS (for example, to save an 
action or do a query).  The Main Menu Bar is always in view 
and accessible; it is located at the top of every window.  
There are also “drop-down menus” that appear throughout the 
system, organized around specific forms, data, or functions.   

 
Resize Restores a window to its previous size and location. 

 
 

 

Maximize / 
Minimize 

To Maximize or Minimize a window select a window 
command icon button at the top right corner of the window. 
You can enlarge the window to fill the entire desktop or 
Minimize the window which keeps it active and easily 
available for your use,    

    

 

                           
 

 
 

Continued on next page 

Close 
Window 

Maximize 

Restore 

Minimize 
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Windows Terminology, Continued 

  
Terms (continued) 
 

Term Definition 

Navigate Term used to describe the way users move around in the 
DCPDS; e.g., move from one place in the application (form, 
window, data field, etc.) to another.  Users can navigate 
through the system by using the mouse or keyboard.   

Scroll Bar The shaded bars located along a side and/or bottom of a 
window when the size of the window contents (document, 
List of Values, inbox, form, etc.) exceeds the space of the 
window.  To scroll to another part of the item (you have open 
and are working with document, List of Values, inbox, form, 
etc.), Select and drag the box or Select the arrows in the scroll 
bar.  

 

Taskflow 
Buttons 

A sequence of windows linked by buttons to take you through 
the steps necessary to complete a task, such as hiring a new 
employee.   
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 Enter Dates Using the Calendar 

   
Purpose To explain the steps needed to use the calendar button.  The calendar feature, 

essentially an LOV, provides an easy way to find and enter a valid date.    

  
Illustration If the data field requires a date, select the calendar icon in the toolbar.  

     

                              
 

    
Entering a Date 
Using the Calendar 

 

 
Step Action 

1 
 

Select in the applicable date data field, then: 

Select the ellipsis at the end of the field.   

The Calendar window opens (see illustration above).  The date 
value that appears below the calendar is either the value already in 
the data field, the default value of the data field, or the current 
system date. 

 
Continued on next page 

Next Year 

Previous Year 

Previous Month 

Next Month 
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Enter Dates Using the Calendar, Continued 

  
Entering a Date Using the Calendar (continued) 
 

Step Action 
2 Select the month and year you wish to enter by Selecting the 

arrows at the top of the Calendar window until the desired month 
and year display: 
 To Display: Select:  

  Previous Month Left arrow button to the left of 
the month display 

 

  Next Month Right arrow button to the left 
of the month display. 

 

  Previous Year Left arrow button to the right 
of the year display. 

 

  Next Year Right arrow button to the 
right of the year display. 

 

3 Select a day button. 
 
Note:  Disabled buttons that show dimmed text represent invalid 
days, which cannot be selected. 

4 Select <OK> button to accept the selected date and close the 
Calendar window. 
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 New Record 

  
Purpose To describe the steps necessary to create a record in the database. 

   
Creating a New 
Record 

 

 
Step Action 

1 
• Select New Record icon    on the Toolbar.  

2 • Select File  >  Save and Proceed from the Main Menu Bar 
OR 

• Select Save icon   on the Toolbar, the record is saved to 
the database. 

  
 Notes: 

• When you insert a new record in a multi-record block, the system 
moves the current block down and inserts a new blank row.  You 
add a new record by filling in this row. 

• When you insert a new record in a single-record block, the system 
opens a blank record in the current block so you can enter data for 
a new record. 

  



                                                                                                 R12                                                                              March 2012 

Fundamentals:  Navigating the DCPDS                                        Mod 1, Chap 3, page 11 

Delete Record 

  
Purpose To describe the steps to delete a record from the database. 

  
To Delete a 
Record 

 

 
Step Action 

1 • Select Edit > Delete Record from the Main Menu Bar, 
Then save work. 

Or 

Select  icon to Delete Record icon on Toolbar.  The record 
is now deleted from the database 

  
 Note:  If you exit without saving your work, the record will not be deleted 

from the database. 
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Copying and Moving Data 

  
Purpose To guide you through the steps to copy or move data from one data field to 

another.  

   
Terms  
 

Term Definition 
Copy Refers to the process of making a duplicate or copy of data 

already in one data field, to then be inserted or pasted in another 
data field. 

When you use the copy function, the data you copy is 
temporarily stored on the “clipboard” until you “paste” it to 
another location or until you “cut” or “copy” other data. 

Clipboard A temporary storage place for data that has been copied or cut. 
Clipboard contents are replaced with the next “copy” or “cut” 
action.   

Cut Refers to the process of removing or cutting data from one data 
field, and inserting or pasting it in another data field.  You use 
the cut function when you want to move data from one data 
field to another.  

When you use the cut function, the data you copy is temporarily 
stored on the “clipboard” until you “paste” it to another location 
or until you “cut” or “copy” other data. 

Paste The function of pasting the contents of the clipboard into the 
current data field. 

  
Copying or 
Moving Data  
 

Note:  The cut function is only available if the data field can be updated.  
This is because the cut function removes data from its current location.  

 
Continued on next page 
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Copying and Moving Data, Continued 

  
Copying or Moving Data (continued) 
 

Step Action 
1 Highlight the data you wish to copy or move; to do this: 

• [Tab] to the data field (when you tab to a data field with text in 
it, the text is automatically highlighted and ready to copy or cut).  
Or 

• Move your mouse so your cursor is to the left or right of the text 
you wish to copy.  Select and continue to hold your mouse 
button down while you drag your cursor over the data, releasing 
the mouse button when you get to the end of the text to be 
copied. 

 
 
 

Caution:  Clipboard contents will be replaced with the next “cut” or “copy” 
action.  To avoid losing clipboard contents (data that has been cut or copied), 
“paste” it to the desired location before you “cut” or “copy” other data. 
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Clear Data 

  
Purpose To describe the steps to enter data and then “erase” the data without saving it 

to the database by using the Clear function.   

The data you clear is erased from the window.  If the data has already been 
saved to the database, the clear function will not delete the data from the 
database.   

If the data is new and has never been saved to the database, it will be lost 
permanently when you clear it.    

 
Clearing Data Use the procedures below to clear data from a data field, record, block, or 

form. 
 

 
To Clear Data 

From a… 
From the Main 

Menu Bar, Select … 
From the Toolbar 

Select… 

Record Edit > Clear Record  
Block Edit > Clear Block  
Form Edit > Clear Form  
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Duplicating a Data Field 

  
Purpose To describe the steps to duplicate data from a previous record if much of the 

data needs to be repeated again in a new record. 

   
Copying a Data 
Field Value 
from the 
Previous 
Record 

1. Enter a new record or query an existing record in a window. 

2. Select File > New Record from the Main Menu Bar to insert a new record 
after the existing record. 

3. Navigate to the data field whose value you want to duplicate in the new 
record. 

4. Select Edit > Duplicate Field Above from the Main Menu Bar to copy 
the data field value from the previous record to the current record. 

  
Copying All 
Data Field 
Values from the 
Previous 
Record 

1. Enter a new record or query an existing record into your form. 

2. Select File > New Record from the Main Menu Bar to insert a new record 
after the existing record. 

3. Select Edit > Duplicate Record Above from the Main Menu Bar to copy 
all data field values from the previous record to the current record. 

Note:  The Duplicate Record Above menu item will not duplicate data fields 
that must be unique. 

  
When Not 
Applicable  

The Duplicate Field Above and Duplicate Record Above menu items are 
not available if there is no previous record (for example, if you are on the first 
record of a block). 
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Editing a Data Field Using the Editor Window 

  
Purpose To provide the steps to view, enter, or update the contents of a text data field 

by using the Editor window.  Using this window is not necessary, but it can 
be useful for doing a search and replace in a data field that contains a lot of 
text. 

   
Using the 
Editor Window 

 

 
Step Action 

1 • Select Edit > Edit Field… from the Main Menu Bar.  
Or 

• Use keyboard shortcut [Ctrl] + e. 
The Editor Window opens: 

 
 

2 
 

• Type in a new value or edit the existing value in the Editor 
window.  

• Follow the procedures below to search for a phrase and replace 
it with another phrase. 

Note:  If the current data field is a display-only data field, the 
Editor Window opens in a display-only mode. 

3 Select <OK> button to close the window and insert the value in 
the data field. 

  
Continued on next page 
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Editing a Data Field Using the Editor Window, Continued 

 
Searching and 
Replacing Text 

Follow the procedures below to search for a phrase within the text of the data 
field.  If you choose, you can also replace the piece of text with another piece 
of text. 

 
Step Action 

1 • Select Edit > Edit Field… from the Main Menu Bar.  
OR 

• Use keyboard shortcut [Ctrl] + e. 
The Editor window opens. 

2 Select <Search> in the Editor window to open a Search/Replace 
window: 

 
 

3 Type a value in the Search for data field.  If you want to replace 
that value with another value, type the new value in the Replace 
With data field. 

4 • Select <Search> to search for the value. 
Or 

• Select <Replace> to search for the value and replace the first 
occurrence with the new value.  
Or 

• Select <Replace All> to search for the value and replace all 
occurrences with the new value. 

5 When you are satisfied with the value in the Editor window, 
Select <OK> button to close the window and insert the value in the 
data field. 
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Direct Data Updates 

 
Purpose After an employee is on board, you can update the database to add new 

information or change existing information.  If a Notification of Personnel 
Action, or a Request for Personnel Action (RPA) is not required, you can 
perform a direct data element update to the database. 

  
Updating a 
Direct Data 
Element  

Follow the procedures below to update information in the database when no   
Notification of Personnel Action, is required (if one is required (SF-50), use 
the Request for Personnel Action). 

 
Step Action 

1 Navigation Path, > People > Enter and Maintain.  The Find 
Person window opens. 

 
 

2 In the Find Person window, query for the employee by either their 
social security number or name: 

• Select in the Social Security data field and then: 

• Type in the employee’s social security number, with the 
dashes (format:  NNN-NN-NNNN). 

• Select <Find> button. 
       Or 

• Select in the Full Name data field: 

• Type in the employee’s last name, or portion of it, 
followed by a percent sign (%).   (Example: Robb%) 

• Select <Find> button.  A List of Values opens; Select the 
employee’s name from list. 

 
Continued on next page 



                                                                                                 R12                                                                              March 2012 

Fundamentals:  Navigating the DCPDS                                        Mod 1, Chap 3, page 19 

Direct Data Updates, Continued 

  
Updating a Direct Data Element (continued) 
 

Step Action 
3 The People window (employee’s record) opens.  If the effective date 

of the data change is not the current date, Select the Alter Effective 
Date icon    on the Toolbar. 

4 Navigate to the data field to be updated by Selecting on the 
appropriate Taskflow Button at the bottom of the window, and then 
any subsequent Taskflow Buttons and list windows. 
If you navigate to a list of categories in a window that has a Details 
field at the bottom of the window: 

• Scroll through the list of categories.  If all are not in 
view, Select the “down” arrow to the left of the category 
or press [Page Down] or [Page Up] on your keyboard to 
scroll down or up through the list. 

• Select the appropriate category. 
• Select in the Details field at the bottom of the window.   

5 Select the data field you need to update and edit the data field as 
required.  Use the LOV within the window as necessary.  

6 Select the Save button    on the Toolbar to save the change to 
the database. 

7 If you are changing existing data, an Option window will display 
asking you to select <Update> or <Correction>: 
• Select Update to change the record as of the effective date you 

specify.  When you update record, all previous information is 
preserved and can be viewed in history. 

• Select Correction if the previous data is incorrect.  The new 
information will override the previous information back to the 
date that the error occurred. 

8 The Message Line will indicate that your transaction has completed 
and has been applied and saved to the database. 
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Saving Your Work 

  
Purpose To update the DCPDS, you need to save all data that you enter, edit, or delete.   

Saving your work is sometimes referred to as “committing a change” or 
“transaction”. 

In many cases, the DCPDS will prompt you to save your work before 
proceeding. 

  
Edits for 
Correct Data 
Entry:  
“Validation” 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 

 
 

When you Select Save, the DCPDS checks your work (“validates” it) against 
certain built-in edits, to ensure the values or combination of values entered 
meet HR Federal and DoD business rules.   

If your work meets the edit criteria, a Message Window and the Message Line 
notifies you that your work will be saved to the database. 

υ Example:    
 

If any of the data you enter is invalid (i.e., does not meet required business 
rule edits) or if required data is missing, an error message opens describing 
the problem to you. 

υ Example:   

 
Caution:  If you receive an error message, your data will not be saved to the 
database.  You need to correct the problem and try the save again. 

Saving Your 
Work 

Use the following methods to save your work. 

   
To: On the Main Menu Bar 

Select… 
Or On the 
Toolbar 
Select… 

Or Use the 
Keyboard 
Shortcut… 

Save your work and 
enter a new 
transaction 

File  > Save     or  
File  > Save and Proceed 

  
Ctrl + S 
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Printing a Window 

  
Purpose You can print an image of the current window at any time. 

  
How to Print a 
Window 

To print a current window:  

  
Step Action 

1 Select File > Print from the Main Menu Bar.  A Print window will 
open. 

2 • Use the following tabs to establish your print options:  
General, Page Setup and Appearance.  Once your options are 
established, select the ‘Print’ button to continue. 
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Attaching a Document  

 
Purpose This section guides you through the steps to attach, view, print, and delete an 

attachment to a record. 

    
Before You 
Begin 

• Supporting documentation is sometimes required with an RPA, Position, 
People, Activity, or other record.  You can attach short comments, word 
documents, images, OLE objects, or Web pages to many records.  For 
example, you can attach a position description to a position record.   

• Use the  icon to attach documents, images, etc. 
  
• Each record can have one or more attachments and you can copy 

attachments from one record to another.  You can store the attachments in 
the database or in your file system in the Document Catalog. 

  
Attaching a 
Document 

While in a Form and wish to attach a document follow the steps listed below: 
(Person window)  
 
 

Step Action 
1  Select the Paperclip  icon to invoke the form and the 

Attachments window will appear 

 
The Seq number is system-generated.  Main or Source are 
alternative regions providing more options/segments to determine 
what kind of attachment you have. 

 
Continued on next page 
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Attaching a Document, Continued 

  
Attaching a Document (continued) 
 

Step Action 
2   Place your cursor in the Category data field, Select the LOV. 

 
 

3 The Categories window opens. Select Comments, Miscellaneous 
or Resume.  Select <OK> button to continue. 

 
 

4 In the Description field type the information you want to attach 
such as a job description, name of word document, etc.  This is a 
free flow text field of 255 characters.  Press [Tab] on your 
keyboard. 

 
Continued on next page 
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Attaching a Document, Continued 

  
Attaching a Document (continued) 
 

Step Action 
5 With your cursor in the Data Type data field Select the LOV.  

Select the format for your data and Select <OK>.   
 

 
 
You can select any of the data types listed.   
• “Document Reference is representative of a document that 

already exists within the Oracle Application 
• “File” places a file in as the attachment.  Such as a word 

document or power point document. 
• “Long Text” is text stored in the database containing 2000 

characters or more and is used when Comments is selected. 
•  “Short Text” is text stored in the database containing less than 

2000 characters. 
• “Web Page” is a URL reference that you can view with your 

Web browser.  You must define your Web browser to view a 
Web page attachment. 

 
Continued on next page 
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Attaching a Document, Continued 

  
Attaching a Document (continued) 
 

Step Action 
6 If the File data type is selected, a web enabled page will populate  

allowing you to search for the file of choice. 
 

 
 

7 Select Browse button to select drive, directory and file, after the 
file is selected, Select Open button and then OK to proceed.   

 
 

 
Continued on next Page 
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Attaching a Document, Continued 

 
Attaching a Document (continued) 
 

Step Action 
8 
 
 

A page will appear indicating File upload was successful.  

 
Close window to return to Oracle. 

9 Upon returning to Oracle, a Decision box appears. Select the 
“Yes” button to save work.  (A message will appear at bottom of 
left screen of saved work). 

 
 

10 
 
 
 
 
 

The Attachments window opens with the Open Document button 
in the text area.  The checkboxes next to the Data Type column 
indicate if the data “may be changed” when the box is selected. 

               
 
Note:  Multiple data types can be inserted into the text area as 
attachments for the document being processed. 
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Viewing and Printing the Attachment   

  
Viewing and 
Printing  

 

Step Action 
1 
 
 
 

 

To view the attachment(s) to a record, Select the Attachment icon 
on the Toolbar.    
 
Note:  The shading on the bottom half of the button indicates there 
is an attachment. 

2 The Attachments window opens.  Select the Seq and Category 
you wish to view or print.  Depending on the attachment selected 
the window will appear different.  (When a text attachment is 
selected the message will appear immediately) 

 
• Example – Text attachment 
• Select the Publish to Catalog button – a File Download 

window will appear.  Open, Save or Cancel options. 
3 To print a text attachment, Select <File> <Print> 

 
Continued on next page 
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Viewing and Printing the Attachment, continued 

 
Viewing the Document (continued) 
 

Step Action 
4 When a file attachment is elected, an Open Document button will 

be visible. 

 
• Example – File attachment 

5 To open the File attachment, Select the Open Document button 
a File download screen appears. 

 
 

 
 

Continued on next page 
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Viewing and Printing the Attachment, continued 

 
Viewing the Document (continued) 
 

Step Action 
6 Make your selection by Selecting one of the buttons. 

•  Opens file from its current location - file 
opens, but does not save automatically– Opens the file 
automatically and does not save it. 

•  Save this file to disk allows you to select 
where you would save it before opening. 

•  Cancels request. 
7 Once the file opens, print the document as normal in a Word or 

Excel format.  
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Deleting an Attachment 

   
Deleting an Attachment  

Step Action 
1 After selecting the action which has an attachment you want to 

delete, Select the Attachment    icon on the Toolbar. 
2 The Attachments window is opened.  Select the Seq and Category 

you want to delete.  

 
Select the Delete Record   button on the Toolbar. 

3 A Decision Message Box displays, “Delete only attachment or 
delete both document and attachment?” 
Select <Attachment> or <Document and Attachment>. 

 
 

 
 
 

Continued on next page 
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Deleting an Attachment, Continued 

   
  

Step Action 
 4 You must save your work before continuing.  Select the save 

 icon. 
 
If you do not save your work and try exit the form, an error 
message will appear asking “Do you want Save your changes?” 
Select the ‘Yes’ button and exit the window.       
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Copying an Attachment from another Record 

   
Copying an 
Attachment 

 

 
Step Action 

1 Query the record you want to copy the attachment from 
2 With the record open, select the Attachment, Highlight the 

message. 

 
3 Select <Edit> <Copy>. Exit the window and record. 

 
 

4 Query the new record that you want to attach the message. Select 
the paperclip  icon. 

 
Continued on the next page 
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Copying an Attachment from another Record continued 

   
  
 

Step Action 
5 When the Attachments window is opened.  Enter the Category, 

Description and Data type information 

 
Place cursor in the text message box   

  

Continued on Next Page 
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Copying an Attachment from another Record continued 

   
  

Step Action 
6 Select <Edit> <Paste> to transfer copy.                        

 
 

 
 

 
 

7 Select Save  icon and close window using the   
 

   
 

 
 

 



                                                                                                  R12                                                                           March 2012 

Fundamentals:  Dated Information and Date Tracking                       Mod 1, Chap 4, Page 1 

Module 1 

Chapter 4 

Dated Information and DateTracking 

Chapter Overview 

  
Introduction Information in the DCPDS is either “dated” or “DateTracked.”  To use the 

DCPDS you must understand these features, because you will use them to 
some extent with every action you process or record you view.   

You can view, add, change, or delete information as of any particular date in 
time – past, present, or future.  The way information is dated and DateTracked 
provides a powerful tool for maintaining a continuous history of information.     

   
Chapter Contents  
 

Topic Page 
Dated Information 2 
Understanding DateTrack 3 
Altering the DateTrack Effective Date 6 
Viewing DateTracked Information and History 8 
Updating and Correcting DateTracked Information 10 

   
Terms This chapter addresses both dated or DateTracked information.  Below are 

brief definitions of each.   
 

Date Type Definition 
Dated Information about locations, organizations, jobs, positions, 

grades, pay tables, and other work structures is “dated” 
information.  All dated information has From and To dates 
that identify when it is/was/will be in effect (the To date is 
blank for current and future information).  Previous versions 
are maintained in the DCPDS history. 

DateTracked  Information on employees, assignments, and compensation 
and benefits is “DateTracked.”  DateTrack is a feature that 
allows you to view, add, change, or delete information as of 
any particular date in time – past, present, or future.  Through 
DateTrack, a continuous history of information, and changes 
to records, is maintained. 
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Dated Information 

  
Purpose Information about locations, organizations, jobs, positions, grades, pay tables, 

and other work structures is dated information.  
 
All dated information has a From and To date that identifies when it 
was/is/will be in effect. 

 Example:  

 
                               

  
From and To 
Dates 

You enter the From date when you enter dated information.  It is the date 
when the information becomes effective or valid.  

 Example: When you build a position hierarchy, you enter a From 
date to indicate the date that particular hierarchy 
becomes in effect.   

 
The “To” date (end date) is automatically assigned when you update the 
information and, thereby, create a new version.  

 Example: When you make changes to the hierarchy, the DCPDS will 
automatically assign a To date (end date) to the previous 
version as you save the new version.   

   
History  All dated information (for example, positions, hierarchy versions, pay tables) 

will be maintained in the database, to keep a history over time.  

   
Business Rule 
 

It is important to understand the following DCPDS business rule related to 
dated information:  

 
Business Rule Work Around 

You cannot assign an 
employee to a work 
structure on a date earlier 
than the work structure 
Date From or later than 
the Date To. 

But you can process an assignment action 
before the effective date, by altering the 
DateTrack Effective Date to a date on or after 
the work structure From date.  You can also 
use DateTrack to make a retrospective 
assignment.  
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Understanding DateTrack 

  
How It Works Information on employees, assignments, and compensation and benefits is 

DateTracked.  DateTrack is a feature that allows you to view, add, change, or 
delete information as of any particular date in time – past, present, or future. 
 
To use the DCPDS you must understand the DateTrack feature, because you 
will use it to some extent with every action you process or record you view. 
 
When you are in the DCPDS, you can set a DateTrack Effective Date in the 
past or future.  You can then view or edit information as of that date.  
DateTrack ensures that only information effective on that DateTrack date is 
used for any processing, validation, and reporting actions. 
 
Through DateTrack, a continuous history of information, and changes to 
records, is maintained. 

 
Terms To understand DateTracking, you will need to understand the following 

terms: 
 

Term Definition 
Effective 
Date 

We are used to thinking of the effective date as the date a 
personnel action takes effect.  In the DCPDS, effective date 
also refers to the point in time you identify for DateTracking 
(the date of the snapshot of the record).  To avoid confusion, 
this Users Guide will generally use the term DateTrack 
Effective Date. 

Update An update is a change to a record where the previous 
information was valid up until the date of the update.  When 
you update a record, all previous information is preserved, and 
can be viewed using DateTrack History. 

Correction A correction is a change to a record where the previous 
information was incorrect.  When you correct a record, the new 
(correct) information overrides previous information that was 
incorrect (back to the date the error occurred).  After the 
correction, if you view the record in DateTrack History, the 
correct information will display even during the period of time 
where the incorrect information was displayed (and related data 
fields will have been adjusted accordingly). 

 
Continued on next page 
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Understanding DateTrack, Continued 

  
Data Display 
and Use in 
DateTrack 

The information you see in the DCPDS, and the information used for any 
processing, validation, and reporting, is based on whatever DateTrack 
Effective Date you are working in: 

 
DateTrack 

Effective Date 
Information Displayed and Used  

for Processing, Validation, and Reporting 

Past Date Information as it was on that date. 
Current Date Information as it is today.  If any action has already been 

input that has a future effective date, you will not see it. 
Future Date Information that includes any future dated actions (as of 

the DateTracked date) that have already been input. 

   
Business Rule 
 

Caution:  It is important to understand the following DCPDS business rule 
related to DateTracked information:  

 
Business Rule Work Around 

You cannot create a record and 
update it on the same day.   

    Example:  You cannot hire an 
employee on the same day you 
accept him or her as an 
applicant, and you cannot hire 
an employee unless he or she 
has been first entered as an 
applicant. 

This is because DateTrack maintains 
records entered for a minimum of 
one day. 

But you can process both things on 
the same workday if you alter the 
DateTrack Effective Date so that the 
two events are effective in the system 
on different days. 

    Example:  You can alter the 
DateTrack Effective Date to a 
past date to enter the applicant; 
then alter the date again to the 
present date to hire the 
applicant. 

 
 

Continued on next page 
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Understanding DateTrack, Continued 

  
DateTrack 
Buttons and 
Menu Items 

Below are the DateTrack Toolbar buttons and the Main Menu Bar items 
related to the DateTrack functions you will use.  Explanations of when and 
how you will use these functions are explained in the pages that follow. 

 
Toolbar Button Main Menu 

Alter Effective Date button:   Tools  > Alter Effective Date 

Date Track History button:   Tools > Date Track History 

 
Current 
Effective Date 
Reminder 

 
Note:  If you need the system set up to remind you of the current effective 
date each time you begin working on the People window, follow your local 
business rules for setting up this option.  
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Altering the DateTrack Effective Date 

  
Purpose When you log on to the DCPDS, the effective date is always the current date.  

To view information current at another date, or to make retrospective or 
future dated changes, you need to change your DateTrack Effective Date. 

  
Altering the 
DateTrack 
Effective Date 

To alter the DateTrack effective date, follow the procedures below.  Before 
you do, be sure to save any unsaved data. 
 
Note:  If you are altering the date to make retrospective or future-dated 
changes, you need to follow these steps before you enter the changes. 

 
Step Action 

1 • Select the Alter Effective Date button  on the Toolbar. 
Or 

• Select Tools > Alter Effective Date… from the Main Menu Bar. 

 
The Alter Effective Date window opens: 

 

2 Type in or use the calendar to enter a new effective date. 
3 Select <OK>. 

Note:  Whenever you are operating in a DateTrack Effective Date that 
is different from the current date, the DateTrack Effective Date will be 
displayed in the Title Bar of every window. 

Example:   
   

Continued on next page 
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Altering the DateTrack Effective Date, Continued 

  
Cautions  Whenever you alter the DateTrack Effective Date, it is important to remain 

aware of the date in which you are working, and to reset it as appropriate.  
Below are some cautions and notes you need to be aware of. 

Cautions:   
• If your current window is a “top-level” window (one that is accessed 

directly from the Navigation List), the new DateTrack Effective Date 
remains in place until you reset it or exit the DCPDS.  

• If your current window is not a “top-level” window, the new 
DateTrack Effective Date only applies while you are working in the 
current window and any windows subsidiary to it.  When you return to 
a top-level window, your DateTrack Effective Date is reset to the 
previous value. 

• In some cases, when you alter the effective date on a subsidiary 
window, the DCPDS returns you to the previous window, and you 
may have to re-query the records you want to view or update. 
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Viewing DateTracked Information and History 

  
Purpose The DCPDS maintains a continuous record of changes made to DateTracked 

information.  You can: 
• View record information for a particular date (snapshot in time). 

Or  
• View all of the changes to a record over time (a full history). 

 
Viewing 
Information as 
of a Particular 
Date 

When you view a record in a window that contains DateTracked information 
(e.g., the People > Enter and Maintain window), you will see a snapshot of 
information as of the DateTrack Effective Date in which you are operating.  
This is either the current date or the date you set by using the Alter Effective 
Date function.   

The procedures below outline how to view information as of a particular date 
and explain the Effective Dates region in DateTracked windows. 

 
Step Action 

1 Set your DateTrack Effective date: 
• Use the current date.  

Or 
• Follow the procedures in Altering the DateTrack 

Effective Date to select a past or future date. 
2 Retrieve the record or records you wish to view.   
3 Look at the Effective Date region in the window: 

Example:  

 
 
This Effective Date region shows you the dates between which the 
information in the snapshot is valid.   

If there is no To date (end date), then there have been no changes to 
the date since the From date and there are no future dated changes. 

If there is a To date, then the record was either deleted or changed 
the next day.  To find out if the record continues to exist, you can 
use Alter Effective Date to set the DateTrack date to the day after 
the To date, or use DateTrack History. 
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Continued on next page 

Viewing DateTracked Information and History, Continued 

  
Viewing the 
DateTrack 
History of a 
Record 

To see a history of all of the changes to a DateTracked record over time, 
follow the procedures below:   

Step Action 
1 • Select the DateTrack History icon  on the Toolbar. 

Or 
• Select Tools > Date Track History… from the Main Menu Bar. 

 
The DateTrack History Change Field Summary window opens.  
Each row shows which data fields were changed, and the 
corresponding From Date. 

 

2 Select Full History button to open a DateTrack History folder 
showing the value of each data field between the effective dates.  The 
row for the current snapshot (corresponding to the effective date you 
are working in) is highlighted. 

 
 

  
Continued on next page 
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Updating and Correcting DateTracked Information 

  
Purpose 
 

Whenever you change DateTracked information, you will be prompted to 
choose between Update and Correction.   

  
Update vs. 
Correction 

Caution:  There are important distinctions between Update and Correction.  
In most cases, you will be updating records, because the previous information 
was correct; it has just changed.  At times it may be necessary to process a 
correction.  In these cases, special care should be taken to ensure that the 
action truly is a correction instead of an update.  Below are the distinctions 
between these two functions and the impact of each on history files. 

 
Term Definition 

Update An update is a change to a record where the previous 
information was valid up until the date of the update.  When you 
update a record, all previous information is preserved, and can 
be viewed using DateTrack History. 

Example:  An employee gets married and changes her 
name, address, and next of kin information.  You Alter 
the Effective Date to the date of her wedding and input 
the new information.  When saving the changes, you 
select Update.  The employee’s previous information, 
up until her wedding date, remains in her history record. 

Note:  Information that you enter in the Assignment, Position, 
and Person Extra Information flexfields is always an update, not 
a correction. 

Correction 
 

A correction is a change to a record where the previous 
information was incorrect.  

Example:  You discover an error in an employee’s 
record made during the processing of his appointment, 
relating to his address. You Alter the Effective Date to 
the date of his appointment and you edit his address 
information.  When saving the changes, you Select 
<Correction>. By choosing correction, you make the 
record correct, from the beginning.   

Caution:  When you correct a record, the new information 
overrides previous information that was incorrect (back to the 
date the error occurred).  After the correction, if you view the 
record in DateTrack History, the correct information will 
display even during the period of time when the information was 
incorrect  
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Updating and Correcting DateTracked Information, Continued 

 
Updating or 
Correcting 
Information 
 

 
Note:  You cannot create a record and then update it on the same day      

 
Step Action 

1 • Select the Alter Effective Date icon  on the Toolbar. 
Or 

• Select Tools > Alter Effective Date…from the Main Menu Bar. 
 
The Alter Effective Date window opens: 

 

2 Type in or use the calendar to enter: 
• The effective date of the update. 

3 Select <OK>. 

Note:  Whenever you are operating in the DateTrack Effective Date 
data field that is different from the current date, the DateTrack 
Effective Date will be displayed in the Title Bar of every window. 

Example:     
                      

4 Edit the data field(s) applicable to the update or correction: 
• If an SF-50 is required, access the window(s) with the data fields 

to be updated through the Navigation List > Request for 
Personnel Action (for an update) or Navigator List > Request for 
Personnel Action > Cancellation/Correction (for a correction).  If 
an SF-50 is not required, you can access and edit the data fields 
without going through the Request for Personnel Action form. 

 
Continued on next page 
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Updating and Correcting DateTracked Information, Continued 

  
Updating or Correcting Information (continued) 
 

Step Action 
5 Select the Save icon  on the Toolbar. 

An option window opens: 

 

6 • Select <Update>. 
Or 

• Select <Correction>. 
7 If you are processing a correction:  check to see if there is an end date 

in the Effective Date region of the record.  If there is an end date, 
you have only updated the first snapshot of the record.  So… 

• Alter the Effective Date to the day after the end date and 
make the correction again.   

• Repeat this procedure until the To data field is blank 
indicating that you have reached the last snapshot of the 
record. 
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Module 1 

Chapter 5 

Updating and Viewing the Employee Record 

Chapter Overview 

  
Introduction This chapter explains the use of the People window (Record) for updating and 

viewing employee records in such areas as education, licenses, emergency 
contacts, etc.  It is also used in the procedure, Building an Applicant, when a 
recruitment tools such as Resumix and USA Staffing are not used. 

 
Chapter Content  
 

Topic Page 
Chapter Overview 2 
Updating the Employee Record  

Using Assignment (ex:  Government Awards) 4 
Using Extra Information (ex:  Separation and 
Retirement) 

7 

Using Special Information (ex: Education) 13 
Using Others (ex: Emergency Contacts) 20 

Viewing the Employee Record   
Address Information 25 
Assignment Information 26 
Extra Information 28 
Special Information 30 
Others Information 32 

Retrieving Records 39 
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Chapter Overview, Continued   
Before You 
Begin 

The People window is used to enter and update employee information when 
an RPA/NPA is not required.  It is also used for retrieving or viewing current 
information on an employee.  Oracle HR contains both a People Record and a 
Position Record.   The two records are linked together through assignment. 

 
The People Window 
 

The People window has four  Regions and five Task flow buttons: 
 

 
 
Note:  Grayed out fields cannot be updated. 

 
Regions/Data Fields/ 
Buttons 

Description 

Last Last name plus suffix (Jr., III, etc.) 
First First name 
Title Not used by DoD (Mr., Mrs., etc.) 
Prefix Not used by DoD (grayed out) 
Suffix Not used by DoD (grayed out) 
Middle Middle name or initial 
Gender Female/Male/Unknown Gender 
Person Types System-generates with Employee or 

Applicant 
Identification  System-generated number 
Social Security Automatically populates 
Personal Information 
Region: 

Birth Date automatically populates 
Work Telephone and Email can be added at 
a later time. 



                                                                                                  R12 March 2012 
 

Fundamentals:  Entering and Updating Employee Records                   Mod 1, Chap 5, Page 3 

Chapter Overview, Continued 

   
The People Window (continued) 
 

Regions/Data Fields/ 
Buttons 

Description 

From/To Self-explanatory 
Taskflow Buttons:  
Address Payroll updates and feeds back to Oracle 

HR.  There are six types:  Forwarding, 
Overseas, Residence 1, Residence 2, etc. 

Assignment Assignment information for tracking 
purposes.  Supervisor data field not used 
by DoD.  Position hierarchy is used to 
maintain supervisory information (see 
Module 2).  The Assignment Taskflow 
Button links the People Records with the 
Position Records and is used for viewing 
only. 

Extra Information 
(single occurring item) 

Maintains additional employee 
information such as acquisition, kinds of 
employees (local nationals, NAF, NG, 
etc.), security, etc.  

Special Information 
(multiple occurring items) 

Maintains special information such as 
demo projects, education, acquisition 
waivers, details, NAF, completed and 
required training, and Career 
Management Programs.  

Others (view only) Finance Information is updated from the 
bi-weekly Personnel Pay Application 
Data (PAD) interface file. 
Person Summary is a snapshot of person 
and position information.   
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Updating the Employee Record (Using Assignment) 

  
Purpose This section uses, as an example, the Assignment process for updating 

Government Awards in the employee record.  Complete instructions can be 
found in Module 5, Workforce Relations Using the DCPDS, Chapter 3, 
Awards, Section, Entering a Non-Monetary Award. 

  
Using Assignment to Update 
Government Awards 

NOTE:  Remember to Date Track as appropriate.  Refer to 
Mod 1, Chapter 4 for specifics.   

 
Step Action 

1 Navigation Path > People > Enter and Maintain 
2 The Find Person window opens. 

 
Query the employee by typing in the Full Name or partial (ex: Tre 
%) or enter Social Security Number and then select the Find 
button.   

3 The People window opens with the employee data populated. 
4 Select the <Assignment> button.  The Assignment window 

displays many of the data fields populated and/or grayed out and 
three Taskflow Buttons:  <Entries>, <Extra Information> and  
<Others>. 

 
 

Continued on next page 
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Updating the Employee Record (Using Assignment), Continued 

  
Using Assignment to Update Government Awards (continued)  
 

Step Action 
5 After invoking the Entries window.  The cursor will be in the first 

data field in the Element Name column.  Move the cursor to the 
first blank data field. 
 

 
Select the LOV icon and select Federal Awards and then Select 
<OK>. 

 
 

 
 

Continued on next page 
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Updating the Employee Record (Using Assignment), Continued 

  
Using Assignment to Update Government Awards (continued)  
 

Step Action 
6 

Select <Entry Values> button  to open the 
Values window.  You can type the appropriate award data in the 
white data fields or Select the LOV to make selections.   

7 Select Save  icon and exit the windows. 
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Updating the Employee Record (Using Extra Information) 

  
Purpose This section uses the process for Updating US Government Separation and 

Retirement data in the employee record, as an example. 

  
Using the Extra Information 
to Update  

 

Step Action 
1 Navigation Path > People > Enter and Maintain > <Open>. 
2 The Find Person window opens.  Query the employee by typing 

in the last name and Selecting the <Find> button. 
3 The People window automatically populates with employee data. 
4 Select the <Extra Information>  button to 

open the window  

 
 

Continued on next page 
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Updating the Employee Record (Using Extra Information), 
Continued   

Flexfields  The following is a listing of flex fields in the Extra Person Information 
window.  There are data fields within each flexfield.  Enter information as 
required. 

 
Flexfields 

Acquisition Basic Data 
Acquisition Contracting Officer 
Acquisition Corps Data 
Acquisition Series 1102 
Air Force AGR 
Alternate Personnel System Info 
Army AGR 
Army Additional Information 
Army SPEP 
BBG/IBB Person Data 
Birth Information 
CIPMS 
DCIPS Performance Payout Info 
DCIPS Periodic Increase Info 
DIS Security 
DoD Enterprise Program Area Basic Data 
 DoD Enterprise Program Area 
Certification Assignment Data 
FEGLI Open Season 
Handicapped Additional Information 
Information Assurance Basic Data 
Initial Accounting Series Qualifications 
LWOP Mil Reempl Rights Info 
Local National Conduct/Performance 
Military Affiliation 
NAF Additional Person Information 
NAF Army Allow and Earnings  
NAF Army Pay 
NAF Army Payroll Information 

 
Continued on next page 
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Updating the Employee Record (Using Extra Information), Continued   

 
Flexfields (continued)  
 

Flexfields, Continued 
NAWC Lab Demo Payout Information 
NSPS Information 
NSPS Pay Retention NTE 
NSPS Performance Payout Info 
NSPS RIF Tenure 
National Guard Information 
Navy Lab Demos Maint Pay Info 
Navy Security Information 
Navy Unique Information 
OPM Separation and Retirement Data 
OSDMIL 
Other Person Information 
Overseas Tour Person Information 
Performance Award Salary 
Personnel Contingency Area 
Probation Certifications 
Reemployed Annuitant 
Training Program Requirements 
US Federal Conversions 
US Federal Ethnicity and Race Category 
US Federal Person Benefit Information 
US Federal Person Group 1 
US Federal Person Group 2 
US Federal Person RPA 
US Federal Person Service Obligation 
US Federal Probations 
US Federal Retained Grade 
US Federal SCD Information 
US Federal Security 
US Federal Separation and Retirement 

 
Continued on next page 
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Updating the Employee Record (Using Extra Information), 
Continued  

Flexfields  (continued) 
  

Flexfields, Continued 
US Federal Uniformed Services 
US Federal User Information 
US Federal Workflow Routing Groups 
USUHS Info 
Welfare to Work 

 
Continued on next page 
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Updating the Employee Record (Using Extra Information), 
Continued 

  
Using the Extra Information (continued)  
 

Step Action 
5 Use the scroll bar to the right to select US Government 

Separation and Retirement  
6 Select in the Details field.  To display the Information window.   

 
Select the LOV icon for each appropriate data field, as some fields 
should only be updated via a Request for Personnel Action.  

 
 

 
Continued on next page 
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Updating the Employee Record (Using Extra Information), 
Continued 

  
Using the Extra Information (continued)  
 

Step Action 
7 Select  button to close window if changes weren’t made or 

Select the Save  icon if changes were made and exit the 
windows. 
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Updating the Employee Record (Using Special Information) 

 
Purpose This section uses the process for updating education in the employee record, 

as an example. 

 
Using Special 
Information (SIT) to 
Update Education  

 

 
Step Action 

1 Navigation Path > People > Enter and Maintain > <Open>. 
2 The People window opens with the Find Person window displayed. 

Query for the employee by typing in the full name, just the last name, 
or partial last name with %.  Select the <Find> button. 

 
 

 
Continued on next page 
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Updating the Employee Record (Using Special Information), 
Continued 

  
Using Special Information (SIT) to Update Education (continued) 
 

Step Action 
3 The People window is populated with the employee’s data. 
4 

Select  button to invoke the Special Information 
window.  

 

  
Flexfields The following is a listing of flex fields in the Special Information window.  

There are data fields within each flexfield.  Enter information as required. 
 

Continued on next page 
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Updating the Employee Record (Using Special Information), 
Continued 

  
Flexfields (continued) 
 

Flexfields 
ACQ - AF Technical Appraisal 
ACQ - Assignment Review 
ACQ -  Career Level Certs 
ACQ  - Continuous Learning 
ACQ – Crit Acq Posn Waivers 
ACQ - Other CAP Waivers 
ACQ - PEO Waivers 
ACQ  - PM and DPM Waivers 
ACQ - SCO Waivers 
ACQ - SES Waivers 
ACQ - Warrant Data 
AGR Prof Dev Program Data 
AGR Reassignment Data 
AGR Training Completions 
Air Force Demo Bonus Info 
Appr – Air Force Lab Demo 
Appr – Army Lab Demo 
Appr – DOD Acquisition Demo 
Appr – NAWC Lab Demo 
Appr – Naval Research Lab Demo 
Appr – Space Nav Warfare Demo 
Appr – Warfare Center Demo 
Appraisal - Non-Appr Fund 
Army Career Program 
Certifications 
Civilian Deployment Info 

 
 

Continued on next page 
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Updating the Employee Record (Using Special Information), 
Continued 

  
Flexfields (continued) 
 

Flexfields, Continued  
Demo Date Information 
Demo Project – CCS/CCAS 
Demo Project – NV Warfare Labs 
Demo Project - Navy 
Demo Project – Performance Pay 
Detail Information 
Education 
IA Certifications 
LN Adverse Action Info 
LN Appraisal Information 
LN Conditions of Employment 
LN Conduct/Performance Army 
LN Education Information 
LN Language Information 
NAF (401)K Changes 
NAF Army Payroll  - Bonds 
NAF Career Program 
NAF Life Insurance Changes 
NAF Medical Insurance Changes 
NAF Prev Retmnt Enrollments 
NAF Retirement Changes 
NAF Rev Pay: AWOP Information 
NAF Rev Pay:  Allowance Info 
NAF Rev Pay: Annual Leave 
NAF Rev Pay: Compensatory Time 
NAF Rev Pay: Deduct and Contri 
NAF Rev Pay: Flex Time Worked  
NAF Rev Pay: Hours and Pay 

 
 

Continued on next page 
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Updating the Employee Record (Using Special Information), 
Continued 

  
Flexfields (continued) 
 

Flexfields, Continued  
NAF Rev Pay: Mil and Home Leave 
NAF Rev Pay: One-Time Earnings 
NAF Rev Pay: Other Deductions 
NAF Rev Pay: Other Earnings 
NAF Rev Pay: Sick Leave 
NAF Unclaimed Compensation 
Navy CIVMAR Permanent Data 
Navy Lab Demo – DCA-EAA Data 
Navy Lab Demo - CCS 
Required Training 
SSC Atlantic-Pacific Payout 
US Fed Cndtn of Emplmt 
US Fed Conduct Perf 
US Fed Language 
US Fed Perf Appraisal 
US Fed  Spcl Consdrtn 

 
Continued on next page 
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Updating the Employee Record (Using Special Information), 
Continued 

 
Using Special Information (SIT) to Update Education (continued)  
 

Step Action 
5 Use the upper scroll bar to the right and scroll down to locate 

Education.  

 
The current date populates in the Start Date data field in the Details 
Region, but you can override it by Date Tracking to the appropriate 
start date.  The End Date data field displays a date for actions that 
have specific end dates, such as performance appraisals, completed 
training, reprimands, etc. 

6 Place cursor in Detail data field to invoke form. 

 
 
 
 

Continued on next page 
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Updating the Employee Record (Using Special Information), 
Continued 

   
Updating the Employee Record (Using the Special Information Type) (continued)  
 

Step Action 
7 The Education window opens.  Select the ellipsis at the end of 

the line to enter the information in the data fields as required by 
the business rules: 

 
8 Select  button if entries are not made. 
9 Select Save  icon if information has been entered.  To exit 

windows, select the   located to the right of window. 
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Updating the Employee Record (Using Others) 

  
Purpose This section guides you through the procedure for updating emergency 

contacts (spouses, children, etc.) and their addresses.   

  
Using Others to Update 
Emergency Contacts  

 

 
Step Action 

1 Navigation Path > People > Enter and Maintain> <Open>.  The 
People window opens with the Find Person window displayed. 
Query for the employee by typing in the full name, just the last 
name, or partial last name with %.  Select the <Find> button. 

 
2 The People window automatically populates with employee data.  
3 Select the  button to open the Navigation 

Options window 

 
 

Continued on next page 
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Updating the Employee Record (Using Others), Continued 

   
Using Others to Update Emergency Contacts (continued)  
 

Step Action 
4 Select Contact and then select <OK> button to open window. 

 
 

 
 

Continued on next page 
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Updating the Employee Record (Using Others), Continued 

Using Others to Update Emergency Contacts (continued) 
 

Step Action 
5 Type in the contact’s name in the Name Region.  The Type data 

field populates with “External”.  Place the cursor in the Relationship 
Region and select the type of contact.   Save changes 

 
Select the <Contact’s Details> button, select Enter Address from the 
details window and Select <OK> button. 

 
 

Continued on next page 
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Updating the Employee Record (Using Others), Continued 

  
Using Others to Update Emergency Contacts  (continued) (continued) 
 

Step Action 
6 The address window displays the Country data field populated with 

“United States.” 

 
7 Select in the Address field to open the window. Type in the Address 

Line1. Enter the City, State, Zip Code, and County.  Telephone 
number is optional. Select the <OK> button. 

 
8 From the main Address window Select in the Type data field then 

Select the ellipsis to select address type.     
 

  
 

Continued on next page 
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Updating the Employee Record (Using Others), Continued 

  
Using Others to Update Emergency Contacts  (continued) (continued) 
 

Step Action 
9  Select the type of address, and then Select the <OK> button.  

 
10 Select the Save icon and then close the form to return to the People 

window. 
  If you … Then …  
  Want to create additional 

contacts 
Exit the window back to the 
Contact window.  Select New 
Record on the Toolbar and 
complete the steps described above.  

 

  Do not want to create 
additional contacts 

Exit.  

 
 

Note:  If you create more than one contact, the contact designated as 
“Primary” will be the first window displayed when you check the data 
again.  Use the Up and Down arrow keys to view the data. 
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Viewing the Employee Record 

  
Purpose This section explains the steps to view the Employee Record using different 

Taskflow Buttons (Address, Assignment, Extra Information, Special Info and 
Others) to access information. 

 
Viewing Address 
Information  

 

Step Action 
1 Follow steps 1-3 as described in “Updating the Employee Record” 

to open the People window. 
2 Select the <Address> button.  The window will display the 

employee’s address, if any, and is stored in the Residence 1 in the 
Type data field.  An address file is received from DFAS every two 
weeks and will update the employee’s record if there are any 
changes.  If you make entries to this area, it will be overwritten by 
DFAS each pay period if it is different from what DFAS has on 
their system.  

 
3 Select in the Type data field and insert a % in the Find field to 

select another Address Type.    Note:  Data can be stored in these 
areas but for information only and is not retrievable.   

 
Select the <OK> button to select the data.  Exit the window. 

  



                                                                                                  R12 March 2012 
 

Fundamentals:  Entering and Updating Employee Records                   Mod 1, Chap 5, Page 26 

Viewing the Employee Assignment 

  
Viewing Assignment 
Information 

 

 
Step Action 

1 Follow steps 1-3 as described in “Updating the Employee Record” 
to open the People window. 

2 Select the <Assignment> button to open the Assignment window.  
The top region displays the Organization, Job, Grade, Location, 
Position, Payroll, and Status data fields, as well as the Effective 
Dates.   

 
3 DoD does not use the alternate region tabs such as the Supervisor 

field Task flow button.   However,   the <Others> and <Entries> 
Task flow buttons are used.  <Entries> is also discussed in 
Module 6, Pay, Benefits, and Entitlements. 

4 Select the <Extra Information> button to invoke the Extra 
Assignment Information.    

 
Continued on next page 
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Viewing the Employee Assignment, Continued 

  
Viewing Assignment Information (continued) 
 

Step Action 
5 The Extra Information window will open.  This provides 

additional assignment and pay information for both Appropriated 
and Non-Appropriated Fund employees such as NTE dates, type of 
detail, and pay rate determinant (US Federal Assignment RPA).   

 
 

6 Select an Information Type, then Double Select in the Details field 
to open window. 

7 Select the ellipsis to select the appropriate information for each 
field according to the DoD business rules. Select Additional 
Assignment Information, then Selected <OK> button. 

 
Repeat the process for each Option selected.  When complete save 
work and then close windows. 
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Viewing the Employee Assignment, Continued 

  
 
Extra Information 
  

 

  
Step Action 

1 Follow the previous steps as described in “Using the Extra 
Information” procedure to open the People window. 

2 Select <Extra Information> button to open the Navigation 
Options window.  

 
Select US Federal Person RPA and then select <OK> 

 
 

Continued on Next Page 
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Viewing the Employee Assignment, Continued 

  
 
Extra Information, Continued 
  

 

  
Step Action 

3 

 
Information is view only.   
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Viewing the Employee Assignment, Continued 

  
 
Special 
Information 
  

 

 
Step Action 

1 Follow steps 1-3 as described in “Updating the Employee Record” 
to open the People window. 

2 Select the <Special Info> button to open the Navigation Options 
window.  

 
3 The Special Information – Query window opens. 

 
 
 

Continued on Next Page 
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Viewing the Employee Assignment, Continued 

  
 
Special Information, Continued 
  

 

  
Step Action 

4 Use the upper scroll bar to the right and scroll down or use the 
query option to locate the Special Information Type you want to 
view. 

 
5 Select the area until Detail. 

 
The details will appear. 

 
6 Select <Cancel> to leave this screen when viewing. 
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Viewing the Employee Record, Continued 

  
 Others 
 

Step Action 
1 Select <Others> button to open the Navigation Options window.  

 
 

2 Select Finance Information and Select <OK>. 

 
 
 

Continued on next page 
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Viewing the Employee Record, Continued 

  
Others (continued) 
 

Step Action 
3 
 

The Finance Special Information window displays eight choices 
in the Name data field. Use the scroll to right to move up or down 
to make your selection. 
Caution:  This is view only data – do not modify. 
 

 
 

 
 

Continued on next page 
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Viewing the Employee Record, Continued 

  
Others (continued) 
 

Select To View 
Additional Leave Info 
 
 
 
 
 
 
 
 
 
 
 
Allowances and Special Pay 

 
 
Place cursor in ‘Detail’ area to view 
information.   

 
 

 
 

Continued on next page 
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Viewing the Employee Record, Continued 

  
Others (continued) 
 

Select To View 
Contributions Info 

 
Cost Budget Info 

 
 

Continued on next page 
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Viewing the Employee Record, Continued 

  
Others (continued) 
 

Select To View 
Earnings and Pay 

 
Employee Leave Info 

 
 

Continued on next page 
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Viewing the Employee Record, Continued 

  
Others (continued) 
 

Select To View 
Employee Leave Info 

 
 

Continued on next page 
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Viewing the Employee Record, Continued 

  
Others (continued) 
 

Select To View 
Employee Org Dues 
Deductions 
 
 
 
 
 
 
 
 
Special Leave Info 
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Retrieving Records 

  
Introduction There are a number of different ways to retrieve and view data in the DCPDS.  

The search capabilities allow you to quickly and easily: 
• Display a specific record or group of records you need to work 

with. 
• Look up information online, for example, to respond to an 

inquiry. 
• Find and enter values into specific data fields. 

You can search for information without having to use a complex query 
language.  You can search by a single letter, word, group of characters, or just 
about anything else.  And, you can find out how much information is 
available that matches your criteria before running the search to save 
computer time and your time if the search would yield too big a response (this 
feature is available only when using Query-by-Example). 

   
Term Query – Query is used interchangeably with search to describe the retrieval 

of records or data. 
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Module 1 

Chapter 6 

Folders 

Chapter Overview  

  
Introduction Folders are on-line displays of information.   As an example, navigate to the 

Civilian In Box for folder setup, etc. 

You can identify a folder from a regular block by the following: 

• A  Open Folder button   displays in the upper-left corner of a 
folder block and 

• The Folder Tools button on the Toolbar  is enabled (is not 
dimmed) when your cursor is in a folder block. 

You can customize the display of data in folders and you can define your 
own, private, folders.  In addition to viewing data in folders on-line, you can 
print and export the data. 

   
Term Folder Definition:  Folders which you have “created” by customizing 

standard DCPDS folders.  When you customize a DCPDS folder, you can 
“define” (specify) the records to be displayed (by setting query criteria), and 
you can customize the layout of the data displayed for these records. 
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Module 1 

Chapter 7 

Other Tools in the DCPDS 

Chapter Overview 

  
Introduction This chapter guides you through the processes of using additional tools that 

will enhance your capability to use the DCPDS. 

   
Chapter Contents  

Topic Page 
Using Ghost View 2 
Corporate Management Information System 
(CMIS) 

5 

End User Layer to Access Data 6 
Using the NPA Maintenance Form 8 
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Using Ghost View  
Purpose To guide you through the procedure to use Ghost View to view reports.  We 

will use the Notification of Personnel Action (NPA) as the example. 

   
What Is It? It is a behind the scenes software application that allows you to view your 

reports/documents that you normally create and view based on your role and 
responsibility. 

  
Who Can 
Access    You must be in a role that allows you to print an RPA/NPA or a role to 

print a DD Form 1556. 

  
Using 
GhostView 

 

Step Action 
1 Navigation Path > Processes and Reports > Submit Processes 

and Reports ><Open>. 
2 The Submit a New Request window opens. Select <OK> button 

 
3 With your cursor in the Name data field, Select the LOV icon and 

select Notification of Personnel Action, then Select 
the<OK>button. 

 
 

Continued on next page 
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Using GhostView, Continued 

  
Using GhostView (continued) 
 

Step Action 
4 The Parameters window opens. Select the LOV icon to select the 

Employee Name or use the shortcut query method.  The next two 
data fields, Front Page and Back Page, automatically populate. 
Select the<OK> button 

 
 

5 Select the <Options> button the Upon Completion window opens, 
Select in the Copies data field and override with “0.”  It is not 
necessary to change the other two data fields. Select the <OK> 
button 

 
 

Continued on next page 
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Using GhostView, Continued 

 
Using GhostView (continued) 
 

Step Action 
6 Select the <Submit> button. 
7 The Requests window opens and shows the Phase and Status of 

your Requests.  With the Current Record Indicator on the Report 
you need, Select the <View Output>. 

 
8 Ghost View Window opens the Notification of Personnel Action 

for your review on your monitor screen. 
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Corporate Management Information System (CMIS) 

  
Definition CMIS is a central depository of all actions that occurs DoD wide.  It has 

view-only capability.  This data warehouse uses Business Objects as the front 
end reporting tool. 

 
System Access Access to the system, at all levels within DoD, will be based on an 

individual’s official need for information.  Each Component has 
responsibility for granting access privileges.   

  
How It Works Regional servers link the regional databases to the DoD Corporate 

Management Information System (CMIS), where information on all DoD 
employees is maintained.  
 
CMIS provides Component Headquarters access to Component information 
and the Department access to DoD-wide human resources information. 
 
CMIS is used to record personnel actions and not to process them. Although 
Oracle HR can generate reports primarily for use by personnelists, it has 
limited ad hoc capabilities.  Access to this database will be through an Oracle 
compatible query tool.  Code is written into an End User Layer (EUL) that 
hides the complexities of a large relational database and gives you an easy-to-
use tool.  The data are broken down into expandable folders.  Once you 
become familiar with the contents of the folders, generating a query becomes 
easy as you are guided by a Wizard that walks you through each required 
step.   
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Using End User Layer to Access Data 

  
Purpose This section explains how the End User Layer (EUL) is used to access data 

from DCPDS.  EUL is a predefined set of views of the database composed of 
folders with related data elements.  It is used to access the database using 
query tools such as Cognos, Business Objects, or a Discoverer tool 
application.  It is attached to the: 

• Regional Service Center (RSC) database.   
• Customer Support Unit (CSU) characteristics: 

• Designed for fast reporting.  
• Use as a reporting tool. 
• Is updated nightly from the RSC database. 

• Transaction updates are done on the RSC database, not the CSU database. 

   
How It Works • The EUL provides an easy-to-use, ad hoc view of the data in the CSU 

database.  Many commercial database inquiry systems exist.  The 
illustration below uses Oracle Discoverer 3.1.  Other tools provide the 
same basic functionality; however, your tool will not perform in exactly 
the same manner as discussed here.  

• Most DoD users are functional specialists or managers and not 
programmers.  The EUL encapsulates data into families of folders.  For 
example, the Employee folder contains data directly related to employees, 
such as Name, SSAN, DOB, Tenure, and Citizenship.  The Civilian 
Position folder contains data directly related to a position, such as PD 
Number, Agency Code, CCPO ID, and FLSA Category. 

• Once the desired data is selected and moved into a selection window, it 
can be further refined by setting up conditions using standard relational 
operators, such as =, >, <, like, and in.  Data items and operators are all 
available through Lists of Values (LOVs).  Conditions can be joined with 
“and or” logic, making it possible to build tightly focussed inquiries.  The 
data are initially displayed in the familiar spread sheet fashion and can be 
exported to an external file in several different formats.  Any inquiry can 
be saved for future use.  This is especially useful when an experienced 
user develops complex inquiries frequently used by new users or 
management officials.   

 
Continued on next page 
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Using End User Layer to Access Data, Continued 

 
How it Works 

(cont) 
An additional feature for experienced users is the ability to build calculation 
fields.  None of the folders contain years of service, but using the system date 
and SCD you can build a field called Yrs_of_Svc using the following 
formula:  trunc ((system date - SCD)/365.25).  This would not be used to 
calculate retirement eligibility, but it could be used for projections for large 
organizations.  Users who are building basic inquiries are guided by a Wizard 
through the process and ensure even beginners can obtain useful queries.  
Sophisticated queries including graphs and cross-tabulated reports are also 
available.   
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Using the NPA Maintenance Form 
 

  
Purpose To provide instructions to the HR professional on the use of the NPA 

Maintenance Form in DCPDS.  The NPA Maintenance Form was developed 
as a tool to provide HR professional a mechanism to control the NPAs 
viewable in Self Service for manager/supervisor in “My Workplace”, My 
Employee Information and for employee in “My Biz” My Information under 
the Personnel Actions (PA) tab, in addition to eOPF.  Manager/supervisors 
and employee will be able to view all personnel actions processed.  Using this 
tool will provide the HR professional the ability to control the NPA to view or 
not to view in Self Service and eOPF.   

 
Who Can 
Access    You must have the CIVDOD PERSONNELIST, US FED HR 

MANAGER, CIVDOD NAF PERSONNELIST, or the CIVDOD NAF HR 
MANAGER responsibility to access this maintenance form.   

  
 

 
 

 
Continued on next page 
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Using the NPA Maintenance Form, Continued 

 
Using the NPA 
Maintenance 
Form 

Step Action 
1 To open the NPA Maintenance Form from the Navigation list 

select → NPA Maintenance Form 
 

 
 

2 The NPA Maintenance Form “Search Criteria” opens.   

 
 

 

  
 

Continued on next page 
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Using the NPA Maintenance Form, Continued 

 
Using the 
Maintenance 
Form 

Step Action 
3 Type your search criteria in the SSAN/LN EmpID or, Full Name or 

First NOA or Effective Date data field and Select the Find icon 
below to search for NPA or NPAs.  The wild card % may also be 
used on Full Name and First NOA.   

 
4 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 

a. Select/Deselect All button on the left is used to change ALL 
the NPAs view for employee in Self Service.  

b. Select/Deselect All button on the right is used to change ALL 
the NPAs for transmission to eOPF.  

c. Set to YES button is used to change the NPA view/transmit to 
Yes. 

d. Set to NO is used to change the NPA view/transmit to No. 
e. Find button is used with the above search criteria. 
f. Clear button is used to clear the form. 
g. Update button is used only when the user has selected to 

change the view/transmit NPA for employee to either YES or 
NO. 

 
Note:  Remark Code XYZ has been added to every NOA.  This 
remark code XYZ = DATA CLEANUP DO NOT 
DISTRIBUTE. 
 
CAUTION should be used when using remark code XYZ.  Once 
action has been updated with XYZ, it can not be viewed by 
manager/supervisor or employee in Self Service or listed in the 
NPA Maintenance form.  User will need to reprocess the RPA 
without the remark code to be viewed. 
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Module 2  

Position Management and Classification  
Using the DCPDS 

Module Overview 

  
Purpose This module introduces the information you need to perform the duties of 

position management and classification in the system. 

  
Module Contents  

Module Overview 1 
Who Uses It 2 
How It Works 2 
Business Activities Supported 3 
Business Rules 3 
Assignment Linkage 4 
DoD Organization Hierarchy 6 
Virtual Positions 6 
Use of COREDOC 6 
Terms and Acronyms 6 
Navigation Window Choices 11 

Chapter 1: Building Positions 1 
Fields and Buttons on the Position Window 3 
Navigating to the Position Window 4 
Completing the Position Window and Flexfields 6 
Completing Additional Position Details window  10 
Completing the Extra Position Information                   12 

Validating the Position 15 
Building a Position Organization Address 17 
Building a Virtual Position 22 

Chapter 2:  Managing Positions 1 
Querying Positions 2 
Validating an Invalid Position 9 
Managing the Self Service Hierarchy – Linking Employee 
Positions to Supervisory Positions 

12 

 
Continued on next page 
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Module Overview, Continued 

  
Module Contents (continued) 
 

Chapter 2:  Managing Positions (continued)  
Quick Copying a Position 19 
Querying Position Information from the RPA 23 
Changing Unencumbered Positions 27 
Changing Encumbered Positions 33 
Terminating and Deleting a Position 51 

Chapter 3: COREDOC 1 
Accessing and Navigating in COREDOC 2 
Creating a Core Document 11 
Viewing and Printing an Existing Core Document 42 
Modifying a Core Document 46 
Attaching a Core Document to the RPA 76 

  
Who Uses It 
 

Users are given the roles and responsibilities by their Component for 
performing position management and classification duties.   Users may 
include:   
• Classifiers, Personnelists, and Generalists 
• Managers and Supervisors 

  
How It Works Position Management and Classification interfaces with other  applications, 

such as COREDOC and Resumix, and is intended to: 
• Αutomatically populates most frequently used data. 
• Provide automated tools for managers and personnelists to create, 

modify, and update documentation. 
• Αlleviate the cumbersome process of documentation. 

 
Continued on next page 
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Module Overview, Continued 

  
Business Activities Supported  

 
Activity Roles/Responsibilities 

Administering 
the Program 

The Personnel Office establishes positions, classifies and 
reclassifies positions, processes position actions, and 
reports organization and position information to the Office 
of Personnel Management (OPM). 

Maintaining 
Position 
Classification 
Records 

The system supports this critical function by enabling you 
to: 

• Define jobs using the supplied occupational series. 
• Classify and validate positions with associated 

position descriptions, grades, and occupational 
series. 

• Use COREDOC to generate documents which 
assign grade level, factor pattern, and KSAs 
consistent with the duties for developing a PD, 
recruitment, basic training competencies, and a 
performance management plan.   

• Process position-related actions with the Request 
for Personnel Action (RPA). 

• Represent the reporting relationships within an 
organization through the position hierarchies for 
security purposes. 

   
Business Rules  

Rule Description 
Owned vs. 
Serviced Rule 

If you service positions belonging to another agency, the 
rules of the owning agency will apply in building the 
position, RPA, etc.  
♦  Example:  If Navy services an Air Force position, Air 
Force rules will apply. 

Validity Checks You cannot validate a position until all required data is 
completed and all conditional relationships have been 
met.  
♦Examples:   

• A non-sensitive position cannot require security 
access of Top Secret.   

• Invalid positions cannot be used for assignment. 
 

Continued on next page 
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Module Overview, Continued 

  
Business Rules (continued) 
 

Rule Description 
Assigning a 
CPCN to a Core 
Document 

• Only users with a classifier or personnel generalist role 
can assign CPCNs and edit cover sheets. 

• The Core Document must be attached to the RPA 
before you can assign it a CPCN.  (The CPCN consists 
of the PD# and the Sequence Nbr as they appear on the 
Position "Name" Field, of Position Build Screens.) 

Editing the Cover  
Sheet on the Core 
Document 

A CPCN must be assigned before you can edit the cover 
sheet on the Core Document. 

  
Assignment 
Linkage  

The Assignment area is the link between the following records to populate the 
RPA in DCPDS: 
• Work Structures (Organization, Position Description, COREDOC).  
• People (applicant or employee). 

• Position data from the RPA and the KSAs from the Core Document will 
flow into Resumix for the creation of the fill requisition and vacancy 
announcement, if used, and for use in the evaluation process.  

• Pay and Benefits (Salary, Duty Station, Work Schedule). 
 

 
Continued on next page 



R12                                                                       March 2012 

Position Management and Classification:  Overview                      Mod 2, Overview, Page 5 

Module Overview, Continued 

  
Illustration of the Assignment Linkage  

 
 

Continued on next page 



R12                                                                       March 2012 

Position Management and Classification:  Overview                      Mod 2, Overview, Page 6 

Module Overview, Continued 

  
DoD 
Organization 
Hierarchy 

The DoD Organization Hierarchy is a structure/architecture that depicts the 
highest organization level down to the lowest organization level.   
• Organization Hierarchy begins at the Secretary of Defense level and 

proceeds downward to the installation level. 

Organization Hierarchy is centrally managed and built in the system for each 
Component down to the UIC or PAS Code level.   

  
Virtual 
Positions 

Virtual positions serve as “place holders” to maintain chain of command in 
the hierarchies, e.g., military supervisors of civilian employees.  Also, virtual 
positions may be used for external people in a database.  For example, virtual 
positions could be used for people with remote assignments, such as a 
personnelist located at a region who performs personnel servicing duties for a 
Region other than the one to which assigned as an employee.  See Building a 
Virtual Position in Chapter 1, in this module of the User Guide for additional 
information. 

 
Use of  
COREDOC 

COREDOC is an optional personnel process.  COREDOC-related procedures 
are located in Chapter 4 of this module of the User Guide.   
COREDOC: 

• Replaces the current process of classifying duties and responsibilities 
for position descriptions. 

• Identifies performance elements for employee evaluation. 
• Lists Knowledges Skills and Abilities (KSAs) needed for recruitment. 
• Lists training competencies. 
• Combines the following into one (core) document: 

• Position description. 
• Performance plan. 
• Recruitment and training criteria. 

 
Terms and Acronyms  
 

Terms and 
Acronyms 

 
Definition 

ACTEDS Army Civilian Training, Education and Development System - 
Army's career development program. 

AFSC Air Force Specialty Code. 
AMSC/SSC 
Reqmt 

Army Management Staff College/Senior Service School 
Requirement. 

 
 

Continued on next page 
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Module Overview, Continued 

  
Terms and Acronyms (continued) 
 

Terms and 
Acronyms 

Definition 

AMSCD Army Management Structure Code - Identifies a standard 
classification of activities and functions to interrelate 
programming, budgeting accounting, and manpower control. 

AMSCO National Guard Army funding account code. 
CMIS Corporate Management Information System - A central systemic 

updating (within 24 hours) of regional data for DoD.  Main usage 
is for Component headquarters with viewing and reporting 
capability only.   

COREDOC 
(CD) 
 

         

The application that generates core documents which 
automatically assign the grade level, factor pattern, and KSAs 
consistent with the duties for developing a PD, recruitment, basic 
training competencies, and a performance management plan. 
Note:  Not all Components are using the Performance 
Management Plan.  

Core Document The core document or PD generated by the COREDOC 
application. 

CPCN 
 

Civilian Personnel Control Number - A combination of PD# and 
Sequence Nbr used to attach the core document to the RPA and 
uniquely identify a specific position. 

CPDF Civilian Personnel Data File - An OPM system for storing 
statistical data on all Federal employees. 

DEMO OGC Demonstration Occupational Group Code. 
DEMO SAC Demonstration Specialty Area Code. 
DOT Code Dictionary of Occupational Titles. 
Employee 
Number 

A unique system-generated number to be used for various actions, 
i.e., dual appointments; identifying an employee when not using a 
SSAN, etc. 

FAC Functional Account and Shred – Identifies homogeneous grouping 
of tasks. 

FLSA Fair Labor Standards Act - The Law which requires Federal 
employees to be identified as Exempt (not covered by the Act) or 
Nonexempt (covered by the Act). 

FTM Option Full Time Manning (FTM) Option. 
KSAs 
(Competencies) 

Knowledge, skills, and abilities described in the PD or 
COREDOC.  KSAs are used by Staffing in recruitment 
announcements. 

 
Continued on next page 
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Module Overview, Continued 

  
Terms and Acronyms (continued) 
 

Terms and 
Acronyms 

Definition 

LEO Position 
Indicator 

Law Enforcement Officer Position Indicator - Indicates if the 
employee is an LEO and is located in an interim locality 
adjustment area. 

Mobilization  
Cross Walk 

Identifies employee skills at local employment offices. 
 

Mobilization 
Position Fill 
Code 

Identifies recruiting source used to fill positions during a 
mobilization, e.g. retired civilians, local applicants, retired 
military, etc. 

MOS Military Occupational Specialty. 
MTOE/TDA/ 
SP 

Modification Table of Organization and Equipment/Table of 
Distribution and Allowances/Specific Instance. 

MTOE/TDA/ 
PARA/LN/SP 

Modification Table of Organization and Equipment/Table of 
distribution and allowances/Paragraph and Line Number/Specific 
Instance. 

NPA Notification of Personnel Action - The short term used for 
different Component forms (SF50 for appropriated, DA/NAF 
4343, AF/NAF 2545, and others). 

OCT Reporting 
Flag 

Organizational Component Translation Reporting Flag - Indicates 
the codes, titles and hierarchical relationships for organizations 
within an agency used for the Central Personnel Data File (CPDF) 
sent to OPM. 

Organization 
Hierarchy 

The basic structure of the various organizations comprising DoD.  
This structure identifies organizations starting at the Secretary of 
Defense and continues down through the various Components 
(Army, Navy, etc.) to the installation or activity level in most 
cases. 

HR-Training Human Resource-Training - An application that assists 
management in the administration of civilian training.   It allows 
managers or designated personnel to track and store completed 
training.  

PAS Code Personnel Accounting Symbol - A unique identifier, similar to a 
UIC, used by Air Force to identify major organizational segments.  
Usually, down one level lower than a UIC, to the directorate level. 

 
Continued on next page 
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Module Overview, Continued 

 
Terms and Acronyms (continued) 
 

Terms and 
Acronyms 

Definition 

PD Position Description - A document containing pertinent 
information about the position, i.e., Title, Occupational Series, 
Pay Plan, Grade, list of duties, etc. 

PD# A unique number given by the user to the PD to avoid duplication.  
POI Personnel Office Identifier - A four-character number that 

automatically populates on positions after CCPO ID and Regional 
Code are entered.    

POID Payroll Office Identification. 
Position 
Hierarchy 

The organization structure of an installation or individual unit 
maintained at region level.  This structure identifies, to the lowest 
level, the organizational location of a position.  It is usually 
comprised of organization units such as divisions, branches, 
sections, and units.   

Position’s 
Organization 
Address (POA) 

POA is built at the regional level and is used on the RPA and 
NPA to fill in the position’s address.  It is also used to set up 
Security constraints. 

PRP/SCI Personal Reliability Program/ Sensitive Compartmented 
Information (PRP/SCI) - used to identify positions subject to the 
program or requiring the employee to have this level of security 
clearance. 

Resumix The business process staffing tool that interfaces with the DCPDS.  
It will be used to fill vacancies from external and internal sources. 

RPA The automated Request for Personnel Action (RPA) standard 
form that enables supervisors and managers to request employee 
and position actions.  It enables the Personnel Office to record 
staffing and classification actions, as well as make personnel 
record changes.  It replaces different Component forms, i.e. SF52, 
DA 4017, etc. 

SAC Specialty Area Code used in Demo projects. 
Sensitivity 
Criteria 

Description of access to sensitive areas used with the China Lake 
Demo Project. 

Sequence Nbr System generated unique position identifier; can be up to 15 
characters in length. 

 
Continued on next page 
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Module Overview, Continued 

 
Terms and Acronyms (continued) 
 

Terms and 
Acronyms 

Definition 

TDA Table of Distribution and Allowance. 
 

UIC 
 

Unit Identification Code - A unique identifier for each of the 
major organizational segments (usually an installation or activity) 
in the organizational hierarchy.  UIC is used for all non-AF 
organizations. 
 

Virtual Position The position used as a "place holder" to maintain the hierarchy of 
chain of command, e.g., a military supervisor of civilian 
employees.  The military supervisor does not reside in the DCPDS 
database.  Also used for “external users” who have remote 
assignments and are not in the database as an employee, e.g., a 
personnelist located at a region who performs personnel services 
at another Region and does not reside in that database. 
 

Work Structures The fundamental definitions of organizations, positions, grades, 
payrolls and other employee groups within your agency that 
provide the frame work for defining the work assignments of your 
employees. 
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Module Overview, Continued 

 
Navigation 
Window Choices 

The following table contains the procedure steps with associated windows 
included in this module. 
 
 

Navigation List Associated Window Procedure Steps by Topic 
Work Structures  ∏  Position   
∏  Description 

Position window Building a Position  

  Querying a Position 
  Validating an Invalid Position 
  Quick Copying a Position 
  Building a Virtual Position  
  Changing Unencumbered Positions  
  Terminating and Deleting a Position 
   
Work Structures  ∏  Position 
Organization  ∏  Custom 

Organization window Building a Position’s Organization Name 
(POA) 

   
Request for Personnel Action  ∏  
Appointment  

RPA - Appointment 
window 

Querying Position Information from the 
RPA 

Request for Personnel Action  ∏  
Change Action  ∏  Change in 
Data Element 

RPA - Position Data Changing Encumbered Positions 

   
View  ∏  List  ∏  Employees List Employees by 

Position Hierarchy  
Viewing a List of Employees by Position 
Hierarchy 

   
COREDOC COREDOC 

Applications window 
Creating a Core Document 

 Occupations to Select 
From window 

Modifying a Core Document 

 Core Document 
Selection window 

Viewing and Printing a Core Document 

   
Request for Personnel  
Action  ∏  Recruit/Fill 

RPA - Appointment, 
Page 4 window 

Attaching a Core Document to an RPA 
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Module 2 

Chapter 1 

Building Positions  

Chapter Overview 

  
Introduction This chapter explains the position structures used in the DCPDS.  It outlines 

the data fields used in the required and Component-unique flexfields and 
describes the data to be entered and maintained.     

   
Building a Position 

  
Purpose This section guides you through the steps of building a position.  A position is 

required before an applicant can be appointed.   

    
Section Content   
 

Topic Page 
Before You Begin 2 
Fields and Buttons on the Position Window 3 
Navigating to the Position Window 4 
Completing the Position Window and Flexfields 6 
Completing Additional Position Details window  10 
Completing the Extra Position Information                   12 

Validating the Position 15 
Building a Position Organization Address 17 
Building a Virtual Position 22 
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Building a Position, Continued 

  
Before You 
Begin 

• Business rules related to specific types of positions will dictate required 
data fields. 

• Some of the most frequently used data will be initialized (auto populated) 
from a previous entry when you open the Flexfields.  In most cases, you 
have the ability to override the information if incorrect or if you need to 
change it. 

• You can validate the position at the main position window or at any of the 
Descriptive Flexfield windows, once all the required data has been input. 

• At implementation of DCPDS, Position’s Organization Address (POA) 
will already be loaded and will appear on the LOV in the US Federal 
Position Group 1 Flexfield, when building a position.  After 
implementation, if a new position address is required, you will have to 
build it before a position can be validated.  See Building a Position’s 
Organization Address (POA). 

• For new positions below the UIC or PAS Code level, the POA is updated 
locally.  This information is used to populate the “TO” and “FROM” data 
fields on the RPA and NPA.  It is not directly related or tied to the 
UIC/PAS organization.  

• New positions need to be linked (added) to a position hierarchy.  (See 
Chapter 3, Managing Position Hierarchy of this module.) 

• Decisions before you begin: 

If you are building one of the 
following positions… 

 
Then… 

• In a new organization You need to build a position’s organization 
address (POA) using instructions in this 
chapter. 

• Acquisition  
• Career Program 
• Obligated  
• Demo Project 
• National Guard  

See the Component-Unique Flexfields in 
the Chapter Overview. 
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Building a Position, Continued 

  
Fields and Buttons 
on the Position 
Window 

Some fields and buttons are unique to the Oracle application and are not being 
used by DoD.  Others will be used as you progress through a position build as 
described in the following table. 

 
Fields/Buttons Description/Action 

Dates Region 
 

The system populates the From data field with the 
current date which becomes the effective date (the date 
the position was established).  
Note:  Ensure the effective date is early enough to 
handle any historical information you want to enter. 

Name Region Includes Position Description Number, Title, Sequence 
Number, Agency Number, and Position Type. 

Organization ex:  HQ US Army Corps of Engineers 
Location GSA Location Code, ex:  110010001 (may be 

overwritten if different from the organization location) 
Job Occupational Series, ex:  2005. Supply Clerical and 

Technician 
Status Indicates if the position is Invalid or Valid 
Occupancy  Used to identify the occupant of the position. 
Extra 
Information 

Used to capture extra information pertaining to the 
position. 

Work Choices Used indicate a choice of schedule and location 
preference. 

Validate  Used to change the position status from invalid to valid 
once all required data is entered and all business rules 
are met. 

Others… Displays the Navigation Options window. 
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Building a Position, Continued 

  
Navigating to the Position Window   
 

Step Action 
1 Select your responsibility from the Responsibilities window, i.e., 

CIVDOD PERSONNELIST, etc. 

 
 

2 Select <OK>.  The Navigation List displays. 
3 Navigation Path Work Structures → Position → Description. 

 
 

 
Continued on next page 
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Building a Position, Continued 

  
Navigating to the Position Window (continued) 
 

Step Action 
4 The Find Position window opens. Select the <NEW> button. 

(The Find Position window is also used to query a position.) 
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Building a Position, Continued 

  
Completing the 
Position Window 
and 
Flexfields 
 
 
 

Because of the relational database and Component-unique flexfields, only 
one Component was used in these steps for building a position.  Thus, 
examples provided are generic. 
 
 
Note:  Use all caps (upper case) when completing the data fields for 
consistency. 

 
Step Action 

1 In the Position window, the cursor is on the Start Date data field which 
is the same as the From Date where the current date is displayed.  If 
you need to change it to a prior date, use the Alter Effective Date 
Method:  Select the Alter Effective Date  icon on the Toolbar.  

 
2 The Alter Effective Date window opens with the cursor in the 

Effective Date data field, Change the Date to a prior date, by deleting 
the displayed date and entering a new date (DD-MMM-YYYY). 

 
Select the <OK> button 

 
Continued on next page 
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Building a Position, Continued 

  
Completing Completing the Position Window and Flexfields (continued) 
 

Step Action 
3 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Position window returns with the new Start date. Select in 
the Date Effective Name field. 

 
 

Note:  Once you save the position, you cannot go back and change 
the start date. 

  Data Field Description/Action  
  Position Description No All Caps, up to 15 characters.  

 
 

Caution:  If you build the same position in upper and lower case, 
the system will recognize two separate positions.  

  Title (For consistency, enter all caps,  
(Ex: SUPPLY TECHNICIAN) 

 

  Sequence Number System generated   
  Agency Group The owning Agency Group   

(Example:  ARMC) 
 

  Position Type Example:  APPR (LN.EXT,NAF)  

 
Continued on next page 
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Building a Position, Continued 

  
Completing Completing the Position Window and Flexfields (continued) 
 

Step Action 
4 
 

The Position Flexfield window opens.  [Tab] to each data field and 
type in information and use the LOV’s to enter data. Select the <OK> 
button 

 
There are Four buttons at the bottom of each flexfield. 
<OK> - Enters the data and moves to the next window. 
<Cancel> - Exits the window without entering data. 
<Clear> - Deletes entered data. 
<Help> Will open your on-line help window for more information. 

 The Position window displays the populated Name field. 

 
5 
 

Click in the Organization data field and then Select the LOV’s icon to 
invoke window. Place the % in the Find data field and Select 
the<Find> button, Highlight the organization for this particular 
position. Select the<OK> button. 

 
 

 
Continued on next page 
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Building a Position, Continued 

  
Completing Completing the Position Window and Flexfields(continued) 
 

Step Action 
6 Click in the Job data field and then select the LOV’s icon to invoke 

window. Place the % in the Find data field and Select the<Find> 
button, Highlight the Job this particular position. Select the<OK> 
button. 

 
 The Position window displays the populated Organization and Job. 

 
• Organizations are centrally maintained at the UIC Level and 

PAS Code Levels.  
Contact your Component for adding organization to the list. 

 
 

The Location (GSA Location) is auto populated from the selection of 
the organization. 
Note:  If the duty location is different from the organization location, 
you can override it with the correct duty location. 

7 Click in the Descriptive Flexfield “[  ]” to add additional position 
details. 

 
 

Continued on next page 
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Building a Position, Continued 

    
Completing Additional Position Details Window  
 

Step Action 
8  
 
 
 
 
 
 
 
 
 
 
 
 

The Additional Position Details window opens. [Tab] to each data 
field and type in the information or use the LOVs to enter data. 

 
Note:  The Servicing Office ID and Region fields must be consistent 
to enable automatic population of Personnel Office ID in the US 
Federal Position Group 1 Flexfield. 

  Data Field Description/Action  
  Servicing Office ID e.g. AG  
 Servicing Agency e.g. AR  

Region e.g. ARNE 
Unit ID Code Not used by AF and 

Air National Guard 
PAS Code  Used AF and Air 

National Guard 
Mobilization 
Indicator 

e.g. B 

Remarks Optional - enter 
freeform text (Used 
by Components for 
tracking purposes 
and will only show 
on this window.) 

  Vacancy Indicator Defaults to 0  
  Payroll System Defaults to D  

 
Continued on next page 
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Building a Position, Continued 

  
Completing Additional Position Details Window (continued) 
 

Step Action 
8 

(cont) 
Note:  Product Distr Instructions and Report Distr Instructions 
are based on Servicing Office ID and automatically populate 
during the initial entry.  If you do not override (manually change) 
the defaults of these two elements, subsequent changes 
automatically populate them. 

 
Caution:  However, if you do override either of these two 
elements, and later change the Servicing Office ID, you must 
ensure the codes are correct and make changes if required. 

9 Select the<OK> button.  The Position window displays the 
populated Descriptive Flexfield  

 
10 After Selecting the OK button the Hiring Information window 

will open displaying FTE.  The number 1system generates in this 
data field as well as the Headcount data field. Select the Positions 
Details Tab to return to the Position Details window. 

 
11 Select in the Status data field and select Active from the LOV. 

      
12 Select the Save   icon on the toolbar.  The Message Line 

indicates:  “Transaction complete:  1 record applied and saved.” 

 
13 Select the <Others> button at the bottom of the Position window. 

  
Continued on next page 
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Building a Position, Continued 

 
Completing the Extra Position Information   
 

Step Action 
14 

 
 
 
 
 

The Navigation Options window opens.  Use the Find function to 
select your agency.     

 
Select the <OK> button. 

15 Once you have selected the Agency from the Navigation Options 
window, the Extra Position Information Flexfield window opens 
with position types. Select the necessary Type. For example, Air 
Force Appropriated/Local National.  

      
Note:  Display of segments may be different for each Component.  
And may be bypassed if not applicable to the position you’re 
building, 

16 Double Select in the Details data field to open the Extra Position 
Information window.    

 
 

Continued on next page 
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Building a Position, Continued 

  
Completing the Extra Position Information (continued) 
 

Step Action 
17 
 
 

 
 
 
 
 
 

Tab through each Data field and enter the appropriate information 
for this particular position. Select the <OK> button. 

 
The Extra Position Information Flexfield window opens displaying 
the populated data in the Details field. 

 
Note: Although <Validate> is on the window, the position cannot 
be validated until all required data is entered. If you try to validate 
the position and the required data is incomplete. You will receive a 
Note Messages similar to the one below.  

 
You will need to make all necessary corrections before validating. 

  
Continued on next page 
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Building a Position, Continued 

  
Completing the Extra Position Information (continued) 
 

Step Action 
18 Continue to follow the previous step for all necessary Types. 

 
19 Select the Save icon on the toolbar and close window. 

 
 

Continued on next page 
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Validating the Position 
 

 
Validating the Position  
 

Step Action 
20 On the last Extra Position Information window, Select the 

<Validate> button.  
 If… Then…  

  If the 
Position 
doesn’t 
validate. 
 
 
 
 
 
 
 
 

You will receive a dialog box with an error 
message of data fields to fix.  Retrieve the 
Flexfield(s) and make corrections.   
 
Note:  You may refer to the List of Position Data 
Fields with Associated Flexfield windows in the 
Module Overview or in the Appendix:  Position 
Data for Components/Agencies. 
 
After correcting, Select Validate on the Extra 
Information Flexfield to simultaneously save 
your changes and validate the data.  Repeat until 
the Position window displays “Valid” in the 
Status Box. 

 

  If... Then…  
  The 

position 
validates 
 

The Status Box on the Position window will 
change from “Invalid”   to 
“Valid” . 
 

 

21 Select Save.  You can now use the validated position for processing 
position-related RPAs. 
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Validating the Position, Continued 

  
Exiting the Position  
 

Step Action 
1 
 

Caution:  If you used the Alter Effective Date window to change the 
effective date of this position, Select it again and Select “Reset” to 
change the system date back to the current date. 

2 Select the X at the top right hand corner on the Position window to 
return the Navigation List. 
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Building a Position’s Organization Address (POA) 

 
Purpose 
 
 

This section explains how to build a Position’s Organization Address 
(POA).  

 
In This Section The following topics are discussed: 

• Accessing and Completing the Organization window. 
• Completing the Organization Classifications Flexfield and Completing 

the US Government Organization Report Information. 

    
Definition Position’s Organization - populates the “TO” and “FROM” data fields on the 

Request for Personnel Action (RPA) and the Notification for Personnel 
Action (NPA).  The position’s organization is the “address” of the position, 
equivalent to the Table 30 in Legacy; the one POA code is also know as an 
“Org Component”.  

• When you build the position address, it will be available in building a 
position for a new organization.  

• The Position’s Organization data field is located in the Extra Position 
Information window in the US Government Position Group 1 
Flexfield window. 

    
Who Uses and 
Maintains  

HR Professionals designated by their Component will maintain and use the 
POA. 
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Building a Position’s Organization Address (POA) 

   
Accessing and Completing the Organization window   
 

Step Action 
1 Navigation Path → Work Structures → Organization → Custom 

→ <Open>. 
2 The Find Organization window opens. Select the <New> button 

 
3 The Organization window opens with the From Date data field 

auto populated and the Internal or External data field populated 
with “Internal”.   

 
4 
 

In the Name data field on the Organization window, Type in a 
unique name to identify the position’s address (Ex: AETC-CPCH). 

 
Note:  If you built the position earlier, or will be effecting the 
action prior to the current date, set the Alter Effective Date   
to match, otherwise, you will get a “Date warning message”. 
 
Do not complete Location or Location Address.   

 
Continued on next page 
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Building a Position’s Organization Address (POA), Continued 

 
Accessing and Completing the Organization window (continued) 
 

Step Action 
5 After entering a Name, tab to “Type” select an Organization Type 

from the LOV’s,  

 
Select <OK> and Save work. 

6 Select in Organization Classification Name data field. 

 
“HR Organization” replaces “Position’s Organization” in the 
previous data field and “Position’s Organization Address” 
populates the following data field.  Both Enabled check boxes are 
now activated.  

7 Select the LOV’s icon to open the Organization Classification 
window. Highlight the correct Organization and Select the<OK> 
button. 

 
  

Continued on next page 



                                                                                                                    R12                                                                                     March 2012 

Position Management and Classification:  Building Positions             Mod 2, Chap 1, page 20 

Building a Position’s Organization Address (POA), Continued 

 
Completing the Additional Organization Information Flexfield  
 

Step Action 
8 Select the Enabled box to enable organization. 

 
9 

Select the Save Icon  in the main menu bar. 
10 Select the <Others> button to open The Additional Organization 

Information window.  Select the US Federal Org Report Info.  
Select the <OK> button.   

 
 

11 The Additional Organization Information window opens. Double 
Select the blank data field. 

 
 

Continued on next page 
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Building a Position’s Organization Address (POA), Continued 

  
Completing the Additional Organization Information Flexfield (continued) 
 

Step Action 
12 Skip the first 2 POA blocks, Enter address then Select the <OK> 

button 

 
13 The Additional Organization Information detail is populated 

with the position’s organization Address. 

 

Select the Save  icon. Then Select the <OK> button. 
14 The Organization window opens.  The new Position’s 

Organization Address (POA) is now available in position by 
Selecting the LOV for Position’s Organization in US Government 
Position Group 1 Flexfield window.  

 
14 Select  to close the window. 
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Building a Virtual Position 

  
Purpose This section explains how to build virtual positions.  Virtual positions are 

required for: 
• Placeholders for a military supervisor. 
• External users who have a need to be in the database to perform their 

duties, but are not assigned to an organization in the database.   
 
An example of a Navy military virtual position is being used for illustration 
purposes. 

         
Before You 
Begin 

Virtual positions are: 
• Required when supervisors of civilian employees are not in the database, i.e., 

military supervisors of civilian employees (Job series = 0002; Type = MIL). 
• Required for external users, i.e., HR Personnelists performing servicing 

duties for a region other than the one to which assigned as an employee (Job 
series = 0003; Type = EXT). 

Note:  Based on work assignments, an HR Personnelist who services employees 
in a different region will be assigned two positions:  

1.  A regular position at the work site with appropriate Job series. 
2.  A virtual “external user” position in the database at a different region 
than the one assigned to with a Job series of 0003. 

• All the data fields are not required as they are for an appropriated position. 
• The position must be placed in the hierarchy to maintain chain-of-command. 
• If you have only one civilian position, i.e. secretary, who reports to a military 

supervisor, you will still need to build a virtual position for the military 
supervisor. 
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Building a Virtual Position, Continued 

    
Completing the Position Window (Ex:  Navy Virtual Position)  
 

Step Action 
1 Navigation Path → Work Structures   → Position → Description 

→ <Open>. 
2 The Find Positions window opens. Select the <NEW> button 

 
3 In the Position window, Select in the Date Effective Name field. 

 
4 
 
 
 
 
 

 

The Position Flexfield window opens.  Use all caps in the Position 
Description No field, Then tab to each field and use the LOV’s to 
enter the data. 

 
Note:  Remember this number if you want to retrieve the position 
later. 
Caution: If you use all upper or all lower case in the position name, 
the system recognizes them as two separate positions.   

 
Continued on next page 
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Building a Virtual Position, Continued 

  
Completing the Position Window (Ex:  Navy Virtual Position) (continued) 
 

Step Action 
4  

(cont) 
Agency Group:  This is the owning Agency, i.e., NV09.  (Block 47 
on the NPA). Select the Agency and Select the <OK> button 

  
5 The Position window reopens.  Select the cursor to the 

Organization data field. 

 
6 
 

Select the LOV’s icon to open the Organization window. Place a % 
in the Find window, then Select the <FIND> button. 

 
 

Continued on next page 
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Building a Virtual Position, Continued 

 
Completing the Position Window (Ex:  Navy Virtual Position) (continued) 
 

Step Action 
7 Highlight the Organization of choice and then Select the <OK> 

button 

 
8 
 
 
 
 

The Position window reopens with the Organization data fields 
populated. 

 
Note:  Organizations are centrally maintained at the UIC (specific to 
all DoD components except Air Force) and PAS Code (specific to 
Air Force and Air National Guard) level.  Contact your Component 
for adding an organization not on the list. 

9 The Location data field auto populates from the selection of the 
organization.  

 
10 Select the cursor to the Job data field.  Enter the four digits of the 

occupational series (for military: 0002; external user: 0003) and 

Press Enter or select the LOV’s icon  to open the Job window to 
make the selection. 

 
Continued on next page 
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Building a Virtual Position, Continued 

  
Completing the Position Window (Ex:  Navy Virtual Position) (continued) 
 

Step Action 
11 The Numerical Code and Occupational Series displays. 

 
12 Select the Descriptive Flexfield “[  ]” to add additional position 

details.  

13 
 

The Additional Position Details window opens. Tab to each data 
field and use the LOV’s to enter the appropriate data.  

 
Select the <OK> button 
Note:  Product Distr Instructions and Report Distr Instructions 
are based on Servicing Office ID and populate during the initial 
entry. 

 
Caution:  If you do not manually change the defaults of these two 
elements, subsequent changes populate them.  However, if you do 
override either of these two elements, and later change the 
Servicing Office ID, you must ensure the codes are correct and 
make changes if required. 

14 The Position window reopens. Place the cursor in the Status data 
field and Select the LOV’s icon to select an Availability Status. 

   
Select the <OK> button. 

 
Continued on next page 
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Building a Virtual Position, Continued 

  
Completing the Position Window (Ex:  Navy Virtual Position) (continued) 
 

Step Action 
15 Select the Save icon  in the main menu to save work. 
16 Select <Others> button on the Position window.  The 

Navigation Options window opens.  
17 Select the Virtual Position and Select the <OK> button. 

 
18 The Extra Position Information Flexfield window opens. 

Select in Details Box. 

 
 

Continued on next page 
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Building a Virtual Position, Continued 

  
Completing the Position Window (Ex:  Navy Virtual Position) (continued) 
 

Step Action 
19 There are four required data fields:  POI, Organization Structure 

ID, Supervisory Status and Positions Organization.  Tab to each 
data field using the LOV’s to enter the appropriate information.  

 
Select the <OK> button. 

20 Select the Save icon  from the main menu to save work. 
21 Select the <Validate> button in the position window. 

22 Select the X on the top right-hand corner of the window to return 
to the main Position window. 
The Status is now “Valid.”   
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 Module 2 

Chapter 2 

Managing Positions 

Chapter Overview 

   
Introduction This chapter contains information for managing positions in the database.  It 

includes procedure steps for retrieving, validating, quick copying, as well as 
correcting and updating encumbered and unencumbered positions.  It also 
outlines how to terminate and delete positions.  Instructions for managing 
positions in position hierarchy are discussed in this module in Chapter 3. 

    
Chapter Contents  
 

Topic Page 
Querying Positions 2 
Validating an Invalid Position 9 
Managing Self Service Position Hierarchy 12 
Quick Copying a Position 19 
Querying Position Information from the RPA 23 
Changing Unencumbered Positions 27 
Changing Encumbered Positions 33 
Terminating and Deleting a Position 51 
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Querying Positions 

  
Purpose This section guides you through the querying options for retrieving previously 

built positions and verification of position occupancy.  

   
Section 
Contents 

• Accessing the Position window 
• Querying All Positions in the Database 
• Querying a Specific Position 
• Verifying Who Occupies the Position 

  
Before You 
Begin 

Examples of when you will use this procedure: 
• You start to build a position, but get interrupted before you validate it. 
• You want to quick copy a position in the database.  
 
You can query on the Position window by selecting any of these data fields:  

• Name 
• Type       
• Hiring Status                
• Job 
• Organization 
• Location 
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Querying Positions 

  
 
Querying All Positions in the Database  

 
Step Action 

1 Navigation Path  →  Work Structures  →  Position  →  Description  
→ <Open>. 

2 The Find Position window opens. To Query all positions within the 
Data base select the <FIND> button. 

 
When the Position window opens scroll through the positions with 
the up or down arrow keys until you reach the position you need. 
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Querying Positions, Continued 

  
Querying a Specific Position 
 

Step Action 
3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To Query a specific position perform any of the following procedures: 
 
Within the Find Position window, place your cursor in Name.  This will 
allow you to search by Position Description No., Title, Sequence Number, 
Agency Group or Type.   
 

 
 
Note: The Query function is case sensitive and will only retrieve values 
identical to your search criteria.  The “%” can be used at the beginning, 
and/or ending of your search value as a wild card character. 
 
Example:  HUMAN RES% will retrieve all positions beginning with 
“HUMAN RES”, but will not retrieve positions built in mixed case, i.e. 
“Human Res.”  “%UMAN RES%” will also result in all “HUMAN RES” 
position titles, as well as “ASSISTANT HUMAN RES” due to the 
preceding wild card character. 
 
Scroll through the listing of retrieved positions in order to locate your 
specific position. 
 

 

Continued on next page 
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Querying Positions, Continued 

  
Querying a Specific Position (Continued) 
 

Step Action 
4 Place cursor in the Type field and select the LOV’s icon to open the 

Position Type window. 

 
Highlight a Type select the <OK> button. 

 

Then select the <FIND>  button. Oracle will then 
retrieve all positions with that Type. 

5 Place the cursor in the Job data field; select the LOV’s icon to open 
the Job window. 

 
Highlight a JOB select the <OK> button. 

 

Then select the <FIND>  button. Oracle will then 
retrieve all positions with that Job Type. 

 

Continued on next page 
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Querying Positions, Continued 

  
Querying a Specific Position (Continued) 
 
 

Step Action 
6 Repeat the Process described in 1A, 1B or 1C. By placing the 

cursor in any of the data fields found on the Find Position window 
and utilizing the LOV’s to make you selection.  You can query any 
multiple combinations of Positions.  

 
 

 
Always conclude the Query by selecting the <FIND> button. 
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Querying Positions, Continued 

  
Verifying Who Occupies the Position  
 

Step Action 
1 After the position has been queried and the Position window opens, 

select the <Occupancy> button at the bottom of the window to verify 
who encumbers this position.  

 
2  The Position Occupancy window displays the current or past 

incumbent(s), with beginning and end dates for each. 

 
 

Continued on next page 
 
 
 
 
 
 
 

Last Name, Fir st Name 
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Querying Positions, Continued 

  
Verifying Who Occupies the Position (Continued) 
 

Step Action 
3 To retrieve more information on the incumbent, select the 

<PERSON> button. This will open the People window. 
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Validating an Invalid Position 

   
Purpose 
 
                  
 

This procedure shows how to validate an invalid position and change the 
status to “Valid”. 
 
Note:  Only validated positions can be used with the RPA. 

   
Section 
Contents 

• Querying the Invalid Position  
• Validating the Position 
• Making Corrections if the Position does Not Validate 

   
Before You 
Begin 

• When building or changing position data in the Position window, the 
status of the position is “Invalid” until all required data is entered and all 
business rules are met. 

• When you select the <Validate> button, the system applies business rules 
that check the data for errors and inconsistencies.  For example, if the 
Grade and FLSA designations are not compatible, an error message will 
appear.  You must then correct the information and validate the position.  

• Once the position is “Valid,” remember to link it to the position hierarchy.  
(See Chapter 3 in this module) 

• After you validate the position, you can use it when processing position-
related RPAs. 

 
Continued on next page 
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Validating an Invalid Position, Continued 

    
Querying the Invalid Position (Continued)  
 

Step Action 
1 Navigation Path  →  Work Structures  →  Position  →    

Description  →  <Open>. 
2 The Find Position window opens.  You can query using any of the 

fields available, or close this window by selecting on the X in the 
right hand corner of the box to return to the main Position screen. 
 

3 On the main Position Screen, press the F11 key to begin your 
query.  Enter your search criteria into the available fields you wish 
to query against, and press Ctrl + F11 to execute your search. 

4 If you entered a partial value, a value including the “%” wild card 
value, or if you are searching against all positions, scroll through 
the LOV in order to find your position. 

5 Once you have located the position and you are in the Position 
window, select the <Validate> button.  If there are no 
inconsistencies or errors in the position, the Status data field 
changes from “Invalid” to “Valid.” 

 
Select the Save icon in the main menu bar. 
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Validating an Invalid Position, Continued 

  
Making Corrections if the Position Does Not Validate  
  

Step Action 
6 If the position doesn’t validate, you will receive an Error message. 

 
The error message informs you what needs to be corrected.  

7 Select <Others> button at the bottom of the window.  To open the 
Navigation Options window. 

 
8 Select the appropriate Option and select the <OK> button 
9 As a convenience, the <Validate> Task flow button also appears 

on the Extra Information window.  

 
After correcting the information in the flex fields, Save your work 
then select the <Validate> button. 
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Managing the Self Service Hierarchy - Linking Employee 
Positions to Supervisory Positions 

  
Purpose To fully implement Self Service Manager Views, “My Workplace”, Self 

Service Hierarchy must be created and in place.  The Position, Others, 
‘Reporting To’ form is useful when linking a subordinate position to a 
supervisory position within a Self Service Hierarchy. 
 

   
Section 
Contents 

• Querying a valid subordinate position to ‘link’, via Position, Others, 
‘Reporting To’ an employee position to a supervisory position. 

• Creating a Self Service Hierarchy 

     
Before You 
Begin 

It is extremely important that the user be cautious when using this tool as the 
capability to disconnect the hierarchy, create orphan records within the 
hierarchy, or attach positions to the wrong hierarchy is a high possibility.   
 
Advance preparation and information collection is extremely important.  
Organization charts or lists of positions that follow an organizational line of 
authority are highly desirable and advantageous to the user making the 
changes. 

 
Who Has Due to the sensitivity of the Position, Others “Reporting To” it can only be 
Access utilized when using Position Description in the CIV DOD Self Service 

Hierarchy Manager responsibility. 
 
 

Continued on next page 
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Managing the Self Service Hierarchy - Linking Employee 
Positions to Supervisory Positions, Continued 

 
Establishing a Self Service Hierarchy  
 

 

Step Action 
1 Navigation Path CIVDOD Self Service Hierarchy Manager → Position 

Description.     

 
2 Query the subordinate position which you will link the ‘Reporting To’ 

supervisory position to then select ‘Others’. 

 
Note:  The position being selected must be valid and encumbered. 

3 Select ‘Reporting To’.   

 
 

Continued on next page 
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Managing the Self Service Hierarchy - Linking Employee 
Positions to Supervisory Positions, Continued 

 
Establishing a Self Service Hierarchy (Continued) 
 

 

Step Action 
4 The ‘Reporting To’ window displays.  If Hierarchy and Name are null 

the subordinate position does not exist in the Self Service Hierarchy.   

 
5 Since the Self Service Hierarchy is the structure used to support the “My 

Workplace” views, enter “Self Service” in the ‘Hierarchy’ data field. 

 
6 Enter the “Name” of the supervisory position.  This is the “position name” 

of the person the subordinate position reports to.  In this example, the 
Food Service Worker position is “reporting to” the Cook Supervisor in 
Self Service Hierarchy. 

 
A position will only display in “My Workplace” correctly if this area of 
the position is properly completed.   

 
Note:  In order to ‘link’ a subordinate position to a supervisory position, 
the supervisory position must already exist in a hierarchy. 
 

 

  

Supv Position 
Hierarchy 

Employee 

Supervisory 
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Managing the Self Service Hierarchy - Deleting ‘Link’ from 
Employee Positions  

  
Purpose To fully implement Self Service Manager Views, “My Workplace”, Self 

Service Hierarchy must be created and in place.  The Position, Others, 
‘Reporting To’ form is useful when deleting a Self Service Hierarchy link 
from a subordinate position to a supervisory position.  
 

   
Section 
Contents 

• Querying a valid subordinate position to delete ‘link’, via Position, 
Others, ‘Reporting To’ to a supervisory position. 

• Deleting Self Service Hierarchy 

     
Before You 
Begin 

It is extremely important that the user be cautious when using this tool as the 
capability to disconnect the hierarchy, create orphan records within the 
hierarchy, or attach positions to the wrong hierarchy is a high possibility.   
 
Advance preparation and information collection is extremely important.  
Organization charts or lists of positions that follow an organizational line of 
authority are highly desirable and advantageous to the user making the 
changes. 

 
Who Has Due to the sensitivity of the Position, Others “Reporting To” functionality, HR 
Access Professionals with a CIV DOD Self Service Hierarchy Manager responsibility 

should only execute the deleting of Self Service Hierarchies. 
 
 
Deleting a Self Service Hierarchy   

Step Action 
1 Navigation Path CIVDOD Self Service Hierarchy Manager → Position 

Description 

 
 

Continued on next page 
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Managing the Self Service Hierarchy - Deleting ‘Link’ from 
Employee Positions, Continued 

 
Deleting a Self Service Hierarchy (Continued)  
 

 

Step Action 
2 Query the subordinate position which you will delete the ‘Reporting To’ 

supervisory position from and then select ‘Others’. 

 
Note:  The position to which you are deleting the supervisory hierarchy 
from must be valid and unencumbered. 

3 Select ‘Reporting To’.   

 
4 The ‘Reporting To’ window displays.  If Hierarchy and Name are null 

the position queried is not linked to a supervisory position (therefore does 
not exist in the Self Service Hierarchy).   

 
 

Continued on next page 
 

Supv Position 

Hierarchy 
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Managing the Self Service Hierarchy - Deleting ‘Link’ from 
Employee Positions, Continued 

 
Deleting a Self Service Hierarchy (Continued)  
 

 

 
Step Action 

5 As discussed above, the “Name” of the supervisory position (for the 
subordinate position queried) is located under the “Name” field below.  
This is the “position name” of the person this position reports to.  After 

reviewing the supervisory position, users much select on the “ ” icon 
to delete this record from the Self Service Hierarchy. 

 
6 

After selecting the delete “ ” icon, the decision message below will 
appear. Select “Yes” to continue or “No” to return to ‘Reporting To’ 
window. 

 
 
 

Continued on next page 
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Managing the Self Service Hierarchy - Deleting ‘Link’ from 
Employee Positions, Continued 

 
Deleting a Self Service Hierarchy (Continued) 
 

 

 
Step Action 

7 Select “Yes” to continue deleting the supervisory ‘Reporting To’ position 

and select save “ ”. 

 
Figure 12 

 
8 After selecting save, the following message will appear on the bottom left 

of the window. 

 
Figure 13 

 
Note:   Encumbered valid positions can only be updated into a Self 
Service Hierarchy by using the CivDOD Self Service Hierarchy 
responsibility. 
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Quick Copying a Position  
 

  
Purpose This procedure documents how to Quick Copy up to 10 copies of a validated 

position.  

   
Section 
Contents 

• Querying the Position to Copy 
• Making Job or Organization Changes 
• Modifying and Quick Copying 
• Using Cut and Paste Method for Querying  
• Validating the Quick Copied Position (s) 

     
Before You 
Begin 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• If you are making a Quick Copy of a position, you need to know how to 
retrieve it and ensure a thorough review of the position data elements is 
completed.  Ensure positions being Quick Copied are valid.   

• On the Position window at the Name field, query the position using one 
or more of the following unique position identifiers: 
• Sequence Number 
• Organization 

• You will need to validate each position that you Quick Copy. 
• You can Quick Copy: 

• Similar positions and make the minor changes needed before 
validating. 

• ‘Add’ or ‘Replace existing positions into a Self Service Hierarchy 
• An encumbered or vacant position. 
• Other “Quick Copied” positions. 

 
Note:  The CIVDOD Self Service Hierarchy Manager responsibility will 
be used to illustrate the Managing of the Self Service Hierarchy and 
Quick Copy functionality in the example below.   
 
You cannot change the Organization, Job (occupational series), or Date 
Position Established (which defaults to the current date) on the copied 
position(s), so if you need to change any of those items, you must do it on the 
Quick Copy Current Position window before clicking the <Quick Copy> 
button.  Likewise, if you are making more than one copy, each must have the 
same value for those items  

Continued on next page 
 
 
 
  



                                                                                                              R12                                                                                      March 2012 

Position Management and Classification:  Managing Positions       Mod 2, Chap 2, Page 20 

 

Quick Copying a Position, Continued  

 
 
Querying the Position to Copy  
 

Step Action 
1 Quick copy is used to create new copies of an existing valid 

position in DCPDS.  Navigation Path CIVDOD Self Service 
Hierarchy Manager → Work Structures → Position → Position 
Description.   

   
 
 

2 Query and review the position to be copied.  Ensure the position is 
a Valid position. Select ‘Others’, ‘Quick Copy’. 

.     
Select ‘Others’, ‘Quick Copy’. 

 

Continued on next page 
 
 
  



                                                                                                              R12                                                                                      March 2012 

Position Management and Classification:  Managing Positions       Mod 2, Chap 2, Page 21 

Quick Copying a Position, Continued  

 
 
Querying the Position to Copy (Continued) 
 

 

Step Action 
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3 Review Original Position Attributes and if necessary change any or all 
of the key data elements on the Quick Copy form:  
 
Hierarchy Options Region: 

• Replace:  replaces the original position with the copied position in 
the current hierarchy structure 

• Add:  adds the copied position(s) to the current hierarchy (allows 
up to 10 copies). 

• No hierarchy change – no hierarchy information will be in the 
copied positions (up to 10).  Hierarchy information will need to be 
added to the copied positions before they can be validated. 

 
New Position Attributes Region:  

• Organization:  click the Organization button and enter 
Organization or enter part of the organization name in the 
Organization field (using % search) and then push the [Tab] key. 

• Job –Series:  click the Job button and using the % search, select 
the new series from the LOV. 

• Start Date Position Established:  the current system date 
autopopulates, click in the ‘Start Date’ field and change the date. 

• Enter the Number of Copies. 
• In sourcing Information:  For those positions being identified as 

‘Insourcing, click in the box ‘Select Box if position being created 
is a newly in-sourced position. 

 
After reviewing and updating position information (if necessary), select 
the ‘Copy’ button.  

 
 

 

Continued on next page 
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Quick Copying a Position, Continued  

 
 
Querying the Position to Copy (Continued) 
 

 

Step Action 
4 On the New Copied Positions Window, take note of the sequence 

number(s) of the new positions so you can retrieve them.   
 

`  
5 From the position window, retrieve the quick copied position, and select 

‘Validate’ button.  The ‘Status’ field now reflects ‘Valid’. 
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Querying Position Information from the RPA 

  
Purpose This procedure guides you through the steps for retrieving a list of the 

positions in your database using the RPA Appointment Window.  

  
Information 
Displayed 

The following items display on the list:   
• Position Title 
• Occupied (Yes/No) 
• Pay Plan 
• Occ Series 
• Grade 
• Organization Name 
• Position Number 
• Position Sequence Number 
• Agency Code/Sub Element 

  
Section Contents • Accessing the RPA 

• Using the RPA Appointment Window to Retrieve Position 
Information  

    
Before You 
Begin 

This method of retrieving position information would normally be used for 
appointing someone to a position.  It is being provided in this section as a 
handy tool to access the position information in your database by Position 
Title.  

Note:  You can also access the rest of position flexfields by selecting the 
<Position> Taskflow Button on the RPA Window. 

 
Continued on next page 
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Querying Position Information from the RPA, Continued   

 
 
Retrieving Position Information by Using Position Title  
 

Step Action 
1 Navigation Path ∏  Request for Personnel Action  ∏  

Appointment  ∏   <Open>.  This will open the RPA-Page 1 
Requesting Info window. 

2 Select the Position Data tab to access page 2. 

 
 

3 The Position Data window (Page 2 of 4) opens.  The cursor 
defaults to Position Title data field.  Select the LOV icon. 

 
 

Continued on next page 
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Querying Position Information from the RPA, Continued 

  
Retrieving Position Information by Using Position Title (continued) 
 

Step Action 
4 The Position Title window opens, Enter the first few characters of 

the title of the positions you want to view, i.e. “Sec” for Secretary 
or enter a % sign to view all positions in your database.  Select 
<OK>. 

 
5 The To Position LOV’s window opens. Use the bottom scrollbar 

to view all the information in the list, in addition to Position Title, 
i.e., Occupied (Yes/No), Pay Plan, Occ Series, Grade, 
Organization, etc. Select the position and select the <OK> button 

 
Note: If you know the sequence number of the position you would 
like to view, you can enter it into the “Find” area of the LOV, after 
the % used in your initial search. 
Example using illustration above:  PERS% was originally entered 
to receive this partial listing.  If you know the sequence number 
that you are attempting to find equals “1234”, you can find it by 
entering it immediately after “PERS%.”  The find box will then 
appear as “PERS%1234”, and this specific position will populate 
to the RPA immediately upon pressing the “Find” button. 

 
Continued on next page 
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Querying Position Information from the RPA, Continued 

  
Retrieving Position Information by Using Position Title (continued) 
 

Step Action 
6 Follow this decision logic table to proceed. 

 If you do not want to view 
a specific position: 

If you want to view a specific 
position: 

 

  Select Cancel and exit the 
RPA Window, by selecting 
Action on the Main Menu 
then select Close Form to 
return to the Navigation 
List. 

• Select the position you want 
to retrieve.  

• Select <OK>. 
The RPA Window displays with 
the Position Title and Position 
Data filled in. 
To view more information: 
• Select <Position>.  
The modified Position Window 
displays.  
• Select the Descriptive 

Flexfield ([ ]) and select 
<Others…> to see the Extra 
Information Flexfields. 
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Changing Unencumbered Positions 

  
Purpose This section guides you through the steps for changing unencumbered 

positions that have never been occupied.  You “correct” data if the change is 
made on the same day as the effective date.  You “update” data if the change 
is effective after the effective date. 

  
Section 
Contents 

• Correcting and Updating  
• Before You Begin 
• Accessing the Position Window 
• Querying the Position  
• Correcting or Updating Position Data 

  
Correcting and 
Updating 
Position Data 

If you are correcting or updating position information, you need to take into 
consideration these situations and timeframes:  

 
 Timeframe   Timeframe  

Situation And, it’s the same day (date 
the position was established), 
then… 

And, it’s a later date, then… 

Erroneous 
information was 
entered while 
building a position 
Example:  FLSA 
was initially 
entered incorrectly. 
A change occurs to 
the data that was 
entered after the 
position was built. 
 
 

Retrieve the position and 
override the data. 
 
 
 
 
 
 
 
 

 

Retrieve the position, use the 
Alter Effective Date Button 
and enter the effective date (the 
date you built the position).  
Correct the FLSA data by 
overriding the erroneous data in 
the position record.   
(date the information becomes 
in effect, or valid).  “Update” 
the data by changing the data in 
the position record. 
Caution:  If you don’t reset the 
date, the next action you take 
will be effective on the altered 
date of your last action. 

 
Continued on next page 
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Changing Unencumbered Positions, Continued 

  
Correcting and Updating Position Data (continued) 

 
Before You Begin              

 

 
Caution:   
• You should carefully evaluate each data item before changing a position. 
• Before making any changes, consider eliminating or deleting and build a 

new position. 
 
Examples:  Eliminate ends the record on the date you enter in the To data  

field on the Position Window.  From that date forward, this end  
date displays in the To data field. 
 
Deleting removes any history of the record and can only be 
accomplished on a position that has never been occupied. 
 

 Information about locations, organizations, jobs, positions, grades, pay tables, 
and other work structures is referred to as “dated” information as opposed to 
“DateTracked’ information used with employee actions.  Dated information is 
maintained in the database to keep a history of actions over time.  Previous 
versions of the position record may be viewed through the use of the Alter 

Effective Date button    on the Toolbar. 
  
 

Continued on next page 
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Changing Unencumbered Positions, Continued 

  
Correcting and Updating Position Data (continued) 

 
 
 
 
 
 
 
 
 

• Changes to the position record are reflected through the use of the From and 
To Dates on the Position Window : 
• The From Field is used to show when the date the position becomes 

effective  in its current state (or the date established). 
• The To Field is used to assign an end date when you terminate a position.  

When “date tracked”, the To date will indicated the end date of the 
position in its state as you are viewing it. 
 
Example:  If you are date tracked to 01-JAN-2010 and the From date 
reflects 01-OCT-2009 and the To date reflects 15-JAN-2010, the position 
details of that position existed between those two dates.  In this case, it 
normally means that there was a change made to the position on 16-JAN-
2010, and the Update option was selected.  Therefore, the details of the 
position reflect their data as it existed between the dates of 01-OCT-2009 
and 15-JAN-2010.  If date tracked any time after 15-JAN-2010, the From 
date will reflect 16-JAN-2010 with no To date reflected. 

 
To change “protected data” (assigned organization and job - occupational series) 
you may use Quick Copy.  Check the appropriate block to change (organization 
or job) on the Quick Copy Window prior to creating the new position.  
Otherwise, once a position is created, this becomes protected data and cannot be 
changed. 

 
Continued on next page 
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Changing Unencumbered Positions, Continued 

   
Accessing the Position Window   
 

Step Action 
1 Navigation Path  →  Work Structures  →  Position  →   

Description  →  <Open>.  
2 The Find Position window opens. 

 
 

3 In the Find Position window, enter % sign to see all positions.    
The Position Window displays the first of all positions in the 
database.  The Message Line displays an arrow indicating there are 
more positions in the database.  Using the up and down arrow 
keys, or the Page Up or Page Down keys,  scroll through the 
positions until you locate the one you want to modify.   

  
Correcting or Updating Position Data  
 

Step Action 

 
 

Caution:   
• If the Message Line of the Position Window says “This 

position is either assigned or obligated,” do not proceed with 
your changes.  You must return to the Navigation List and 
follow the process for Changing Encumbered Positions. 

 
• If the Message Line is blank, proceed with your changes. 
 

 
Continued on next page 
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Changing Unencumbered Positions, Continued 

    
Correcting or Updating Position Data (continued)  
 

Step Action 
 Notes:   

• If you want to verify who encumbers the position, select the 
<Occupancy> Taskflow Button.  The Position Occupancy 
Window displays.  This folder shows current or past 
employees with beginning and ending dates for each.  Close 
the window to return to the Position Window. 

• If you want to see information about this position, i.e., Who 
created the position?  When it was created, when and who 
updated it, etc., select Help on the Main Menu Bar and select 
About This Record. 

1 
Select the Alter Effective Date button    if you want to 
change the From date.  The Alter Effective Date window opens. 

 
 

2 Enter the new date and select <OK>.  The new system date 
displays at the top of the Position Window and in the From data 
field.  

3 Select the <Others> button.  Continue the steps in Building a 
Position to access related descriptive flexfields and key flexfields 
until all data fields are completed.   

 
Continued on next page 
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Changing Unencumbered Positions, Continued 

 
Correcting or Updating Position Data  (continued) 
 

Step Action 
4 After completing the last Extra Position Information Flexfield 

Window, select Save on the Toolbar. 
Select the <Validate> button. 

5  If the Position… Then…  
  Doesn’t Validate You receive a dialog box with an error 

message.  Retrieve the necessary 
flexfield(s) and make corrections.   
After correcting, select Save and select 
<Validate> on the Extra Information 
Flexfield to save your changes and 
validate the data.   
Position Window displays “Valid” in 
the Status Box.  

 

  Validates  The Status Box on the Position 
Window shows “Valid.” 

 

 
 

To Exit Select Action on the Main Menu Bar and select Close Form to return to the 
Navigation List. 

 

 
Caution:  If you changed the effective date for this position change, you must 
reset the date before proceeding to another action. 
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Changing Encumbered Positions 

  
Purpose This section guides you through the process of changing position data on 

encumbered (occupied) positions.  The information in this section applies to 
the following kinds of position change situations: 

• Change an encumbered (filled) position – first incumbent (occupant). 
• Change an encumbered position – additional past incumbent(s). 
• Change a vacant position with past incumbents. 

  
Section Contents • Process Definition 

• Who Changes Position Information 
• Business Rules 
• Examples of Changes Generating an NPA 
• Requirements for Changing Specific Data Elements 
• Accessing the RPA 
• Illustration of Change in Data Element (NOA 800)  
• Illustration of Change in Duty Station (NOA 792) 
• Example of Using the Position Window in Work Structures  

• Accessing the Position Window 
• Querying the Position 
• Changing Competitive Level 

   
Regulatory 
References 

US OPM, The Guide to Processing Personnel Actions (GPPA) 

  
See Also 
      

Module 2, Position Management and Classification Using the DCPDS 
Sections, 

Building a Position 
Querying Positions 
Building a Position Hierarchy 
Quick Copying a Position 
Changing Unencumbered Positions 

• Module 3, Processing Requests for Personnel Action Using the DCPDS 
 

Continued on next page 
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Changing Encumbered Positions, Continued 

  
Process 
Definition 

• Position data elements that appear on the Notification of Personnel 
Action (NPA) cannot be changed on the Position Window.  They must be 
processed through the RPA using the appropriate Nature of Action Code 
(NOAC).  For example:  

•  Position Work Schedule - Use the RPA and NOAC 781. 
• FLSA - Use the RPA and process FLSA change in conjunction 

with appointment or placement action; or, as NOAC 800, 
Change in Data Element 

• Refer to the OPM GPPA to determine the correct NOAC to use for 
various actions affecting the information on an NPA. 

• Position data elements that do not appear on the NPA can be changed in 
two ways, either: 

• On the RPA Window using the Position Taskflow Button to 
access the Position Window (be sure to datetrack to the date the 
updated position information takes effect) 

      Or 
• In Work Structures using the data field on the Position Window. 

   
Who Can 
Change 
Position 
Information 

• Component policies and business rules determine who is assigned this 
responsibility.  

• Position data is usually modified at Regional Service Centers (RSCs) by 
HR professionals given the responsibility.  Modification of position data 
is not done at Customer Service Units (CSUs) or by line managers outside 
of the civilian personnel community.  However, the need to make changes 
to position data can come from officials in serviced organizations, which 
may have new workloads, mission changes, or other circumstances that 
require that positions be modified. 

 
Continued on next page 
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Changing Encumbered Positions, Continued 

  
Business Rules • You cannot delete positions that are encumbered. 

• To cancel an encumbered position, the position must be eliminated (to 
accurately maintain assignment history), and the employee separated or 
moved to another position. 

• If the elimination date  is a future date: 
• You can do so while the employee continues to encumber the 

position.  If the employee continues to encumber the position 
past the date that the position was eliminated, you will receive 
a daily alert to move the employee from the position. 

• If the elimination date  is a current or past date: 
• The incumbent must be moved from the position before the 

position can be eliminated. 

  
Examples of 
Changes 
Generating an 
NPA 

The following position changes are examples of actions that must be done via 
the RPA for encumbered positions, because they require production of an 
NPA. 
 

 
Nature 

of 
Action 
(NOA) 

                                                                  
RPA Position Actions  

                                                          
Process Definition 

781 Change in Work Schedule A change in the work schedule or time 
basis on which an employee is paid, 
including change between seasonal and 
non-seasonal work schedules. 

782 Change in Hours A change in the total number of hours 
during that day that a part-time employee 
is scheduled to work. 

792 Change in Duty Station A change in an employee’s official duty 
station or work site. 

800 Change in Data Element A change in Bargaining Unit Status, 
FLSA Category, Personnel Office ID, etc.  

 
Continued on next page 
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Changing Encumbered Positions, Continued 

 
Requirements for Changing Specific Data Elements   
 

Data Element Associated Requirements 
JOB 

 
 
 

DCPDS will not allow the “Job” (the occupational series) 
assigned to a position to be changed once a position is created 
and saved.   
When a position is encumbered, an NPA will always be 
required to move the employee to a different position.  The 
NOA will vary depending upon the circumstances.  Refer to 
the GPPA. 

ORGANIZATION For vacant or encumbered positions, the position can be 
realigned through Mass Actions, with NOA 790 Realignment 

  Or  
If organizational information is updated on the Organization 
Window, that information will automatically “flow” to all of 
the positions in the organization.   
 
Note:  OPM does not require that such a change be 
documented with a personnel action NPA, but neither does it 
prohibit such documentation. 

LOCATION The duty location of the position must be identical with that of 
the assignment of the employee who encumbers the position. 
 
Note:  OPM requires that a change in position/assignment 
location be documented with a personnel action with NOA 
792 -Change in Duty Station, if no other changes occur 
simultaneously. 
A list form of the NPA may be used if the change affects a 
large number of employees/assignments.  

VALID GRADE Changes in Grade, Pay Plan, or Pay Basis in an encumbered 
position always require an NPA.   

 
Continued on next page 
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Changing Encumbered Positions, Continued 

Accessing the RPA 

 
Before You 
Begin 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

• The primary sources of information for position data changes are the RPA 
and the position description.  

• Once in the RPA, the Position Window is the same as the one used in 
Work Structures to build a new position except <Event History> 
Taskflow Button has been added.  The Taskflow Button (<Others>) is 
not available.  The buttons and fields on the Position Window are 
described in the procedure steps of Building a Position in this module.  

• If the position is moving to a new organizational location, the new 
Organizational Hierarchy must be established before you can move the 
position.  

• If you wish to change a position after you build it, and the position is 

being used on an RPA, you will need to alter the effective date    of 
the RPA action to make your position change.  Otherwise, the RPA will 
not recognize the change.    

Note:  Remember to reset the alter effective date    to the current date 
before proceeding with another action. 
 
Caution:  You should carefully evaluate each data item before changing a 
position. 

  
Continued on next page 
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Changing Encumbered Positions, Continued 

 
Accessing the 
RPA 
(continued) 

Follow this path to access the RPA.  Navigation Path → Request for 
Personnel Action  →  Change Actions  →  Change in Data Element  → 
<Open> to display the RPA – Page 1 with the selected action listed in the 
Actions Request data field. 

   
Illustration of Change in Data Element (NOA 800)  
 

Step Action 
1 Use the procedures listed in Module 3, Request for Personnel 

Action, Chapter 2, Completing the RPA to complete Page 1 of the 
RPA. 

2 With your cursor in the First Action Region of 5-A Code data field 
select the LOV icon to display the First Nature of Actions window.  
Select the correct Nature of Action and select <OK> to 
automatically populate the data field on page 1. 

 
 

 
Continued on next page 
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Changing Encumbered Positions, Continued 

 
Illustration of Change in Data Element (NOA 800) (continued) 
 

Step Action 
3 

  
If an action is pending on the employee, a message box will 
display identifying the action.  Select the <OK> button. 

4 
 

 

Select the Position Data tab .  In the To 
Information side of the position Data form.   
Select the LOV’s icon and select an Occ. Code. Select 
the<OK>button 

 
5 The Employee and Position Data window opens. 

 
For example, Select the LOV’s in the Bargaining Unit Status 
data field on page 3. to display a listing. 

  
Continued on next page 
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Changing Encumbered Positions, Continued 

 
Illustration of Change in Data Element (NOA 800) (continued) 
 

Step Action 
6 Select the correct code, and select the <OK> button to 

automatically populate the data field. 

 
7 Select the Remarks and Address tab to display Page 4 of the RPA.  

In Part F – Remarks for SF-50 Region, place your cursor in the 
Code data field.  Select the LOV icon for a listing of appropriate 
codes for the NOA that you have selected. 

  
 

Continued on next page 
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Changing Encumbered Positions, Continued 

 
Illustration of Change in Data Element (NOA 800) (continued) 
 

Step Action 
8 Select the PA Remarks value and select the <OK> button to 

automatically populate the data field. 

 
 
  

 
 

9 
Select the Save    button on the Toolbar.   

10 
 
 
 
 

A Decision message will appear Select the <Yes> button.  

 
 

Continued on next page 
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Changing Encumbered Positions, Continued 

Illustration of Change in Data Element (NOA 800) (continued) 
 

Step Action 
11 
 
 
 

 
 

 

Route the action to the correct Approving Official’s Workflow Inbox 
and select <OK>.  (After everyone in the routing group has given 
approval, the last one will submit to Update HR) 
 
Caution:  The RPA must be saved to your inbox prior to Updating 
HR, or routing to the next user.  If not, you will not be able to locate it 
when you query closed actions in the future. 
 
The Message Line indicates the change is saved and displays at the 
bottom of the RPA – Page 4. 

 
12 To Exit, Select File on the Main Menu then select Close Form to 

return to the Navigation List. 
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Changing Encumbered Positions, Continued 

Illustration of Change in Duty Station (NOA 792)  
 

Step Action 
1 Navigation Path ∏  Request for Personnel Action  ∏  Change 

Actions  ∏  Change in Duty Station  ∏  <Open> the RPA – Page 1 
with the selected action listed in the Actions Requested data field. 

 
 Use the procedures listed in Module 3, Processing Requests for 

Personnel Actions Using the DCPDS, Chapter 1, Processing a Request 
for Personnel Action to complete Page 1 and Page 2 of the RPA.  
Also, follow the procedures listed in Change of Data Element (NOA 
800).  Select the Employee and Position Data tab to display page 3. 

    2 
 

 

The Duty Station data field is highlighted. 
Note:  The Bargaining Unit Status (BUS) data field may have to be 
changed along with Duty Station data field. 

 
Continued on next page 
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Changing Encumbered Positions, Continued 

 
Illustration of Change in Duty Station (NOA 792) (continued) 
 

Step Action 
3 Place your cursor in the Duty Station Code data field.  Select the 

LOV’s icon 

 
4 Select the new duty station and select the <OK> button to 

automatically populate the data field. 

 
 

 
 

Continued on next page 
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Changing Encumbered Positions, Continued 

 
Illustration of Change in Duty Station (NOA 792) (continued) 
 

Step Action 
5 The Remarks and address window opens, select the LOV’s icon  

 
6 Select the remark code and select the <OK> button 

 
7 The Duty Station Code and Duty Station (City-County-State or 

Overseas Location) data fields are now changed.  

 
Select <Save> button 

Continued on next page 
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Changing Encumbered Positions, Continued 

 
Step Action 

8 
 
 
 
 
 

 

A decision message displays Select the <Yes> button.  

 
Caution:  The RPA must be saved to your Civilian Inbox before 
processing to Update HR, or routing to the next user.  If not, you 
will not be able to locate it when you query closed actions in the 
future. 

9 Select the person to route the action to. (After everyone in the 
routing group has given approval, the Approving Official will 
submit to Update HR.) 

 
10 The Message Line indicates the change is saved and displays at the 

bottom of Page 4 of the RPA. 

 
11 To Exit, Select File on the Main Menu then select Close Form to 

return to the Navigation List. 
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Changing Encumbered Positions, Continued 

 
Accessing the 
Position 
Window 

Navigation Path → Work Structures → Position → Description → <Open>.   

  
Querying the Position   
 

Step Action 
1 Enter a partial PD Number (ex. E7038%).  Select the<find> button 

 
2 Select the <Others> Taskflow Button.    
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Changing Encumbered Positions, Continued 

 
Changing Competitive Level  
 

Step Action 
3 The Navigation Options window opens.  Select the Agency that 

you need, i.e. “Navy”.  Then select the <OK> button. 

 
4 The Extra Position Information window opens. Select US 

Federal Position Group 1.  

 
 

 
Continued on next page 
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Changing Encumbered Positions, Continued 
  

Changing Competitive Level (continued) 
 

Step Action 
5 Double Select Details data field.  The Extra Position Information 

window opens with previously completed information entered. 

 
6 Place your cursor in Competitive Level data field.  Enter your data that 

is now the correct i.e., “0000”.  Select the <OK> button. 

 
 

Continued on next page 
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Changing Encumbered Positions, Continued 

Changing Competitive Level (continued) 
 

Step Action 
7 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Extra Position Information displays with the new 
Competitive Level reflected in the Details box (sixth data field in 
the string of info = 0000). 

 
8 

Select Save  icon. And close the Extra Position Information 
window. 

9 The Position window opens.  If the Status data field says 

 “Invalid,” select the <Validate> button and 
correct any data required until the Status data field is “Valid.” 

10 To Exit, Select File on the Main Menu then select Close Form to 
return to the Navigation List. 
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Terminating and Deleting a Position 

  
Purpose This section explains how to terminate or delete a position.  The required 

steps depend on whether the position is encumbered or has been occupied. 

   
Section Contents • Before you begin 

• Terminating a Position 
• Deleting a Position 

   
Who Does This 
Process       

You must be assigned a role in the personnel area to perform this function or 
assigned this role by your Component. 

  
Before You 
Begin 

Things to consider before terminating or deleting a position and the differences. 

 

When to “Terminate” When to “Delete” 
It is not encumbered. It is not within a hierarchy. 
You want to use it again. It has never been occupied. 
You want to keep historical data. It isn't being used by an RPA. 
        Note: A new sequence number      

 will be assigned. 
 

        Note: All historical data is 
removed, but the sequence 
number never goes away. 

 
Continued on next page 



                                                                                                              R12                                                                                      March 2012 

Position Management and Classification:  Managing Positions       Mod 2, Chap 2, Page 53 

Terminating and Deleting a Position, Continued 

  
Terminating a Position  
 

Step Action 
1 Navigation Path → Work Structures → Position → Description 

→ <Open>.  The Find Position window opens. 

 
Enter the position number you wish to terminate. 

2 Type in an end date in the Proposed End Date data field of the 
Dates Region of the position record.  The date may be a past, 
current, or future date. Retrieve the position you wish to terminate. 
Note:  If this date is a past or current date, you should ensure that 
no one is assigned against the position before you end date it.  See 
"Before you begin" at the beginning of this section for additional 
information.  
• Helpful Hint:  You will know the position is occupied if 

Location is grayed out, as well as the Message Line at the 
bottom of the window. 

Example of an occupied position: 

 

 
 

Continued on next page 
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Terminating and Deleting a Position, Continued 

  
Terminating a Position (continued) 
 

Step Action 
2 

Cont. 
Note:  If the position is occupied, the system will send a daily 
reminder to take an action on the employee on and after the “To” 
Date. 

3 Example of an Unoccupied Position (Location is not grayed out): 

 
4 Select Save.  The Message Line indicates: "Transaction complete: 

1 records applied and saved." 
5 Exit the Position Window by selecting File on the Main Menu 

then and select Close Form to return to the Navigation List. 

 
Deleting a  
Position 

If the position is in a hierarchy, follow the process in Deleting a Position 
from a Position Hierarchy in this module.  If not, follow these steps to 
delete a position that has never been occupied or is not being used by an RPA.   

 
Step Action 

1 Navigation Path → Work Structures → Position → Description → 
<Open>.  The Find Position window opens. 

2 Retrieve the position you wish to delete by using the Querying 
function.  Place the cursor in the Name data field and enter a partial 
value of the position, ex:  %JI123%.  Select View → Query by 
Example → Enter → Run. 

 
Continued on next page 
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Terminating and Deleting a Position, Continued 

  
Deleting a Position (continued) 
 

Step Action 
3 The queried position auto populates the Position Window.  

 
4 

Select the Delete    button on the Toolbar.  
5 A Dialog Box displays asking if you really want to delete this 

record.  Select <Yes>. 

  
 

Continued on next page 
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Terminating and Deleting a Position, Continued 

  
Deleting a Position (continued) 
  

Step Action 
6 A Dialog Box open with opens explaining the system will 

completely remove the position from the database. 

 
Select the <PURGE> button. 

7 After selecting the Purge button a Caution box will appear 
explaining the system will automatically delete extra information 
types associated with the position.  

 
Select the <OK> button. 

8 Select the Save icon complete the removal of the position 
9 To Exit, Select File on the Main Menu then select Close Form to 

return to the Navigation List. 
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Module 2 

Chapter 3  

Managing Position Hierarchy Using COREDOC  

Overview 

  
Introduction 
 
 
 
 

This chapter explains the use and functionality of the Department of Defense 
Core Document System (COREDOC).  COREDOC is an application included 
in the DCPDS as part of the Position Management and Classification 
function.  It includes a cover sheet, position description, performance plan, 
training competencies, and knowledge, skills, and abilities (KSAs) for 
staffing. 

  
Chapter Contents  

Topic Page  
Chapter Overview 1 
Accessing and Navigating in COREDOC 2 
Creating A Core Document 11 
Viewing and Printing an Existing Core Document 42 
Modifying a Core Document 46 
Attaching a Core Document to the Request for Personnel 
Action (RPA) 

76 

     
Before you 
Begin 

• Component use of COREDOC is optional. 
• NAF does not use COREDOC. 
• All Agencies may not use the Performance Plan. 
• Neither the General Schedule Supervisory Guide (GSSG) nor the GS 

Leader Grade Evaluation Guide is presently available. 
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Accessing and Navigating in COREDOC 

 
Purpose This section explains how to access the COREDOC Application and navigate 

through the system using the menu items, user default information data fields, 
and exiting. 

  
Section Contents • Accessing COREDOC 

• COREDOC Main Menu Bar  
• File Menu  
• Utility Menu 
• User Default Information Window 
• Window Menu 
• Help Menu 
• Exiting COREDOC 

  
Accessing COREDOC  

 Step Action 
1 Navigation Path → Coredoc → <Open>. 

 
 

Continued on next page 
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Accessing and Navigating in COREDOC, Continued 

  
Accessing COREDOC (continued) 
 

Step Action 
2 The Core Applications window opens.  Select <OK>.    

 

 
 

3 Selecting <OK> opens the Core Document Development System 
Title window  

 
 

 
Continued on next page 
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Accessing and Navigating in COREDOC, Continued 

  
Accessing COREDOC (continued) 
 

Step Action 
4 The Core Document Development System window opens with 

the Main Menu Bar selections for accessing the COREDOC 
processes and functions. 
 

 

  
COREDOC 
Main Menu Bar  

The four main menu selections are described below.  

 
Menu Item Description 

File Allows you to perform a variety of processes and 
functions.  You can create, delete, view, print, import, 
export, copy, use and view standard core documents (CDs) 
or rename them. 

Utility  You can establish system-generated defaults for the CD.  
In addition, users with “Classifier” or “Super User” role 
can assign a Civilian Personnel Control Number (CPCN) 
to a CD. 

Window You are provided three choices for displaying open 
windows in COREDOC.  You can arrange them according 
to viewing preference. 

Help Provides Help System Maintenance entries and general 
information About CD Writer. 

 
Note: Open, Delete, View, Print, Copy, Rename are 
grayed out, until a new COREDOC is created. 

  
Continued on next page 
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Accessing and Navigating in COREDOC, Continued 

 
File Menu  The File menu is used to perform a number of functions.  To access the File 

menu, select File on the Main Menu Bar.  The following menu opens.   
    

 
 

Select  To…/Function 
New Create a new core document (CD). 
Open… Open an existing CD.  See How to Modify a Core 

Document in this module for additional information. 
Delete… Delete an existing CD. 
View… View a CD while working in the application.  See How to 

View a Core Document in this module for additional 
information.  

Print… Print a copy of a CD. 
Import CDs… Import COREDOC is not available. 
Export CDs… Export COREDOC is not available. 
Use Standard 
CDs… 

Copy a core document from the standard library, if 
necessary. 

View Standard 
CDs… 

View a standard core document.  

Copy… Duplicate an existing regular or standard core document in 
your directory.  

Rename… Assign a new name to an existing regular or standard CD. 
Exit Exit from CD Writer to the COREDOC Applications 

window.  You can continue the Exit process and return to 
the Navigator window.  
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Accessing and Navigating in COREDOC, Continued 

  
Utility Menu 
 
 

 

Select Utility on the Main Menu Bar to access the Utility menu.  
 

 
 

Option Available for 
Systems Default Any user of the COREDOC Application. 
System 
Administration 

Users who have been designated as Systems 
Administrators for the COREDOC Application. 

  
User Default 
Information 
Window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
              

 

 

The User Default Information window opens when Utility is selected on the 
Main Menu Bar.  The data areas are described below. 
 

 
 

The first time you access COREDOC, you will be prompted to complete the 
blank User Default Information window.  This window allows you to enter 
certain defaults and establish a standard Name and Goals for the 
organizations for which you have responsibility.  The information that you 
type in the data fields will be generated on each CD that you process, 
eliminating the need to retype the information. 
 
Note:  The window has predetermined defaults that may or may not be 
compatible with the organization you service.  You must review the defaults 
and make the appropriate changes to the data fields. 

 
Continued on next page 
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Accessing and Navigating in COREDOC, Continued 

  
User Default Information Window (continued) 
 

User Default 
Information 

Window Data 
Field 

 
Description 

Oracle User ID Contains the Oracle User Identification assigned to 
you.  This field cannot be modified. 

Output Format 
 

                                

You can determine the type of output desired, e.g., CD 
or Position Description.  

Note:  It is recommended you retain the CD as the 
default. 

On/Off Setting 
For: 

You can “3” on or off for any of the boxes next to the 
settings by selecting inside the box.  The settings are 
described below. 
 Critical/Noncritical – automatically designates all 

selected duties as critical when activated. 
 Percentage for FWS Positions – you should not 

select this option unless your Agency/Organization 
requires duty percentages to appear for wage grade 
positions.  

 Show KSA Linkage to Specific Duties – allows 
you to show the linkage between a selected duty 
statement and competency (KSA) for a CD. 

 Automatic Staffing KSA Selections – allows 
automatic selection of KSAs for a CD. 

Agency Code 
 
 
 
 
 

                                 

 

Designates the format of the core document, and in 
particular, the Performance Management Plan.   
Select the Agency Code data field to access the drop-
down menu, highlight your agency, and select <OK>.  
You can select from the choices indicated on the drop-
down menu (Air Force, Army, DoD, Marines, National 
Guard, and Navy).   

Note:  The Fourth Estate Agencies and other Agencies 
should use the “DD” Agency Code. 

 
Continued on next page 
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Accessing and Navigating in COREDOC, Continued 

  
User Default Information Window (continued) 
 

Data Field Description 
Coredoc Access Indicates the status that you are using to access the 

User Default Information window.  The system 
default is a Classifier.  The other options are “S” for 
Super User, and “M” Coredoc Manager. 

Import CDs Import CDs is not available. 
Export CDs Export CDs is not available. 
Organization 
Name 

Allows you to enter a default Organization Name.  The 
information that you type in this data field will be 
generated on each CD that you process, eliminating the 
need to retype the information.   

Organization 
Goals 
                                  

                                     

 

Allows you to enter default Organization Goals.  The 
information that you type in this data field is generated 
on each CD you process, eliminating the need to retype 
the information. 
Note:  You should always check the Systems Default 
information to be sure it is correct for the organizations 
for which you have responsibility. 

Save/Exit Once you have selected all the system defaults, select 
<Save> to save your information and return to the 
Core Document Development System window. 
      Or 
Select <Exit> to return to the Core Document 
Development System window and not save your 
changes. 

  
Window Menu The Window menu provides three choices for displaying open windows; you 

can arrange them according to your preference for viewing. 
 
The Window menu also lists all windows you currently have open, including 
your sign-in “responsibility” (listed in the Navigator window). 
 
To access the Window menu, select Window on the Main Menu Bar. 
 

 
                                                        

 
Continued on next page 
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Accessing and Navigating in COREDOC, Continued 

  
Window Menu   . 

Choice Action 
Cascade Opens open windows in a “cascaded” or stair-step fashion. 
Tile Opens open windows in a “tile” (non-overlapping fashion). 
Arrange Icons Arranges the icons of any minimized windows side-by-side 

in the lower left of the window. 

   
Help Menu The Help Menu provides Help System Maintenance entries and general 

information About CD Writer.   
 
To access the Help menu, select Help on the Main Menu. 

 

 
 
 

 
Menu Item Description 

View 
COREDOC 
Manual 

Provides a view of COREDOC Manual from Integrated 
Personnel Process Improvement (PPI) release.  

Print 
COREDOC 
Manual 

Prints the COREDOC Manual from the Integrated PPI 
COREDOC manual on-line without exiting.  

Help System Provides general information about the purpose and 
functionality contained in the COREDOC software. 

About CD 
Writer 

Provides general information about the CD Writer 
COREDOC software. 
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Accessing and Navigating in COREDOC, Continued 

  
Exiting 
COREDOC 
 

 

There are a number of methods to exit COREDOC:   
• Select <Exit> from any of the application windows, and follow the 

directions on the windows to continue the exiting process, or    
• Select File on the Main Menu; select Exit.  A Dialog Box opens. 
 

 
 
• Select <Yes> to exit CD Writer and return to the Navigator window.   
• Select <No> to return to the Coredoc Applications window. 
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Creating a Core Document 

  
Purpose This procedure provides information on the process of creating, viewing, and 

printing a new core document (CD). 

  
Section Contents • Accessing the COREDOC Applications window 

• Selecting an Occupational Series 
• Naming Core Documents 
• Selecting: 

• Duties for a Regular CD 
• Supplementary Duties for a Regular CD 
• Percentages of Time for a Regular CD 
• Staffing KSAs for a Regular CD 

• Verifying Title, Pay Plan, Series and Grade for a Regular CD 
• Completing Organizational Goals and Purpose for a Regular CD 
• Developing the Performance Management Plan for a Regular CD 

• Using the System-Generating Performance Requirements 
• Entering New Performance Requirements 

• Creating a Standard CD 
• Viewing and Printing a CD 
• Exiting COREDOC 

   
Accessing the Coredoc Application window  
 

Step Action 
1 Navigation Path → Coredoc → <Open>.  
2 

 

The Core Document Development System window with the Main 
Menu Bar opens.   
• Select File to display a drop-down menu.  
• Select New to begin the process of creating a core document.  
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Creating a Core Document, Continued 

   
Selecting an Occupational Series  
 

Step Action 
1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Occupations to Select From window opens with three 
Taskflow Buttons at the bottom of the window.  
• Scroll and select the occupation you need for your CD, and then 

select <OK>, or 
• Input the Series number in the Find data area followed by a “%” 

Select <Find>.  The series number you designated opens.   
• From the listing, select the series and occupation you need and 

select <OK>. 

 
 

Note:  Several series are further defined into a number of 
occupations.  For example, 0318 has other associated occupations 
listed:  318A, 318B, etc. 
Additionally, several Primary Occupations require you to select 
duties from two or more occupational menus.  This usually applies 
when two or more wage occupations of equivalent grade are used in 
the CD creation process.  If you select one of these series you will 
be returned to the Occupation to Select From window where 
another series with an associated occupation may be selected. 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Selecting an Occupational Series (continued) 
 

Step Action 
2 The Coredoc Document Development System – New Core 

Document window with the title “Please Confirm The Following 
Work Situation” opens with a description of the occupation you 
selected.  Use the scroll bar and scroll through the description to 
ensure it meets your needs. 
 

 
 

3 Select one of the taskflow buttons at the bottom of the window: 

  Select <Information> Select <Continue>  
  To display detailed position 

classification information 
about the selected series and 
occupation to read before 
proceeding. 

To display the Action - CD 
Type window when the series 
and occupation are correct.  

 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Selecting an Occupational Series (continued) 
 

Step Action 
4 If you select <Information>, the Core Document Development 

System - New Core Document window opens with detailed 
information about the selected series and occupation. 
 

 
 

5 Select <Print> to print the information on the occupation, or  
 <Exit> to return to the Core Document Development System 
window. 

6 If you select <Continue> on the Core Document Development 
System window, because the series and occupation are correct, the 
Action – CD Type window opens.  
Select <Exit> on the Core Document Development System 
window if the series and occupation are not correct to return to the 
Core Document Development System Main Menu window. 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Naming Core 
Documents 

Follow the steps below to select or create your own unique CD. 

 
Step Action 

1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select <Continue> on the Core Document Development System-
New Core Document window. 
The Action - CD Type Dialog Box opens.  
 

 
 
Select one of the following types of CDs: 
• Regular CD - is based on unique duty requirements or special 

qualifications of the position.  Regular CDs have a system-
generated name beginning with “TMP” and ending with a 
sequential number. 

• Standard CD - is based on standard duties and qualifications 
and is normally used Component wide.  Standard CDs will have 
a system-generated name comprised of four parts: 
•  The abbreviation, “STD,” 
•  The user’s two-digit agency code, 
•  The four-digit occupational series,  
•  The two-digit grade, and 
•  A sequential number. 

Note: It is recommended that you establish your own naming 
convention for both “Regular” and “Standard” CDs.  Your CDs are 
based on your Component’s business rules.  You may enter any 
identifier that does not exceed the allocated space of twenty 
alphanumeric characters. 

2 
 
 

Select Regular CD on the Action – CD Type window and select 
<OK>. 
Note:  A Regular CD is used for illustration purposes only. 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Naming Core Documents (continued) 
 

Step Action 
3 
 
 
 
 
 
 
 
 
 
 

The Action – Enter CD Name window opens.  In the example, a 
system-generated CD Name of “TMP00789” opens in the CD 
Name data field.   
 

 
 

Note:  Select <Help> for the COREDOC Help System window 
to display an explanation of the CD Name. 
 

 
4 Select <Ok> to accept the system-generated CD Name, or type in 

your own specific name and number for the CD that meets the 
business rules of your Component.   

5 Select <OK> to display the Duty List window with the associated 
duties for the series and occupation you selected. 

6 Select <Cancel> to cancel to exit the window. 
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Creating a Core Document, Continued 

  
Selecting Duties for a Regular CD  
 

Step Action 
1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

On the Duty List for…window, select the duties to include in your 
CD at this time.  

 
 

Note:  It is not necessary to select all the duties listed for your series 
and occupation, only the ones that applies to your CD. 

2 Select <Select All> to select all the duties listed for the series and 
occupation. 
     OR 
Select <Continue> to not select any duties. 
Note:  If you select <Continue>, a dialog box opens.  “You have 
NOT selected any duties for this series.”  Select <OK>.  A second 
dialog box opens, “Do you wish to abandon this series for this 
coredoc?”  Select <Yes> to begin a new series or <No> to return to 
the Duty List for: window.   
Select the box next to the Duty Title associated with your series and 
occupation to display the Duty Classification Levels for… 
window.  For Example:  Duty Classification Levels For:  
Information Systems window. 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Selecting Duties for a Regular CD (continued) 
 

Step Action 
3 The Duty Classification Levels for:  Information Systems 

window opens a description of the first level for the series listing in 
the Level Selections Area.   

 
 

Notes:   
• Select the Title or Series (i.e., Human Resources Specialist GS-

0201-09) to access the Level/Description for each of the levels.  
Or  

• Select <Cancel> to return to the Duty List for:  window 
without making a Duty Level selection. 

4 Select the level you need for your CD.  The Duty List for:  window 
returns for selecting additional duties.  Select another duty. 

5 Select <Statement> to display the Duty Statement window. 

 
 

Continued on next page 
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Creating a Core Document, Continued 

  
Selecting Duties for a Regular CD (continued) 
 

Step Action 
6 Select <Return> to return to the Level Selection window.  Select 

the level appropriate for the duty position.  The system will return to 
the Duty Selection window and the Grade you selected will reflect 
on the window. 

7 Select <Continue> to display the Supplementary List window.   
 

 
   
A description and the use of the buttons:   

  Button Description/Use  
  

 
Proceed to the next creation 
window. 

 

  
 

Return to the Occupations to 
Select From window to select 
a new series. 

 

  
 

Save your work up to this point 
and quit. 

 

  
 

Exit your work without saving.  
A series of dialog boxes 
display.  Select the correct 
response and return to the Core 
Document Development 
Window. 

 

  
 

 

Return to the Duty List 
window. 

 

 
 

Continued on next page 
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Creating a Core Document, Continued 

  
Selecting Duties for a Regular CD (continued) 
 

Step Action 
8 Select <Continue> to proceed.  The Core Document 

Development System - Supplementary List window opens for 
selecting additional duties. 
Note:  These duties do not affect the grade or series, but are 
important to ensure requirements are complete for the CD. 
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Creating a Core Document, Continued 

    
Selecting Supplementary Requirements for a 
Regular CD   

 

 
Step Action 

1 Select the Select box to select a level or select <Continue> to return 
to the Duty List.  

 
     

2 • Select <Previous> to select additional supplementary duties. 
• Select <Information> for information about the window. 

3 Select <Continue> after you select all the supplementary duties for 
COREDOC to display another Supplementary List window. 
     OR 
Select <Continue>, even if you did not make any selections. 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Selecting Supplementary Requirements for a Regular CD (continued) 
 

Step Action 
4 The Core Document Development System – Supplementary List 

window opens.  Each of the four options is explained in the text.  
Select the option that meets your needs to continue the COREDOC 
process. 

 
5 
 
 

Select <Continue> to display the Percentages of Time window.   
 
Note:  If you did not select any of the supplementary duties, a 
dialog box asks, “Are you finished with Supplementary 
Information?” 
 
Select <Continue> to continue creating a CD.   
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Creating a Core Document, Continued 

 
Selecting Percentages of Time   
 

Step Action 
1 
 
 

The Percentages of Time window opens with the duties you 
selected with an assigned percent for each one. COREDOC 
automatically distributes percentages to equal a total of 100% unless 
you make adjustments.  Total Percentage is displayed at the bottom 
of the screen and must always equal 100%.   

 
Note:  You may change the percentage of time, if needed.  Select 
the box under “%” and type in a new percentage.  The total 
percentage must add up to 100 percent. 

2 Select <Continue> to display the Staffing KSAs window. 
3 The Please Wait Dialog Box advises, “Processing information into 

the database...” before accessing the next step in the COREDOC 
process. 
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Creating a Core Document, Continued 

  
Selecting 
Staffing KSAs 
 

All of the competencies listed appear in the CD in the Basic Training 
Competencies Section.  Only those you select for staffing, however; will be 
listed in the selected Staffing KSAs section of COREDOC. 

 
Step Action 

1 
 

The Core Document Development System – Staffing KSAs 
window opens. 

 
 

Select the checkbox next to each KSA for the position description.  
As you select a KSA, the system will take you to the description for 
that KSA until you have selected all the KSAs that you need.  The 
KSAs will populate in the Description field. 
 
Notes:   
• The KSA Checkboxes will usually be blank.  If there are check 

marks in them, a pre-determination has been made that the 
KSAs are essential to both staffing and training.   

• Numbers in the % of Time Column indicate the percentage of 
work requiring the particular competency (KSA). 

• If the competency applies to all KSAs selected, then the 
percentage is 100.  If the competency applies to only one duty 
and that duty comprises 30% of the job, then the % of time will 
be 30.0.  The % of Time Column opens to assist in deciding 
which KSAs to select for staffing. 

2 Select <Continue> to display the Title, Pay Plan, Series, Grade 
window after you have selected all the KSAs you need for the CD. 
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Creating a Core Document, Continued 

  
Verifying Title, Pay Plan, Series, and Grade for a Regular CD   
 

Step Action 
1 The Core Document Development System – Title, Pay Plan, 

Series, and Grade window opens.  The window contains the CD 
Name, Official Title, Series, Pay Plan, and Grade data fields.  
These are automatically populated based on your previous selections 
in the creation process. 

 
 

• Select <Edit> and highlight selection to change the Official 
Title, Series, or Pay Plan.  Any changes made on this window 
will be reflected in the Classification Summary of the CD.  CD 
Name cannot be changed.  

• Select Title to make any changes to the Official Title. 
• Select <Continue> to go to the next step and display the Goals 

and Purpose window.  
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Creating a Core Document, Continued 

 
Completing the Organizational Goals and Purpose for a Regular CD    
 

Step Action 
1 The Core Document Development System – Goals and Purpose 

window opens. 
 

 
2  If you  Then  
  Choose to write your own 

Organizational Goals and 
Purpose. 

Select <Edit> and type them 
in the fields provided. 
Select Save.  Select <Exit> 
The Performance 
Management Plan window 
will display. 

 

 
 

 

 Choose to use Standards 
Goals.   
(Note:  Users with 
“Classifier” or “Super User” 
role can establish “Standard 
Goals” as a default for the 
organizations serviced.) 

Select <Standard Goals> for 
auto population.  Select 
<Exit>.  The Performance 
Management Plan window 
will display. 

 

  Choose not to input Goals and 
Purpose. 

Select <Exit>.  The  
Performance Management 
Plan window will display. 
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Creating a Core Document, Continued 

  
Developing the 
Performance 
Management 
Plan for a 
Regular CD 

COREDOC is programmed to reconfigure the duties selected into objectives 
for use in the Performance Management Plan window.  It will format the 
duty statements (objectives) to emulate your component’s current 
performance management plan.  The window is essentially the same for each 
Component; however, the output will be different depending on your 
Component.  For example, Air Force does not use this part of COREDOC.  
Follow these steps to develop the Performance Management Plan: 

  
Step Action 

1 The Core Document Development System – Performance 
Management Plan window opens.   
 

          
 
There are four Taskflow Buttons on the window.  The descriptions 
of the buttons follow. 
 

<Edit> - Add or change text to comply with your Component’s    
                governing performance elements and standards. 
<Delete> - Remove text from the document. 
<Duties> - Load duty statements associated with the CD.  
<Continue> - Continue the creation process. 

 
Select <Duties> to display the Core Document Development 
window. 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Developing the Performance Management Plan for a Regular CD (continued) 
 

Step Action 
2 A Duty Text Dialogue Box opens:   

 

 
 

3  Select <Yes> if you Select <No> if you  

  Want the system to load 
performance requirements. 

Want to enter your own 
performance requirements. 

 

 
Using the System-Generated Performance Requirements  
 

Step Action 
1 If you select <Yes>, a Duty Text Dialogue Box opens. 

 

 
 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Using the System-Generated Performance Requirements (continued) 
 

Step Action 
2  Select <OK>.  A notice opens. 

          
 

3 Select <OK>. 

            
 

4 Select <Continue>.  The Core Document Development System - 
Performance Management Plan window opens.  This window 
provides the CD Name, Organization, Comments, Official Title, 
Pay Plan, Series, Grade, and Agency fields with your input.  
 

 
 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Using the System-Generated Performance Requirements (continued) 
 

Step Action 
5 Select <Edit>.  Select Exit. 
6 The Core Document Development System window opens. 

 

 
 

7 Select File.  Select Exit.  
8 The Please Confirm window will display the question “Are you 

sure you want to Quit CD Writer?” 

 
 

9 Select <Yes> to exit. 
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Creating a Core Document, Continued 

 
Entering New Performance Requirements  
 

Step Action 
1 If you selected <No> in Step 3 of Developing the Performance 

Management Plan above, the Core Document Development 
System - Performance Management Plan window opens with 
the Specific Performance Requirements Section blank.   

         
Select <Edit>. 

2 The Core Document Development System - Performance 
Management Plan window opens with Specific Performance 
Requirements blank.         
 

 
 

Type the specific performance requirements.  
Select <End Edit>.  

 
Continued on next page 
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Creating a Core Document, Continued 

  
Entering New Performance Requirements (continued) 
 

Step Action 
3 The Core Document Development System - Performance 

Management Plan window opens with your input.    

         
 

4 Select <Exit>. 
5 The Core Document Development System window opens.  This 

window provides the CD Name, Organization, Comments, 
Official Title, Pay Plan, Series, Grade, and Agency fields with 
your input. 

 
 

6 Select Edit and then Exit. 
7 The Core Document Development System window opens. 

 
8         Select File and then Exit to exit COREDOC. 
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Creating a Core Document, Continued 

 
Creating a Standard CD  
 

Step Action 
1 The Action – Please Select window opens with two Taskflow 

Buttons and the statement “Your current agency code is ___.  Do 
you want to accept your current default agency code for this CD or 
do you want to CHANGE it?” 

 
 

2  If you select Then  
  <Accept> The Action –Authorizations window opens and 

the system defaults to the agency code shown on 
the window.  Two buttons are on the bottom of 
the screen: 
<OK> - Opens the Duty List For:  (Pay Plan, 
Series, Job Title) Window in the block titled 
“Selecting from the Duty List”. 
<Help> - takes you to the COREDOC Help 
System Window on Standard CDs shown in this 
decision-logic table. 

 

 
 

 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Creating a Standard CD (continued) 
 

Step Action 
2 

(cont) 
  

If you select  
 

Then 
 

  <Change> The Agencies window opens with three 
Taskflow Buttons used in all queries. 

 
 

 

  Your 
Agency and 
Name and 
select 
<OK> 

The Action – Default Agency window opens 
with your Component listed in the default 
agency field.  

 

 

 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Creating a Standard CD (continued) 
 

Step Action 
2 

(cont) 
  

If you select 
 

Then 

 

  <Ok> The Action – Authorization window opens 
with the CD Name field auto populated. 
Two buttons are on the bottom of the window: 
 
 <Ok> - Opens the Core Document  
              Development System window. 
 
<Help> - Opens the COREDOC Help  
               System Window on Standard CDs  
               shown in the next step. 
 

 
 

 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Creating a Standard CD (continued) 
 

Step Action 
2 

(cont) 
  

If you select  
 

Then 

 

  <Help> The COREDOC Help System window opens 
with the sequentially assigned number.  Three 
buttons are located on the window: 
 
<Search> - Opens the Search/Replace window         
                    to make changes and give you an  
                    explanation of the characters that   
                    constitute the Standard CD. 
 
<OK> -       Opens the next window. 
 
<Cancel>-  Returns you to the previous  
                    window. 

 
 

 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Creating a Standard CD (continued) 
 

Step Action 
2 

(cont) 
  

If you select 
 

Then 
 

  <Cancel> You are returned to the Action – Authorization 
window. 
Select <Ok> and continue with the Standard 
CD. 
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Creating a Core Document, Continued 

  
Viewing and Printing a CD  
 

Step Action 
1 Select File and then View on the Main Menu Bar. 
2 The Available Core Documents window opens 

 

 
 

3 Select the CD you wish to preview. 
4 Select <OK>. 
5 The Action – View Report Dialog Box opens with the statement, 

“If you decide to print this report from the Report Previewer by 
pressing the Print button, you must manually select the printer 
from the File Menu (Choose Printer) in the Previewer.” 

Select <Ok>. 

 
 

 
Continued on next page 
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Creating a Core Document, Continued 

  
Viewing and Printing a CD (continued) 
 

Step Action 
6 The Report Progress Dialog Box opens informing you that the 

activity is processing. 

 
 

7 The pd:  Previewer window opens with a menu bar, eight buttons, 
a page indicator, and a scroll bar. 

 
 
Note:  You can preview the first page of the CD by using the 
scroll bar on the side.  If you want to preview the rest of the CD, 
select <Next> until you get to the last page.   

 
Continued on next page 
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Creating a Core Document, Continued 

  
Viewing and Printing a CD (continued) 

Step Action 
8 Select File.  Select Print.  The Print window opens. 

 

 
 

9 Select the appropriate printer in Printer Name data field.  Select 
the Print Range and number of copies needed.  Select <OK> to 
print the number of copies needed. 

10 Select <Close> to return to the Core Document Development 
System window. 

 
 

 
Continued on next page 
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Creating a Core Document, Continued 

   
Exiting COREDOC   
 

Step Action 
1 Select Edit on the Main Menu Bar.  

The COREDOC DEVELOPMENT SYSTEM Dialog box opens 
with a new Toolbar. 
Select File and select Exit from the drop down menu. 

 
2 The Please Confirm Dialog Box opens asking, “Are you sure you 

want to quit CD Writer?” 
Select <Yes>. 

 
 

3 The Navigator window opens. 
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Viewing and Printing an Existing Core Document 

  
Purpose This section explains how to access COREDOC to view and print an existing 

CD.  

  
Section 
Contents 

• Accessing COREDOC 
• Viewing a CD 
• Printing a CD 

  

  
Accessing COREDOC  
 

Step Action 
1 From the Responsibilities window, select your assigned 

Responsibility → <OK>.   
2 The Navigator List opens.  Select Coredoc → <Open>. 

  
Viewing a CD  

Step Action 
1 The Core Document Development System window opens. 

 

 
 

2 Select File and then select View on the Main Menu Bar. 
 

Continued on next page 
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Viewing and Printing an Existing Core Document, Continued 

  
Viewing a CD (continued) 
 

Step Action 
3  The Available Core Documents window opens.  Select the CD 

you wish to preview. 
 

 
 

4 Select <OK>. 
5 The Action – View Report Dialog Box opens with the statement, 

“If you decide to print this report from the Report Previewer by 
pressing the Print button, you must manually select the printer 
from the File Menu (Choose Printer) in the Previewer.” 

Select <Ok>. 

 

 
 

  
Continued on next page 
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Viewing and Printing an Existing Core Document, Continued 

 
Viewing a CD (continued) 
 

Step Action 
6 The Report Progress Dialog Box opens informing you that the 

activity is processing. 

                     
 

7 The pd:  Previewer window opens with a menu bar, eight 
Taskflow Button, a page indicator, and a scroll bar. 

 
 
Note:  You can preview the first page of the CD by using the 
scroll bar on the side.  If you want to preview the rest of the CD, 
select <Next> until you get to the last page.   
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Viewing and Printing an Existing Core Document, Continued 

  
Printing a CD 

Step Action 
1 Select <Close> to return to the Core Document Development 

System window. 
 

 
 

2 Follow Steps 3 and 4 in Viewing a CD. 
3 The Report Destination window opens.  Select Printer to print the 

CD. Select <OK>. 

 
 

4 Follow Steps 5 and 6 in Viewing a CD. 
5 The CD prints to your default printer. 
6 The COREDOC Development System window opens. 
7 Select File, and select Exit to return to the Navigator window. 
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Modifying a Core Document  

   
Purpose After you generate a core document (CD), you have the option to edit and 

modify the document.  This section explains how to modify an existing CD. 

 
Section Contents • Retrieving an Existing CD 

• Opening a CD 
• Edit Menu 
• Editing and Modifying: 

• Goals and Purpose 
• Major Duties 
• Percentages of Assigned Duties 
• Knowledge Factors 
• Other Factors 
• KSAs 
• Staffing KSAs 
• Other Work Requirements 
• Performance Management Plan 
• Title/Pay Plan/Series 
• Cover Sheet 
• Classification Remarks 

• Adding More Occupations 
• Adding the Classification Summary 

   
Before You 
Begin  

• The options on the Toolbar and drop-down menus are defined in the 
Overview section of this module.  

• The Help option is available on the Main Menu Bar and includes the two 
drop-down choices: 
• Help System provides general information about the purpose and 

general functionality in COREDOC. 
• Show Key provides information on using convention keystrokes. 

• You must be in the Role of Classifier or Super User to modify the Cover 
Sheet. 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Retrieving an Existing CD  
 

Step Action 
1 Navigation Path → Coredoc → <Open>. 
2 The Core Document Development System window opens. 

Select File. 
From the drop-down menu, select Open. 
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Modifying a Core Document, Continued 

  
Opening a CD  
 

Step Action 
1 The Core Document Selection window opens.  There are two 

Taskflow buttons to use in editing a CD. 
 

 
 
<CDs w/CPCNs> - Opens the Available Core Document  
                                 window which contains CDs with CPCNs  
                                  already assigned. 

<My CDs> - Opens the Available Core Documents window  
                      which contains a listing of CDs you have  
                      generated.  (They are not activated until you link  

          them with an RPA.) 
<Cancel> - Returns to the Core Document Main Menu. 
 
Note:  If you previously created CDs but did not link one to an 
RPA, this window will be by-passed and will take you to the 
Available Core Documents Window in step 2. 
 
Select <My CDs>.  (This is used for illustration purposes only.) 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Opening a CD (continued) 
 

Step Action 
2 The Available Core Documents window opens a listing of Core 

Documents, which includes PP, Series, Title, Grade, CD Name, 
Agency, and CPO.  
Select the CD you need to modify and select <OK>.   
 

 
 

3 
 
 
 
 
 
 
 
 
 
 
 

The Core Document Development System window opens. 
Select Edit. 
 

 
 
Note:  You can modify most data fields in a CD, except those 
determined by your Component’s business rules. 

 
Continued on next page 
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Modifying a Core Document, Continued 

   
Edit Menu The Edit Menu contains 15 options to use in modifying a CD: 
 

Menu Item Function/Description 
Goals and Purpose  Use to change the Organizational Goals and 

Purpose. 
Major Duties  Use to modify duties and tasks. 
Percentages Use to change the percentages of time assigned. 
Knowledge Factors Use to edit the classification Knowledge factors. 
Other Factors  Use to edit other classification factors. 
KSAs 
(Competencies)  

Use to add, delete, or modify the Basic KSAs. 

Select Staffing KSAs  Use to select or deselect previously selected staffing 
(requirement) KSAs. 

Other Work 
Requirements  

Use to modify, add, or delete supplementary duties 
and responsibilities. 

Performance 
Management Plan 

Use to add, delete, or modify performance elements 
and standards. 

Title/Pay Plan/Series  Use to change title series, and/or pay plan. 
Cover Sheet  
  

Used by supervisors and managers to complete and 
sign a cover sheet. The Cover Sheet option activates 
under the Edit and Reports toolbar menus when a 
CD has been attached to an RPA. 

Classification 
Remarks  

Use to add remarks to the summary information. 

More Occupations  Use to add duties from a different Occupational 
series. 

Classification 
Summary  

Use to view the classification summary. 

Exit  Use to exit and return to the Main Coredoc 
window. 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Modifying Goals and Purpose  
 

Step Action 
1 
 
 

Select Goals and Purpose. 
 

 
The Core Document Development System – Goals and Purpose 
window opens. 
  

 
 
There are three Taskflow buttons:   
• <Edit>- - Allows you to modify the goals and purposes. 
Note:  When you select <Edit>, the <Exit> Button will change to    
            <SAVE>. 
• <Standard Goals> - Auto populates the organization’s name  
                                         and goals in the designated fields. 
• <Exit> - Returns you to the Core Document Development    

               window. 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Modifying Goals and Purpose (continued) 
 

Step Action 
2 Place your cursor in the data field that needs editing.  Select 

<Edit> and make the necessary changes. 
3 
 

Select <Save> to save your changes.   
 
Note:  The button returns to <Exit>, once Save is selected. 

4 Select <Exit> to return to the Core Document Development 
window. 
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Modifying a Core Document, Continued 

 
Editing Major Duties  
 

Step Action 
1  Select Edit, then select Major Duties on the Main Menu Bar. 
2 The Core Document Development System - Major Duties 

window opens with the information automatically populated. 
 

 
 

3 Select <Edit> to edit the displayed duty statement, or  
Select <Next> to view the next duty statement, or  
Select <Add> to add a new duty statement, or  
Select <Delete> to delete the current duty statements, or  
Select <Relation> to understand the connections between   
            individual duty statements and the classification knowledge  
            and training competencies, or 
Select <Exit> to exit the window. 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Editing Major Duties (continued) 
 

Step Action 
4 Select <Edit> to display the Edit Options Dialog Box, which 

allows you to select one of the three options, described in clear 
text. 
 

 
 
Select Current Text. 

5 The Duty Statement for Level 1 window opens. 
Place your cursor in one of the text boxes to change any of the text 
or to delete the current text and type in the new text.  
Select <Edit> to modify the text.  The duty statement opens.  
Delete and make changes as needed. 

6 Select <Save>. 
7 Select <Next> to view the next duty statement on the Core      

                       Document Development System – Major Duties    
                       window.  Use your Edit and Save buttons to  
                       continue editing your document, or  
Select <Add> to add a new duty statement to the Core Document  
                      Development System – Major Duties window, or  
Select <Delete> to delete a duty from the Core Document  
                       Development System – Major Duties window. 

8 Select <Exit> when you complete editing the major duties. 
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Modifying a Core Document, Continued 

 
Modifying Percentages of Assigned Duties  
 

Step Action 
1 Select Edit and select Percentages on the Main Menu Bar. 
2 The Percentages of Time window opens with a list of duties 

selected for a CD and the percentages of time spent performing 
each duty or work objective with the total percentage shown at the 
bottom.  Normally, it totals 100 percent but may fall within a range 
of 90-100.  If the total is more than 90 and less than 100, the 
additional duty statement “Performs Other Duties as Assigned” 
opens. 

Select the desired number to be changed and enter the new 
number.  

If you select the CRITICAL/NONCRITICAL setting, a column 
opens between percentage and duty. All duties are indicated as 
critical with a “C” in the column. To change a duty to non-critical, 
type an “N” over the desired “C” in the column. 

 

 
 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Modifying Percentages of Assigned Duties (continued) 
 

Step Action 
3 Select <Continue>. 
4 The Please Wait Dialog Box opens stating “Processing 

information into the database…” 
5 The Available Titles window opens.  Make modifications as 

needed using these buttons. 
Select <Select> - to make the title selection. 
Select <Information> - to see information about titling practices 
appropriate for the position. 
Select <Exit> to return to the Main Menu. 
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Modifying a Core Document, Continued 

  
Editing Knowledge Factors  

Step Action 
1 Select Edit and select Knowledge Factors on the Main Menu Bar. 
2 The Core Document Classification Knowledge Factors window 

opens. 
Select <Add> to include a new knowledge factor, which creates a 
new record and attaches it, to the end of the knowledge factors 
section.  
 

 
 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Editing Knowledge Factors (continued) 
 

Step Action 
3 
 
 

The Core Development System – Classification Knowledge 
Factors window opens.  Type in the additional knowledge factor 
in the Description field. 
Select <Add>. 
 
Caution: If you delete a classification knowledge, it could     
               impact on the classification of the position. 
 

 
 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Editing Knowledge Factors (continued) 
 

Step Action 
4 The Knowledge Factor Level Flexfield opens. Select Level and 

Points. Select <OK>. 

 
 

5 The Link to duty?  Dialog Box opens and asks, “Do you want to 
link it to a duty in order to display it in the Core Document?” 
 
Select <Yes>. 
 

 
 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Editing Knowledge Factors (continued) 
 

Step Action 
6 The Link Knowledge Factor to Duties window opens.  Select 

one of the two Taskflow buttons.   
<Select All> - Links the new knowledge factor with the duty                          
statements. 
<Continue> - Returns to the previous window. 
To select a related duty, select on the check boxes next to a duty 
name.  
You can select <Select All> or select individually by checking the 
related check boxes. 
 

 
 
Select <Continue>. 

7 
    

The Core Document Development System – Classification 
Knowledge Factors window opens. 
Select <Exit> to return to the Main Menu.  
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Modifying a Core Document, Continued 

  
Editing Other Factors  
 

Step Action 
1 Select Edit and select Other Factors on the Main Menu Bar. 
2 The COREDOC (Other Factors) window opens.  

<Edit> –Edits a classification factor. 
<Next> - Views the next knowledge factor. 
<Library> - Lists other factor level options from the 
occupational database library. 
<Exit> – Returns to the Main Menu. 
 

 
 
Select <Edit>. 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Editing Editing Other Factors (continued) 
 

Step Action 
3 The CORE DOCUMENT (Other Factors) window opens. Make 

the necessary changes in the knowledge factors in the Description 
field. 
 

 
 
Select <End>. 

4 You are returned to the CORE DOCUMENT [Other Factors] 
window.  Select <Exit> to return to the Main Menu. 
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Modifying a Core Document, Continued 

  
Editing KSAs (Competencies)  
 

Step Action 
1 Select Edit, and then KSAs on the Main Menu. 
2 The Core Document - KSAs Competencies window opens.  You 

are presented with six buttons from which to make a selection. 
<Edit> –Edits the displayed competency (KSA). 
<Next> – View the next competency (KSA). 
<Add> – Add a new competency (KSA). 
<Delete> –Delete the current competency (KSA). 
<Link> –Links one or more competencies to a Duty  
                Statement. 
<Exit> – Returns to the Main Menu. 

Select <Link>. 
 

 
 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Editing KSAs (Competencies) (continued) 
 

Step Action 
3 The Link KSA to Duties window opens with two buttons. 

Select the check boxes next to duties, as needed.  
Select <Continue>.  
 

 
 

4 You are returned to the previous window.  Select <Exit> to return 
to the Main Menu.  
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Modifying a Core Document, Continued 

  
Editing Staffing KSAs  
 

Step Action 
1 Select Edit, then select Select Staffing KSAs on the Main Menu. 
2 The Core Document Development System – Staffing KSAs 

window opens. 
Select the appropriate check boxes next to each KSA Competency. 
Select <Exit> to return to the Main Menu. 
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Modifying a Core Document, Continued 

   
Modifying Other Work Requirements  
 

Step Action 
1 Select Edit, and then Other Work Requirements on the Main 

Menu. 
2 The Core Document Development System – Other Work 

Requirements window opens. 
Select <Library> to view a list of supplemental items for an 
occupational series. 
 

 
 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Modifying Other Work Requirements (continued) 
 

Step Action 
3 The Supplementary List window opens.  Select the check boxes 

desired from the Supplementary List and select <Continue>. 
 

 
 

4 The Forms Dialog Box opens, asking, “Are you finished selecting 
supplementary information from Library?” 
Select <Yes>. 
  

 
 

5 The Core Document Development System – Other Work 
Requirements window opens again with your changes.  Review 
and select <Exit> to return to the Main Menu. 
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Modifying a Core Document, Continued 

   
Modifying the Performance Management Plan  
 

Step Action 
1 Select Edit, and then select Performance Management Plan on 

the Main Menu. 
2 The Core Document Development System – Performance 

Management Plan opens with four Taskflow buttons. 
Select <Duties> to select the Standard Performance Requirements. 
 

 
 

3 

 
 

Note:  The Main Menu or a component-specific Performance 
Management Plan window will display.  The window opens if a 
CPCN assigned to the core document.  
Select <Edit> to modify a performance element.  Use the scroll 
bar 
to navigate through the performance elements.   
Select <Delete> to remove all of the performance elements from 
the CD. 

4 Select <Exit> to return to the Main Menu. 
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Modifying a Core Document, Continued 

   
Editing the Title/Pay Plan/Series  
 

Step Action 
1 Select Edit, and then Title/Pay Plan/Series on the Main Menu. 
2 The Core Document Development System – Title, Pay Plan, 

Series, Grade window opens. 
Select <Edit>. 

 
 

3 The same window opens with Official Title highlighted and the 
three option buttons <Edit>, <Title>, and <Exit>. 
Select Title. 

4 The Available Titles window opens with three Taskflow buttons. 
<Select> - To make the title selection. 
<Information> -To view Occupational Information. 
<Exit> -To return to the previous screen. 

Select your title selection and Select <Select>.   

 
5 The Core Document Development System – Title, Pay Plan, 

Series, Grade window opens with the newly selected title.  
Select <Exit> to return to the Main Menu. 
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Modifying a Core Document, Continued 

  
Editing the 
Cover Sheet 

Note: Only users with the Classifier or Super User role can access the Cover 
Sheet.  The Cover Sheet will vary from Component to Component. 

 
Step Action 

1 Select Edit then Cover Sheet on the Main Menu. 
2 The Core Document – Cover Sheet window opens with four 

Taskflow buttons.  Change information in the needed data fields. 
Select Save and then Select <Next>. 
 

 
 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Editing the Cover Sheet (continued) 
 

Step Action 
3 Core Document Cover Sheet – Screen 2 of 3 opens with five 

Taskflow buttons.  Input information in the needed data fields. 
Select Save and then select <Next>. 

 
 

4 Core Document Cover Sheet – Screen 3 of 3 opens with four 
Taskflow buttons.  Change information in the needed data fields. 
Select <Save>. 

 
5 Select <Exit> to return to the Main Menu. 
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Modifying a Core Document, Continued 
  

Editing Classification Remarks  
 

Step Action 
1 Select Edit, then select Classification Remarks on the Main 

Menu 
2 The Core Document Development System – Classification 

Remarks window opens with two Taskflow buttons. 
Select <Edit> and place your cursor in the Classification Remarks 
data field and type your input. 
Select <End Edit> once you have finished.  

 
 

3 Select <Exit> to return to the Main Menu. 
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Modifying a Core Document, Continued 
 

 
Adding More Occupations  
 

Step Action 
1 Select Edit, and then More Occupations on the Main Menu. 
2 The Occupations to Select from window opens.  Select the 

occupation(s) you plan to add.  Select <OK>. 
 

 
 

3 The Core Document Development System window opens with 
three Taskflow Buttons. 
The message asks, “PLEASE CONFIRM FOLLOWING WORK 
SITUATION.”  Review the information. 
Select <Exit>.  
 

 
 

 
Continued on next page 
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Modifying a Core Document, Continued 

  
Adding More Occupations (continued) 
 

Step Action 
4 The Core Document Development System window opens.  The 

contents of the added occupation are displayed and ready to be 
printed, if desired. Select <Exit> to return to the Main Menu. 
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Modifying a Core Document, Continued 

 
Adding the Classification Summary  
 

Step Action 
1 Select Edit, and then select Classification Summary on the Main 

Menu. 
2 The Core Document Development System – Classification 

Summary window opens.  It provides a brief explanation of the 
basis for the classification title, pay plan, series, and grade.  
• The CD Number and Title are at the top.  
• A brief explanation states how the percentages of time for the 

duties affect the classification.  
Note:  You cannot edit the information.  Changes made to title, 
pay plan, series, any duty, factor, or Competency (KSA) made 
earlier will be noted here. 
 

 
 

3 Select <Exit> to return to the Main Menu. 
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Attaching a Core Document to the Request for Personnel 
Action (RPA)  

  
Purpose Many Request for Personnel Actions (RPAs) require a core document (CD).  

You can attach a CD to a previously completed RPA or create a new RPA 
and attach a CD.  This procedure guides you through attaching a CD to the 
RPA after the position has been built. 

  
Section 
Contents  

• Retrieving the RPA 
• Attaching the Core Document 
• Assigning a CPCN 
• Creating a Cover Sheet 
• Exiting, Saving, and Routing 

   
Before You 
Begin 

• The following sequence of events occur when attaching a CD to the RPA: 
A.  Create a Core Document (CD) 
B.  Preview a CD 
C.  Attach a CD to the RPA 

• You can attach a CD to the RPA without assigning a CPCN or a Cover 
Sheet, and you do not have to have a position attached to an RPA. 

• To assign a CPCN to a CD, it must first be attached to the RPA.  The 
CPCN includes the PD# and the Sequence # as they appear on the 
position Name data field of the Position Window.   

• You can create a CD through the COREDOC Application or through the 
RPA.  

• In order to create or edit the Cover Sheet on the CD, it must first be 
attached to an RPA. 

• Only users with a classifier role can assign CPCNs and edit cover sheets. 
• The RPA Windows and buttons are explained in detail in Module 3. 
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Attaching a Core Document to the Request for Personnel 
Action (RPA), Continued 

 
Retrieving the RPA  

Step Action 
1 Navigation Path  →  Request for Personnel Action  →  

Recruit/Fill  →  <Open>. 
2 
 
 
 
 
 
 
 
 
 

Page 1 of 4 of the Request for Personnel Action window 
(Recruit/Fill) opens. You will use this RPA to attach the CD. 
With the cursor in Block 6, Action Authorized By data field, select 
the LOV on the Toolbar, click selection, and select <OK>. 

  

3 Select <Others…>. 
4 The Navigation Options window opens.  

 
 

Select Coredoc and <OK>. 
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Attaching a Core Document to the Request for Personnel 
Action (RPA), Continued 

  
Attaching the Core Document  
 

Step Action 
1 The Coredoc Attach Detach Screen window opens.  Four options 

are listed.   
 

 
Select ATTACH to attach a previously built COREDOC. 

 
2 The Attach Core Document window opens.   

 

 
 

Select the CD you want to attach to the RPA.  
3 Select <OK>. 
4 The Coredoc Attach Detach Screen window opens again.   

• The ATTACH button has a dotted line around it to indicate 
the CD is attached.   

Select the COREDOC button to open the Core Document 
Development System Window to insure it has been attached. 
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Attaching a Core Document to the Request for Personnel 
Action (RPA), Continued 

    
Assigning a CPCN   

 
Step Action 

1 
 
 

To assign a CPCN to the CD, select Utility on the Main Menu and 
then select Assign CPCN. 
Note: Before you can assign a CPCN to a CD, it must be attached 
to the RPA.  

 
 

2 The Action — Assign CPCN window opens. 
 

         
 
Input the PD Number and the Sequence Number. 
Both numbers are from the Position Build. 
Select <OK>. 
 

 
Continued on next page 
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Attaching a Core Document to the Request for Personnel 
Action (RPA), Continued 

  
Attaching the Core Document (continued) 
 

Step Action 
3 The Please Confirm Action window opens. 

 
 
Select <Yes>.  The Record Update window opens briefly. 
 

4 The Core Document Development System window opens with 
the CPCN in the CPCN data field.  
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Attaching a Core Document to the Request for Personnel 
Action (RPA), Continued 

  
Attaching the Core Document 
 

Step Action 
1 Select Edit and select Cover Sheet on the Main Menu.   

Note:   
• The CD must be attached to an RPA to access the cover sheet.   
• You must be in a Classifier or Super User role to access the 

cover sheet. 

2 The Core Document – Cover Sheet window opens with four 
Taskflow Buttons. 
 

 
 

< Help> - Accesses an LOV for a data field on the Cover   
                  Sheet. 
<Next> -  Opens the next page of the Cover Sheet for     
                  viewing. 
<Save> -   Saves the information entered on the window. 
<Exit> -    Returns to the Main Menu Window. 

 
Input the information required in the data fields.  
Select <Save>.  Select <Next>. 

 
Continued on next page 
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Attaching a Core Document to the Request for Personnel 
Action (RPA), Continued 

  
Attaching the Core Document (continued) 
 

Step Action 
3 The Core Document Cover Sheet – Screen 2 of 3 window opens.   

Input the required information in the data fields. 
 

 
 

Select <Next>. 
 

Continued on next page 
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Attaching a Core Document to the Request for Personnel 
Action (RPA), Continued 

  
Attaching the Core Document (continued) 
 

Step Action 
4 The Core Document Cover Sheet – Screen 3 of 3 window opens.   

Input the needed information in the required data fields. 
 

 
 

Select <Save>.  A Dialog Box opens, asking:  “Do you really want 
to save?”  Select <Yes>. 

5 Select <Exit> to return to the Main Menu. 
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Attaching a Core Document to the Request for Personnel 
Action (RPA), Continued 

   
Exiting, Saving and Routing   

 
Step Action 

1 Select Edit on the Main Menu Bar and then select Exit. 

 
 

2  The Coredoc Attach Detach Screen window opens.  

 
 
Select EXIT.  

3 The Request for Personnel Action window opens.  Select Save 
on the Toolbar. 

4 The Dialog Box opens and asks, “Do you wish to route the 
Request for Personnel Action now?” 
Select <Yes>. 

 
Continued on next page 
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Attaching a Core Document to the Request for Personnel 
Action (RPA), Continued 

  
Exiting, Saving, Routing (continued) 
 

Step Action 
5 The Routing window opens with the “Save and Hold in Personal 

Inbox” selected.   Select <OK>. 
 

 
 

6 Select File on the Main Menu Bar of COREDOC Development 
System window.   From the drop-down menu, select Exit. 

 
 

 
Continued on next page 
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Attaching a Core Document to the Request for Personnel 
Action (RPA), Continued 

 
Exiting, Saving, Routing (continued) 
 

Step Action 
7 A Confirmation Dialog Box opens. 

Select <Yes>. 
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Module 3 

Processing Requests for Personnel Actions Using the 
DCPDS 

Module Overview 

  
Purpose This module introduces you to the Request for Personnel Action (RPA), how 

to access, process, print, view, and save personnel actions.  Additionally, 
examples of RPAs for Appropriated Fund Employees, Nonappropriated Fund 
(NAF) Employees, and Local Nationals (LNs) are shown. 

    
Module 
Contents 

 

Topic Page 
Overview:  Request For Personnel Action Overview O-1 
Chapter 1:  Processing A Request for Personnel Action 1 

Overview 1 
Request for Personnel Action 2 

Taskflow Buttons 4 
History Taskflow Button 5 
Extra Information Taskflow Button 5 
Person Taskflow Button 7 
Position Taskflow Button 8 
Others Taskflow Button 9 

Requesting Info Tab - Part A - Requesting 
Office 

10 

Requesting Info Tab - Part B – Preparation of 
SF 50 

13 

Position Data Tab 16 
Position Data Tab - From and To Information 17 
Employee and Position Data Tab – Employee 
Data 

18 

Employee and Position Data Tab – Position 
Data 

20 

Remarks and Address Tab 23 
 

Continued on next page 
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Module Overview, Continued 

  
Module Contents (continued) 
 

Topic Page 
Chapter 1:  Processing A Request for Personnel Action 
(Cont) 

 

Saving and Routing a Request for Personnel Action 25 
Printing a Request for Personnel Action/Notification 31 

Chapter 2:  Accessing Requests for Personnel Action 2-1 
Accessing Personnel Actions from the Navigator 
Window 

2 

Viewing Personnel Actions from the Navigator 
Window 

7 

Viewing Status of Your RPA Requests  7 
View a Request for Personnel Action 8 
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Overview:  Request for Personnel Action 

   
 Introduction The Request for Personnel Action (RPA) enables supervisors and managers to 

request employee and position actions.  It allows the Human Resources Office 
(HRO) to record staffing and classification actions, as well as make personnel 
record changes.  The DCPDS configures the RPA form to meet the 
requirements based on the Nature of Action (NOA) family selected, the user’s 
role and responsibility, as well as any other security measures determined by 
your Component and local policy.   
 
The RPA is an interactive process that automates the creating, editing, 
approving, coordinating, and tracking of personnel actions.  It provides a 
single, integrated process to supervisors, managers, personnelists, manpower, 
and payroll to manage personnel actions electronically, route to the 
appropriate officials, and provides reports.   
 
This module explains how to use the automated RPA to process personnel 
actions and collect personnel data. 

 
See Also 

 
Related information is contained in: 

Module 1, Fundamentals of the DCPDS 
Module 2, Position Management and Classification Module Using the 
DCPDS: 

Chapter 1, Building Positions 
Chapter 2, Managing Positions 

Module 6, Administering Pay, Benefits, and Entitlements Using the 
DCPDS 
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Overview:  Request for Personnel Action, Continued 

 
Before You 
Begin 

• Once you have entered information into the RPA, you will route it to the 
appropriate office or person for regulatory data and signature.  Then that 
office or person will route the action to the next person in the routing list 
or group box as designated by the Component.  

• When the action has been approved and the record updated, you will be 
able to: 
• Print a Notification of Personnel Action (NPA), on or after the 

effective date. 
• The shading of the data fields in the RPA indicates inaccessible data 

fields; have read-only capability; or where you can enter data. 

  
Types of Data 
Fields 

The following table represents the data field shading and access level. 

 
Field Color Action Methodology 

White You can enter or edit the 
data in the data field. 

You can enter data or the data 
field is automatically populated. 

Light Gray You can only view the 
information in the data 
field. 

Data field is automatically 
populated and you can not 
change the information. 

Dark Gray You cannot enter or view 
the information in the field. 

Data is not accessible to you in 
your present role and 
responsibility. 

Yellow You must enter data. This is a required field. 
 

               
Note:  For security reasons, the application will not allow you to process your 
own RPA, nor will you be able to view your own RPA in any groupbox to 
which you belong.  Also, the person’s RPA that you are processing can not be 
routed to that person for any type of action. 
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Processing an RPA Based on Role 

  
Roles and 
Responsi-
bilities 

The amount of information that you complete on the RPA is dependent on the role 
and responsibility that you are assigned and your Component’s business rules. 
You can have more than one role for a given routing group and you may belong to 
more than one group box group.  The table below describes the combination of 
roles for an RPA. 

 
 

If your Role is You can… You can also be assigned 
additional roles(s) as… 

Initiator 

  Note:  An 
RPA cannot be 
routed to an 
Initiator unless 
they are also 
assigned 
additional roles. 

Create an RPA. Requester 
Authorizer 
Personnelist 
Approver (if you have the 
role of Personnelist) 

Requester Sign in the Requester data 
field and edit data of the 
RPA.  The Supervisor can 
use the LOV to select their 
own name while the 
Personnelist can select from 
many names. 

Initiator 
Authorizer 
Personnelist 
Approver (if you have the 
role of Personnelist) 

Authorizer Sign in the Authorizer data 
field and edit the RPA.  The 
supervisor can use the LOV 
to select their own name 
while the Personnelist can 
select from many names. 

Initiator 
Requester 
Personnelist 
Approver (if you have the 
role of Personnelist) 

Personnelist Review the data of the RPA, 
edit the RPA, and submit the 
RPA to Update HR, if 
assigned the Approver role. 

Initiator 
Requester 
Authorizer 
Approver 

 
Continued on next page 



  R12 March 2012 

Processing Personnel Actions:  Overview                                   Mod 3, Overview, Page 6 

Processing an RPA Based on Role, Continued 

  
Roles and Responsibilities (continued) 
 

If your Role is You can… You can also be assigned 
additional roles(s) as… 

Reviewer View and route the RPA. Initiator 
Approver 
. 

Edit the RPA, complete the 
RPA, approve the RPA, 
and submit the RPA to 
Update HR. 

 
 

Initiator 
Requester 
Authorizer 
Personnelist  

Note:  Managers and 
supervisors are often assigned 
the role of Initiator, Requester, 
Authorizer, or Reviewer based 
on Component requirements 
and business rules. 
Personnelist and Approver 
roles are often dependent on 
Component business rules. 
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Module 3 

Chapter 1 

Processing a Request for Personnel Action 

Chapter Overview 

  
Introduction This chapter describes the process of creating a Request for Personnel Action 

(RPA) using the DCPDS.  It is an interactive process that automates the 
initiating, editing, approving, and coordinating personnel actions between 
supervisors, managers, personnelists, manpower, and payroll.  

  
Chapter 
Contents 

 

Topic Page 
Overview 1 
Request for Personnel Action 2 

Taskflow Buttons 4 
History Taskflow Button 5 
Extra Information Taskflow Button 5 
Person Taskflow Button 7 
Position Taskflow Button 8 
Others Taskflow Button 9 

Requesting Info Tab - Part A - Requesting Office 10 
Requesting Info Tab - Part B – Preparation of SF 50 13 
Position Data Tab 16 
Position Data Tab - From and To Information 17 
Employee and Position Data Tab – Employee Data 18 
Employee and Position Data Tab – Position Data 20 
Remarks and Address Tab 23 

Saving and Routing a Request for Personnel Action 25 
Printing a Request for Personnel Action/Notification 31 
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Chapter Overview, Continued 

   
Before You 
Begin 

 

• If your role is as an initiator, you create/initiate an RPA from the 
Navigator window menu. 

• If your role is one of responding to an RPA that has been routed to you, 
select the Civilian Inbox menu on the Navigator window. 

• The DCPDS configures the RPA based on the Nature of Action (NOA) 
family selected by you, your role and responsibility, and security 
measures set up by the DCPDS and your Component. 

• Lists of Values (LOVs) simplify data entry and decrease the chance for 
error.  Business rules automate the form by performing calculations and 
validating data for you. 

• For security purposes, the system administrator determines which menu 
you will see and restricts your access to personnel records by organization 
and position based on your role and responsibility. 

• DCPDS simplifies data entry for the RPA by: 
• Grouping NOA Codes (NOACs) into families of related actions. 
• Shading of data fields to indicate where to enter data. 
• Automatically entering any related information based on the 

person and position. 
• Supplying default values for Extra Information windows from 

the relational database. 
• Providing shortened LOVs of Legal Authorities and Remarks that 

apply only to the NOA on the RPA. 
• Computing pay amounts based on pay table, pay plan, grade, step, 

pay rate determinant, duty location, and effective date of the 
action. 

   
Request for Personnel Action 

  
Accessing the 
Request for 
Personnel 
Action 

From the Navigator window, follow this path to access the RPA window to 
create an RPA or to access any of the menu options listed under Request for 
Personnel Action.   
 
Navigation List → Request for Personnel Action → Appointment →   
<Open> (or any of the NOAs listed under the Request for Personnel Action 
menu) to display the RPA – Page 1 window.  Appointment is used in this 
example to explain the type of information you must enter or automatically 
populated by the DCPDS application when you initiate an RPA. 
 

Continued on next page 
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Request for Personnel Action, Continued 

  
Request for Personnel Action (continued)   
 

A description of the buttons located at the top of the RPA –Requesting Info 
tab is discussed below. 

Buttons Description/Function 

 
 
 

             

Routing Group Button provides you the opportunity to 
change the routing group for the action you are processing 
to another routing group.  Everyone belongs to at least one 
routing group. 
 
Note:  Only one Routing Group may be maintained at the 
Region.  Component business rules will make this 
determination. 

 

Note Pad Button permits you to make comments about the 
action that you are processing or see notes written by others 
in the routing groups.  Other routing group members can 
read the note, change, amend, and delete the action.  The 
Civilian Inbox indicates if there is a note with an RPA.  The 
note will remain with the RPA History, even if a user 
deletes it. 

 
           
 

 

Change Family Button allows you to change the Nature of  
Action family to a different action.   
 
 
Caution:  If you change the NOA to a different family, 
some of the information on the RPA will be deleted.  A 
message will display with information on what is being 
deleted. 

 
Refresh Button allows you to update “refresh” data when 
you have already selected a person or position on the RPA.  
Select a Taskflow Button, i.e., <Extra Information>, 
update the data on all areas that need to be updated, save the 
data, select <Refresh>, and the new data will populate the 
RPA data fields. 

 The Status line indicates what type of action has occurred 
for an RPA.  This line displays after the action has been 
saved; e.g., Authorized, Approved, Update HR Complete. 

 
Continued on next page 
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Request for Personnel Action, Continued 

  
Taskflow Buttons 
 
 
 
 
 
 
 
 
 

 

There are five Taskflow Buttons at the bottom of each RPA page.  These 
buttons are used to provide additional information that is not included on 
the RPA.   
• The Taskflow Buttons access windows used to provide additional 

information such as education, security clearance, position 
description, benefits, etc.   

• This information can be an initial input, an update, and reviewed from 
the RPA. 

• If information in the Taskflow Buttons is not complete, the RPA will 
not update the employee’s record.   

Note:  You can access these Taskflow Buttons at any time while in the 
RPA; however, you must always save any work you have completed prior 
to accessing the Taskflow Buttons.  After saving, follow any directions 
that are displayed on the screen.   

  
Taskflow Buttons 
Location 

 
 
 

  
 

Continued on next page 

Taskflow Buttons 
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Request for Personnel Action, Continued 

 
Taskflow Buttons (continued) 
 

 

Taskflow 
Buttons 

Description/Function 

 
 
 
 

 
 

<History> button displays the Routing History window 
that shows a history of the RPA action – who initiated the 
request, who approved it, who reviewed it, etc.  You can 
see the progress as it is routed, including the personal 
inboxes and groupboxes.   
Note:  Information cannot be changed in this window.  It 
is for viewing/read only. 

 

 
 
 
 
 
 
 
 

 

<Extra Information> Taskflow button allows you to 
view, change, or input new information in the Extra 
Request Information Type.  

Illustrations of Extra Request Information Types are 
displayed below.  Components will determine if they 
need to be completed unless it is an OPM requirement.  
Use the scroll bar to see all the additional. 

 
 

Continued on next page 
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Request for Personnel Action, Continued 

  
Taskflow Buttons (continued) 
 
 

Taskflow 
Buttons 

Description/Function 

Extra 
Information 

Window 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To input data in the Type categories of the Extra 
Information window, scroll to the Type needed.  Select 
the “white” area of the Details data field to open a 
window to input the appropriate information.   

 
 
Extra PA Request Information window.  Complete the 
data fields by using the LOV button located in this 
window next to the question mark.   

 
 
Select <OK>.  The Details data field populates.  Continue 
this process of selecting Type, Details, and <OK> to 
complete the information for the Extra Request 
Information window. 

 
 
Note:  You must save your work after you have 
completed the information for each Extra PA Request 
Information window.  

 
Continued on next page 
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Request for Personnel Action, Continued 

  
Taskflow Buttons (continued) 
 
 

Taskflow 
Buttons 

Description/Function 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

<Person> Taskflow button displays the People window 
with information on the employee whose action you are 
processing.  A completed record is displayed only if you 
have entered a name in Part B of the RPA.   

 
 
Note:  You can make changes in the People window or 
create a new record here.  Just remember to Date Track to 
the effective date of the action or before the date of the 
appointment.  

 
Continued on next page 
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Request for Personnel Action, Continued 

  
Taskflow Buttons (continued) 
 
 

Taskflow 
Buttons 

Description/Function 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

<Position> Taskflow button displays the Position 
window for the RPA you are processing, if the To Side 
data fields are completed.   

 
 
Notes:   
• You can build a position from the RPA by selecting 

<Position>.   
• The date your position is established must be on or 

before the effective date of the RPA.  You will need 
to date track, if it is not. 

 
 

Continued on next page 
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Request for Personnel Action, Continued 

  
Taskflow Buttons (continued) 
 

Taskflow 
Buttons 

Description/Function 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

<Others> Taskflow Button displays a Navigation 
Options window.   
Highlight anyone of the options; select <OK> and make 
updates, if necessary. 

 
Selecting COREDOC displays the Coredoc Attach 
Detach Screen window with options that can be 
accomplished from the RPA.  Follow the directions 
displayed on the screen. 

 
After reviewing all the Navigation Options and making 
any changes and saving, select <OK> to return to the 
RPA.  If the RPA is ready to save and process, follow the 
instructions for routing to Route or Update HR. 

 
Continued on next page 
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Completing the Request for Personnel Action 

 
Requesting Info 
Tab - Part A - 
Requesting 
Office 

This section explains how to complete the RPA.  Data fields are described 
and the actions explained.  The white data fields must be completed.  The 
Nature of Action (NOA) selected, determines the fields to be completed.  An 
appointment action is used as an example. 

 
 

Data Field Description/Action 
Actions 
Requested 

The data field automatically populates based on the action 
selected from the Navigation List → Request for Personnel 
Action. 

Request 
Number 

Each RPA is assigned a ‘Request Number’ by the DCPDS 
after the RPA is saved for the first time.  The ‘Request 
Number’ format is YYMMM/9-character Identifier 
(determined by the Component)/6-Digit Sequential Number 
(system generated).  

For 
Additional 
Information 
Call 
 
 
 

 

If you are the person to contact about this action, type in 
your name or the name of the contact person.  The data field 
can be left blank. 

      Or 
Select the LOV for a listing of database names, select the 
correct name from the LOV, and select <OK>.   
 
Notes:   

• If a screen is displayed asking you to reduce the list, 
type a few letters of the last name of the individual, 
followed by the % sign; or input a % sign and select 
<OK>. 

• If you type in the name of a person to contact or any 
other names in Part A, the name must be entered as 
listed in the database. 

 
Continued on next page 
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Request for Personnel Action, Continued 

  
Requesting Info Tab - Part A - Requesting Office (continued) 
 

Data Field Description/Action 
Telephone 
Number 

Type in the telephone number of the person to contact about 
this action. 

Proposed 
Effective 
Date 
 
 
 

 

Type the proposed effective date for the action in the DD-
MMM-YYYY format; e.g., 09-JUN-2000 or the date will 
automatically default to ASAP.  Hyphens are required and 
the month is always capitalized. 

      Or 
Select the LOV on the Toolbar.  The current month and year 
with the current date highlighted is displayed in the 
Calendar Window.  Select the correct date and select 
<OK> to automatically populate the date field. 

ASAP 
 

                

 

Select this data field if you want the effective date on this 
action to be As Soon As Possible.   
Note:  You cannot select both a proposed effective date and 
the ASAP field.  If you do not check ASAP or enter a date, 
the system date will automatically default to ASAP. 

Action 
Requested 
By 
 
 

               

 

Type in your name, if you have the role of the Requestor or 
Personnelist.  
      Or 
Select the LOV for a listing of names given the 
responsibility of requesting.  Select the correct name and 
select <OK> to automatically populate the data field.   
Note:  A manager/supervisor who does not have the 
personnelist role will only see their own name on the LOV. 

Title The Requestor’s title automatically populates this field. 
Request 
Date 

The date is automatically populated once the Action 
Requested By data field is completed.  You can change the 
date by typing in a new date or use the LOV to select a 
month, day, and year. 

 
Continued on next page 
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Request for Personnel Action, Continued 

  
Requesting Info Tab - Part A - Requesting Office (continued) 
 

Data Field Description/Action 
Action 
Authorized 
By 
 
 
 

 

Type in your name if you have the role of the Authorizer or 
Personnelist.  You can also leave blank.  

      Or 
Select the LOV for a listing of names.  Select the correct 
name and select <OK> to automatically populate the data 
field. 
Note:  A manager or supervisor who does not have the 
personnelist role will only see their own name on the LOV. 

Title The Authorizer’s title automatically populates this field. 
Concurrence 
Date 

The date automatically populates once the Action 
Authorized By data field is completed.  The date can be 
changed by deleting it and typing in a new date. 

      Or 
Select the LOV on the Toolbar for a calendar.  Select the 
date needed (DD-MMM-YYYY) and then <OK> to 
automatically populate the data field. 

 
Continued on next page 
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Request for Personnel Action, Continued 

  
Requesting Info 
Tab - Part B – 
Preparation of 
SF 50   
 
 
 
 
 
 
 

 
 

 
 
Note:  It is important to complete the data fields in the following order. 
   

Data Field Description/Action 
Effective 
Date 
 

 
 

The Human Resource Office completes the Effective Date. 
By typing in the effective date using DD-MMM-YYYY 
format; e.g., 23-MAY-2000. 

      Or 
Select the LOV to display a calendar.  Select the correct date 
and select <OK>. 

Last Name  
 
 

 
 
 
 
 
 

 

Type in the last name or part of the last name of the person 
for which the RPA is being processed.  Press the [Tab] to 
automatically populate the data field. 
     Or 
Select the LOV on the Toolbar, select the name from the list 
displayed, and select <OK> to automatically populate the 
data field.   
If you select a name from the LOV, the First Name, Middle 
Name, Date of Birth, and Social Security Number data 
fields will automatically populate on the RPA. 
Note:  The list displayed in the LOV is dependent on the 
type of NOAC selected in data field 5A (Code).  In some 
instances fields are populated by Resumix. 

  
Continued on next page 
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Request for Personnel Action, Continued 

  
Requesting Info Tab - Part B – Preparation of SF 50 (continued) 
 

Data Field Description/Action 
Social 
Security 
Number 
 
 
 
 
 

              

Automatically populates based on the Name data field.   

      Or 
Select the LOV for a listing of SSNs.  You can type a % 
followed by a couple of numbers and a % and select TAB or 
[Enter] for a list of SSNs.  Select the correct SSN and name 
and select <OK>.  The First Name, Middle Name, Last 
Name, Date of Birth, and Social Security data fields will 
automatically populate. 
Note:  If you type in a social security number, the First 
Name, Middle Name, Last Name, and Date of Birth data 
fields will automatically populate based on the social 
security number you typed. 
 

5-A Code 
and 5-B 
Nature of 
Action Code 
 

 

 
 

Type in the Nature of Action Code (NOA). 
       Or  
Select the LOV to display a listing of NOACs, select the 
correct code, and select <OK> to automatically populate the 
Code and Nature of Action data fields.   
 
Note:  The Nature of Action should be selected before other 
personnel data fields on Part B are completed.  The NOA 
family selected will automatically populate some of the data 
fields.   
 

 
 

Continued on next page 
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Request for Personnel Action, Continued 

 
Requesting Info Tab - Part B – Preparation of SF 50 (continued) 
 

Data Field Description/Action 
5-C Code 
and 5-D 
Legal 
Authority 
Code 
 
 

 
 
 
 
 
 

 

Type in the Legal Authority Code that you need for this 
action.  Data block 5-D Legal Authority Code will 
automatically populate with the correct Legal Authority. 

      Or 
Select the LOV to display the Authority Code.  Select the 
appropriate code and select <OK>. 
 
Note:  The authority codes in the LOV reflect those that are 
applicable to the family of the NOA selected in the Nature 
of Action data field.   
 
Tab to the next data field and continue this process until you 
have completed all the Legal Authority Code data fields that 
need to be completed to process this action. 
 
Note:  A number of Codes will automatically populate data 
block 5D with the Legal Authority.  Some will have a blank 
space that needs an insertion value.   

 
 
With your cursor in the Block 5D, select [Tab] to display 
the PA Request First LA1 Insertion Values Window.  
Type in the information and select <OK> to populate the 
blank space in the Legal Authority data field. 

 
 

Continued on next page 
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Request for Personnel Action, Continued 

 
Position Data 
Tab  

The FROM INFORMATION and TO INFORMATION Regions are 
automatically populated or not populated based on the NOA selected.  If the 
data fields are white, you may need to complete them.  Information needed 
for the TO INFORMATION Region is described below.  The same 
information is applicable to the FROM INFORMATION Region, if not 
populated. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
 
Notes:   
• The Routing Group and Note Pad buttons are always located at the top of 

each page of the RPA.   
• Employee and SSN fields are automatically populated on each page of 

the RPA once a person has been identified with an action. 
• Nature of Action is automatically populated on each page of the RPA 

based on the NOA selected from the Navigation List or from the Change 
Family button.  

 
Continued on next page 
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Request for Personnel Action, Continued 

  
Position Data  
Tab - From and To 
Information   

 

Data Field Description/Action 
Position Title 
 
 
 
 
 

 

Select the LOV for a list of position titles available for 
this action.  The Reduction Criteria Window displays.  
Enter a few letters, followed by “%” and select <OK>.  
Select the desired position when displayed and select 
<OK> to populate the Position Title data field for your 
action. 
Note:  Your selection of a position automatically 
populates the following data fields:  Pay Plan, Occ 
Code, Grade or Level, and Pay Basis on RPA - Page 2. 
 

Pay Plan;  
Occ. Code;  
Grade or Level; 
and Pay Basis  

These data fields automatically populate based on the 
position selected.  Certain pay plans, grades, pay tables 
or pay rate determinate may also require users to type in 
the salary fields. 
 

Step or Rate 
 
 
 
 

 
 

 

Type a two number digit; e.g., "01," in the data field. 
      Or 
Select the LOV, select the correct step or rate, and select 
<OK> to automatically populate the data field.   

The Pay Rate Determinant is defaulted to “0.”  You can 
change to the correct value if zero does not apply. 
Note:  Your input of a step or rate may automatically 
populates the following data fields:  Total Salary, Basic 
Pay, Locality Adj, Adj Basic Pay, and Other Pay on 
RPA – Page 2.  The Effective Date must be inputted 
before your pay will calculate properly. 
 

Total Salary; 
Basic Pay; 
Locality Adj; 
Adj Basic Pay; 
and Other Pay 

These data fields may automatically populate based on 
your input of a step or rate.  Centrally maintained Tables 
keep this information up-to-date at all times. 

 
Continued on next page 
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Request for Personnel Action, Continued 

  
Position Data Tab - From and To Information (continued) 
 

Data Field Description/Action 
Award Enter the amount of a monetary award or the number of 

hours in this data field if this is an awards NOA.  
Otherwise the data field is dark. 
 

UoM Enter the required Unit of Measure either ‘H’ for hours 
or ‘M’ for money if an awards action.  The data field is 
dark if this is not an award NOA. 
 

Name and 
Location of 
Position’s 
Organization 
(Data fields 14 
and 22) 

Information is automatically populated depending on the 
RPA action.  Information completed in Building a 
Position and the Organization’s Address provides this 
data. 
See Module 2, Position Management and Classification, 
Chapter 1, Building a Position, Section, Building a 
Position’s Organization Address. 
 

  
Employee and 
Position Data 
Tab – 
Employee Data 

 

 
 

 
Continued on next page 
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Request for Personnel Action, Continued 

  
Employee and Position Data Tab – Employee Data (continued) 
 

Data Field Description/Action 
Veterans 
Preference 
 

 

For actions other than Appointment, the employee’s 
record automatically populates this data field.  For a 
Change NOA or if input is required, select the LOV and 
select the applicable veteran’s preference for an 
Appointment and select <OK>.  

Tenure For actions other than Appointment, the employee’s 
record automatically populates this data field.  For a 
Change NOA or if input is required, select the LOV and 
select the applicable tenure group and select <OK>.   
You can also type in the information. 

Veterans 
Preference for 
RIF 

For actions other than Appointment, the employee’s 
record automatically populates this data field.  For a 
change NOA or if input is required, select the LOV and 
select the applicable Veterans RIF group information, 
and select <OK>.  You can also type in the information. 

FEGLI; 
Annuitant 
Indicator;  
Pay Rate  
Determinant; 
and Retirement 
Plan 

For actions other than Appointment, the employee’s 
record automatically populates these data fields.  For a 
change NOA or if input is required, select the LOV for 
each of these data fields and select the applicable values 
and select <OK> to automatically populate the data 
field.  You can also type in the information. 

Service Comp 
Date (Leave) 

For actions other than Appointment, the employee’s 
record automatically populates these data fields.  For a 
change NOA, except on an Appointment, select the LOV 
to display a calendar.  Select the correct date and select 
<OK> to automatically populate the data field. 
     Or 
Type the correct service computation date in the data 
field. 
 

 
Continued on next page 
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Request for Personnel Action, Continued 

  
Employee and Position Data Tab – Employee Data (continued) 
 

Data Field Description/Action 
Work Schedule  This information is automatically populated from the 

Position information. 
      Or 
For a change NOA or if input is required, select the 
LOV.  Select the correct work schedule for this action.  
Select <OK> to automatically populate the data field. 

Part-Time 
Hours Per Pay 
Period 

This information is automatically populated from the 
Position information. 
 
      Or 
For a change NOA or if input is required, select the 
LOV.  Select the correct information and select <OK> to 
automatically populate the data field. 

  
Employee and 
Position Data 
Tab – Position 
Data 

 

 
 

Data Field Description/Action 
Position 
Occupied 

Data field automatically populates if a position was 
selected on the previous page.  The data field 
information is dependent of the type of position to be 
occupied; e.g., competitive or excepted.   
If input is required, select the LOV, select the correct 
position information for this action, and select <OK> to 
automatically populate the data field. 

 
Continued on next page 
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Request for Personnel Action, Continued 

  
Employee and Position Data Tab – Position Data (continued) 
 

Data Field Description/Action 
FLSA Category; 
Appropriation 
Code; 
Bargaining 
Unit; 
Duty Station 
Code and Duty 
Station Location 

Data fields automatically populate from the Position 
data. 
If input is required, select the LOV, select the correct 
information and select <OK> to automatically populate 
the data field. 
     Or 
Type in the correct information for each data field. 

Educational 
Level 
 
 
 
 
 
 
 

 

For actions other than Appointment, the employee’s 
record automatically populates this data field. 
      Or 
Type in the level, if known; e.g., 04, 06, 10, 13 and up.   
 
       Or 
Select the LOV, select the educational level for the 
applicant, and select <OK> to populate the data field. 
Note:  Your input in this data field determines whether 
or not the Year Degree Att and Academic Discipline 
data fields need to be completed. 

Year Degree Att Type in a four-digit number; e.g., year 1995, or use the 
LOV on the Toolbar if the applicant for the position has 
a degree when you do an Appointment action. 
For actions other than Appointment, the employee’s 
record automatically populates the data field.   

Academic 
Discipline 
 
 
 

 

Select the LOV to display a list of academic disciplines.  
Select the appropriate discipline and select <OK> to 
automatically populate the data field.  Or type in the 
information. 
 
Note:  This data field is completed only if applicant or 
employee has a degree.  The data field is automatically 
populated from the Person window for other actions.  
This information may be required by OPM. 

 
Continued on next page 
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Request for Personnel Action, Continued 

Employee and Position Data Tab – Position Data (continued) 
 

Data Field Description/Action 
Functional Class This data field automatically populates if a position was 

selected on Page 2 of the RPA. 
If input is required, select the LOV, select the correct 
information and select <OK> to automatically populate 
the data fields. 

Citizenship 
 

 
 

 

If input is required, select the LOV on the Toolbar.  
Select the correct information.  Select <OK> to 
automatically populate the data field.  Or type in the 
information. 

For actions other than Appointment, the employee’s 
record automatically populates this data field.   

Veterans Status 
 
 

 

If input is required, select the LOV on the Toolbar.  
Select the correct information.  Select <OK> to 
automatically populate the data field. 

For actions other than Appointment, the employee’s 
record automatically populates this data field.   

Supervisory 
Status 

This data field is automatically populated if a position 
has been selected on the previous page. 
      Or 
If input is required, select the LOV on the Toolbar.  
Select the correct information.  Select <OK> to populate 
the data field. 

 

 

 
Note:  There are six position data fields that you can change on the RPA that 
will flow back to the Position.  The changes will not invalidate the Position 
that was previously created.  These data fields are: 

• Data Field 32  -  Work Schedule 
• Data Field 33  -  Part-Time Hours 
• Data Field 34  -  Position Occupied 
• Data Field 35  -  FLSA Category 
• Data Field 36  -  Appropriation Code 1 and Appropriation Code 2 
• Data Field 37  -  Bargaining Unit Status 

 
 
 



                                                                                                   R12                                                                            March 2012 
 

Processing Personnel Actions:  
Processing a Request for Personnel Action                                    Mod 3, Chap 1, Page 23 

 

Request for Personnel Action, Continued 

  
Remarks and 
Address Tab 

 

 
 

 
 . 

Data Field Description/Action 
Remarks by 
Requesting 
Office (Part D) 
 
 

 

The "Yes"/"No" buttons will be checked by the 
Supervisor completing this data field, if this is a 
resignation/retirement action, additional information 
about the action needs to be completed.    
 
Notes:   
• If “Yes” is checked, the Remarks section of Part D is 

grayed out.  You must attach a separate explanation 
to the RPA using the Attachment button on the 
Toolbar.  This meets the requirements of the GPPA.  
See Chapter 3, Attaching Documents to a Request 
For Personnel Action, Module 1, Fundamentals. 

• If “No” is checked, you will be able to type 
information into the Remarks section of Part D. 

Resignation/Re-
tirement (Part E) 

Employee statement is entered in this data field if this 
action is a resignation/retirement action. 

Forwarding 
Address 

Employee's forwarding address is automatically 
populated if the action is a resignation/retirement action. 

  
Continued on next page 
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Request for Personnel Action, Continued 

 
Remarks and Address Tab (continued) 
 

Data Field Description/Action 
Remarks for SF 
50 (Part F) 
 
 
 
 
 
 
 

 

Select the LOV on the Toolbar to display a list of remarks 
appropriate for the NOA.  Select the appropriate 
code/remark and select <OK> to automatically populate 
each Remarks code data field.   
Move the cursor to the next block in the Remarks data 
field to input another code/remark, if required.   
Continue to do this until all appropriate codes/remarks 
have been selected for this action. 
 
Notes: 
• The LOV will display only the remarks that apply to 

the NOAs selected for your RPA. 
• If there are more than four remarks in the Remarks 

data field, place your cursor in the last data field and 
select the down arrow ↓ key to insert additional 

remarks.  Or, select the new Record    Button on 
the Toolbar for an additional line. 

 

 
Notes:   

 • If you wish to insert information in the remarks data field, select in the 
remarks code data field, press the [TAB] key to display the pop-up screen, 
and type in your remark. 

• If a remark code has been pre-programmed as mandatory for your Nature 
of Action, the remark code and clear text will pop into the view on the 
screen as soon as the personnelist touches the remarks input area for the 
first time. 

• A remark can be deleted by substituting a different remark code in the 
code field. 

• A remark can be deleted without replacement by selecting the Clear 
Record    button on the Toolbar.   

• Each remark is a separate record in the system, so the “record” you are 
deleting when your cursor is in a remark code/cleartext field is only the 
remark.  It is safe to respond “yes” to erase the remark you want to 
remove. 
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Saving and Routing a Request for Personnel Action 

    
Routing the 
Request for 
Personnel 
Action 
 
 
 
 
 
 
 

Select the Save button on the Toolbar    to save your RPA action. 

 
Once you have saved your RPA, a dialog box appears. Select one of the 
options: <Cancel> to stop the process and return to the RPA. 
              <No> to save your action to this point and return to the RPA.  
               <Yes> to display the Routing Window.  
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Saving and Routing a Request for Personnel Action, Continued 

    
  
Routing 
Window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The Routing window gives you several options for processing your RPA.  
Select the option based on your role in the routing of your RPA. 

 
 
Notes:   

• The application defaults to the Save and Hold in Personal Inbox 
option. 

• Some of the options in the Routing window may be grayed out 
based on your role and responsibility. 

To print a DoD customized NPA which has a four character NOA, deselect 
the “X” in the Print Notification Box.  The NPA will default to the user’s 
printer on the effective date. 

Continued on next page 
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Saving and Routing a Request for Personnel Action, 
Continued, Continued 

  
Saving and Routing Request  (continued) 
 

Routing To 
Region 

Description/Function 

Select Routing 
List 

Click Select Routing List to display a Routing Lists 
window to allow you to select a predetermined 
sequence of recipients.  The listing defines the order in 
which a personal inbox or groupbox receives the 
workflow notification.   
 
Select the routing list and <OK> to populate the data 
field on the Routing window.  Then select <OK> on 
the Routing window to route the action. 

Select Person Choose Select Person to display a Routing People 
window to route the action with a listing of individuals 
based on their role.   
Select the correct individual to route the action too.  
Select <OK> to populate the data field on the Routing 
window.  Then select <OK> on the Routing window to 
route the action to the correct person. 

 
 

Continued on next page 
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Saving and Routing a Request for Personnel Action, 
Continued, Continued 

  
 Saving and Routing Request (continued) 
 

Routing To Region Description/Function 
Select Groupbox Choose the Select Groupbox to display Routing 

Groupboxes Window.  A Groupbox contains a group 
of people who share a common function in the RPA 
process.  The Groupbox could contain members of an 
office, branch, workgroup, etc.  Each Groupbox 
member’s role is individually defined and may or may 
not be identical to the roles of other Groupbox 
members. 

 
 
Select the correct Groupbox for routing the action based 
on its role in the RPA process.  Select <OK> to 
populate the data field on the Routing Window.  Then 
select <OK> on the Routing window to route the 
action to the correct Groupbox. 

 
Continued on next page 
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Saving and Routing a Request for Personnel Action, 
Continued, Continued 

  
Saving and Routing Request  (continued) 
 

Routing To Region Description/Function 
Save and Hold in 
Personal Inbox 
 
 
 

 

Select this option if you have not finished working on 
the RPA action.  It will be saved in your Civilian Inbox.  
You can then select and complete the RPA action at a 
later time.   
Select <OK> to save the RPA to your Civilian Inbox. 
Notes:   

• The system automatically defaults to the Save 
and Hold in Personal Inbox option. 

• You must save the action to your Inbox in 
order to query the RPA from your Inbox after 
the action has processed. 

Update HR 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 

You can select Update HR only if you have the 
assigned role and responsibility of updating the DCPDS 
database.  This procedure will generate a Notification of 
Personnel Action (NPA).  The DCPDS applies the RPA 
data to the appropriate position and personnel records, 
replacing existing information with the new 
information. 
Selecting Update HR automatically places an “X” in 
the Print Notification box if the effective date on the 
RPA is current or a past date.  You do not have to print 
a Notification of Personnel Action at this time; 
therefore, you can deselect the print option.  You can 
print the personnel action at a later time. 
NAF activities and other users of NPAs with four-
character NOAs must deselect the Print Notification 
box to get the action to print.  It will default to your 
printer on the effective date of the action. 
Note:  The DCPDS application does an edit check on 
the RPA action when the Update HR option is selected, 
notifying you of corrections that need to be made before 
any Update HR can occur. 

Print Notification Discussed in the next procedure of this chapter. 
 

Continued on next page 
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Saving and Routing a Request for Personnel Action, 
Continued, Continued 

 
Saving and Routing Request  (continued) 
 

Routing To Description/Function 
Approval 
 
 

 
 

Select the Approval box on the Routing Window if you 
are assigned the role of Approver.   
 
Note:  As an Approver, you can submit the RPA to 
Update HR, print the Notification for Personnel 
Action, return the RPA to the initiator to make changes 
and resubmit, or return the RPA to the Authorizer to 
make changes and resubmit or to a personnelist to 
finalize. 

Interim Approval The use of this function is dependent on Component 
business rules. 

<Cancel> Select <Cancel> to stop the process and return to the 
RPA. 

<OK> 
 

 

Select the <OK> button to process the action and 
Update HR or to route the action to another inbox. 
Note:  Follow the instructions if an Error Message 
Window displays on your screen.   
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Printing a Request for Personnel Action/Notification 

 
Printing There are several methods you can use to print the RPA or NPA.   

1. On the Main Menu Bar select File → Print. 
2. Select the Print button on the Toolbar. 
3. Print a Request for Personnel Action or a Notification of Personnel 

Action from the Routing Window. 
4. For the DoD Customized NOAs, use the Routing window to deselect 

the “X” in the Print Notification Window.  It will default to the user’s 
printer. 

   
Printing from 
the Routing 
Window 

This print action is performed when you Update HR from the Routing 
Window. 

Routing To Description/Function 
Print Notification Select the box next to Print Notification.  The system 

places an “X” in the box and the Printer data field is 
highlighted. 

Printer Click in the Printer data field, a Printers window 
displays listing all the printers that the system 
administrator has made available.  Select the correct 
printer and then <OK> to automatically populate the 
printer data field.   
Select <OK> on the Routing window to print the 
action. 

 
Note:  You cannot print a future action with a future 
effective date. 

 
 

Continued on next page 
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Printing a Request for Personnel Action/Notification 

 
Printing from the Routing Window (continued) 
 

Routing To Description/Function 
Printing from the 
Menu Bar or the 
Toolbar 

• Select Action → Print on the Main Menu Bar or 
select the Print button on the Toolbar.   

• The Printing window displays.  You have the 
option of printing the Request for Personnel Action 
(RPA).  The Notification of Personnel Action 
(NPA) is grayed out until on or after the effective 
date of a finalized personnel action.   

• Select your selection based on the action you are 
completing.   

• Select the Printer data block to display a listing of 
printer options.  Select the correct printer and select 
<OK> to automatically populate the Printer data 
field. 

• Select <OK> on the Printing window to print the 
action.  A Note window displays with information 
about your printing request. 
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Module 3 

Chapter 2 

Accessing Requests for Personnel Action 

Chapter Overview 

  
Purpose Requests for Personnel Actions (RPAs) can be accessed in a number of 

methods.  This chapter will provide information on accessing RPAs from the 
Civilian Inbox and the Navigation Window.  RPAs are accessed based on 
your role and responsibility. 

  

 
 
 
Access to 
Requests for 
Personnel 
Action 
 
 

 

 

 
Based on your role and responsibility in your organization, you will have 
access to a range of RPAs through the: 

• Civilian Inbox as described in Module 1, Fundamental of the 
DCPDS. 

• Navigation List on the Navigator Window using the Request for 
Personnel Action or the CAO/TRANSFER Request. 

• Reports function by selecting Processes and Reports from the 
Navigation List. 

• Processes and Reports and selecting the View Requests from the 
Navigation List.  

• PSEUDOSF50 from the Navigation List. 

 
 
 

Chapter 
Contents 

 

 Topic Page 
Accessing Personnel Actions from the Navigator Window 2 
Viewing Personnel Actions from the Navigator Window 7 

Viewing Status of Your RPA Requests  7 
View a Request for Personnel Action 8 
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Accessing Personnel Actions From The Navigator Window 

  
Nature of 
Actions 
 
 
 
 

 
 

 

There are other methods of accessing RPAs in addition to the Civilian Inbox.  
One method is through the Navigator Window by using the Navigation List 
which has a listing of Nature of Actions (NOAs) that can be accessed by you.  
The access to the NOA menu listings is dependent on your role and 
responsibility.   
 
Note:  Each of the NOAs may display a variety of opening windows, if they 
do not display Page 1 of the RPA, on initial entry.  These windows require 
actions to be performed by you before you can complete the RPA.  For 
illustration purposes, the Cancellation/Correction NOA has been selected. 

   
Cancellation/ 
Correction as 
an Example 

This process is performed to cancel an RPA action or to correct an RPA.   
Follow the steps listed below to cancel and/or correct an action. 

 
Step Action 

1 Navigation Path, Request for Personnel Action → 
Cancellation/Corrections →Open.  The Approved Requests for 
Personnel Action window opens with your cursor in the Full 
Name data field. 

 
 

 
 

Continued on next page 
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Accessing Personnel Actions From The Navigator Window, 
Continued 

 
Cancellation/Correction as an Example (continued) 
 

Step Action 
2 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Press the F11 key (type a few letters in the Full Name data field 
followed by ‘%’) Press the CTRL + F11 keys together to execute 
the query and populate the Name data field with a list of names 
that meet your query.   
      Or 
Press the F11 key and place a ‘%’ in the Full Name data field 
followed by pressing the both the CTRL and F11 keys to display a 
list of all employees with requests for actions. 
Note:  ‘Processed’ in the Status area indicates the action has been 
approved and updated to HR. ‘Pending’ status indicates a future 
action that will occur on the effective date of the RPA.  

 
Note:  If you select a pending action and click ‘Re-route’, the 
RPA will return to your Inbox.  You can make any necessary 
changes and resubmit the action. 

 
Continued on next page 
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Accessing Personnel Actions From The Navigator Window, 
Continued 

  
Cancellation/Correction as an Example (continued) 
 

Step Action 
3 
 
 
 
 
 
 
 
 

 

If a multiple listing is displayed, use the scroll bar to locate the 
Name and Social Security Number of the employee you queried 
(the information automatically displays in the Status area).  
Review the information about the status of the actions in the Status 
area.   
Use the scroll bar next to the Status field to locate the RPA you 
want to cancel/correct or use the up and down arrow keys.  Click 
in the Current Record Indicator block to highlight the action to 
cancel/correct.  
Note:   

• If you are canceling or correcting dual actions, you must 
process a separate RPA for each action.   

4 
 

Click the   Taskflow button to create an RPA to 
begin the process of canceling an action.  Correction, as an 
illustration, is explained in Step 5. 

 
Continued on next page 
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Accessing Personnel Actions From The Navigator Window, 
Continued 

  
Cancellation/Correction (continued) 
 

Step Action 
4a 

 

 
 

The RPA displays with the cancellation NOA entered in the 
Actions Requested data field.   
Note:  You cannot change the Nature of Action family or any data 
on this action once Cancellation NOA has been selected. 

 
4b 
 

 
 

Save the action, route, approve, or submit the RPA for Update HR 
as you would any other RPA, following the directions given on the 
screen. 
Note:  If you close the Cancellation action, the application places 
it in your Civilian Inbox where you can continue to work on it.  If 
you delete the Cancellation action before approving and Updating 
HR, the system restores the original approved action to the 
Approved Requests for Personnel Action Window. 

 
Continued on next page 
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Accessing Personnel Actions From The Navigator Window, 
Continued 

 
Cancellation/Correction as an Example (continued) 
 

Step Action 

5 
 

Click the   Taskflow button to begin the process 
of correcting an action. 

     5a 
 

The RPA is displayed with the Correction NOA entered in the 
Actions Requested data field.  Enter the data you wish to correct in 
the appropriate data field(s). 

 
5b 
 

 

Save the corrected action, route, approve, or submit the RPA for 
Update HR as you would any other RPA, following the directions 
given on the screen. 
Notes:   

• If you close the Correction action without routing, the 
application places it in your Civilian Inbox where you can 
continue to work on it at a later time.   

• If you delete the Correction action before approving and 
Updating HR, the system restores the original approved 
action to the Approved Requests for Personnel Action 
Window. 

Updating HR enters the corrections in the appropriate records for 
the effective date of the original action.  A NPA can be printed at 
this time, if needed. 

 
 

Continued on next page 
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Viewing Personnel Actions from the Navigator Window 

  
Viewing Status 
of Your RPA 
Requests 

On occasion, you may need to view the request status of your RPAs.  To 
access your requests, follow the Navigation Path →Processes and Reports   
View Requests →Open  
To display the Concurrent Request Summary window.  Click the Find 
button (this will display a listing of all your RPAs that you have printed or 
requested for printing).  
 

 
 
 
 

  
 

Concurrent 
Request 
Window 
Description 

The information displayed in the window is dependent on the information 
displayed in the drop-down menu listing.  There are five selections for 
viewing your actions in this area.  Information on this function is available in 
Module 1, Fundamentals of the DCPDS, Chapter 8, Reports. 
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Viewing Personnel Actions from the Navigator Window, Continued 

  
View a Request 
for Personnel 
Action 

After the request has been submitted and you are still in the Submit Requests 
Window, you can view the action as well as print the action.  

 
Step Action 

1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

In the Requests window click the ‘View Output’ button to display 
the completed NPA.  The NPA will be displayed using the 
Ghostview Software program.  

 
Note:   The Ghostview Software program needs to be loaded to 
your PC and the appropriate path is assigned to your user ID 
profile before the NPA will be displayed. 
 

2 Select File→Print from the Main Menu Bar to print the action or 
click the Print Icon on the left of the screen. 
 

    3 Select File→Close Form to return to the Navigation List. 
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Module 4 

Staffing Using the DCPDS 

Module Overview 

  
Introduction This module contains procedures related to recruitment and staffing.  

  
Module Contents  

Topic Page 
Module Overview  

Navigation List 6 
NOA Families Used in Staffing 9 

Chapter 1:  Building an Applicant  
Building an Applicant 3 
Building an Address 6 
Accepting an Applicant 7 
Deleting or Purging an Accepted Applicant 10 

Chapter 2:  Building An External User  
Building an External User 3 

Building a Virtual Position? 3 
Building an External User? 3 
Changing Status to “Accepted” 7 
Assigning an External User to a  Different 
Position 

9 

Chapter 3:  Overview of Resumix Functionality  
Create Requisition 2 
Create Applicant 10 
Refresh 13 

 
Continued on next page 
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Module Overview, Continued 

  
Module Contents (continued) 
 

Chapter 4:  Placement Actions 1 
Accessing the Civilian Inbox or the RPA to Process an 
Action 2 

Processing a Recruit/Fill 3 
Processing Promotions/Change to Lower Grade  7 
Processing Reassignments 10 
Processing Not to Exceed (NTE) Actions 12 
Updating and Viewing Education Data 15 
Processing a Detail 16 
Extending a Detail 20 
Terminating a Detail 23 

Chapter 5:  Changing Employee Records 1 
Processing Name Changes 2 
Processing Realignments 4 
Processing Position Changes 6 
Processing a Change in Title 9 

Chapter 6:  Staffing Mass Actions 1 
Processing a Mass Realignment 2 
Processing Mass Pay Adjustments 12 
Viewing Current Pay Tables 21 
Viewing Past Pay Tables 23 

Chapter 7:  Cancellations and Corrections 1 
Processing Cancellations 4 
Processing Corrections 6 
Processing Corrections to Social Security Number or 
Date of Birth 

9 

Processing DoD Corrections 12 
Using the Pseudo SF50 14 
Miscellaneous 16 

Chapter 8:   AUTORIF Extract 1 
Creating an AUTORIF Extract File 2 

Chapter 9:   Severance Pay 1 
Severance Pay Calculator 2 

 
Continued on next page 
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Module Overview, Continued 

 
Module Contents (continued) 
 

Chapter 10:  Processing a Reconstruct History Action 1 
Chapter 11:  Change in Appointment Office (CAO) 1 

CAO/Transfer Request Form 3 
Initiating the CAO/Transfer Request Form (Gaining 
Region) 

8 

Processing the CAO/Transfer Request (Gaining 
Region) 

10 

Building the Applicant (Gaining Region) 13 
Processing the CAO/Transfer Request  15 
Processing a Return to Duty with the CAO Process 20 
Viewing the Pseudo Assignment 22 
Canceling an Initiated CAO/Transfer Request  23 
Canceling a Consummated CAO/Transfer RPA 24 
Deleting Applicant Records 26 
CAO/Transfer Separation Process 27 
Appendix A – CAO/Transfer Error Messages  32 
Appendix B – Work Around List for CAO/Transfer 34 
Appendix C – Trip Counter Combination Table 38 

Chapter 12:  Processing a Conversion/Extension on Temporary 
or Term Appointment 

1 

Processing a Projected Conversion or Extension 
Action 

3 

Processing a Current or Past Dated Conversion or 
Extension Action 

7 

Processing a Conversion/Extension Action on an 
Erroneously Separated Employee 

8 

Chapter 13:  RIF Tool  
General Information – DCPDS RIF Tool 3 
Creating a RIF Extract and RIF Staging Table  13 
Creating a RIF – RIF Options Page and Appraisal 
Information Page 

29 

RIF Overview Page  49 
RIF Overview Page – Representative Rate Tab and 
Lines of Progression Tab 

59 

RIF Overview Page – Edit Positions/Employees Tab 73 
RIF Overview Page – RIF Process Tab 109 
RIF Overview Page – RIF Reports Tab, RIF Notices 
Tab and Process Log Tab 

149 

RIF Administrator Responsibility 167 
 

Continued on next page 
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Module Overview, Continued 

 
Module Contents (continued) 
 

Chapter 14:  Data Flow Processes Between DCPDS and 
USA Staffing 

 

Transmit DCPDS RPA Data File 2 
Transmit USA Staffing Selection File 9 
Transmit Cancellation of Applicant Selection  13 

 
Continued on next page 
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Module Overview, Continued 

  
Before You 
Begin 

• There are two ways to process staffing actions. 
1. From your Workflow Inbox.  You respond to a Request for Personnel 

Action (RPA) initiated and forwarded by a manager or supervisor, or 
an RPA you saved to your Workflow Inbox. 

2. From the Navigation List.  If you have been given the responsibility, 
you may initiate an action by accessing an RPA from the Navigation 
List. 

• Once an RPA is saved, it must be routed to another person or to your 
Civilian Inbox. 

• If you initiate an RPA and decide not to use it, you can delete it from your 
Civilian Inbox by using the Clear Record button on the Toolbar. 

• When you save an RPA the first time, a Request Number displays in Part 
A, Block 2 of the RPA.  The first five characters depict the year/month the 
action is initiated, the next nine are for component use, and the remaining 
six are a system generated sequence number.  It is assigned to the 
Requisition, and if RESUMIX is used, it is assigned to the related vacancy 
announcement. 

• Recruit/Fill is not a Nature of Action (NOA); it is a placeholder until the 
personnelist/staffer determines how the fill action will occur; e.g., 
appointment, promotion, reassignment, etc. 

• NOAs are separated into Job Families on the Navigation List.  For 
example, a Promotion, and QSI are located in the Salary Change menu.  
NTEs are located in the Extension of NTE menu.  See the list of NOA 
Families in this module. 

• The RPA can be printed from the inbox of the initiator or anyone to whom 
it has been routed.  RPAs may also be printed in the Reports menu. 

• You can view previous or subsequent RPAs on the Notifications 
Summary Window of the Workflow Inbox.  Place the cursor in the 
Subject Column, and scroll up or down using the Up and Down Arrow 
Keys. 

• Completed RPAs do not normally display in the Workflow Inbox.  A 
separate folder can be set up for these actions.  

• The RPA has electronic signature capability. 

• The Refresh Button on the RPA pulls in the current person/position 
information to the RPA. 

 
Continued on next page 
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Module Overview, Continued 

 
Navigation 
List 

 

 
 

 
Continued on next page 
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Module Overview, Continued 

 
Menu Options 
on the 
Navigation List 

The menu options on the Navigation List are familiar; however, there are 
some that may need additional information.  Use of many of the menu options 
may be determined by your Component business rules.  The following list of 
menu options gives a general description and where each is located in the 
User Guide. 

 
Menu Option/Form Location in User Guide/Information 

Appointment Performed as a staffing function. 
Award/One-Time Payment Module 6, Pay, Benefits, and Entitlements Using 

the DCPDS. 
Cancellation/Correction Chapter 7, Module 4, Staffing Using the 

DCPDS. 
DOD Correction Process-
002 

Chapter 7, Module 4, Staffing Using the 
DCPDS. 

DOD-911 Chapter 10, Module 4, Staffing Using the 
DCPDS 

CAO/Transfer Chapter 11, Module 4, Staffing Using the 
DCPDS. 

Change in Data Element Performed in staffing. 
Change in ART Status Air Force unique. 
Change in Duty Station Module 2, Position Management and 

Classification Using the DCPDS. 
Change in FEGLI Module 6, Pay, Benefits, and Entitlements Using 

the DCPDS. 
Change in Hours Module 2, Position Management and 

Classification Using the DCPDS. 
 Change in Retirement  
   Plan 

Module 6, Pay, Benefits, and Entitlements Using 
the DCPDS. 

 Change in SCD Performed in staffing. 
 Change in Tenure Performed in staffing. 
 Change in Veterans     
   Preference 

Performed in staffing. 

 Change in Work  
   Schedule 

Module 2, Position Management and 
Classification Using the DCPDS. 

 Change Position  Number Module 2, Position Management and 
Classification Using the DCPDS. 

 Name Change Chapter 5, Module 4, Staffing Using the 
DCPDS.  
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Module Overview, Continued 

  
Menu Option/Form Description/Action 

   Change Position    
   Sensitivity 

Module 2, Position Management and 
Classification Using the DCPDS. 

   Change Position Title Chapter 5, Module 4, Staffing Using the 
DCPDS.  

  Details Performed in staffing. 
  Conversion to Appointment Performed in staffing. 
  Extension of NTE Module 4, Staffing Using the DCPDS, 

Chapter 7. 
  Federal Position Change Chapter 5, Module 4, Staffing Using the 

DCPDS.  
  Living Benefits Module 6, Pay, Benefits, and Entitlements 

Using the DCPDS. 
  NonPay/NonDuty Status Module 5, Workforce Relations Using the 

DCPDS. 
  Other Pay Performed in staffing. 
  Realignment Chapter 5, Module 4, Staffing Using the 

DCPDS.  
  Reassignment Chapter 4, Module 4, Staffing Using the 

DCPDS.  
Long-Term Training Army unique. 
Recruit/Fill Chapter 4, Module 4, Staffing Using the 

DCPDS.  
Return to Duty Performed in staffing. 
RIF Exception Performed in staffing. 
Salary Change Module 6, Pay, Benefits, and Entitlements 

Using the DCPDS.  
Separation Chapter 10, Module 4, Staffing Using the 

DCPDS  
Foreign Language Prof Pay Performed in staffing. 
USUHS Salary Change Navy unique. 
Mass Realignment Chapter 6, Module 4, Staffing Using the 

DCPDS.  
 Mass Salary Chapter 6, Module 4, Staffing Using the 

DCPDS. 
Mass Appraisals Chapter 2, Module 5, Workforce Relations 

Using the DCPDS.  
 Mass Awards Chapter 3, Module 5, Workforce Relations 

Using the DCPDS. 
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NOA Families Used in Staffing  

 
Purpose 
 
 
 

This section provides examples of the various Nature of Action (NOA) 
Families in staffing associated with the RPA on the Navigation List. 
 
Note:  Prefixes to NOAs: 

A = Army NAF 
C = DOD  Reconstruct-911 
D = Demonstration Projects 
E = NAWC Science & Technology Reinvention Demo Project 
L = China Lake Demonstration Project 
N = Air Force NAF 
P = Pseudo  
Q = Acquisition Demonstration Project 
T = Transfer 
Y = NSPS 
 

   
Associated NOAs  
 

Menu List Associated NOAs 
Appointment            

 
 

 
Continued on next page 
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NOA Families Used in Staffing, Continued 

  
Associated NOAs (continued) 
 

Menu List Associated NOAs 
Appointment 

(cont) 

 

 
 

Continued on next page 
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NOA Families Used in Staffing, Continued 

  
Associated NOAs (continued) 
  

Menu List Associated NOAs 

Appointment 
(cont) 

 
 

 
Continued on next page 
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NOA Families Used in Staffing, Continued 

  
Associated NOAs (continued) 
 

Menu List Associated NOAs 
CAO/Transfer-
Transfer 
Interagency 

 

 

 
 

 
 
 
 

Continued on next page 
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NOA Families Used in Staffing, Continued 

  
Associated NOAs (continued) 
 

Menu List Associated NOAs 
 Conv to Appt  

 
 

 
Continued on next page 
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NOA Families Used in Staffing, Continued 

  
Associated NOAs (continued) 
 

Menu List Associated NOAs 
Conv to Appt 
(cont) 

 

 

 
 
 

 
Continued on next page 

 



                                                                                                  R12                                                                             April 2012 

Staffing:  Overview  Mod 4, Overview, Page 15 

 
NOA Families Used in Staffing, Continued 

  
Associated NOAs (continued) 
 

Menu List Associated NOAs 
Conv to Appt 
(cont) 

 

 

 
 

 
 

Continued on next page 
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 NOA Families Used in Staffing, Continued 

  
Associated NOAs (continued) 
 

Menu List Associated NOAs 

Award – One 
Time 
Payment 

 

 

 
 

Detail  

 
 

 
Continued on next page 
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NOA Families Used in Staffing, Continued 

  
Associated NOAs (continued) 
 

Menu List Associated NOAs 

Extension of 
NTE 

 

 
 

Long Term 
Training 

 

 
 

Non 
Pay/Duty 
Status 

 

 
 

Other Pay  
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Module 4 

Chapter 1 

Building an Applicant 

Chapter Overview 

  
Introduction To process an appointment action in the DCPDS, you must first enter the 

person as an applicant.  You can do this one of two ways: 

1. If Resumix is used for the recruitment and selection process, information 
about the applicant will automatically flow from Resumix. 

2. If Resumix is not used, enter the applicant data through the process 
explained below (referred to as “building” an applicant). 

   
Chapter Contents  
 

Topic Page 
Before You Begin 2 
Building an Applicant 3 

Building an Address 6 
Accepting an Applicant 7 

Deleting or Purging an Accepted Applicant 10 
 

Continued on next page 
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Chapter Overview, Continued 

  
Before You 
Begin 

The system requires a one-day interim period between the date an applicant is 
entered and the date the person can be assigned to a position: 

• Day 1:  Build applicant (enter applicant data) and change the 
applicant’s status to “Accepted”. 

• Day 2:  Appoint the applicant. 
Example:  To appoint an applicant to a position effective August 19, a prior 
date of at least one day must be used for entering the applicant (e.g., 18 
August or earlier).   
 
How to work around:  Use the Date Track feature to work around this 
business rule to input and appoint the applicant all in the same workday.  
Using Date Track, you: 

• Alter the effective date back at least one day to “enter” or build the 
applicant,   

• Change the applicant’s status to “Accepted. 

• Reset the effective date to the current date to “appoint” the applicant.   
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Building an Applicant  

  
Building an 
Applicant 

The following procedures describe how to build an applicant.  Only the 
required data fields are described. 

 
Step Action 

1 Navigation Path → People → Enter and Maintain → <Open>.  
The Find Person window opens.  Select the <New> button. 

  

 
2 The People window is revealed: 

 
 

Continued on next page 
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Building an Applicant, Continued 

  
Building an Applicant (continued) 
 

Step Action 
3 If you plan to appoint the applicant within the next two days, you will 

need to alter the effective date in the system to meet the business 
rules described in the introduction.  To do this:  

• Select the Alter Effective Date    button on the Toolbar.   
• Alter the Effective Date so that it is at least one day prior to the 

date you wish to appoint the applicant.   

• Type over the highlighted data in the Effective Date data 
field (which displays the current date). Use the format: DD-
MMM-YYYY.  Then select <OK> 

The altered effective date displays on the Title Bar of the People 
Window. 

4 
 

 

Your cursor will be in the LAST data field of the NAME Region.  
Enter the applicant data in all upper case letters, as described below. 

Caution:  Press [Tab] each time you want to navigate to the next 
data field.  Do not use [Enter]. 
 Data Field Action  

  Last • Type in the last name of the applicant.  The 
system accepts mixed case (e.g., Smith); 
however, in accordance with the Guide to 
Processing Personnel Actions, Department of 
Defense should use all upper case letters (e.g., 
SMITH). 

• If the applicant has a suffix, it should be 
included at the end of the last name, separated 
by a comma and a space (e.g., SMITH, JR).  
Do not use the Suffix data field for storing an 
applicant’s information. 

• Press [Tab]. 

 
 

  First • Type in the applicant’s first name in all upper 
case letters. 

• Press [Tab] 2 times to place your cursor in 
the Middle data field. 

 

  Middle • Type in a middle name (in all upper case) or 
initial. 

• Press [Tab]. 

 

 
Continued on next page 
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Building an Applicant, Continued 

  
Building an Applicant (continued) 
 

Step Action 
4 

(cont) 
 Data Field Action  

  Gender • Select the LOV  icon to select Male or 
Female.   

 
Press [Tab] or select in the Action data field. 

 

  Action 
        

• Select the LOV icon   
• Select Create Applicant from the LOV. 

 
 

 

  Person Type 
for Action 

• After selecting Create Applicant in the 
previous field, a Person Type window will 
appear Select a Type  

 
• Select the <OK> button 

 

 
Continued on next page 
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Building an Applicant, Continued 

  
Building an Applicant (continued) 
 

Step Action 
4 

(cont) 
 Data Field Action  

  Social 
Security 
Number 

• Type in the applicant's SSN. 
• Use the format NNN-NN-NNNN (you 

must type the dashes). 
• Press [Tab]. 

 
 

  Birth Date • Type in the applicant’s birth date, using 
the format:  DD-MMM-YYYY.  

• Press [Tab].  

 

  Person Types • No action   
  Identification • No action – automatically populated   

5 
 
 

 

Save your action using the   icon.  

The Message Line will indicate “Working…” followed by 
“Transaction complete:  1 Records applied and saved.” 
Note:  The system calculates the applicant’s age and populates an 
Applicant Number in the Applicant data field. 

 
Building an 
Address 

It is optional to enter an applicant’s address when building an applicant.  
Component business rules will determine if it is required. 

 
Step Action 

6 In the People window, select the<Address> button.  The Address 
window opens: 

 
 

Continued on next page 
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Building an Applicant, Continued 

  
Building an Address (continued) 
 

Step Action 
6-b 

 
 
 
 
 
 
 
 
 
 

Enter the Address Information into Line 1. Press [Tab] to the City 
field. 
Enter the City data field and press [Tab] or select to the State data 
field. 
Enter the State or select the LOV icon to select the state from the list. 
Enter the Zip Code 
Select the <OK> button. 

 
 

7 The system automatically fills a “check” in the box to indicate this is 
a primary residence.  

Save your work and close the window. 

  
Accepting the 
Applicant 

You are now ready to “Accept” the applicant. 
 
Step Action 

8 Select the <Others>  button. 
 

Continued on next page 
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Building an Applicant, Continued 

  
Accepting the Applicant (continued) 
 

Step Action 
9 The Navigations Options window opens. Select “Application” 

from the list and select the <OK> button.   

 
 

10 
 
 
 
 
 
 
 
 
 
 
 
 

 

In Status data field select the LOV icon and select “Accepted” from 
the list, then select the <OK> button. 

 
Note:  The Received Date data field populates. 

 
Continued on next page 
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Building an Applicant, Continued 

  
Accepting the Applicant (continued) 
 

Step Action 
11 The Status data field now displays “Accepted” and an Option 

window opens, with ‘Update’ that keeps the history of existing 
information or ‘Correction’ that corrects existing information. 

 
Select the <Correction> button. 

12 Select the Save icon. The ‘From’ date in the ‘Effective Dates’ Region 
at the bottom of the window changes from the date used to enter the 
applicant to the date currently used to accept the applicant if the 
applicant is not “Accepted” on the same date the applicant is built. 

13 Close the Application window by selecting the  in the upper right 
corner. 

14 In the People window reset the effective date by selecting  Alter 
Effective Date icon, when the date window opens select the ‘RESET’ 
button.  This sets the effective date to the current date, so the applicant 
is ready to be assigned. Select the <OK> button. 

15 The applicant is ready to be assigned to a position via the RPA. Close 
the window and process the appointment action. 
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Deleting or Purging an Accepted Applicant 

  
Deleting or 
Purging an 
Applicant 

You can delete an “accepted” applicant using Date Track or you can 
completely remove or "purge" an applicant from the database. 

 
Step Action 

1 Navigation Path → People → Enter and Maintain → Open.  
The Find Person window opens. 

 
Query for the applicant by entering his or her name in Full Name 
data field and select the <Find> button. 

2 The People window opens with the applicant data.  Select the 
<Others> button. 

3 The Navigations Options window opens. Select Application from 
the list then select the <OK> button. 

 
 

 
 

Continued on next page 
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Deleting or Purging an Accepted Applicant, Continued 

  
Deleting or Purging an Applicant (continued) 
 

Step Action 
4 The Application window opens. Alter Effective Date to the day 

before this date.  For example, if the date is 02-Jul-2000, Date 
Track to 30-Jun-2000.  

 
5 

Select the Delete Record    on the Toolbar. 
6 A decision box appears asking if you are sure you want to delete 

this record.  Select the <Yes> button. 

 
 

 
Continued on next page 
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Deleting or Purging an Accepted Applicant, Continued 

  
Deleting or Purging an Applicant (continued) 
 

Step Action 
7 A decision appears, asking if you want: 

‘Next’ - remove the next change, or 
‘All’  -   remove all scheduled changes, or 
‘Purge’ - completely remove from the database. 

 
 
 To Remove Acceptance of 

the Applicant. 
To Purge the Applicant 
Record. 

 

 1.  Select <Next>.  This will 
remove acceptance of the 
applicant. 

Select <Purge>.  This will 
remove the applicant from the 
database. 

 

  2.  Select Save.   
  3.  Reset the DateTrack date.   
  4.  Close the Application 

Window.  The People 
Window displays. 

  

  5.  Select the Delete Record 
button on the Toolbar. 

  

  6.  A Dialog Box displays, 
asking if you are sure you 
want to delete the record.  
Select <Yes>. 

  

  7.  Select Save.   
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Module 4 

Chapter 2 

Building an External User 

Chapter Overview 

  
Introduction This procedure explains how to build an External User and assign the user to 

a virtual position.  It is designed for both military and civilian personnel who 
need access privileges to a database.  Oracle HR and the DCPDS require you 
to be an employee (or External User) in the database in order to use the 
database.   

A typical example for building an external user would be a personnelist in 
one Region needs access to another Region in order to process personnel 
actions.   The personnelist is built as an External User and assigned to a 
“virtual” position in that region. 

It is a process similar to building the “skeletonized” virtual position.  This 
process builds a “skeletonized” assignment for an external user.   

    
Chapter Contents  
 

Topic Page 
Chapter Overview 1 

Before You Begin 2 
Building an External User 3 

Building a Virtual Position? 3 
Building an External User? 3 
Changing Status to “Accepted” 7 
Assigning an External User to a  Different Position 9 

 
Continued on next page 
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Chapter Overview, Continued 

  
 
Before You 
Begin 

External Users: 
• Can be military or civilian. 
• Need to be assigned to a virtual position unless they: 

• Do not finalize personnel actions (sign RPAs/NPAs). 
• Will never appear on the Training Request Form or DD Form 1556 as the 

person being trained. 
• Need to be in a hierarchy for another Component. 

• Cannot be assigned Elements; e.g., FEGLI, etc. 
• May be assigned any level of RPA responsibility, or may be given no RPA 

access. 
• Can prepare Training Request Forms. 
• Are not reported in CPDF/OPM Strength Data. 
• Can be assigned User Ids just as any other user in the database. 
 
Note:  If the External User is assigned the approver or signer role of NPAs, there 
must be a position working title in the virtual position the user is assigned to 
before the user can finalize a personnel action.  Otherwise, the signature block on 
the printed NPA will contain the External User’s name without a title. 
 
This is a two-day process:   

1. Day 1:  The person is an “Active Applicant” and then an “Accepted 
Applicant” 

2. Day 2:  The person is an “External User.” 
 
Example:  To assign an External User to a Virtual Position effective 17 May 
2003, a prior date of at least one day must be used for entering the applicant 
(e.g., 16 May or earlier). 
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Building an External User 

 
Building 
Virtual 
Positions 

Personnelists will normally build Virtual Positions following the procedure in 
Module 2, Position Management and Classification Using the DCPDS, 
Chapter 1, Building a Virtual Position. 

   
Building an 
External Users  

System Administrators or personnelists build External Users to be placed in 
Virtual Positions using the following procedure.  Components will determine 
who has this responsibility. 

  
Step Action 

1 In the Responsibilities window, Select CIVDOD External Users.   
Then click the <OK> button. 

 
 

Continued on next page 
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Building an External User, Continued 

  
Building an External Users (continued) 
 

Step Action 
2 The Navigator - CIVDOD External Users window opens.  Click 

Employee Enter and Maintain, Click <Open>. 

 
3 The Find Person window opens. Click the <New> button or click 

the "X" in the top right to close the window. 

 
4 Click the DateTrack  button and set the effective date back at 

least one day from the date the External User is to be effective.  
(Ex: Current date is 17-MAY-2003; DateTrack to 16-MAY-2003) 
The new effective date opens on the Title Bar:   

 
 

Continued on next page 
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Building an External User, Continued 

  
Building an External Users (continued) 
 

Step Action 
5 On the Enter and Maintain External User window, build a 

skeleton Applicant.  Input the following data fields only: 

 
  Data Field Action  
  Name Type in the name (all caps).  If the 

person has a suffix, include it with 
last name field.  Do not use the 
SUFFIX field. 

 

  Sex Click the drop-down menu to select.  
  Action Click the LOV to select or type in 

“Create Applicant.” 
 

  SSAN Type in the number (may be real or 
bogus for External Users). 

 

  Birth Date Type in a date (may be real or bogus 
for External Users). 

 

 
Continued on next page 
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Building an External User, Continued 

  
Building an External Users (continued) 
 

Step Action 
6 Click Save on the Toolbar.   
7 The Altered Effective Date populates in the Title Bar and the 

From data field in the Effective Date Region.  The Applicant data 
field has a system-generated number.  The employee’s age 
populates in the Age data field. 

 
Click the <Application> Taskflow Button at the bottom of the 
window.  

8 
 

The Application window opens with the DateTracked date and 
the name of the applicant on the Title Bar.   

 
 
Note:  The Effective Date of the Applicant remains the same (in 
this case, 16-MAY-2003) throughout the process. 
 

9 Delete CIVDODHR from the Organization data field. 
 

Continued on next page 
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Building an External User, Continued 

   
Changing Status 
to "Accepted" 

 

Step Action 
10 Place the cursor in the Status date field.  The Choose an Option: 

window opens with two taskflow buttons: 
1. <Update> - Keep history of existing information. 
2. <Correction> - Correct existing information. 

Select the <Correction> button. 

 
11 With the cursor still in the Status data field, click the LOV icon 

and select “Accepted.” From the list then click the <OK> button.  
The Status changes from “Active Application” to “Accepted.” 

 
 

Continued on next page 
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Building an External User, Continued 

 
Changing Status to "Accepted" (Continued) 
 

Step Action 
12 In the Position data field, click the LOV icon to select the virtual 

position that the External User will be assigned.  In the reduction 
criteria, type %.EXT%.  All civilian virtual positions display.  
Select one of the positions. 
Click <OK>.  (If you need a military virtual position, type 
%.MIL%. 

13 Click the Save icon.   
A Caution Box opens and asks:  “Do you want to use the location 
of the new position?”  

14 Click the <OK> button.  The Position and Location data fields 
populate. 

15 Click the "X" in the top right of the window to Exit the window.  
The Enter and Maintain External User window opens with Type 
data field populated with “Applicant.”   

16 DateTrack to the date the user is to be effective.  (Ex:  17-MAY-
2003). The cursor is in the Type data field, and says “Applicant.” 

17 Click the LOV and select “External User.  
Click <OK>. 

18 The Choose an option: window opens. 

 
Click <Update>. 

19 The Enter and Maintain External User window opens with the 
Type and Hire Date (17-MAY-2003) data fields populated.   

20 Click Save. 
 
Note:  Remember to reset DateTrack back to the current date. 
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Building an External User, Continued 

  
Assigning an External 
User to a Different 
Position 

 

Step Action 
1 To assign an External User to a different position, click <Assignment> 

on the Enter and Maintain External User window. 
2 The Assignment window opens.  Click the Clear Record button on the 

Toolbar.  With your cursor in the Position data field, select the new 
position from the LOV.  
 
Notes:  If the assignment is effective in the future (or past), date track to 
the effective date of the reassignment before completing your update. 

• The Position data field LOV opens only the virtual positions 
belonging to the organization shown in the Organization data 
field.  

• If you wish to see all virtual positions regardless of organization 
in the LOV, delete the name from the Organization data field 
before requesting the Position LOV. 

3 Click Save. 
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Module 4 

Chapter 3 

Data Flow Processes Between DCPDS  
and RESUMIX  

Chapter Overview 

  
Introduction This chapter is written for personnelists familiar with Resumix.  It explains 

the three processes where information flows between DCPDS and Resumix.   
1. Create Requisition  -  A requisition is created in Resumix from 

information in DCPDS; e.g., Position data in the RPA, KSAs from 
COREDOC, and other position data. 

2. Create Applicant  -  An action is initiated in Resumix to create an 
applicant in DCPDS when an outside candidate accepts a job offer.  

3. Refresh  -  Information in DCPDS is used to automatically and 
periodically update employee information in Resumix.  

Note:  For information beyond what is contained in this chapter on the 
Resumix application, please refer to the Resumix user manuals. 

 
Chapter Contents  

Topic Page 
Chapter Overview 1 
Create Requisition 2 

What Position Data Flows to Resumix 2 
Creation of the Requisition ID Number 4 
Creating a Requisition 5 
What COREDOC Data Flows to Resumix 6 
Creating a Requisition with COREDOC Data 7 

Create Applicant 10 
What Applicant Data Flows from Resumix 10 
Creating an Applicant in DCPDS 12 

Refresh 13 
How Employee Data Flows to Resumix 13 
What Employee Data Flows to Resumix 13 
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Create Requisition 

   
Purpose This section explains the creation of a requisition and the population of 

predetermined fields in Resumix with position information in DCPDS.    

   
What Position Data Flows to RESUMIX  
 

RESUMIX 
Field Label 

DCPDS Data Fields  
(Information will flow as clear text unless indicated 

otherwise) 
Standard  

1. Dept Name  Office Symbol  
2. Dept Number  PAS Code (code) 
3. Location Description RPA - Block B39, Duty Station (1st 30 chars) 
4. EEO type  Occupation Category Code (code) 
5. Job Class  RPA - Block B32, Work Schedule (code) 
6. Job Code RPA - Block B17, Occ. Code 
7. Job Title Title (1st 30 chars) 
8. Req ID  
 

RPA - Block A2, Request Number  
Note:  Every RPA is assigned a Request Number.   
• The format is:  YY/MMM/9-Character Identifier/6-Digit 

Sequential Number.  
      ♥ Example:  00AUGAFPC11029123456 
The system administrator establishes the process for the 
application to automatically populate the 9-character 
identifier in accordance with your Component requirements.  
DCPDS automatically assigns the sequential number. This 
Request Number flows to the Resumix requisition and 
becomes the Requisition ID Number.  It also becomes the 
job posting number for that requisition. 

9. Date Needed   
 

RPA - Block A4, Proposed Effective Date.  If no date is 
entered, then default will be current date. 

10. Description KSAs in COREDOC   
 

Continued on next page 
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Create Requisition, Continued 

  
What Position Data Flows to RESUMIX (continued) 
 

RESUMIX 
Field Label 

DCPDS Data Fields  
(Information will flow as clear text unless indicated 

otherwise) 
Custom  

1. ACQ-Critical Position Critical Position (code) 
2. ACQ-Career Level Career Level  
3. ACQ-Program Type Program Type (code) 
4. ACQ-Special Assignment Special Assignment (code) 
5. Agency Group/Subelement 

Code 
Agency Group (code) 
 

6. Bargaining Unit Status RPA - Block 37, Bargaining Unit Status (code) 
7. Date Oblig Exp Expiration Date  
8. FLSA Category RPA - Block 35, FLSA Category 
9. Grade/Level (Numeric) RPA - Block B18, Grade/Level 
10. Language Required Language Required (code) 
11. Obligated Employee SSAN Obligated Employee SSAN 
12. Obligated Type Obligated Type (code) 
13. Org Struc ID Organizational Structure ID 
14. Part-Time Hours RPA - Block B33, Part-Time Hours Per 
15. Pay Basis RPA - Block B21, Pay Basis (Code) 
16. Pay Plan RPA - Block B16, Pay Plan 
17. Personnel Office ID Personnel Office ID (code) 
18. Position NTE Date  Date To 
19. Position Occupied ID RPA - Block 34, Position Occupied (code) 
20. Position Sensitivity Position Sensitivity (code) 
21. Position Status Status (code) 
22. POSN-Career Program ID Career Program (Air Force) (code) 
23. POSN-Career Field ID Career Field (Army) (code) 

 
Continued on next page 
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Create Requisition, Continued 

  
What Position Data Flows to RESUMIX (continued) 
 

RESUMIX 
Field Label 

DCPDS Data Fields  
(Information will flow as clear text unless 

indicated otherwise) 
Custom  

24. POSN-Competitive Area Competitive Area 
25. POSN-Number (Position Description No)+(Sequence Number) 
26. POSN-Drug Test Reqd Drug Test (code) 
27. Program Element Program Element (code) 
28. Servicing Agency Servicing Agency (code) 
29. Servicing Office ID Servicing Office ID (code) 
30. Target Grade/Level (Numeric)  Target Grade  
31. UIC Unit ID Code (code) 
32. Vacancy Indicator Vacancy Indicator  

  
Creation of the 
Requisition ID 
Number  

The RPA Request Number flows to Resumix and becomes the Requisition 
ID Number.   
 
♥ Example: 

 
 

 
Continued on next page 
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Create Requisition, Continued 

  
Creation of the Requisition ID Number (continued) 
 
 You can rename the requisition and job posting and the vacancy 

announcement created in Resumix, but you cannot overwrite the RPA 
Request Number. 
 

 
 

  
Creating a Requisition  
 

Step Action 
1 Access your Civilian Inbox from the Navigation List in DCPDS. 
2 In the Notifications Summary window, highlight the appropriate 

RPA. 
3 Click <Respond>.  The RPA opens. 
4 Review the RPA and data associations to ensure that all required data 

has been recorded. 
5 Scroll down and click <Others>. 
6 The Navigation Options window opens: 

 

 
 

7 Highlight Resumix-Requisition and click <OK>. 
 

Continued on next page 
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Create Requisition, Continued 

  
Creating a Requisition (continued) 
 

Step Action 
8 The Resumix-requisition dialog box opens.  Click the<OK> 

button.  
 

 
 

9 A message confirming the data flow opens.  Click the<OK> 
button. 
 

 
 

10 
 

 

A requisition has been created in Resumix with the same identifier 
as the RPA. 
 
Note:  Always check to see if there is a Core Document attached 
to the RPA since data also flows from that document to the 
Resumix requisition.  See the next section for instructions.  If there 
should be a document and none is attached, you will need to locate 
and attach the appropriate document to the RPA prior to flowing 
data. 

 
What 
COREDOC 
Data Flows To 
RESUMIX 

If a Core Document is attached to an RPA when the Resumix-Requisition 
process is engaged, the “Selected Staffing KSAs” identified in that Core 
Document flow to the Resumix requisition.  It is recommended that you 
review the Core Document KSAs prior to transferring the data to the 
requisition.  

   
Continued on next page 
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Create Requisition, Continued 

 
Creating a 
Requisition with 
COREDOC Data 

 

 
Step Action 

1 Access your Civilian Inbox from the Navigation List. 
2 Highlight the appropriate RPA. 
3 Click the<Respond> button. 
4 Review the RPA and data associations to ensure that all required 

data has been recorded. 
5 Scroll down and click <Others>. 
6 The Navigation Options window opens. 

 

 
 

7 Highlight COREDOC and click the<OK> button. 
 

Continued on next page 
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Create Requisition, Continued 

   
Creating a Requisition with COREDOC Data (continued) 
 

Step Action 
8 The COREDOC Attach Detach window opens. 

 

 
 
If there is a COREDOC document attached to the RPA the status 
line opens:  “ATTACHED.” 
 
Note:  You can attach a document, detach an attached document, 
edit an attached document, or build a document from scratch, if 
necessary.  The buttons on this window provide access to these 
functions.  You cannot, however, access other types of RPA 
attachments (word processing documents, spreadsheets, charts, 
etc.) from this window. 

9 To open the attached document, click <COREDOC>. 
10 The COREDOC Menu appears. 
11 To view the “Selected Staffing KSAs” which flow to the 

requisition description field, click Reports on the Main Menu Bar, 
then click KSAs (No Comps). 

 
Continued on next page 
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Create Requisition, Continued 

   
Creating a Requisition with COREDOC Data (continued) 
 

Step Action 
12 Section I, Position and Organization Information and Section II, 

Knowledges, Skills, and Abilities, Paragraph A, Selected Staffing 
KSAs of the document display. 
 

 
 

13 After viewing, click Edit then Exit.  The COREDOC Attach 
Detach window opens. 

14 Click Exit. 
15 Return to the Navigation Options window. 
16 Highlight RESUMIX-Requisition and click <OK>.  The 

RESUMIX-Requisition dialog box opens.  Click <OK>. 
17 A message confirming the data flow opens.  Click <OK>. 

 
Note:  A requisition is created in RESUMIX with the KSAs from 
the core document displayed in the description field. 
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Create Applicant 

  
Purpose 
 

This section explains how Resumix creates an applicant in DCPDS.  It also 
examines the population of predetermined fields in DCPDS with employee 
information in Resumix.  This data sharing capability is intended to eliminate 
duplicate entries and facilitate the creation of applicant records in DCPDS.  
After an outside candidate accepts a job offer, you will initiate action in 
Resumix to create an applicant in DCPDS.  An outside candidate is one who 
is not in the same regional database as the vacancy being filled. 

  
What Applicant  
Data Flows 
from 
RESUMIX 

A variety of person-related data flows from the Resumix applicant record to 
the applicant record in DCPDS.   

RESUMIX 
Field 

DCPDS Location 
(Information will flow as clear text unless indicated 

otherwise) 
Standard  

1. Address - St, City, 
ST, Zip 

Address Line 1 
Address Line 2 
Address Line 3 
LOCAL_ADDR_STREET 
 
City 
LOCAL_ADDR_CITY 
 
State 
LOCAL_ADDR_STATE 
 
Postal Code 
ADRS_MAIL-ZIP 

2. Home Phone Telephone number 1 - HOME_PHONE 
3. First Name First Name -NAME_PERS 
4. Middle Name Middle Name (1st char only) - NAME_PERS 
5. Last Name Last Name - NAME_PERS 

 
Continued on next page 
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Create Applicant, Continued 

  
What Applicant  Data Flows from RESUMIX (continued) 
 

RESUMIX 
Field 

DCPDS Data Fields 
(Information will flow as clear text unless 

indicated otherwise) 
Standard  

6. Trailer Suffix 
7. Sex  (Required) Sex (code) 
8. Race Race or National Origin (code) 
9. Identification Number 

(Required) 
Social Security  
 

      Custom  
1. Birth Date  (Required) Birth Date 
2. Date Occ Cert Issued   Date Occupational Cert Issued   
3. Physical Date  Physical Date  
4. Physical exam or Test 

Type 
Physical Exam or Test Type (code) 
 

5. SCD Civilian SCD Civilian 
6. SCD Leave SCD Leave 
7. SCD RIF SCD RIF 
8. Security Clearance Personnel Sec Clearance (code) 
9. Social Security Number Social Security 
10. Type of Occ Cert Type of Occupational Cert (code) 
11. Veteran Preference 
          (Numeric) 

Veteran Preference (code) 

  
Continued on next page 
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Create Applicant, Continued 

 
Creating an 
Applicant in 
DCPDS 

The “Hire” process in Resumix triggers the automatic flow of data to DCPDS.  
To hire an applicant in Resumix, you change the applicant’s Tracking Action 
and Status.  In response, the applicant’s data automatically flows from 
Resumix to create an applicant record in DCPDS. 

 
Step Action 

1 Locate the candidate in Resumix. 
2 Change the candidate’s Tracking Action to “Decision.” 
3 

 

Change the candidate’s Status to “Accept.” 
Note:  There is an additional acceptance process in DCPDS.  New 
applicants are not immediately available for placement against 
RPAs.  They must first be “accepted” in DCPDS.  However, you 
cannot accept applicants until the day after their records are 
created.  Further, they cannot be placed until the day after they are 
accepted.  For information relating to accepting an applicant, see 
Module 4, Staffing Using the DCPDS, Chapter 1, Building an 
Applicant. 
For internal candidates, those who are in the same regional 
database as the vacancy being filled, the user must change the 
candidate’s Tracking Action to “Decision” and the Status to 
“Accept - Internal.”  This will prevent the creation of an applicant 
record in DCPDS.  After this has been accomplished, the user 
must change the candidates status from “available” to 
“unavailable” and total openings form “1” to “0” in the Resumix 
application. 
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Refresh 

  
Purpose 
 
 
 

                   

This section explains the process of the periodic and automatic updating of 
current employee information in Resumix from information contained in 
DCPDS. 
 
Note:  The employee must have a record in Resumix for the update to occur. 

   
How Employee 
Data Flows to 
RESUMIX 

Employee data flows from the DCPDS database to the applicant record in 
Resumix to populate standard and custom fields.  Where data involved in the 
process is different between DCPDS and Resumix fields, the DCPDS data 
will update (refresh) the Resumix database, overwriting or deleting any 
previous Resumix data.  In other words, DCPDS data is considered the data 
of record. 
 
All data flow for this process is direct database-to-database transfers 
accomplished via Oracle SQL*Net database links between the Regional 
DCPDS and Regional Resumix databases. 

  
What Employee 
Data Flows to 
RESUMIX 

 

RESUMIX 
Field 

DCPDS Data Fields 
(Information will flow as clear text unless indicated 
otherwise) 

Standard  
1. Disability Handicap Code (code) 
2. Sex Sex (code) 
3. Race  Race National Origin (code) 

Custom  
1. Appointment Type Appointment Type (code) 
2. Appraisal Type Appraisal Type (code) 
3. Birth Date   Birth Date 
4. PERM-Agency 

Group 
Agency Group (code) 

5. PERM-PP Current Permanent PP 
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Refresh, Continued 

  
What Employee Data Flows to RESUMIX (continued) 
 

RESUMIX 
Field 

DCPDS Data Fields 
(Information will flow as clear text unless indicated 
otherwise) 

Custom  
6. PERM-PP Current Permanent PP 
7. PERM-SER Current Permanent SER 
8. PERM-GR   Current Permanent GR 
9. PERM-Office Symbol Current Permanent Office Symbol 
10. PERM-Org Struc ID Current Permanent Organization Structure ID 
11. PERM-PAS Current Permanent PAS Code (code) 
12. PERM-UIC Current Permanent Authorized Unit ID Code 

(code) 
13. PERM-Comp LVL Current Permanent Competitive Level 
14. Rating of Record Rating of Record (code) 
15. SCD Civilian   SCD Civilian   
16. SCD Leave   SCD Leave   
17. SCD RIF   SCD RIF 
18. Education Level Education Level, highest level (code) 
19. Spec Placemt Cons 

Reas 
Spcl Plcmt Consid Reason (code) 
All values 

20. Citizenship Citizenship (code) 
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Chapter 4 

Placement Actions 

Chapter Overview 

  
Introduction This chapter guides you through a number of staffing actions to include 

recruit/fill, promotions, change to lower grade, reassignment, retained grade, 
etc.  Not all staffing procedures are illustrated.  

   
Chapter Contents  

Topic Page 
Accessing the Civilian Inbox or the RPA to Process an Action 2 
Processing a Recruit/Fill 3 
Processing Promotions/Change to Lower Grade  7 
Processing Reassignments 10 
Processing Not to Exceed (NTE) Actions 12 
Updating and Viewing Education Data 15 
Processing a Detail 16 
Extending a Detail 20 
Terminating a Detail 23 

 
Continued on next page 
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Chapter Overview, Continued 

  
Before you 
begin 

Staffing actions may be initiated by a manager and forwarded to the personnel 
office for processing or by the personnel office.  The Civilian Inbox and 
Workflow Inbox are used to access the RPA if a manager submits the action. 

  
Accessing the 
Civilian Inbox 
 or the RPA to 
Process an  
Action 

If an action is initiated by: 
 

A manager… Personnel… 
Navigation Path→ Civilian 
Inbox → Open. 

Navigation Path →Request for 
Personnel Action →Reassignment (or 
any action) → Open. 

The Notifications Summary 
window opens.  Move the 
Current Record Indicator to the 
RPA you need   
(ex:  Reassignment). 

 

Select <Respond> to display the 
RPA. 
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Processing a Recruit/Fill 

   
Purpose This procedure guides you through the steps for processing a Recruit/Fill in 

the Workflow Inbox. 

  
Accessing the 
Workflow 
Inbox 

 

Step Action 
1 Navigation Path →Worklist → <File> → <Open>. 
2 The Notifications Summary window opens and contains all 

actions sent to you that relate to your responsibilities. Select the 
action you wish to display and select . 

 
3  

To view or edit the Request 
for Personnel Action: 
• Select   

  

 
To display the routing history of the 
Request for Personnel Action: 
• Select  

   

 
 
 

Continued on next page 
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Processing a Recruit/Fill, Continued 

  
Completing the  
RPA for Recruit/ 
Fill 

 

Step Action 
4 The RPA opens.  Select the <Change Family> button at the top of 

the window.  A Message Box appears, “Are you sure you want to 
change Nature of Action family?”  Select the <Yes> button.   

  

 
 

Continued on next page 
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Processing a Recruit/Fill, Continued 

  
Completing the RPA for Recruit/Fill (continued) 
 

Step Action 
5 The LOV window opens select a Family, select the <OK> button. 

The data fields in the RPA are ready for input. 

 
6 Select the LOV icon to open the window to make your selection for 

data fields. 

 
 
 
 

Continued on next page 
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Processing a Recruit/Fill, Continued 

  
Completing the RPA for Recruit/Fill (continued) 
 

Step Action 
7 The position data on the TO INFORMATION Region is normally 

completed by the supervisor/personnelist initiating the action.  Refer 
to the specific actions in this chapter for processing instructions 
(e.g., promotion, reassignment, grade change).  
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Processing Promotions/Change to Lower Grade 

  
Purpose This procedure guides you through the steps for processing a Promotion 

action or a Change to Lower Grade (CLG). 

  
Completing the 
RPA 

 

Step Action 
1 Navigation Path → Workflow Inbox. 
2 The Notifications Summary window opens.  Select and open the 

RPA for Promotion or CLG you wish to process. 
3 Select the <Open> button.  
4 Select the <Request for Personnel Action> 
5 The Request for Personnel Action window opens.  Complete each 

data field in Part A by typing in the data or using the LOV.  
Complete Part B and FIRST ACTION Regions to include the 
Name of Employee, Effective Date, Nature of Action Code, and 
Legal Authority Code. 

 
6 Select the Position Data tab with your cursor in block 15, the 

Position Title data field, click the LOV icon to select a new 
Position. 

 
 

Continued on next page 
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Processing Promotions/Change to Lower Grade, Continued 

  
Completing the RPA (continued) 
 

Step Action 
7 If necessary, change the Step or Rate data field in Block 19 by 

typing in the data or using the LOV. Select the Save icon. 

 
 

 
Extra 
Information 

In some actions, additional extra information for Promotions or Change to 
Lower Grade must be input. 

 
Step Action 

8 Select <Extra Information> on the bottom of any page of the 
RPA. 

9 Review the Pay Information NOA Flexfield to verify the data 
fields have populated. 

 
Note:  For most promotions or CLGs, no extra information is 
required. 

 
Continued on next page 
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Processing Promotions/Change to Lower Grade, Continued 

  
Extra Information (continued) 
 

Step Action 
10 After verifying the information close the window 
11 The RPA opens.  Select the Save icon. 
12 A Message Box opens asking if you want to route this action. 

Select the <Yes> button.  

 
13 The Routing window opens.  Select Update HR. 

 
14 Select the Print Notification checkbox and select the Printer if 

you want to print the action at this time. 
Select the Approval checkbox. Then select the <OK> button. 

15 
 
 

The Message Bar at the bottom of the window indicates the 
Transaction is complete. 
Note:  If an Error Message Box opens and indicates an edit to 
correct, click <OK>.  The RPA opens.  Make the correction on 
the RPA and select Save. 
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Processing Reassignments 

  
Purpose This procedure guides you through the steps for processing a reassignment.  

A reassignment action may be initiated by a manager and forwarded to the 
personnel office for processing or the personnel office may initiate it. 

  
Completing the 
RPA  

 

 Step Action 
1 Navigation Path → Workflow Inbox → <Open>.  The 

Notifications Summary window opens.   
2 Select the RPA action you wish to display. 
3 Select <Open> to edit or view the RPA. 
4 Select the <Request for Personnel Action> 
5 The RPA opens.  With your cursor in Part B, type the date or click 

the LOV for the Effective Date in Block 4.   
6 Place your cursor in Part B, Block 1, select the LOV or type the 

employee’s name or SSN in Block 2.  The remaining data fields 
automatically populate. 

7 Fill in Block 5-A with the NOA and the Legal Authority Code in 
Block 5-C. 

8 Select the <Position Data> tab to advance to Page 2.  The TO 
INFORMATION side of the RPA should be completed by the 
manager. 

9  With your cursor in Block 15, Position Title, select the LOV.  As 
this is a long list, type in a partial title and click <Find> to display a 
shortened list.  The remaining data fields automatically populate.  If 
applicable, the employee step may need to be adjusted. 

10 Select the <Employee and Position Data> button to advance to 
Page 3 for review and make changes as needed. 

11 Select the <Remarks and Address> button to advance to Page 4.  
Select the LOV to select appropriate remarks or type in remark 
codes. 

12 Select the Save icon on the Toolbar. 
13 A Message Box opens asking if you want to route this action. 

Select <No> to continue completing RPA.     
 
 

Continued on next page  
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Processing Reassignments, Continued 

  
Completing the RPA (Continued) 
  

Step Action 
14 
 

 

Select <Extra Information> and complete the descriptive 
flexfields.  
Note:  Normally, there is no need to enter data in <Extra 
Information>.  However, there may be some instances when it 
may be necessary (e.g., when an employee’s position is obligated, 
the qualification standard was waived to accomplish the placement 
actions. 

15 Select the Save icon on the toolbar and exit the Extra PA Request 
Information Window.   

16 Select the Save icon on the toolbar once you are returned back to 
the main pages of the RPA. 

17 A Message Box opens asking if you want to route this action. 
Select <Yes>.  The Routing window opens select <Update HR>, 
select a Printer, make a determination if the Back Page of the NPA 
needs to print,  and select the Approval checkbox, then the <OK> 
button. 
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Processing Not to Exceed (NTE) Actions 

 
Purpose  This procedure guides you through the steps for processing a Not-To-Exceed 

Action from the Civilian Inbox.  This procedure addresses a Promotion NTE; 
however, the procedures are similar for other NTE actions, such as 
Appointment, Leave-Without-Pay, Suspension, etc. 

   
Processing the 
NTE Action 

 

Step Action 
1 Navigation Path → Workflow Inbox → <Open>. 
2 The Notifications Summary window opens.  Select the RPA 

Promotion NTE to process and choose the <Open> button. 
4 Select the <Request for Personnel Action> 
5 The RPA opens.  Place your cursor in Part B, Block 5-A Code; use 

the LOV or type in the appropriate code (e.g. 703).  A PA Req 
First NOA Ins Values window opens.  Type in the NTE date of 
your action.  

 
6 Select the <OK> button. 
7 

 

 

 

 

 

 
 

The RPA opens with the date populated in Block, 5-B Nature of 
Action.  Complete remaining data fields as needed.  

 
Note:  To change the NTE date, put your cursor in the block and 
press the [TAB] key.  The NTE pop-up appears for editing.  Use the 
same procedure for editing the Remarks and Legal Authority 
Codes.  Fill in information on pages 2, 3 and 4 if appropriate. 

8 Select the Save icon on the Toolbar. 
 

Continued on next page  
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Processing Not-To-Exceed (NTE) Actions, Continued 

 
Completing 
Extra 
Information 

Complete the Extra Information as required for this action. 

Step Action 
9 Select the <Extra Information> button. 
10 The Extra PA Request Information window opens select any 

Information Type; e.g., Global Information for 5/7/9 NOAs.  

 
Click in the Details data field to open the Extra PA Request 
Information window 

11 Enter data in each appropriate field.  

 
 
 

Continued on next page  
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Processing Not-To-Exceed (NTE) Actions, Continued 

 
Completing Extra Information (Continued) 
 

Step Action 
12 Select the <OK> button after each Extra PA Request 

Information data field completed.  Save work Exit the window to 
return back to the main RPA. 

13 From the main RPA window, select the Save icon. 
14 A Message Box opens.  Select the <Yes> button. 
15 The Routing window opens. Select Update HR, then Print 

Notification checkbox appears select a Printer, if you want to print 
the action at this time. Select the Approval check box, then the 
<OK> button. 
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Updating and Viewing Education Data 

  
Purpose This section explains how initial education information is captured.  It also 

explains how to locate and update education information, as well as how to 
view a list of employees by their education data to select one for viewing.  
For more detail in updating education data, see Module 1, Fundamental of the 
DCPDS, Chapter 5, Updating and Viewing the Employee Record. 

  
Initial Input Education should initially be input on the Appointment RPA.  If Block 45, 

Educational Level, is coded with the value 06, 10, 13, or higher, Block 46, 
Year Degree Attained, and Block 47, Academic Discipline must be 
completed to pass CPDF edits.  If any other value is input in Block 45, Blocks 
46 and 47 must be blank. 
To capture education data on the Appointment RPA, select <Extra 
Information>, select Extra PA Request Information, click in the Details data 
field and complete Education Information for 1/5/7/9 NOAs. 

  
Locating and 
Updating 
Education 
Information 

To locate education information on an employee for viewing or updating, 
Navigate to the → People → Enter and Maintain →<Open>.  The Find 
Person window opens.  Query for the employee needed.  The People window 
opens Click the <Special Information> button. When window opens Scroll 
to Education and click in the Detail data field to display and complete the 
DDF.  

  
Viewing 
Education 

Navigation Path →View →Lists →People by Special Information → 
<Open>. 
• The List People by Special Information window opens.  
• In the Special Information Type data field, type in Education% and 

select <Find>. 
• The list of employees by name opens.  
• Move the Current Record Indicator to locate the employee you need, 

click in the Detail data field. 
• The Education descriptive flexfield opens.  
• View the information and exit the window. 
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Processing a Detail 

  
Purpose This procedure provides instructions to process a detail using the People 

Record, to include extending and terminating, correcting or canceling on any 
appropriated fund employee. 

    
Before You 
Begin 

• Before detail actions can be processed, the employee to be detailed must 
exist and have a current assignment. 

• Before, during, and at the conclusion of a detail, an employee continues to 
occupy the same position to which assigned before the detail began. 

• All details are on a not-to-exceed (NTE) basis and must have an end date. 
• Payroll Interface is output only if Payroll Org Code (Navy only), FLSA, 

or premium pay is not the same as the Payroll Org Code, FLSA or 
premium pay of the employee’s current position. 

• If you need an RPA to document a Detail, Navigate to Request for 
Personnel Action, then Detail.  Complete, save, and print the RPA.  This 
RPA cannot be updated to the database. 

• The system will generate a Detail Notification of Personnel Action (NPA) 
if the Detail SIT is completed and data element Print NPA contains a ‘Y’.   

 
Continued on next page 
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Processing a Detail, Continued 

  
  

Step Action 
1 Navigation Path →People →Enter and Maintain →<Open>. 
2 The Find Person window opens; type in the employee’s name, 

then click the <Find> button.   
3 Click the <Special Information> button; the Special Information 

window opens.  Scroll down to the Detail Information data field. 
The Start Date populates with the current date but it can be 
overridden by clicking in the Start Date data field, deleting the 
date, and substituting a different date.  To input, change, or view 
specific information applicable to a detail, click in the Detail data  
Field. 

  
 

Continued on next page 
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Processing a Detail, Continued 
 

  
Step Action 

4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The Detail Information window opens.  Complete each data fields 
using the LOV. The Nature of Action data field is the only required 
field for all Components.  If you input the Valid Grade, you must 
also enter the Pay Plan.  For Air Force and Navy, the Position 
Number is required; it must be a valid position number and 
sequence.  All other data fields, except NOA, may be completed or 
left blank.  

 
Notes:  
1:  Normally the Premium Pay field will be blank.  However, in 
those instances where a detail involves a premium pay indicator 
that is different from the employee’s non-detail assignment input 
the premium pay indicator that applies to the detail (or choose it 
from the LOV).  The difference in the detail/non-detail premium 
pay indicator will trigger the output of a payroll interface 
transaction. 
2:  When Detail Info SIT is saved, the following fields will auto-
populate from the Detail Position Info as long as the Detail Position 
is valid in the system. 

Valid Grade Pay Plan Demo Location Code 
Series Appropriation Code Demo Pay Plan 

FLSA Category Bargaining Unit Status Demo Broadband 

Work Schedule Position Title Location 

OSC/Navy Pay Org Organization  
 

 
 

Continued on next page 
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Processing a Detail, Continued 
 

  
Step Action 

5 Select the <OK> button this returns you to the Special 
Information window with the Detail data field populated 

6 Type the End Date of the Detail next to the Start Date.  Click the 
Save icon. A pop-up Note tells you the number of days.   

 
 

7 When users re-query the Detail Information SIT, they then can see 
the fields that were auto-populated when Save was completed. 
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Extending a Detail 

    
Extending a 
Detail 

Follow your Component’s policy in selecting an extension method. 
 

• Method 1:  Change the End Date of the detail to the extended date, 
change the Nature of Action from 930 (Detail) to 931 (Extension of 
Detail), and change the Total Days This Detail to reflect the total 
number of days of the detail.  Save the changes.  NOA 931 NPA will 
generate with an effective date of the original Detail start date.  NOA 
931 Pay500 (if generated) will have an effective date of the original 
Detail start date and the new NTE date will be in columns 397-402. 

 
• Method 2:  Create a new Detail entry.  Use the end of the original 

detail as the date for the Start Date, the new NTE date of the detail for 
the End Date, ‘931’ as the Nature of Action, and the length of the 
extension for the Total Days This Detail.  All other fields would be 
completed as they were for the original detail that is being extended.  
Save the changes.  NOA 931 NPA will generate with an effective date 
of the Extension of Detail.  NOA 931 Pay500 (if generated) will have 
an effective date of the Extension of Detail and the new NTE date will 
be in columns 397-402. 

 

  
Detail NPA 
Information 

• Details NPAs are generated only when the Detail SIT is completed/saved 
and the data element Print NPA contains a ‘Y’. 

• Details NPAs are not available for viewing through Processes and Reports. 
• Details NPAs cannot be corrected or cancelled.   
• For Air Force, NPA is flowed to PARIS when user saves Detail SIT and 

data element Print NPA contains a ‘Y’. 
• The table below determines where the information is pulled to print on the 

FROM side (blocks 7 through 14) and the TO side (blocks 15 through 22): 
 

When NOA 
equals: 

Use Employee Current 
Assignment Information on:  

Use Employee Detail SIT 
information On: 

930 FROM Side (See Note 3) TO Side (See Note 1) 
931 FROM Side (See Note 3) TO Side (See Note 1) 
932 TO Side (See Note 3) FROM Side (See Note 2) 

 

 
 

Continued on next page 
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Extending a Detail, Continued 

 
 

 

 
Note 1:  This identifies the data fields in the Detail SIT to print in each of the 
blocks: 

 ♦ Block 15. TO: Position Title and Number - This block will 
consist of 2 lines.  On the first line, print value in “Position 
Title”.  On the second line, print value in “Position Number”. 

♦ Block 16. Pay Plan - Print value in “Pay Plan” located in 
Detail SIT. 

♦ Block 17.  Occ. Code - Print value in “Series” located in 
Detail SIT. 

♦ Block 18.  Grade/Level- Print value in “Valid Grade” located 
in Detail SIT. 

♦ Block 19.  Step /Rate - IF Detail position is a higher or lower 
grade than permanent position, print value of “00”.  If Detail 
position is the same grade as permanent position, print the 
employee’s step as of effective date of action. 

♦ Blocks 20, 21, 20A, 20B, 20C, 20D:  Print the pay information 
as it resides in the employee’s record as of the effective date 
of the action. 

♦ Block 22. Name and Location of Position’s Organization- 
Print the Table 30 entry as defined for the “Organization” 
value located in Detail SIT. 

 

 

 
Note 2:  This identifies the data fields in the Detail SIT to print in each of the 
blocks: 

 ♦ Block 7. FROM: Position Title and Number - This block will 
consist of 2 lines.  On the first line Print value in “Position 
Title”.  On the second line print value in “Position Number”. 

♦ Block 8. Pay Plan - Print value in “Pay Plan” located in Detail 
SIT. 

♦ Block 9.  Occ. Code - Print value in “Series” located in Detail 
SIT. 

♦ Block 10.  Grade/Level - Print value in “Valid Grade” located 
in Detail SIT. 

 
 
 

Continued on next page 
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Extending a Detail, Continued 

 
 

Note 2 (Cont): 
 ♦ Block 11.  Step /Rate - If Detail position is a higher or lower 

grade than permanent position, print value of “00”.  If Detail 
position is the same grade as permanent position, print the 
employee’s step as of effective date of action. 

♦ Blocks 12, 13, 12A, 12B, 12C, 12D:  Print the pay information 
as it resides in the employee’s record as of the effective date 
of the action. 

♦ Block 24. Name and Location of Position’s Organization- 
Print the Table 30 entry as defined for the “Organization” 
value located in Detail SIT. 

 

 
Note 3:  Exception is for Detailed Employees who are currently on Retained 
Grade.   

 If the PRD is A, B, E, F, U, or V, then the following applies: 
♦ Step equals “00” 
♦ Pay Basis is pulled from the Retained Grade record 

instead of the current position 
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Terminating a Detail 
 

 
 
Terminating a 
Detail 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
    

 

Follow your Component’s policy in selecting a termination method. 
 

• Method 1:  Change the End Date of the detail to the Termination date 
(if different from the original End Date), change the Nature of Action  
to ‘932’ (Termination of Detail), and, if needed, change the Total 
Days This Detail to reflect the total number of days of the detail.  
Save the changes.  NOA 932 NPA will generate with an effective date 
of the Detail End date.  NOA 932 Pay500 (if generated) will have an 
effective date of the Detail End. 

 
• Method 2: Create a new Detail entry.  Type the effective date of the 

Termination of Detail in the Start Date and End Date fields, ‘932’ as 
the Nature of Action and Total Details This Detail would be left 
blank.  All other fields would be completed as they were for the 
original detail that is being terminated.  NOA 932 NPA will generate 
with an effective date of the Termination of Detail.  NOA 932 Pay500 
(if generated) will have an effective date of the Termination of Detail.   
 

Note: NOA 932 Termination of Detail will auto-generate for Air Force 
records only (if most current Detail entry equals NOA 930 or 931 and Detail 
End Date is greater than or equal to (<=) the current system date). 
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Module 4 

Chapter 5 

Changing Employee Records 

   
Introduction This chapter guides you through the various procedures to change employee 

records to include a Name Change, Realignment, and a Change in Title. 

  
Chapter Contents  
 

Topic Page 
Processing Name Changes 2 
Processing Realignments 4 
Processing Position Changes 6 
Processing a Change in Title 9 
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Processing Name Changes 

  
Purpose This section guides you through the steps for processing an employee name 

change. 
 
Notes:  

• Use the employee’s SSAN when following this process because the 
application will not always respond to an employee name.  

• Components will determine business rules for employee 
documentation of name change.  

  
Making the 
Name Change 

 

Step Action 
1 Navigation Path → Request for Personnel Action → Change 

Actions → Name Change → <Open>. 
2 The RPA window opens. 

Note:  The supervisor/manager may submit the RPA with the new 
name or a note indicating the employee’s new name to the 
personnelist.  The employee may also notify the personnel office 
of their name change.  

 
 

Continued on next page 
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Processing Name Changes, Continued 

  
Making the Name Change (continued) 
 

Step Action 
3 • Place the cursor in the Part B Region, Social Security 

Number data field, type in the Social Security Number. 
• Place the cursor in the Part B Region, Last Name data 

field, type in the new name. 

 
4 • Enter NOA Code 780 in 5-A Code data field.  The 

employee’s previous name populates in 5-B, Nature of 
Action.   

• Enter the appropriate Legal Authority Code in the 5-C 
Code data field.  The Legal Authority populates in 5-D, 
Nature of Action.   

 
6 • Personnel Office:  Enter the effective date in Part B 

Region, Effective Date data field.  OR 
• Supervisor/Manager:  Enter the effective date in Part A 

Region, Prop Eff Date data field. 
7 Select the Save icon on the Toolbar. 
8 A Decision window appears asking if you wish to route the RPA 

now.  Select the <Yes> button.   
The Routing window appears.  Save and route or update your 
RPA as described in Module 3, Processing Requests for Personnel 
Action Using the DCPDS. 

9 Select the <OK> button and Exit the window. 
 

Continued on next page 
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Processing Realignments 

 
Purpose This section guides you through the steps to process a realignment action.   

   
Processing 
Realignments 

 

Step Action 
1 Navigation Path → Request for Personnel Action → Realignment 

→   <Open>.  
2 The RPA window opens.  Complete data fields in Part A either by 

utilizing the LOV icon to select the information or type in the data 
fields. 

3 Place the cursor in Part B, 5-A Code data field, type in the NOA 
Code 790 or select the LOV icon to select the appropriate action.  

4 Place the cursor in 5-C Code data field and type in the Legal 
Authority Code or select the LOV icon and select the appropriate 
code.  If the legal authority code requires an insertion value, the 
PA Request First LA1 Insertion Values window appears.  Type 
in the required information.  Select the <OK> button.  

 
5 Select the Save icon on the Toolbar. 
6 A Decision window appears asking if you wish to route the RPA 

now.  Select the <No> button.   
7 A Message Box appears informing you an RPA number has been 

generated.  Select the<OK> button. 
8 Select the <Extra Information> button. The window opens with 

the name of the employee and action on the Title Bar. Select 
Realignment Extra Information Type.  

9 Click in the Details data field.  The Extra PA Request 
Information window opens.  Enter data in each required data 
field. 

10 Select the <OK> button.  The Extra PA Request Information 
Types is viewed and the Realignment Extra Information Details 
data field completed. 

11 Select the Save icon on the Toolbar. 
 

Continued on next page 
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Processing Realignments, Continued 

   
Processing Realignments (continued) 
 

 

12 Select US Fed Realignment Type. Select in the Details data field.  
The window opens.  Enter the required data in each field. Select 
the <OK> button, select the Save icon on the Toolbar and close 
the Extra PA Request Information window.   

13 Select the Save icon on the Toolbar.  A Message Box opens 
asking if you want to route this action.  Select the <Yes> button. 

14 The Routing window opens, select Update HR and print 
notification as desired. Select the Approval box, and select the 
<OK>button. 
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Processing Position Changes 

  
Purpose This section guides you through the steps for processing position changes.  

  
Processing 
Position Changes 

 

 
Step Action 

1 Navigation List → Request for Personnel Action → Federal 
Position Change →   <Open>. 

2 The RPA window opens.  Complete data fields in Part A either by 
utilizing the LOV icon to select the information or type in the data 
fields. 

3 Complete Part B and First Action areas using the LOV icons or 
type in the information in the data fields. 

4 Select the Save icon on the Toolbar.  A Decision window appears 
asking if you wish to route the RPA now.  Select the <No> button. 

5 A Message Box appears informing you an RPA number has been 
generated.  Select the<OK> button. 

6 Select the <Person> button.  The People window opens with the 
data fields populated. 

 
 

Continued on next page 
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Processing Position Changes, Continued 

  
Processing Position Changes (continued) 

Step Action 
7 Select the <Extra Information> button.  The window opens with 

the employee name on the Title Bar.  Date Track to the effective 
date of the Position Change action.  Select US Federal Retained 
Grade.  Click in the Details data field.  

 
8 The Extra Person Information window opens.  Use the LOV to 

select or type the information in for each data field. 

 
Select the <OK> button.   

9 Select the  Save icon on the Toolbar and exit the window.  
10 The Position Change RPA appears.  Select the Position Data tab. 

Place the cursor in Block 15, the Position Title data field, select the 
LOV to select the new position. 

11 Place the cursor in the TO INFORMATION Region, Block 19, 
Step or Grade data field, type “00.”  

 
 

Continued on next page 
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Processing Position Changes, Continued 

  
Completing the 
RPA 

 

Step Action 
12 A Message Box opens and tells you the grade and steps do not 

match a pay table.  Select the<OK> button. 

 
13 Select the Employee and Position Data tab place the cursor in 

Block 29, Pay Rate Determinant, select the LOV icon to select the 
correct value.  A Message Box appears and tells you the Pay 
Calculation has been recalculated. 

14 Select the <OK> button then select the  Save icon on the Toolbar.  
15 A Message Box opens asking if you want to route this action.  If 

you need to input other data, select the <No> button. Select the 
applicable position.  Select the <Extra Information> button and 
enter data.  Once complete select the <OK> button. 

16 The RPA Appears.  Select the Save icon on the Toolbar. 
17 A Message Box opens asking if you want to route this action.  

Select the<Yes> button.  
18 The Routing window opens select Update HR and the Print 

Notification checkbox then select a Printer if you want to print the 
action. Select the Approval checkbox. 
Select the <OK> button. 
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Processing a Change in Title 

  
Purpose This section guides you through the steps to process a Change in Title.  Refer 

to Module 2, Position Management and Classification Using the Modern 
DCPDS, Chapter 2, Building Positions, and Section:  Changing Encumbered 
Positions. 

  
Processing a 
Change in 
Position Title 

 

Step Action 
1 Navigation Path → Request for Personnel Action → Change 

Actions → Change in Position Title → <Open>. 
2 The RPA opens. Use the LOV’s to select or type the data in the 

fields of Part A. 
3 Use the LOV to select the Effective Date or type in the effective 

date.  Then use the LOV to select the Employee. 
4 Use the LOV to select 0900 Nature of Action Code, for First 

Action, 5- A Code.  There is no Legal Authority associated with 
this NOA. 

5 Select the  Save icon on the Toolbar.   
6 A Message Box asks if you want to route the action.  Select the 

<No> button. 
7 A Message Box tells you the Request Number has been generated. 

Select the <OK> button. 
8 Select the <Extra Information> button on the RPA.  The Extra 

Person Information window opens.  
9 Select Change Position Title Type.  Click in the Details data field. 
10 The window opens.  Type in the new Position Title then select the 

<OK> button 
11 The Extra Person Information window appears with the new 

position title in the Details data field.  Select the Save icon on the 
Toolbar. 

12 A Message Box informs you the Transaction is complete.  Select 
the <OK> button.  Exit the window. 

13 The RPA appears.  Select the <Refresh> button. 
14 Select the Save icon on the Toolbar. 
15 Route the action and update HR as in previous processes. 
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Module 4 

Chapter 6 

Mass Actions 

Chapter Overview 

  
Introduction 
 
 
 
 
 

 

The purpose of this chapter is to provide information to process Mass 
Realignments and Mass Pay Adjustments.  

• Mass Realignments – used with reorganization 

• Mass Pay Adjustments – used with annual pay adjustment 

• The first two Navigation List items, Preview Mass Realignment and 
Final Mass Realignment, are not used by DoD. 

• The Custom Mass Realignment menu item is available as a “rough draft” 
window (Managers would use this to create their mass realignment file for 
the Personnelist to execute file).  It displays exactly like the Mass 
Realignment [Final] window, but without the <Execute> Taskflow 
Button. A Realignment can be created by clicking either the Custom Mass 
Realignment or the Custom Final Mass Realignment menu item.  A 
Realignment can only be executed in the Mass Realignment [Final] 
window. 

Chapter Contents  
Topic Page 

Processing a Mass Realignment 2 
Before You Begin 2 
Who Does It 3 
Previewing Your Action 7 
Adding Legal Authority Codes and Remarks 8 
Executing the Realignment 9 
Locating and Correcting Errors 11 

Processing Mass Pay Adjustments 12 
Before You Begin 12 
Processing Mass Salary 13 
Submitting Processes and Reports 16 
Initiating Future Dated SF52 for Processing 18 
Accessing the Request Log 19 
Printing the NPA (SF-50) 19 

Viewing Current Pay Tables 21 
Viewing Past Pay Tables 23 
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Processing a Mass Realignment 

  
Purpose This section provides information on how to process mass realignments that 

allow for an efficient processing of a group of similar personnel actions. 

  
Before You 
Begin 

• If your organization is changing, you must first build a position 
organization address before you begin the realignment. 

• A realignment is the movement of one or more positions, along with the 
employee(s) occupying the positions, when all of the following conditions 
are met: 
• An organization change occurs; for example, a reorganization or 

transfer of function. 
• Any employees involved remain in the same agency. 
• Although locality payments may or may not change, there is no other 

change in employees’ position, grade, or pay. 
• A mass realignment can be used when the same personnel action applies 

to two or more positions, provided the following characteristics are the 
same for all of the personnel actions:   
• Effective date. 
• Nature of action. 
• Authority code. 

In addition, the personnel actions required to document a realignment would 
be the same as those to process an individual RPA.   
• A US Appropriated Fund realignment is defined by OPM as Nature of 

Action (NOA) 790, whether the RPA is processed individually or part of a 
mass action.  When a vacant position is realigned, there is no RPA 
because no employee is directly affected.  The NOA used for a mass 
realignment does not apply to the position action of realigning vacancies. 

• You should coordinate with your System Administrator when you plan to 
process a Realignment.  They will need to run Futures and Batch Print.  
Unencumbered positions do not require Futures and a Batch Print.  

• If Geo Loc (geographic location) changes and locality pay changes, use 
NOA 895. 

• Once you Save your realignment in Preview or Final, you cannot change 
the document. 

 
Continued on next page 
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Chapter Overview, Continued 

  
Who Does It 

  The capability to create and execute a Mass Realignment is available in 
the CIVDOD Personnelist, Classifier, and Staffer responsibilities. 

 
  Taskflow Button Function  
  <Execute> Processes your action by submitting it 

to update the database. 
 

  <LACs/Remarks> Displays the Legal Authority Code 
and Remarks window.  Authority 
code(s) and any remarks saved on this 
window will apply globally to the mass 
realignment. 

 

  <Position Details> 
 
 
 
 
                                             
                                           
            
 

 

Displays the first of two windows 
where data to be changed in the mass 
realignment may be input and saved.  
The first is the Mass Realignment 
(Position Details) window.  This 
window has an <Additional Details> 
Taskflow Button which when clicked, 
displays the Mass Realignment 
(Position Additional Details) window.  
 

Note:   Once the information on the 
Position Details windows is saved, it 
cannot be overwritten.  You should not 
save the Mass Realignment until the 
information on the Position Details 
window is ready to finalize.  If 
erroneous information is saved, create 
a new realignment with a new name 
and process it instead of the erroneous 
one.   

 

  <Preview> Displays the Mass Realignment 
(Preview) window where the positions 
(and their incumbents, if any) for the 
realignment can be viewed and selected 
or deselected.  Also, a data element 
change not applicable to all positions in 
the realignment may be input and 
saved on this window. 

 

     
Continued on next page 
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Processing a Mass Realignment, Continued 

  
Who Does It (continued) 
 

Step Action 
1 

 
Navigation Path →  Mass Actions  →  Mass Realignment  →  
Custom Final Mass Realignment  →  <Open> 

2 The Mass Realignment [Final] window opens with four taskflow 
buttons.  

 

3 With your cursor in the Name data field, type in a unique name for 
the realignment you are creating.   

4 
 

Click the LOV icon to select a date in the Effective Date data 
field.  

5 Type in the required information in the Description data field.  
This is an optional free-form field where you can record pertinent 
information for reference.  For example, “RM directed realignment 
to implement IG Report #507  

6 The Status data field is system-generated to show the progress of 
your realignment; i.e., Unprocessed, Submitted, etc.  No action is 
required 

7 The By Organization drop-down menu does not change in the 
Source Region. 

8 Click the LOV icon to complete the Organization data field.  This 
is the organization realignment that the positions will be moving 
From. 

9 Click the LOV icon to choose the Organization Hierarchy.  This 
is an optional field. 

 
Continued on next page 
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Processing a Mass Realignment, Continued 

  
Who Does It (continued) 
 

Step Action 
10 

 
       

 

Select the LOV icon to choose the Target Organization.  This is 
the organization that realigned positions will be moving To.  
 
Notes:   
• The “From” and “To” organizations may be the same.  
• The Additional Source Criteria is used to limit the positions the 

system brings to the Mass Realignment (Preview) window as 
possible participants in the Realignment being processed.  
Completing a field filters out all positions that do not match 
the criteria.  For example, if you put “FPH” in the 
Organization Structure ID field, only positions with an Org 
Structure Code = “FPH” will be eligible for inclusion in your 
realignment, and only those positions will appear on the Mass 
Realignment (Preview) window.  You may complete all, 
none, or a combination of the four Additional Source Criteria 
fields.  When more than one of these fields is input, only 
positions that satisfy all of the Additional Source Criteria 
displays on the Mass Realignment (Preview) window. 

11 
 

     

Type the Organization Structure ID in the Additional Source 
Criteria Region.    This is an optional field. 
Note:  Complete this field, if you want to limit selection of 
positions to realign to a specific organization structure code. 

12 

     

Click the LOV icon to select the Personnel Office ID (optional). 
Note:  Input this field, if you want to limit selection of positions 
that you want to realign to a specific personnel office 

13 
 

 

Click the LOV icon to select the Agency Code/ Subelement 
(optional). 
Note:  Input this field, if you want to limit selection of positions to 
realign to a specific agency code and subelement combination. 

14 Type the Office Symbol in the data field. (optional) 
 

Continued on next page 
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Processing a Mass Realignment, Continued 

  
Who Does It (Continued) 

 
Step Action 
15 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select the <Position Details> button.   

 
Use the LOV to select or Type the information in the data fields.  
Select the <OK> button to return to the main window. 
Notes:  
• All are optional data fields. 
• If a data element is blank, the system does not change the data 

when the realignment is processed.  For example, if a new 
office symbol is not entered; all positions in the realignment 
will retain their current office symbol. 

 
 

Caution:  If erroneous data elements are entered and saved, they 
cannot be changed.  Create a new mass realignment to correct the 
error. 

16 Select the <Additional Details> button to display window.  Use 
the LOV to Select or Type the information in the data fields Click 
the <OK> button twice to return to the Mass Realignment  
window. 
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Processing a Mass Realignment, Continued 

   
Previewing Your  
Action 

 

Step Action 
1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 

In the Mass Realignment window, select the <Preview> button.  
The window opens with a Realign Checkbox position information 
and the data elements from the two previous windows populated.  
As you scroll through the columns, the Name and SSN columns 
remain visible. The From information cannot be updated and the 
Target columns are populated only if values are to be changed in 
the realignment.  You can input additional or change the data in 
Target Columns if necessary.   

 
Note: The check mark in the Realign Checkbox indicates the 
position on the line next to it is to be included in the realignment.  
Remove the check mark not to be included the position on the line   
The window initially appears with all positions selected for 
inclusion in the realignment unless, these individuals are part of 
another mass realignment file that has not yet been processed.  If 
that’s the case, the employees will come across in preview as not 
checked, and if they are part of this realignment, you must check 
that record.  If a large number of positions appear on the window, 
but only a few are to be realigned, click the <Select/Deselect All> 
button to remove the check mark from the Realign Checkboxes.  
Then, select the few positions to be included by individually 
placing a check mark in the Realign Checkbox.  
Note:  If you select/deselect records, please save, return to main 
screen, then navigate back to preview.  Review preview to make 
sure the target data flowed across in the target columns. 

2 
 

Exit the window to return to the Mass Realignment (Final) 
window.  Once you have “Executed” or “Processed” the action, 
The <Preview> button is grayed out. 
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Continued on next page 

 
Processing a Mass Realignment, Continued 

  
Adding Legal 
Authority Codes 
and Remarks 

 

Step Action 
1 
 
 
 

Click the <LACs/Remarks> button. The Legal Authority Codes 
and Remarks window opens.  Place the in the Legal Authority 
Region, Code 1 data field, click the LOV icon.  
• At least one LAC is required, Remarks are optional. 
• The Required Checkboxes on the Legal Authority Codes and 

Remarks window are not used.  There are no required 
Remarks for realignment. 

 
2 The First Legal Authority Codes 1 window opens select UNM or 

ZLM then click the <OK> button.  

 
 

Continued on next page 
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Processing a Mass Realignment, Continued 

  
Adding Legal Authority Codes and Remarks (continued) 
 

Step Action 
3  Place the cursor in the Code data field of the Remarks region, 

 click the LOV icon to select a Remarks code.  Click 
the <OK> button   

 
 

4 After selecting a code a Remark insertion window will appear. 
This is an optional field. click the <OK> button 

 
5 Click Save icon and exit the window. 

 
Executing the 
Realignment 

1 The Mass Realignment (Final) window opens.  Click the 
<Execute> button.  A Message box appears informing you the 
Realignment Final Process was successfully submitted.” 

 
The system checks if the realignment will process for a random 
person, unless all of the positions being realigned are vacant.  

 
Continued on next page 
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Processing a Mass Realignment, Continued 

  
Executing the Realignment (continued) 
 

Step Action 
2 
 
 

 

If you receive an Error Message stating the first personnel action 
will not complete successfully, you have the option to <Proceed> 
or <Cancel>.   

Note:  The system is checking the personnel action it first 
encounters which may or may not be the first action that displays 
on the Error Message. 

 
3 If you click the <Cancel> button, then you get a second Error 

Message that explains what caused the failure. 

 
4 Correct your error(s) as necessary on the Position Details window 

then click the <Execute> button again when ready to process. 

Individual realignment actions that do not successfully pass the 
business rules will create a Request for Personnel Action with 
NOA 790, routed to the “WGIPERSONNEL” groupbox.   

A report generates automatically to your default printer to identify 
any positions that became invalid as a result of processing the 
Realignment. 
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Processing a Mass Realignment, Continued 

 
Locating and 
Correcting Errors 

 

Step Action 
1 Navigation Path → Federal Maintenance Forms → Process 

Log (Federal) →   <Open>. 
2 The Process Log window opens. 

 
Select a process from the list to view results  

 

3 Access your Civilian Inbox to correct errors on the RPAs or 
click the <Position Details> button on the Mass Realignment 
window to correct position errors. 
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Processing Mass Pay Adjustments 

  
Purpose To provide information on how to process mass pay adjustments.  The mass 

salary process accomplishes an update of the employee HR record, of the 
personnel action, and payroll interface flow required to implement new or 
updated pay schedules.    

  
Before You 
Begin 

DoD WILL PROVIDE ANNUAL PROCESSING INSTRUCTIONS 
WITH CURRENT EXECUTIVE ORDER, ETC. 
 
• All pay schedules and locality percentage tables are centrally created for 

the HR system and are date sensitive.  Table loads must be completed 
before a Mass Salary Execution is done.    

 
• Mass Salary Preview may be run at any time, with or without benefit of 

salary schedule table update, to identify the records that will be selected 
for processing with the run.  You have the option to deselect records by 
name in the preview run and save the changes for use in the execution 
run.   

 
• Table updates will be released by the system maintenance contractor for 

loading on the appropriate date based on the effective date of the pay 
table(s) being updated.  Patch documentation and technical load 
instructions should be reviewed to determine the actual date of patch load 
and any other unique processing instructions.    

 
• Separate Mass Salary runs are required for each pay table number being 

applied.   

 
Who Does It 

  The capability to create and execute a Mass Salary Adjustment run is 
available in the CIVDOD Personnelist responsibilities.  Execution of the 
processes should be accomplished by or coordinated with system 
administrators to minimize system workload impact. 
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Processing Mass Pay Adjustments, Continued 

 
Processing 
Mass Salary  

Mass Salary Preview may be run at any time with or without benefit of salary 
schedule table update.  The preview will display all records that will be 
selected for processing with the execution.  Final Mass Salary may not be 
run until appropriate salary tables have been loaded in accordance with 
system patch instructions.  All system patches that contain salary tables will 
be date sensitive to ensure accuracy of record updates.   

  
Step Action 

1 
 
 

 

Navigation Path  →  Mass Actions  →  Mass Salary  →   
Preview Mass Salary → <Open>. 
 
Note:  The Preview Mass Salary menu item is exactly like the 
Final Mass Salary window, but without the <Execute> Button.  A 
mass salary run may be created on either the Preview Mass 
Salary or the Final Mass Salary window.   

2 The Mass Salary window opens.  Place the cursor in the Name 
data field, type in a unique name that will identify the pay table 
being processed and any other unique parameters included in the 
run.  Each pay table number to be previewed requires a separate 
setup.  

 
3 In the Pay Table ID data field, Click the LOV icon to select a pay 

table number.  Wage salary tables have a “W” prefix because there 
is no tie between a pay table number and a name.  It does not come 
from OPM with the “W” prefix. 

 
Continued on next page 
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Processing Mass Pay Adjustments, Continued 

  
Processing Mass Salary (continued) 
 

Step Action 
4 
 
 
 
 

 

If the preview run will be saved and used for the final execution, 
the Executive Order Number and Executive Order Date data 
fields may be included at this time, but are not required.  Data 
fields should be left blank if the preview is being run in advance of 
the signing of the Executive Order. 
 
Notes:  Executive Order fields apply only to General Schedule and 
equivalent increase, including special rate GS tables.  The system 
will default the “E.O.” to the SF-50 print, so only the executive 
order number is required.  Executive Order Date is the date the 
order was signed; e.g., dd-mmm-yyyy. 
 
Click the LOV icon to enter the Effective Date. This is the date the 
pay table that the system populates once the action is saved. 

5 The Additional Criteria Region has optional fields for 
Organization, Agency Code, Subelement Code Personnel Office 
ID, and Duty Station.  The fields are available for entry only in the 
event the records selected must be limited to one or more of the 
data fields. 

 
 

6 Click the LOV icon to select the Pay Plan and Pay Rate 
Determinant It is required to select the records to be processed.  
Exclusion of any combination will result in the records not being 
previewed.  

 
 

Continued on next page 
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Processing Mass Pay Adjustments, Continued 

  
Processing Mass Salary (continued) 
 

Step Action 
7 
 

 

Click the <LACs/Remarks> button. Place the cursor in the Code 
1 data field, click the LOV icon and select a code.  
Note:  Standard authority codes and SF-50 for grade and pay 
retention remarks designated in the OPM Guide to Processing 
Personnel Actions (GPPA) will be automatically written to the 
NPAs and should not be input on this screen.  Any additional 
authority codes or remarks documented in the OPM instructions 
for documenting the pay adjustment will need to be included here.    

 
8 Click the Save icon and exit window. 
9 The Mass Salary window opens with the Status data field 

populated with “Unprocessed.”  
10 Click the <Preview> button. Use the bottom scroll bar, to view the   

Old and New Salaries All salary fields are provided in the view as 
well as Pay Plan, Grade, Step, and Pay Rate Determinant. 

 
11 After viewing the records, click the Save icon    
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Processing Mass Pay Adjustments, Continued 

  
Submitting 
Processes and 
Reports 

This is normally accomplished by the System Administrator.  A Personnelist 
cannot process these reports.  A separate run must be accomplished for every 
pay table.  This does not update an employee record nor produce an NPA.  It 
will create an RPA for each selected employee. 

 
Step Action 

1 Navigation Path → Processes and Reports → Submit Processes 
and Reports → <Open>. 

2 The Submit a New Requests window opens. click the <OK> 
button 

 
 

3 Click the LOV icon in the Name data field, to select “Process 
Mass Salary” then click the <OK> button.  

 
 
 

Continued on next page 
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Processing Mass Pay Adjustments, Continued 

  
Submitting Processes and Reports (Continued) 
 

Step Action 
4 The Name data field opens. Use the LOV’s to select the 

appropriate Mass Salary Name (i.e., Mass Salary Process to run), 
then click the <OK> button.  

 
 

 5 Click the Options button, select a printer.  This does not produce a 
printed document; however, printer identification is required. 
Change the number of Copies to “O.” Then click the <OK> 
button. 

 
 

 
 

Continued on next page 
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Processing Mass Pay Adjustments, Continued 

 
Submitting Processes and Reports (continued) 
  

Step Action 
6 Click the <Submit> button. 
7 The Request window will appear click the <Refresh Data> button 

repeatedly to change status to Complete Normal.  

 
8 After the status has completed normal Click the <Diagnostics> 

button to check the run time.  The Request Diagnostics window 
opens and gives you the status of your report. 

9 Click <Save>.  Exit the windows and return to the Navigation 
List.   

  
Initiating Future 
Dated SF52 for 
Processing 

 

Step Action 
1 Click the Submit New Requests button in the Name data field, 

click the LOV icon to select “Initiate Process Future Dated SF52 
Due for Processing” then click the <OK> button. 

2 Select a printer, and change the number of copies to “O” and 
<Submit> the request.   

3 
 
 

 

Follow steps 3-8 from the previous procedure, Submitting 
Processes and Reports. 
 
Note:  The Request Diagnostics window provides information 
about Warnings and Errors.  You are directed to the Process Log 
or the Concurrent Manager log for specific information. 

 
Continued on next page 
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Processing Mass Pay Adjustments, Continued 

  
Initiating Future Dated SF52 for Processing (Continued) 
 

Step Action 
4 Navigation Path → Federal Maintenance Forms → Process Log 

→ <Open>. 
5 

 

 

The Process Log Errors window opens.  select the Process view 
results 
Note:  All processes that have run may be viewed.  The latest run 
open first.  Use the page-down key or the scroll bar to view others.  
Use the right and left arrow keys to view long lines of text. 
The Log Text Region contains the employee identification 
information and the reason for the error or warning.  In most cases, 
the RPA shows a request number, and you will find the action in 
your WGI Personnel Box 

6 Close the window and return to the Navigation List. 

   
Printing the NPA 
(SF-50) 

 

Step Action 
1 Navigation Path → Processes and Reports → Submit Processes 

and Reports → <Open>. 
2 The Submit a New Requests window opens. click the <OK> 

button Place the cursor in the Name data field, click the LOV and 
select “Batch Print Notification of Personnel Action.”  

3 
 
 
 
 
 

 

 

In the Parameters data field, click the LOV icon to open the 
Parameters window.  With your cursor in the NOA Code data 
field, click the LOV icon and select “894” for pay adjustment or 
type it in.  No other parameters are required.  Click the <OK> 
button. 
Caution:  If you click “yes” in the Reprint Printed SF50s data 
field, it will print ALL previously printed SF50s. 
 
Note:  The data fields, Reprint Printed SF50s, Front Page, and 
Back Page automatically populate with “Yes” or “No.” 

4 
 

 

Select the printer in the Options Region.  Click the <Submit> 
button. 
Note:  Follow steps 6-9 in this procedure under Submitting 
Processes and Reports to review your request. 

 
Continued on next page 
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Processing Mass Pay Adjustments, Continued 

  
Printing the NPA (SF-50) (continued) 
 

Step Action 
5 Access your Workflow Inbox to correct the pay adjustment actions 

that could not process because of a problem in the employee 
record.  Review and correct each action to ensure the employee 
receives the appropriate pay adjustment. 

6 
 
 
 

 

In your Workflow Inbox, select the action to correct and select the 
action to Open.  The Action window opens.  Make the necessary 
corrective action to resolve the error condition and process the pay 
adjustment.  Select the <Respond> button. 
 
Note:  Be sure to scroll to the bottom of the Message Box to view 
the entire error message.  
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Viewing Current Pay Tables 

 
Purpose This section guides you through the steps for viewing current pay tables. 

    
Viewing the  
Current Pay  
Table 

Note:   These are current pay tables, so there is no To or ending date.  Also, 
during development, the salaries on the tables must be defined so that HR 
knows how to handle the monetary units for printing and other purposes.  For 
example, the screens above reflect tables with money defined as a monetary 
unit of “whole US dollars.”  However, other tables may be defined differently: 
• Wage Tables in the US are defined as “US dollars and cents” and must be 

built with the decimal point included (dollars to the left of the decimal, and 
cents 2 places to the right of the decimal).   

• Special pay tables, such as the Demo Project at China Lake, have extra 
columns, such as “high step” which is necessary to perform their pay outs 
each year. 

Korean local national pay table open “Won” instead of dollars in the salary 
field, so the number of digits may be more or less than that of an annualized GS 
type salary. 

  
Step Action 

1 Navigation Path → Other Definitions → Table Values →  <Open>. 
2 The Table Value window opens.  

 
Press the F11 key in the Table data field; enter the Pay Table ID 
number you are looking for, such as 0000.  If you do not know the 
entire number, enter “00%,” then CTRL + F11 key.  

 
Continued on next page 
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Viewing Current Pay Tables, Continued 

  
Viewing the Current Pay Table (continued) 
 

Step Action 
3 “00%” open Pay Table ID 0000 first.  It is the table for regular rate 

GS type employees.  The Step (00) open in the Name data field in the 
Column Region.   
The Values Region, Pay Plan, and Grade display in the Exact 
Column.  Salary open in the Value Column; and the beginning and 
ending dates of the table are in the From and To data fields of the 
Effective Dates Column. 

4 
 
 

Use the down arrow key on the keyboard to scroll to the next step on 
the table.  You can scroll back and forth through the table.  To see 
different pay plans and grades in the Exact Column, use the left 
scroll bar and move it down to view the GG and GS pay plans and 
grades on the table.  

 

5 To view another table, query again. 
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Viewing Past Pay Tables 

  
Purpose This section guides you through the steps for viewing past pay tables to make 

corrections and cancellations 

   
Viewing Past Pay 
Tables 

 

Step Action 
1 Navigation Path → Other Definitions → Table Values → 

<Open>.  
2 Press the F11 key in the Table data field; enter the Pay Table ID 

number you are looking for, such as 0000.  If you do not know the 
entire number, enter “00%,” then CTRL + F11 key. 

3 Click the Alter Effective Dates  icon on the Main Menu Bar.   
4 
 
 
 
 
 

In the Effective Dates Region, enter the date for the time frame 
you want to view; e.g., if you need to look at a 2000 pay table, 
choose the effective date of the table or if unknown, choose a date 
within the month of the effective date.  If the table opens a 1999 
pay table, you will need to choose a later date to view.   
Note:  As each new pay table replaces an old one, the current table 
is end dated one day prior to the effective date of the new table and 
becomes “historical.” 

5 The Table Values window open.  This is an example of a date 
tracked historical table (OPM Standard Pay Table 0000 for 2000):   
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Module 4 

Chapter 7 

Cancellations and Corrections 
 
Chapter Overview 

  
Introduction This chapter explains how and when to cancel or correct a previous action 

using one of the following actions. 
• Cancellations 
• Corrections  
• DoD Correction Process 
• Pseudo SF 50 

Sometimes you need to follow special procedures when the action to be 
canceled was taken before the employee came to work in your agency or DoD 
Component.   

   
Chapter Contents  
 

Topic Page 
Before you begin 2 
Processing Cancellations 4 
Processing Corrections 6 
Processing Corrections to a Social Security Number or 
Date of Birth 9 
Processing DoD Corrections 12 
Using the Pseudo SF50 14 
Miscellaneous 16 
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Cancellations and Corrections, Continued 
  

Before you 
begin 
 
 

• You will process a Request for Personnel Action (RPA) with a Nature of 
Action (NOA) 001, Cancellation, if you need to completely wipe out a 
personnel action. 
• If canceling a previous action results in an employee being returned to 

an old assignment (one that started and ended before the employee 
entered your DCPDS database), you must create the old assignment.  
This gives the employee a previous or “fall-back-to” assignment to 
return to when the cancellation is processed.  You can correct a data 
element on an employee’s most recent personnel action, by processing 
the action with DoD Correction Process as provided for in the OPM 
Guide to Processing Personnel Actions.  

• However, there will be instances when an employee’s past history 
must be both reconstructed and corrected.  For example:  an 
employee’s pay was set incorrectly some time ago and the original 
action needs to be corrected.  Subsequent personnel actions involve 
incorrect pay because of the initial mistake.  Therefore, you may have 
to reconstruct and correct several actions.  
• The capability to view and print personnel actions in Self Service 

must also be considered.  The 'Personnel Actions' tab displays in 
'My Biz' and 'My Workplace'.  NPAs created are viewable when 
the ' Print Auto-Generated Reports’ is Y (Yes). 

 
• Capturing the value of the 'Print Auto-Generated Reports' flag is 

done via the RPA process. The flag is automatically set to 'Y' upon 
update to HR unless Remark Code 'XYZ - - DATA CLEANUP 
DO NOT DISTRIBUTE ' is present.  NPAs will appear on the 
maintenance form and are viewable in Self Service based on the 
following table: 

 
Flag  = Maintenance Form Self Service View NPAs 
‘Y' (Yes) Display Display NPAs 
'N' (No)   Display Do not display NPAs with   

' XYZ' 
               

• The flag can be changed for those NPAs viewable on the 
maintenance form.  When a NPA is processed with Remark 
code 'XYZ', the action must be cancelled and reprocessed 
without the remark code in order for the NPA to be viewed in 
Self Service. 

 Continued on next page 
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Cancellations and Corrections, Continued 
  

Before you 
begin (cont) 
 
 

• When you do a Correction, all updates in the database will be as of the 
effective date of the corrected action.  In those cases where the database 
must reflect this data earlier, process a DoD correction as of the 
employee’s hire/conversion date (as appropriate). 

• All updates in the database will be as of the effective date of the action 
that was corrected.  In any case, where the database must reflect this data 
earlier, process a DoD correction as of the employee’s hire/conversion 
date (as appropriate). 

• It is possible to correct an action that was not actually processed.  You 
could correct a “change in data element” on an employee’s conversion 
date, update the database, suppress the SF50, and inhibit payroll interface 
just to correct a data element that appears on RPAs/NPAs but is not 
directly updateable. 
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Processing Cancellations 

  
Purpose This procedure guides you through the steps to process a Cancellation.  If you 

use the <Correction> Taskflow Button, you can correct only data fields 
entered on the current RPA. 

  

 
 

Continued on next page 

Canceling an 
Action 

 

Step Action 
1 Navigation Path → Request for Personnel Action → 

Cancellation/Correction → <Open>. 
2 The Find People window opens.   

 
Query the employee’s record on NPAs by inputting the 
employee’s full name, partial name, or social security number. 

3 The Approved Requests for Personnel Action window opens.  
The employee’s name and Social Security data fields will populate 
in the top region.  The bottom region populates with actions 
processed for that employee.  Select the action you need to cancel. 

 
Click the bottom scroll bar to view remaining data fields. 
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Processing Cancellations, Continued 

  
Canceling an Action (continued) 
 

Step Action 
4 Select the <Cancellation> button. 

Note:  If the Effective Date is a future date, both Cancellation and 
Correction Taskflow buttons are grayed out.  Click the<Re-route> 
button to send the action back to your Workflow Inbox and cancel 
it from the Inbox 

5 The RPA opens.  FIRST ACTION, Block 5-A Code, Nature of 
Action, populates.  Complete any remaining data fields that are 
white. 

 
6 Select the Save icon on the Toolbar. 
7 The Decision window appears asking if you wish to route the RPA 

now.  Click the <Yes> button.  The Routing window opens.  Save 
and route or update the RPA. 

8 Select the<OK> button.   
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Processing Corrections 

  
Purpose 
 
 
 

This procedure guides you through the steps to process a correction on current 
actions.  
 
Note:  To make current corrections, use Cancellation/Correction on the 
Navigator window.  To correct past actions and to open all data fields on the 
RPA, use the DoD Correction Process.  This procedure is covered in this 
chapter.  

  
Correcting an 
Action 

 

Step Action 
1 Navigation Path → Request for Personnel Action → 

Cancellation/Correction → <Open>. 
2 The Find People window opens.   

 
Query the employee’s record on NPAs by inputting the 
employee’s full name, partial name, or social security number. 

3 The Approved Requests for Personnel Action window opens.  
The employee’s name and Social Security data fields will populate 
in the top region.  The bottom region populates with actions 
processed for that employee.  Select the action you need to cancel. 

 
Click the bottom scroll bar to view remaining data fields. 

 
Continued on next page 
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Processing Corrections, Continued 

  
Correcting an Action (continued) 
 

Step Action 
4 Select the <Correction> button. 

Note:  If the Effective Date is a future date, both Cancellation and 
Correction Taskflow buttons are grayed out.  Click the<Re-route> 
button to send the action back to your Workflow Inbox and correct 
the action from the Inbox 

5 The RPA opens.  FIRST ACTION, Block 5-A Code, Nature of 
Action, populates.  Complete any remaining data fields that are 
white. 

 

6 Select the Save icon on the Toolbar. 
7 Select the Extra Information button. 

 
 

Continued on next page 
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Processing Corrections, Continued 

  
Correcting an Action (continued) 
 

Step Action 
8 

 
Select the appropriate flag.  “Y” will allow the correction to be 
displayed in Self Service – My Biz and My Workplace.  “N” will 
suppress the display (See Before you Begin at the start of this 
chapter).  After making a selection, click the OK button and return 
to the main RPA screen.   

9 On the Remarks and Address tab, insert the Remark Code ‘XYZ’ 
if applicable.   

 
10 Select the Save icon. 
11 The Decision window appears asking if you wish to route the RPA 

now.  Click the <Yes> button.  The Routing window opens.  Save 
and route or update the RPA. 

12 Select the<OK> button.   
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Processing Corrections to a Social Security Number or DOB 

 
Purpose To correct a SSN or DOB for an employee record in the HR database you will 

need to determine if the record requiring correction is a record converted from 
Legacy DCPDS or a record created in the current DCPDS database.  The 
process for correcting these two areas will be different depending on how the 
record entered the HR database.   

 
Correction to  
Social Security  
Number or  
Date of Birth 
 
 

 
If the record was established after deployment of the HR database then the 
following steps can be used to correct the SSN or DOB.   
 
Note: If the record that requires correction was not created in the HR 
database (legacy converted or M2M record) you will have to process a DoD 
correction to an appointment or conversion to appointment as a work around.   

 
Step Action 

1 Navigation Path → People → Enter and Maintain → <Open>.  
Enter the name or current SSN of the employee and select the 
<Find> button.   

 
 

Continued on next page 
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Processing Corrections to a Social Security Number or DOB, 
Continued 

 
Step Action 

2 Date Track to the day before the effective date of the Employee 
Record, this should change the Type from Employee Ex-Applicant 
to Applicant.   

 
3 
 

Click in the SSN or DOB field and change to the correct value.   
              Old SSN#                                      New SSN# 

      
Note: This can only be done against the Applicant record, if you 
attempt to change this field when the Type is Employee Ex-
Applicant you will receive an error that change must be updated 
using an RPA.   

4 The Update or Correction window will display when you Tab out 
of this field. 

 
Select the <Correction> button.  Save your changes and reset 
your Date Track effective date.  
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5 Navigation Path → Req Personnel Action → 
Cancellation/Correction → <Open.  The Find People window 
opens.   

 
 

Continued on next page 

 

Processing Corrections to a Social Security Number or DOB, 
Continued 

 
Step Action 

5 
(cont) 

Query the employee’s record on NPAs by inputting the 
employee’s full name, partial name, or social security number. 

 
6 In Part B for the RPA, correct the SSAN or DOB.  Then, if 

correcting the SSAN, select the Extra Information button and 
SSAN Hold Area for New/Old/499. 
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In the Social Security OLD field type in the old SSN (or the SSN 
that needs to be corrected).  In the Social Security NEW field type 
in the new SSN (or the correct SSN).  In the NOA Code 499, type 
in 499.  Select OK and continue processing the correction until it 
Updates HR. 

  
 

Processing DoD Corrections 

  
Purpose 
 
 
 

This procedure guides you through the steps to process a DoD correction on 
current actions. To correct past actions and to open all data fields on the RPA, 
use the DoD Correction Process.   

  
Processing a 
DoD Correction 

 

Step Action 
1 Navigation Path → DOD Correction Process → <Open>. 
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2 The Request for Personnel Action opens.   

 
 
Place the cursor in Part B, Block 1, Last Name, click the LOV 
icon to select the employee’s name to which the action applies or 
type in the information. 

3 Place the cursor in Part B, Block 4, Effective Date click the LOV 
icon to select the effective date of the action to be corrected 

4 Place the cursor in Block 5-A Code, and select the NOA to be 
corrected preceded by a “C.” 

5 Place the cursor in Part B, Block 5-C Code; select the correct 
Legal Authority Code(s).  This data field must be entered. 

6 Complete the data fields that need to be corrected. 
7 Select the Remarks and Address Tab, and add any required 

remarks. 
8 Select the Save icon 
9 The Decision window appears asking if you wish to route the RPA 

now.  Click the <No> button.    
10 Select the <Extra Information> button to open the PA Request 

Information Flexfield window. 
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Processing DoD Corrections, Continued 

  
Processing a DoD Correction (continued) 
 

Step Action 
11 Select those flexfields that may need to be updated, to include the 

Control Payroll and SF50 Output for Pre-Conv 
Cancellations/Corrections.  

 
 The Extra PA Request Information window opens.  The values 
default to Yes but may be changed to No.  Leave as Yes or change 
to No in the Payroll Output Flag data field, to indicate if a payroll 
interface transaction must be sent to DFAS for the reconstructed 
action.  Leave as Yes or change to No in the SF50 Output Flag 
data field, to indicate if an NPA is to be produced. 

12 Select DOD Correction SF50 From Side.  The value defaults to 
blank.  You must select No or Yes depending on whether want you 
data to print on the From Side of NPA. 

13 Select the Save icon. 
14 Select <Yes> to the routing action request   
15 Select Update HR, select a printer and click the <Approval> 

button 
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Using the Pseudo SF50 

  
Purpose This procedure guides you through the steps for using a Pseudo SF50.  The 

Pseudo SF50 does not update the database.  It only produces a Notification of 
Personnel Action (NPA) for Correction or Cancellation of a prior action that 
has no impact on an employee’s current assignment or employment status. 

   
Using the 
Pseudo SF50 

 

Step Action 
1 Navigation Path→ PSEUDOSF50 →   <Open>. 
2 The Pseudo SF50 window opens.  Place the cursor in Block 1, 

type the employee’s last name and [TAB] key.  The LOV displays 
and populates the rest of the information; e.g., first name, SSAN, 
Date of Birth. You cannot use the SSAN to get the LOV.  This 
window has 50 data elements and two taskflow buttons, 
<Reports> and <Exit>.  This NPA is not broken into four pages 
as the regular RPA. 

 
 

 
Continued on next page 
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Using the Pseudo SF50Processing DoD Corrections, Continued  

 
Using the Pseudo SF50 (continued) 
 

Step Action 
3 Type in everything you need on the final SF50, to include codes as 

well as clear text.  Use the scroll bar on the right side to view the 
entire window. 

 
4 Use the scroll bar on the right side of the window to move to the 

end of the form.  Once all data is entered, select Save on the 
Toolbar. 

 
5 Select the <Reports> button.  This transmits the Pseudo SF50 to 

your default printer. 
6 When you are finished, select the <Exit> button on the bottom of 

the window to return to the Navigator window. 
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Miscellaneous  
 
Other helpful hints for processing corrections: 
 
 

Step Action 
1 
 
 

To view the original action when processing a correction after 
opening the RPA from the Cancellation/Correction Window, select 
<Others> → Corrected PA Request. 

 
Note:  This process does not pertain to the DoD Correction. 

2 Select <OK> and the original action will appear.  This view of the 
RPA is read only but it will allow you to see the information input 
on the original action.   
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Module 4 

Chapter 8 

AUTORIF Extract  

Chapter Overview 

  
Introduction This chapter explains how to create an AUTORIF Extract File.  The extracted 

data is uploaded into AUTORIF to produce a Retention Register for 
Reduction-in-Force (RIF) purposes.  AUTORIF is a separate application and 
operates externally using data extracted from DCPDS.   

  
Chapter Contents  

Topic Page 
Before you Begin 1 
Creating an AUTORIF Extract File 2 

  
See Also 
     

The Module 4, Chapter 13 for detailed instructions on how to upload the 
extract file into AUTORIF. 

  
Before you 
Begin 

• Components will determine who has access to the AUTORIF Extract File. 
• Normally, employee records will be reviewed and corrected prior to 

running the extract file.  
• If an employee record is updated or corrected after the extract is produced, 

it may be necessary to create a new extract file prior to running 
AUTORIF (depending on your RIF cut-off date).  

• You can change the data within the extract file, but the data is not 
changed in the DCPDS database.  To change the database, you must go 
into the system to make the change and then rerun the extract file. 
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Creating an AUTORIF Extract File 

  
Purpose This section guides you through the steps for creating an AUTORIF Extract 

File.  There are two files that will download when executing the AUTORIF 
Extract process, the AUTORIF Extract and the AUTORIF Extract Pay File.  
The AUTORIF Extract Process is only available through the CIVDOD 
Personnelist responsibility.   

  
Creating an AUTORIF Extract File   
 

Step Action 
1 On the Navigation List → Processes and Reports → AutoRIF 

Extract → <Open>.  
 

 
 

2 The AUTORIF Load Screen displays: 
 

 
 

 
Continued on next page 
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Creating an AUTORIF Extract File, Continued 

 
Creating an AUTORIF Extract File (continued) 
 

Step Action 
3 
 
 

Type in the File Name (maximum length of field is 20 characters).   

 
 Note:  A file name must be input prior to identifying the output 
file path.  If you write more than one extract, be sure to change the 
file name, otherwise, it will overwrite the first one.  

4 Identify the output file path.  There are two ways to perform this 
function:  

 
Select <Browse>  
Navigate to the location the extract file is to be saved to 

 
Select <Save> 
-or- 
Type the location of the directory in the Output File Path 

 
 

Note: Do not save to the C:\my documents directory.   
 

 
 

Continued on next page 
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Creating an AUTORIF Extract File, Continued 

 
Creating an AUTORIF Extract File (continued) 
 

Step Action 
5 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Select a Submitting Office Id (SOID).  At least one SOID is 
required when requesting the AUTORIF extract; however, more 
than one SOID can be used to generate a file.  To request an 
extract consisting of only one SOID users may enter data using the 
List Of Values (LOV) – or - manually type the SOID in the ADD 
field (SOID must be entered with capital letters).   

  - or -  
When creating an extract that requires more than one SOID enter 
the SOID in the LOV, click <ADD>.  Repeat for each SOID to be 
included in the extract file.   

 
Or simply type each SOID separated by a comma in the space 
following the <ADD> button (do not insert a space between 
SOIDs). 

Note:  If requesting an extract consisting of multiple SOIDs users 
must enter all SOIDs in the data field after the <ADD> button.   

 
 

Note:  If one or more of the following fields (UIC, PAS Code, 
Work Schedule, Position Occupied, Geographical Location(s), or 
Competitive Area) are populated with values, they will be 
considered as “AND” to the SOID.  The extract will only contain 
those records that meet all of the conditions.   

 
Continued on next page 
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Creating an AUTORIF Extract File, Continued 

 
Creating an AUTORIF Extract File (continued) 
 

Step Action 
6 
 
 
 
 
 
 
 
 

 
 

Select a UIC.  The UIC is not required; any value input will be 
validated before the request is executed.  To create an extract file 
consisting of multiple UICs follow the instructions for adding 
multiple SOIDs.   
 

   - or -       
 

 
 

Note:  If requesting an extract consisting of multiple UICs users 
must enter all UICs in the data field after the <ADD> button.   

7 Select a PAS Code (Air Force only).  The PAS Code is not 
required; any value input will be validated before the request is 
executed. 

 
8 Select a Work Schedule (optional).  Use of this field is optional 

because the work schedule must be identified as a part of the RIF 
options upload process.   

 

9 Select the Position Occupied (optional).  Use of this field is 
optional because the position occupied must be identified as a part 
of the RIF options upload process.   

 

10 Select a Geographical Location Code (GeoLoc) (optional).  Any 
value will be validated before the request is executed.  To create 
an extract file consisting of multiple GeoLocs follow the 
instructions for adding multiple SOIDs. 

 
 
 

Continued on next page 
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Creating an AUTORIF Extract File, Continued 

 
Creating an AUTORIF Extract File (continued) 
 

Step Action 
11 Select a Competitive Area (optional).  Use of this field is optional 

because the competitive area, if desired, can be used as a part of 
the RIF options upload process.   

 
AUTORIF Extract Pay File Criteria – The following two fields are 
available for the user to limit which pay files are downloaded into 
the Pay Table file.  This area is optional.  The user can input 
values in one or both of the fields.  Unless a value is input, all 
FWS or GS Pay Tables found for records contained in the extract 
process will be downloaded.  

12 Select a Pay Table (optional).  Input the FWS Pay Table that will 
be used to determine representative rates for wage grade positions 
(i.e., W135).   

 
13 Select a GS Locality Area:  Input the GS Locality Area that will be 

used to determine representative rates for GS positions (i.e., ZX).   

 
14 Once all data elements are input select <LOAD>. 

 
 

  
 

Continued on next page 
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Creating an AUTORIF Extract File, Continued 

 
Creating an AUTORIF Extract File (continued) 
 

Step Action 
15 Once the Load button is selected DCPDS attempts to validate the 

input value against the LOV.   
The following errors will be displayed if the SOID, UIC or 
GeoLoc is not contained in the LOVs.  Remember fields are case 
sensitive.   

 
 

 
 

 
 

The error message will also occur when using multiple SOIDs, 
UICs or GeoLocs in the <ADD> field without a comma separator.  
Note:  When typing directly in the <ADD> field you must type the 
value exactly as it is contained in the LOV and it must have a 
comma separator (no spaces) between SOIDs, UICs or GeoLocs. 
  
Once you have corrected the entry, select <LOAD>. 

 

 
Continued on next page 
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Creating an AUTORIF Extract File, Continued 

 
Creating an AUTORIF Extract File (continued) 
 

Step Action 
16 If all entries are valid, DCPDS will create two extract files in the 

directory identified in the Output File Directory.  

 
The first pop-up screen indicates the employee/position file was 
successfully created. 

  
The second pop up screen indicates the representative rate file was 
successfully created.    
The representative rate for GS/GG/GM pay plans is Step 04 of the 
Locality Pay Table.  The representative rate for the FWS pay plans 
is Step 02 of the pay table.  All Locality Pay Tables and/or FWS 
Pay Tables will be downloaded, unless a specific Locality Pay 
Table or FWS Pay Table is identified in the extract process.   

17 Select <Exit> to close the AUTORIF Load Window 
 

 
 
Navigate to the directory specified to find the two files displayed 
below.  The representative rate text file is created with the same 
name as your extract file including “_rates.txt”. 
 

 
 
Proceed to AUTORIF and upload.   
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Module 4 

Chapter 9 

Severance Pay  

Chapter Overview 

  
Purpose This section outlines the steps users must take to process a severance pay 

calculation for individual employees. 

  
Chapter Contents  
 

Topic Page 
Severance Pay Calculator 2 
Severance Pay Update in DCPDS with 
Separation Type Action 

6 
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Severance Pay Calculator 

   
Using the Severance Pay Calculator  
 

Step Action 
1 Navigation Path → People → Enter and Maintain → <Open>.  

The Find Person window opens.  Query the employee by typing 
in the last name and selecting the <Find> button. 

 2 The People window opens with the data fields populated.  Select 
the <Assignment> button.   

3 The Assignment window opens.  Select the <Entries> button.  
The window opens with the Element Name column and other data 
fields populated. 

4 Under Element Name column, select the next available line (or 
add a blank line by selecting the green plus sign in the tool bar).  
Then select LOV icon and select Severance Pay Calculation from 
the elements then select the <OK> button. 

 
 

Continued on next page 
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Severance Pay Calculator, Continued 

  
Using the Severance Pay Calculator (continued) 
 

Step Action 
5 Select the <Entry Values> button. Complete the data fields. 

 
Data Field Action 

Date Requested Enter Projected Date of Separation 
SCD Severance Enter Service Computation Date 
Salary Enter Salary 
Sev Pay Weeks Paid Enter any if paid previously 
Sev Pay Avg Hours Enter Avg Hours 

 

6 Select the Save icon on the Toolbar.  This sends the worksheet to 
the user’s default printer.  The worksheet is also available if the 
user goes to Processes & Reports>View Requests>Severance 
Pay Calculation.   

7 Exit the windows. 
8 Element Severance Pay Calculation is a non-recurring element 

and is stored under the Pay Period in which it was created and 
the element is automatically end-dated with the last day of the 
pay period.  This element will not show when the pay period 
changes. 

 
9 Users can change the information in the Severance Pay 

Calculation Entry Value screen and save the changes.  A new 
report will be generated (except when the bottom status line says 
there’s nothing to save – simply re-input the same request date 
and save again to make the system think something new has 
been added). 

 
 
 

Continued on next page 
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Severance Pay Calculator, Continued 

  
Using the Severance Pay Calculator (continued) 
 

Step Action 
10 Only one Severance Pay Calculation Element Entry should be 

created during any given pay period.  If a user creates a second 
entry in the same pay period, it will appear to work, but instead of 
generating a printed report, when it is saved, the report will error.     

11 Users can create a Severance Pay Calculation Element Entry while 
they are in different pay periods and reports will generate.  For 
example, user creates a Severance Pay Calculation Element Entry 
on 26 Jan 2011 and receives a report.  On Monday, 31 Jan 2011, 
the beginning of a new pay period, the user would create another 
Severance Pay Calculation Element Entry and receive a report. 

12 Note: If users input a value in the Sev PayWeeks Paid data field 
that exceeds the employee’s total entitlement. The severance pay 
calculation work sheet will reflect a zero in the entitled number of 
severance pay weeks. 

 
13 A sample of the report is shown below.   

 
 
                        PERSONAL DATA - PRIVACY ACT OF 1974 
 
RECD ID:   APPR                                           AS OF: 29 APR 2009 
 
                            -------------------------------------- 
                           | SEVERANCE PAY CALCULATION WORK SHEET | 
                            -------------------------------------- 
 
    I.  EMPLOYEE INFORMATION 
 
    NAME:  First Name MI Last Name 
    SOCIAL SECURITY NUMBER:      
    PAY-PLAN/SERIES/GRADE/STEP:    GS-0303-05/03 
    ORGN/LOC:    HQ USAF DIR SPT EL                  AF24 290244     PENTAGON 
ADM, VA 
    PROJECTED DATE OF SEPARATION:   05 FEB 2007 
    SERVICE COMPUTATION DATE(SEV)   2006/02/20 00:00:00 
    DATE OF BIRTH:  27 JUL 1966 
 
    ANNUAL SALARY: $ 25,195.00            HOURLY SALARY: $ 12.07 
    WEEKLY SALARY: $   482.80             AVG WORK HOURS:40 
    PREVIOUS # OF SEVERANCE PAY WEEKS:0 
 
 
    * II.  CALCULATIONS. 
 
      A.  CALCULATED DATES: 
 
          1. CREDITABLE YEARS (LEQ 10.00):  $   .00 
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          2. CREDITABLE YEARS (GTR 10.00):  $   .00 
          3. CREDITABLE YEARS (  TOTAL  ):  $   .00 
          4. AGE OVER 40 YEARS:             $   .50 
 
      B.  CALCULATE BASIC SEVERANCE PAY: 
 
          1. WEEKLY PAY RATE TIMES         $   482.80 
             CREDITABLE YEARS (LEQ 10) :   X    $   .00 
                                            ----------   $       .00 
          2. WEEKLY PAY RATE TIMES           $   482.80 
             CREDITABLE YEARS (GTR 10):     X    $   .00 
             MULTIPLIED BY 2:               X    2.00 
                                            ----------    $       .00 
          3. BASIC SEV PAY (B1 + B2):       $       .00 
 
      C.  CALCULATE AGE ADJUSTMENTS: 
 
             10% OF BASIC SEV PAY:          $      .00 
             TIMES AGE OVER 40 YEARS:        X $   .50 
                                             ----------    $       .00 
      D.  AGE ADJUSTED SEVERANCE PAY ( B1 + B2 + C):       $       .00 
 
      E.  CALCULATE MAXIMUM ALLOWABLE SEVERANCE PAY: 
 
             BI-WEEKLY PAY RATE             $   965.60 
             TIMES 26 PAY PERIODS:                X26.00 
                                               ---------  $ 25,105.60 
    * III. RESULTS. 
 
         A. SEVERANCE PAY FUND AUTHORIZED 
            (LESSER OF II-D AND II-E):              $       .00 
 
         B. ENTITLED NUMBER OF 
            SEVERANCE PAY WEEKS:                   0 
 
         C. WEEKLY SEVERANCE PAY 
           (NOT INCLUDING LAST WEEK):               $      .00 
 
         D. FINAL PAYMENT 
          (LAST WEEK OF ENTITLEMENT):               $      .00 
 
         E. DATE SEVERANCE PAY BEGINS:              06 FEB 2007 
 
      *  DISCLAIMER: THE CALCULATIONS ON THIS WORKSHEET MAY NOT 
         BE EXACT. FOR EXACT FIGURES, CONTACT YOUR FINANCE OFFICE. 
 
         ALL PAY RATES ARE DETERMINED USING THE OPM STANDARD OF 
         2087 WORK HOURS/YEAR. THE HOURLY PAY RATE IS THEN 
         MULTIPLIED BY THE AVERAGE NUMBER OF HOURS WORKED PER 
         WEEK OVER THE LAST 52 WEEKS. THIS GIVES THE WEEKLY 
         SALARY WHICH IS THEN MULTIPLIED BY 2 TO GIVE THE 
         BI-WEEKLY RATE AND THEN BY 26 TO GIVE THE ANNUAL SALARY. 
 
         TOTAL LIFETIME ENTITLEMENTS CANNOT EXCEED 52 WEEKS. 
         THEREFORE, THE RESULTS MAY BE ADJUSTED TO MEET LEGAL 
         LIMITS. 
 
                                        2 
    REPORT NAME:  RPSEV 

 
Continued on next page 
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Severance Pay Calculator, Continued 

   
Update of Severance Pay Elements within an RPA Process  
 

Step Action 
1 Create separation RPA using normal procedures.  
2 Go into Extra information>Separation Other than Retirement 

and fill in the appropriate elements relating to Severance Pay 
(Amount, Weeks, and Weekly Amount) for the employee. 

3 Biweekly - If employee is choosing Biweekly payments, then both 
Severance Pay Amount and Severance Pay Weekly Amount need 
to have a value in them as well as Severance Pay Weeks.  Once 
Update HR has been accomplished, the Pay500 will be produced 
with a payment option of “B” for biweekly in position 102.   
 
Lump Sum – If employee is choosing a Lump Sum Payment, then 
only Severance Pay Amount needs to have a value in it.  Once 
Update HR has been accomplished, the Pay500 will be produced 
with a payment option of “L” for lump sum in position 102.   

 
4 

 
 
 
 

Continued on next page 



                                                                                                               R12                                                                      March 2012 

Staffing:  Severance Pay    Mod 4, Chap 9, Page 7 

Severance Pay Calculator, Continued 

  
Update of Severance Pay elements within an RPA Process (continued) 
 

Step Action 
5 NOTE:  If there is not a value in position 102 on the PAY500, 

DFAS will reject the transaction.  Here are the Pay500 rules for 
payment option being produced systematically based on input of 
above elements.   
 
Nature of 
Action 
(NOA) 
(Positions 70-
72) 

Severance 
Pay Amount 
(Positions 
359-366) 

Severance 
Pay Weekly 
Amount 
(Positions 
367-372) 

Payment 
Option 
(Position 
102) 

3## Null (or 
zeroes) 

Null (or 
zeroes) 

Null 

3## Any value 
other than 
Null (or 
zeros) 

Null (or 
zeroes) 

L 

3## Any value 
other than 
Null (or 
zeroes) 

Any value 
other than 
Null (or 
zeroes) 

B 
 

 

 
 

Continued on next page 
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Severance Pay Calculator, Continued 

  
Update of Severance Pay elements within an RPA Process (continued) 
 

Step Action 
6 Corrections – Correction actions (NOA 002) for NOA 3## with 

Severance Pay will systematically flow Payment Options based 
on input conditions.    
 
- If a “Null” value flowed on the original 3## action and only 

Severance Pay Amount is input within the 002 action, it will 
flow an “L” in position 102 of the Pay500.  

  
- If a “Null” value flowed on the original 3## action and both 

Severance Pay Amount and Severance Pay Weekly Amounts 
are input within the 002 action, it will flow a “B” in position 
102 of the Pay500.   

 
- If a “B” value flowed on the original 3## action and only 

Severance Pay Amount OR Severance Pay Weekly Amount 
is changed within the 002 action, flow “B” in position 102 of 
the Pay500.   

 
- If an “L” value flowed on the original 3## action and only 

Severance Pay Amount is input within the 002 action, flow 
“L” in position 102 of the Pay500.   

 
- If an “L” value flowed on the original 3## action and both 

Severance Pay Amount and Severance Pay Weekly Amounts 
are input within the 002 action, flow “B” in position 102 of 
the Pay500.   
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Module 4 

Chapter 10 

Processing Reconstruct History Action 

 
Chapter Overview 
Introduction This chapter explains how to reconstruct an employee’s past history.  There 

will be instances when an employee’s past history must be both reconstructed 
and corrected.  For example:  an employee’s pay was set incorrectly some 
time ago and the original action needs to be corrected.  Subsequent personnel 
actions involve incorrect pay because of the initial mistake.  Therefore, you 
may have to reconstruct and correct several actions.  
 

   
Chapter Contents  
 

Topic Page 
How It Works 2 
Processing a Reconstruct History Action 4 
Verifying Your Transaction 9 
Reminder (with example) 9 
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Processing a Reconstruct History Action  

  
Purpose This section explains the steps to reconstruct a record that had been processed 

prior to or outside of DCPDS.  Reconstructing is required to recreate or correct 
erroneous pre-conversion actions.  The responsibility of CIVDOD Reconstruct 
History is used throughout the process and to establish history in an employee’s 
record prior to conversion into the HR database or after an employee has been 
accessed to your region using the CAO or Interagency Transfer process.   
 
Examples of a reconstruct history action vs. a correction action: 

• A reconstruct history action:  A promotion action in Legacy 
was processed at the wrong step resulting in subsequent errors.  
The record converted to DCPDS and requires corrective action.   

• A correction action:  An employee’s record in DCPDS has an 
incorrect step that resulted from the entry of a QSI Award.   

   
How it Works There are five stages in the process: 
  

Stage Description 
1 The OPF is reviewed to determine what corrective actions are 

required. 
2 The position and employee data in DCPDS is reviewed. 
3 Using  the CIVDOD Personnelist or Classifier responsibility, a 

position is created or quick copied to establish position history. 
 
Note:  A position must be quick copied or created for each action 
using the CIVDOD Personnelist responsibility 

4 Using the CIVDOD Reconstruct History responsibility, 
subsequent actions that require corrections are reconstructed with 
the same errors.  

5 Using the CIVDOD Personnelist responsibility, correct the 
erroneous actions. 
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Processing a Reconstruct History Action, Continued 

 
Before you 
Begin 
 
 
 
 

A system administrator must assign the CIV DOD Reconstruct History 
responsibility with an effective date of 01-01-1996, for the type of employees 
serviced, i.e., appropriated, non-appropriated (NAF) and LN (a separate one 
for each country).  To begin the process:   

• Complete a review of the OPF. 
• Identify a chronology of events to determine what actions are required 

to make the record accurate and complete.   
• Using the CIVDOD Personnelist responsibility: 

• Review the employee’s record to ensure accurate data came across 
at conversion, using the employee’s Assignment History and 
Assignment Data in DCPDS.  

• Build or quick copy a position of assignment.  It must exist on the 
effective date being used for the Reconstruct History action. 

 
Note:  A position for the Reconstruct History and positions for subsequent 
actions are required.  

 
• Using the CIVDOD Reconstruct responsibility:  

• Process an RPA with a NOA 911 - Reconstruct History to 
establish history only. The effective date must be a date prior to 
the date of the erroneous action, this will begin the history, but 
must be on or after the appointment date.    
• Update HR.  
• Updated HR notification flows to and can be viewed from the 

Civilian Inbox.  
• Process subsequent pre-conversion actions requiring corrections 

using the same erroneous data for each action.   
• An employee has only one assignment per day.   
• Salary data must be manually entered. 
• NPAs and Payroll can be suppressed through the DDF in Extra 

 Information. Make sure to open this DDF and identify if an                                
NPA needs to be received or produce payroll.    

  
 

Continued on next page 
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Processing a Reconstruct History Action, Continued 

  
Processing a 
Reconstruct 
History Action 

After the position is built (using the Classifier or Personnelist 
Responsibility), follow these steps to reconstruct a record that was processed 
prior to or outside DCPDS that contains errors. 

 
Step Action 

1 Select CIVDOD Reconstruct History from the responsibilities list 

2 Navigation Path → Reconstruct History→ <Open> 

3 The RPA window opens.  It is used only to establish history.  
Subsequent actions requiring reconstruction must be processed using 
another RPA (while still in the responsibility of CIVDOD 
Reconstruct History.)  This is the only RPA where both the NOA 
and the Authority Code auto populate.  The NOA is 911 
Reconstruct History and the Authority Code is ZZZ – Not 
Applicable. 

 
 

 
Continued on next page 
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Processing a Reconstruct History Action, Continued 

  
Processing a Reconstruct History Action (continued) 
 

Step Action 
4 On the Request Info Page, enter the employee’s Last Name and the            

Effective Date  All other data fields are auto populate.   
5 Click Position Data tab, In the TO INFORMATION section, select 

the Position Title in Block 15.  Select the position you quick copied 
or created for history to be created.  Remember, this is a position the 
employee was in prior to the action requiring corrective action, and 
must reflect the same data, i.e., position, pay, and employee data).   

    
6 Enter the employee’s pay value from the day history is being created 

as it was on the original action date.  If the information was 
incorrect, input the incorrect data as it appeared on the NOA, then 
process a 002 Correction.  After the basic pay, locality, and adjusted 
basic pay is input, the system totals them in the Total Salary  

7  
 
 
 
 

Note:   If a step is input  in Block 19, Step or Rate, 

 a Message Box instructing the user to enter the 
salary fields will appear. Click the <OK> button. 
Caution:  Be extra careful when entering the salary fields.  History 
is being created and the From side of the subsequent or follow-on 
action will reflect the data on this “Reconstruct” action.  If the action 
is in error, cancel the 911 action using “corrections and cancellation” 
and start over.    

 
Continued on next page 
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Processing a Reconstruct History Action, Continued 

 
Processing a Reconstruct History Action (continued) 
 

Step Action 
8 Click the Employee and Position Data tab, Enter required data as it 

was on the effective date of the action being reconstructed. The 
source document for this information will normally be an NPA (data 
entered from original NPA). 

 
9 Click the Remarks and Address tab.  Input information, such as 

any applicable Remarks.   
10 
 
 

Click the <Extra Information> button. Select US/Gov Appt  
Information. Update the Appointment Type. 
Note:  The Date Arrived Personnel Office auto populates with the 
effective date of the reconstructed action.  Manually input the 
correct date.  (To find the Date Arrived Personnel Office, go to 
People → Enter and Maintain → Assignment →<Others> → 
<Extra Information> → US Gov Assignment Non SF 52.) 

11 
 

Select Produce Payroll, NPA, Reports. Enter the appropriate data 
and click the <OK> button   
Note 1:  This DDF must be opened and saved.  If not, the following 
Error Notification will appear: 
CIVDOD_911_PAR_EXTRA_INFO. 

 
 

Continued on next page 



                                                                                                 R12                                                                            March 2012 

Processing an Reconstruct History Action                                     Mod 4, Chap 10, Page 7 

Processing a Reconstruct History Action, Continued 

 
Processing a Reconstruct History Action (continued) 
 

Step Action 
11 

(cont) 
 
 

The system populates an “N” in all three data fields. If the default is 
left at “N” (no print of NPA) in the Produce NPA data field, and 
upon updating HR, “de-select” printer, the NPA will print through 
the batch process.  (The system is set up so that if the “counter” area 
of the print process reflects “0,” actions are printed through batch 
print).  

 
Note 2:  Reconstruction actions are mainly used for historical 
purposes and should not be filed in official personnel folders, nor 
provided to employees.  Therefore, to avoid the possibility of 
having these NPAs printed, distributed, or filed unnecessarily, 
follow these steps: 

• Change the “N” to a “Y” in the Produce NPA data field, and  
• Select a printer at the time HR is updated.   

This option prints the NPA as soon as you update HR, and it can be 
destroyed immediately.  It also sets the “counter” area of the print 
process to “1” so another NPA is not produced in the batch print 
process.  
Note 3:  The Produce Report data field is not yet available for use. 

12 Once selections are made, select the <OK> button and Save icon. 
13 After saving work, a decision box will appear asking if request 

should be routed,select the <OK> button 
14 Select Update HR and the <OK> button. 

 
 
 

Continued on next page 
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Processing a Reconstruct History Action, Continued 

 
Processing a Reconstruct History Action (continued) 

 
Step Action 

 

15 
 

The Print Notification Box will have an “X” in it.   
Notes:    

• If an NPA is to print in Batch, make sure the Print 
Notification Box is selected, and the DDF in Extra 
Information has a “Y” for printing the NPA.  (destroy the 
SF-50 that prints when updating the system.) 

• If the Print Notification Box is deselected, an NPA will not 
be printed in Batch. 

• This history RPA cannot be saved to the Civilian Inbox.  
However, the Update HR Completed does save and can be 
viewed. 
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Processing a Reconstruct History Action, Continued 

 
 Verifying Your 
Transaction 

To check the assignment history on the employee after the transaction 
processes. 

 
Step Action 

1 Navigation Path → View → Histories → Employee Assignment 
→ <Open>. 

2 The Assignment History window opens.  Type in the name of the 
employee whose action is being checked.  Select the <Find> 
button to view the action. 

3 The action can now be processed using the correct NOAs.  
 
 
 
 
Reminder 

 
 

 
 
Only RPA’s created using the CIVDOD Reconstruction History RPA (911) 
are reconstructed and do not have to pass all of the CPDF edits and 
component Business Rules. 
 
All other RPA NOA’s must pass all applicable CPDF edits and business rules. 
 
 Remember to update the values in the Produce Payroll, NPA, Reports DDF in 
the RPA to allow suppression of payroll or prevent NPA from printing. 
 

Step Action 
1 To demonstrate how the CIVDOD Reconstruct History can be used, 

the following example is provided:  An employee is due a cash 
award with an effective date that was prior to conversion into the HR 
database. 

 
 
 

Continued on next page 
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Processing a Reconstruct History Action, Continued 

 
Reminder (continued) 
 

 

Step Action 
2 Navigation Path → CIVDOD Reconstruct History <Open>.  The 

RPA window opens and is used only to establish history in an 
employee record. 

 
When the RPA opens the NOA and LAC are auto-populated with 
911 and 5-C and 5-D are grayed out.  Enter Effective Date first, 
and then Last Name or Social Security number of the individual 
re-creating history on.  

3 Select the Position Data tab Enter position in the “TO” 
Information (position identified is the employee’s assignment 
prior to the action being corrected).  This will also be the 
information that’ll reflect on the “FROM” side of the next action 
when it gets created.  Items 20, 20A, 20B and 20C need to be 
input manually once the step is entered in Block 19.  

 
 

Continued on next page 
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Processing a Reconstruct History Action, Continued 

 
Reminder (continued) 
 
 

 

Step Action 
4 Select the Employee and Position Data tab. Manually enter items 

23 – 32 & 45 – 50. Be extra careful and make sure that the data 
being entered is reflective of what the employee had at the time of 
assignment being created.  Remember, this will also be the data that 
will reflect on any subsequent RPA.   

 
5 Select the Remarks and Address tab. Enter applicable remarks in 

Part F.  Once all information has been entered on the RPA then 
update HR to create the history transaction in the employee’s 
record.  The ability now to see all of the Reconstruction History 
RPA transactions in the Completed Personnel Actions window 
when searching the employee record will be available.   

 
 

Continued on next page 
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Processing a Reconstruct History Action, Continued 

 
 

 
Reminder (continued) 
 

Step Action 
6 When the RPA has been processed, Exit the window and select the 

appropriate RPA from the navigation list to complete the 
employee’s history record being reconstructed (this should be 
accomplished while still in the CIVDOD Reconstruct History 
responsibility). 

7 Once the Reconstruction History RPA has been updated to HR the 
user can initiate and complete a follow on RPA to add the required 
history transaction i.e. individual was due an individual cash award 
and it was never processed.  Navigation Path →  Request for 
Personnel Action → Award One-Time Payment → <Open>  

 
 

Continued on next page 
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Processing a Reconstruct History Action, Continued 

 
Reminder (continued) 
 

Step Action 
8 Select the Position Data tab. The information populated on this 

page now reflects the information that was input with the 911 
Reconstruction History RPA.  Enter the award amount. 

 
9 Select the Employee and Position Data tab. The Employee and 

Education Data items reflect the information that was manually 
entered on the reconstruct history RPA. 

 
 

Continued on next page 
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Processing a Reconstruct History Action, Continued 

  
Reminder (continued) 
 

Step Action 
10 Select the Remarks and Address tab. Enter any applicable 

remarks in Part F. 

 
11 Select the <Extra Information> button. This action may be 

required to flow to payroll or documentation is needed for the 
official personnel folder     

12 The Extra PA Request Information window will open select 
Produce Payroll NPA Reports and double click in the Details 
data field.   

13 Enter an “Y” in the appropriate data fields. 

 
14 Save your changes, exit and update HR.  The process is now 

complete and should have valid documentation of the missing 
personnel action.  
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Module 4 

Chapter 11 

Change in Appointing Office (CAO) 

Or 

Interagency Transfer (Transfers) Actions 

Chapter Overview 

 
Introduction This chapter covers the CAO or Interagency Transfer (Transfer) process in 

DCPDS.   

 
 

Before you 
Begin 

The information in this chapter documents the re-architecture of the 
CAO/Transfer process and should be reviewed before attempting to process a 
CAO or Interagency Transfer action.  Major changes include the relocation of 
the CAO/Transfer request form, a new process for the creation of the 
Applicant record and a process for the automatic generation of the Separation 
action.   

 
 

Chapter 
Contents 
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Continued on next page 



                                                                                      R12                                                                     December 2011 

Staffing:  Change in Appointing Office (CAO) or Transfer          Mod 4, Chap 11, Page 2 
   

CHAPTER OVERVIEW, Continued 
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CAO/Transfer Request Form 

  
Introduction The Change in Appointing Office/Interagency Transfer RPA is used to process 

an accession action from one Region database to another without a break in 
service.  This chapter must be followed to successfully complete the process of 
CAO/Transfer actions.   

 

 
Step Action 

1 Open the request form using the following navigation: Navigation List 
→ Req Personnel Action → CAO/Transfer → CAO/Transfer Request 
<Open>.  

 
All components of the CAO process are located under the Req 
Personnel Actions menu of the Navigation List.   

 
 

Continued on next page 
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CAO/Transfer Request Form, Continued 

  
Introduction (continued) 
 

Step Action 
2 The CAO/Interagency Transfer window will appear with two 

tabs.  The Status Tab and the Initiate Tab. 

 
The Status Tab is displayed when the request form is opened.  It 
provides the user the current statuses of all CAO/Transfer “In 
Progress”.   

 
 
 

Continued on next page 



                                                                                      R12                                                                     December 2011 

Staffing:  Change in Appointing Office (CAO) or Transfer          Mod 4, Chap 11, Page 5 
   

CAO/Transfer Request Form, Continued 

  
Introduction (continued) 
 

Step Action 
3 Users can query (F11, Ctrl F11) on the SSAN, Request or Status 

Fields to find individual requests or click <Refresh> to retrieve 
records based on selecting either the <Gain, Loss or All> radio 
dials.  

 
 

Status Tab
SSAN Social Security Number
Name Employee Name
Request Status of Request
Current Status Most Recent Phase/Status of Transaction

Gain 
Gain to view all requests submitted by users at your Region 
database (Gain to your Region),

Loss
Loss to view all requests submitted by another Region 
database (Loss at your Region),

All All to view all (Gain and Loss) requests.  
Refresh Refreshes the Status View  

Clicking on the “?” button which appears to the right of the 
Current Status field opens the CAO Details window, which 
provides additional details on the request form selected.  The 
Initiate Tab is used to submit the CAO/Transfer request and will 
be described later in this chapter.  

 
 

Continued on next page 
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CAO/Transfer Request Form, Continued 

  
Introduction (continued) 
 

Step Action 
4 The CAO Details Window displays two parts: the Transaction 

and Details region.   

 

The Transaction region of the window displays the information 
input when the CAO/Transfer request form was initiated.  
Additionally, the Key field is included in the display window.  
This is the unique identifier for the request in progress.  The 
Details region provides users with the progress of the request 
selected.  

SSAN/Name Social Security Number and Name of Employee

POC
Point of contact for the Losing Region; should include Name and DSN 
phone number.  CML if you do not have DSN.

SOID Loss Losing Region SOID
SOID Gain Gaining Region SOID
Agency Transfer to Agency Code
NOA Nature of Action
Effective Date Effective Date of CAO/Transfer RPA Action
POID Payroll Office ID
Build Applicant Creates applicant record for CAO process
Cancel Request Cancels CAO/Transfer request prior to update of RPA
Details Region
Phase Stage of DCPDS Processing Entered
Status Status in Current Phase (e.g. Initiated or Completed)
Status Date Date/Time Stamp at Phase initiation or completion
 

 
 
 

Continued on next page 
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CAO/Transfer Request Form, Continued 

  
Introduction (continued) 
 

Step Action 
5 Select the Initiate tab and the Initiate window displays.  All fields 

must be entered prior to initiating a new request.  The POC field is 
used to provide the Losing Region with a contact name and 
telephone number.  Use this field to identify the person who can 
assist in problem resolution. 

 
The Initiate Tab contains the following data fields:  
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Initiating the CAO/Interagency Transfer Request (Gaining Region) 

 
Initiating a 
CAO/ 
Transfer 
Request Form  

The Initiate tab is used to submit a CAO/Transfer request.  This process is 
only to be used by the Gaining Region when gaining an employee from 
another component within DoD.  Both the Gaining and Losing Region 
database employee record must be maintained in DCPDS.  Other Federal 
agencies should be gained using the Appointment Family RPA.  If it is 
determined that a CAO or Transfer is appropriate for the action being 
processed, use the following steps to initiate a CAO/Transfer Request: 

 
Step Action 

1 From the Navigation List → Req Personnel Action → 
CAO/Transfer   → CAO/Transfer Request <Open>.  
The CAO/Transfer Request displays.  Select the <Initiate > tab. 

 
 

Continued on next page 
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Initiating the CAO/Interagency Transfer Request (Gaining Region), 
Continued 

 
Initiating a CAO/Transfer Request Form (Continued) 
 

Step Action 

2 The Initiate Window displays: 

 
Input the SSAN and Losing SOID in the Loss Data region.  Input 
the Agency, Gaining SOID and Payroll Office in the Gain Data 
region.  Select either the CAO or Transfer radio dial; enter the 
NOA, Effective Date and POC information.  Select the 
<Initiate> button.  Once initiated you will receive the following 
message:  

 
Select <OK> 
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Initiating the CAO/Interagency Transfer Request (Gaining Region), 
Continued 

 
Processing the 
CAO/Transfer 
Request 
(Gaining 
Region) 

Once the request is initiated, the data input will be cleared from the request 
screen.  DCPDS uses the Concurrent Manager to process the request.  This 
allows the user initiating the CAO/Transfer request the ability to continue 
working in other areas of the HR database while the request is being 
processed.  Although the request uses Concurrent Manager for processing, 
users can periodically check the status of the request by returning to the 
CAO/Transfer request form and select the <Refresh> button until the 
Current Status changes.   
This section will explain what happens during the CAO process after it has 
been initiated. This includes a brief description of what is processing in 
DCPDS and what if any action is required from the user.   
 
Step Action 

1 After the CAO/Transfer request has been submitted, a SOID 
Validation is made.  The system insures that both the Losing and 
Gaining SOIDs are valid before an attempt is made to retrieve the 
SF-75 Information.  Until the SOID Validation phase is completed 
this transaction will only be displayed by selecting the “All” radio 
dial at the bottom of the Status tab.  
 
Select the “?” button which shows that the “SOID Validation has 
been initiated. 

 
 

2 The information input on your CAO/Transfer request appears in the 
Transaction region of the form.  This provides you with all the 
information initially input on your request form.   

 
 

At this point the Key field (CAO ID) only contains a number; after 
the Gaining and Losing region have been validated, the Key field 
will also include the Gaining/Losing Region . 

  
Continued on next page 
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Initiating the CAO/Interagency Transfer Request (Gaining Region), 
Continued 

 
Processing the CAO/Transfer Request (Gaining Region) (Continued) 
 
 

Step Action 
 Note:  To view changes in the Status area, select the <Refresh> 

button on the Status Tab.    
3 After both the Gaining and Losing SOID are validated, a request for 

“SF-75 Info” is initiated to the Losing database for the SSAN on the 
CAO/Transfer request form.  The Current Status is then updated to 
“SF-75 Info/Initiated”. 
 

 
 

Select the “?” button. 
4 The CAO Details shows “SF-75 Info” request initiated by the 

Gaining Region.  A date/time stamp is included in the Status Date 
field for each Phase in the CAO Details window.  DCPDS is 
programmed to continue processing the current Phase until a 
response is received.  A communication problem between 
Region/Interface server would be indicated when a transaction 
remains at one Phase for an excessive amount of time.  
 

 
The <Cancel Request> button is now active.  The request can be 
cancelled anytime prior to the update of the RPA.  Once an RPA has 
been processed, user must cancel the accession using the 
Cancellation/Correction RPA.   

  
Continued on next page 
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Initiating the CAO/Interagency Transfer Request (Gaining Region), 
Continued 

 
Processing the CAO/Transfer Request (Gaining Region) (Continued) 
 
 

Step Action 
5 Select the <Refresh> button and the Current Status will change to 

Applicant Build/Pending.  This indicates to the user DCPDS is waiting 
for the Applicant record to be created.  The Name column is populated 
with the name of the Employee record retrieved from the Losing 
Region.   
 

 
Select on the “?” button to open the CAO Details and proceed.  The 
next step is to Build the Applicant. 
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Building the Applicant Record 

 
 
Building the 
Applicant 
Record (Gaining 
Region) 

To gain an employee using the CAO/Transfer process, the Applicant record 
must be created following the steps in this section of the guide.  Do not enter 
Applicant record in an RPA until this process has been completed. 
 
Step Action 

1 After the SF-75 Info has been copied to the Interface Server, a notice 
is sent to the Gaining region and the Current Status will be changed 
to Applicant Build/Pending.   
 

 
 
Select the “?” button. 

2 The <Build Applicant> button becomes active. The system is ready 
to create and update the Applicant record with the SF-75 Info (CAO 
Loss 1, 2, 3, and 4 DDFs) received from the Losing Region.  

 
Select the <Build Applicant> button.  The system builds the 
Applicant and updates the Person → Extra Information/Special 
Information with the SF-75 Info received.  The following message 
will display when the Applicant record has been created.   

  
Select <OK>.  Close CAO Details window and <Refresh> the Status 
Tab.  
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Continued on next page 

Building the Applicant Record, Continued 

 
Building the Applicant Record (Gaining Region) (Continued) 
 

Step Action 
3 The Current Status changes to Applicant 

Build/Completed

 
 
Click the “?” button and the message changes to “Update RPA to 
proceed”. 
 

 
 
Proceed to the RPA and Update the action.  
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Processing the CAO/Transfer Request  

 
 
Processing the 
CAO/Transfer 
Request (Same 
Region) 

When a CAO or Interagency Transfer is required to be processed on the 
same Region database, use the following steps.  This process would be used 
if both SOIDs required in the CAO/Transfer action exist on the same Region 
database.  An example of this would be when a security reason required the 
use of “Secure View” to prevent the disclosure of Privacy Act information or 
when there are cross-serviced records, changing agencies in the same Region 
database.   
 

Step Action 
1 Initiate the CAO/Transfer request form.  

 
2 The request validates the Gaining and Losing SOID. 

 
Click the “?” button. 

3 The CAO Details Window displays; there is no difference in the 
process to this point.  

 
 
 

Continued on next page 
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Processing the CAO/Transfer Request, Continued 

 
Processing the CAO/Transfer Request (Same Region) (Continued) 
 

Step Action 
4 After DCPDS determines the Gaining and Losing SOID are on the 

same Region the SF-75 Information is generated/received the Current 
Status is changed to indicate the Applicant Build/Pending.  Click the 
Status tab to view this information. 

 
5 Click the “?” button to open the CAO Details Window. Then select 

<Build Applicant>. 

 
6 <Refresh> the Status Tab and the Current Status changes to 

Transaction/Complete. 

. 
 

Click the “?” button.  The CAO Details Window shows DCPDS is 
ready for the RPA update.   

 
 

Continued on next page 
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Processing the CAO/Transfer Request, Continued 

 
Processing the CAO/Transfer Request (Same Region) (Continued) 
 

Step Action 
7 Input data and update the RPA.  Return to the CAO/Transfer request 

form and the Current Status is now changed to 
Transaction/Complete. 

 
The CAO Details Window shows the Separation was created for 
update at the Region database. 

 
 

The Separation action will generate as a future action and be 
consummated in the next Futures (Process-Future Dated RPA) run.  
Errors will be routed to the POI WGI/Suspense Group Box.  These 
actions will require manual processing. 
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Processing the CAO/Transfer Request, Continued 

 
Processing the 
CAO/Transfer 
Request 
(Gaining 
Region) 

To process the RPA, navigate to the CAO or Interagency Transfer RPA or 
open the Recruit/Fill RPA, select the <Change Family> button and the 
appropriate RPA type (CAO or Transfer). 

Step Action 
1 Select the Applicant record created by the CAO/Transfer Request, 

code the RPA by completing the required data elements on the RPA 
and in the Extra Information DDFs.   

 
<Update HR>. 

 

Continued on next page 
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Processing the CAO/Transfer Request, Continued 

 
Processing the CAO/Transfer Request (Gaining Region) (Continued) 
 

Step Action 
2 If an Applicant record is used on the RPA that was created manually 

or by Resumix, the displayed error message will be received when 
you attempt to Update HR.  

 
If the Applicant record used on the RPA was not the one created by 
the CAO/Transfer process even though the request form was 
initiated, the displayed error message will be received.  

 
Remove Applicant Record from RPA and use the CAO/Transfer 
process to create the Applicant record for use in the CAO process.  
These business rules are only applied when using the CAO or 
Interagency Transfer RPA.  DCPDS will only allow update if the 
Applicant record was created by DCPDS using the CAO/Transfer 
process.   

3 
 

The successful update of the CAO or Interagency RPA will generate 
the output of a Pay500 transaction from the Gaining Region database 
to the Payroll office identified in the CAO/Transfer request.  
Note:   Pay500 output to the Losing Payroll office is determined by 
comparing the Gaining and Losing payroll office.  A Pay500 
transaction will only be generated if the payroll offices are different. 
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Processing a Return to Duty with the CAO Process 

 
Processing a 292 
RTD when 
employee on 
LWOP is being 
gained using the 
Change in 
Appointing Office 
RPA  

The following information is provided to document the way in which the 
system processes CAO and Return to Duty (RTD) actions on employees who 
are in a non-pay status at the losing database when the CAO request form is 
submitted.  This section only applies to the CAO RPA process; there is no 
requirement to process a RTD for the Transfer Interagency RPA.   

Step Action 

1 After completing the CAO/Transfer request form and receiving the 
“Update RPA to Proceed” status notice, navigate to the Workflow 
Inbox.  Locate and open the CAO RPA that will be used to gain the 
new hire.   

2 Input the Employee Name or SSAN and Effective Date of the 
action.  The system checks the Duty Status of the employee at the 
losing database; if the duty status is LWOP- Mil (20), LWOP- 
OWCP (25) or LWOP (30) the system will populate blocks 5A-5D 
with “T292, RTD (Return To Duty), DAM, Reg 630.101.  Using the 
LOV select the appropriate NOA and NOAC to complete the action 
to be processed.  Complete RPA and Update HR.    

 
3 Note:  THIS ONLY APPLIES WHEN UPDATING T292 NOA 

RPA. 
Do not input Education Code on page 3 of the RPA or in the RPA 
Extra Information Education DDF.  The RPA will not update if 
education information is included with this action.  The education 
information is populated in the Applicant record when the CAO 
Loss data is loaded during the Applicant build so the existing 
education information will be captured at the time of data transfer.  

  
Continued on next page 
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Processing a Return to Duty with the CAO Process, Continued 

 
Processing a 292 RTD when employee on LWOP is being gained using the Change in 
Appointing Office RPA (Continued) 
 
 

Step Action 
4 
 

It is important to insure the Type of Employment field has the 
correct value.  The Type of Employment can be found in the US 
Fed Appointment Info DDF and is auto-populated based from the 
data received with the “SF-75 info” and stored in Person Extra 
Information US Fed 1 Type of Employment data field.  When 
DCPDS loads the Applicant record with the “SF-75 info” it places 
the “F” (Employee on LWOP) code received from the employee’s 
record at the Losing Region database.   
Note:  If you do not change the Type of Employment before 
updating the RPA the “F” (Employee on LWOP) will flow to 
payroll on the Pay500.   

5 
 
 

After the action has updated in the database two Pay500 
transactions will be generated.  Navigate to the Pay500 transactions 
to verify that payroll output was generated for both the 292 and 
your CAO NOA.  The Pay500 for the 292 will process first - then 
the Pay500 for your gain.   

 
Note: When processing a CAO where the losing and gaining 
payroll office id (POID) is changing you will receive a PayNew on 
the 292 record not on file.  This is happening because the 292 
pay500 is writing to payroll before the CAO gain, the new payroll 
office will not have a record of the employee until after the CAO 
pay500 is processed.  This will not prevent the CAO from 
processing at the gaining payroll.  No action is required by 
submitting personnel office.   
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Viewing the Pseudo Assignment 

 
Viewing the 
Pseudo 
Appointment 

After updating the CAO or Transfer Interagency the system will create a 
pseudo assignment entry from the SCD-Leave date to the day before their hire 
date.  You can view this pseudo assignment by using the following steps:  
 
Step Action 

1 
 
 

Navigate to the People Window, People > Enter Maintain, you will 
notice the employee’s hire date is no longer the effective date of the 
appointment action but the SCD-Leave date of the employee.  To 
view the Pseudo assignment, select <Assignment>. 

 Select the Alter Effective Date    button on the Toolbar.   
Input the date prior to the Assignment Start Date. 

 
Note:  The Pseudo Assignment is effective from the SCD-Leave 
date through the current active assignment.   
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Canceling an Initiated CAO/Transfer Request 

 
Canceling a 
CAO/IT 
Request 

A CAO or Interagency Transfer can be canceled any time prior to update of 
the RPA.  To cancel the request use the following steps: 

Step Action 
1 Navigate to the CAO/Transfer request form and query for the 

record you desire to cancel.  
 

2 Click on the “?” to open the CAO Details window.  Click the 
<Cancel Request> button.  The request can be cancelled either 
before or after the Applicant has been created.  If the Applicant 
record has been created prior to deleting the request (Build 
Applicant button will be grayed out), the system will also delete the 
Applicant record in this process.  Select the <Cancel Request> 
button.  

 
 

3 When you receive the dialogue box asking if you really want to 
cancel the pending CAO transaction, click the <Yes> button. 

 
 

4 Once the process is complete, you will receive the “Transaction 
Cancelled” notice.  

 
Attempting a search for the applicant record will show that the 
Applicant record has been deleted. 

Continued on next page 
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Canceling an Initiated CAO/Transfer Request, Continued 

 
Canceling a CAO/IT Request (Continued) 
 

Step Action 
5 Close the CAO Detail Window and click the <Refresh> button, 

the Current Status will now show “Cancellation/Complete”  
 

 
 

6 Clicking on the “?” button shows that the request cancellation was 
successful.   

 
Close the CAO Details Window.  A new request can now be 
initiated if required. 
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Canceling a Consummated CAO/Transfer RPA 

 
Canceling a 
Consummated 
CAO/Transfer 
RPA 

Once an RPA has been updated “Cancel Request” button is disabled.  
Canceling the CAO/Transfer request must now be accomplished using the 
Oracle Cancellation process.  This section should only be used to cancel a 
CAO/Transfer that has already consummated in DCPDS and the RPA has 
been updated.   

Step Action 

1 Navigate to the Cancellation/Correction RPA.   

 
2 Query for the Employee that needs to be canceled.  

 
3 

 
4 After successful update of the RPA the Applicant record created 

by the CAO/Transfer process must still be deleted.  Follow the 
instructions in the “Deleting Applicant Record Updated on the 
CAO/Transfer RPA” section of this guide to delete the Applicant 
record.  
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Deleting Applicant Records after Canceling CAO/Transfer RPA 

 
Deleting 
Applicant 
records used 
in the 
CAO/Transfer 
process.   

To delete a CAO or Interagency Transfer RPA after the action has been 
consummated (Update HR Complete), the following steps should be used:  
After Canceling the RPA using the Cancellation/Correction, the Applicant 
record must be deleted using the <Delete Personal Records> functionality.  
Use of this functionality is required because the Applicant record created in the 
CAO/Transfer process is populated with historical information from the 
Losing Region.  This information is used to create a pseudo assignment that 
allows users to do Reconstructive actions, when required to the record.   

Step Action 
1 Using the System Administrator Responsibility select Delete 

Personal Records from the navigation menu.  

 
To find the record enter query mode <F11> enter the Last Name 
and Social Security number <Ctrl F11>.  Verify the applicant 
record is displayed.  

 
Verify receipt of the correct record, select <Delete Person>.   

2 A popup dialog box displays asking if you are sure you want to 
delete this record.  Select <Yes>.  

3 Select <Save>. When these steps have completed, return to the 
beginning of this section and create a new applicant record using 
the CAO/Transfer Request form process.   Once the record has 
been processed for a pay period you cannot delete the applicant 
record.   
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CAO/Transfer Separation Process  

 
CAO/Transfer 
Separation 
Process (Gaining 
Region) 

Once the RPA for a CAO or Interagency Transfer is processed.  DCPDS 
once again sends a message to the Losing Region database.  The purpose is 
to inform the Gaining Region that the separation information has flowed to 
the Losing Region.  A notice is also created to inform the Gaining Region a 
Separation action was created successfully at the Losing Region once the 
RPA has been created.  The Separation RPA created will be consummated 
when “Futures” is run at the Losing Region.  
Step Action 

1 After consummating the CAO or Interagency Transfer RPA, open 
the CAO/Transfer request.  The Current Status has changed and 
shows the following: 

and the CAO Details shows: 

 
2 
 
 

DCPDS sends the data elements required by the Losing Region 
database for the creation of the Separation RPA (CAO or 352 
Termination Appt In).  The Separation RPA at the Losing Region is 
created (similar to the process used to create the Termination Exp of 
Appt RPAs) and the next “Futures” process to that region will 
update the Region database with the Separation.   
Note:  If the Gaining and Losing Payroll offices are the same there 
will be no Pay500 transaction generated to the Losing Payroll.  IF 
the Gaining and Losing Payroll offices are different a Pay500 
transaction will be generated to the Losing Payroll office.  

 
 

Continued on next page 
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CAO/Transfer Separation Process, Continued 

 
CAO/Transfer Separation Process (Gaining Region) (Continued) 
 

Step Action 
3 User will be notified that the RPA was created successfully by the 

following message displayed in the Current Status column. 

Click the “?”. 

 
The last entry to be received is the Separation/Complete this 
informs the user that the Separation process was successful.  This 
message does not guarantee the RPA has updated at the Losing 
Region it only provides notice that the RPA was created.    

4 The Separation action will generate as a future action and be 
consummated the next Futures (Process-Future Dated RPA) run.  
Errors will be routed to the POI WGI/Suspense group box and will 
require manual processing. 
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CAO/Transfer Separation Process  

 
CAO/Transfer 
Separation 
Process (Losing 
Region) 

The CAO/Interagency Transfer request is to be submitted by the Gaining 
Region but this section is to inform users of the potential benefit to the Losing 
Region afforded by the change in the CAO process.  This change to the 
request form allows the Losing Region to monitor Separations generated 
through the CAO/Transfer process. 

Step Action 
1 The request form can be accessed by navigating from the Navigation 

List to: Req Personnel Actions → CAO/Transfer → 
CAO/Transfer Request.   

 
The Status Tab does not “Auto-Query” and is defaulted to the Gain 
radio dial.  To view the transaction processed by other Region 
databases on current employee records on your Region database click 
the “Loss” radio dial.  Users have the capability of querying (F11, 
Ctrl F11) on SSAN, Request or Current Status.  Once the 
information is displayed the Status Report can be exported using the 
File > Export functionality. 

 
 

Continued on next page 



                                                                                      R12                                                                     December 2011 

Staffing:  Change in Appointing Office (CAO) or Transfer          Mod 4, Chap 11, Page 30 
   

 
CAO/Transfer Separation Process, Continued 

 
CAO/Transfer Separation Process (Losing Region) (Continued) 
 

Step Action 
2 Click the <Refresh> button.  This will show all of the records with 

the Current Status of Separation/Pending.  These are based on an 
active CAO/Transfer request being initiated by another Region 
database.  

 
Click the “?” button.  The CAO Details Window opens.   

3 
 
 

This provides the Losing Region with a means of identifying the 
submitting Region when a problem occurs during processing of the 
CAO action.   
 
Note:  It is important to note here that the Losing Region can only 
view the transaction history.  They do not have the capability to 
change or cancel the request; the “Cancel Request” button is not 
active when the Losing Region views the CAO Details Window.  
Only the Region initiating the CAO/Transfer can cancel that 
request.     

 

Continued on next page 
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CAO/Transfer Separation Process, Continued 

 
CAO/Transfer Separation Process (Losing Region) (Continued) 
 

Step Action 
4 
 
 
 

Once the RPA is updated at the Gaining Region, DCPDS sends the 
separation data to the Losing region.  Another entry is recorded in 
the Status Report to inform the Losing Region a Separation action 
is pending.  The Status Report “Current Status” column changes to 
“Separation/Complete. 

 
 

Click the “?” button. 

 
Separation/Pending is the final entry in the Status Report.   
 
Note: This message does not guarantee the RPA has updated at the 
Losing Region it only provides notice that the RPA was created.   

5 The Separation action will generate as a future action and be 
consummated in the next Futures (Process-Future Dated RPA) run.  
Errors will be routed to the POI WGI/Suspense group box.  These 
actions will require manual processing. 

6 If you are not certain what the POI is for the Employee, it can be 
found in the Position→Extra Information→US Fed Position 1.  
You must be attached to the WGI/Suspense box for that POI to see 
the Separation action.  
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Appendix A 

Errors Reporting in the CAO/Transfer Process 
The following is a list of error messages that may be encountered when attempting to initiate a 
CAO/Transfer Request. 

If attempting to initiate a CAO/Transfer request on a SSAN that already has an active CAO/IT 
request form initiated the following error message will appear:  The system has been designed to 
allow only one active Request form at a time for the same SSAN.  To input a new request user 
must first “Cancel” the active request form.  
 

 
 
Action to take:  
 Check the CAO/Transfer Status Report to verify an active request exists.  If the 

information on the existing request is inaccurate, cancel and Initiate a new request. 
 
If no “Employee” record is found on losing region the “Message” will be: 
 

 
 
Action to take:  
 Verify that the Losing SOID, SSAN input on the CAO/Transfer request form is accurate, 

or 
 Contact the Losing Region to verify the Employee record exists, CAO process will not 

work if there is not an Employee record on the database.   
 

If the Error is a Trip Counter Mismatch error: (A condition exists that DCPDS has not been 
coded to handle). 
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Action to take: 
 Submit a Remedy ticket.  This message indicates a DCPDS code problem and should be 

reported immediately.  
 
For all of the error conditions listed below the user will receive the following notice on the Status 
Tab,  

 

 
 
However, the “Message” displayed when user clicks “?” will be different for example, If: 
The Losing SOID input on the request form does not exist on the interface server the “Message” 
will be: 

 
 
The Gaining SOID on the request form does not exist on the Interface server: 

 
 

 
Action to take:  
 Check the Gaining or Losing SOID entered on the CAO/Transfer request if the SOID is 

incorrect re-submit with correct SOID.   
 Submit Remedy ticket.  The SOID is not on the Interface Server and the process will not 

work for that SOID until it is added.  
 
The Gaining SOID on the request form does not exist on the Gaining Region database: 
 

 
 
Action to take:  
 Check the Gaining SOID input on the CAO/Transfer request.  Re-input correct SOID.  

 
If more than one “Employee” record is found on the losing region then the “Message” will be: 

 
 

Action to take:  
 This error occurs because DCPDS finds more than one employee record at the losing 

Region.  The cause is usually because the employee has a pseudo assignment.  This will 
require a manual work around to the CAO/Transfer action.   

NOTE:  The work around for this error is found in Appendix B.  



                                                                                      R12                                                                     December 2011 

Staffing:  Change in Appointing Office (CAO) or Transfer          Mod 4, Chap 11, Page 34 
   

APPENDIX B 

CAO/Transfer Work Around for More than 1 Employee Record at 
Losing Region 

 
 

After processing the CAO/Transfer request form and receiving the following error message use 
the work around described in this section to appoint the employee to your region.   

 
 

CAO Gain Work Around-(Gaining Region) 
 

a. Open the Interagency Transfer RPA. 

 
 

b. Enter the appropriate “P5XX or P7XX” NOAC (Do not use “TXXX” if the “P” NOAC 
are not available you are using the wrong RPA form as they are only available in the 
Transfer Interagency RPA).  
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c. After completing all necessary information on the RPA, navigate to Extra Information 
CAO/Transfer SF50 From Side DDF.  Enter the Employee’s data received from the 
Losing Region.  Update HR once all data has been input. 

d. Send pick-up notification to the Losing Region. 
 

CAO Loss Work Around-(Losing Region) 
 

After receiving notice (pick-up 50) from the Gaining Region that an employee serviced by your 
Region has been picked up, use the following steps to process and complete the gain action at 
your Region: 
 

a. Navigate to the Separation Family RPA.  Select the “CAO” NOAC and input the 
LAC “ZLM” the Legal Authority clear text should be the same Legal Authority used 
in the gain action. 

 
b. After completing all necessary information on the RPA, click the Extra Information 

button and navigate to the “CAO Separation” DDF. 
 - Enter the Gaining NOAC (NOAC used by gaining region to pick up employee). 
      - Enter the Gaining Payroll Office ID 

 
c. Click on the “Separation and Retirements” DDF 

- Enter appropriate data elements. 
- DO NOT enter the “Type of Pay Change” this will be automatically 

determined by the system. 
 
 
 
 
 
NOTE:  A Pay500 transaction will not be generated if the Losing and Gaining Payroll office is 
the same (e.g. PE to PE). 
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Interagency Transfer Gain Work Around-(Gaining Region) 
 

When an Interagency Transfer request form is submitted and the required Employee information 
is not received from the Losing Region database use the following steps to process the gain to 
your Region: 

 
a. Navigate to the Appointment Request for Personnel Action (RPA).  Use the appropriate 

NOAC and LAC to process the Transfer action.  Complete all required information. 
 
 
 
 
 
 

b. Update HR 
 

Interagency Transfer Gain Work Around-(Losing Region) 
 
After receiving notice from the Gaining Region that an employee serviced by your Region has 
been picked up, use the following workaround to separate the Employee from your Region 
database: 
 

a. Navigate to the Separation Family RPA.  Select the “CAO” NOAC and input the LAC 
“ZLM” (use the clear text for the appropriate “DBM, DFM or DKM” LAC). 

 

 
 
 
 
 

 
b.  After completing all necessary information on the RPA, select Extra Information button 

and navigate to the “CAO Separation” DDF. 
 

-  Enter “352” in the Gaining NOA Code (this will allow the system to flow a 352 NOA on the 
Pay500 when required). 

 - Enter the Gaining Payroll Office ID 
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c.   Click on the “Separation and Retirements” DDF 
 - Enter appropriate data elements. 
 - DO NOT enter the “Type of Pay Change” this will be automatically determined by 
the system. 

 
 
 
 
 
 
 
NOTE: A Pay500 transaction will not be generated if the Losing and Gaining Payroll office are 
the same (e.g. PE to PE). 
 
 
NOTE:  A Pay500 transaction will be generated if the Losing and Gaining Payroll office are the 
same (e.g. DE to PE). 
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Appendix C 

Trip Counter Combination Table 
 

Gaining 
Region 

Interface 
Server 

Losing 
Region Region Notes 

0 Null Null 
A CAO transaction has been initiated.  This will be processed locally by 
the gaining region.  The SOIDs input on the form are validated and the 
values for gaining and losing region are determined.  

1 Null Null The first time the interface server processes a new transaction. 

1 2 Null 
The control data has been copied to the interface server.  This 
combination will exist the first time the losing region processes a new 
transaction.  Ignored on the gaining region and interface  

1 2 3 
The control data has been copied to the losing region.  This state will exist 
briefly while the losing region unloads the data into the loss tables.  
Ignored on the gaining region and the interface server.  

1 2 4 

The losing region has completed loading the loss tables.  This 
combination is processed by the interface server and ignored by the 
gaining and  
 losing regions.  

1 5 4 The loss data has been copied to the interface server.  Processed by the 
gaining region and ignored by the interface server and losing region. 

6 5 4 The loss data has been copied to the gaining region.  This transaction is 
suspended pending user input.  

7 5 4 

The gaining region has processed the RPA.  At this point, the person 
being processed is an employee on both the gaining and losing region.  
This is the start of the separation process.  This combination is ignored on 
the gaining and losing regions and process by the interface server.  

7 8 4 
Confirm table copied to the interface server.  This combination will be 
processed by the losing region and ignored by the gaining region and 
interface server.  

7 8 9 
Confirm data copied to the losing region.  This state will exist briefly 
while the separation RPA is created.  Processed by the losing region and 
ignored by the gaining region and interface server.  

7 8 10 
The separation RPA has been created at the losing region, pending 
consummation by futures.  This be processed by the interface server and 
ignored on the gaining and losing regions.  

7 11 10 The interface server has acknowledged the separation processed by the 
gaining region and ignored by the interface server and losing region.  

12 11 10 Gaining region has acknowledged the separation.   Processed by the 
interface server and ignored on the gaining and losing regions.  

12 12 10 This transaction is complete.  All transaction data will be purged from the 
gaining and losing regions in 10 days.  
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Module 4 

Chapter 12 

Processing a Conversion/Extension on Temporary or Term 
Appointment 

 

Chapter Overview 
   

Introduction This chapter provides the user with the instructions for conversion/extension 
process to a temporary or term appointment prior to consummation of the 
suspense-generated 355 Termination Expiration of Appointment RPA. 

  
 

Chapter 
Contents 

 

Topic Page 

Chapter  Overview 1 
Introduction 1 
Before You Begin 1 

Processing a Projected Conversion or Extension Action 3 
Processing a Current or Past Dated Conversion or Extension 
Action 7 
Processing a Conversion/Extension Action on an Erroneously 
Separated Employee 

 
8 

 
 

Before you 
Begin 
 
 
 
 

Suspense processing in DCPDS will automatically generate a projected 355 
Termination-Expiration of Appointment RPA 14 days prior to the separation 
effective date.  For this reason, it is important for users to review the employee 
record prior to processing a conversion/extension RPA.  Prior to processing the 
conversion/extension RPA, users should: 

• Check the employee’s record for the creation of the suspense-generated 
355 Termination Expiration of Appointment RPA. 

• Verify the effective date of the conversion/extension is at least two days 
prior to the effective date of the 355. 

• Ensure the 355 system generated RPA has been deleted from database 
after conversion/extension has been updated. 
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Processing a Projected Conversion or Extension Action 
 

 
Processing a 
Projected 
Conversion or 
Extension 
Action 

Processing of a conversion/extension to a temporary or term appointment 
should be processed a minimum of two days prior to employees’ NTE date. 
To process a projected conversion or extension to a temporary or term 
appointment, use the following instructions.  
 

Step Action 

1 The user should check for the existence of a system generated 355.  
This is accomplished by navigating to the Cancellation/Correction 
window in DCPDS. 
 

 

2 
 
 
 
 
 
 
 
 
 
 
 
 

Identify the employee by Name or SSAN, click the “All” radio dial. 
This will display all “Processed” and “Pending” RPAs.  

 
Note:  In this example, both the initial appointment and the pending 
system generated termination are shown.  Note the effective date of 
the 355 (04-Jul-2011). 

 
Continued on next page 
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Processing a Projected Conversion or Extension Action, 
Continued 

  
 

Step Action 
3 
 
 
 

Open the conversion/extension RPA.  Enter the effective date (e.g. 
11-Jul-2011, this date must be greater than the current date).  The 
effective date entered should be at least two days prior to the NTE 
date.  Enter the Last Name or SSN of the employee being extended.   

 
If the employee identified on the RPA has another RPA pending 
update, DCPDS will display a warning message providing the RPA 
number, type of projected action, effective date, and the current 
location of the RPA. (This only occurs when the employee is 
initially placed on the RPA.)  

 
Before proceeding with the conversion/extension, the user should 
verify that the RPAs listed in the “Note” do not negatively impact 
the action to be processed. 

 
Continued on next page 
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Processing a Projected Conversion or Extension Action, 
Continued 

 
 

Step Action 
4 If the conversion/extension RPA is still appropriate, complete and 

update the RPA.  If a pending action exists for the employee in 
DCPDS, a “Caution” window will display. This “Caution” informs 
the user that the RPA indicated is in a pending status; select <OK> 
to continue with the update of the conversion/extension action.   

 
Note:  When the RPA is updated, the pending action listed on this 
note will be re-routed to either the inbox of the user that updated the 
RPA or to the WGI/Suspense inbox if the RPA was system 
generated. 

5 Navigate to Cancellation/Correction RPA, enter the employee 
information and select “All”. 

 
The termination action (355) is no longer present. The projected 
action (765) is reflected in an approved status.  Users will find that 
the suspense-generated 355 RPA has been re-routed in the 
WGI/Suspense inbox of the applicable POI. 

 
Continued on next page 
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Processing a Projected Conversion or Extension Action, 
Continued 

 
 

Step Action 
6 The suspense-generated 355 RPA will be deleted the next time 

suspense is initiated as long as both the conversion/extension RPA 
and the suspense-generated 355 RPA are in a projected status.  It is 
not necessary for users to delete the 355 RPA. 

7 The suspense process looks for a conversion/extension RPA prior to 
creating the suspense-generated 355 RPA.  DCPDS will not 
automatically create a 355 RPA if a projected 5XX or 7XX RPA 
already exists for the employee 14 days prior to the NTE date.   
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Processing a Current or Past Dated Conversion or Extension 
Action 

 
 
Processing a 
Current or 
Past Dated 
Conversion or 
Extension 
Action 

There will be situations where the user cannot process a conversion/ 
extension to a temporary or term appointment a minimum of two days prior 
to an employee’s NTE date.  To process a conversion or extension to a 
temporary, or term appointment with a current or past effective date and the 
355 has not yet processed, use the following instructions.  
 
Step Action 

1 Follow steps 1 and 2 in the “Processing a Projected Conversion or 
Extension Action”.  If a system generated 355 exists, use the 
following steps to process the conversion/extension RPA. 

2 Enter the effective date.  Enter the Last Name or SSN of the 
employee being converted or extended.  Complete and update the 
RPA. 

 
Remember, a caution window will display if another RPA is in 
process for your selected employee. 

3 
 
 
 

If a system-generated 355 exists (step 1 above), user should re-
route RPA to the WGI/Suspense Group Box for the POI.  Hold the 
termination in the WGI/Suspense Group Box (or other inbox) until 
the extension or conversion consummates. After the new action 
consummates, you may Red-X the termination. 
Note: The suspense process will not automatically delete this 355 
because there is no pending extension action.  The new process 
only deletes the system generated 355 RPA when both the 355 and 
the conversion/extension RPA are in a pending status. 
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Processing a Conversion/Extension on an Erroneously 
Separated Employee 

 
Processing a 
Conversion/ 
Extension 
Action on an 
Erroneously 
Separated 
Employee 

There are many instances when managing employees on temporary and term 
appointments, the HR office is not notified of a requirement to extend a NTE 
date until after the system-generated 355 has updated DCPDS. If an RPA is 
received to convert/extend an employee record after the system-generated 355 
RPA has updated DCPDS, the following steps must be used to ensure that the 
employee record is restored and converted/extended and that information is 
properly updated in DCPDS. 
 
Step Action 

1 Verify the record no longer has an active employee status by 
navigating to the Person Record, Navigation List → People → 
Enter and Maintain and query DCPDS for the employee’s Name or 
SSN. When the record is retrieved, check the Person Types field.  If 
the Person Type is Ex-employee or Ex-employee.Ex-applicant, 
proceed to Step 2. 

 or  

2 
 

Navigate to the Cancellation/Correction Window Req Personnel 
Action → Cancellation/Correction and query the employee record. 

 
Note: You will not retrieve an Ex-employee record from a secure 
view; use of a responsibility with global view is required for this 
step. 

 
Continued on next page 
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Processing a Conversion/Extension on an Erroneously 
Separated Employee, Continued 

  
 

Step Action 
3 Select the NPA for NOA 355 and then click the Cancellation 

button.   

 
DCPDS will create and display the cancellation action to be 
processed.  The user should then update the cancellation action. 

4 
 
 

Navigate to the Conversion/Extension RPA and enter the effective 
date.  
Note:  The effective date of the conversion/extension should be at 
least two days prior to the NTE date in the assignment history. 

 
Complete and update the RPA.  
CAUTION:  The update of the RPA must be completed on the 
same day the 355 is canceled. If the conversion/extension RPA is 
not processed on the same day, a new system generated 355 RPA 
will be created when Suspense process is executed, and terminate 
the employee when the Futures process is run. 

 
Continued on next page 
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Processing a Conversion/Extension on an Erroneously 
Separated Employee, Continued 

  
 

Step Action 
5 Return to the People window.   

 
The Person Type has been restored to Employee, Ex-applicant or 
Employee. 

6 Select the Assignment button. 

 
Verify the Assignment Status screen has also been restored to 
Temp/Term NTE and is correctly displayed.  

 
 

Continued on next page 
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Processing a Conversion/Extension on an Erroneously 
Separated Employee, Continued 

  
 
 

Step Action 
7 Select the Extra Information button. 

 
Check Assignment NTE Dates and US Federal Assignment NTE 
dates to verify the information was restored. 
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Module 4 

Chapter 13 
RIF Tool 

 
Chapter Overview 

 
 

Introduction    Refer to page 4 of this chapter. 
 

 
 

Chapter    Refer to page 2 of this chapter. 
Contents 

  
 

Also See  Module 4, Chapter 8, AUTORIF Extract  
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1. Purpose and History of the DCPDS RIF Tool 
 a. Purpose 
  (1) The DCPDS RIF Tool is designed to allow DOD components to conduct 

reduction in force procedures in accordance with the 5CFR351 regulation 
through the DCPDS Oracle Framework.   

  (2) This tool can be used for all General Schedule, FWS and NSPS employees 
whose data is stored within DCPDS.   

 b. History of the DCPDS RIF Tool 
  (1) AUTORIF 
   (a) AUTORIF is a program used by the Department of Defense that 

uses an extract from DCPDS and uploaded into an ACCESS97 
database to conduct reduction in force procedures.  The program is 
maintained by Lockheed Martin.   

   (b) Due to aging software and security issue concerns a decision was 
made to discontinue using AUTORIF and migrate to a tool 
maintained with the Oracle Framework. 

  (2) DCPDS RIF Tool 
   (a) CRT 09-94333-DoD contains the original requirements for the 

DPCDS RIF Tool and DCPDS RIF Tool Administrator and was 
promoted to DCPDS on November 10, 2010 

   (b) CRT 09-94372-DoD contained the original requirement for the 
reports and was promoted to DCPDS on November 10, 2010 

   (c) SCR 10-121859-DoD was approved through SCRWG #32 and was 
promoted to DCPDS on July 31, 2011 and contained the following 
enhancements: 

    1. Ability to disable the Alternate Offer functionality 
    2. Add additional find/search capabilities throughout the tool 
    3. Auto-populate the Date Conversion Due for VRA 

Employees that are converted to competitive service within 
the tool 

    4. Add a Bump/Retreat Column in the Round 2 screen 
    5. Add a Reviewed Checkbox for employees/positions with 

errors/warnings 
    6. Define the number of visible rows through the tool 
    7. Ability to un-cancel a RIF. 
    8. Add RIF Action Codes to a select group of reports 
   (d) SCR 11-125285-DoD was approved through SCRWG #34 and was 

promoted to DCPDS on November 13, 2011 and contained the 
following enhancements: 

    1. Ability to delete an extract or staging table 
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    2. Ability All Positions Capability 
    3. With Warning/Error Changes 
    4. New Report – RIF Action – Round 2 Report 
 
2. Regulations and Guidance – The following regulations and guidance were used to 

create this tool. 
 a. 5CFR351 – Reduction in Force 
 b. OPM Workforce Reshaping Operations Handbook & Appendixes – 2009 
 
 
3. Quality Control Review of DCPDS  
 a. Quality Review of DCPDS – It is strongly recommended that a quality review of 

DCPDS be performed prior to executing the DCPDS RIF Extract.  The DCPDS 
RIF Extract is a “snap shot” of DCPDS at the time the extract is accomplished.  
Any corrections/changes made to the DCPDS RIF Tool does not feed back to 
DCPDS.  If the position/employee record is refreshed from DCPDS to the 
DCPDS RIF Tool, any changes made to the position/employee record in the 
DPCDS RIF Tool will be lost. 

 b. Check Data Elements for Accuracy – The following data elements should be 
checked for accuracy 

  (1) Competitive Levels  
  (2) Obligated Position/Obligated SSAN  
   (a) for every employee on a temporary promotion/reassignment, the 

obligated position area of the employee record contains their 
permanent position 

   (b) for every employee on a temporary promotion/reassignment, the 
obligated ssan area of the position record contains the employee’s 
SSAN  

  (3) Appointment Type does not equal null 
  (4) Appointment Type/Tenure – probationary period/conversion dates match 
  (5) SCD-RIF/SCD-LV  
  (6) Appraisal Pattern/Rating of Record combination match 
  (7) Veterans Preference 
   (a) VP-RIF Value is not null 
   (b) VP-RIF correlates to the VP-RIF Value (VP-RIF = No, VP-RIF 

must equal 1) 
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4. Data Flow/Calculations 
 a. Extract  
  (1) In order to create a RIF, an extract from DCPDS must be accomplished. 
  (2) This is a “snapshot” of the data at the time the extract is accomplished.  

The extract defines the widest range of positions needed to accomplish the 
RIF.   

  (3) At least one Servicing Office ID must be identified.  Multiple staging 
tables can be created from one extract.   

 b. Staging Table 
  (1) From the extract, a staging table is then created that will allow the user to 

make changes to certain data elements.   
  (2) Editing the staging table is optional.   
  (3) Any changes made to the staging table does not affect the Extract.  
  (4) If necessary multiple staging tables may be created from one extract.  All 

changes made to the RIF Table are saved to the staging table except when 
a position is deleted.   

  (5) Multiple RIFs can be created from one staging table.   
 c. RIF Options 
  (1) Once the staging table is created, the RIF Options must be defined.   
  (2) The RIF Options use DCPDS defined data elements to define the 

Competitive Area of the RIF as well as the date parameters used to 
accomplish the RIF. 

 d. RIF Creation – Once the RIF Options are determined the RIF is created. 
 e. Appraisal Calculations 
  (1) Once the RIF Options have been defined, appraisal calculations will then 

take place.   
  (2) Because there are multiple ways appraisals can be updated throughout the 

RIF process, the user will be directed to the appraisal page when the RIF 
is created, before processing the RIF and each time a new iteration is 
started or when the RIF Options are changed.   

  (3) Unless a change in the appraisal calculations are found, the values input at 
the time the RIF was created or last changed will brought into the page.   

  (4) Modal Rating – A count of current appraisals is made to determine the 
modal rating.   

   (a) Single Pattern RIF – If it has been determined to be a single pattern 
RIF, then default values will be set.   

   (b) Multiple Pattern RIF - If more than one pattern is found among the 
current appraisals, then the user will need to identify which pattern 
or patterns employees are currently rated under.   
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  (5) Appraisal Designation – If more than one pattern is checked for a Multiple 
Pattern RIF under the Modal Rating area, then the user will need to define 
by Pay Plan, PAS or UIC the pattern that applies. 

  (6) Appraisal Point Calculation  
   (a) Single Pattern RIF – Nothing to do. 
   (b) Multiple Pattern RIF – If it has been determined to be a multiple 

pattern RIF, then the user may need to change the points to be 
assigned to appraisals (dependent upon component policy) 

 f. Position/Employee Warnings/Errors 
  (1) At the time the RIF is created and before processing a RIF a check is made 

of position and employee records to determine whether there are any 
errors contained in the record.   

  (2) Warning/error messages will not clear from the position/employee tabs 
until the warnings/errors are fixed and the Pre-Process Button is executed. 

 
 
5. Creating and Naming Tables within the DCPDS RIF Tool 
 a. There are three instances in which the user will have to create a unique name: 
  (1) Creating an Extract Table 
  (2) Creating a Staging Table 
  (3) Creating a RIF Table 
 b. The same name that is created for the extract table can be used for the staging 

table and RIF table.  However, the same name cannot be used for more than one 
extract, staging or RIF table.   

 c. Even though there may be employees within the same competitive area 
description (i.e., all positions within a single geographical location or 
organizational unit), it will be necessary to create separate RIF tables if there are 
employees being abolished with different work schedules, different types of 
service (competitive/excepted) or excepted service employees with different 
appointment authority codes (J8M, Y1M, Y2M, etc.). 

 d. Because all of the tables will be stored within DCPDS, is recommended that 
components create a naming convention to help identify their RIFs when multiple 
RIF tables are necessary for the same competitive area criteria (full-time vs part-
time, competitive service vs excepted service, different RIF effective dates). 

 
 
6. Steps to Processing a RIF 
 Step 1: Create a RIF Extract (Section B.2.b.) 
 Step 2: Create a RIF Staging Table (Section B.3.k.) 
 Step 3: Edit the RIF Staging Table (Optional) (Section B.4.b.) 
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 Step 4: Set RIF Options (Section C.1.b.) 
 Step 5: Calculate Appraisal Points (Section C.2.a.) 
 Step 6: Set Representative Rates (Section E.1.) 
 Step 7: Set Lines of Progression (Section E.2.) 
 Step 8: Abolish Positions (Section F.1.f.) 
 Step 9: Correct Position/Employee Errors (if applicable) (Section F.1.l.) 
 Step 10: Edit Employee Records (Section F.3.b.) 
 Step 11: Edit Tenure Tie Breaks (Section G.2.a.) 
 Step 12: Pre-Process Round 1 (checks for position/employee errors and abolishes and 

recalculates appraisal information) (Section G.4.) 
 Step 13: Process Round 1 (if no errors) (Section G.5.) 
 Step 14: Adjust Round 1 (if Allow Displacement Exceptions is checked) (Section G.6.) 
 Step 15: Pre-Process Round 2 (checks for valid representative rates and lines of 

progression) (Section G.7.) 
 Step 16: Process Round 2 (Section G.8.) 
 Step 17: Final Adjustments (Section G.9.) 
 Step 18: New Iteration (Section G.10.) 
 Step 19: Generate Reports (Section H.1.) 
 Step 20:  Generate Notices (Section H.2.) 
 
 
7. Responsibilities and Menu Items 
 a. DCPDS RIF Responsibilities – There are two responsibilities that are associated 

with the DCPDS RIF Tool.  Access to these responsibilities will be the 
responsibility of your system administrator:   

  
  (1) DCPDS RIF Tool – The DCPDS RIF Tool Responsibility is used to create 

and process RIFs and generate reports and notices within DCPDS.  
(Sections B through H) 

  (2) DCPDS RIF Tool Administrator – The DCPDS RIF Tool Administrator 
Responsibility used to “move” RIFs from one user to another, retrieve 
RIFs that have been archived and generate overall reports within a Region.  
(Section I) 
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 b. Menu Items – The following menu items are available within the DCPDS RIF 
Tool: 

 
  (1) Create a DCPDS RIF Extract – The user is directed to the Create a 

DCPDS RIF Extract Page when the link is selected. (Section B.2.a.) 
  (2) Create a DCPDS RIF – The user is directed to the Create a RIF Table 

Page when the link is selected.  (Sections B.3.a.) 
  (3) DCPDS RIF Application – The user is directed to the DCPDS RIF Page 

when the DCPDS RIF Application Link is selected from the Navigation 
Page.  (Section A.7.a.) 

  (4) User is directed to the navigation screen when the Return Button is 
selected from the Create a RIF Staging Table Page (Section B.5.a.).   

 
8. DCPDS RIF Page 
 a. General Information – DCPDS RIF Page 

(1) The DPCDS RIF Page shows a listing of all active RIFs that have been 
created by the user that have not been deleted or archived.   

(2) The user is directed to this page by: 
(a) Selecting the DCPDS RIF Application link on the Navigator Page 

(Section A.6.b.) or 
(b) Clicking the Cancel and Back to RIF Home Button within the RIF 

(Section D.1.c.) 
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 (3) From this page, the user can do the following: 
   (a) Search for RIFs using RIF Title or RIF ID 
   (b) Create a New RIF using the Create New RIF Button (user is 

directed to the Create a RIF Table Page) (Section B.3.a.) 

     
   (c) Update a RIF using the Update Button (user is directed to the RIF 

Overview Page Tab) (Section D.1.) 

     
   (d) Delete a RIF using the Delete Button 
   (e) Archive a RIF using the Archive Button 
 
 b. Search for RIFs 
  (1) When the user first enters the DCPDS RIF Page, all RIFs that were created 

are available. 
  (2) The user can limit the number of RIFs seen on the screen by entering a 

name of a RIF or a partial name in the RIF Title Area or by entering a RIF 
ID.  If a partial name is used, all names beginning with that characters 
entered will be returned, with or without a wild character (%) 

  (3) If the user does not enter any characters or uses a % or _ in the beginning 
of the name, the following error message will be displayed. 

   
  (4) To view all of the RIFs available, Click Home and and click the DCPDS 

RIF Application Link to reenter the page. 
 
 c. Defining the Number of Visible Rows  

   
  (1) The user will be able to define the number of visible rows by selecting the 

Records Displayed drop down button and selecting designed number. 
  (2) The default for the number of visible rows will be 25. 
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 d. Update a RIF 

   
  (1) The Update Button allows the user to update position/employee records, 

lines of progression, representative rates and process a RIF. 
  (2) Select the Update Button 
  (3) User will be directed to the RIF Overview Page (Section D.1.) 
 
 e. Delete a RIF 

   
  (1) The Delete Button allows the user to delete a RIF. 
  (2) Once deleted a RIF cannot be restored 
  (3) Select the Delete Button 
  (4) The following confirmation message will be displayed.  Click Yes to 

continue, No to return to the DCPDS RIF Page 

 
 
 f. Archive a RIF 

   
  (1) The Archive Button allows the user to “close” a RIF.   
  (2) Once closed no further processing can take place.   
  (3) The RIF Administrator is the only one that can reactivate an archived RIF.  

(Section I) 
  (4) Select the Archive Button on the row of the RIF you wish to archive 
  (5) The following confirmation will be displayed.  Click Yes to continue, 

click No to return to the DCPDS RIF Page 

    
  (6) The RIF will disappear from the users screen. 
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Section B – Creating a RIF Extract  
and RIF Staging Table 
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1. General Information – Creating a RIF Extract and RIF Staging Table  
 a. Before being able to create a RIF, the user must first create a RIF Extract.  From 

the RIF Extract, the user will be able to create one or more RIF Staging Tables.  
Once the RIF Staging Table is created, the user can then create one or more RIFs 
from the RIF Staging Table.   

 b. There are four pages available that will be used to create a RIF Extract and RIF 
Staging Table.   

  (1) Create a DCPDS RIF Extract Page 
  (2) Create a RIF Table Page 
  (3) Edit RIF Staging Table Page 
  (4) Create a RIF Staging Table Page 
 
 
2. Create a RIF Extract Page 
 a. General Information – Create a RIF Extract Page 
  (1) Creating a RIF Extract is the first step in creating a RIF within DCPDS.   
  (2) The DCPDS RIF Extract/Staging Table Criteria and Business Rules 

provides a list of data elements and business rules that are used to create 
the extract and staging tables.  (Attachment 1) 

  (3) The RIF Extract will be used to create the staging table.  The RIF Table 
will then be created from the staging table.  It is recommended that when 
creating the extract the widest criteria be used in order to capture all of the 
employees that need to be included in the RIF.  Example:  If the Position 
Occupied, at the time the extract is created, is input with a value of 1 
(Competitive Service), then VRA employees (Excepted Service) 
scheduled to convert between the time extract is downloaded and the 
effective date of the RIF will be missed.  This is due to the fact that the 
extract is limited to competitive service employees.  By leaving the 
position occupied blank, both competitive service and excepted service 
employees will be downloaded into the extract and then filtered out when 
the RIF is created based on the VRA conversion date and the RIF effective 
date.   
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  (4) The user is directed to this page when the Create a DCPDS RIF Extract 

Link is selected from the Navigator Page.  (Section A.6.b.) 
  (5) From this page, the user can do the following:   
   (a) Create a DCPDS RIF Extract by selecting the Create Button  

     
   (b) Remove all values shown on the screen by selecting the Reset to 

Default Button 

     
   (c) Return to the Navigation Page by selecting the Return Button 

     
 
 b. Create a RIF Extract 

STEP 1 – Create a DCPDS RIF Extract 
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  (1) Click on the Create a RIF Extract from the Navigator Page 

  
  (2) DCPDS RIF Extract File Name Area:  Enter a unique RIF Extract Name 

in the area provided 
   (a) required input 
   (b) limited to 50 characters 
  (3) Servicing Office ID - Enter one or more, using the Add Button when 

adding more than one value 
   (a) required input – at least one value must be input 
   (b) LOV – Select from the List of Values 
   (c) allows for multiple values 
  (4) To further limit the records brought into the Extract, the user may input 

values in one or more of the following fields.  Values input serve as an 
“AND” function to the SOID. 

   (a) PAS Code – LOV and allows for multiple values 
   (b) UIC – LOV and allows for multiple values 
   (c) Geographic Location Code – LOV and allows for multiple values 
   (d) Competitive Area Code – LOV and allows for multiple values 
   (e) Work Schedule – LOV and allows for only one value – Full-time, 

Part-time, Intermittent or Seasonal values will be available 
    1. Part-time includes Work Schedule = P, S 
    2. Seasonal includes Work Schedule = G, J, Q, T 
   (f) Position Occupied 
    1. LOV and allows for only one value 
    2. If Position Occupied = 1 during the Extract process and 

there are VRA employees that are due to convert to 
competitive service after the date the extract is run, then 
those employees will need to be manually added after the 
RIF is created. 

   (g) Appointing Authority Code 
    1. LOV and only allowed if Position Occupied = 2 
    2. The Include Vacancies Checkbox will be cleared and 

disabled if the Appointing Authority Code is populated 
   (h) Include Vacancies Checkbox 
    1. Default unchecked 
    2. Exception:  An obligated position that is invalid or 

eliminated will be included in the extract if the position 
matches all other criteria for the extract.   
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    3. If checked, only valid and active vacant positions will be 
included. 

    4. Not including vacancies in the extract will not preclude the 
user from adding positions from DCPDS or manually 
adding positions after the RIF is created.   

   (i) Demos Only 
    1. Default unchecked 
    2. Will only create retention registers for Demo employees  
 
 c. Error/Warning Messages 
  (1) The following error message will be displayed if the user fails to input an 

Extract Name and clicks the Create Button:  Error:  “Please enter the 
Extract Name” 

    
  (2) The following error will be displayed if the user fails to input at least one 

Servicing Office ID and clicks the Create Button:   

    
  (3) The following error will be displayed if the user inputs a duplicate Extract 

Name and clicks the Create Button 

    
 
 d. Create Button – once all values are input, select the Create Button – the user will 

be directed to the Create a RIF Table Page.  (Section B.3.a.) 

   
 
 
3. Create a RIF Table Page 
 a. General Information – Create a RIF Table Page 
  (1) The Create a RIF Table Page serves as two purposes, (1) to track the 

progress of a newly created RIF Extract and (2) once the creation of the 
RIF Extract has been completed, create a RIF Staging Table.  The Staging 
Table is necessary to create the RIF.  Once the Staging Table has been 
created, the user will be able to either edit the Staging Table or proceed 
directly to creating the RIF by setting the RIF Options.   
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  (2) The user is directed to this page by 
   (a) Clicking the Create a DCPDS RIF Link on the Navigator Page 

(Section A.6.b.) or 
   (b) Clicking the Create new RIF Button on the DCPDS RIF Page 

(Section A.7.) 
   (c) Selecting the Create Button on the Create a RIF Extract Page 

(Section B.2.d.) or 
   (d) Clicking the Return Button on the Edit RIF Staging Table Page 

(Section B.4.f.) or 
   (e) Clicking the Switch to the Extract List Button (Section B.5.a.) or 
   (f) Clicking the Return to Create a RIF Page Button on the RIF 

Options Page (Section C.1.g.) 
 (3) From this page, the user can do the following: 
  (a) Sort RIF Extracts 

   (b) Search for an Extract 
   (c) Delete an Extract (Delete Button associated with the Extract) 
   (d) Switch to the Staging Table List (to access Staging Tables already 

created) 
   (e) View the Process Log  
   (f) Refresh the Extract List 
   (g) Return to the Navigator Page 
   (h) Create a Staging Table from an Extract 
   (i) Create a RIF Table (Set Options Button) 
   (j) Edit a Staging Table (Edit Button) 
   (k) Delete a Staging Table (Delete Button associated with the Staging 

Table) 
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 b. Sorting RIF Extracts – RIF Extracts can be sorted in ascending or descending 
order using any of the columns shown below except the Select Column by 
clicking on columns.   

 
 
 c. Search/Find an Extract  
  (1) If directed to this page from the Create a RIF Table Page, the RIF Extract 

Name will be auto-populated in the Extract Name Area.  Click the Find 
Button to locate your extract.   

   
  (2) To find a different extract, enter either a partial or the full name in the 

Search area and click the Find Button or  
  (3) If there are more than 10 extracts shown, use the Next Button to locate an 

Extract 
 
 d. Defining the Number of Visible Rows  

 
  (1) The user will be able to define the number of visible rows by selecting the 

Records Displayed drop down button and selecting designed number. 
  (2) The default for the number of visible rows will be 25. 
 
 e. Phases of an Extract 
  (1) Until the Extract is established, the extract will not appear in the Extract 

List 
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  (2) Once the Extract has been established, the phase will show as Processing. 

 
  (3) Use the Refresh Extract List Button to show the progress of the extract 

creation.  

    
   Depending on the size of the extract it may take up to/exceed 30 minutes 

for the extract to completely process.  Periodically clicking the Refresh 
Extract List Button will show the progress of the extract.  As positions are 
added to the extract, the position count will increase.   

 

 

 
 
 f. Delete an Extract 

  

   
  (1) The Delete Button associated with the RIF Extract allows the user to 

delete an extract. 
  (2) Once deleted a RIF extract cannot be restored 
  (3) Select the Delete Button 
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  (4) The following confirmation message will be displayed.  Click Yes to 
continue, No to return to the RIF Extract Page. 

  (5) If there is a staging table associated with the extract, the extract cannot be 
deleted until the staging table is deleted.  The following error message will 
be displayed. 

    
 
 g. Switch to the Staging Table List Button 

   
  (1) The Switch to the Staging Table List Button allows users to access Staging 

Tables that have been already created 
  (2) Directs the user to the Create a RIF Staging Table Page (Section B.5.a.) 
 
 h. View the Process Log Button – Directs the user to the Process Log Page 

(Section H.3.a) 

   
 
 i. Refresh the Extract List Button – Refreshes the status of the Extract.  The phase 

will show as either Processing or Completed.  The Extract will not be available 
for editing or to create the RIF until the phase shows as Completed.   

   
 
 j. Return Button – Returns the user to the Navigator Page. 

   
 
 k. Create a Staging Table from an Extract 

STEP 2 – Create a RIF Staging Table 

  (1) Once the phase shows as Completed, you can create the Staging Table. 
  (2) Select the Extract that you would like to create a Staging Table by clicking 

the radio button next to the Extract 
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  (3) Input a Staging Table Name in the New Staging Table Name Area and 

click the Create Button.  The Staging Table Name is limited to 50 
characters. 

    
  (4) While the Staging Table is being created a Progress Clock will be visible. 

    
  (5) Once the Staging Table has been created, the Progress Clock will 

disappear and the Staging Table will appear in the Staging RIF Tables 
Area 

    
  (6) Error/Warning Messages 
   (a) If the user fails to input a staging table name prior to clicking the 

Create Button, the following error message will be displayed:   

     
   (b) If the user attempts to create a Staging Table with an identical 

name, the following message will be displayed:   

     
  (7) Edit Button 

    
   (a) Once the Staging Table has been created, the user can edit the 

Staging Table by clicking the Edit Button  
   (b) Clicking the Edit Button directs the user to the Edit RIF Staging 

Table Page (Section B.4.a.)  
  (8) Set RIF Options Button 
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   (1) Once the Staging Table has been created, the user can create a RIF 
by clicking the Set RIF Options Button.   

   (2) Clicking the Set RIF Options Button directs the user RIF Options 
Page (Section C.1.a.). 

  (9) Delete Button 

    
   (1) A Staging Table can be deleted if it is no longer needed provided 

there is no RIF associated to it. 
   (2) Click the Delete Button associated with the Staging Table.   
   (3) Click Yes to continue, No to return to the RIF Extract Page. 
    
   (4) If there is a RIF associated with the Staging Table, in order to 

delete the staging table, the RIF must be deleted.  The following 
error message will be displayed. 

    
 
 
4. Edit RIF Staging Table Page 

a. General Information – Edit RIF Staging Table Page 
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  (1) Once the RIF Staging Table is created, the user can edit the staging table if 

necessary.   
  (2) The data elements available for editing, if changed, can impact whether or 

not an employee is brought into the RIF or can change the position an 
employee competes from. 

   (a) Example 1:  If the VRA Conversion Date is before the RIF 
Effective Date and the RIF is a competitive service RIF, then the 
employee will be brought into the RIF as a competitive service 
employee. 

   (b) Example 2:  Obligated CPCN, if the Obligated CPCN is changed 
then employee will be placed on the Obligated CPCN when the 
RIF is created.   

  (3) The user is directed to this page by 
   (a) Clicking the Edit Button in the Staging RIF Tables Area of the 

Create a RIF Table Page (Section B.3.k.) or 
   (b) Clicking the Edit Button on the Create a RIF Staging Table Page 

(Section B.5.a.) 
 (4) From this page, the user can do the following: 
  (1) Search for records using the following criteria: 
   (a) Pay Plan 
   (b) Last Name 
   (c) Employee ID 
   (d) Obligated Employee SSAN 

   (2) Edit the certain employee/positions data elements  
   (3) Save changes to the employee/position data elements 
   (4) Proceed to Setting RIF Options (creating the RIF) 
   (5) Delete positions from the Staging Table 
   (6) Return to the Create a RIF Table Page 
 
 
 
 



Section B – Creating a RIF Extract and RIF Staging Table                                       November 2011 

Staffing:  RIF Tool                                                                               Mod 4, Chap 13, Page 25 

 b. Editing Data Elements 

STEP 3 – Edit the RIF Staging Table (Optional) 

  (1) Only the following data elements are editable from the Edit RIF Staging 
Table Page.  These data elements directly impact whether or not the record 
will be brought into the RIF based on the RIF Options.   

  (2) Employee/Position data – employee related data is shown on the main line 
of the record.  The Show/Hide Link reveals position related data.   

   (a) Obligated Position/Employee Information – When the RIF is 
created, an employee on a temporary promotion/reassignment will 
be moved back to their permanent position, provided the following 
data elements are populated correctly.  When moving an employee 
to their permanent position, the employee record must be coded 
with the Permanent CPCN and the Obligated Position Type must 
be “T”, in addition the CPCN identified in the Permanent CPCN 
area of the employee record must contain the employee’s SSAN in 
the Obligated Employee SSAN area and the Obligated Type must 
contain a “T” 

    1. Obligated Employee SSAN 
    2. Obligated Type 
    3. Permanent CPCN 
    4. Obligated Position Type 
 

 

 
 

   (b) Date VRA Conversion Due 

 

 
    1. If the RIF is a competitive service RIF and the Date VRA 

Conversion Due is prior to the effective date of the RIF, 
then the employee record will be brought into the 
competitive service RIF 

    2. If the RIF is an excepted service RIF and the Date VRA 
Conversion Due is prior to the effective date of the RIF, 
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then the employee record will not be brought into the 
excepted service RIF.   

   (c) Current Appt Auth(1) – will only be used to further define a RIF 
when the Position Occupied = 2 (Excepted Service). 

   (d) Competitive Area 
   (e) PAS Code 
   (f) Unit ID Code 
   (g) Organization 
   (h) Office Symbol 
   (i) Location 
   (j) SOID 
 
 c. Save Button – The Save Button will store any changes made to the employee 

record.   

  
 
 d. Proceed to Setting RIF Options Button – Directs the user to RIF Options Page.  

(Section C.1.a.)   

  
 
 e. Delete Button – Permanently delete one or more positions from the Staging Table 

   
  (1) locate the position/employee record(s) and click the select button for each 

position 
  (2) click the Delete Button 
  (3) the following warning message will be displayed:   

 
  (4) Once the records are deleted, the user is directed back to the Edit RIF 

Staging Table Page 
  (5) If records are inadvertently deleted from the Staging Table, they can be 

added to the RIF using the Add from DCPDS Button once the RIF has 
been created.  (Section F.1.h.)   

 
 f. Return Button – The Return Button directs the user to the Create a RIF Table 

Page (Section B.3.a.) 
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5. Create a RIF Staging Table Page 
 a. General Information – Create a RIF Staging Table Page 

 
  (1) The user is directed to this page by: 
   (a) Clicking the Switch to Staging Table List Button in the Create a 

RIF Table Page (Section B.3.g.) 
 (2) From this page, the user can do the following: 

   (a) View user created staging tables 
   (b) Switch to the Extract List – The Switch to Extract List Button 

directs the user to the Create a RIF Table Page (Section B.3.a.)  

     
   (c) Proceed to Setting RIF Options – The Proceed to Setting RIF 

Options Button directs the user to the RIF Options Page (Section 
C.1.a.) 

     
   (d) Edit the RIF Staging Table – The Edit Button directs the user to 

the Edit RIF Staging Table Page (Section B.4.a.) 

     
   (e) Return to the Navigator Page – the Return to the Navigator Page 

Button directs the user to the Navigator Page (Section A.6.b.) 
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Section C – RIF Options Page and  
Appraisal Information Page 
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1. RIF Options Page 
 

 

 

 
 a. General Information – RIF Options Page 
  (1) Once the RIF Staging Table has been created, and the records are edited if 

necessary, the next step will be to identify the RIF Options.   
  (2) The user is directed to this page by: 
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   (a) Selecting the Set Options Button from the Staging RIF Tables 
Area/Create RIF Table Page (Section B.3.k.) or 

   (b) Selecting the Proceed to Setting RIF Options Button on the Edit 
RIF Staging Table (Section B.4.d.) or 

   (c) Selecting the Proceed To Setting RIF Options Button from the 
Create a RIF Staging Table Page (Section B.5.a.) 

 (3) From this page, the user can do the following: 
   (a) Identify the data elements that will be used to create the RIF 
   (b) Create the RIF 
   (c) Return to the Create a RIF Page  
  (4) Those data elements that are identified with an ‘*’ prior to the data 

element are required data elements.   
 
 b. RIF Name Area 

 

STEP 4 – Set RIF Options 

 (1) Input a unique RIF Name and click the Create a DCPDS RIF Table Button 

 
  (2) Once the RIF Name is input and the Create a DCPDS RIF Table Button is 

selected, the RIF Options fields will open up.   

Important Note 1:  Exiting from the RIF Options Page – If you exit from this page after you 
have entered the RIF Name and clicked Create a DCPDS RIF Table but before you have 
selected the Save RIF Options Button, the RIF name will be locked and cannot be used.  In 
order to reuse the RIF Name you must delete the RIF.  (Section A.7.e.)   

  (3) Error messages 
   (a) If the user attempts to create a RIF with a name that has already 

been used, the following error will be displayed:   

     
   (b) If the user clicks the Create a DCPDS RIF Table without entering a 

RIF Name, the following error will be displayed:   
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 c. General Options – the following data elements are required/available when 
creating the RIF parameters.   

   
 (1) RIF Effective Date  
  (a) required field 
  (b) must be a future date 
  (c) this field is used to perform tenure and VRA conversions as well as

 determine Modal Rating calculations 
  (d) Error Messages 
   (1) The following error message will be displayed if the user 

attempts to save the RIF Options using a date earlier than 
the current date 

     
   (2) The following error message will be displayed if the user 

attempts to save the RIF Options without inputting a RIF 
Effective Date 

     
 (2) Appraisal Cutoff Date 
  (a) required field 
  (b) must be prior to RIF Effective Date 
  (c) this field in conjunction with the Appraisal Earliest Date will be 

used to determine what appraisals will be used in the appraisal 
calculation process.   

  (d) Error Messages 
   (1) The following error message will be displayed if the user 

attempts to input an Appraisal Cutoff Date after the 
effective date of the RIF 
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   (2) The following error message will be displayed if the user 
attempts to save the RIF Options without inputting an 
Appraisal Cutoff Date 

     
 (3) Appraisal Earliest Date 
  (a) required field 
  (b) auto-populated minus four years plus 1 day from the Appraisal 

Cutoff Date 
  (c) user updateable 
  (d) the following error message will be received if the Appraisal 

Earliest Date is left blank 

    
  (e) the following error message will be received if the date is changed 

to a date after the Appraisal Cutoff Date 

    
 (4) Reason for RIF  
  (a) required field 
  (b) LOV – must select a value from the LOV – LOV values are 

mandated by OPM 

    
 (5) RIF Type 
  (a) required field 
  (b) LOV – must select a value from the LOV – Real or Mock 

    
 (6) Treat GS and GM Alike? Checkbox 
   
  (a) Default checked 
  (b) If checked, treats GS and GM positions as if they are GS and 

places them in the same competitive level as GS, provided all other 
aspects are the same (PP-SRS-GR-CLC) 

  (c) If unchecked, places GS and GM positions is separate competitive 
levels 
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 (7) User Alternate Offer? Checkbox 
   
  (a) Default unchecked 
  (b) If unchecked, does not allow the user to make alternative offers 

during Round 2. 
  (c) If checked, the user will be required to select an alternate offer or 

confirm that no alternate offer will be made for each employee.   
 (8) NSPS Positions – Use GS Grade Equivalency? Checkbox 
   
  (a) Default unchecked 
  (b) If unchecked, does not allow the user to input a GS Grade 

Equivalency into NSPS positions in the Position Tab 
  (c) If checked, requires the user to enter a GS Grade Equivalent into 

each NSPS position.  Until all NSPS positions have a GS Grade 
Equivalency, the user will not be able to process Round 2. 

  (d) If checked, the value stored in the GS Grade Equivalent field in the 
position record will be used to determine an employee’s 
assignment right for GS/FWS positions.   

 (9) Allow Intervening Displacement Checkbox 
   
  (a) Default unchecked 
  (b) If unchecked, then Tenure I employees displace Tenure III during 

Round 1 and Round 2 competition 
  (c) If checked, during Round 1 competition Tenure I employees 

displace Tenure II and Tenure II automatically displaced Tenure 
III employees, during Round 2 competition Tenure I employees 
will displace Tenure II employees  

 (10) Round 1 Option – Use Vacancies in Round? Checkbox 
   
  (a) Default checked 
  (b) If checked, then vacancies will be used in Round 1 competition 
  (c) If unchecked, then not be used in Round 1 competition but will be 

available for use in Round 2. 
 (11) Round 1 Option – Allow Displacement Exceptions? Checkbox 
   
  (a) Default checked 
  (b) If checked, then the user will be able to make adjustments to 

placements made during Round 1 competition (Adjust Round 1). 
  (c) If unchecked, as soon as Round 1 competition is completed, the 

user will be immediately directed to Round 2 competition. 
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 (12) Round 2 – View Lowest Tenure Option for each Competitive Level? 
Checkbox 

   
  (a) Default checked 
  (b) If checked, then only the lowest tenured employee will be visible 

during Round 2.  If the employee being impacted is a Tenure I 
employee and there are Tenure II and Tenure III within the 
competitive level, then only the Tenure II employee will be visible.  
If the Tenure II employee is impacted, the Tenure II will 
automatically be placed in the Tenure III position and the Tenure 
III then competes in Round 2  or is automatically separated based 
on whether the Allow Administrative Assignment Rights? – 
Competitive Service – Bumping Rights for Tenure III Employees 
Checkbox is selected 

 (13) Allow Administrative Assignment Rights?  (Choose competitive or 
excepted service) Checkbox 

  
  (a) Default unchecked 
  (b) If checked, user will have the ability to select either the excepted 

service checkbox or one or both of the competitive service 
checkboxes.   

  (c) Error Message:  If the user attempts to select both excepted service 
and competitive service options, the following error message will 
be displayed: 

    
  (d) Excepted Service – Bump/Retreat Rights for Excepted Service 

Employees Checkbox 
   1. If checked, then excepted service employees will be 

allowed to have bump/retreat rights during Round 2 
competition.   

   2. If unchecked, then competition will end with Round 1 
competition for excepted service RIFs  

  (e) Competitive Service – Bumping Rights for Tenure III Employees 
Checkbox 

   1. If checked, then Tenure III employees will have bump 
rights during Round 2 competition. 
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   2. If unchecked, then Tenure III employees will have no 
competition rights and will not be visible during Round 2 
competition. 

  (f) Competitive Service – Bumping Rights in the Same Subgroup 
   1. If checked, then employees will have bump rights within 

the same subgroup versus retreat rights 
   2. If unchecked, employees will have retreat rights within the 

same subgroup 
 
 d. RIF Parameters Area 
  (1) Competitive Level 

 
   (a) Work Schedule 
    1. Default – Full-time 
    2. Only one value allowed 
    3. Full-time – selects all employees with a Work Schedule of 

“F” 
    4. Part-time – selects all employees with a Work Schedule of 

“P” or “S” 
    5. Intermittent – selects all employees with a Work Schedule 

of “I” 
    6. Seasonal – selects all employees with a Work Schedule of 

“G”, “J”, “Q”, “T” 
   (b) Position Occupied 
    1. Default – 1-Competitive Service 
    2. Only one value allowed 
    3. Most commonly used – 1-Competitive Service or 2-

Excepted Service 
   (c) Appointing Authority Code 
    1. Input only allowed and is required if Position Occupied = 

2-Excepted Service 
    2. Only one value allowed 
  (2) Additional Parameters 
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   (a) Include vacancies? Checkbox 
    1. Default unchecked 
    2. If unchecked, no vacancies will be uploaded from the RIF 

Staging Table 
    3. If checked, will include all vacancies from the RIF Staging 

Table 
    4. Note:  Once the RIF is created vacancies can still be 

brought in from DCPDS by using the Add From DCPDS 
Button (Section F.1.h.) or manually adding positions 
(Section F.2.e.).   

   (b) Include Temporary Employees? Checkbox 
    1. Default unchecked 
    2. If unchecked, then no temporary employees will be 

included from the RIF Staging Table 
    3. If checked, then temporary employees will be included 

from the RIF Staging Table, but will not be included in RIF 
competition. 

   (c) Load vacancies from temporary actions (promotions, etc.) 
Checkbox 

    1. Default unchecked 
    2. If unchecked, then positions vacated when employees are 

moved from their temporary promotion/reassignment will 
not be brought in from the RIF Staging Table 

    3. If checked, then positions vacated when employees are 
moved from their temporary promotion/reassignment will 
be brought in from the RIF Staging Table. 

  (3) Competitive Area 

   
   (a) Two Methods Available – Competitive Area – There are two 

methods available to identify positions using the competitive area 
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    1. DCPDS Defined Competitive Area – uses Competitive 
Area Codes, Geographical Codes and/or Organizational 
Unit Codes to further define the competitive area 

    2. User Defined Competitive Area – user will individually 
select positions/employees to define the competitive area.  
This can be used when no one data element or combination 
of data elements can be used to identify a competitive area 

   (b) DCPDS Defined Competitive Area 

  
    1. Default selected 
    2. If no values are selected, then all positions within the 

parameters identified in the Extract, the Competitive Level 
Area and the Additional Parameters will be brought into the 
RIF. 

    3. Add/Edit/View Button – to further define the competitive 
area based on the competitive area code, geographical code 
or organizational units, the user will need to access the 
DCPDS Defined Competitive Area Page by clicking the 
Add/Edit/View Button. 

   
    4. Each area will be considered an “AND” to the Work 

Schedule and Position Occupied.   
    5. Click the Checkbox to open a list of values for one of the 

three areas.  To select all values available on each page, 
click Select All, Click Next 10 and repeat until all values 
are selected. 
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    6. Once all values have been selected, click the Save Button.   

      
    7. For each area where values are selected, the user will 

receive a confirmation notice.  The following is a sample 
confirmation notice that will be displayed.   

     
    8. Search/Sort Capability 
     a. Select Competitive Area Code – The user will have 

the capability of searching or sorting by the 
Competitive Area Code 

     
     b. Select Geographical Location Code – The user will 

have the capability of searching or sorting by the 
Geographical Location Code or Geographical 
Location Code Description.   

     
     c. Select Organizational Units Area – The user will 

have two ways of further defining the competitive 
area using organizational units.  Use the Radio 
Button to select either Organizational Codes or 
Organizational Units.   

      
     (1) Select Organizational Codes – The user will 

have the capability of searching or sorting 
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on the PAS/UIC/Org Structure ID 
combination.   

     
      (2) Select Organizational Units – The user will 

have the capability of searching or sorting 
on the PAS/UIC or PAS/UIC description.   

     
 
    10. Once all changes have been made in the DCPDS Defined 

Competitive Area Page, click Return to RIF Options Page 
Button.   

      
    11. The values selected will now show in the Competitive Area 

of the RIF Options Page 

  
   (c) User Defined Competitive Area – the User Defined Competitive 

Area allows the user to select positions that are not easily 
identifiable using Competitive Area Code, Geographical Code, or 
Organizational Codes.   
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    1. User Defined Competitive Area Comments Area 

 
     a. If the User Defined Competitive Area method is 

used, then the user must provide comments in the 
User Defined Competitive Area Comments area 
describing how positions were identified.   

     b. If no comments are input, the following error 
message will be displayed upon selecting the Save 
Button.   

       
   2. Users can use the search criteria or the Next/Previous 

Buttons to locate positions to be included in the 
competitive area 

     
    3. Use the Select Button next to the employee name to select 

individual employees to include in the competitive area 
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    4. Once all positions have been selected, Click the Save 

Button.  The user will be directed to the RIF Options Page 

      
    5. Click the Return to RIF Options Page Button to return to 

the RIF Options Page without saving your selections.   

      
    6. Employee IDs will be used to identify all positions brought 

into the RIF using the User Defined Competitive Area 
Method.   

      
   (d) Changing methods.  When the user switches between DCDPS 

Defined Competitive Area and User Defined Competitive Area and 
vice versus, all values previously selected will be removed and the 
following message will be displayed. 
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 e. Save RIF Option Changes Button 

   
 (1) Once all RIF Options have been made, select the Save RIF Option 

Changes Button.  The Save RIF Option Changes Buttons creates the RIF 
using the settings identified in the RIF Options Page. 

 (2) As the RIF is created, the following calculations and processes are 
completed: 

  (a) Brings only those employees that meet the RIF Options into the 
RIF Table 

  (b) Identifies all position/employee errors and writes the errors to the 
position/employee records and Process Logs. 

  (c) Using the RIF Effective Date changes VRA employees to 
competitive service if the VRA Conversion Date is prior to the 
effective date of the RIF. 

  (d) If the Appointing Authority = J8M, populate the Date Conversion 
Career Due with the Date VRA Conversion Due plus 1 year if the 
Date Conversion Career Due is null.   

  
 
  (e) Using the RIF Effective Date changes Appt Type 2A and Tenure 2 

to Tenure 1 when the Date Conversion Career Due is prior to the 
effective date of the RIF 

  (f) Using the RIF Effective Date changes the Appt Type 1A and 
Tenure 2 to Tenure 1 when the Date Probationary Period End is 
prior to the effective date of the RIF 

  (g) Moves employees from the temporary promotion/change to lower 
grade/reassignment position to their permanent position provided 
the permanent position is coded with the employee’s SSAN and 
the employee record is coded with the employee’s permanent 
CPCN. 

3. User is directed to the Appraisal Information Page provided no errors are 
found on the page.  (Section C.2.a.) 

 
 f. Reset Button – The Reset Button removes all values input by the user.   
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 g. Return to Create a RIF Page Button – Directs the user to the Create a RIF 
Table Page (Section B.3.a.) 

  
 
 
2. Appraisal Information Page 
 a. General Information – Appraisal Information Page 

STEP 5 – Calculate Appraisal Points 

  (1) Once the RIF Options have been determined, the next step will be for the 
user to (1) calculate appraisal points for a single pattern RIF or (2) make 
modal rating and appraisal point decisions and then calculate appraisal 
points for a multiple pattern  RIF.   

  (2) The user is directed to this page by: 
   (a) Selecting the Save RIF Options Changes Button on the RIF 

Options Page (Section C.1.e.) 
   (b) Selecting the Pre-Process Round 1 Button (Section G.4.b.) 
   (c) Selecting the New Iteration Button (Section G.10.b.) 
  (3) From this page, the user can do the following: 
   (a) Single Pattern RIF – Calculate Single Pattern Appraisal Points 
   (b) Multiple Pattern RIF 
    1. More than one modal rating found – choose the modal 

rating(s) to be used in the RIF. 
    2. More than one modal rating chosen – update the Assign 

Pattern Designations to Positions Area 
    3. Update the Multiple Appraisal Points Area if necessary 
 
 b. Modal Rating Area  
  (1) For Both Single and Multiple Pattern RIFs, the Modal Rating Area counts 

all appraisals within one year of the effective date of the RIF and displays 
a count of all appraisals found by pattern and then by rating .   
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  (2) If there is a tie amongst the highest number of ratings, then the ratings that 
are tied are listed in the Tied Ratings Column.  The highest numbered 
rating then populated into the Most Frequently Assigned Rating.   

  (3) The rating that is found to be the most frequently assigned rating is listed 
in the Most Frequently Assigned Rating Column and is used in the 
calculation of the modal rating. 

 
 c. Appraisal Information Page – Single Pattern Page 

 
 (1) If all appraisals within the look-back period are found to be of the same 

pattern, the RIF is considered to be a single pattern RIF. 
 (2) Points are assigned based on the following rules: 
  (a) All ratings of 3 are assigned 12 points 
  (b) All ratings of 4 are assigned 16 points 
  (c) All ratings of 5 are assigned 20 points 
  (d) Employees with no appraisals are assigned a modal rating and 

points are assigned based on the modal rating. 
 (3) Calculate Single Pattern Appraisal Points  

 (a) If, through appraisal calculations, a single pattern RIF is found, the 
user cannot make any changes on this page and the only action that 
can be taken by the user is to calculate appraisal points by clicking 
the Calculate Single Pattern Appraisal Points.   

     
   (b) As the appraisal calculation process is in progress, a Progress 

Clock will be visible.   

     
   (c) If no appraisal errors are found the user is directed to the RIF 

Overview Page/Status Tab once all calculations have been made.  
(Section D.1.a. & Section D.2.a.) 
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   (d) If appraisal errors are found the user is directed to the RIF 
Overview/Process Log Tab once all calculations have been made. 

  
 d. Appraisal Information Page – Multiple Pattern Page 

 (1) General Information – Appraisal Information Page Multiple Pattern Page 
  (a) If more than one appraisal pattern is found within the look-back 

period that will be used in the appraisal calculation, the RIF is 
considered to be a multiple pattern RIF. 

  (b) There may be multiple decisions the user will need to make if the 
RIF is considered to be a multiple pattern RIF.   

  (2) Modal Rating Area 

  
   (a) This area displays all valid appraisals within the current year with 

the total count by pattern for each rating.  If more than one Pattern 
is available, the user will need to select all of the patterns that 
apply to records within the RIF.  (Example:  If the competitive area 
contains both GS/FWS and current NSPS employees and GS/FWS 
are rated under a Pattern A and the NSPS Employees are rated 
under a Pattern H, then both patterns need to be selected.  If 
current GS employees are rated under Pattern A and were 
converted from NSPS within the last year and had ratings under 
the NSPS system (Pattern H), only Pattern A should be selected, 
since they will now be rated under the Pattern A appraisal system.)   

   (b) Modal Rating Summary Level – Once a pattern is selected the 
Modal Rating Summary Level(s) becomes available.  The value is 
defaulted to the most frequently assigned rating for each level.   

   (c) If more than one pattern is selected then proceed to the Assign 
Pattern Designations to Positions Area (Section C.2.d.(3)) 

   (d) If only one pattern is selected, then proceed to Multiple Pattern 
Appraisal Points Area (Section C.2.d.(4)) 
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  (3) Assign Pattern Designations to Positions Area – if more than one pattern is 

selected from the Modal Rating Area, the Assign Pattern Designation to 
Positions Area will appear.   

   
   (a) When a RIF has more than one modal rating that is assigned to a 

set of positions, it is necessary to associate the modal rating with 
the right positions.  In order to determine which positions are rated 
under a specific modal rating, the user will need to assign a Pattern 
Designation to Positions using one of three methods – PAS, UIC or 
Pay Plan.  The default for this area is Pay Plan. 

   
   (b) (Example:  GS/FWS employees rated under Pattern A will receive 

the modal rating for a Pattern A and points for valid appraisals will 
be assigned using the values for Pattern A from the Multiple 
Pattern Appraisal Points Area.  NSPS employees rated under 
Pattern H will receive the modal rating for a Pattern H and points 
for valid appraisals will be assigned using the values for Pattern H.  
Input the GS/FWS pay plans in the Pattern A row and the NSPS 
pay plans in the Pattern H row.) 



Section C – RIF Options Page and Appraisal Information Page                                November 2011 

Staffing:  RIF Tool                                                                               Mod 4, Chap 13, Page 48 

  (4) Multiple Pattern Appraisal Points Area – the amount of points that will be 
assigned to an employee’s valid appraisals will be based on component 
multiple pattern appraisal policy.  The points assigned here will determine 
the amount of points that will be assigned to modal rating for each pattern 
as well as the amount of points for each valid appraisal (last 3 appraisals 
within the look back period). 

   
   (a) Default values are as follows: 
    1. Summary Level 3 – 12 points 
    2. Summary Level 4 – 16 points 
    3. Summary Level 5 – 20 points 
   (b) Values can be changed to any point value between 12 and 20 

(dependent on component policy) 
  (5) Calculate Multiple Pattern Appraisal Points Button 

    
   (a) Once all values have been set, click the Calculate Multiple Pattern 

Appraisal Points Button.   
   (b) As the appraisal calculation process is in progress, a Progress 

Clock will be visible.   

     
   (c) Appraisal Calculations will be made based on the values assigned 

in the page to each employee within the data base. 
   (d) If no appraisal errors are found the user is directed to the RIF 

Overview Page/Status Tab once all calculations have been made.  
(Section D.1.a. & Section D.2.a.) 

   (e) If appraisal errors are found the user is directed to the RIF 
Overview/Process Log Tab once all calculations have been made. 

  
  (6) Reset Button – resets all values to the default values. 
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1. RIF Overview Page 
 

 
 a. General Information – RIF Overview Page 
  (1) Once the RIF has been created, the user will be directed to the RIF 

Overview Page.  The RIF Overview Page allows the user to update all of 
the pertinent information concerning a RIF including representative rates, 
lines of progression and edit positions and employees as well as process 
the RIF and generate reports and notices.   

  (2) The user is directed to this page by: 
   (a) Selecting the Update Button associated with a RIF on the DCPDS 

RIF Page (Section A.7.a. & Section A.7.d.) 
   (b) Selecting the Calculate Single Pattern Appraisal Points Button for 

a single pattern RIF after completing the RIF Options area when 
creating a RIF (Section C.2.c.) or 

   (c) Clicking the Calculate Multiple Pattern RIF Points Button after 
completing the RIF Options area when creating a RIF (Section 
C.2.d.) 

 
 b. Tabs within the RIF Overview Page 
  (1) Status Tab (Section D.2.) 
  (2) Options Tab (Section D.3.) 
  (3) Appraisal Info Tab (Section D.4.) 
  (4) Representative Rate Tab (Section E.1.) 
  (5) Lines of Progression Tab (Section E.2.) 
  (6) Edit Positions/Employee Tab (Section F.) 
  (7) RIF Process Tab (Section G.) 
  (8) Reports Tab (Section H.1.) 
  (9) Notices Tab (Section H.2.) 
  (10) Process Logs Tab (Section H.3.) 
 
 c. Cancel and Back to RIF Home Page Button – The Cancel and Back to RIF 

Home Page Button will be available on all of the Tabs and directs the user back to 
the DCPDS RIF Page. (Section A.7.a.) 
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2. RIF Overview Page – Status Page 
 
 a. General Information – RIF Overview Page – Status Tab 
  (1) The Status Tab provides the user with statistical information concerning 

the current status of the RIF, and allows the user to update the 
Supplemental RIF Information Area. 

 

 

 
(2) The user is directed to this page by 

(a) Selecting the DCPDS RIF Application link on the Navigator Page 
(Section A.6.b.) or 

(b) Clicking the Calculate Single Pattern Appraisal Points or Calculate 
Multiple Pattern Appraisal Points after creating a RIF (Section 
C.2.c. or Section C.2.d.) 

  (3) From this page, the user can do the following: 
   (a) View RIF Statistics – all the data listed in the RIF Statistics and 

RIF Statistics – Current Information Area is auto-populated based 
on the status of the RIF 

   (b) View/Update Supplemental Information 
 
 b. Supplemental RIF Information 
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  (1) Reason for RIF – Auto-populated from the Options Tab – cannot be 
updated from this page 

  (2) RIF Type – Auto-populated from the Options Tab – cannot be updated 
from this page 

  (3) BRAC RIF Checkbox 

     
   (a) User updatable 
   (b) Check if the RIF is a BRAC related RIF 
  (4) Actions Report Information – User updateable 

    
   (a) Actions Report Issued – Iteration # – Used to store the Iteration # 

the Actions Report was issued 
   (b) Date Actions Report Issued – Used to store the Date the Actions 

Report was issued 
  (5) Notices Information – User updateable 

    
   (a) Notices Issued – Iteration # – Used to store the Iteration # the 

Notices were first issued 
   (b) Date Notices Issued – Used to store the date the Notices were first 

issued 
  (6) Cancelling and Uncancelling a RIF 

Important Note 2:  Cancelling/Uncancelling a RIF – The RIF Status will change from the 
current status to RIF Cancelled once the RIF Canceled, Date RIF Canceled and Reason 
Cancelled is completed.  If the RIF is “uncancelled”, the status will return to the previous 
status.   

  
   (a) Cancelling a RIF 
    1. To Cancel a RIF, click the RIF Canceled Checkbox 
    2. Date RIF Canceled – If the RIF Canceled checkbox is 

selected, the Date RIF Canceled is required and is used to 
store the date the RIF was cancelled.  If the user attempts to 
move off of the RIF Status Tab Page after selecting RIF 
Canceled Checkbox, without inputting a Date RIF 
Canceled, the following message will be displayed:   
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    3. Reason Cancelled – If the RIF Canceled Checkbox is 

selected, the Reason Cancelled is required and is used to 
store the reason the RIF was cancelled and is limited to 
4000 characters.  If the user attempts to move off of the 
RIF Status Tab after selecting the RIF Canceled Checkbox, 
without inputting a Reason Canceled, the following 
message will be displayed: 

     
    4. To save the changes, click the Save Button or select a 

different tab.   
    5. The RIF Status will change from the current status to RIF 

Canceled 

    
    6. A RIF with the status of RIF Cancelled will not be able to 

make any changes to employee records nor will they be 
able to process the RIF.  

   (b) Uncancelling a RIF 
    1. To Cancel a RIF, uncheck the RIF Canceled Checkbox 
    2. To save the changes, click the Save Button or click on a 

different tab.   
    3. The following message will be displayed.  Click Yes to 

continue, click No to cancel: 

     
    4. The RIF Status will change from RIF Canceled to the 

previous status. 
    5. The Date RIF Cancelled and the Reason Cancelled remarks 

will be removed.   
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  (7) RIF Remarks 

  
   (a) User updateable 
   (b) Used to track the progress of the RIF 
   (c) Limited to 4,000 characters 
  (8) Tenure Tie Break Remarks 

  
   (a) Used to document changes made to employees whose have the 

same tenure and Adjusted SCD-RIF  
   (b) Limited to 4,000 characters 
 
 c. Save Button – The Save Button saves changes made on the Status Page. 

   
 
 
3. RIF Overview Page – Options Tab 
 
 a. General Information – RIF Overview Page – Options Tab 

Important Note 3:  RIF Data Parameters – RIF Data Parameters shown on the Options Tab 
can only be changed prior to running Iteration 1/Round 1.  If any of the RIF Data Parameters 
need to be changed after Iteration 1/Round 1, then a new RIF will need to be created. 
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  (1) The Options Tab allows the user to make change the General Options 

Area as needed.  The RIF Data Parameters can only be change prior to 
running Iteration 1/Round 1.   

  (2) General Options Area – The data elements in the General Options area can 
be changed prior to beginning Round 1 processing.  Calculations will be 
made during Pre-Process Round 1.  If changes are needed to be made after 
Round 1 has begun, a new iteration must be executed. 

   (a) RIF Effective Date – Once the RIF Effective Date is set, this data 
field cannot be changed; however, if the date must be changed, a 
new date can be input in the New RIF Effective Date field.   
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   (b) New RIF Effective Date – If necessary, a new RIF Effective Date 
can be identified.  The following calculations will take place if a 
new RIF Effective Date is input 

    1. Modal Rating calculations 
    2. Tenure calculations – check the date conversion due and 

date probationary period due for tenure 2 employees and 
convert those employees whose tenure is past due based on 
the new RIF effective date. 

   (c) Appraisal Cutoff Date/Appraisal Earliest Date – If the Appraisal 
Cutoff Date is changed, appraisal calculations will be made during 
Pre-Process Round 1.   

   (d) All other fields can be selected/deselected as needed. 
  (3) RIF Data Parameters – The RIF Data Parameters can only be changed 

before running the first iteration through the RIF Process Tab.  (Section G. 
3.) 

 
 
4. RIF Overview Page – Appraisal Info Tab 
 

a. General Information – RIF Overview Page – Appraisal Info Tab 

Important Note 4:  Appraisal Info Tab – This page is for information purposes only.  
Appraisal Information can only be changed after selecting the Pre-Process Round 1 Button or 
after selecting the New Iteration Button from the RIF Process Tab.   

  (1) The Appraisal Info Tab is view capability only.  The user cannot make any 
changes to this page.   

  (2) This information on this page can only be changed by selecting the Pre-
Process Button under the RIF Process Page or by “restarting” the RIF 
using the New Iteration Button.  The user will be directed to the Appraisal 
Information Page (Section C.2.a.) to make any necessary changes.   

 
b. RIF Options Page – Appraisal Info Tab – Single Pattern RIF – If, through 

appraisal calculations, the RIF has been determined to be a single pattern RIF, the 
following screen will be displayed.   
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 c. RIF Options Page – Appraisal Info Tab – Multiple Pattern RIF – If, through 

appraisal calculations, the RIF has been determined to be a multiple pattern RIF, 
there are several screens that maybe seen, depending on the values selected in the 
Appraisal Information Page.   
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Section E – RIF Overview Page –  
Representative Rate Tab and  

Lines of Progression Tab 
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60 

 b. Filter/Sort Capabilities 61 
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 d. Upload Representative Rates 62 
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 f. Retrieve/Refresh Representative Rates from DCPDS 65 
 g. Add/Update/Delete Individual Representative Rates 66 
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67 

 b. Upload Lines of Progression 69 
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Notes Important Note Page # 
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6 Lines of Progression  67 
7 Excepted Service and Term Only RIFs  
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1. RIF Overview Page – Representative Rate Tab 

STEP 6 – Set Representative Rates 

a. General Information – RIF Overview Page – Representative Rate Tab 

Important Note 5:  Representative Rates – (1) All representative rates must be 
entered/refreshed for each PP-GR combination found in the database before being allowed to 
auto-populate Lines of Progression or being allowed to Process Round 2.  (2) NSPS 
representative rates must be manually entered or uploaded using the Upload Process.  (3) If 
manually uploading more than one set of representative rates, through the use a text file, 
combine all representative rate tables into one file.  Uploading more than one file will 
overwrite the previous values. 

  (1) Once the RIF has been created and before lines of progression can be 
determined, the representative rates must be created for all PP-GR-Pay 
Table combinations.  Round 2 processing cannot begin until all 
representative rates have been entered.   

  (2) The user is directed to this page  
   (a) By clicking the Representative Rate Tab from the RIF Overview 

Page (Section D.1.b.) 
   (b) Pre-Process Round 2 Button when there are missing representative 

rates (Section G.7.b.) 
 (3) From this page, the user can do the following: 

   (a) Upload representative rates through the use of a text file 
   (b) Identify locality areas when there are multiple representative rate 

areas 
   (c) Retrieve/Refresh Representative Rates for GS/FWS directly from 

DCPDS 
   (d) Manually update/edit representative rates 
  (4) Representative Rate Scenarios 
   (a) Single Pay Table/Locality Pay Areas found – if only one GS and 

one WG pay table is found, then those pay tables will 
automatically be loaded. 
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   (b) Multiple Pay Tables/Locality Pay Areas Detected 

 
  (5) All Pay Plan/Grade/Pay Table combinations are required to have an hourly 

rate input prior to beginning Round 2 competition 
  (6) All representative rates must be updated before the Lines of Progression 

Auto-populate Button on the Lines of Progression Page will become 
available. 

  (7) GS/FWS hourly rates may be updated by: 
   (a) Using the Upload Process 
   (b) Retrieve/Refresh Representative Rates from DCDPS  
   (c) manually inputting each value 
  (8) NSPS hourly rates may be updated by: 
   (a) uploading the values through the Upload process or  
   (b) manually inputting each value 
  (9) If there are multiple pay tables/locality pay area codes detected, the user 

must select one value for FWS and one for GS before being allowed to 
refresh the GS/FWS pay tables from DCPDS.   

 
 b. Filter/Sort Capability 

  
  (1) Filter by Pay Plan 

     
   (a) If there are multiple wage areas or general schedule areas, the 

filter/sort capabilities will not be fully functional until the user 
selects the pay tables that will be used to define the representative 
rates or uploads the missing pay tables.   

   (b) To Filter by Pay Plan, click the drop down box associated with the 
Filter by Pay Plan and select a pay plan.  Only the pay plan 
matching that value will be available.  Selecting the null value will 
show all pay plans.   
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  (2) Sort Ascending By 

  
   (a) The user will be able to sort all pay plans using one of the 

following data elements:  Pay Table, Pay Plan, Grade or Hourly 
Rate. 

   (b) If the Filter By Pay Plan has been used, only the selected pay plan 
will be sorted.   

 
 c. Defining the Number of Visible Rows  

 
  (1) The user will be able to define the number of visible rows by selecting the 

Records Displayed drop down button and selecting designed number. 
  (2) The default for the number of visible rows will be 25. 
 
 d. Upload Representative Rates 
  (1) Representative rates may be updated through the use of a text file 
  (2) Text file format 
   (a) Create a text file using the following format: 
Field Name Position Length Type Description 
Pay Table 1 4 C  
Pay Plan 5 2 C  
Grade 7 2 N  
Hourly Rate 9 8 N  
   (b) Sample Text File 
     Y500YA0100002171 
     Y500YA0200003183 
     Y500YA0300005380 
     Y500YB0100001360 
     Y500YB0200002298 
  (3) Click the Browse Button next to the Upload Representative Rates – Once 

the text file has been created, browse to locate the file to be uploaded and 
Click Open.  The file name will now be displayed in the Upload 
Representative Rates Area 
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  (4) Click the Upload Button 
   (a) Incorrect format.  The following error message will be displayed if 

the file is not in the correct format: 

     
   (b) Correct format.  If the file is in the correct format, the values 

uploaded from the file will be displayed in the Representative Rate 
Area 

 
 
 e. Multiple Pay Tables/Locality Pay Area Codes Detected 

   
  (1) If there are multiple locality areas within the competitive area, before 

being allowed to load the GS/FWS pay tables from DCPDS, the user must 
identify which pay tables will be used to set representative rates. 

  (2) Click the Select Values Button 
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  (3) The user will be directed to the Multi Select Page 
   (a) The user will have the ability to sort by clicking on the appropriate 

column the WG Pay Tables by Pay Table ID and the Locality Pay 
Areas by Geographical Location Code or Locality Pay Area.  In 
addition, the user will have the ability to search and find locality 
pay areas by performing a search against the Geographical 
Location Code or Locality Pay Area.   

    
 
   (b) If there is only one Wage Area, that value will automatically be 

selected 

  

  
   (c) If there are multiple Wage Areas and multiple General Schedule 

areas, the user will need to select one value from each table.   
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  (4) Once a value is selected from both the Wage Grade Area and the Locality 

Pay Area, Click the Save and Return Button 

    
  (5) To return to the Representative Rate Page without making any changes, 

click the Cancel and Return Button 

    
  (6) The GS/FWS representative rates will be populated into the 

Representative Rate Tables based on the pay tables selected.   

  
 
 f. Retrieve/Refresh Representative Rates from DCPDS 
  (1) If GS/FWS pay tables are updated/changed in DCPDS, the user will be 

able to refresh those values from DCPDS by clicking the Retrieve/Refresh 
Representative Rates from DCPDS Button.    
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 g. Add/Update/Delete Individual Representative Rates 
  (1) Add a Representative Rate 
   (a) The user has the option of manually entering the values for each 

representative rate.   
   (b) To add a representative rate click the Add Representative Rate 

Button 

     
   (c) A new line will appear.   

  
   (d) Enter all values and click the Save Selected Row Button 

     
   (e) The following error messages will be displayed if one of the 

required fields are not entered 

     

     

     

     
  (2) Update a Representative Rate 
   (a) Click the Select Radio Button next to the representative rate you 

wish to update. 

    
   (b) The hourly rate field will open. 
   (c) Enter the new value  
   (d) Click the Save Selected Row Button 

     
  (3) Delete a Representative Rate 
   (a) Click the Select Button next to the representative rate you wish to 

delete. 
   (b) Click the Delete Selected Row Button 

     
   (c) The following confirmation message will be displayed.  Click Yes 

to continue.  Click No to cancel the deletion. 
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  (4) Reset - Click the Reset Button to reset to the values at the last Save. 

    
 
 
2. RIF Overview Page – Lines of Progression 

STEP 7 – Set Lines of Progression 

a. General Information – RIF Overview Page – Lines of Progression Tab 

Important Note 6:  Lines of Progression – (1) Auto-populate Lines Button will not become 
available until the GS/WG representative rates have been added; (2) When selecting the Auto-
Populate Lines Button, the user will be directed to the Process Log Page if representative rates 
have not been entered for all PP-GR combinations.  (3) At least one line of progression must 
be input before being allowed to Process Round 2.  (4) If lines of progression are added prior 
to processing Round 2, it is important to verify those values prior to processing Round 2, since 
they will not be able to be changed during Round 2 processing. 

 

Important Note 7:  Excepted Service and Term only RIFs, Lines of Progression and Final 
Adjustments – In order for vacancies to be available as potential placements during Round 2, 
Lines of Progression must be loaded prior to processing Round 1.  Round 2 for Excepted 
Service and Term only RIFs is normally skipped and therefore, the user is not provided the 
ability to update the Lines of Progression prior to entering Final Adjustments.  If lines of 
progression are not entered, then competing employees and vacancies will not be available 
during Final Adjustments.   

 
  (1) Lines of Progression can be updated several ways; however, the Auto-

populate Lines of Progression Button will not become available until the 
GS/WG  representative rates have been added in the Representative Rate 
Tab.  Round 2 processing cannot begin without at least one line of 
progression being entered.   

   (a) Screenshot for Lines of Progression Page without the Auto-
populate Lines Button 
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   (b) Screenshot for Lines of Progression Page with the Auto-populate 

Lines Button 
 

   

   
  (2) The user is directed to this page by:  
   (a) Clicking the Lines of Progression Tab from the RIF Overview 

Page/Lines of Progression Tab (Section D.1.b.) 
   (b) Clicking the Pre-Process Round 2 Button and there are no lines of 

progression entered.  In order to enter Round 2, there must be at 
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least one line of progression entered.  All other lines of progression 
can be entered as they are reached during Round 2 competition.  
(Section G.7.c.) 

 (3) From this page, the user can do the following: 
   (a) Upload lines of progression the use of a text file 
   (b) Auto-populate lines of progression (provided all representative 

rates have been added) 
   (c) Manually update/edit lines of progression 
  (4) Find/Search capability 
   (a) Users will have the ability to search and sort lines of progression 

using Pay Plan, Series and Grade 

   
 
 b. Upload Lines of Progression 
  (1) Lines of progression may be updated through the use of a text file 
  (2) Text file format 
   (a) Create a text file using the following format: 
Field Name Position Length Type Description 
PP 1 2 C Pay Plan of the impacted position 
SERIES 3 4 N Series of the impacted position 
GRADE 7 2 N Grade of the impacted position 
Pay Plan 3 13 2 C Pay Plan for the 3 grades down 
Grade 3 15 2 N Grade for the 3 grades down 
Pay Plan 5 21 2 C Pay Plan for the 5th grade down 
Grade 5 23 2 N Grade for the 5th grade down 
   (b) Sample Text File 
    GS031806GS03GS01 
    GS031807GS04GS02 
    GS031808GS05GS03 
  (3) Click the Browse next to the Upload Lines of Progression – Once the text 

file has been created, browse to locate the file to be uploaded and Click 
Open.  The file name will now be displayed in the Upload Lines of 
Progression Area, click the Upload Button 
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  (4) Error/Warning – the following warning will be displayed if duplicate pay 
plan/series/grade combinations are found.  Click Yes to continue.  Click 
No to cancel.   

    
 
 c. Auto-populate Lines of Progression 
  (1) When using the Auto-populate Lines Button, the user will be directed to 

the Process Log Page if all pay plan, grade combinations have not been 
entered on the Representative Rate Page. 

  
  (2) Standard lines of progression rules: 
   (a) GS Two-grade Interval Rules – GS-15, GS-14, GS-13, GS-12, GS-

11, GS-09, GS-07, GS-05 
   (b) GS One-grade Interval Rules – GS-11, GS-10, GS-09, GS-08, GS-

07, GS-06, GS-05, GS-04, GS-03, GS-02, GS-01 
   (c) FWS – all positions will auto-populate with one grade intervals 
   (d) NSPS – all positions will auto-populate with one grade intervals 
  (3) GS/FWS 3-Grade/5-Grade bottom limits.  When the bottom of the pay 

grade scale is reached without completing a line of progression (GS-
01/WG-01), representative rates will be used to determine the rest of the 
line of progression.  Example:  GS-05 ($16.50 rep rate) position is 
abolished.  3 grade line of progression would be GS-04/GS-03/GS-02 
($11.88) – 5 grade line of progression would be GS-01 ($10.71)/look at 
WG rep rate.  If there are WG grades with a lower representative rate, then 
the highest WG representative rate that does not exceed the GS-01 rep rate 
is the next line of progression – WG-01 ($9.98).  (WG-02 rep rate is 
$11.35) 
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(4) NSPS 3-Grade/5-Grade bottom limits.  When the bottom of the pay grade 

scale is reached without completing a line of progression (YA-01), 
representative rates must be used to determine the rest of the line of 
progression.  (Example:  YA-01 ($21.71 rep rate) position is abolished.  
Line of progression would be to the pay schedule that falls within the line 
of progression – in this case would be YB.  The highest YB representative 
rate that does not exceed the YA-01 rep rate is the next line of progression 
– YB-01 (13.60).   

 
d. Add/Update/Remove/Refresh Lines of Progression 

 
  (1) Add a Line of Progression 
   (a) The user has the option of manually entering the values for each 

lines of progression.   
   (b) To add a line of progression click the Add a Line of Progression 

Button 

     
   (c) User will be directed to the Add a Line of Progression Page. 

  
   (d) Once all values have been entered, click the Save Button. 
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   (e) User will be directed back to the Lines of Progression Tab. 
  (2) Update a Line of Progression 
   (a) Click the Update Button on the row you wish to update. 

     
   (b) You will be directed to the Update a Line of Progression Page 

    
   (c) Once all change have been made, Click the Save Button 

     
   (d) User will be directed back to the Lines of Progression Tab. 
  (3) Remove a Line of Progression 
   (a) Click the Select Button on the row of the line of progression you 

wish to remove.   

    
   (b) Click the Remove a Line of Progression Button 

     
   (c) Note:  There is no warning message to warn the user that the line 

of progression will be removed. 
  (4) Refresh a Line of Progressions 
   (a) To refresh lines of progression, click the Refresh Button 

     
   (b) All manual inputs previously made will be updated based on auto-

population rules. 
   (c) The following confirmation message will be displayed.  Click Yes 

to continue.  Click No to cancel.   
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Section F – RIF Overview Page –  
Edit Positions/Employees Tab 
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Section Description Page # 
 f. Employee Record Error/Warning Area 106 
 g. Tenure and Seniority Area 107 
 
 
Steps Description Page # 
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9 Correct Position/Employee Errors 84 
10 Edit Employee Records 96 
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1. RIF Overview Page – Edit Positions/Employees Tab 
 a. General Information – RIF Options Page – Edit Positions/Employees Tab 

 
  (1) The Edit Positions/Employee Tab allows the user to view/edit all of the 

employees brought into the RIF Table from the Staging Table that meet 
the RIF Data parameters.   

  (2) From this page, the user can do the following: 
   (a) Search/filter records (Section F.1.b.) 
   (b) Sort records (Section F.1.c.) 
   (c) Defining the number of visible rows (Section F.1.e.) 
   (d) Abolish Positions (Section F.1.f.) 
   (e) Update the GS Equivalent Grade for NSPS positions (Section 

F.1.g.) 
   (f) Add positions from DCPDS (Section F.1.h.) 
   (g) Refresh a position from DCPDS (Section F.1.i.) 
   (h) Delete one or more positions (Section F.1.j.) 
   (i) Remove from RIF one or more positions (Section F.1.k.) 
   (j) View position/employee errors (Section F.1.l.) 
   (k) Edit position/employee records (including refreshing 

position/employee data from DCPDS) (Sections F.2.and F.3.) 
  (3) Before the user will be allowed to process the RIF, all employee errors 

must be corrected and at least one position must be abolished 
 

Important Note 8:  Edit Position/Employee Tab – (1) Employee errors messages will not be 
cleared until the Pre-Process Round Button is executed; (2) Appraisal recalculations will not 
be made until all employee errors have been cleared and at least one position has been 
abolished.   
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 b. Search/filter Records 

  
  (1) search criteria is not case sensitive 
  (2) multiple criteria can be entered and is considered an “And” function 
  (3) Find Button 
   (a) Use the Find Button is find only those records that meet the search 

criteria 
   (b) Only those records that match the criteria will be “visible” and 

editable.   
  (4) Clear Button – Click the Clear button to remove the search criteria and 

then click the Find Button to view all positions. 
  (5) Special Filters – There are five types of special filters  
   (a) With vacancy – finds only those positions that are vacant 
   (b) With Error – finds only those positions that have an error 

associated with the record 
   (c) With Warning – finds only those positions that have a warning 

associated with the record 
   (d) With Abolish – finds only those positions that are abolished 
   (e) With Removed – finds only those positions that the Removed from 

RIF 
 
 c. Sort Records – All columns except the Select, Details, Edit and Delete Columns 

can be selected to sort the records visible in the Search Results Area.   

 
 
 d. Action Columns – The Select, Details, Warning, Reviewed, Edit, Delete columns 

allow the user to …. 
  (1) Select Column – the Select checkbox is used to activate the Abolish 

Selected, Delete Selected and Remove Selected Buttons.  The user must 
select at least one position. 

 
  (2) Details Column – the Details Column shows either Show or Hide link.  

The Show/Hide Link shows any employee/position warning/errors 
associated with the record. 
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  (3) Warning/Error Column – If the employee/position record contains an 

warning or error, the Warning/Error Column will contain an icon. 
   (a) Warning - There is a potential in the employee record.  Review and 

correct the record if necessary.   

     
   (b) Error – There is an error in the position/employee record.  The 

record must be corrected before the user will be allowed to begin 
processing the RIF.   

     
  (4) Reviewed Column – The Reviewed Column will contain a checkbox if 

there is a warning or error associated with the employee record.  This 
checkbox can be checked either from this page or within the employee 
record page.   

    
  (5) Edit Column – The Edit Column contains an Edit Button.  This button 

allows the user to edit positions/employees.   
  (6) Delete Column – The Delete Column contains a Delete Button.  This 

button allows the user to delete positions from this page.   
 
 e. Defining the Number of Visible Rows  

 
  (1) The user will be able to define the number of visible rows by selecting the 

Records Displayed drop down button and selecting designed number. 
  (2) The default for the number of visible rows will be 25. 
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f. Abolish Positions 

STEP 8 – Abolish Positions 

  (1) Users will not be able to abolish the following positions: 
  (a) unencumbered (vacant) positions 
  (b) temporary employees (Tenure 0) 
  (c) positions marked as Removed from RIF 
  (d) employees marked as “Armed Forces Restoration” 
  (e) employees marked as “Final Written Decision of Removal Under 

5CFR432” or “Final Written Decision of Removal Under 
5CFR752” 

  (2) Abolish Positions – there are several ways to abolish a position 
  (a) Upload an Abolish List through the use of a text file 

    1. Create a text file using the following format – the file may 
contain either SSAN or CPCN or both 

     a. SSAN should be entered without dashes 
     b. CPCN should be entered with the PD #, followed by 

a period and then by sequence # 
Field Name Position Length Type Description 
SSAN 1 9 C  
     
Or     
CPCN 1 31 C  
     
    2. Sample file format 
     123456789 
     9G100.45678 
    3. Click the Upload Abolish List button 

      
    4. Click the Browse Button to locate the file to be uploaded.   

    
    5. Once the file has been located, Click the Upload Button 

   6. Confirmation Notice – the following confirmation notice 
will be displayed 
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  (b) Mark one or more position for abolishment from the 
Position/Employee Tab 

   1. Select one or more positions in the Select Column 
   2. Click the Abolish Selected Button  

     
   3. Abolish Confirmation Notice:  The following confirmation 

notice will be displayed:   

   
   4. Abolished column will change from N to Y 

 
   5. If one or more positions have been selected that meets one 

of the conditions identified in Section F.1.f.(1) above, the 
following warning message will be displayed:   

  

 
  (c) Abolish All – The Abolish All Button allows the user to abolish all 

positions within the RIF Database.   
   1. Select the Abolish All Button 

     
   2. The following confirmation message will be displayed: 
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 3. If there are positions that meet one of the conditions 
identified in Section F.1.f.(1) above, the following warning 
message will be displayed 

 
  (d) Mark a position for abolishment through the individual position 

screen (Section F.2.g.) 
 
 
g. Update the GS Equivalent Grade for NSPS positions – there are several ways 

to update the GS Equivalent Grade for NSPS positions 
 (1) Upload a GS equivalent grade for NSPS positions through the use of a text 

file 
   (a) Create a text file using the following format  
Field Name Position Length Type Description 
CPCN 1 31 C  
GS Grade 32 2 N  
   (b) Sample file format 
    9G10045678                     05 
 
   (c) Click the Upload GS Equivalent Grade Button 

     
   (d) The user will be directed to the Upload GS Equivalent Grade for 

NSPS Positions Page 

     
   (e) Click the Browse Button and navigate to locate the file to be 

uploaded.   

     
   (f) Once the file has been located, click the Upload Button 
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  (g) Confirmation Notice – the following confirmation notice will be 
displayed 

    
  (h) Click the Return to RIF Edit Positions/Employees Button to return 

to editing the positions/employees 

    
 (2) Update the GS Equivalent Grade for NSPS positions through the position 

screen (Section F.2.a.(2)) 
 
 h. Adding positions from DCPDS 
  (1) General Information – Adding positions from DCPDS 

    
   (a) If a position (vacant or encumbered) was not brought into the RIF 

table at the time it was created or was deleted once the RIF was 
created, then it can be brought into the RIF Table by using the Add 
from DCPDS Button.   

   (b) A position can be brought into the RIF using either the CPCN of 
the position or the SSAN of the employee. 

   (c) If the position was deleted from the RIF Table, this functionality 
will bring the position from the RIF Staging Table.  If any position 
or employee data has changed, then the user will need to “refresh” 
the position on the Position Tab.  (Section F.2.c.) 

  (2) To add a position (vacant or encumbered) that was not included in the RIF 
Extract (a position that was created after the extract was accomplished):   

   (a) Click the Add Position from DCPDS Button  
   (b) Input the CPCN or SSAN of the position and click the Submit 

Button 

 
   (c) The following confirmation notice will be displayed if the position 

was successfully added:   
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   (d) If the position already exists in the RIF Table, then the following 
message will be displayed 

     
   (e) If the employee already exists in the RIF Table, then the following 

message will be displayed 

     
   (f) If the position does not exist in DCPDS, the following message 

will be displayed:   

     
 
 i. Refresh position or employee data DCPDS – If the position or employee is 

already in the database and a refresh of the position or employee data is needed, it 
will be necessary to use the refresh capabilities within the Position Tab to refresh 
the data.  (Section F.2.c.) 

 
 j. Delete positions 
  (1) Due to the necessity of retaining historical data, deleting positions will be 

limited to those RIFs where Round 1 has not been processed.  If a position 
will not be used in the RIF competition, then it will need to be marked as 
Removed from RIF.   

  (2) Delete Selected Button – The Delete Selected Button allows the user to 
select one or more position from the Position/Employee Tab  

    
  (a) Select one or more positions in the Select Column 
  (b) Click the Delete Selected Button  
  (c) Delete Confirmation Notice:  The following confirmation notice 

will be displayed:   

    
   (d) If the users selects a position that has been abolished, the following 

notice will be displayed: 

    
  (3) Delete a position from the Position/Employee Tab using the Delete Button  
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  (a) Identify the position to be deleted 
  (b) Click the Delete Button associated with the position 

    
  (c) Delete Confirmation Notice:  The following confirmation notice 

will be displayed:   

    
 (4) Delete a position from the Edit Position/Employee Record using the 

Delete Button through the individual position screen (Section F.2.f.) 
  (5) A position that has been included in the RIF process in a previous iteration 

cannot be deleted.  If the position is no longer to be used in the RIF 
process, it should be marked as Remove from RIF.  (Section F.1.k. or 
F.2.i.) 

   (a) The following error message will be displayed: 

    
 
 k. Remove from RIF – The Remove from RIF functionality removes the position 

from RIF competition, but the position/employee remains in the RIF database.  
There are several ways to remove a position from the RIF.   

 (1) Users will not be able to mark the following positions as Remove from 
RIF: 

  (1) abolished positions 
  (2) Remove from RIF from the Edit Positions/Employee Tab 

(a) Select one or more position and select the Remove Selected Button 

 
   (b) Two required areas will become available 

     
    1. Reason Removed and 
    2. Removed Comment 
   (c) Using the drop down menu, select one of the reason(s) the 

position(s) is/are being removed 
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   (d) Add a comment (Effective 10/31/2010) in the Removed Comment 

Area 
   (e) Select the Apply Button 

     
   (f) The following Remove from RIF Confirmation Remarks will be 

displayed.  Select Yes to continue.  No to cancel 

   
   (g) If the user fails to input data in one or both of the Reason Removed 

or Removed Comment area, the following Error Message will be 
displayed:   

     
  (h) Abolished positions – if a position has been abolished and the user 

selects the position to be Removed from RIF, the following 
warning message will be displayed:   

 
  (3) Remove from RIF from the individual position/employee record.  (Section 

F.2.i.) 
 
 l. View position/employee errors 

STEP 9 – Correct Position/Employee Errors 

  (1) Show/Hide Link – The Show/Hide Link in the Details column on the 
Position/Employee Tab will display position and/or employee errors that 
have been found.   
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  (2) Position Errors – Position errors are also listed in the Position Data Errors 
Area on the Edit Position/Employee Page/Position Tab 

   
  (3) Employee Errors – Employee errors are also listed in the Employee 

Record Errors Area on the Edit Position/Employee Page/Employee Tab 

  
  (4) Warning/Error messages will not disappear from position/employee page 

until the error has been fixed and the Pre-Process Round 1 Button has 
been executed in the Process RIF Page.   

 
 
2. RIF Options Page – Edit Positions/Employees Tab – Position Tab 
 

a. General Information – RIF Overview Page – Edit Positions/Employee Tab – 
Position Tab 
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 (1) From this page, the user can do the following: 
  (a) Action Buttons: 
   1. Refresh a position/employee record from DCPDS 
   2. Copy an existing position 
   3. Manually add a Position 
   4. Delete a Position – only if the position has not been 

impacted in a previous iteration 
   5. Add to Abolish/Remove from Abolish – only available for 

encumbered positions.  The button will start as Add to 
Abolish and will switch to Remove from Abolish once a 
position has been marked as Abolish 

   6. Clear Employee Data – only available for encumbered 
positions 

   7. Cancel changes 
   (b) Edit position data 
    1. Required data elements (data elements are preceded with an 

*) 
     a. CPCN 
     b. Position Title 
     c. Pay Plan 
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     d. Grade 
     e. Occupational Series 
     f. Competitive Level Code 
     g. Position Occupied 
     h. Work Schedule 
     i. SOID 
     j. Organization 
     k. Geographic Location Code 
    1. If the user changes the Position Occupied, Work Schedule, 

Competitive Area Code, SOID, Organization Code, 
Geographic Location Code that will place the 
position/employee outside of the RIF Parameters, the 
following is a sample warning message that will be 
displayed upon clicking Pre-Process Round 1:   

  
 (2) All data elements shown on this page are populated with the data stored in 

the RIF Staging Table and DCPDS with the exception of Pattern 
Designation field and the GS Grade Equivalent (NSPS Positions Only) 

  (a) Pattern Designation is auto-populated for those Multiple Pattern 
RIFs when more than one value is selected in the Appraisal 
Information Page during the RIF creation, a new iteration or 
appraisal calculation process.  (Section C.2.a.) 

  (b) GS Grade Equivalent (NSPS Positions Only) 
   1. The GS Grade Equivalent (NSPS Positions Only) field is 

only required to be input when the GS Grade Equivalent 
Checkbox is selected in the RIF Options Page 

   2. Is only required for NSPS positions 
   3. Contains only the grade portion (13, 07) of the GS grade 

equivalency) 
   4. Used to determine GS grade equivalencies during Round 2 

competition. 
   5. Can be updated using a text file (Section F.1.g.) 
 

 b. Actions Buttons – The following actions buttons will only be available before 
Round 1 is processed or after a new iteration is begun.  The following are the 
conditions when a button will be available:   

  (1) Refresh Button –Will be available for all position/employee records 
  (2) Copy Button –Will be available for all position/employee records 
  (3) Add Button – Will be available for all position/employee records 
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  (4) Cancel – Will be available for all position/employee records 
  (5) Delete – Will be available for all position/employee records until Round 1 

is processed the first time.   
  (6) Add to Abolish Button – Will be available for all employees except 

Tenure 0, Removed from RIF, Armed Forces, 5CFR432 and 5CFR752 
Exceptions.   

  (7) Remove from Abolish Button – Will only be available for employees 
whose position have been marked as Abolish 

  (8) Clear Employee Data – Will only be available for encumbered positions 
that have not been marked as Abolish or Removed from RIF.   

 
 c. Refresh the current position or employee record 

Important Note 9:  Refreshing Position/Employee Data – (1) If the RIF has been processed 
through Round 1, the DCPDS RIF Tool is currently unable to reuse positions that were 
occupied in the RIF Table by one employee for placement of another employee (i.e., Employee 
A retires from Position 20.9999 and Employee B is promoted to that same position – Position 
20.9999).  It will be necessary to create a position with a different sequence number in DCPDS 
in order to add the vacant position to the DCPDS RIF Tool – Position 20.9998.  (2) During the 
refresh process, an employee whose tenure was changed or the Date Career Conversion Due 
was populated based on the VRA Conversion Due during the RIF creation will be reset.  The 
user will be required to manually change/update those values.   

  (1) There are four types of refresh.  Depending on the situation, the refresh 
process will be done in one of two ways – using the Refresh Button from 
the Position Tab or using the Add from DCPDS Button from the 
Position/Employee Tab.   

        
   (a) Refresh of position and/or employee data when the CPCN and 

Employee SSAN does not change 
    1. Click the Refresh Button 

  
    2. The following warning message will be displayed.  Click 

Yes to continue, No to return to the position page 
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    3. Once the refresh has completed the following message will 

be displayed: 

     
   (b) Refresh of a vacant position to add an employee not currently in 

the RIF Table.   
    1. Click the Refresh Button 

      
    2. The employee will be appended to the position 
    3. The following information message will be displayed after 

the refresh is complete: 

    
   (c) Refresh of an encumbered position in the RIF Table that is now 

vacant 
    1. If the position has not been processed through the RIF 

(Process Round 1 has not been accomplished), use the 
Refresh Button to clear the employee data.   

    2. If the RIF has been processed (Process Round 1 has been 
accomplished), then mark the position as Removed from 
RIF.  It will be necessary to create a position in DCPDS 
with a different sequence # in order for it to be brought into 
the RIF Table.  Use the Add from DCPDS function to bring 
in the vacant position. 

   (d) Movement of an employee from one position to another 
(promotion/reassignment) 

    1. If the RIF has not been processed (Process Round 
1/Iteration 1) has not been accomplished, then refresh both 
the old and new position.  If the new position is not in the 
RIF Table, then use the Add from DCPDS function 
(Section ##). 

    2. If the RIF has been processed (Process Round 1/Iteration 1) 
then: 
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     a. Mark the From position and employee record as 
removed from RIF. 

     b. If the From position will be used as a vacancy in the 
RIF, it will be necessary to create a position in 
DCPDS with a different sequence # in order for it to 
be brought into the RIF Table.  Use the Add from 
DCPDS function to bring in the vacant position.   

     c. If the To position is in the RIF Table, use the 
Refresh Button to bring in the employee. 

     d. If the To position is not in the RIF Table, use the 
Add from DCPDS function to bring in both the 
position and employee.   

 
 d. Copy a Position 
  (1) The user can “add” a position to the RIF database by using the Copy 

Button.   

Important Note 10:  Copy Position Function – If the user adds a CPCN that can be found in 
DCPDS using the Copy function, the refresh process will not work.  The Position ID of the 
position is needed to complete the refresh process and is only added to the RIF Table when the 
RIF is created or when using the “Add a Position from DCPDS” functionality.   

  (2) Enter the Edit Position/Employee Record Page by clicking the Edit button 
on any of the positions in the RIF and  

  (3) Click the Copy Button from within the Position Tab  

    
  (4) An identical position will be created, without the CPCN.  The user will 

need to input a unique CPCN (position number and sequence number). 

    
  (5) Once the CPCN has been input, click the SAVE Button  

    
  (6) To cancel the Copy function, click the Back to RIF Page Button 

    
  (7) Error/Warning Messages 
   (a) The following error message will be displayed if a duplicate CPCN 

is entered:   
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   (b) The following error message will be displayed if the user fails to 

input a CPCN:   

 
e. Add a Position Record 

  (1) The user can “add” a position to the RIF database by using the manually 
typing in all of the position data into the RIF Table.   

Important Note 11:  Add Position Function – If the user adds a CPCN that can be found in 
DCPDS using the Add function, the refresh process will not work.  The Position ID of the 
position is needed to complete the refresh process and is only added to the RIF Table when the 
RIF is created or when using the “Add a Position from DCPDS” functionality.   

 
  (2) To add employee data to a vacant position, see Section F.3.c. 
  (3) Enter the Edit Position/Employee Record Page by clicking the Edit button 

on any of the positions in the RIF and  
  (4) Click the Add Button 

    
  (5) All position data fields will open for input.  Those marked with an asterisk 

(*) are required fields.   
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  (6) Error/Warning Messages 
   (a) The following validation screen will be displayed if one or more of 

the required fields are missing when the Save Button is selected 

    
   (b) The following error message will be displayed if a duplicate CPCN 

is entered:   
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 f. Delete a Position 

  
 (1) Only those RIFs where Iteration 1 has not been processed will the user be 

able to delete positions.   
 (2) Select the Delete Button 
 (3) The following confirmation message will be displayed.   

  
 (4) The following message will be displayed if the user attempts to delete a 

position after Iteration 1 has been processed: 

  
 

 g. Add to Abolish/Remove from Abolish 
 (1) Only those positions that do not meet the following record conditions will 

be available to be abolished; 
  (a) Unencumbered Position 
  (b) Remove from RIF 
  (c) Temporary employees (Tenure 0) 
  (d) Armed Forces Restoration Right 
  (e) Final Written Decision of Removal Under 5CFR432 
  (f) Final Written Decision of Removal Under 5CFR752 
 (2) Once an employee record is marked as abolished, the Add to Abolish 

Button will change from Add to Abolish to Remove from Abolish.  See 
the following screen shots to show how the button changes depending on 
whether a position has or has not been abolished.   

   
 

 h. Clear Employee Data 
 (1) Only those RIFs where Iteration 1/Round 1 has not been processed will 

the user be able to clear employee data from positions.   
 (2) The Clear Employee Data Button will only be available for encumbered 

positions 
 (3) Clears all employee data from the record.   
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 (4) Clear Employee Data Button – To clear employee data from the position, 
click the Clear Employee Data Button 

   
 (5) The following confirmation message will be displayed 

   
 
 i. Remove from RIF 

  
 (1) The Remove from RIF Area will be available for all records except: 
  (a) Abolished records 
  (b) Temporary employees 
 (2) If the Removed from RIF checkbox is utilized, then a value must be 

selected from the Reason Removed from RIF LOV and comments must be 
entered in the Comments Area 

 (3) If the user attempts to exit the record without selecting a Reason or 
entering comments, the following message will be displayed:   

   
 (4) If the checkbox is deselected, then the Reason Removed and the 

comments will be deleted. 
 
 j. Position Data Errors 

 (1) Competitive Level 

    
 (2) User changed RIF Options on an individual position and the new value 

does not match the RIF Options set when the RIF was created and clicked 
Pre-Process Round 1 
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3. RIF Options Page – Edit Positions/Employees Tab – Employee Tab 
 
 a. General Information – RIF Overview Page – Edit Positions/Employee Tab – 

Employee Tab 
  (1) Encumbered Position 
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  (2) Unencumbered Position 

 
(3) From this page, the user can do the following: 

   (a) Edit employee data  
   (b) Manually add an employee to the RIF Table 
   (c) Identify certain employees that need special handling  
   (d) Edit employee appraisals 
 
 b. Editing Employee Data 

STEP 10 – Edit Employee Records 

  (1) Required data elements: 
   (a) First Name 
   (b) Last Name 
   (c) Social Security Number 
   (d) Appointment Type 
   (e) Tenure 



Section F – RIF Overview Page –                                                                                November 2011 
                    Edit Positions/Employees Tab 

Staffing:  RIF Tool                                                                               Mod 4, Chap 13, Page 97 

   (f) Veterans Preference for RIF Value 
   (g) SCD-RIF 
   (h) All other data elements may be updated manually or through the 

Refresh Process 
  (2) Automatic Changes to the employee record:  The following data elements 

will be automatically changed during the RIF creation process: 
   (a) Tenure 
    1. If Appt Type = 2A and Tenure = 2 and Date Conversion 

Career Due is prior to the effective date of the RIF, then the 
Tenure is automatically changed to 1 

    2. If Appt Type = 1A and Tenure = 2 and Date Probationary 
Period Ends is prior to the effective date of the RIF, then 
the Tenure is automatically changed to 1 

   (b) Date Conversion Career Due – If the Legal Authority Code = J8M 
and Date VRA Conversion Due is prior to the effective date of the 
RIF and the Date Conversion Career Due is null, then the Date 
Conversion Career Due will be automatically populated with the 
Date VRA Conversion Due plus one year.   

  (3) Editing Retention Factors 
   (a) Tenure and Seniority Area Changes – Changing the following data 

elements may change the Tenure and Seniority Area 
    1. Appointment Type/Tenure/Date Conversion Career 

Due/Date Probationary Period Ends 
     a. If Appt Type = 2A and Tenure = 2 and Date 

Conversion Career Due Date is prior to the effective 
date of the RIF, then the Tenure will automatically 
change to 1 

     b. If Appt Type – 1A and Tenure = 2 and Probationary 
Period End Date is prior to the effective date of the 
RIF, then the Tenure will automatically change to 1 

Important Note 12:  SCD Change – If the SCD-RIF is changed, the Adjusted SCD will not be 
recalculated until all errors have been cleared, at least one position abolished and the Pre-RIF 
Process Button is executed. 

    2. SCD-RIF – If the SCD-RIF is changed, the Adjusted SCD-
RIF will be recalculated when the Pre-Process RIF Button 
is selected in the Process RIF Tab.   

   (b) Tenure Tie Break Group Changes 
    1. If an employee is part of a group of employees with the 

same Tenure/Subgroup/Adjusted SCD and the tenure, VP-
RIF, SCD-RIF and/or appraisals are changed; this will 
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remove them from the current group and may place them in 
another group or place them in a 
Tenure/Subgroup/Adjusted SCD by themselves.   

    2. If the Tenure, VP-RIF, SCD-RIF or appraisals are changed, 
the following message will be displayed: 

     
 
 c. Manually adding an employee to the RIF 
  (1) Clicking the Add Employee Button, will open the employee fields.  Those 

identified with an “*” are required and must be input.   

    

Important Note 13:  Add Employee Function – If the user adds an employee using the Add 
Employee function, the refresh process will not work.  The Employee Number is needed to 
complete the refresh process and is only added to the RIF Table when the RIF is created or 
when using the “Add a Position from DCPDS” functionality.   
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  (2) Once all inputs have been made, click the SAVE Button.  
  (3) The following screen will be displayed if any of the required fields are not 

input.   
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 d. Additional Employee Information Area 
  (1) General Information – Additional Employee Information Area 
   (a) The Additional Employee Information Area is used to identify 

certain employees that need special handing during the RIF 
process.   

   (b) There are four fields associated with the Additional Employee 
Information Area: 

    1. Exception Type 
    2. Exception Reason 
    3. Exception End Date 
    4. Exception Reason 
  (2) Exception Type – There are four types of exceptions available in the 

Additional Employee Information Area: 
   (a) Final Written Decision of Removal Under 5CFR432 
   (b) Final Written Decision of Removal Under 5CFR752 
   (c) Armed Forces Restoration Right 
   (d) Mandatory/Permissive/Temporary Exception 
  (3) Exception Reason 
   (a) This field is only required if the Exception Type = 

Mandatory/Permissive/Temporary Exception 
   (b) Listed below are the different types of exceptions: 
    1. Mandatory Exception to the Regular Order of Release 

Based Upon Service in the Armed Forces 
    2. Mandatory Exception to the Regular Order of Release and 

the Use of Annual Leave to Obtain Retirement Benefits 
and/or to Continue Health Benefits 

    3. Mandatory Use of Annual Leave in Relocation Situations 
to Obtain Retirement Benefits and/or to Continue Health 
Benefits Coverage 

    4. Permissive Continue Exception to the Regular Order of 
Release 

    5. Permissive Temporary Exception to Satisfy a Government 
Obligation 

    6. Permissive Temporary Exception and Use of Sick Leave 
    7. Permissive Temporary Exception to the Use of Annual 

Leave to Obtain Retirement Benefits and/or Continue 
Health Benefits 

    8. Discretionary Temporary and Other Exceptions 
    9. Liquidation Exception 
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  (4) Exception End Date – Only required if the Exception Type = 
Mandatory/Permissive/Temporary Exception 

   (a) This field is required if the Exception Reason is not null 
   (b) This date is auto-populated into the Exception Date on the RIF 

Options Page 
   (c) If more than one employee has an exception date, then the latest 

date is auto-populated 
  (5) Exception Remarks – This field is required only when the Exception 

Reason = Mandatory Exception to the Regular Order of Release Based 
Upon Service in the Armed Forces.   

  (6) Employees Requiring Special Handling 
   (a) Final Written Decision of Removal Under 5CFR432 
    1. Not included on Retention Registers 
    2. Not included in the RIF Process 
    3. Not included in the Appraisal Calculation Process 
    4. Not included in the EEO Statistical Reports 
    5. Are included in the RIF Table only to document their 

removal 
    6. Will not have the ability select the Abolish or Remove from 

RIF Buttons 
    7. Final Written of Removal Decision Under 5CFR432 or 

5CFR752 Report 
   (b) Final Written Decision of Removal Under 5CFR752 
    1. Not included on Retention Registers 
    2. Not included in the RIF Process 
    3. Not included in the Appraisal Calculation Process 
    4. Not included in the EEO Statistical Reports 
    5. Are included in the RIF Table only to document their 

removal 
    6. Will not have the ability select the Abolish or Remove from 

RIF Buttons 
    7. Final Written of Removal Decision Under 5CFR432 or 

5CFR752 Report 
   (c) Armed Forces Restoration Right  
    1. Not included on Retention Registers 
    2. Not included in the RIF Process 
    3. Not included in the Appraisal Calculation Process 
    4. Not included in the EEO Statistical Reports 
    5. Are included in the RIF Table only to be able to run reports 



Section F – RIF Overview Page –                                                                                November 2011 
                    Edit Positions/Employees Tab 

Staffing:  RIF Tool                                                                               Mod 4, Chap 13, Page 102 

    6. Will not have the ability select the Abolish or Remove from 
RIF Buttons 

    7. Armed Forces Restoration Right Report 
   (d) Mandatory/Permissive/Temporary Exception except Mandatory 

Exception to the Regular Order of Release Based Upon Service in 
the Armed Forces 

    1. Exception End Date is required 
    2. Exception Remarks is optional 
   (e) Mandatory Exception to the Regular Order of Release Based Upon 

Service in the Armed Forces 

    
    1. Exception End Date is required 
    2. Exception Remark is required 
    3. If the exception end date is after the effective date of the 

RIF, the employee must be moved to the beginning of the 
tenure and subgroup regardless of Adjusted SCD.  All 
employees within the tenure subgroup must be separated 
from the competitive level before an employee marked with 
this exception can be separated from the competitive level 
(both Round 1 and Round 2). 

    4. If the exception end date is after the effective date of the 
RIF, and there is more than one employee within a 
competitive level with this exception, then all employees 
with this type of exception are moved to the beginning of 
the tenure and subgroup and listed in Adjusted SCD order 
and then followed by all other employees without this type 
of exception (both Round 1 and Round 2).  

    5. Round 2 Competition – If the exception date is after the 
effective date of the RIF, then employees with this type of 
exception cannot be separated from Round 2.  They can be 
reassigned or change to lower grade, but cannot be 
separated.  The Separate Button will be replaced with a 
ByPass Button in Round 2.   

    6. Will have the ability select the Abolish or Remove from 
RIF Buttons 

    7. Mandatory/Permissive/Temporary Exception Report 
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 e. Performance Appraisal Information Area 

Important Note 14:  Appraisal Changes (1) – Changes made to appraisals (additions, 
deletions, changes) will require a complete recalculation of all appraisals within the database.  
The recalculation will be accomplished when the Pre-RIF Process Button is executed, 
provided all position/employee errors are corrected and at least one position abolished, as well 
as when a new iteration is executed.   

 

Important Note 15:  Appraisal Changes (2) – Any changes made to appraisals (additions, 
deletions, changes) within the DCPDS RIF Tool will be lost if the user refreshes the 
appraisals within the Edit Appraisals Page or if the user answers Yes during the Pre-Process 
phase or New Iteration.   

  (1) Manual Update of Appraisals – Appraisals may be manually updated by 
adding/editing/removing appraisals by accessing the Edit Appraisals Page 
using the Update Appraisal Button. 

    
  (2) Edit Appraisals Page 

    
 
   (a) Add Appraisals  
    1. To add an appraisal, click on the Add Appraisal Button. 
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    2. The Add Appraisal Page will appear 

  
     a. All data elements are required  
     b. Appraisal pattern and ratings must meet the 

following combinations: 
      (1) Pattern A – Rating 1 or 3 
      (2) Pattern B – Rating 1, 3 or 5 
      (3) Pattern C – Rating 1, 3 or 4 
      (4) Pattern D – Rating 1, 2 or 3 
      (5) Pattern E – Rating 1, 3, 4 or 5 
      (6) Pattern F – Rating 1, 2, 3 or 5 
      (7) Pattern G – Rating 1, 2, 3 or 4 
      (8) Pattern H – Rating 1, 2, 3, 4 or 5 
     c. Validation of appraisal pattern/ratings will only take 

place during Pre-Process Round 1.  If errors are 
found 

     d. Appraisal calculations will take place once the Pre-
Process Round 1 Button is executed, provided there 
are no errors in position/employee records and there 
is at least one position abolished.   

     e. Click the Save Button to save changes 

       
     f. Once the changes are made, the user is 

automatically directed back to the Edit Appraisal 
Page. 

   (b) Remove Appraisals 

Important Note 16:  Remove Appraisal – There is no confirmation message warning the user 
that the appraisal will be removed from the record  

    1. To remove an appraisal from an employee record, select the 
record by clicking in the Select Column next to the 
employee record and clicking the Remove Appraisal 
Button 
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   (c) Refresh Appraisals 
    1. To refresh appraisals, click the Refresh Appraisal Button 

      
    2. Any changes made to the employee record in DCPDS will 

be reflected in the refresh 
    3. Any changes made to the employee record in the DCPDS 

RIF Tool that has not been made to the employee record in 
DCPDS will be lost.   

    4. Refreshing appraisals will result in the appraisal points and 
the average assigned points being removed from the 
employee record.  The Pre-Process Round 1 process will 
recalculate appraisals.   

   (d) Update Appraisals 
    1. To update individual appraisals within the tool, click the 

Update Button associated with the appraisal to be updated 

     
   2. The user will be directed to the Update Appraisal Page 

 
    3. Make the appropriate changes and click the Save Button. 

      
    4. Once the changes have been saved, the user will be 

automatically directed back to the Edit Appraisal Page 
    5. If the user attempts to add an appraisal with the same 

effective date the following error message will be 
displayed: 
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    6. To return to the Appraisal Page without making any 

changes, click either the Cancel Button or the Back to 
Position/Employee Page Button 

          
 
 f. Employee Record Error/Warning Area 

 
  (1) Reviewed Checkbox 
   (a) This checkbox will be used to indicate that the employee record 

has been reviewed and/or updated by the user. 
   (b) There are no business rules associated with this checkbox. 
   (c) If the error/warning is changed to no longer meet the warning/error 

condition, the record will be unchecked during Pre-Process Round 
1. 

  (2) Error/Warning Messages 
   (a) Error:  If Appointment Type = 2A and Tenure = 2 and Date 

Conversion Due is null or greater than 3 years from current date 

     
   (b) Error:  If Appointment Type = 1A and Tenure = 2 and Date 

Probationary Period Ends is null or greater than 1 year from 
current date.   

     
   (c) Appointment Type Null:  Validation Error 

     
   (d) Error:  VP-RIF Value 
    1. VP-RIF is null 

      
    2. VP-RIF does not equal 1-6 

      
   (e) Error:  Appraisal Pattern and Agency Rating are incompatible 
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   (f) Warning:  SCD-RIF is greater than SCD-LV 

     
 g. Tenure and Seniority Area – The Tenure and Seniority Area are auto-populated 

from other areas of the employee record.  The Tenure and Subgroup are 
automatically changed when changes are made to the employee record.  The 
Adjusted SCD is recalculated when the Pre-Process Round 1 Button is executed 

  (1) Tenure Group – uses the following combinations to change existing 
Tenure Group  

   (a) Appointment Type 2A and Tenure 2 and Date Conversion Due is 
equal to or less than effective date of RIF – change tenure to 1. 

   (b) Appointment Type 1A and Tenure 2 and Date Probationary Period 
Ends is equal to or less than effective date of RIF – change tenure 
to 1 

  (2) Subgroup – uses the value found in Veterans Preference RIF Value to 
determine the Subgroup 

   (a) Subgroup AD – Veterans Preference RIF Value = 6 
   (b) Subgroup A – Veterans Preference RIF Value = 2 – 5 
   (c) Subgroup B – Veterans Preference RIF Value = 1 
  (3) Adjusted SCD – The Adjusted SCD is automatically calculated by 

subtracting the appraisal points from the year portion of the SCD-RIF.   
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Section G – RIF Overview Page –  
RIF Process Tab 

 
 
Section Description Page # 
1. General Information – RIF Overview Page – RIF Process Tab 111 
 a. User can do the following 111 
 b. RIF Status 111 
 c. Minimally Acceptable Employees 113 
 d. Unsatisfactory Employees 113 
 e. Allow Intervening Displacement Actions 113 
 f. View Lowest Tenure for Each Competitive Level 114 
2. Edit Tenure Tie Breaks 114 
 a. General Information – Tenure Tie Break 114 
 b. Editing Tenure Tie Breaks 114 
3. Change Options 116 
 a. General Information – Change Options 116 
 b. Changing RIF Options 116 
4. Pre-Process Round 1 118 
 a. General Information – Pre-Process Round 1 118 
 b. Pre-Process Round 1 Button 118 
5. Process Round 1 119 
 a. General Information – Round 1 119 
 b. Process Round 1 Button 120 
 c. Round One Report 120 
6. Adjust Round 1 121 
 a. General Information – Adjust Round 1 121 
 b. Adjust Round 1 Button 121 
 c. No changes available 122 
 d. Change a placement from one vacancy to another 122 
 e. Switch vacancies between two employees 123 
 f. Change placement and by-pass a vacant position or lower retention 

standing employee 
124 

 g. No Placement (Release from CL) 125 
 h. Intervening Displacement Actions 126 
 i. View/Edit/Clear All Placement Exceptions 127 
 j. Finish Adjust Round One 127 
7. Pre-Process Round 2 128 
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Section Description Page # 
 a. General Information – Pre-Process Round 2 128 
 b. Missing Representative Rates 129 
 c. Missing Lines of Progression 129 
8. Process Round 2 130 
 a. General Information – Process Round 2 130 
 b. RIF Action Button 133 
 c. Assignment Right 134 
 d. Alternate Offer 137 
 e. Set Exception or View/Delete Exception Button 139 
 f. By-Pass Button 140 
 g. Separate Button 141 
 h. Round 2 Complete 141 
9. Final Adjustments 142 
 a. General Information – Final Adjustments 142 
 b. Processing Final Adjustments 143 
10. New Iteration 145 
 a. General Information – New Iteration 145 
 b. Starting a New Iteration  145 
 
Steps Description Page # 
11 Edit Tenure Tie Breaks 114 
12 Pre-Process Round 1 118 
13 Process Round 1 119 
14 Adjust Round 1 121 
15 Pre-Process Round 2 128 
16 Process Round 2 130 
17 Final Adjustments 142 
18 New Iteration 145 
 
 
Notes Important Notes Page # 
17 Change Options 116 
18 Alternate Offer 137 
19 Excepted Service and Term Only RIFs 143 
20 Retaining Manual Changes to Appraisals 146 
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1. General Information – RIF Overview Page – RIF Process Tab 
 

 
a. From this page, the user can do the following: 

  (1) Edit Tenure Tie Breaks  
  (2) Process the RIF – depending on where the user is in the process, different 

buttons will become available. 
 
 b. RIF Status – The following is a list of the RIF Status 
  (1) RIF Not Started 

  
   (a) User has not begun the RIF process or  
   (b) Errors still need to be resolved or no positions have been abolished 

or user selected No when asked “Do you wish to start processing 
Round 1?” after previously selecting the Pre-Process Round 1 
Button or the user selected New Iteration – Step 1 Button/New 
Iteration Step 2 – Button.   

   (c) Buttons Available 
    1. Pre-Process Round 1 Button 
    2. Change Options Button 
  (2) Ready to Begin Processing Round 1 
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   (a) All errors have been resolved, at least one position has been 

abolished and the user selected Yes when asked “Do you wish to 
start processing Round 1?” after selecting the Pre-Process Round 1 
Button 

   (b) Buttons Available – Process Round 1 Button 
  (3) Ready to Adjust Round 1 

  
   (a) Round 1 is complete and the user is ready to begin adjusting 

Round 1 or has made changes in the Adjust Round 1 Page, but has 
not yet selected the Finish Adjust Round One Button 

   (b) Buttons Available 
    1. Round One Report 
    2. Adjust Round 1 
    3. New Iteration – Step 1 
  (4) Ready to Begin Processing Round 2 

  
   (a) User has finished adjusting Round 1 by selecting the Finish Adjust 

Round One Button but not yet selected the Pre-Process Round 2 
Button 

   (b) Buttons Available 
    1. Pre-Process Round 2 
    2. New Iteration – Step 1 
  (5) Processing Round 2 
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   (a) Pre-Process Round 2 is complete (all representative rates have 
been entered and at least one line of progression has been entered) 
and the user is ready to begin processing Round 2. 

   (b) Buttons Available 
    1. Process Round 2 
    2. New Iteration – Step 1 
  (6) Processing Final Adjustments 

  
   (a) Process Round 2 is complete (all impacted employees have either 

been placed or separated) and the user has not selected the Finish 
Final Adjustments Button 

   (b) Buttons Available 
    1. Final Adjust Button 
    2. New Iteration – Step 1 
  (7) RIF Complete 

  
   (a) Final Adjustments is complete 
   (b) Buttons Available – New Iteration – Step 1 
 
 c. Minimally Acceptable Employees – Employees with a current annual 

performance rating of minimally successful rating (Summary Level Rating = 2) is 
only allowed to retreat to other employees with a minimally successful rating or 
below during Round 2. 

 
 d. Unacceptable Performance Rating – Employees with a current annual 

performance rating of unacceptable (Summary Level Rating = 1) who is separated 
in Round 1, does not compete in Round 2 – when the employee is reached for 
placement/separation, the employee will be automatically separated from Round 
2.   

 
 e. Allow Intervening Displacement Actions – If the Allow Intervening 

Displacement Actions Checkbox is selected on the RIF Options Page and there 
are both Tenure II and Tenure III employees within the competitive level, then 
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special processing will take place.  During Round 1 processing, Tenure I 
employee will automatically displace the Tenure II employee and the Tenure II 
employee will displace the Tenure III.  During Round 2 processing, if a Tenure I 
employee is being considered for placement, and there are Tenure II and Tenure 
III within a competitive level, only the lowest Tenure II employee will be 
displayed if the View the Lowest Tenure Option for each Competitive Level is 
checked on the RIF Options Page.  If the Tenure I is placed in the Tenure II 
position, a message will be displayed notifying the user that there are Tenure III 
employees in the competitive level.  When the Tenure II employee is reached for 
placement, a review of the Tenure III’s position must be made to determine 
whether this position is considered an available position or whether the position 
offer would be in lieu of separation.   

 
 f. View the Lowest Tenure Option for each Competitive Level – If the View the 

Lowest Tenure Option for each Competitive Level Checkbox is selected, then 
only the lowest retention standing employee is visible during Round 2.  
Exception:  If the Allow Intervening Displacement Actions Checkbox is selected, 
then for Tenure I employees, if there are Tenure II and Tenure III employees 
within a competitive level, only the Tenure II employee is visible.  If the Tenure 
II employee is selected, then the Tenure II is automatically placed in the Tenure 
III position  

 
 
2. Edit Tenure Tie Breaks 

STEP 11 – Edit Tenure Tie Breaks 

 
 a. General Information – Edit Tenure Tie Breaks 
  (1) When the RIF is created, the DCPDS RIF Tool assigns a random number 

to all employees whose tenure/subgroup/adjusted SCD is tied.  
Employee’s retention standing will be determined based on the random 
number when they have the same Tenure and Adjusted SCD.   

  (2) Users can change the sort order based on individual component or RIF 
competitive area policies.   

 
 b. Editing Tenure Tie Breaks 
  (1) Click the Edit Tenure Tie Breaks Button 
  (2) User will be directed to the Tenure Tie Break Page 
  (3) The user will have the capability to searching/sort by the Tenure or Tenure 

Date 
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  (4) Click the Competitive Level Area to show the employees where the tenure 

is tied 

    
  (5) Select the first employee (Employee1) and identify the stack order (2), the 

employees are automatically shuffled based on the selection.   
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  (6) Tenure Tie Break Comments Area 
   (a) It is recommended that if the tenure tie break stack order is 

changed that comments are provided to document what criteria 
was used to change the order 

   (b) Comments are auto-populated into the RIF Options Page 

     
 
 
3. Change Options 

  

Important Note 17:  Change Options – (1) The Change Options Button is only available prior 
to running Iteration 1/Round 1.  (2) Using the Change Options Button allows the user to 
change RIF data parameters.  Depending on the changes made, there is the potential of 
adding or removing positions/employees from the database.  (3) Removes the abolish status 
from all employees and removes any information entered in the Additional Employee Status.   

 a. General Information – Change Options 
  (1) The Change options Button allows the user to make changes to the RIF 

Data Parameters prior to beginning processing the RIF.  This button will 
only be available prior to running Iteration 1/Round 1.  Once a new 
iteration is started, the Change Options Button is no longer available.   

  (2) Warning:  Using the Change Options Button allows the user to change RIF 
data parameters but will remove all positions from abolish status.   

 
 b. Change RIF Options 
  (1) Click the Change Options Button 
  (2) The following confirmation message will be displayed.  Click Yes to 

continue.  Click No to return to the Process RIF Page 

   
  (3) The user will be directed to the RIF Options Tab, if they selected Yes.  

Make the appropriate changes and Click the Recreate Button.   
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  (4) The following confirmation message will be displayed.  Click Yes to 

refresh appraisals from DCDPS.  Otherwise click No. 

   
  (5) The user will be directed to the Appraisal Information Page.  Make any 

necessary change (if needed) and click the Calculate Single/Multiple 
Pattern Appraisal Points Button. 
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4. Pre-Process Round 1 

  

STEP 12 – Pre-Process Round 1 

 a. General Information – Pre-Process Round 1 – Pre Process Round 1 validates 
position/employee records to ensure there are no errors and there is at least one 
position that has been abolished.  Once all errors have been corrected and there is 
at least one position abolished, then appraisal calculations will take place.   

 
 b. Pre-Process Round 1 
  (1) If the Pre-Process Round 1 Button is selected and errors are found or no 

positions have been marked as abolished, the user is directed to the 
Process Log Page (Section H.3.a.) and identifies the type of errors found. 

  
  (2) If the Pre-Process Round 1 Button selected and there is at least one 

position abolished and no errors are found: 
   (a) A Progress Clock will be visible while the system checks for errors 

and abolishments.   
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   (b) User is directed to the Appraisal Information Page (Section 
C.2.a.).  Click either the Calculate Single Pattern Appraisal Point 
Button or Calculate Multiple Pattern Appraisal Point Button. 

    
   (c) Upon clicking the Calculate ________Appraisal Points: 
    1. A Progress Clock will be visible while system performs the 

appraisal calculation 

     
    2. Once the appraisal calculations have been completed, the 

following confirmation message is displayed:   

    
   (d) Click Yes to start processing Round 1.   
    1. The user is directed to the Process RIF Page (Section G.5.)  
    2. Process Round 1 Button and Change Options Buttons are 

available.   

      
    3. RIF Status reads Ready to Begin Processing Round 1  
 
 
5. Process Round 1 

 

STEP 13 – Process Round 1 

 a. General Information – Process Round 1 
  (1) The purpose of Round 1 is to determine which employees will compete in 

Round 2 competition.  Round 1 will only take place for those competitive 
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levels that contain an employee’s whose position has been abolished.  
Round 1 competition will take the highest ranking employee and place 
them in vacancies first, and then the lowest ranking employee. 

   (a) Exceptions: 
    1. Mandatory Exception Based on Services in the Armed 

Forces with an exception date past the effective date of the 
RIF – cannot be impacted as long as there are employees in 
the same Tenure/Subgroup within the competitive level – 
they float to the top of the Tenure/Subgroup even though 
they have a lower Adjusted SCD.   

    2. Intervening Displacement 
     a. Allow Intervening Displacement? Checkbox is 

selected on the RIF Options Page:  If a competitive 
level contains Tenure I, Tenure II and Tenure III 
employees, a Tenure I employees will displace 
Tenure II employees and the Tenure II will 
automatically displace the Tenure III employee.   

     b. Allow Intervening Displacement? Checkbox is not 
selected on the RIF Options Page:  The Tenure I 
displaces the Tenure III.   

  (2) Once all errors are corrected and at least one position has been abolished, 
the Process Round 1 Button and Change Options Buttons become 
available.   

  (3) The user will not be able to update/change any position/employee 
information after Process Round 1 Button is clicked until a new iteration 
has taken place.   

 
 b. Process Round 1 Button 
  (1) Click the Process Round 1 Button to begin processing Round 1.   
  (2) While Round 1 is processing a Progress Clock will be displayed 

    
  (3) Once Round 1 has been completed, the following buttons are available: 

    
  (4) RIF Status changes to Ready to Adjust Round 1 
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 c. Round One Report  
  (1) The Round One Report shows all placement actions made during Round 1 
  (2) This report can be viewed when Round 1 is complete or by accessing the 

Round 1 Report in the Reports Area 
  (3) To view/save the report Click the Round One Report and Click Open or 

Save.   

 
 
 

6. Adjust Round 1 

STEP 14 – Adjust Round 1 

 a. General Information – Adjust Round 1 
  (1) The purpose of Adjusting Round 1 is to allow the user to change 

placements made during Round 1.   
  (2) The Adjust Round 1 Button will become available immediately after 

processing Round 1 provided the Round 1 Option – Allow Displacement 
Exceptions? Checkbox was selected in the RIF Options. 

  (3) Component policy will dictate whether this option is allowed.   
 
 b. Adjust Round 1 Button 

   
  (1) The Adjust Round 1 Button directs the User to the Adjust Round 1 Page 
  (2) Adjust Round 1 Page displays only those competitive areas that were 

impacted during Round 1 competition 
  (3) From the Adjust Round 1 Page, the user can do the following: 
   (a) Make changes to placements made during Round 1 
   (b) Switch the placements of two employees between two vacancies 
   (c) Separate an employee from the competitive level 
   (d) View the employee history report 
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 c. No changes available – The following are screenshots show when there are no 

placement changes that are available 
  (1) Only one employee within the competitive level 

 
  (2) Lowest retention standing employee was abolished 

 
 
 d. Change a placement from one vacancy to another 

  
  (1) Click the employee record to change placement 
  (2) Click the new position 
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  (3) Click the New Placement Button 
  (4) The following Confirmation Message will be displayed.  Click Yes to 

continue, No to return to the Adjust Round 1 Page 

   
  (5) Employee’s placement changed from 35776.99999 to 35776.99998 

 
 
 e. Switch vacancies between two employees – Allows the user to switch 

placements of two employees between two vacancies.  

    
  (1) Select one of the employees that will be participating in the swap. 
  (2) In the Vacancy Switch Column, click the two positions that will be 

swapped.   
  (3) Click the Switch Vacancy Button 
  (4) The following Confirmation Message will be displayed.  Click Yes to 

continue, No to return to the Adjust Round 1 Page 
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 f. Change placement and by-pass a vacant or lower retention standing 

employee 

 
  (1) Click the employee record to change placement 
  (2) Click the new position 
  (3) Click the New Placement Button 
  (4) The following Confirmation message will be displayed.  Click Yes to 

continue.  No to return to the Adjust Round 1 Page 

    
  (5) Placement Exception Page – user will be directed to the Placement 

Exception Page.  An exception remark box will be displayed for each 
position that is below retention standing of the retention standing of the 
new employee.  The box will be auto-populated with the following remark 
for each position below the employee’s current retention standing and the 
new position selected:  Adding the Placement Exception on abolished 
position (Impacted Position) to displacement position (position being by-
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passed).  The user can input addition remarks if necessary.  Once all 
remarks have been input, click Save and Return. 

 
  (6) Impacted employee now shows being placed in the new position 

 
 
 g. No Placement (Release from CL) 

 
  (1) Click the employee record to release from the CL 
  (2) Click the No Placement (Release from CL) Button 
  (3) Confirmation Message.  Click Yes to continue.  No to return to the Adjust 

Round 1 Page 

     
  (4) Placement Exception Page – user will be directed to the Placement 

Exception Page.  An exception remark box will be displayed for each 
position that is below retention standing of the retention standing of the 
selected employee.  The box will be auto-populated with the following 
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remark for each position below the employee’s retention standing:  
Adding the Placement Exception on abolished position (Impacted 
Position) to displacement position (position being by-passed).  The user 
can input addition remarks if necessary.  Once all remarks have been 
input, click Save and Return. 

  
  (5) The employee is now separated from the competitive level 

 
 
 h. Intervening Displacement Actions 
  (1) If the Intervening Displacement Checkbox is selected from the RIF 

Options and there is a Tenure I, Tenure II and Tenure III employee within 
the same competitive level and the Tenure I position is abolished, then the 
Tenure I will automatically displace the Tenure II, the Tenure II will 
automatically displace the Tenure III and the Tenure III will be separated 
from Round 1. 
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 i. View/Edit/Clear All Placement Exceptions 

 
  (1) When a placement exception has been used, the View/Edit and Clear All 

Buttons will appear in the Placement Exceptions column 
  (2) To View/Edit placement exceptions, click the View/Edit Button to show 

the placement exceptions for the impacted employee 
   (a) Remarks Area 

 
   (b) Delete an Exception – To delete an exception, click the Delete 

Button next to the Remark Area.  Note:  There is no confirmation 
message that will display.  Note:  If there is only one exception, 
use the Clear All instead of the Delete Button.  This will allow the 
user to reinstate the exception if necessary.   

   (c) Cancel and Return Button 

     
   (d) Save and Return Button 

     
 
  (3) Clear All Button 
   (a) Clears all exceptions for the impacted individual 
   (b) The following confirmation message will be displayed 

    
   (c) Exceptions are now cleared 

 



Section G – RIF Overview Page – RIF Process Tab                                                       November 2011 

Staffing:  RIF Tool                                                                               Mod 4, Chap 13, Page 128 

  (4) RIF History Button – directs the user to the RIF History Report (Section 
H.1.) 

    
 
 j. Finish Adjust Round One 

   
  (1) Once all placement changes have been made, select the Finish Adjust 

Round One Button 
  (2) The following Confirmation Message will be displayed:  Click Yes to 

continue.  Click No to return to the Adjust Round 1 Page 

    
 
 
7. Pre-Process Round 2 

STEP 15 – Pre-Process Round 2 

 a. General Information – Pre-Process Round 2 
  (1) The Pre-Process Round 2 Button will only be available when there are 

missing representative rates and/or lines of progression. 
  (2) The Pre-Process Round 2 Button looks first at missing representative rates 

and then at missing lines of progression.  An entry is made into the 
Process Log when there are missing representative rates or lines of 
progression.   
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 b. Missing Representative Rates: 
  (1) When selecting the Pre-Process Round 2 Button, if there are missing or 

invalid representative rates, the following Confirmation message will be 
displayed:   

    
   (a) Clicking Yes directs the user to the RIF Overview 

Page/Representative Rates Tab (Section E.1.a.). 
   (b) Clicking No will stop the process and return the user to the Process 

RIF Tab 
  (2) Once all Representatives Rates have been entered, return to the Process 

RIF Tab and begin process Round 2. 
 
 c. Missing Lines of Progression 
  (1) When selecting the Pre-Process Round 2 Button, if there is not at least one 

line of progression that has been entered, the following Confirmation 
message will be displayed: 

    
   (a) Clicking Yes directs the user to the RIF Overview Page/Lines of 

Progression Tab (Section E.2.a.).   
   (b) Clicking No will stop the process and return the user to the Process 

RIF Tab 
  (2) Once at least one line of progression has been entered, return to the 

Process RIF Tab and begin to process Round 2. 
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8. Process Round 2 

STEP 16 – Process Round 2 

   

   
 
 a. General Information – Process Round 2 
  (1) The purpose of Round 2 is to place employees separated from Round 

1/Adjust Round 1 or to place those employees impacted during Round 2 
by a higher ranking employee.  Positions available during Round 2 will be 
based the employee’s retention standing, lines of progression and 
representative rates.   

  (2) Exceptions to the normal processing of Round 2 are as follows:   
   (a) Unacceptable Employees – Unacceptable employees separated 

from Round 1 and those impacted during Round 2 are 
automatically separated from Round 2. 
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   (b) Tenure 3 Employees – Tenure 3 employees separated from Round 
1 and those impacted during Round 2 are automatically separated 
if the Allow Administrative Assignment Rights?/Competitive 
Service – Bumping Rights for the Tenure III Employees Checkbox 
is not checked on the RIF Options Page. 

   (c) Intervening Displacement 
    1. Allow Intervening Displacement? Checkbox Selected – If 

the Allow Intervening Displacement? Checkbox is selected, 
and the View Lowest Tenure Option for each Competitive 
Level? Is Checked on the RIF Options Page and a 
competitive level contains both Tenure II and Tenure III 
employees, a Tenure I employees will only see the Tenure 
II employees in the list of available positions.   

     a. If the user selects a competitive level with both 
Tenure II and Tenure III employees and selects a 
Tenure II employee for displacement, the following 
confirmation will be displayed notifying the user 
that the CLC contains a Tenure III employee and 
further review will need to take place to determine 
whether the Tenure III position is considered an 
available position or an in lieu of separation for the 
Tenure II employee.   

    
     b. When the Tenure II is reached for impact during 

Round 2, an information message will be displayed 
notifying the user that there is a Tenure III 
employee within the same CLC.  Review the 
expiration of the Tenure III position to determine if 
the Tenure III position is considered an available 
position or an in lieu of separation offer.  If the 
position is considered an in lieu of separation offer 
and there are no other positions that can be used as 
a available position, separate the employee and 
make the placement in Final Adjustments.   
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    2. Allow Intervening Displacement? Checkbox is not selected 

on the RIF Options Page:  The Tenure I displaces the 
Tenure III.   

   (d) Mandatory Exception Based on Services in the Armed Forces with 
an exception date past the effective date of the RIF. 

    1. Separated from Round 1 and competing in Round 2 can be 
reassigned or changed to lower grade but cannot be 
separated.  The Separate Button in Round 2 will show as 
By-Pass.   

    2. Available for Impact in Round 2 – cannot be impacted as 
long as there are employees in the same Tenure/Subgroup 
within the competitive level – they float to the top of the 
Tenure/Subgroup even though they have a lower Adjusted 
SCD.   

  (3) Once all representative rates have been entered and at least one line of 
progression has been entered, the Process Round 2 Button will appear.   

    
  (4) User is directed to the Process Round 2 Page after clicking the Process 

Round 2 Button from the Process RIF Tab 
  (5) The first time the user enters the Round 2 Page or after a New Iteration, all 

employees separated from Round 1/Adjust Round 1 will be shown for 
placement in Round 2 in retention standing order. 

  (6) RIF History Button – directs the user to the RIF History Report (Section 
H.1.) 

    
  (7) Use the RIF Action Button to begin Round 2 placement 
  (8) Shows all employee separated from Round 1/Adjust Round 1 in retention 

standing order (highest to lowest) 
  (9) The RIF Action Button will only be available for the highest retention 

standing employee.  Once a RIF Action has taken place on the highest 
retention standing employee, that employee will be removed from the list 
and the RIF Action Button will move to the next highest retention standing 
employee 

  (10) Competitive Service RIF:  Does not include term employees unless the 
Allow Administrative Assignment Rights button was selected 
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  (11) Excepted Service RIF:  Round 2 will not be available for excepted service 
RIFs, unless the Allow Administrative Assignment Rights Button for 
excepted service employees was selected 

  (12) RIF Statistics Area – shows current information 
   (a) Current SSAN – shows the SSAN of the current employee that a 

RIF placement decision needs to be made 
   (b) # Left to Process – changes as placement are made 
 
 b. RIF Action Button 

   
  (1) General Information – RIF Action Button 
   (a) User will be directed to the Round 2 RIF Action Page 
   (b) All available positions within the employee’s RIF assignment right 

will be displayed in the Available Positions Area beginning with 
positions at the employee’s current grade.   

   (c) If no lines of progression have been entered for the impacted 
position, the user will be directed to the Add Lines of Progression 
Page.   

  
    1. Lines of Progression values will be auto-populated based 

on the pay plan and grade combination; however, the user 
may make changes as appropriate.   

    2. Save Button – Once all changes have been made click 
Save.  User will be directed back to the Round 2 Page.   

     . 
    3. Cancel Button – Cancel Button will direct the user back to 

the Process Round Two Page.  Until the Lines of 
Progression have been updated, the user will not be able to 
continue processing Round 2.   
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   (d) All positions within the lines of progression/representative rates 
will be visible on the page.  Highest to lowest representative rate 
and lowest to highest retention standing order.  If the user selected 
View Lowest Tenured Employee within the Competitive Level, 
then only the lowest retention standing employee within each 
competitive level will be visible.   

   (e) Vacancies will be shown first in PP-SRS-GR-CLC order followed 
by encumbered positions in reverse retention standing order 
(lowest to highest).   

   (f) Positions below the employee current grade will be grouped by 
representative rate with vacancies first and then encumbered 
positions.   

   (g) Type of Offer – there are two types of offers: 
    1. Assignment Right – default value 
    2. Alternate Offer – This option will only be available if the 

Use Alternate Offer? Checkbox has been selected in the 
RIF Options Page.   

  

   
 
 c. Assignment Right 
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  (1) Available Positions – Positions (vacant or encumbered) with the same or 
lower representative rate within the lines of progression will be visible 
under the Available Positions Area of the Round 2 Page.   

  (2) Select the Type of Offer – Assignment Right/Alternate Offer.   
  (3) If the Use Alternate Office? Checkbox has not been selected in the RIF 

Options Page, then the Type of Offer will be grayed out and only an 
Assignment Right will be allowed.   

    
  (4) A position must be selected as an Assignment Right before positions will 

be available for selection for an Alternate Offer  
  (5) Select the position by using the radio button next to the position to be used 

as an Assignment Right and click the RIF Assignment Right Button 

    

   
  (5) The following Confirmation Message will be displayed.  Click Yes to 

continue, Click No to return to the Round 2 Page. 

    
  (6) A screen will appear that shows the position identified as the RIF 

Assignment Right. 
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  (7) No Alternate Offer being made 
   (a) Use Alternate Offer? Checkbox is selected: 
    1. If no Alternate Offer is to be made and you are finished 

with the placement, click the Done Button.   
    2. Upon clicking Done, the following confirmation message 

will be displayed.  Click Yes to continue.  Click No to 
return to the previous page to make an Alternate Offer. 

      
    3. If the user clicked Yes, the user is directed back to the 

Process Round 2 Page and the highest retention standing 
employee is no longer visible and the next lower retention 
standing employee is now ready for placement.   

   (b) Use Alternate Offer? Checkbox is not selected 
    1. The following Confirmation Notice will appear.  Click Yes 

to continue, Click No to return to the Round 2 Page 

    
    2. If the user clicked Yes, the user is directed back to the 

Process Round 2 Page and the highest retention standing 
employee is no longer visible and the next lower retention 
standing employee is now ready for placement.   

  (8) If you are not ready to move onto the next employee, click the Back to 
Round 2 Page Button 

    
  (9) If you are going to offer the employee an Alternate Offer, select Alternate 

Offer from the Type of Offer window.    
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 d. Alternate Offer 
  (1) General Information – Alternate Offer 
   (a) Alternate Offers can be used to provide additional position offers 

to employees.   

Important Note 18:  Alternate Offer – The ability to offer alternate offers during Round 2 will 
only be available if the User Alternate Offer? Checkbox has been selected on the RIF Options 
Page.   

   (b) The ability to offer alternate offers will only be available if the Use 
Alternate Offer? Checkbox has been selected on the RIF Options 
Page.  If the Use Alternate Offer? Checkbox has not been selected, 
then the Alternate Offer selection in the Type of Offer will not be 
available.   

   (c) Positions identified as alternate offers (pending or accepted) will 
be available for RIF Assignment Offers during Round 2 Processing 

   (d) Positions identified as alternate offers will not be available for 
placements as alternate offers for other employees 

   (e) If a position identified as an alternate offer (pending or accepted) is 
used as a RIF Assignment for another lower retention standing 
employee, the Alternate Offer will automatically be removed from 
the employee’s record that was originally identified to receive the 
Alternate Offer. 

   (f) When a position identified as an alternate offer is marked as 
accepted and that position is not used as a RIF Assignment Right 
for another employee during Round 2 processing, then the position 
identified as a RIF Assignment Right is released to be used as RIF 
Assignment Rights for anyone with a lower retention standing.  A 
mini Round 2 will begin at the next lowest retention standing that 
meets lines of progression/representative rates.   

  (2) Making an Alternate Offer (after a RIF Assignment has been made) 
   (a) If an Alternate Offer is to be made (and the Use Alternate Offer? 

Checkbox has been selected in the RIF Options Page), then select 
Alternate Offer from the Type of Offer drop down menu.   

     
   (b) A listing of available positions within the employee’s assignment 

right will be displayed.   
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   (c) Using the Radio Button, select the position to be used as an 

Alternate Offer and click the Alternate Offer Button. 

     
   (d) The following confirmation message will be displayed.  Click Yes 

to continue.  Click No to return to the Alternate Offer Page. 

    
   (e) The user will be directed to the employee’s RIF Assignment Right 

Page showing the position that was selected a RIF Assignment 
Right.   

  
   (f) To view the placement or mark the position as Accepted, click the 

Type of Offer drop down button and select Alternate Offer 
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   (f) If the employee has accepted the Alternate Offer, click the 

Accepted Offer Button, otherwise click Done. 
   (g) The position will be marked as Accepted and the user will be 

returned to the Process Round 2 Page and the following 
confirmation message will be displayed.  Click Yes to confirm.  
Click No to cancel.   

 
   (h) The user is directed back to the Process Round 2 Page and the 

highest retention standing employee is no longer visible and the 
next lower retention standing employee is now ready for 
placement.   

 
 e. Set Exception or View/Delete Exception Button 

    
  (1) When a position is not be used as a placement for an employee, an 

exception can be used 
  (2) Set Exception 
   (a) Using the Radio Button, select the position where the exception is 

to be used 
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   (b) The user will be directed to the Placement Exception Screen for 

the position selected. 

 
    1. Remarks Area – The Remarks area will be auto-populated 

identifying both the abolished position and the impacted 
position.   

    2. Additional remarks may be added as needed 
    3. Click Save and Return when all comments have been added 
    4. Click Cancel and Return if you do not wish to set an 

exception 
  (3) Error/Warning/Confirmation Messages 
   (a) If a position has not been selected as an exception, the following 

error message will be displayed. 

     
   (b) If a vacant position has been selected as an exception, the 

following confirmation message will be displayed. 

  
 
 f. By-Pass Button 

   
  (1) When an employee has been marked as Mandatory Exception Based Upon 

Service in the Armed Forces and the exception date is after the effective 
date of the RIF, they can be reassigned or change to lower grade, but 
cannot be separated. 

  (2) The By-Pass Button allows the user to move onto the next employee 
without placing the employee in a position or separating the employee.   
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  (3) The By-Pass Button will appear in place of the Separate Button  

 
  (4) Note:  There is no confirmation message upon clicking the By-Pass 

Button.   
 
 g. Separate Button 

   
  (1) The Separate Button is used when there are no positions for which an 

employee qualifies. 
  (2) No Available Positions – If there no positions (vacant or encumbered) 

with the same or lower representative rates within the lines of progression 
the following screen will appear under the Available Positions Area of the 
Round 2 Page. 

 
  (3) Confirmation Message – Click Yes to separate the employee, click No to 

return to the Round 2 Page.   

    
 
 h. Round 2 Complete – When Round 2 is complete, the following confirmation 

message will be displayed.  Click Yes to go to the Process Log Page, Click No to 
return to the RIF Page.   

   



Section G – RIF Overview Page – RIF Process Tab                                                       November 2011 

Staffing:  RIF Tool                                                                               Mod 4, Chap 13, Page 142 

  
 
 
9. Final Adjustments 

STEP 17 – Final Adjustments 

 a. General Information – Final Adjustments 
  (1) The purpose of Final Adjustments is to place employees separated from 

Round 2 into vacant positions that are not considered a valid RIF 
Assignment.  This can be to a position where a waiver of qualifications 
has been granted or to a position that is below the 3/5 line of progression 
limitation.   

  (2) Once all Round 2 placements, Final Adjustments will be available if 
necessary 

  (3) Final Adjustments allow placements into vacancies. 
  (4) Positions shown will be at or below current grade 
  (5) Can be lower than 3-grade or 5-grade limit 
  (6) Only positions that will be available for possible placements will be 

vacancies that were not used during Round 1 or Round 2 
  (7) Excepted Service and RIFs involving only Term employees do not 

compete in Round 2 unless the Allow Administrative Assignment Rights 
Checkbox is selected and therefore loading lines of progression is not 
required.  In order for vacancies to be available for potential placements 
during Final Adjustments, lines of progression  must be done before 
processing Round 1.   
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Important Note 19:  Excepted Service and Term only RIFs, Lines of Progression and Final 
Adjustments – In order for vacancies to be available as potential placements during Round 2, 
Lines of Progression must be loaded prior to processing Round 1.  Round 2 for Excepted 
Service and Term only RIFs is normally skipped and therefore, the user is not provided the 
ability to update the Lines of Progression prior to entering Final Adjustments.  If lines of 
progression are not entered, then competing employees and vacancies will not be available 
during Final Adjustments.   

 

  

  
 
 b. Processing Final Adjustments 
  (1) To place an employee in a selected vacancy 
   (a) Using the radio button select the employee you wish to place. 
   (b) A list of vacant positions will show in the Final Adjustment 

Placement Options Area (if any) 
   (c) Using the radio button, select the position you wish to place the 

employee into 
   (d) Select the type of placement from the Final Adjustment Placement 

Area and the remarks. 
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   (e) Click the Place Employee in Selected Vacancy Button 

     
   (f) The following message will be displayed 

     
   (g) The employee will disappear from the list of impacted employees 

as well as the position used. 
   (h) The following error messages will be displayed: 
    1. If either the Separated or null placement is selected 

      
    2. If the Type of Placement and Remarks Area is not updated 

      
    3. If a position has not been selected 

      
   (i) If no positions are available at or below the employee’s current 

grade the following will be displayed 

 
  (2) To record remarks against the employee without placing the employee in a 

vacant position, enter the remarks in the Remarks Area and click Save 
Remark Button   

    

    
  (3) Once all placements have been made in Final Adjustments, click the 

Finish Final Adjustments Button.   

    
   (a) The following confirmation message will be displayed.  Click Yes 

to continue, click No to return to Final Adjustments. 
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   (b) The user will be returned to the Process RIF Page. 
  (4) Back to RIF Button – if at any time during the processing of Final 

Adjustments, the user needs to return to the RIF Page, use the Back to RIF 
Page Button.   

    
 
 
10. New Iteration 

STEP 18 – New Iteration 

 a. General Information 
  (1) If necessary, once Round 1 has been processed, the user can restart the 

RIF at any time using the New Iteration – Step 1 Button.   

    

    

    

    

    
  (2) Restarting the RIF is done is two steps – clicking the New Iteration – Step 

1 Button and New Iteration – Step 2.   
 
 b. Starting a New Iteration 
  (1) Click the New Iteration – Step 1 Button from the Process RIF Tab 
  (2) The following confirmation will be displayed after clicking the New 

Iteration – Step 1 Button.   

    
   (a) Click Yes to start a new iteration.  User will be directed to RIF 

Overview Page  
   (b) Click No cancel the new iteration.  User will be returned to the 

previous page.   
  (3) RIF Overview Page/Options Tab – New Iteration Step 2 Button  
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   (a) The New Iteration Step 2 Button is only available after the New 

Iteration Button is used 
   (b) Only the General Options will be available for changes.  The RIF 

Data Parameters will not be available for change.  If the RIF Data 
Parameters does not contain the correct RIF parameters, the user 
will be required to create a new RIF with the correct data 
parameters.   

   (c) Clicking New Iteration Step 2 Button – the following confirmation 
message will be displayed after clicking the New Iteration Step 2 
Button: 

     
    1. Click No to retain any manual changes made to employee 

appraisals.   

Important Note 20:  Retaining Manual Changes to Appraisals – To retain any manual 
changes/corrections made to employee records, click NO.  If you click YES, then all changes 
made to employee appraisal records will be refreshed from the employee record in DCPDS.   

    2. Click Yes to refresh all employee appraisals.   
  (4) After clicking YES or NO the appraisal calculations process is launched 

and the user is directed to the Appraisal Information Page.  (Section 
C.2.a.) 

  (5) After clicking the Calculate Button 
   (a) Appraisals are recalculated based on the values identified in the 

Appraisal Information Page and  
   (b) The user is directed to the RIF Overview Page/Status Tab (Section 

D.2.) 
    1. The RIF Status changes to RIF Not Started 
    2. The Current Iteration Number changes by 1 
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    3. Position/Employee records are now available for update. 
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Section H – RIF Overview Page –  
RIF Reports Tab, RIF Notices Tab  

and Process Log Tab 
 
 
Section Description Page # 
1. RIF Overview Page – RIF Reports Tab 150 
 a. General Information – RIF Overview Page – RIF Reports Tab 150 
 b. Selecting an Iteration 150 
 c. Generating a Report 151 
 d. Parameters Page 151 
 e. Request Summary List 155 
2. RIF Overview Page – RIF Notices Tab 156 
 a. General Information – RIF Overview Page – RIF Notices Tab 156 
 b. Selecting an Iteration 157 
 c. Generating a Notice within DCPDS 157 
 d. Generating a Notice using Mail Merge Functionality 161 
3. RIF Overview Page – Process Log Tab 163 
 a. General Information – RIF Overview Page – Process Log Tab 163 
 b. Process Log Entries 164 
 
 
Steps Description Page # 
19 Generate Reports 150 
20 Generate Notices 156 
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1. RIF Overview Page – RIF Reports Tab 
 
 a. General Information – RIF Overview Page – RIF Reports Tab 

STEP 19 – Generate Reports 

   
  (1) The user can run a variety of reports once the RIF Table has been created.   
  (2) Attachment 4 contains a complete list of all reports available, the purpose 

of the report and the data elements the report can be filtered and sorted by. 
  (3) Some reports will only be available during specific phases of the RIF.   
  (4) Depending on the report, users will have the ability to further filter which 

records are seen in the report or change the order in which records appear 
on a report.  Attachment 4 contains a complete list of reports and  

  (5) All reports can be saved as either a .rtf (Rich Text File) or .pdf (portable 
document format with the exception of the two Actions Reports and the 
three Retention Registers.  These reports can only be generated as a .pdf.  
See Section H.1.e. for information on the Request Summary List Area.   

 
 b. Selecting an Iteration 
  (1) Users must identify the iteration number for all reports prior to selecting 

the report name or selecting the parameters.   
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  (2) If the user fails to input the iteration number in the Please Select Iteration 
Area, the following error message will be displayed: 

    
 
 c. Generating a Report 
  (1) Searching for Reports – Use the Report Name, Report Description or the 

Next Button to locate the report need.  A list of the Report Name and 
Report Description can be found at Attachment 4.   

  (2) Submit Report – To generate a report without changing which records are 
seen or the order in which they are shown on the report, click the Submit 
Report Button 

    
  (3) Parameters – To change which records are seen or the order in which they 

are shown on the report, click the Parameters Button.   

    
 
 d. Parameters Page 
  (1) General Information – Parameters Page 
   (a) The Parameters Page contains three areas 
    1. Output Type 
    2. Filter Conditions 
    3. Sort Order 
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  (2) Output Type 
   (a) Users will have the capability of downloading reports in either an 

.RTF format or PDF format 
   (b) Default – the default will be to download the report as an RTF. 

     
  (3) Filter Conditions Area – Depending on the report, the user may be able to 

further define which records are seen in the report.   
   (a) Input Area 
    1. If the report cannot be further defined, the Input Area will 

be blank 

      
    2. If the report can be further defined, the data elements that 

can be further defined will be listed in the Input Area 

      
    3. Select the data element needed 
   (b) Operators – Once the parameter has been selected, select the 

appropriate operator  
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    1. Not Equals  – Select only those records where the value 
input in the Parameters Area does not match the value 
found in the RIF Table.   

    2. Less Than  – Selects only those records where the value 
input in the Parameters Area is less than the value found in 
the RIF Table.   

    3. Less Than or Equal To  – Selects only those records 
where the value input in the Parameters Area is less than or 
equal to the value found in the RIF Table.   

    4. Equals – Select those records where the value input in the 
Parameters Area matches exactly the value found in the 
RIF Tables (including case sensitivity) 

    5. Greater Than  – Selects only those records where the 
value input in the Parameters Area is greater than the value 
found in the RIF Table.   

    6. Greater Than or Equal To  – Selects only those records 
where the value input in the Parameters Area is greater than 
or equal to the value found in the RIF Table.   

    7. Like  – Selects only those records where the value in 
the Parameters Area that are like the value found in the RIF 
Table.   

    8. Not Like  – Selects only those records where the 
value in the Parameters Area that are not like the value 
found in the RIF Table.   

   (c) Parameters 
    1. Once the operator has been selected, input the value 

needed.   
    2. In most cases, the value input in the Parameters Area must 

match exactly as it is in the RIF Tables.  This area is case 
sensitive.   

    3. When using Like and Not Like, the value must be followed 
by the % sign.   

   (d) Add to Filter/And into Filter/Or into Filter/Clear Filter 

     
    1. Add to Filter – Once the Input Area, the Operator Area and 

the Parameters Area have been completed, click the Add to 
Filter Button to add to the filter area 

    2. And into Filter – Allows the user to add more than one 
condition to the filter.  Using the And into Filter both 
conditions must be met 
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    3. Or into Filter – Allows the user to add more than one 
condition to the filter.  Using the Or into Filter one or both 
of the conditions can be met. 

    4. Clear Filter – clears the filter from the filter area. 
   (3) Samples: 
    1. ( Last Name ) LIKE ‘AIF%’  AND ( Pay Plan ) = ‘GS’  

AND ( Grade or Level ) is looking for anyone with a Last 
Name beginning with AIF and has a Pay Plan of GS and 
Grade of 12.   

    2. ( Grade or Level ) = ‘12’  OR ( Grade or Level ) = ‘11’ is 
looking for anyone with a Grade of 11 or 12.   

  (4) Sort Order – Depending on the report, the user may be able to define how 
the records are seen in the report.   

   (a) Available Area 
    1. If the report cannot be sorted, the Available Area will be 

blank.   

      
    2. If the report can be sorted, the data elements that the report 

can be sorted on will be listed in the Available Area 

      
   (b) Selected Area 
    1. Select the data element and click the Move Button to move 

the selected data element into the Selected Area.   
    2. More than one data element can be used to sort records.  If 

more than one data element is selected, the top data 
element will be the first sort, followed by the second data 
element listed.   

   (c) Ascend/Descend 
    1. Ascend is the default for records sorting 
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    2. To change to descending order, click the Descend Radio 
Button 

 
  (5) Back to Main Page Button – directs the user back to the Main RIF Page 

    
  (6) Submit Report Button – Once the parameters have been input and the 

select sort criteria has been selected, click the Submit Report Button to 
generate the report.   

    
 
 e. Request Summary List 

    
  (1) Due to the complexities of the two Actions Reports and the three 

Retention Register Reports, these reports will run as concurrent processes.   
  (2) Once the report is generated, the report will be shown in the Request 

Summary List Area and the Phase shows as Pending, Running or 
Complete. 

  (3) Once the report is available for view/printing, the phase will show as 
Completed.   

  (4) Click the Refresh Button periodically to check the status of the report.   
  (5) These reports will only be available in a .PDF format.  Click the Output 

Button to view the report.   
  (6) These reports will be available for up to two days after the report is 

generated. 
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2. RIF Overview Page – RIF Notices Tab 
 a. General Information – RIF Overview Page – RIF Notices Tab 

STEP 20 – Generate Notices 

  
 
  (1) The user can run a variety of standard notices that are stored within the 

DCPDS RIF Tool once the RIF has been processed.   
  (2) The content of the notices cannot be changed within the DCPDS RIF 

Tool.   
  (3) Notices may be generated in one of two ways 
   (a) Standard Notices – Air Force, Army and Navy have provided 

standard notices; however, these notices may be used by any user.   
   (b) Mail Merge – Allows the user to download employee information 

for the purpose of generating user unique notices 
  (4) Availability of notices 
   (a) Reassignment-Non-RIF Notices can be generated after Round 1 is 

completed.   
   (b) In Lieu of Separation Notices will be available for those employees 

placed in Final Adjustments.   
   (c) All other notices will be available after Round 2 is processed.   
   (d) The type of action processed will dictate which employees will be 

available for each notice.   
   (e) The Cancellation Notice will be available for all employees 



Section H – RIF Overview Page – RIF Reports Tab,                                                    November 2011 
                     RIF Notices Tab and Process Log Tab 

Staffing:  RIF Tool                                                                               Mod 4, Chap 13, Page 157 

  (5) Attachment 5 contains a complete list of all notices available, the purpose 
of the notice and any unique aspects of the notice.   

  (6) The user will have the ability to update information that is specific to the 
current Reduction in Force.   

  (7) Performance Ratings – The information populated into the Performance 
Ratings Area of the notices will depend on the whether the employee has 
valid appraisals or a modal rating was applied.   

   (a) Modal Rating – An employee with no valid appraisals will have 
been assigned a modal rating.  The following paragraph will be 
placed in the Perf Rating 1 data field in place of the appraisal 
information:  Since you do not have a Performance Rating of 
Record that could be used for computation of additional service 
credit for RIF Retention, a Modal Rating was used.  This Modal 
Rating is based on the rating level assigned most frequently for 
actual rating of records for employees whose appraisal pattern is 
the same as the pattern that applies to your position of record.  That 
pattern is (A) and the Modal Rating is (3). 

   (b) Rating of 5 on 31-OCT-2006 
 
 b. Selecting an Iteration 
  (1) Users must identify the iteration number for all notices prior to selecting 

the notice name.   
  (2) If the user fails to input the iteration number in the Please Select Iteration 

Area, the following error message will be displayed: 

    
 
 c. Generating a Notice within DCPDS 
  (1) General Information – Generating a Notice 
   (a) Searching for Notices – Use the Notice Name, Notice Description 

or the Next Button to locate the notice needed.  A list of the Notice 
Name and Notice Description can be found at Attachment 5.   

   (b) Processing Notices – There are two ways to process notices.  Each 
process will be discussed below.   

    1. To generate a notice within the DCPDS RIF Tool, see 
Section 4 below.   

    2. To generate notices using the Mail Merge Process see 
Section 5 below.   

  (2) Generating a Notice within the DCPDS RIF Tool 
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   (a) To generate a notice within the DCPDS RIF Tool, click the 
Process Button associated with the notice.   

   
   (b) Process ________________ Notice Page – each notice page 

contains two areas 

    
    1. Please Enter Notice Information 
     a. The notice information area will change based on 

the type of notice selected.  Attachment 5 discusses 
which fields are available for each notice and which 
notices the special paragraphs will be available.   

     b. MSPB Office – Selected notices contain the MSPB 
Office.  Use the Radio Button to select the MSPB 
Office, the MSPB Address will be auto-populated 
based on the MSPB Office selected; however the 
user can update the address if needed.  Click the 
Select Button.   
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    2. Please Select Employee(s) to process RIF Notice – Select 

the employees you need notices generated on.   
 
 
    3. Create Notice Button – Once all employees have been 

selected, Click the Create Notice Button 

      
    4. The user will be prompted to Open or Save the File.  Click 

Open to view the notice.   

      
    5. The following error message will display if the user fails to 

select at least one employee when generating notices. 

     
  (3) Special Paragraphs 
   (a) General Information – There are 6 types of special 

paragraphs/pages that can be added to notices.  See Attachment 5 
for the paragraph # and the components that will be able to use the 
paragraphs 

    1. Bargaining Unit Paragraph 
    2. Separation – Temporary Exception Paragraph 
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    3. Temporary Exception Paragraph 
    4. Temporary Exception More Severe Action Paragraph 
    5. Waiver of Qualifications Paragraph 
    6. Right of First Refusal Form 
   (b) Bargaining Unit Paragraph – replaces the Appeal Rights Paragraph 

in Change to Lower Grade and Separation Notices 
   (c) Separation – Temporary Exception Paragraph: 
    A Permissive Temporary Exception has been granted to the RIF 

retention order in accordance with 5 CFR 351.608(c), extending 
the date your personnel action will be effective to .   

 
    This exception has been granted to provide you with a 60 day 

minimum reduction in force notice as required by 5 CFR 351.801.  
You will continue in your present position until .  Unfortunately, 
an offer of continued employment cannot be made to you at this 
time.  However, be assured every effort will be made during this 
notice period to assist you in locating a position up to and 
including your present grade until the effective date of the 
reduction in force (RIF Effective Date).  However, in accordance 
with 5 CFR 351.608(a)(2), you cannot be considered for other 
positions through reduction in force procedures between the 
effective date of the reduction in force (RIF Effective Date) and 
the permissive temporary exception period (New Date). 

   (d) Temporary Exception Paragraph: 
    A Permissive Temporary Exception has been granted to the RIF 

retention order in accordance with 5 CFR 351.608(c), extending 
the date your personnel action will be effective to (New Date).  
This exception has been granted to provide you with a 60 day 
minimum reduction in force notice as required by 5 CFR 351.801.  
However, in accordance with 5 CFR 351.608(a)(2), you will not be 
considered for other positions through the RIF process during the 
period (RIF Effective Date) and (New Date). 

   (e) Temporary Exception More Severe Action Paragraph 
    A Permissive Temporary Exception has been granted to the RIF 

retention order in accordance with 5 CFR 351.608(c), extending 
the date your personnel action will be effective to (New Date).  
This will meet the required minimum 60 day reduction in force 
notice when the agency gives the employee a new notice because 
the employee is reached for a more severe reduction in force 
action.  However, in accordance with 6 CFR 351.608(a)(2), you 
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will not be considered for other positions during the period (RIF 
Effective Date) and (New Date). 

   (f) Waiver of Qualifications Paragraph – Available for Army notices 
only.   

   (g) Right of First Refusal Form – Available for Navy notices only.   
  (4) Back to Main Page returns the user to the RIF Notices Tab 

    
 
 
 d. Generating a Notice using the mail merge functionality 
  (1) General Information – Mail Merge Functionality 
   (a) The Mail Merge Process allows the user to “extract” a spreadsheet 

listing of employees within the database for the purpose of 
generating notices through a mail merge process using a word 
processing function or other user generated reports.   

   (b) The Mail Merge Process will only be available after Round 
1/Round2 is complete.   

   (c) A listing of the data elements will be contained in the extract can 
be found in Attachment 5.   

  (2) To generate a spreadsheet: 
   (a) Click the Mail Merge Extract.   

     
   (b) The user will be directed to the Process Mail Merge Extract Page 

 
  (c) To only extract those impacted by RIF.  

    
    1. To generate a listing of all employees within the database, 

select No from the “Only extract those impacted by RIF”.  
This option is typically used to generate additional reports.   

    2. To generate a listing of employees for the purpose of 
generating notices, select Yes from the “Only extract those 
impacted by RIF”. 
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  (d) To limit the employees based on the type of action processed, select the 
type of RIF action – leaving the field blank will pull all types of actions.   

  
  (e) Once all filters have been applied, click the Create Extract Button.   

    
  (f) The following screen will be displayed.  Click Save and navigate to the 

directory where you want to store your file.   

    
  (g) You are now ready to generate your notices using a word processing 

function. 
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3. RIF Overview Page – Process Log Tab 
 
 a. General Information – RIF Overview Page – Process Log Tab 

  
  (1) The Process Log Page shows a variety of log entries that keep track of the 

status of the RIF, errors that have occurred when processing the RIF, mass 
updates that took place.  A listing of the log types available are listed 
below.   

  (2) The user is directed to this page 
   (a) When the Pre-Process Round 1 Button is selected and there are 

errors found in position/employee records or no positions have 
been abolished (Section G.4.b.) 

   (b) Clicking the View the Process Log Button from the Create a RIF 
Table Page (Section B.3.h.) 

   (c) Clicking the Yes Button of the View Round 2 Process Log 
confirmation message (Section G.8.h.) 

  (3) From this page, the user can do the following: 
   (a) Sort Process Log Entries 
   (b) View a variety of Process Logs 
  (4) Sort entries in the Process Log – To Sort entries in the Process Log, click 

on any one of the following columns 
   (a) Log Type 
   (b) Log Date 
   (c) Status 
   (d) Program Description 
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   (e) National Identifier 
   (f) CPCN 
   (g) Message Name 
  (5) Log Type – The Process Log can be narrowed by selecting one of the 

following log types: 

    
  (6) Status – The Process Log can be narrowed by selecting one of the 

following statuses: 

    
 
 b. Process Log Entries – The following is a list of process logs and identifies when 

entries are made to the individual process logs. 
 
Log Type Remarks 
Add position to RIF  
Appraisal Calculation  
Change RIF Database Parameters  
Create RIF Database (1) Create RIF from Staging Table 

(2) Identifies employee errors 
(3) Identifies employees converted from VRA 
(4) Identifies tenure changes from 2 to 1 
(5) Identifies positions treated as GS (GM/GL) 
(6) Identifies when obligated position not found 
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Log Type Remarks 
(7) Identifies when obligated SSAN not found 
(8) Identifies when a position is created from a 

temporary promotion 
(9) Identifies employees moved to their permanent 

position 
(10) Assigning appraisal points or modal rating points 

Extract to RIF Staging Table  
Mass Abolish Identifies those positions that cannot be abolished when 

using the Mass Abolish Function (tenure = 0, exception, 
vacant, remove from RIF) 

Mass Delete  
Mass Remove from RIF Identifies those positions that are abolished and the user 

attempts to marks the position as Remove from RIF using 
the Mass Remove from RIF process 

New Iteration Identifies when a new iteration was started and when it was 
completed 

Pattern Designation  
RIF Action – Adjust Round 1 Identifies when Adjust Round 1 was started and when it 

was completed 
RIF Action – Final Adjustments Identifies when Final Adjustment was started and when it 

was completed and if any placements were made 
RIF Action – Round 1 Identifies when Round 1 was started and when it was 

completed and if any placements were made 
RIF Action – Round 2 Identifies when Round 2 was started and when it was 

completed and if any placements were made 
RIF Staging Table  
Refresh Appraisal Information  
Refresh Position and/or Employee  
Save RIF Options Changes  
Upload Abolish Produces an entry for each CPCN contained in the abolish 

upload list and whether or not the position was marked as 
abolished 

Upload GS Equivalent Grade  
Utility  
Validation Round 1 Identifies when Round 1 validation was started and when it 

was completed and identifies any errors found 
Validation Round 2 Identifies when Round 1 validation was started and when it 

was completed and identifies when any errors are found 
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Section I – RIF Administrator Responsibility 
 
 
Section Description Page # 
1. General Information – RIF Administrator Responsibility 168 
2. Changing the Current Owner 169 
3. Reactivate an Archived RIF 170 
4. Generate Overall Reports 170 
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1. General Information – RIF Administrator Responsibility 
 a. The DCPDS RIF Tool Administrator Responsibility is used to “move” RIFs from 

one user to another, retrieve RIFs that have been archived and generate overall 
reports within a Region. 

 b. Access to this responsibility will be assigned by your systems administrator. 
 c. All RIFs created within the Region will be visible. 
 

 
 d. The user is directed to the RIF Administrator Page when the DCPDS RIF Tool 

Administrator Link is selected from the Navigator Page. 

 
 e. From this page, the user can: 
  (1) change the current owner 
  (2) reactivate an archived RIF 
  (3) generate overall reports 
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2. Changing the Current Owner 
 a. Select the RIF you wish to change owners by clicking the radio button associated 

with the RIF.   

 
 b. The New Owner column will open up 
 c. Using the drop-down button, select the new owner 
 

 
 d. Click the Save Button 

   
 e. The New Owner Becomes the Current Owner 

 
 f. To cancel the action prior to saving, click the Reset Button 
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3. Reactivate an Archived RIF 
 a. To view archived RIFs, click the Plus sign on the Archived/Completed RIFs row.  

 
 b. To reactivate an archived RIF, click the Reactivate Button associated with the RIF 

you wish to reactivate. 

 
 
 c. The RIF will be moved back into the Active RIF section and will be moved into 

the box of the owner that archived the RIF. 

 
 
 
4. Generate Overall Reports 

 
 a. To generate reports for all RIFs within the region, click the Reports Button.   
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 b. Date Parameters – The Completed RIF Report and the CanclReports are 

generated based on the RIF Effective Date. 
 c. Three Reports Available 
  (1) On-Going RIF Reports – shows all on-going RIFs based from the current 

date forward. 
  (2) Completed RIFs Report – using the effective date of the RIF, shows all 

RIFs between the dates input in the date parameter. 
  (3) Cancelled RIFs Report – using the effective date of the RIF, shows all 

RIFs between the dates input in the data parameter.   
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Attachment 1 
DCPDS RIF Extract/Staging Table Criteria and Business Rules 

 
1. DCPDS RIF Extract Table Criteria 
 

Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
POSITION DATA ELEMENTS 

A CPCN Position Work Structures/Position/ Description/ 
Position Details/Position Flexfields/ 

  Y (concatenate Position Description 
No. and Sequence Number) 

B Title Position Work Structures/Position/Description/ 
Position Details/Position Flexfields/ 

  Y  

C Pay Plan Position Work Structures/Position/Description/ 
Extra Information/US Valid Grade Info/ 

  Y Segment 1 of Valid Grade 

D Occupational Series Position Work Structures/Position/Description/ 
Position Details/ 

  Y Segment 1 of Job 

E Grade or Level Position Work Structures/Position/Description/ 
Extra Information/US Valid Grade Info/ 

  Y Segment 2 of Valid Grade 

F Position Type Position Work Structures/Position/Description/ 
Position Details/Position Flexfields/ 

   See Business Rules Area 

G Position_ID Position hr_all_positions_f    See Business Rules Area 
 

H 
Competitive Level Position Work Structures/Position/Description/ 

Extra Information/US Federal Position 
Group 1/ 

  Y  
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Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
I Position Occupied Position Work Structures/Position/Description/ 

Extra Information/US Federal Position 
Group 2/ 

CLC  Y See Business Rules Area 

J Work Schedule Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Group 1/ 

CLC  Y  

K Bargaining Unit Status Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Group 1/ 

    

L Occupied Category Code 
(PATCOB) 

Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Group 1/ 

    

M Position Sensitivity Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Group 1/ 

    

N Pay Table ID Position Work Structures/Position/Description/ 
Extra Information/US Valid Grade Info/ 

  Y  

O Supervisory Status Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Group 1/ 

    

P Key Emergency Essential Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Group 2/ 

    

Q Drug Test Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Group 2/ 
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Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
R Mobilization Indicator Position Work Structures/Position/Description/ 

Position Details/Additional Position 
Details/ 

    

S Program Type 
(Acquisition) 

Position Work Structures/Position/Description/ 
Extra Information/Acquisition Program 
Information/ 

    

T Career Field Position Work Structures/Position/Description/ 
Extra Information/Career Program/ 

   If Agency Code = “AF” then 
Career Field (AF) else if Agency 
Code = “AR” then Career Field 
(AR) else “ ” 

U Competitive Area Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Group 1/ 

CA  Y See Business Rules Area 

V PAS Code Position Work Structures/Position/Description/ 
Position Details/Additional Position 
Details/ 

CA  Y Air Force Positions only 
See Business Rules Area 

W Unit ID Code (UIC) 
(ARMY, NAVY) 

Position Work Structures/Position/Description/ 
Position Details/Additional Position 
Details/ 

CA  Y Army/Navy Positions 
See Business Rules Area 

X Organization Structure ID Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Group 1/ 

CA  Y  

Y Position’s Organization 
(POA) 

Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Group 1/ 

  Y  

Z Organization Name Position      
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Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
AA Organization_ID Position hr_all_organization_units table     
AB Location_ID Position hr_all_positions_f     
AC 1st Line Organizational 

Narrative 
Position Clear Text of Position Organization     

AD 2nd Line Organizational 
Narrative 

Position Clear Text of Position Organization     

AE 3rd Line Organizational 
Narrative 

Position Clear Text of Position Organization     

AF 4th Line Organizational 
Narrative 

Position Clear Text of Position Organization     

AG 5th Line Organizational 
Narrative 

Position Clear Text of Position Organization     

AH Office Symbol Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Group 1/ 

  Y  

AI Funct Acct and Shred 
(FAC) 

Position Work Structures/Position/Description/ 
Extra Information/Multiple Position 
Information/ 

    

AJ Program Element (PEC) Position Work Structures/Position/Description/ 
Extra Information/Multiple Position 
Information/ 

    

AK Location (Geographical 
Location Code) 

Position Work Structures/Position/Description/ 
Position Details/ 

CA  Y See Business Rules Area 

AL Locality Pay Area Code  ghr_locality_pay_areas_f     
AM Locality Pay Percentage  ghr_locality_pay_areas_f     



Attachment 1 – DCPDS RIF Extract/Staging Table Criteria and Business Rules                                                              November 2011 

Staffing:  RIF Tool                                                                               Mod 4, Chap 13, Page 177 

Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
AN Training Program ID Position Work Structures/Position/Description/ 

Extra Information/US Federal Position 
Group 2/ 

    

AO Position NTE Date Position Work Structures/Position/Description/ 
Position Details/Additional Position 
Details/ 

    

AP Servicing Office ID 
(CCPO ID) 

Position Work Structures/Position/Description/ 
Position Details/Additional Position 
Details/ 

CA  Y See Business Rules Area 

AQ Personnel System Indicator Position Work Structures/Position/Description/ 
Extra Information/US Federal Alternate 
HR System/ 

    

AR Obligated Employee 
SSAN 

Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Obligated/ 

  Y See Business Rules Area 

AS Obligated Type Position Work Structures/Position/Description/ 
Extra Information/US Federal Position 
Obligated/ 

  Y See Business Rules Area 

EMPLOYEE DATA ELEMENTS 
AT Last Employee People/Enter and Maintain/Name/   Y  

AU First Employee People/Enter and Maintain/Name/   Y  

AV Middle Employee People/Enter and Maintain/Name/   Y  

AW Suffix Employee People/Enter and Maintain/Name/   Y  

AX Social Security Number Employee People/Enter and Maintain/   Y  
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Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
AY Employee ID Employee People/Enter and Maintain/     

AZ Pers_ID Employee per_all_people_f    See Business Rules Area 
BA Assignment_ID Employee per_all_assignments_f    See Business Rules Area 
BB Step or Rate Employee People/Enter and Maintain/Assignment/ 

Extra Information/US Federal 
Assignment RPA 

    

BC Basic Salary Rate Employee People/Enter and Maintain/Assignment/ 
Entries/Basic Salary Rate/ 

    

BD Adjusted Basic Pay Employee People/Enter and Maintain/Assignment/ 
Entries/Adjusted Basic Pay/ 

    

BE Locality Pay or SR 
Supplement 

Employee People/Enter and Maintain/Assignment/ 
Entries/Locality Pay or SR Supplement/ 

    

BF Total Pay Employee People/Enter and Maintain/Assignment/ 
Entries/Total Pay 

    

BG Temp Appt NTE Employee People/Enter and Maintain/Assignment/ 
Extra Information/Assignment NTE 
Dates/ 

    

BH Limited Appt NTE Employee People/Enter and Maintain/Assignment/ 
Extra Information/Assignment NTE 
Dates/ 

    

BI Appointment Type Employee Extra Information/US Federal Person 
Group 1 

  Y  
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Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
BJ Tenure Employee People/Enter and 

Maintain/Assignment/Extra 
Information/US Federal Assignment 
RPA 

 RS Y  

BK Date Conversion Career 
Begins 

Employee People/Enter and Maintain/Extra 
Information/US Federal Conversions/ 

  Y  

BL Date Conversion Career 
Due 

Employee People/Enter and Maintain/Extra 
Information/US Federal Conversions/ 

 RS Y See Business Rules Area 

BM Date Prob/Trial Period 
Begins 

Employee People/Enter and Maintain/Extra 
Information/US Federal Probations/ 

  Y  

BN Date Prob/Trial Period 
Ends 

Employee People/Enter and Maintain/Extra 
Information/US Federal Probations/ 

 RS Y See Business Rules Area 

BO Date VRA Conversion 
Due 

Employee People/Enter and Maintain/Extra 
Information/US Federal Conversions/ 

 RS Y See Business Rules Area 

BP WGI Due Employee People/Enter and Maintain/Assignment/ 
Entries/Within Grade Increase/ 

    

BQ Vet Pref for RIF Value Employee People/Enter and Maintain/Extra 
Information/Other Person Information/ 

 RS Y See Business Rules Area 

BR Veterans Preference Employee People/Enter and Maintain/Extra 
Information/US Federal Person RPA/ 

    

BS Current Appointment Auth 
(1) 

Employee People/Enter and Maintain/Extra 
Information/US Federal Person Group 1/ 

CLC  Y See Business Rules Area 

BT Current Appointment Auth 
(2) 

Employee      
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Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
BU SCD RIF Employee People/Enter and Maintain/Extra 

Information/US Federal SCD 
Information/ 

 RS Y See Business Rules Area 

BV SCD Leave Employee People/Enter and Maintain/Extra 
Information/US Federal SCD 
Information/ 

    

BW Annuitant Indicator Employee People/Enter and Maintain/ 
Assignment/Extra Information/US 
Federal Assignment RPA/ 

    

BX Birth Date Employee People/Enter and Maintain/     
BY Sex Employee People/Enter and Maintain/     
BZ Hispanic or Latino Employee People/Enter and Maintain/Extra 

Information/US Federal Ethnicity and 
Race Category/ 

    

CA American Indian/Alaskan 
Native 

Employee People/Enter and Maintain/Extra 
Information/US Federal Ethnicity and 
Race Category/ 

    

CB Asian Employee People/Enter and Maintain/Extra 
Information/US Federal Ethnicity and 
Race Category/ 

    

CC Black or African American Employee People/Enter and Maintain/Extra 
Information/US Federal Ethnicity and 
Race Category/ 

    

CD Native Hawaiian or Other 
Pacific islander 

Employee People/Enter and Maintain/Extra 
Information/US Federal Ethnicity and 
Race Category/ 
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Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
CE White Employee People/Enter and Maintain/Extra 

Information/US Federal Ethnicity and 
Race Category/ 

    

CF Handicap Code Employee People/Enter and Maintain/Extra 
Information/US Federal Person Group 1/ 

    

CG Personnel Sec Clearance Employee People/Enter and Maintain/Extra 
Information/US Federal Security/ 

    

CH Retirement Plan Employee People/Enter and Maintain/Assignment/ 
Entries/Retirement Plan/ 

    

CI Duty Status Employee People/Enter and Maintain/Assignment/ 
Extra Information/US Federal 
Assignment Non RPA/ 

    

CJ LWOP NTE Start Date Employee People/Enter and Maintain/Assignment/ 
Extra Information/US Federal 
Assignment NTE Dates/ 

    

CK LWOP NTE Employee People/Enter and Maintain/Assignment/ 
Extra Information/US Federal 
Assignment NTE Dates/ 

    

CL Education Level Employee People/Enter and Maintain/Special 
Info/Education/ 

    

CM Education Level Clear 
Text 

Employee People/Enter and Maintain/Special 
Info/Education/ 

    

CN Instructional Program 
(Academic Discipline 
Code) 

Employee People/Enter and Maintain/Special 
Info/Education/ 
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Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
CO Instructional Program 

Clear Text 
Employee People/Enter and Maintain/Special 

Info/Education/ 
    

CP Rating of Record Pattern 
(current year) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

CQ Appraisal Type (current 
year) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

CR Rating of Record (current 
year) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

CS Date Effective (current 
year) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

CT Rating of Record Pattern 
(2nd appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

CU Appraisal Type (2nd 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

CV Rating of Record (2nd 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

CW Date Effective (2nd 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

CX Rating of Record Pattern 
(3rd appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

CY Appraisal Type (3rd 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

CZ Rating of Record (3rd 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DA Date Effective (3rd 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 
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Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
DB Rating of Record Pattern 

(4th appraisal) 
Employee People/Enter and Maintain/Special 

Info/US Fed Perf Appraisal/ 
 RS  See Business Rules Area 

DC Appraisal Type (4th 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DD Rating of Record (4th 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DE Date Effective (4th 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DF Rating of Record Pattern 
(5th appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DG Appraisal Type (5th 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DH Rating of Record (5th 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DI Date Effective (5th 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DJ Rating of Record Pattern 
(6th appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DK Appraisal Type (6th 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DL Rating of Record (6th 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DM Date Effective (6th 
appraisal) 

Employee People/Enter and Maintain/Special 
Info/US Fed Perf Appraisal/ 

 RS  See Business Rules Area 

DN Obligated Position Number 
(Permanent CPCN) 

Employee People/Enter and Maintain/Extra 
Information/US Federal Person Group 2/ 

  Y See Business Rules Area 
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Column 
# Field Name 

Position/ 
Employee 

Record DCPDS Location 

COMP 
AREA/ 
CLC RS 

 
 

EDIT Special Instructions 
DO Obligated Position Type Employee People/Enter and Maintain/Extra 

Information/US Federal Person Group 2/ 
  Y See Business Rules Area 

DP Temp Prom NTE Employee People/Enter and Maintain/Assignment/ 
Extra Information/Assignment NTE 
Dates/ 

    

DQ Temp Posn Chg NTE Employee People/Enter and Maintain/Assignment/ 
Extra Information/Assignment NTE 
Dates/ 

    

DR Temp Reasmt NTE Employee People/Enter and Maintain/Assignment/ 
Extra Information/Assignment NTE 
Dates/ 

    

DS Temp CLG NTE Employee People/Enter and Maintain/Assignment/ 
Extra Information/Assignment NTE 
Dates/ 
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2. Business Rules 
 (a) Records Included/Excluded from the Extract 
  (1) Position Type – Include positions only where Position Type (Column F) = APPR and TECH 
  (2) SES Positions – Exclude Pay Plan (Column C) = ES, EX, IE, IP, ST, SL (any others?) or Pay Plan = AD and Grade = 00 
  (3) DCIPS Positions – Exclude Personnel Systems Indicator (Column AO) = 02 
  (4) Encumbered Records – Include active encumbered records regardless of the Position Status (Work Structures/ 

Position/Status). 
  (5) Vacant Positions – Include vacant positions only if the Position Status is “Valid” and the record is not end-dated – except if 

Obligated Employee SSAN (Column AR) is not null and Obligated Type (Column AS) = “T” then include regardless of the 
Position Status. 

 (b) Appraisal Records 
  (1) Include only those appraisals where the Appraisal Type (People/Enter and Maintain/Special Info/US Fed Perf Appraisal/) does 

not equal E, F, I, P, R, S, X, Z (Columns CQ, CU, CY, DC, DG, DK, DO) 
  (2) Appraisal Information – the following columns are considered together – CP-CS, CT-CW, CX-DA, DB-DE, DF-DI, DJ-DM.  

If the Appraisal Type equals = E, F, I, P, R, S, X, Z then do not include Rating of Record Pattern, Rating of Record or Date 
Effective.  

 (e) Comp Area/CLC Column 
  (1) CA – used to restrict those records that will be contained in the RIF Extract Table – SOID is required, all other fields will be an 

“and” function 
  (2) CLC – used as an “and” function to the competitive area – allow the use of the Current Appointing Authority only if the 

Position Occupied = 2 
 (f) RS Column – fields identified as RS will be considered in the retention process. 
 (g) Obligated Position/Employee Information  
  (1) Extract Table will only populate those records with the Obligated SSAN (Column AR) only when the Obligated Type (Column 

AS) = “T” 
  (2) Extract Table will only populate those records with the Obligated Position Number (Column ED) when the Obligated Position 

Type = “T” (Column EE) 
  (3) Employees will be moved to their permanent position based on the information contained in the position record (Obligated 

SSAN and Obligated Type) and the employee record (Obligated CPCN and Obligated Position Type) during the RIF creation. 
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  (4) Employees will be included in/excluded from the RIF process when it is determined that employees on temporary 
promotion/reassignment/change to lower grade/position change currently occupy positions in different competitive areas than 
their permanent position. 

 (h) Position/Employee ID fields – Pers_ID (Column AX), Assignment_ID (Column BA), Position_ID (Column G), Organization_ID 
(Column AA), Location_ID (Column AB) fields are used in the upload processing logic only and are not required to be visible in the 
automated program. 
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Attachment 2 
Designation of Series by 

One Grade/Two Grade Intervals 
 
 

SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-0006 Correctional Institution Administration Series TWO   
GS-0007 Correctional Officer Series ONE   
GS-0011 Bond Sales Promotion Series TWO   
GS-0017 Explosives Safety Specialist TWO YES  
GS-0018 Safety and Occupational Health Management 

Series 
TWO   

GS-0019 Safety Technician Series ONE   
GS-0020 Community Planning Series TWO   
GS-0021 Community Planning Technician Series ONE   
GS-0023 Outdoor Recreation Planning Series TWO   
GS-0025 Park Ranger Series* TWO   
GS-0028 Environmental Protection Specialist Series TWO   
GS-0029 Environmental Protection Assistant Series ONE   
GS-0030 Sports Specialist Series TWO   
GS-0050 Funeral Directing Series  ONE   
GS-0060 Chaplain Series TWO   
GS-0062 Clothing Design Series TWO   
GS-0072 Fingerprint Identification Series* TWO   
GS-0080 Security Administration Series TWO   
GS-0081 Fire Protection and Prevention Series ONE   
GS-0082 United States Marshal Series TWO   
GS-0083 Police Series ONE   
GS-0084 Nuclear Materials Courier Series ONE   
GS-0085 Security Guard Series ONE   
GS-0086 Security Clerical and Assistance Series ONE   
GS-0090 Guide Series ONE   
GS-0095 Foreign Law Specialist Series TWO   
GS-0099 General Student Trainee Series ONE   
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-0101 Social Science Series  TWO   
GS-0102 Social Science Aid and Technician Series ONE   
GS-0105 Social Insurance Administration Series TWO   
GS-0106 Unemployment Insurance Series TWO   
GS-0107 Health Insurance Administration Series  ONE   
GS-0110 Economist Series TWO   
GS-0119 Economics Assistant Series ONE   
GS-0130 Foreign Affairs Series TWO   
GS-0131 International Relations Series  TWO   
GS-0132 Intelligence Series TWO   
GS-0134 Intelligence Aid and Clerk Series  ONE   
GS-0135 Foreign Agricultural Affairs Series TWO   
GS-0136 International Cooperation Series TWO   
GS-0140 Workforce Research and Analysis Series TWO   
GS-0142 Workforce Development Series TWO   
GS-0150 Geography Series TWO   
GS-0160 Civil Rights Analysis Series TWO   
GS-0170 History Series TWO   
GS-0180 Psychology Series  TWO   
GS-0181 Psychology Aid and Technician Series ONE   
GS-0184 Sociology Series TWO   
GS-0185 Social Work Series TWO   
GS-0186 Social Services Aid and Assistant Series ONE   
GS-0187 Social Services Series ONE   
GS-0188 Recreation Specialist Series TWO   
GS-0189 Recreation Aid and Assistant Series ONE   
GS-0190 General Anthropology Series TWO   
GS-0193 Archeology Series  TWO   
GS-0199 Social Science Student Trainee Series  ONE   
GS-0201 Human Resources Management Series TWO   
GS-0203 Human Resources Assistance Series ONE   
GS-0241 Mediation Series  TWO   
GS-0243 Apprenticeship and Training Series TWO   
GS-0244 Labor Management Relations Examining 

Series 
TWO   

GS-0249 Wage and Hour Compliance Series TWO  2/ 
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-0260 Equal Employment Opportunity Series TWO   
GS-0299 Human Resources Management Student 

Trainee Series  
ONE   

GS-0301 Miscellaneous Administration and Program 
Series 

TWO   

GS-0302 Messenger Series   ONE   
GS-0303 Miscellaneous Clerk and Assistant Series  ONE   
GS-0304 Information Receptionist Series  ONE   
GS-0305 Mail and File Series   ONE   
GS-0309 Correspondence Clerk Series  ONE   
GS-0312 Clerk-Stenographer and Reporter Series  ONE YES 1/ 
GS-0313 Work Unit Supervising Series   ONE   
GS-0318 Secretary Series  ONE   
GS-0319 Closed Microphone Reporting Series  ONE   
GS-0322 Clerk-Typist Series  ONE   
GS-0326 Office Automation Clerical and Assistance 

Series 
ONE   

GS-0332 Computer Operation Series ONE   
GS-0335 Computer Clerk and Assistant Series ONE   
GS-0340 Program Management Series  TWO   
GS-0341 Administrative Officer Series  TWO   
GS-0342 Support Services Administration Series  ONE   
GS-0343 Management and Program Analysis Series TWO   
GS-0344 Management and Program Clerical and 

Assistance Series 
ONE   

GS-0346 Logistics Management Series   TWO   
GS-0350 Equipment Operator Series  ONE   
GS-0351 Printing Clerical Series  ONE  2/ 
GS-0356 Data Transcriber Series  ONE   
GS-0357 Coding Series  ONE   
GS-0360 Equal Opportunity Compliance Series TWO   
GS-0361 Equal Opportunity Assistance Series  ONE   
GS-0382 Telephone Operating Series  ONE   
GS-0390 Telecommunications Processing Series  ONE   
GS-0391 Telecommunications Series TWO   
GS-0392 General Telecommunications Series ONE   
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-0394 Communications Clerical Series  ONE   
GS-0399 Administration and Office Support Student 

Trainee Series  
ONE   

GS-0401 General Natural Resources Management and 
Biological Sciences Series  

TWO   

GS-0403 Microbiology Series  TWO   
GS-0404 Biological Science Technician Series  ONE   
GS-0405 Pharmacology Series  TWO   
GS-0406 Agricultural Extension Series  TWO  2/ 
GS-0408 Ecology Series  TWO   
GS-0410 Zoology Series  TWO   
GS-0413 Physiology Series  TWO   
GS-0414 Entomology Series  TWO   
GS-0415 Toxicology Series  TWO   
GS-0421 Plant Protection Technician Series  ONE   
GS-0430 Botany Series TWO   
GS-0434 Plant Pathology Series TWO   
GS-0435 Plant Physiology Series TWO   
GS-0436 Plant Protection and Quarantine Series TWO  2/ 
GS-0437 Horticulture Series TWO   
GS-0440 Genetics Series TWO   
GS-0454 Rangeland Management Series TWO   
GS-0455 Range Technician Series ONE   
GS-0457 Soil Conservation Series TWO   
GS-0458 Soil Conservation Technician Series ONE   
GS-0459 Irrigation System Operation Series ONE   
GS-0460 Forestry Series TWO   
GS-0462 Forestry Technician Series ONE   
GS-0470 Soil Science Series TWO   
GS-0471 Agronomy Series TWO   
GS-0480 Fish and Wildlife Administration Series TWO   
GS-0482 Fish Biology Series TWO   
GS-0485 Wildlife Refuge Management Series TWO   
GS-0486 Wildlife Biology Series TWO   
GS-0487 Animal Science Series TWO   
GS-0493 Home Economics Series  TWO  2/ 
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-0499 Biological Science Student Trainee Series ONE   
GS-0501 Financial Administration and Program Series TWO   
GS-0503 Financial Clerical and Technician Series ONE   
GS-0505 Financial Management Series  TWO   
GS-0510 Accounting Series TWO   
GS-0511 Auditing Series TWO   
GS-0512 Internal Revenue Agent Series TWO   
GS-0525 Accounting Technician Series ONE   
GS-0526 Tax Specialist Series TWO   
GS-0530 Cash Processing Series ONE   
GS-0540 Voucher Examining Series ONE   
GS-0544 Civilian Pay Series ONE   
GS-0545 Military Pay Series ONE   
GS-0560 Budget Analysis Series TWO   
GS-0561 Budget Clerical and Assistance Series ONE   
GS-0592 Tax Examining Series ONE   
GS-0593 Insurance Accounts Series ONE   
GS-0599 Financial Management Student Trainee Series ONE   
GS-0601 General Health Science Series TWO   
GS-0602 Medical Officer Series TWO   
GS-0603 Physician Assistant Series TWO   
GS-0610 Nurse Series TWO   
GS-0620 Practical Nurse Series ONE   
GS-0621 Nursing Assistant Series ONE   
GS-0622 Medical Supply Aide and Technician Series ONE   
GS-0625 Autopsy Assistant Series ONE   
GS-0630 Dietitian and Nutritionist Series TWO   
GS-0631 Occupational Therapist Series TWO   
GS-0633 Physical Therapist Series TWO   
GS-0635 Kinesiotheraphy Series TWO   
GS-0636 Rehabilitation Therapy Assistant Series ONE   
GS-0637 Manual Arts Therapist Series TWO   
GS-0638 Recreation/Creative Arts Therapist Series TWO   
GS-0639 Educational Therapist Series TWO   
GS-0640 Health Aid and Technician Series ONE   
GS-0642 Nuclear Medicine Technician Series  ONE   
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-0644 Medical Technologist Series TWO   
GS-0645 Medical Technician Series ONE   
GS-0646 Pathology Technician Series ONE   
GS-0647 Diagnostic Radiologic Technologist Series ONE   
GS-0648 Therapeutic Radiologic Technologist Series ONE   
GS-0649 Medical Instrument Technician Series ONE   
GS-0650 Medical Technical Assistant Series ONE   
GS-0651 Respiratory Therapist Series ONE   
GS-0660 Pharmacist Series TWO   
GS-0661 Pharmacy Technician Series TWO   
GS-0662 Optometrist Series ONE   
GS-0664 Restoration Technician Series ONE YES 1/ 
GS-0665 Speech Pathology and Audiology Series TWO   
GS-0667 Orthotist and Prosthetist Series TWO   
GS-0668 Podiatrist Series TWO   
GS-0669 Medical Records Administration Series TWO   
GS-0670 Health System Administration Series TWO   
GS-0671 Health System Specialist Series TWO   
GS-0672 Prosthetic Representative Series ONE   
GS-0673 Hospital Housekeeping Management Series TWO   
GS-0675 Medical Records Technician Series ONE   
GS-0679 Medical Support Assistance Series ONE   
GS-0680 Dental Officer Series TWO   
GS-0681 Dental Assistant Series ONE   
GS-0682 Dental Hygiene Series ONE   
GS-0683 Dental Laboratory Aid and Technician Series ONE   
GS-0685 Public Health Program Specialist Series TWO   
GS-0688 Sanitarian Series TWO   
GS-0690 Industrial Hygiene Series TWO   
GS-0696 Consumer Safety Series TWO   
GS-0698 Environmental Health Technician Series ONE   
GS-0699 Medical and Health Student Trainee Series  ONE   
GS-0701 Veterinary Medical Science Series TWO   
GS-0704 Animal Health Technician Series ONE   
GS-0799 Veterinary Student Trainee Series ONE   
GS-0801 General Engineering Series TWO   
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-0802 Engineering Technical Series ONE   
GS-0803 Safety Engineering Series TWO   
GS-0804 Fire Protection Engineering Series TWO   
GS-0806 Materials Engineering Series TWO   
GS-0807 Landscape Architecture Series TWO   
GS-0808 Architecture Series TWO   
GS-0809 Construction Control Technical Series ONE   
GS-0810 Civil Engineering Series  TWO   
GS-0817 Survey Technical Series ONE   
GS-0818 Engineering Drafting Series ONE  2/ 
GS-0819 Environmental Engineering Series TWO   
GS-0828 Construction Analyst Series TWO   
GS-0830 Mechanical Engineering Series TWO   
GS-0840 Nuclear Engineering Series TWO   
GS-0850 Electrical Engineering Series TWO   
GS-0854 Computer Engineering Series TWO   
GS-0855 Electronics Engineering Series TWO   
GS-0856 Electronics Technical Series ONE   
GS-0858 Bioengineering and Biomedical Engineering 

Series 
TWO   

GS-0861 Aerospace Engineering Series TWO   
GS-0871 Naval Architecture Series TWO   
GS-0873 Marine Survey Technical Series ONE   
GS-0880 Mining Engineering Series TWO   
GS-0881 Petroleum Engineering Series TWO   
GS-0890 Agricultural Engineering Series TWO   
GS-0892 Ceramic Engineering Series TWO YES 1/ 
GS-0893 Chemical Engineering Series TWO   
GS-0894 Welding Engineering Series TWO YES 1/ 
GS-0895 Industrial Engineering Technical Series ONE   
GS-0896 Industrial Engineering Series TWO   
GS-0899 Engineering and Architecture Student Trainee 

Series 
ONE   

GS-0901 General Legal and Kindred Administration 
Series 

TWO   

GS-0904 Law Clerk Series TWO   
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-0905 General Attorney Series TWO   
GS-0920 Estate Tax Examining Series TWO  2/ 
GS-0930 Hearings and Appeals Series TWO  2/ 
GS-0935 Administrative Law Judge TWO   
GS-0945 Clerk of Court Series TWO   
GS-0950 Paralegal Specialist Series TWO   
GS-0958 Employee Benefits Law TWO   
GS-0962 Contact Representative Series* TWO   
GS-0963 Legal Instruments Examining Series ONE   
GS-0965 Land Law Examining Series TWO   
GS-0967 Passport and Visa Examining Series TWO   
GS-0986 Legal Assistance Series ONE   
GS-0987 Tax Law Specialist Series TWO   
GS-0991 Workers’ Compensation Claims Examining 

Series 
TWO   

GS-0993 Railroad Retirement Claims Examining Series TWO   
GS-0996 Veterans Claims Examining Series TWO   
GS-0998 Claims Assistance and Examining Series ONE   
GS-0999 Legal Occupations Student Trainee Series ONE   
GS-1001 General Arts and Information Series TWO   
GS-1002 General Arts & Information Technician ONE YES  
GS-1008 Interior Design Series TWO   
GS-1010 Exhibits Specialist Series TWO   
GS-1015 Museum Curator Series TWO   
GS-1016 Museum Specialist and Technician Series* TWO   
GS-1020 Illustrating Series  TWO   
GS-1021 Office Drafting Series ONE   
GS-1035 Public Affairs Series TWO   
GS-1040 Language Specialist Series TWO   
GS-1046 Language Clerical Series ONE   
GS-1051 Music Specialist Series TWO   
GS-1054 Theater Specialist Series TWO   
GS-1056 Art Specialist Series TWO   
GS-1060 Photography Series ONE   
GS-1071 Audiovisual Production Series TWO   
GS-1082 Writing and Editing Series TWO   
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-1083 Technical Writing and Editing Series  TWO   
GS-1084 Visual Information Series  TWO   
GS-1087 Editorial Assistance Series ONE   
GS-1099 Information and Arts Student Trainee Series ONE   
GS-1101 General Business and Industry Series TWO   
GS-1102 Contracting Series TWO   
GS-1103 Industrial Property Management Series  TWO   
GS-1104 Property Disposal Series  TWO   
GS-1105 Purchasing Series ONE   
GS-1106 Procurement Clerical and Technician Series  ONE   
GS-1107 Property Disposal Clerical and Technician 

Series  
ONE   

GS-1108 General Business Technician TWO YES  
GS-1130 Public Utilities Specialist Series  TWO   
GS-1140 Trade Specialist Series TWO   
GS-1144 Commissary Management Series* TWO   
GS-1145 Agricultural Program Specialist Series  TWO   
GS-1146 Agricultural Marketing Series TWO   
GS-1147 Agricultural Market Reporting Series TWO   
GS-1150 Industrial Specialist Series  TWO   
GS-1152 Production Control Series  ONE   
GS-1160 Financial Analysis Series  TWO   
GS-1163 Insurance Examining Series TWO   
GS-1165 Loan Specialist Series  TWO   
GS-1169 Internal Revenue Officer Series  TWO   
GS-1170 Realty Series  TWO   
GS-1171 Appraising Series  TWO   
GS-1173 Housing Management Series TWO   
GS-1176 Building Management Series  TWO   
GS-1199 Business and Industry Student Trainee Series  ONE   
GS-1202 Patent Technician Series  ONE   
GS-1210 Copyright Series  TWO   
GS-1220 Patent Administration Series TWO   
GS-1221 Patent Adviser Series  TWO   
GS-1222 Patent Attorney Series TWO   
GS-1223 Patent Classifying Series TWO   
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-1224 Patent Examining Series  TWO   
GS-1226 Design Patent Examining Series  TWO   
GS-1299 Copyright and Patent Student Trainee Series ONE   
GS-1301 General Physical Science Series  TWO   
GS-1306 Health Physics Series TWO   
GS-1310 Physics Series  TWO   
GS-1311 Physical Science Technician Series  ONE   
GS-1313 Geophysics Series  TWO   
GS-1315 Hydrology Series  TWO   
GS-1316 Hydrologic Technician Series ONE   
GS-1320 Chemistry Series  TWO   
GS-1321 Metallurgy Series  TWO   
GS-1330 Astronomy and Space Science Series  TWO   
GS-1340 Meteorology Series  TWO   
GS-1341 Meteorological Technician Series ONE   
GS-1350 Geology Series TWO   
GS-1360 Oceanography Series TWO   
GS-1361 Navigational Information Series  TWO   
GS-1370 Cartography Series  TWO   
GS-1371 Cartographic Technician Series  ONE   
GS-1372 Geodesy Series  TWO   
GS-1373 Land Surveying Series  TWO   
GS-1374 Geodetic Technician Series  ONE   
GS-1380 Forest Products Technology Series  TWO   
GS-1382 Food Technology Series  TWO   
GS-1384 Textile Technology Series  TWO   
GS-1386 Photographic Technology Series  TWO   
GS-1397 Document Analysis Series   TWO   
GS-1399 Physical Science Student Trainee Series  ONE   
GS-1410 Librarian Series TWO   
GS-1411 Library Technician Series  ONE   
GS-1412 Technical Information Services Series  TWO   
GS-1420 Archivist Series   TWO   
GS-1421 Archives Technician Series* TWO   
GS-1499 Library and Archives Student Trainee Series   ONE   
GS-1501 General Mathematics and Statistics Series TWO   
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-1510 Actuarial Science Series TWO   
GS-1515 Operations Research Series TWO   
GS-1520 Mathematics Series  TWO   
GS-1521 Mathematics Technician Series ONE   
GS-1529 Mathematical Statistics Series  TWO   
GS-1530 Statistics Series  TWO   
GS-1531 Statistical Assistant Series  ONE   
GS-1540 Cryptography Series  TWO   
GS-1541 Cryptanalysis Series  ONE   
GS-1550 Computer Science Series TWO   
GS-1599 Mathematics and Statistics Student Trainee 

Series  
ONE   

GS-1601 Equipment, Facilities and Services Series  TWO   
GS-1603 Equipment, Facilities and Services Assistance 

Series 
ONE   

GS-1630 Cemetery Administration Series  TWO   
GS-1640 Facility Operations Series TWO   
GS-1654 Printing Services Series  TWO   
GS-1658 Laundry Operations Series TWO   
GS-1667 Food Services Series  ONE   
GS-1670 Equipment Services Series  TWO   
GS-1699 Equipment Facilities, and Services Student 

Trainee Series  
ONE   

GS-1701 General Education and Training Series  TWO   
GS-1702 Education and Training Technician Series* TWO   
GS-1703 Education Specialist TWO YES  
GS-1710 Education and Vocational Training Series TWO   
GS-1712 Training Instruction Series TWO   
GS-1715 Vocational Rehabilitation Series TWO   
GS-1720 Education Program Series TWO   
GS-1725 Public Health Educator Series TWO   
GS-1730 Education Research Series  TWO   
GS-1740 Education Services Series   TWO   
GS-1750 Instructional Systems Series   TWO   
GS-1799 Education Student Trainee Series   ONE   
GS-1801 General Inspection, Investigation, TWO   
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

Enforcement and Compliance Series 
GS-1802 Compliance Inspection and Support Series  ONE   
GS-1805 Investigative Analysis Series TWO   
GS-1810 General Investigation Series  TWO   
GS-1811 Criminal Investigation Series TWO   
GS-1812 Game Law Enforcement Series TWO YES 1/ 
GS-1815 Air Safety Investigating Series  TWO   
GS-1816 Immigration Inspection Series  TWO  2/ 
GS-1822 Mine Safety and Health Inspection Series ONE   
GS-1825 Aviation Safety Series ONE   
GS-1831 Securities Compliance Examining Series  TWO  2/ 
GS-1849 Wage and Hour Investigation Series TWO   
GS-1850 Agricultural Warehouse Inspection Series  TWO   
GS-1854 Alcohol, Tobacco and Firearms Inspection 

Series  
TWO  2/ 

GS-1860 Equal Opportunity Investigation Series TWO   
GS-1862 Consumer Safety Inspection Series  ONE   
GS-1863 Food Inspection Series ONE   
GS-1864 Public Health Quarantine Inspection Series  TWO  2/ 
GS-1881 Customs and Border Protection Interdiction 

Series 
TWO   

GS-1884 Customs Patrol Officer Series  TWO  2/ 
GS-1889 Import Compliance Series  TWO   
GS-1890 Customs Inspection Series   TWO YES 1/ 
GS-1894 Customs Entry and Liquidating Series  TWO   
GS-1895 Customs and Border Protection Series TWO   
GS-1896 Border Patrol Enforcement Series   TWO   
GS-1897 Customs Aid Series  ONE YES 1/ 
GS-1899 Investigation Student Trainee Series  ONE   
GS-1910 Quality Assurance Series  TWO   
GS-1980 Agricultural Commodity Grading Series  TWO   
GS-1981 Agricultural Commodity Aid Series ONE   
GS-1999 Quality Inspection Student Trainee Series ONE   
GS-2001 General Supply Series TWO   
GS-2003 Supply Program Management Series  TWO   
GS-2005 Supply Clerical and Technician Series  ONE   
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SERIES SERIES DEFINITION 

NORMAL 
ONE GRADE/ 
TWO GRADE 
INTERVAL 

NSPS 
UNIQUE 
SERIES NOTES 

GS-2010 Inventory Management Series  TWO   
GS-2030 Distribution Facilities and Storage 

Management Series 
TWO   

GS-2032 Packaging Series ONE   
GS-2050 Supply Cataloging Series TWO YES 1/ 
GS-2091 Sales Store Clerical Series ONE   
GS-2099 Supply Student Trainee Series ONE   
GS-2101 Transportation Specialist Series TWO   
GS-2102 Transportation Clerk and Assistant Series  ONE   
GS-2110 Transportation Industry Analysis Series  TWO   
GS-2121 Railroad Safety Series TWO   
GS-2123 Motor Carrier Safety Series  TWO   
GS-2125 Highway Safety Series TWO   
GS-2130 Traffic Management Series TWO   
GS-2131 Freight Rate Series ONE   
GS-2135 Transportation Loss and Damage Claims 

Examining Series 
ONE   

GS-2144 Cargo Scheduling Series ONE   
GS-2150 Transportation Operations Series TWO   
GS-2151 Dispatching Series ONE   
GS-2152 Air Traffic Control Series TWO   
GS-2154 Air Traffic Assistance Series ONE   
GS-2161 Marine Cargo Series TWO   
GS-2181 Aircraft Operation Series TWO   
GS-2183 Air Navigation Series TWO   
GS-2185 Aircrew Technician Series ONE   
GS-2199 Transportation Student Trainee Series ONE   
GS-2210  Information Technology Management Series TWO   
GS-2203 Computer Operator ONE YES  
GG-2204 Computer Technician ONE YES  
GS-2299 Information Technology Student Trainee ONE   
 
*Series includes both one and two grade interval work – default to the two grade interval  
 
1/ These series were cancelled by OPM but will still be used by NSPS 



Attachment 2 – Designation of Series by One Grade/Two Grade Intervals                November 2011 

Staffing:  RIF Tool                                                                               Mod 4, Chap 13, Page 200 

2/ These series have been cancelled by OPM; however, there may still be employees 
occupying these series 
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Attachment 3 
RIF Processing Action, Placement Codes  

and Cleartext 
 

Action Codes 
AA Accepted Alternate Offer – used to document a placement pending acceptance by the 

employee 
AB Abolished – when the employee is marked as abolished 
BB Bumped By – when an employee is bumped from their position by another employee – 

Round 2 
BI Bumped Into – when an employee is placed through bump rights into another position 

(vacant or encumbered) – Round 2 
DB Displaced By – when an employee is displaced in Round 1 by another employee 
DI Displaced Into – when an employee displaces another employee in Round 1 
DS Displaced 
NO None – when an employee who is impacted in Round 1 or Round 2 whose position has not 

been abolished or when an employee is impacted in one iteration but not in another 
NP New Placement – a change was made to Round 1 placement 
PA Alternate Offer – Accepted Offer – used to document a placement when an employee has 

accepted an alternate offer – Round 2 
PB By-Passed – used to document when an employee with a mandatory exception based on 

armed forces service is by-passed during Round 2 
RB Retreated By – when an employee is retreated from their position by another employee – 

Round 2 
RI Retreated Into- when an employee is placed through retreat rights into another position 

(vacant or encumbered) – Round 2 
UV Used Vacancy – vacant position used in Round 1/Adjust Round 1/Round 2 
 

Placement Codes 
AO  Accepted Offer – Used to document when an employee has accepted an alternate offer 

during Round 2 
CG  Change to Lower Grade/Reduction in Band – when an employee is placed in a position at a 

lower representative rate 
CL  Change to Lower Grade in Lieu of RIF Separation – used to document when an employee 

is placed in a lower graded position in lieu of RIF Separation – Final Adjustments 
RL  Reassignment in Lieu of RIF Separation – used to document when an employee is placed 

at the same representative rate in lieu of RIF separation – Final Adjustments 
RN Reassignment Non-RIF – when an employee is place in another position in Round 1 
RR  Reassignment-RIF – when an employee is placed in a position at the same representative 

rate – Round 2 
SE  Separated – when no position is found to place the employee in Round 1 or Round 2 
UV  Used Vacancy – vacant position used in Round 1/Adjust Round 1/Round 2 
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Attachment 4 
DCPDS RIF Tool Reports 

 
Below is a list of reports that are available within the DCPDS RIF Tool.  A description of each 
report is listed below.   
 
Report 
# Report Name Report Description 
1. ARIF_ABCLISTING Alphabetical Listing Report  
2. ARIF_ABOLISH Abolishment Report 
3. ARIF_ABOLISH_ABBR Abolishment List – Abbreviated Report  
4. ARIF_ACTIONS Actions Report 
5. ARIF_ACTIONS_ABBR Actions – Abbreviated Report 
6. ARIF_AFRESTORATION Armed Forces Restoration Right Report  
7. ARIF_CLC_SAME_TITLE CLC Discrepancies – same CLC assigned to 

different series Report  
8. ARIF_CLC_DIFF_TITLE CLC Discrepancies – Different Position Titles, 

PP-SRS-GR with the same CLC Report  
9. ARIF_CLC_DIFF_SERIES CLC Discrepancies – Same Position Title, PP-

SRS-GR with different CLCs Report  
10. ARIF_DISVETS Disabled Veterans Impact Report 
11. ARIF_DUTYSTATUS Duty Status Report  
12. ARIF_EEOSTATS EEO Statistics for Actions – ERI Report 
13. ARIF_EEOSTATS_COMPLVL EEO Statistics for Actions by PP-Series-GR-CL – 

ERI Report 
14. ARIF_EEOSTATS_WKFORCE EEO Statistics for Workforce Report 
15. ARIF_ERR_WARNINGS Error/Warning Messages for Positions/Employees 

Report  
16. ARIF_FINAL_REMOVAL Final Written of Removal Decision Under 

5CFR432 or 5CFR752 Report  
17. ARIF_GAINLOSS Gains – Losses – Movement Report 
18. ARIF_HANDICAP Handicap Impact Report 
19. ARIF_HISTORY RIF History Report  
20. ARIF_LEFTVACANCIES Leftover Vacancies Report 
21. ARIF_LINESOFPROGRESSION Lines of Progression Report 
22. ARIF_LOWAPPREMPS Minimally Satisfactory/Unacceptable Employees 

Report 
23. ARIF_MODALRATING Modal Rating Report 
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Report 
# Report Name Report Description 
24 ARIF_MPTEXCEPTIONS Mandatory/Permissive/Temporary Exception 

Report  
25. ARIF_PLACEEXCEPT Placement Exceptions Report 
26. ARIF_REMOVEDRIF Removed from RIF Report 
27. ARIF_REPRATES Representative Rate Report 
28. ARIF_RETREG Retention Register – Basic Report  
29. ARIF_RETREGNOPA Retention Register – Standard – No Privacy Act 

Report  
30. ARIF_RETREGSTANDARD Retention Register – Standard Report  
31. ARIF_RIPOPTS RIF Options Report  
32. ARIF_RIFSUMMARY RIF Summary Report  
33. ARIF_ROUND1_RPT RIF Action – Round 1 
34.  RIF Action – Round 2 
35. ARIF_SRS_GRD_INTERVAL Designation of Series by One Grade/Two Grade 

Interval Report  
36. ARIF_TENURE Tenure Report 
37. ARIF_TENURE0 Tenure 0 Employees Report 
38. ARIF_TIEBREAK Tenure Tie Break Report 
39. ARIF_VACANCIES Vacancies Report 
40. ARIF_WORKSHEET Worksheet Report  
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1. Alphabetical Listing Report  
 a. Report Name – ARIF_ABCLISTING 
 b. Purpose of Report – Lists all employees within the RIF database except the 

following employees: 
  (1) Tenure 0 
  (2) Remove from RIF 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report: 
  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) SSAN 
  (5) Pay Plan 
  (6) Occupational Series 
  (7) Grade or Level 
  (8) Competitive Level Code 
  (9) Position Title 
  (10) Organizational Code 
  (11) Tenure 
  (12) Subgroup 
  (13) Adjusted SCD-RIF 
 e. Sort Order 
  (1) The sort order default is alphabetically by Name.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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2. Abolishment Report 
 a. Report Name – ARIF_ABOLISH 
 b. Purpose of Report – Lists all positions that have been abolished – positions have 

been marked with a code of AB.   
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report: 
  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) SSAN 
  (5) Pay Plan 
  (6) Occupational Series 
  (7) Grade or Level 
  (8) Competitive Level Code 
  (9) Position Title 
  (10) Organization  
 e. Sort Order 
  (1) The sort order default is alphabetically by Name.  
  (2) The following data elements will be available to sort the report. 
   (a) Name – default 
   (b) CPCN 
   (c) SSAN 
   (d) PP-SRS-GR-CLC 
   (e) Org Code 
 f. Sample Report 
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3. Abolishment List – Abbreviated Report  
 a. Report Name – ARIF_ABOLISH_ABBR 
 b. Purpose of Report – This report uses the same criteria as the Abolishment 

Report except the report shows only the Org Code and PAS/UIC and not the full 
organizational information – positions have been marked with a code of AB. 

 c. Availability of Report – This report is available at any time during the RIF 
process. 

 d. Filter Conditions – the following data elements will be available to filter the 
report: 

  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) SSAN 
  (5) Pay Plan 
  (6) Occupational Series 
  (7) Grade or Level 
  (8) Competitive Level Code 
  (9) Position Title 
  (10) Organization (UIC/PAS) 
 e. Sort Order  
  (1) The sort order default is alphabetically by Name 
  (2) The following data elements will be available to sort the report.   
   (a) Name  
   (b) CPCN 
   (c) SSAN 
   (d) PP-SRS-GR-CLC 
   (e) Org Code 
 f. Sample Report 
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4. Actions Report 
 a. Report Name – ARIF_ACTIONS 
 b. Purpose of Report – Lists employees that have been impacted by the RIF 

process and shows all actions that took place during the RIF process.   
 c. Availability of Report – This report will only be available after Round 1 is 

processed and is only available at a .PDF using a concurrent process.   
 d. Filter Conditions – The following data elements will be available to filter the 

report: 
  (1) Employee Name 
  (2) CPCN 
  (3) SSAN 
  (4) Pay Plan 
  (5) Occupational Series 
  (6) Grade or Level 
  (7) Competitive Level Code 
  (8) Position Title 
  (9) Org Code 
  (10) Tenure 
  (11) Subgroup 
  (12) Adjusted SCD-RIF 
 e. Sort Order 
  (1) The sort order default is by PP-SRS-GR-CLC. 
  (2) The following data elements will be available to sort the report.   
   (a) Name 
   (b) Org Code and Name 
   (c) Type of Placement and Name 
   (d) PP-SRS-GR-CLC and Name 
 f. Sample Report 
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5. Actions – Abbreviated Report 
 a. Report Name – ARIF_ACTIONS_ABBR 
 b. Purpose of Report – Lists employees that have been impacted by the RIF 

process.  This report shows only the codes used during the process and only the 
final placement. 

 c. Availability of Report – This report will only be available after Round 1 is 
processed and is only available at a .PDF using a concurrent process. 

 d. Filter Conditions – The following data elements will be available to filter the 
report: 

  (1) Employee Name 
  (2) CPCN 
  (3) SSAN 
  (4) Pay Plan 
  (5) Occupational Series 
  (6) Grade or Level 
  (7) Competitive Level Code 
  (8) Position Title 
  (9) Org Code 
  (10) Tenure 
  (11) Subgroup 
  (12) Adjust SCD-RIF 
 e. Sort Order –  
  (1) The sort order default is by ???? 
  (2) The following data elements will be available to sort the report.   
   (a) Name – default 
   (b) Org Code and Name 
   (c) PP-SRS-GR-CLC and Name 
 f. Sample Report 
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6. Armed Forces Restoration Right Report  
 a. Report Name – ARIF_AFRESTORATION 
 b. Purpose of Report – Lists all positions that have been selected as Armed Forces 

Restoration Right. 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) SSAN 
  (5) Pay Plan 
  (6) Occupational Series 
  (7) Grade or Level 
  (8) Competitive Level Code 
  (9) Position Title 
  (10) Organizational Code 
  (11) Tenure 
  (12) Subgroup 
  (13) Adjusted SCD-RIF 
 e. Sort Order 
  (1)  The sort order default is alphabetically by Name.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 

 
 
 



Attachment 4 – DCPDS RIF Reports                                                                          November 2011 

Staffing:  RIF Tool                                                                               Mod 4, Chap 13, Page 211 

7. CLC Discrepancies – same CLC assigned to different series Report  
 a. Report Name – ARIF_CLC_SAME_TITLE 
 b. Purpose of Report – Lists all positions have a different position title and PP-

SRS-GR but have the CLC 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Name 
  (2) CPCN 
  (3) SSAN 
  (4) Pay Plan 
  (5) Occupational Series 
  (6) Grade or Level 
  (7) Position Title 
  (8) Organizational Code 
 e. Sort Order 
  (1) The default sort order for this report is alphabetically/numerically by (1) 

Position Title and PP-SRS-GR (2) CLC.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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8. CLC Discrepancies – Different Position Titles, PP-SRS-GR with the same CLC 
Report  

 a. Report Name – ARIF_CLC_DIFF_TITLE 
 b. Purpose of Report – Lists all positions that have the same CLC but the series is 

different – grouped by CLC. 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Name 
  (2) CPCN 
  (3) SSAN 
  (4) Pay Plan 
  (5) Occupational Series 
  (6) Grade or Level 
  (7) Position Title 
  (8) Organizational Code 
 e. Sort Order  
  (1) The default sort order for this report is alphabetically/numerically by (1) 

CLC and (2) PP-SRS-GR. 
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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9. CLC Discrepancies – Same Position Title, PP-SRS-GR with different CLCs Report  
 a. Report Name – ARIF_CLC_DIFF_SERIES 
 b. Purpose of Report – Lists all positions that have the same Position Title and PP-

SRS-GR but have different CLC – group by CLC. 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Name 
  (2) CPCN 
  (3) SSAN 
  (4) Pay Plan 
  (5) Occupational Series 
  (6) Grade or Level 
  (7) Position Title 
  (8) Organizational Code 
 e. Sort Order 
  (1) The default sort order for this report is alphabetically/numerically by (1) 

CLC and (2) PP-SRS-GR.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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10. Disabled Veterans Impact Report 
 a. Report Name – ARIF_DISVETS 
 b. Purpose of Report – Lists all employees where VP-RIF = 6 and are impacted in 

the RIF process.   
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report: 
  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) Pay Plan 
  (5) Occupational Series 
  (6) Grade or Level 
  (7) Competitive Level Code 
  (8) Position Title 
  (9) Veterans Appointment Preference 
  (10) Handicap Code 
  (11) RIF Action Taken 
 e. Sort Order 
  (1) The default sort order for this report is alphabetically by Name.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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11. Duty Status Report  
 a. Report Name – ARIF_DUTYSTATUS 
 b. Purpose of Report – Lists all employees that have a Duty Status Code Other than 

00 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) SSAN 
  (5) Pay Plan 
  (6) Occupational Series 
  (7) Grade or Level 
  (8) Competitive Level Code 
  (9) Position Title 
  (9) Organizational Code 
  (11) Duty Status 
 e. Sort Order 
  (1) The default sort order for this report is alphabetically by Name.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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12. EEO Statistics for Actions – ERI Report 
 a. Report Name – ARIF_EEOSTATS 
 b. Purpose of Report – Count of those employees impacted in the RIF employees 

by (1) Gender (2) Race or National Origin and (3) type of action  
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – There are no filter conditions available for this report.   
 e. Sort Order  
  (1) The default sort order is alphabetical/numerical by (1) Gender and (2) 

Race or National Indicator.   
  (2) There are no data elements available to sort this report 
 
e. Sample Report 
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13. EEO Statistics for Actions by PP-Series-GR-CL – ERI Report 
 a. Report Name – ARIF_EEOSTATS_COMPLVL 
 b. Purpose of Report – Count of those employees impacted in the RIF employees 

by (1) Gender (2) Race or National Origin (3) Gender and (4) type of action  
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – There are no filter conditions available for this report.   
 e. Sort Order 
  (1) The default sort order is alphabetically/numerically order by PP-SRS-GR-

CLC and then by Race or National Indicator. 
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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14. EEO Statistics for Workforce Report 
 a. Report Name – ARIF_EEOSTATS_WKFORCE 
 b Purpose of Report – Count of employees by (1) Race or National Origin (2) 

Gender for the RIF database  
 c Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – There are no filter conditions available for this report.   
 e. Sort Order 
  (1) The default sort order is numerically by Race or National Indicator.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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15. Error/Warning Messages for Positions/Employees Report  
 a. Report Name – ARIF_ERR_WARNINGS 
 b. Purpose of Report – List of employees with error or warning messages  
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Last Name 
  (2) First Name 
  (3) SSAN 
  (4) CPCN 
  (5) Pay Plan 
  (6) Occupational Series 
  (7) Position Title 
  (8) Position Error/Warning Message 
  (9) Employee Error/Warning Message 
 e. Sort Order  
  (1) The default sort order is alphabetically by Name 
  (2) The following data elements will be available to sort the report: 
   (a) Name 
   (b) CPCN 
 f. Sample Report 
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16. Final Written of Removal Decision Under 5CFR432 or 5CFR752 Report  
 a. Report Name – ARIF_FINAL_REMOVAL 
 b. Purpose of Report – List of employees with an Exception Type (Additional 

Employee Information Area of the Employee Tab) of Final Written Decision of 
Removal Under 5CFR432 or Final Written Decision of Removal Under 5CFR752 
has been selected  

 c. Availability of Report – This report is available at any time during the RIF 
process. 

 d. Filter Conditions – the following data elements will be available to filter the 
report 

  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) SSAN 
  (5) Pay Plan 
  (6) Occupational Series 
  (7) Position Title 
  (8) Organizational Code 
 e. Sort Order  
  (1) The default sort order is alphabetically by Name 
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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17. Gains – Losses – Movement Report 
 a. Report Name – ARIF_GAINLOSS 
 b. Purpose of Report – Lists all employees that have been impacted in the RIF, 

showing their current position and projected position or separation.   
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Last Name 
  (2) First Name 
  (3) From CPCN 
  (4) From Pay Plan 
  (5) From Occupational Series 
  (6) From Grade or Level 
  (7) From Competitive Level 
  (8) From Position Title 
  (9) From Organizational Data 
  (10) To CPCN 
  (11) To Pay Plan 
  (12) To Occupational Series 
  (13) To Grade or Level 
  (14) To Competitive Level 
  (15) To Position Title 
  (16) To Organizational Data 
 e. Sort Order  
  (1) The default sort order is alphabetically by Name 
  (2) The following data elements will be available to sort the report: 
   (a) Name 
   (b) CPCN 
 f. Sample Report 
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18. Handicap Impact Report 
 a. Report Name – ARIF_HANDICAP 
 b. Purpose of Report – Lists all employees that are impacted in the RIF process 

with a Handicap Code of other than 05 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
   
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) Pay Plan 
  (5) Occupational Series 
  (6) Grade or Level 
  (7) Competitive Level Code 
  (8) Position Title 
  (9) SSAN 
  (10) Handicap Code 
  (11) RIF Action 
 e. Sort Order 
  (1) The default sort order is alphabetically by Name 
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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19. RIF History Report  
 a. Report Name – ARIF_HISTORY 
 b. Purpose of Report – Shows RIF employee history  
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Name 
  (2) CPCN 
  (3) SSAN 
  (4) Pay Plan 
  (6) Occupational Series 
  (7) Grade or Level 
  (8) Competitive Level Code 
  (9) Tenure 
  (10) Subgroup 
  (11) Adjusted SCD-RIF 
  (12) Position Title 
  (13) Organization 
 e. Sort Order 
  (1) The default sort order is alphabetically by Name 
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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20. Leftover Vacancies Report 
 a. Report Name – ARIF_LEFTVACANCIES 
 b. Purpose of Report – Lists all positions that were not used in the RIF Process.   
 c. Availability of Report – This report is available after processing Round 1 and/or 

Round 2 ???? 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) CPCN 
  (2) Pay Plan 
  (3) Occupational Series 
  (4) Grade or Level 
  (5) Competitive Level Code 
  (6) Position Title 
  (7) Organizational Data 
 e. Sort Order  
  (1) The default sort order is alphabetically/numerically by CPCN 
  (2) The following data elements will be available to sort the report: 
   (a) CPCN 
   (b) PP-SRS-GR-CLC 
   (c) Org Code 
 f. Sample Report 
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Report #21 – Lines of Progression Report 
 a. Report Name – ARIF_LINESOFPROGRESSION 
 b. Purpose of Report – Lists all lines of progression that have been entered for the 

RIF.   
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – There are no filter conditions for this report.   
 e. Sort Order – This report is automatically sorted alphabetically/numerically by 

PP-SRS-GR 
  (1) The default sort order is alphabetically by PP-SRS-GR 
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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22. Minimally Satisfactory/Unacceptable Employees Report 
 a. Report Name – ARIF_LOWAPPREMPS 
 b. Purpose of Report – Lists all positions that have been abolished 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) SSAN 
  (5) Pay Plan 
  (6) Occupational Series 
  (7) Grade or Level 
  (8) Competitive Level Code 
  (9) Position Title 
  (10) Organizational Code 
  (11) Current Summary Rating Level 
 e. Sort Order  
  (1) The default sort order is alphabetically by Name 
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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23. Modal Rating Report 
 a. Report Name – ARIF_MODALRATING 
 b. Purpose of Report – Shows only those employees where a modal rating was 

applied 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Last Name 
  (2) First Name 
  (3) SSAN 
  (4) Pay Plan 
  (5) Occupational Series 
  (6) Grade or Level 
  (7) Competitive Level Code 
  (8) Org Code 
  (9) Tenure 
  (10) Subgroup 
  (11) Adjusted SCD-RIF 
  (12) Modal Pattern 
  (13) Modal Rating 
 e. Sort Order  
  (1) The default sort order is alphabetically by Name 
  (2) The following data elements will be available to sort the report: 
   (a) Name 
   (b) SSAN 
   (c) Modal Pattern, Name 
 f. Sample Report 
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24. Mandatory/Permissive/Temporary Exception Report  
 a. Report Name – ARIF_MPTEXCEPTIONS 
 b. Purpose of Report – Lists all employees where a 

Mandatory/Permissive/Temporary Exception has been utilized 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) SSAN 
  (5) Pay Plan 
  (6) Occupational Series 
  (7) Grade or Level 
  (8) Position Title 
  (9) Organizational Code 
  (10) Mandatory/Permissive/Temporary Exception 
  (11) Exception End Date 
  (12) Exception Remarks 
 e. Sort Order  
  (1) The default sort order is alphabetically by Name 
  (2) The following data elements will be available to sort the report: 
   (a) Name 
   (b) Type of Exception and Name 
   (c) Exception End Date and Name 
 f. Sample Report 
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25. Placement Exceptions Report 
 a. Report Name – ARIF_PLACEEXCEPT 
 b. Purpose of Report – Lists all positions that a placement exception was used 
 c. Availability of Report – This report is available at any time during the RIF 

process????. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) SSAN 
  (5) Pay Plan 
  (6) Occupational Series 
  (7) Grade or Level 
  (8) Competitive Level Code 
  (9) Position Title 
 e. Sort Order  
  (1) The default sort order is alphabetically by Name 
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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26. Removed from RIF Report 
 a. Report Name – ARIF_REMOVEDRIF 
 b. Purpose of Report – Lists all positions that have been identified as removed 

from RIF 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) Pay Plan 
  (5) Occupational Series 
  (6) Grade or Level 
  (7) Competitive Level Code 
  (8) Position Title 
  (9) Tenure 
  (10) Subgroup 
  (11) Org Code 
  (12) Removed from RIF Comments 
 e. Sort Order 
  (1) The default sort order is alphabetically by Name 
  (2) The following data elements will be available to sort the report: 
   (a) Name and CPCN 
   (b) CPCN 
 f. Sample Report 
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27. Representative Rate Report 
 a. Report Name – ARIF_REPRATES 
 b. Purpose of Report – Lists all representative rates that have been added to the 

representative rate table. 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Pay Table 
  (2) Pay Plan 
  (3) Grade 
  (4) Hourly Rate 
 e. Sort Order 
  (1) The default sort order is alphabetically by Name 
  (2) The following data elements will be available to sort the report: 
   (a) Pay table, PP-GR 
   (b) PP-GR 
   (c) Rate 
 f. Sample Report 
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28 Retention Register – Basic Report  
 a. Report Name – ARIF_RETREG 
 b. Purpose of Report – Retention Register with no privacy act information, no 

placement actions and no appraisal information.   
 c. Availability of Report – This report is available at any time during the RIF 

process and is only available at a .PDF using a concurrent process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Tenure 
  (2) SCD-RIF 
  (3) Adjusted SCD 
  (4) Name 
  (5) Position Title 
 e. Sort Order  
  (1) The default sort order is alphabetically/numerically by PP-SRS-GR-CLC 

and then by retention standing.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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29. Retention Register – Standard – No Privacy Act Report  
 a. Report Name – ARIF_RETREGNOPA 
 b. Purpose of Report – Retention Register includes privacy act information with 

placement actions and no appraisal information.   
 c. Availability of Report – This report is available at any time during the RIF 

process and is only available at a .PDF using a concurrent process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report: 
  (1) Name 
  (2) CPCN 
  (3) Position Title 
  (4) Organization 
  (5) Tenure 
  (6) Subgroup 
  (7) SCD-RIF 
  (8) Adjusted SCD 
 e. Sort Order  
  (1) The default sort order is alphabetically/numerically by PP-SRS-GR-CLC 

and then by reverse retention standing.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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30. Retention Register – Standard Report  
 a. Report Name – ARIF_RETREGSTANDARD 
 b. Purpose of Report – Retention Register includes privacy act information with 

placement actions and appraisal information.   
 c. Availability of Report – This report is available at any time during the RIF 

process and is only available at a .PDF using a concurrent process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Subgroup 
  (2) Tenure 
  (3) SCD-RIF 
  (4) Adjusted SCD 
  (5) Name 
  (6) SSAN 
  (7) CPCN 
  (8) Position Title 
  (9) Organization 
 e. Sort Order  
  (1) The default sort order is alphabetically/numerically by PP-SRS-GR-CLC 

and then by reverse retention standing.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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31. RIF Options Report  
 a. Report Name – ARIF_RIFOPTS 
 b. Purpose of Report – Shows all RIF Options used 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – There are no filter conditions for this report.   
 e. Sort Order – There are no sort order conditions available for this report.   
 f. Sample Report 
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32. RIF Summary Report 
 a. Report Name – ARIF_RIFSUMMARY 
 b. Purpose of Report – Lists all positions/employees within the RIF database and 

the type of action taken 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Name 
  (2) Pay Plan 
  (3) Occupational Series 
  (4) Grade or Level 
  (5) Competitive Level Code 
  (6) Tenure 
  (7) Subgroup 
  (8) Adjusted SCD-RIF 
  (9) Final Placement 
 e. Sort Order  
  (1) The default sort order is alphabetically/numerically by PP-SRS-GR-CLC 

and then by retention standing.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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33. RIF Action – Round 1 
 a. Report Name – ARIF_ROUND1_RPT 
 b. Purpose of Report – Lists all employees impacted during Round 1 processing.   
 c. Availability of Report – After Round 1 is run. 
 d. Filter Conditions – There are no filter conditions available for this report.   
 e. Sort Order – There are no data elements available to sort the report. 
 f. Sample Report 
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34. RIF Action – Round 2 
 a. Report Name –  
 b. Purpose of Report – Lists all employees impacted during Round 2 processing.   
 c. Availability of Report – After Round 2 is run. 
 d. Filter Conditions – There are no filter conditions available for this report.   
 e. Sort Order – There are no data elements available to sort the report. 
 f. Sample Report 
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35. Designation of Series by One Grade/Two Grade Interval Report  
 a. Report Name – ARIF_SRS_GRD_INTERVAL 
 b. Purpose of Report – Lists the GS occupational series whether the series is a one 

or two grade interval.  The data contained in this report is not updateable.   
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – There are no filter conditions available.   
 e. Sort Order – There is no sort capability for this report.  The default sort order for 

this report is numerically by occupational series.   
 f. Sample Report  
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36. Tenure Report 
 a. Report Name – ARIF_TENURE 
 b. Purpose of Report – List of employees in retention standing order 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report: 
  (1) CPCN 
  (2) SSAN 
  (3) Pay Plan 
  (4) Occupational Series 
  (5) Grade or Level 
  (6) Competitive Level Code 
  (7) Tenure 
  (8) Subgroup 
  (9) Adjusted SCD-RIF 
  (10) Position Title 
  (11) Organization 
  (12) Last Name 
  (13) First Name 
 e. Sort Order  
  (1) The default sort order is alphabetically/numerically by Tenure/Subgroup 

in retention standing.   
  (2) There are no data elements available to sort this report 
 f. Sample Report 
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37. Tenure 0 Employees Report 
 a. Report Name – ARIF_TENURE0 
 b. Purpose of Report – Lists all employees with a Tenure = 0 
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Last Name 
  (2) First Name 
  (3) CPCN 
  (4) SSAN 
  (5) Pay Plan 
  (6) Occupational Series 
  (7) Grade or Level 
  (8) Competitive Level Code 
  (9) Position Title 
  (10) Organizational Code 
  (11) Employee NTE Date 
  (12) Position NTE Date 
 e. Sort Order 
  (1) The default sort order is alphabetically by Name 
  (2) The following data elements will be available to sort the report: 
   (a) Name 
   (b) Employee NTE Date 
 f. Sample Report 
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38. Tenure Tie Break Report 
 a. Report Name – ARIF_TIEBREAK 
 b. Purpose of Report – Lists all employees with the same Tenure/Adjusted SCD-

RIF.   
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Tenure 
  (2) Subgroup 
  (3) Adjusted SCD-RIF 
  (4) SSAN 
  (5) Last Name 
  (6) First Name 
 e. Sort Order 
  (1) The default sort order is alphabetically by Tenure/Adjusted SCD-RIF 
  (2) There is no sort order available for this report.   
 f. Sample Report 
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39. Vacancies Report 
 a. Report Name – ARIF_VACANCIES 
 b. Purpose of Report – Lists all vacancies within the RIF database.   
 c. Availability of Report – This report is available at any time during the RIF 

process. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) CPCN 
  (2) Position Title 
  (3) Pay Plan 
  (4) Occupational Series 
  (5) Grade or Level 
  (6) Competitive Level Code 
  (7) Organization 
 e. Sort Order 
  (1) The default sort order is alphabetically by CPCN 
  (2) The following data elements will be available to sort the report: 
   (a) CPCN 
   (b) Position Title 
   (c) Org Code 
   (d) PP-SRS-GR-CLC 
 f. Sample Report 
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40. Worksheet Report  
 a. Report Name – ARIF_WORKSHEET 
 b. Purpose of Report – Lists of all employees impacted in the RIF process and 

shows all actions taken during each iteration.   
 c. Availability of Report – This report is available at the end of Round 2. 
 d. Filter Conditions – the following data elements will be available to filter the 

report 
  (1) Name 
  (2) SSAN 
 e. Sort Order 
  (1) The default sort order is alphabetically by Name 
  (2) The following data elements will be available to sort the report: 
   (a) Name 
 f. Sample Report 
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Attachment 5 
DCPDS RIF Tool Notices 

 
1. List of notices that are available within the DCPDS RIF Tool.   
 
Notice 
# Report Name Report Description 

AIR FORCE NOTICES 
1. AF_ARIF_CANCELLATION Air Force – Cancellation Notice 
2. AF_ARIF_CTLG Air Force – RIF Change to Lower Grade Notice 
3. AF_ARIF_CTLG_LSEP Air Force – Change to Lower Grade Notice – In 

Lieu of Separation 
4. AF_ARIF_CTLG_LSEP_TERM Air Force – Change to Lower Grade Notice – In 

Lieu of Separation – Term Employee 
5. AF_ARIF_RN_LSEP Air Force – Management Reassignment Notice – 

In Lieu of Separation 
6. AF_ARIF_RN_NR Air Force – Management Reassignment – NonRIF 

Notice 
7. AF_ARIF_RN_RIF Air Force – Management Reassignment – RIF 

Notice 
8. AF_ARIF_SEP Air Force – RIF Separation Notice 
9. AF_ARIF_SEP_OVERSEAS Air Force – RIF Separation Notice – Excepted 

Service – Overseas Family Member 
10. AF_ARIF_SEP_TERM Air Force – RIF Separation Notice – Term 

Employee 
ARMY NOTICES 

11. AR_ARIF_CANCELLATION Army – Cancellation Notice 
12. AR_ARIF_CTLG Army – RIF Change to Lower Grade Notice 
13. AR_ARIF_CTLG_LSEP Army – Change to Lower Grade Notice – In Lieu 

of Separation 
14. AR_ARIF_CTLG_LSEP_TERM Army – Change to Lower Grade Notice – In Lieu 

of Separation – Term Employee 
15. AR_ARIF_RN_BO Army – Management Reassignment Notice – RIF 

Notice – Better Offer 
16. AR_ARIF_RN_LSEP Army – Management Reassignment Notice – In 

Lieu of Separation 
17. AR_ARIF_RN_NR Army – Management Reassignment – NonRIF 

Notice 
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Notice 
# Report Name Report Description 
18. AR_ARIF_RN_RIF Army – Management Reassignment – RIF Notice 
19. AR_ARIF_SEP Army – RIF Separation Notice 
20. AR_ARIF_SEP_OVERSEAS Army – RIF Separation Notice – Excepted Service 

– Overseas Family Member 
21. AR_ARIF_SEP_TERM Army – RIF Separation Notice – Term Employee 

NAVY NOTICES 
22. NV_ARIF_CANCELLATION Navy – Cancellation Notice 
23. NV_ARIF_CERT_EXP_SEP Navy – Certificate of Expected Separation 
24. NV_ARIF_CTLG Navy – RIF Change to Lower Grade Notice 
25. NV_ARIF_CTLG_BO Navy – RIF Change to Lower Grade Notice – 

Better Offer 
26. NV_ARIF_CTLG_LSEP Navy – Change to Lower Grade Notice – In Lieu 

of Separation 
27. NV_ARIF_RN_BO Navy – Management Reassignment Notice – RIF 

Notice – Better Offer 
28. NV_ARIF_RN_LSEP Navy – Management Reassignment Notice – In 

Lieu of Separation 
29. NV_ARIF_RN_RIF Navy – Management Reassignment – RIF Notice 
30. NV_ARIF_SEP_NO_SEV Navy – RIF Separation Notice without Severance 

Pay 
31. NV_ARIF_SEP_SEV Navy – RIF Separation Notice with Severance Pay 

SPECIAL PARAGRAPHS 
1. Bargaining Unit Appeal 

Paragraph 
All component letters 

2. Temporary Exception Paragraph All component letters 
3. Temporary Exception– More 

Severe Action Paragraph 
All component letters 

4. Separation – Temporary 
Exception 

All component letters 

5. Right of First Refusal Form Navy only letters 
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2. Fillable Notice Data Fields/Special Paragraphs  
 

AIF FORCE NOTICES 

Fillable Notice Data Fields C
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Issuing Office Symbol X X X X X X X X X X 
Issuing Office Street Address X X X X X X X X X X 
Issuing Office City, State, Zip Code X X X X X X X X X X 
RIF Location      X     
RIF POC X X X X X X X X X X 
RIF POC Telephone X X X X X X X X X X 
Reason for RIF  X X X X  X X X X 
Description of Competitive Area  X X X X  X X X X 
Benefits and Entitlement POC  X X X X  X X X X 
Benefits and Entitlement Address  X X X X  X X X X 
Benefits and Entitlement Phone Number  X X X X  X X X X 
MSPB Office  X X X    X X X 
MSPB Address  X X X    X X X 
Signature Block Line 1 X X X X X X X X X X 
Signature Block Line 2 X X X X X X X X X X 
Signature Block Line 3 X X X X X X X X X X 
RIF POC E-mail Address X X X X X X X X X X 
SPECIAL PARAGRAPHS           
Bargaining Unit Appeal  Para 4 Para 4 Para 4    Para 5 Para 4 Para 4 
Separation – Temporary Exception  Para 3 Para 3 Para 3    Para 3 Para 3 Para 3 
Temporary Exception Paragraph  Para 3 Para 3 Para 3    Para 3 Para 3 Para 3 
Temporary Exception – More Severe Action Paragraph  Para 3 Para 3 Para 3    Para 3 Para 3 Para 3 
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ARMY NOTICES 

Fillable Notice Data Fields C
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Issuing Office Symbol X X X X X X X X X X X 
Issuing Office Street Address X X X X X X X X X X X 
Issuing Office City, State, Zip Code X X X X X X X X X X X 
RIF Location       X     
RIF POC X X X X X X X X X X X 
RIF POC Telephone X X X X X X X X X X X 
Reason for RIF  X X X X X  X X X X 
Description of Competitive Area  X X X X X  X X X X 
Benefits and Entitlement POC  X X X X X  X X X X 
Benefits and Entitlement Address  X X X X X  X X X X 
Benefits and Entitlement Phone Number  X X X X X  X X X X 
MSPB Office  X X X     X X X 
MSPB Address  X X X     X X X 
Signature Block Line 1 X X X X X X X X X X X 
Signature Block Line 2 X X X X X X X X X X X 
Signature Block Line 3 X X X X X X X X X X X 
RIF POC E-mail Address X X X X X X X X X X X 
SPECIAL PARAGRAPHS           
Bargaining Unit Appeal  Para 4 Para 4 Para 4     Para 5 Para 4 Para 4 
Separation – Temporary Exception  Para 3 Para 3 Para 3     Para 3 Para 3 Para 3 
Temporary Exception Paragraph  Para 3 Para 3 Para 3     Para 3 Para 3 Para 3 
Temporary Exception – More Severe Action 
Paragraph  Para 3 Para 3 Para 3     Para 3 Para 3 Para 3 
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NAVY NOTICES 

Fillable Notice Data Fields C
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Issuing Office Symbol X X X X X X X X X X 
Issuing Office Street Address X X X X X X X X X X 
Issuing Office City, State, Zip Code X X X X X X X X X X 
RIF Location           
RIF POC X X X X X X X X X X 
RIF POC Telephone X X X X X X X X X X 
Reason for RIF   X  X X X X X X 
Description of Competitive Area   X X X X X X X X 
Benefits and Entitlement POC   X X X X X X X X 
Benefits and Entitlement Address   X X X X X X X X 
Benefits and Entitlement Phone Number   X X X X X X X X 
MSPB Office   X X X    X X 
MSPB Address   X X X    X X 
Signature Block Line 1 X X X X X X X X X X 
Signature Block Line 2 X X X X X X X X X X 
Signature Block Line 3 X X X X X X X X X X 
RIF POC E-mail Address X X X X X X X X X X 
SPECIAL PARAGRAPHS           
Right of First Refusal Form            
Bargaining Unit Appeal   Para 7 Para 7 Para 7    Para10 Para10 
Separation – Temporary Exception         Para11 Para11 
Temporary Exception Paragraph   Para 8 Para 8 Para 8      
Temporary Exception – More Severe Action Paragraph   Para 8 Para 8 Para 8      
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3. List of data elements contained in the Mail Merge Extract 
 
Data Element Remarks 
Employee Name  
From Org Line 1  
From Org Line 2  
From Org Line 3  
From Org Line 4  
From Org Line 5  
To Title  
To PP-SERS-GR-CL  
To CPCN  
To Org Line 1  
To Org Line 2  
To Org Line 3  
To Org Line 4  
To Org Line 5  
RIF Effective Date  
From Title  
From PP-SERS-GR  
From CPCN  
From Comp Level  
From Comp Area  
Adjusted SCD-RIF  
Position Occupied  
Position Occupied Descr  
Tenure Group  
Sub-Group  
Perf Rating 1 See Section  
Perf Rating 2  
Perf Rating 3  
Exception Date  
RIF Action  
RIF Action Description  
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GLOSSARY OF CHANGES 
 
Date of Change Version Section Remarks 
2011/07/16 1.0  Initial  
2011/11/13 1.1 Overall Adjusted sections referenced through the guide as a result of additional new sections 
  Overall Adjusted page numbers as a result of new sections 
  A.1. Renamed section to Purpose and History 
  A.1.a. Added new section – Purpose and renumbered section a. & b. to (1) and (2) respectively 
  A.1.b. Added new section – History 
  B.3.a.(3) Added two new sections – (c) Delete an Extract and (k) Delete a Staging Table and renumbered 

sections (c)-(i) to (d)-(j) respectively 
  B.3.f. Added new section – Delete an Extract and renumbered f.-j. to g.-k. respectively 
  B.3.k. Added new section (9) Delete Button 
  E.2. Added Important Note 7 on Excepted Service and Term Only RIFs, Lines of Progression and Final 

Adjustments and renumbered all other important notes 
  F.1.b. Renamed Section to Search/filter Records 
  F.1.b.(5) Updated section to show new filter 
  F.1.b.(5)(b) Added new section – With Error and renumbered sections (b)-(d) to (c)-(e) respectively 
  F.1.b.(5)(c) Removed “error” from description 
  F.1.d. Added new section – Action Column and renumber sections d.-k. to e.-l. respectively 
  F.1.f.(2)(c) Added a new section – Abolish All 
  F.3.b.(3) Renamed section to Editing Retention Factors 
  F.3.b.(3)(a) Added new section – Tenure and Seniority Area Changes 
  F.3.b.(3)(b) Added new section – Tenure Tie Break Group Changes 
  F.3.f.(2)(d) Added screenshot to show error message when VP-RIF does not equal 1-6 
  G.2.a.(1) Clarified Tenure Tie Break information 
  G.9. Added Important Note 7 on Excepted Service and Term Only RIFs, Lines of Progression and Final 
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Date of Change Version Section Remarks 
Adjustments and renumbered all other important notes 

  Atch 4 Corrected the purpose of Report #23 – Modal Rating Report 
  Atch 4 Added new report – Report #34 – RIF Action – Round 2 Report and renumbered 34-39 to 35-40 

respectively 
  Index  Added new entries and adjusted page numbers 
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DCPDS RIF TOOL 
INDEX 

 
Topic Section Page # 

A 
Abolish All Button F.1.f.(2) 78 
Abolish Positions F.1.f. 78 
Abolish Selected Button F.1.f.(2)(b) 79 
Abolishment Report Atch 4 – 2 206 
Abolishment – Abbreviated Report Atch 4 – 3 207 
Action Buttons F.2.b. 87 
Action Columns F.1.d. 76 
Actions Report Atch 4 – 4 208 
Actions – Abbreviated Report Atch 4 – 5 207 
Add a Line of Progression E.2.d.(1) 71 
Add a Position Record F.2.e. 92 
Add Appraisals F.3.e.(2)(a) 103 
Add to Abolish F.2.g. 93 
Add/Update/Delete Individual Representative Rates E.1.g. 66 
Add/Update/Remove/Refresh Lines of Progression E.2.d. 71 
Adding positions from DCPDS F.1.h. 80 
Additional Employee Information Area F.3.d. 100 
Adjust Round 1 G.6. 121 
Adjust Round 1 Button G.6.b. 121 
Adjusted SCD F.3.g.(3) 107 
Allow Administrative Assignment Rights? Checkbox C.1.c.(13) 35 
Allow Intervening Displacement Actions G.1.e. 113 
Allow Intervening Displacement Checkbox C.1.c.(9) 34 
Alphabetical Listing Report Atch 4 – 1 205 
Alternate Offer G.8.d. 137 
Appointing Authority Code C.1.d.(1)(c) 36 
Appraisal Cutoff Date C.1.c.(2) 32 
Appraisal Earliest Date C.1.c.(3) 33 
Appraisal Info Tab D.4. 56 
Appraisal Information Page C.2. 44 
Appraisal Information Page – Multiple Pattern RIF C.2.d. 46 
Appraisal Information Page – Single Pattern RIF C.2.c. 45 
Archive a RIF A.8.f. 11 
Armed Forces Restoration Right F.3.d.(6)(c) 101 
Armed Forces Restoration Right Report Atch 4 – 6 208 
Assign Pattern Designations to Positions Area C.2.d.(3) 47 
Assignment Right G.8.c. 134 
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Topic Section Page # 
Auto-populate Lines of Progression E.2.c. 70 

B 
By-Pass Button G.8.f. 140 

C 
Calculate Multiple Pattern Appraisal Points Button C.2.d.(5) 48 
Calculate Single Pattern Appraisal Points Button C.2.c. 45 
Cancel and Back to RIF Home Page Button D.1.c. 50 
Cancelling a RIF D.2.b.(6)(a) 52 
Change a placement from one vacancy to another G.6.d. 122 
Change Options G.3. 116 
Change placement and By-Pass a Vacant Position or Lower Retention 
Standing Employee 

G.6.f. 124 

Changing Methods C.1.d.(3)(d) 42 
Changing RIF Options G.3.b. 116 
Changing the Current Owner I.2. 169 
CLC Discrepancies – different position titles, PP-SRS-GR with the 
same CLC Report 

Atch 4 – 8 212 

CLC Discrepancies – same CLC assigned to different series Report Atch 4 – 7 211 
CLC Discrepancies – same Position title, PP-SRS-GR with different 
CLCs Report 

Atch 4 – 9 213 

Clear Employee Data F.2.h. 93 
Competitive Area C.1.d.(3) 37 
Competitive Level C.1.d.(1) 36 
Copy a Position F.2.d. 90 
Create a RIF Extract B.2.b. 15 
Create a RIF Extract Page B.2. 14 
Create a RIF Staging Table Page B.5. 27 
Create a RIF Table Page B.3. 17 
Create a Staging Table from an Extract B.3.k. 21 
Create Button B.2.d. 17 
Creating a RIF Extract and RIF Staging Table B. 13 
Creating and Naming RIF Tables within the DCPDS RIF Tool A.5. 7 

D 
Data Flow/Calculations A.4. 6 
DCPDS Defined Competitive Area C.1.d.(3)(b) 38 
DCPDS RIF Extract/Staging Table Criteria and Business Rules Atch 1 173 
DCPDS RIF Notices Atch 5 249 
DCPDS RIF Page A.8. 9 
DCPDS RIF Reports Atch 4 203 
DCPDS RIF Responsibilities A.7.a. 8 
Defining the Number of Visible Rows A.8.c. 10 
Defining the Number of Visible Rows B.3.d. 19 
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Topic Section Page # 
Defining the Number of Visible Rows E.1.c. 63 
Defining the Number of Visible Rows F.1.e. 77 
Delete a Position F.2.f. 93 
Delete a RIF A.8.e. 11 
Delete a Staging Table B.3.k.(9) 23 
Delete an Extract B.3.f. 20 
Delete Button B.4.e. 26 
Delete positions F.1.j. 82 
Designation of Series by One Grade/Two Grade Interval Table Atch 2 187 
Designation of Series by One Grade/Two Grade Interval Table Report Atch 4 – 35 243 
Details Column F.1.d.(2) 76 
Disabled Veterans Impact Report Atch 4 – 10 214 
Duty Status Report Atch 4 – 11 215 

E 
Edit a RIF Staging Table Page B.4. 23 
Edit Appraisals Page F.3.e.(2) 103 
Edit Button – Staging Table B.3.k.(7) 22 
Edit Positions/Employees Tab F.1. 75 
Edit Tenure Tie Breaks G.2. 114 
Editing Data Elements B.4.b. 25 
Editing Employee Data F.3.b. 96 
Editing Tenure Tie Breaks G.2.b. 114 
EEO Statistics for Actions – ERI Report Atch 4 – 12 216 
EEO Statistics for Actions by PP-SRS-GR-CL – ERI Report Atch 4 – 13 217 
EEO Statistics for Workforce Report Atch 4 – 14 218 
Employee Record Error/Warning Messages F.3.f. 106 
Employee Tab F.3. 95 
Employees Requiring Special Handling F.3.d.(6) 101 
Error Filters F.1.b.(5)(b) 76 
Error/Warning Messages B.2.c. 17 
Error/Warning Messages F.3.f.(2) 106 
Error/Warning Messages Report Atch 4 – 15 219 
Exception End Date F.3.d.(4) 101 
Exception Reason F.3.d.(3) 100 
Exception Remarks F.3.d.(5) 101 
Exception Type F.3.d.(2) 100 
Extract – Creating a RIF B.1. 14 
Extract – Delete B.3.f. 20 
Extract Phases B.3.e. 19 

F 
Filter/Sort Capabilities E.1.b. 61 
Filters F.1.b 76 
Final Adjustments G.9. 142 
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Topic Section Page # 
Final Written Decision of Removal Under 5CFR432 F.3.d.(6)(a) 101 
Final Written Decision of Removal Under 5CFR752 F.3.d.(6)(b) 101 
Final Written of Removal Decision Under 5CFR432 or 5CFR752 
Report 

Atch 4 – 16 220 

Finish Adjust Round One G.6.j. 128 

G 
Gains – Losses – Movement Report Atch 4 – 17 221 
General  Information – Adjust Round 1 G.6.a. 121 
General Information – Additional Employee Information Area F.3.d.(1) 100 
General Information – Appraisal Information Page C.2.a. 44 
General Information – Appraisal Information Page – Multiple Pattern 
RIF 

C.2.d.(1) 46 

General Information – Change Options G.3.a. 116 
General Information – Create a RIF Extract Page B.2.a. 14 
General Information – Create a RIF Staging Table Page B.5.a. 27 
General Information – Create a RIF Table Page B.3.a. 17 
General Information – Creating a RIF Extract and RIF Staging Table B.1. 14 
General Information – DCPDS RIF Page A.8.a. 9 
General Information – DCPDS RIF Tool A. 3 
General Information – Edit a RIF Staging Table Page B.4.a. 23 
General Information – Edit Tenure Tie Breaks G.2.a. 114 
General Information – Final Adjustments G.9.a. 142 
General Information – Generating a Notice H.2.c. 157 
General Information – New Iteration G.10.a. 145 
General Information – Pre-Process Round 1 G.4.a. 118 
General Information – Pre-Process Round 2 Button G.7.a. 128 
General Information – Process Round 1 G.5.a. 119 
General Information – Process Round 2 G.8.a. 130 
General Information – RIF Administrator Responsibility I.1. 168 
General Information – RIF Options Page C.1.a 30 
General Information – RIF Options Page – Edit Positions/Employees 
Tab 

F.1.a. 75 

General Information – RIF Overview Page D.1.a. 50 
General Information – RIF Overview Page – Appraisal Info Tab D.4.a. 56 
General Information – RIF Overview Page – Edit Positions/Employee 
Tab – Employee Tab 

F.3.a. 95 

General Information – RIF Overview Page – Edit Positions/Employee 
Tab – Position Tab 

F.2.a. 85 

General Information – RIF Overview Page – Lines of Progression Tab E.2.a. 67 
General Information – RIF Overview Page – Options Tab D.3.a 54 
General Information – RIF Overview Page – Representative Rate Tab E.1.a. 60 
General Information – RIF Overview Page – RIF Notices Tab H.2.a. 156 
General Information – RIF Overview Page – RIF Process Tab G.1. 111 
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Topic Section Page # 
General Information – RIF Overview Page – RIF Reports Tab H.1.a 150 
General Information – RIF Overview Page – Status Page D.2.a. 52 
General Information – RIF Overview Page Process Log Page H.3.a. 163 
General Options C.1.c. 32 
Generating a Notice H.2.c. 157 
Generating a Notice using the Mail Merge Functionality H.2.d 161 
Generating a Report H.1.c. 151 
Generating Overall RIF Reports I.4. 170 
Glossary of Changes  257 

H 
Handicap Impact Report Atch 4 – 18 223 
History of the DCPDS RIF Tool A.1.b. 4 
History Report G.6.i.(4) 128 
History Report G.8.a.(6) 132 
History Report Atch 4 – 19 224 

I 
Important Note 1:  Exiting from the RIF Options Page C.1.b. 31 
Important Note 2:  Cancelling/Uncancelling a RIF D.2.b. 52 
Important Note 3:  RIF Data Parameters D.3.a 54 
Important Note 4:  Appraisal Info Tab D.4.a. 56 
Important Note 5:  Representative Rate Tab E.1.a. 60 
Important Note 6:  Lines of Progression E.2.a. 67 
Important Note 7:  Excepted Service and Term Only RIFs E.2. 67 
Important Note 8:  Edit Position/Employee Tab F.1.a. 75 
Important Note 9:  Refreshing Position/Employee Data F.2.c. 87 
Important Note 10:  Copy Position Function F.2.d. 90 
Important Note 11:  Add Position Function F.2.e. 91 
Important Note 12:  SCD Change F.3.b. 97 
Important Note 13:  Add Employee Function F.3.c. 98 
Important Note 14:  Appraisal Changes (1) F.3.e. 103 
Important Note 15:  Appraisal Changes (2) F.3.e. 103 
Important Note 16:  Remove Appraisal F.3.e.(2)(b) 104 
Important Note 17:  Excepted Service and Term Only RIFS G.9. 143 
Important Note 18:  Change Options G.3. 116 
Important Note 19:  Alternate Offer G.8.d. 137 
Important Note 20:  Retaining Manual Changes to Appraisals G.10.b. 145 
Include Temporary Employees? Checkbox C.1.d.(2)(b) 37 
Include Vacancies? Checkbox C.1.d.(2)(a) 37 
Intervening Displacement Action G.6.h. 126 

L 
Leftover Vacancies Report Atch 4 – 20 226 
Lines of Progression Report Atch 4 – 21 227 
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Topic Section Page # 
Lines of Progression Tab E.2. 67 
Load vacancies from temporary actions (promotions, etc.)? Checkbox 
 

C.1.d.(2)(c) 37 

M 
Mail Merge Functionality H.2.d. 161 
Mandatory Exception to the Regular Order of Release Based Upon 
Serviced in the Armed Forces 

F.3.d.(6)(e) 102 

Mandatory/Permissive/Temporary Exception F.3.d.(6)(d) 102 
Mandatory/Permissive/Temporary Exception Report Atch 4 – 24 231 
Manual Update of Appraisals F.3.e.(1) 103 
Manually adding an employee to the RIF F.3.c. 98 
Menu Items A.7.b. 9 
Minimally Acceptable Employees G.1.c. 113 
Minimally Satisfactory/Unacceptable Employees Report Atch 4 – 22 228 
Missing Lines of Progression G.7.c. 129 
Missing Representative Rates G.7.b. 129 
Modal Rating Area C.2.b. 44 
Modal Rating Area C.2.d.(2) 46 
Modal Rating Report Atch 4 – 23 229 
Multiple Pattern Appraisals Points Area C.2.d.(4) 48 
Multiple Pattern RIF C.2.d. 46 
Multiple Pay Tables/Locality Pay Area Codes Detected E.1.e. 64 

N 
New Iteration G.10. 145 
No changes available G.6.c. 122 
No Placement (Release from CL) G.6.g. 125 
Notices H.2. 156 
NSPS Positions – Us GS Grade Equivalency? Checkbox C.1.c.(8) 34 

O 
Options Tab D.3. 54 

P 
Parameters Page H.1.d. 151 
Performance Appraisal Information Area F.3.e. 103 
Phases of an Extract B.3.e. 19 
Placement Exceptions Report Atch 4 – 25 233 
Position Data Errors F.2.j. 94 
Position Occupied C.1.d.(1)(b) 36 
Position Tab F.2. 85 
Pre-Process Round 1 G.4. 118 
Pre-Process Round 1 Button G.4.b. 118 
Pre-Process Round 2 G.7. 128 
Proceed to Setting RIF Options Button B.4.d. 26 
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Topic Section Page # 
Process Log Entries H.3.b. 164 
Process Log Page H.3. 163 
Process Round 1 G.5. 119 
Process Round 1 Button G.5.b. 120 
Process Round 2 G.8. 130 
Processing Final Adjustments G.9.b. 143 
Purpose A.1.a. 4 
Purpose and History of the RIF Tool A.1. 4 

Q 
Quality Control Review of DCPDS A.3. 5 

R 
Reactivate an Archived RIF I.3. 170 
Reason for RIF C.1.c.(4) 33 
Refresh a Line of Progression E.2.d.(4) 72 
Refresh Appraisals F.3.e.(2)(c) 105 
Refresh position or employee data from DCPDS F.1.i. 82 
Refresh the current position or employee record F.2.c. 87 
Refresh the Extract List Button B.3.i. 21 
Regulations and Guidance A.2. 5 
Remove a Line of Progression E.2.d.(3) 72 
Remove Appraisals F.3.e.(2)(b) 104 
Remove from Abolish F.2.g. 93 
Remove from RIF F.1.k. 83 
Remove from RIF Area F.2.i. 94 
Removed from RIF Report Atch 4 – 26 234 
Representative Rate Report Atch 4 – 27 235 
Representative Rate Tab E.1. 59 
Request Summary List H.1.e. 155 
Reset Button C.1.f. 43 
Reset Button C.2.d.(6) 48 
Responsibilities and Menu Items A.7. 8 
Retention Register – Basic Report Atch 4 – 28 236 
Retention Register – Standard – No Privacy Act Report Atch 4 – 29 237 
Retention Register – Standard Report Atch 4 – 30 238 
Retrieve/Refresh Representative Rates From DCPDS E.1.f. 65 
Return Button B.3.j. 21 
Return Button B.4.f. 26 
Return to Create a RIF Page Button C.1.g. 44 
Reviewed Checkbox F.3.f.(1) 106 
RIF Action Button G.8.b. 133 
RIF Action – Round 1 Report Atch 4 – 33 241 
RIF Action – Round 2 Report Atch 4 – 34 243 
RIF Administrator Responsibility I. 165 
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Topic Section Page # 
RIF Effective Date C.1.c.(1) 32 
RIF Extract – Create B.2.b. 15 
RIF Name Area C.1.b. 31 
RIF Notices Tab H.2. 156 
RIF Options Page C.1. 30 
RIF Options Page and Appraisal Information Page C. 29 
RIF Options Report Atch 4 – 31 239 
RIF Overview Page D. 49 
RIF Overview Page D.1. 50 
RIF Overview Page – Appraisal Info Tab D.4. 56 
RIF Overview Page – Appraisal Info Tab – Multiple Pattern RIF D.4.c. 57 
RIF Overview Page – Appraisal Info Tab – Single Pattern RIF D.4.b. 56 
RIF Overview Page – Edit Positions/Employee Tab – Employee Tab F.3. 95 
RIF Overview Page – Edit Positions/Employee Tab – Position Tab F.2. 85 
RIF Overview Page – Edit Positions/Employees Tab F. 73 
RIF Overview Page – Lines of Progression Tab E.2. 67 
RIF Overview Page – Options Tab D.3. 54 
RIF Overview Page – Process Log Page H.3. 163 
RIF Overview Page – Representative Rate Tab E.1. 60 
RIF Overview Page – Representative Rate Tab and Lines of 
Progression Tab 

E. 59 

RIF Overview Page – RIF Notices Tab H.2. 156 
RIF Overview Page – RIF Process Tab G. 109 
RIF Overview Page – RIF Reports Tab H.1. 150 
RIF Overview Page – RIF Reports Tab, RIF Notice Tab, Process Log 
Tab 

H. 149 

RIF Overview Page – Status Tab D.2. 51 
RIF Parameters C.1.d. 36 
RIF Parameters – Additional Parameters C.1.d.(2) 36 
RIF Parameters – Additional Parameters – Include Temporary 
Employees? Checkbox 

C.1.d.(2)(b) 37 

RIF Parameters – Additional Parameters – Include Vacancies? 
Checkbox 

C.1.d.(2)(a) 37 

RIF Parameters – Additional Parameters – Load vacancies from 
temporary actions (promotions, etc.)? Checkbox 

C.1.d.(2)(c) 37 

RIF Parameters – Competitive Area C.1.d.(3) 37 
RIF Parameters – Competitive Area – DCPDS Defined Competitive 
Area 

C.1.d.(3)(b) 38 

RIF Parameters – Competitive Area – Users Defined Competitive 
Area 

C.1.d.(3)(c) 40 

RIF Parameters – Competitive Level C.1.d.(1) 36 
RIF Parameters – Competitive Level – Appointing Authority Code C.1.d.(1)(c) 36 
RIF Parameters – Competitive Level – Position Occupied C.1.d.(1)(b) 36 
RIF Parameters – Competitive Level – Work Schedule C.1.d.(1)(a) 36 
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RIF Processing Actions and Placement Codes and Cleartext Atch 3 201 
RIF Reports Tab H.1. 150 
RIF Status G.1.b. 111 
RIF Summary Report Atch 4 – 32 240 
RIF Type C.1.c.(5) 33 
Round 1 Option – Allow Displacement Exceptions? Checkbox C.1.c.(11) 34 
Round 1 Option – Use Vacancies in Round? Checkbox C.1.c.(10) 34 
Round 2 – View Lowest Tenure Option for each Competitive Level? 
Checkbox 

C.1.c.(12) 35 

Round 2 Complete G.8.h. 141 
Round One Report G.5.c. 120 

S 
Save Button B.4.c. 26 
Save Button D.2.c. 54 
Save RIF Options Changes Button C.1.e. 43 
Search for Records F.1.b. 76 
Search for RIFs A.8.b. 10 
Search/Find an Extract B.3.c. 19 
Selecting an Iteration H.1.b. 150 
Selecting an Iteration H.2.b. 157 
Separate Button G.8.g. 141 
Set Exception or View/Delete Exception Button G.8.e. 139 
Set RIF Options Button B.3.k.(8) 22 
Several ways to abolish positions F.1.f.(2) 78 
Show/Hide Links B.4.b. 25 
Show/Hide Links F.1.l.(1) 84 
Single Pattern RIF C.2.c. 45 
Sort Records F.1.c. 76 
Sorting RIF Extracts B.3.b. 19 
Special Filters F.1.b. 76 
Staging Table – Create from an Extract B.3.k. 21 
Staging Table – Delete B.3.k.(9) 23 
Staging Table – Edit Button B.3.k.(7) 22 
Starting a New Iteration G.10.b. 145 
Status Tab D.2. 51 
Step 1 – Create a RIF Extract B.2.b. 15 
Step 2 – Create a RIF Staging Table B.3.k. 21 
Step 3 – Edit the RIF Staging Table B.4.b. 25 
Step 4 – Set RIF Options C.1.b. 31 
Step 5 – Calculate Appraisal Points C.2.a. 44 
Step 6 – Set Representative Rates E.1. 60 
Step 7 – Set Lines of Progression E.2.a. 67 
Step 8 – Abolish Positions F.1.f. 78 
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Topic Section Page # 
Step 9 – Correct Position/Employee Errors F.1.l. 84 
Step 10 – Edit Employee Records F.3.b. 96 
Step 11 – Edit Tenure Tie Breaks G.2.a. 114 
Step 12 – Pre-Process Round 1 G.4. 118 
Step 13 – Process Round 1 G.5. 119 
Step 14 – Adjust Round 1 G.6. 121 
Step 15 – Pre-Process Round 2 G.7. 128 
Step 16 – Process Round 2 G.8. 130 
Step 17 – Final Adjustments G.9. 142 
Step 18 – New Iteration G.10 145 
Step 19 – Generate Reports H.1. 150 
Step 20 – Generate Notices H.2. 156 
Steps to Processing a RIF A.6. 7 
Subgroup F.3.g.(2) 107 
Supplemental RIF Information D.2.b. 52 
Switch to the Staging Table List Button B.3.g. 21 
Switch Vacancies between two employees G.6.e. 123 

T 
Tabs within the RIF Overview Page D.1.b. 50 
Tenure and Seniority Area F.3.g. 107 
Tenure Group F.3.g.(1) 107 
Tenure Report Atch 4 – 36 244 
Tenure 0 Employees Report Atch 4 – 37 245 
Tenure Tie Break – Edit G.2. 114 
Tenure Tie Break Group Changes F.3.b.(3)(b) 97 
Tenure Tie Break Report Atch 4 – 38 246 
Treat GS and GM Alike? Checkbox C.1.c.(6) 33 
Two Methods Available – Competitive Area C.1.d.(3)(a) 37 

U 
Unable to abolish positions F.1.f.(1) 78 
Uncancelling a RIF D.2.b.(6)(b) 53 
Unsatisfactory Employees G.1.d. 113 
Update a Line of Progression E.2.d.(2) 72 
Update a RIF A.8.d. 11 
Update Appraisals F.3.e.(2)(d) 105 
Update the GS Equivalent Grade for NSPS positions F.1.g. 80 
Upload Abolish List F.1.f.(2)(a) 78 
Upload Lines of Progression E.2.b. 69 
Upload Representative Rates E.1.d. 63 
Use Alternate Offer? Checkbox C.1.c.(7) 34 
User can do the following G.1.a. 111 
Users Defined Competitive Area C.1.d.(3)(c) 40 
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V 
Vacancies Report Atch 4 – 39 247 
View Lowest Tenure for Each Competitive Level G.1.f. 114 
View position/employee errors F.1.l. 84 
View the Process Log Button B.3.h. 21 
View/Edit/Clear All Placement Exceptions G.6.i. 127 

W 
Warning Filters F.3.b.(5) 97 
With Abolished Filter F.1.b.(5)(d) 76 
With Error Filter F.1.b.(5)(b) 76 
With Removed Filter F.1.b.(5)(e) 76 
With Vacancy Filter F.1.b.(5)(a) 76 
With Warning Filter F.1.b.(5)(c) 76 
Work Schedule C.1.d.(1)(a) 36 
Worksheet Report Atch 4 – 40 248 
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Module 4 

Chapter 14 

Data Flow Processes Between DCPDS and USA Staffing 

Chapter Overview  

  
Introduction This chapter is written for personnelists familiar with USA Staffing.  It 

explains the three processes where information flows between DCPDS and 
USA Staffing.   

1. Transmit DCPDS RPA Data File -  Position data transmits from 
DCPDS to the Request Processing area in USA Staffing 

2. Transmit USA Staffing Selection File - An action initiated in USA 
Staffing triggers the flow of selection and recruitment data from USA 
Staffing to DCPDS.  

3. Transmit Cancellation of Applicant Selection - An action initiated 
in USA Staffing transmits declination/offer cancelled data to DCPDS.    

Note:  Troubleshooting tips are provided in the Troubleshooting Guide for 
DCPDS and USA Staffing Interface. For additional information about USA 
Staffing, refer to USA Staffing Help (available within USA Staffing).   

 
Chapter Contents  

Topic Page 
Chapter Overview 1 
Transmit DCPDS RPA Data File 2 

DCPDS Data Transmitted to USA Staffing 2 
Creation of Tracking Number 5 
Transmitting Data to USA Staffing 5 

Transmit USA Staffing Selection File 9 
USA Staffing Selection Data Transmitted to DCPDS 9 
Event Codes Generated Based on USA Staffing Data 10 
Creating an Applicant Record in DCPDS 11 
Transmitting Updated USA Staffing Data 12 

Transmit Cancellation of Applicant Selection  13 
Transmitting Offer Cancelled Data to DCPDS 13 
 Offer Cancelled Data Transmitted to DCPDS 13 
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Transmit DCPDS RPA Data File 

   
Purpose This section explains the transmission of the RPA data file from DCPDS to 

USA Staffing and the population of predetermined fields in USA Staffing 
with position information from DCPDS.      

   
DCPDS Data 
Transmitted 
to USA 
Staffing 

DCPDS transmits data to the Request Processing page in USA Staffing.  
Specific DCPDS data auto-populates in the USA Staffing Vacancy area for 
newly created vacancies as indicated in the following table; these values do not 
auto-populate when using existing vacancies.    

 
DCPDS Data Fields 

(Information will flow as clear text 
unless indicated otherwise) 

USA Staffing 
Value Names (Read 

Only) 

USA Staffing 
Auto-populated 

Fields 

1. Processing Region  PROCESSING 
REGION 

n/a 

2. RPA Request Number  RPA REQUEST 
NUMBER 

Tracking Number  

3. Servicing Office ID SERVICING OFFICE 
ID 

n/a 

4. Date of Request (RPA Part A, 
Request Date) 

DATE OF REQUEST Date of Validation 
of Hiring Need  

5. Servicing Agency - code SERVICING AGENCY n/a 
6. POS Agency Sub-element - 

code 
 

AGENCY 
SUBELEMENT 

n/a 

7. Position Type - code 
 

POSITION TYPE n/a 

8. Geographic Duty Location – 
code and cleartext 

GEO CODE DUTY 
LOCATION  

n/a 

GEOGRAPHIC DUTY 
LOCATION 

n/a 

9. Date Position Classified  DATE POSITION 
CLASSIFIED  

Position 
Description 

Review Date  
10. Date Position Audit  DATE POSITION 

AUDIT 
n/a 

11. Position Title POSITION TITLE Position Title  
12. Agency Group - code AGENCY GROUP n/a 

 

 

 
Continued on next page 
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Transmit DCPDS RPA Data File, continued 

   
DCPDS Data Transmitted to USA Staffing (continued)  
 

DCPDS Data Fields/ Location 
(Information will flow as clear text 

unless indicated otherwise) 

USA Staffing 
Value Names (Read 

Only) 

USA Staffing 
Auto-populated 

Fields 

13. Part Time Hours – Biweekly PART TIME HOURS  
BIWEEKLY n/a 

14. Pay Basis  PAY BASIS Salary Rate 
15. Pay Plan PAY PLAN Pay Plan 
16. Occupational Code  OCCUPATIONAL 

CODE n/a 

17. Grade/Pay Band GRADE PAYBAND n/a 
18. Target Grade Level  TARGET GRADE 

LEVEL n/a 

19. Work Schedule WORK SCHEDULE n/a 
20. Mobility Agreement MOBILITY 

AGREEMENT n/a 

21. Air Reserve Technician (ART) 
ID 

AIR RESERVE 
TECHNICIAN ART ID n/a 

22. Drug Test Designated DRUG TEST 
DESIGNATED n/a 

23. Financial Statement Required FINANCIAL 
STATEMENT 
REQUIRED 

n/a 

24. Gun Ammo Access ID GUN AMMO ACCESS n/a 
25. Key/Emergency Essential KEY EMERGENCY 

ESSENTIAL n/a 

26. LEO Position Indicator LEO POSITION 
INDICATOR n/a 

27. Position Sensitivity POSITION 
SENSITIVITY n/a 

28. Supervisory Status SUPERVISORY 
STATUS n/a 

29. Position Description String POSITION 
DESCRIPTION 

STRING 
n/a 

30. Position Occupied/Status POSITION OCCUPIED n/a 
 

Continued on next page 
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Transmit DCPDS RPA Data File, continued 

   
DCPDS Data Transmitted to USA Staffing (continued)  
 

DCPDS Data Fields/ Location 
(Information will flow as clear text 

unless indicated otherwise) 

USA Staffing 
Value Names (Read 

Only) 

USA Staffing 
Auto-populated 

Fields 

31. Position NTE Date POSITION NTE DATE n/a 
32. Obligated Position OBLIGATED 

POSITION n/a 

33. Name (Selecting Official) – 
based on the Level 1 
Supervisor identified for the 
“To” position  

NAME SELECTING 
OFFICIAL n/a 

34. Email (Selecting Official) 
based on the Level 1 
Supervisor identified for the 
“To” position  

EMAIL SELECTING 
OFFICIAL n/a 

35. Phone (Selecting Official) 
based on the Level 1 
Supervisor identified for the 
“To” position  

PHONE SELECTING 
OFFICIAL n/a 

36. USA Staffing Office USA STAFFING 
OFFICE n/a 
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 Transmit DCPDS RPA Data File, Continued 

 
Creation of 
Tracking  
Number 

When data is transmitted to USA Staffing from DCPDS, the RPA Number 
flows to USA Staffing and becomes the Tracking Number.   

 
 

 
Transmitting 
Data to USA 
Staffing 

The following steps describe how to transmit data to USA Staffing.   

Step Action 
1 Access your Civilian Inbox from the Navigation List in DCPDS. 
2 In the Notifications Summary window, highlight the appropriate 

RPA. 
3 Select <Respond>.  The RPA opens. 
4 Review the RPA and position data to ensure that all required data has 

been recorded. 
5 If family is Recruit/Fill, go to step 9.  If family is not Recruit/Fill, 

select <Change Family>. 

 
 

6 Select <Yes>. 

 
 

 
Continued on next page 
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Transmit DCPDS RPA Data File, Continued 

 
Transmitting Data to USA Staffing (continued)  
 

Step Action 
7 Scroll down, highlight Recruit/Fill and select <OK>.  

 
 

8 Select <OK> 

 
9 Select the yellow disk to save. 

 
 

10 Select <Yes>.  

 
 

 
Continued on next page 
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Transmit DCPDS RPA Data File, Continued 

 
Transmitting Data to USA Staffing (continued)  
 

Step Action 
11 Select the appropriate routing option (i.e., ‘Select Groupbox’), 

highlight the appropriate routing destination, and select <OK>,  

 
 

12 Select <OK>.  

 
 

 
Continued on next page 
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Transmit DCPDS RPA Data File, Continued 

 
Transmitting Data to USA Staffing (continued)  
 

Step Action 
13 Select <OK>.  

 
 

14 
 
 

This creates the USA Staffing file using the RPA number as the 
tracking number. 
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Transmit USA Staffing Selection File 

  
Purpose 
 

This section explains how USA Staffing transmits a selection file to DCPDS.  
It further explains the creation of an applicant build and the population of 
predetermined fields in DCPDS with selection data from USA Staffing.  This 
data sharing capability is intended to eliminate duplicate entries and facilitate 
the creation of applicant records in DCPDS whenever possible.   

   
USA Staffing 
Selection Data 
Transmitted to 
DCPDS 

The following table identifies selection data that flows from the USA Staffing 
applicant record to build an applicant record in DCPDS, when an applicant 
record with an identical social security number (SSN) does not already exist; 
if an applicant record with an identical SSN already exists, the information 
identified in the following table does not populate DCPDS.  If the person-
related data is not available or is incorrect in USA Staffing, the personnelist 
must manually update the information in DCPDS as appropriate.      
 

 
USA Staffing 
Field Label 

DCPDS Data Fields 
(Information flows as clear text unless indicated 

otherwise) 
1. Effective Date Effective date will not populate if a name is 

already identified in part B of RPA 
2. SSN Social Security Number in applicant build  
3. First Name First name (all caps) in applicant build  
4. Middle Initial Middle initial (all caps) in applicant build  
5. Last Name Last name (all caps) in applicant build  
6. Date of birth Birth date in applicant build 
7. Gender Gender in applicant build 
8. Address Line 1 Address line 1 in personal address information 
9. Address Line 2 Address line 2 in personal address information 
10. Address Line 3 Address line 3 in personal address information 
11. City City in personal address information 
12. State State in personal address information 
13. Zip code Zip code in personal address information 
14. Country code Country code in personal address information 
15. Selection phone 

number 
Telephone 1 in personal address information  

16. Processing region Processing Region – used behind the scenes 
17. RPA number RPA Number – used behind the scenes 
18. Servicing office ID Servicing Office ID –  used behind the scenes 

 



 R12  April 2012 

Data Flow Processes Between USA Staffing and DCPDS      Mod 4, Chap 14, Page 10 

 
Transmit USA Staffing Selection File, Continued 

 
Event Codes 
Generated 
Based on USA 
Staffing Data 

The following table identifies DCPDS event codes generated when selection 
data is transmitted from USA Staffing.   

 
USA Staffing Field 

Label 
Event Code Event Code Description 

1. Effective Date E13500 Selectee’s Entrance on 
Duty Date 

2. Vacancy ID (VIN) EV1000 Vacancy ID (VIN) 
3. Announcement 

Opening Date 
E06001 Job Announcement Opens 

4. Announcement 
Closing Date 

E06002 Job Announcement Closes 

5. Announcement 
Number 

E06000 Job Announcement 
Number 

6. Selection 
Certificate Name  

E08501 Certificate Name 

7. Selection 
Certificate Issue 
Date  

E08500 Date Certificate Issued 

8. Tentative Offer E10000 Selection Reviewed and 
Tentative Offer Extended 

9. Date Selection 
Made (from 
Selection Manager) 

E09000 Selection Date 

10. Official Offer E12000 Official Offer 
11. Job Analysis/ 

Assessment 
Confirmation Date 

E04500 Job Assessment 
Confirmation Date 

12. Certificate Owner  E08502 Referral Certificate Issued 
By 

13. Selection  
Certificate Return 
Date  

E08510 Date Certificate Returned 

14. Selection Audit 
Date 

E08515 Date Selection Audited 
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Transmit USA Staffing Selection File, Continued 

 
Creating an 
Applicant 
Record in 
DCPDS 

The following steps describe the process for creating an applicant record in 
DCPDS. 

 
Step Action 

1 
 
 
 
 
 

 

In DCPDS, change RPA family from Recruit/Fill to appropriate 
RPA family.   
 
Skip down to step 4 if an Interagency Transfer Request does not 
need to be processed; otherwise, go to step 2. 
 
Note: Applicant and employee information is not attached to the 
RPA if the RPA family is Recruit/Fill.  

2 Process an Interagency Transfer Request if an Interagency 
Transfer Request is required.  Refer to DCPDS User’s Guide 
Module 4, Chapter 11 for additional information.   

3 Put the selectee’s name on the RPA after the Interagency Transfer 
Request is complete.   

4 In USA Staffing, open the certificate Audit page for the 
appropriate Vacancy Identification Number (VIN). 

5 
 

 

Ensure RPA tracking number is tied to the selectee and save.  
 
Note: The manager may assign the tracking number to the selectee 
using Selection Manager. 

6 
 
 

 

Complete the certificate audit and put a check in the “Complete” 
box.   
 
Note: Marking the “Complete” box on the USA Staffing Audit 
page triggers the transmission of data to DCPDS.   

7 
 
 
 

 

In DCPDS, ensure the applicant record includes correct and 
complete information in the fields for name, gender, date of birth, 
etc., before processing the RPA.   
 
Note: DCPDS creates applicant records for selected applicants 
who do not have existing applicant or employee records in 
DCPDS.  DCPDS only places the created applicant record on the 
RPA if part B of the RPA does not already have a name identified. 
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Transmit USA Staffing Selection File, Continued 

 
Transmitting 
Updated USA 
Staffing Data 

The following steps describe how to transmit updated USA Staffing selection 
data to DCPDS.  Use these steps if USA Staffing data has been transmitted to 
DCPDS at least once.   
 

 
 Step Action 

1 In USA Staffing, open the certificate Audit page for the 
appropriate Vacancy Identification Number (VIN). 

2 Deselect the Complete box and save 
3 Update the appropriate fields on the Audit page (e.g., official offer, 

effective date) and save. 
4 Put a check in the “Complete” box.   
5 
 
 
 

 
 

In DCPDS, updated data will be viewable as described in the USA 
Staffing Data Transmitted to DCPDS section of this module.  
 
Note: DCPDS automatically end dates duplicate event codes 
transmitted via the interface.  
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Transmit Cancellation of Applicant Selection 

  
Purpose This section explains how USA Staffing transmits an offer 

cancelled/declination file To DCPDS. 

 
 

Transmitting 
Offer Cancelled 
Data to DCPDS 
 
 

The following steps describe how to transmit offer cancelled data from USA 
Staffing to DCPDS.   
 

Step Action 
1 
 
 

 

In DCPDS, manually remove the name of the selectee who 
declined from the RPA 
 
Note: The interface will not remove or override a name that exists 
on the RPA.     

2 In USA Staffing, open the certificate Audit page for the 
appropriate VIN.    

3 Deselect the Complete box and save 
4 
 
 

 

Select the blank option from the Tracking Number drop down 
menu for the selectee who declined and Save.  
 
Note: Selecting save initiates the trigger to transmit declination 
data to DCPDS.  USA Staffing will not transmit declination data 
to DCPDS if you do not select save before proceeding to the next 
step.  

5 If you need to transmit a new selection, refer to the Transmit 
USA Staffing Selection File section of this module for additional 
information.  

 

 
 Offer 
Cancelled Data 
Transmitted to 
DCPDS 

The following table identifies offer cancelled/declination data that flow from 
USA Staffing to DCPDS.      

 
USA Staffing 

Field 
DCPDS Data Field 

 
1. Date selectee declined/ 

offer cancelled 
Event code E09001 

2. Processing region Processing Region – used behind the scenes 
3. RPA number RPA Number – used behind the scenes 
4. Servicing office ID Servicing Office ID –  used behind the scenes 
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Module 5 

Workforce Relations Using the DCPDS 

Module Overview 
 

  
Purpose The purpose of this module is to familiarize you with using the DCPDS to 

administer Workforce Relations.   

  
Module Contents  
 

Module Overview 1 
Chapter 1:  Performance Plans 1 
Chapter 2:  Performance Appraisal Information 1 

Quick Guide 3 
Entering Performance Appraisal Data 3 
Adding a Performance Appraisal  5 
Entering Non Appropriated Fund Appraisal Data 6 
Entering Air Force Technical Appraisal Data 8 
Processing Mass Appraisals 9 
Mass Appraisal Upload/Update Processes 14 

Chapter 3:  Awards  1 
Processing a Monetary Award 2 
Entering a Non-Monetary Award 5 
Correcting Award Data 9 
Deleting Award Data 10 
Processing a Mass Award 11 
            Creating a Mass Award File 12 

Previewing a Mass Award File 15 
Changing a Mass Award File 16 
Entering Legal Authority Codes and Remarks 16 
Executing a Mass Award 17 
Viewing the Status of a Mass Award File 18 
Locating and Correcting Errors 20 

Processing an Award for an Ex-Employee 21 
 

Continued on next page 
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Module Overview, Continued 

 
Module Contents (Continued) 
 

Chapter 4:  Adverse Actions and Reprimands 1 
Preparing an RPA for Adverse Actions 2 
Documenting Adverse Actions 6 
Documenting Reprimands 9 

 
See also 
      

• Module 1, Fundamentals of the DCPDS 
• Module 3, Processing Requests for Personnel Actions Using the DCPDS 
• Module 6, Administering Pay, Benefits, and Entitlements Using the 

DCPDS 
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Module 5 

Chapter 1 

Performance Plans 

 
Introduction Employees must have an approved, written, or otherwise recorded 

performance plan based on work assignments and responsibilities.  The plan 
must cover the official appraisal period. 
 
If your activity uses COREDOC for position descriptions and the series is in 
the COREDOC library of position descriptions, DCPDS will allow you to 
generate a performance plan for an employee. 
 
COREDOC is programmed to reconfigure the duties selected into objectives 
for use in the Performance Management Plan window.  It will format the 
duty statements (objectives) to emulate your Component's current 
performance management plan.  The window is essentially the same for each 
Component; however, the output will be different depending on your 
Component.  Air Force does not use this part of COREDOC.  
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Module 5 

Chapter 2 

Performance Appraisal Information 

Chapter Overview   

  
Introduction The Department of Defense (DoD) Appraisal System is an integral part of 

performance management within the DoD.  The DoD Performance Appraisal 
System allows Components to establish their own performance appraisal 
program, but requires that they conform to statute and regulation which fall 
within the flexibilities of the system.  DCPDS allows the performance 
appraisal data to be captured and recorded in the system.  

  
Chapter Contents  

Topic Page 
Quick Guide 3 
Entering Performance Appraisal Data 3 
Adding a Performance Appraisal 5 
Entering Non Appropriated Fund Appraisal Data 6 
Entering Air Force Technical Appraisal Data 8 
Processing Mass Appraisals 9 
Mass Appraisals Upload/ Update Processes 14 
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Before You 
Begin 

 
 
 
Demonstration Projects have their own unique Appraisal SITs, with the 
exception of two Demos.  ONR Demo (4) and the SPAWAR-1105 Demo (6) 
use the US Fed Perf Appraisal.     
 
The Demo Appraisal SITs are: 
 

• Appr – Air Force Lab Demo 
• Appr - Army Lab Demo 
• Appr – DOD Acquisition Demo 
• Appr – Naval Research Lab Demo 
• Appr – NAWC Lab Demo 
• Appr – Space Nav Warfare Demo 
• Appr – Warfare Center Demo 

 
The Demonstration Projects Appraisal SITs have the same fields as the  
US Fed Perf Appraisal SIT, with the exception of one additional item which 
is Performance Rating Points.  Each demonstration project has unique values 
for updating the appraisal fields.  Upon update of the Demo appraisal SITs, 
the system performs a crosswalk conversion of data in order to update the 
US Fed Perf Appraisal SIT. 
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Entering Performance Appraisal Information 

  
Quick Guide The following is a quick guide to the steps for Entering Performance 

Appraisal Data: 
• Navigation Path > People > Enter and Maintain > and select Open. 
• In the Find Person window, locate the employee’s name by typing 

the last name of the employee and select the Find button.   
• Select the employee’s name from the list of values then select the OK 

button 
Or 

• Input the first few letters of the employee’s last name, followed by 
“%,” then select Find button, select the employee’s name, and select 
OK button. 

• Select Special Info button on the People window. 
• Continue following the steps on Entering Performance Appraisal 

Data. 

   
Entering Performance 
Appraisal Data 

 

 
Step Action 

1 The Special Information window opens.  Scroll to US Fed Perf 
Appraisal in the Name data field or use the query technique (F11, 
place checkmark in Information Exists, then Ctrl F11).  Place your 
cursor in the blank Detail data field and select. 

 
 

Continued on next page 
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Entering Performance Appraisal Information, Continued 

  
Entering Performance Appraisal Data (continued) 
 

Step Action 
2 The US Fed Perf Appraisal window opens.  Complete the data 

fields below by using the LOV’s in the window or by typing in the 
data.  

 
3 Complete the data fields then select the <OK> button. 

 
4 The Special Information window opens with the information 

populated in the Detail data field.   

 
 

5 Select Save icon on the Toolbar and exit the windows 
 

Continued on next page 
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Adding a Performance Appraisal 

  
Adding a 
Performance 
Appraisal 

You can add an instance to existing appraisal data. 

Step Action 
1 Select the Special Information button to open the window, place 

the cursor in the Name data field and press F11 key to clear the 
field.  

2 Place a check mark in the Information Exists checkbox and press 
both the CTRL +F11 key. 

3 Any Special Information Type (SIT) that has information will 
display.  Use the scroll bar to Select the US Fed Perf Appraisal.  
Place your cursor in the blank Detail data field and select. 

 
 

4 The past appraisal data opens in the Details Region with the most 
current data at the bottom.  Select in the first blank data field under 
Start Date.  The current date populates but you can override it. 

 
 

5 Select in the Detail data field to display US Fed Perf Appraisal 
window, complete it, and select the OK button.  

6 
 
 

Select Save icon on the Toolbar and exit the windows. 
 
Note:  When you reopen the Special Information window, the 
entries will be reordered with the most current one at the top. 

  
 

 



                   R12 March 2012 

Workforce Relations:  Performance Appraisal                                   Mod 5, Chap 2, Page 6 

 

 

Entering Non Appropriated Fund Appraisal Data 

  
Quick Guide The following is a quick guide to the steps to Entering Performance Appraisal 

Data: 
• Navigation Path > People > Enter and Maintain and select Open 

button. 
• On the Find Person window, locate the employee by typing the last 

name of the employee and select the Find button.   
• Select the employee’s name from the list of values and select the OK 

button 
Or 

• Input the first few letters of the employee’s last name, followed by 
“%,” select the Find button, select the employee’s name, and select 
the  OK button 

• Select the Special Info button on the People window. 
• Continue following the steps on Entering NAF Appraisal Data. 

  
Entering NAF 
Appraisal Data 

Scroll to Appraisal – Non-Appr Fund in the Name data field. 
 

 
 
 
 

 
 

Continued on next page 
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Entering Non Appropriated Fund Appraisal Data, Continued 

  
Entering NAF Appraisal Data (Continued) 
 

Step Action 
1 The Appraisal – Non Appr Fund window opens.  Complete the 

data fields by typing in the information or use the LOV. 

 
2 Select OK button. 
3 Select Save icon on the Toolbar and exit the windows. 
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Entering Air Force Technical Appraisal Data 

  
Purpose This procedure provides the steps to complete the Air Force Technical 

Appraisal (TA) for eligible registrants.  It is used in conjunction with the 
annual performance appraisal to form part of the Whole Person Score.  
Employees who are currently in permanent GS/GM-15 positions do not 
receive a TA.  

  
Entering AF 
Technical Appraisal 

 

 
Step Action 

1 Follow the Quick Guide in the Entering Performance Appraisal 
Information Section to navigate to the Special Information 
window.  With your cursor in the Name data field, scroll to the 
ACQ – AF Technical Appraisal.  Place your cursor in the blank 
Detail data field and select.  

2 The ACQ – AF Technical Appraisal window opens.  Complete 
the data fields by typing in the information or use the LOV. 

 
3 Select OK button.     
4 Select the Save icon and exit the windows. 
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Processing Mass Appraisals 

 
Purpose This section provides information on how to process mass appraisals that 

allow for efficient processing of a group of similar appraisals. 

    
Before You 
Begin 

• Mass appraisals can be used when you want to update multiple records at 
one time. 

• When you process mass appraisals, the People Record in HR is updated.  
An RPA is not produced as it is with other mass actions.  

• You can export the data from the Preview window to an Excel 
spreadsheet. 

  
Who Does It 

       

The capability to create and execute a mass appraisal is available only in the 
CIVDOD Personnelist and US Federal HR Manager responsibilities. 

  
Processing a  
Mass Appraisal  

 

 
Step Action 

1 
 

Navigation Path > Mass Actions > Mass Appraisals > Final 
Mass Appraisals and select Open button. 
Notes:   
• The Preview Mass Appraisal window is available as a “rough 

draft” window.  It is exactly like the Final Mass Appraisal 
window, but the Execute task flow button is not available.  
You can create the Mass Appraisal by selecting either menu 
item.  Mass Appraisals can only be processed in the Final 
Mass Appraisal window. 

 
Continued on next page 
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Processing Mass Appraisals, Continued 

  
Processing a Mass Appraisal (Continued) 
 

Step Action 
2 The Final Mass Appraisal window opens with three taskflow 

buttons.  With your cursor in the Name data field, type in a unique 
name for the appraisal action you are creating. 

 
 
Note:  The Status data field is system-generated to show how far 
your award file has progressed when you save your action; e.g., 
Unprocessed, Submitted, etc.  No action is required. 

3 The Description data field allows user to enter free text to describe 
your action and has a limit of 100 characters.  Complete the 
remaining data fields by using the LOV or typing in the data. 

4 Select the LOV icon to select the organization  

 
5 Use the LOV’s to select the appropriate information to enter in all 

required data fields in the Appraisal Details region. 

 
6 
 
 

Select Save icon on the Toolbar. 
Note:  Completing this window also completes the Source 
Criteria and Appraisal Details Regions.  Specific appraisal data 
such as Target Rating of Record, Target Factor (AF), etc. are 
input using the Preview task flow button.   

 
Continued on next page 
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Processing Mass Appraisals, Continued 

 
Previewing Your 
Action 

By selecting Preview button on the Final Mass Appraisals window You 
open the window where names for a mass appraisal can be viewed and 
selected or deselected, and where individual ratings are displayed. 

 
Step Action 

7 On the Final Mass Appraisals window, select Preview button.  
The Mass Appraisals (Preview) window opens with data 
elements populated from the previous window. 

 
Note:  The check mark in the Appraisal checkbox indicates the 
name on the line is included in the mass appraisal action.  Deselect 
the name if it is not to be included.  If a large number of names 
appear on the window, but only a few are to be included, select 
Select/Deselect All button to remove the checkmark from the 
checkboxes.  Then, select the few names to be included by 
individually selecting in the checkbox next to the names. 
 

8 Select Save icon on the Toolbar and exit the window to return to 
the Final Mass Appraisals window. 
 

  
Continued on next page 
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Processing Mass Appraisals, Continued 

 
Validating the 
Mass Appraisal  

Selecting Validate button on the Final Mass Appraisals window opens a 
Message Box.  Select Validate after Preview has been completed to ensure 
there are no rejects before Executing the action. 

 
Step Action 

9 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select Validate button on the Final Mass Appraisals window a 
Message Box will display the following “Validation process 
completed successfully.”  Select OK button. 

 
 

OR 
 

An Error Message Box can appear which indicates the required 
items that have not been entered.   
 
Note:  Air Force requires the Target Factor column to be 
completed; otherwise, an error will occur. 
To view the errors navigate to Processes and Report, View 
Requests.  The Find Requests window opens.  Select the Find 
button to view your entire request.   
Select the View Output button to view error details.  
To correct the actions on the Mass Appraisals (Preview) window, 
save your action, and return to the Final Mass Appraisals 
window. 

  
Continued on next page 
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Processing Mass Appraisals, Continued 

 
Executing the 
Mass Appraisal 

Selecting Execute button on the Final Mass Appraisals window processes 
your action by submitting it to update the database. 

 
Step Action 
10 Select Execute button on the Final Mass Appraisals window a 

Message Box will display informing “Mass Appraisals Final 
Process successfully submitted.” 

 
11 Select OK button.  To return to the Final Mass Appraisals 

window. 
 
Note:  Once your have “Executed” or “Processed” the action, the 
taskflow buttons (Execute, Validate, and Preview) are grayed 
out. 
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Processing Mass Appraisals Upload/Update Processes 

 
Purpose This section outlines the steps to be taken to update appraisal information for 

Acquisition Workforce Demonstration Project employees.  

 
Who Does It 

       

The capability to process mass appraisal is available to the CIVDOD 
Personnelist and US Federal HR Manager 

 
Processing a Mass Appraisal   
 

Step Action 
 Note:  Copy the file containing the appraisal transactions your hard 

drive noting the subdirectory you are placing it in.  The appraisal 
file must be in the exact format as specified in Figure 1 of this 
document.  Insure there are no blank lines at the bottom of the file 
before loading the file 

1 
 

Navigation Path > Mass Actions > Mass Appraisals> Load Mass 
Appraisals and select Open button. 

2 The Mass Appraisals Load window will open 

 
3 Under “File Name” you will need to type in the complete path to 

the file you copied to your hard drive (e.g., c:\Appr_bk.txt).   The 
name of the file must be in the standard DOS format; therefore, 
please be sure that it does not exceed 8 characters.  It is best to put 
the file in either the root directory or the Temp directory.  If the 
path to the file is too long it may not be found. 

4 Provide an appropriate name for the “Mass Appraisal Name”.  
Make a note of the name you type in – you will use it later in the 
process. 

 
 

Continued on next page 
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Processing Mass Appraisals Upload/Update Processes, 
Continued 

 
Processing a Mass Appraisal (continued) 
 

 

Step Action 
5 Provide a description of the process in the “Description” field. 

6 
 

The system provides a default value for the “Rating of Record 
Pattern” and the “Rating of Record Level”.  Changes can be 
made as needed.  (For the Rating of Record Pattern, use A for 
Pass/Fail, H for 5 level rating system, etc.)  If the Rating of 
Record Level is left blank on this screen, the preview screen 
will auto-populate this field with same value that is provided in 
the ASCII file for Rating of Record except for the following 
demonstration project records which will be populated as 
follows: 
 

a.      If the Demo Location Code = 2 (SPAWAR) and the 
Rating of Record Level is blank, the Rating of Record Level 
in the preview screen will also be blank.  Rating of Record 
Level is not applicable to these two Demonstration Projects. 

 
b.   If the Demo Location Code = 4 (NRL) and the Rating of 
Record Level is blank, the Rating of Record Level in the 
preview screen will be populated as follows: 

 
1) If Rating of Record = G then populate 

Rating of Record Level with 3 
2) If Rating of Record = N then populate 

Rating of Record Level with 1 
 

c.    If the Demo Location Code = A (Air Force Lab Demo) 
and the Rating of Record Level is blank, the Rating of 
Record Level in the preview screen will be populated as 
follows: 

 
1) If Rating of Record = A then populate 

Rating of Record Level with 5 
2) If Rating of Record = D then populate 

Rating of Record Level with 4 
3) If Rating of Record = G then populate 

Rating of Record Level with 3 
4) If Rating of Record = K then populate Ratin   

Record Level with 2 
 

 
Continued on next page 
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Processing Mass Appraisals Upload/Update Processes, 
Continued 

 
Processing a Mass Appraisal (continued) 

 
Step Action 

6 
(cont) 

d.  If the Demo Location Code = Q (DoD Acq Demo) and the 
Rating of Record is blank, the Rating of Record Level in the 
preview screen will be populated as follows: 

 
1) If Owning Agency = AF, NV, DD and Rating of 

Record = A then populate Rating of Record 
Level with 5 

2) If Owning Agency = AF, NV, DD and Rating of 
Record = D then populate Rating of Record 
Level with 4 

3) If Owning Agency = AF, NV, DD and Rating of 
Record = G then populate Rating of Record 
Level with 3 

4) If Owning Agency = AF, NV, DD and Rating of 
Record = N then populate Rating of Record 
Level with 1 

5)   If Owning Agency = AR and Rating of Record = E 
then populate Rating of Record Level with 5 

6) If Owning Agency = AR and Rating of Record = H 
then populate Rating of Record Level with 4 

7) If Owning Agency = AR and Rating of Record = L 
then populate Rating of Record Level with 3 

8) If Owning Agency = AR and Rating of Record = U 
then populate Rating of Record Level with 1 

 
e.  If the Demo Location Code = R (Army Lab Demo) and the 
Rating of Record Level is blank, the Rating of Record Level in the 
preview screen will be populated as follows: 

 
1) If Rating of Record = E then populate Rating  

Record Level with 5 
2) If Rating of Record = H then populate Rating  

Record Level with 4 
3) If Rating of Record = L then populate Rating  

Record Level with 3 
4) If Rating of Record = U then populate Rating  

Record Level with 1 
 
f.    If the Demo Location Code = 7 (NAWC Lab Demo) use H for     
Rating of Record Pattern. 

 
Continued on next page 
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Processing Mass Appraisals Upload/Update Processes, 
Continued 

 
Processing a Mass Appraisal (continued) 

 
Step Action 

7 Type in the “Date Appraisal Due” and the “Appraisal Period End 
Date”.  When the appraisal is processed, the Performance Salary 
on the Salary Award DDF under Extra Information on 
People/Enter and Maintain is generated based business rules for 
your component.     

8 Save the record by selecting on the Save Icon on the top line 
menu. 

9 Select the “Load” button in the lower right corner of the screen. 

 
10 Once the load process has completed, you will receive a pop-up 

message providing you with the Request ID number and the 
number of records that processed. 

11 Navigate to Processes and Reports ∏ View Requests <Open>  
to check the status of the load process.   

12 The Find Request window opens select the <Find> button to query 
your request.  

 
13 Select the Refresh Data button to help bring the Phase to 

Completed. (Depending on how many organizations you have in 
your file this may take a little time.  When your original job ID 
says “completed”, all requests are completed.) 

 
Continued on next page 
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Processing Mass Appraisals Upload/Update Processes, 
Continued 

 
Processing a Mass Appraisal (continued) 

 
Step Action 
14 Select <View Output> button to review the reports generated.  

You will receive a report listing any records that could not be 
loaded (i.e., the employee did not have an assignment as of the 
effective date of the appraisal) as well as a report indicating 
successful loading of records for each Organization included in 
your file.  Exit window.  

 
15 
 
 
 
 
 
 
 
 
 
 
 
 

From the Navigation window select Final Mass Appraisals 
<Open>   

 
Note:  Insure that the “Phase” reflects “Completed” for your “Start 
Automatic Mass Appraisal Load Process” entry before proceeding 
with these steps. 

 
Continued on next page 
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Processing Mass Appraisals Upload/Update Processes, 
Continued 

 
Processing a Mass Appraisal (continued) 

 
Step Action 

16 The Mass Appraisals Final window will open. Select F11 key then 
type in the name of the load you provided in step 5 followed by the 
wildcard character (%) then select both F11and CTRL keys to 
execute the query.   If upload file contains employees from 
different organizations, the system appends a number after the 
name you provided in step 5 for each of the various organizations 
(i.e., “Test Appraisal Update (Org 1)”, “Test Appraisal Update 
(Org 2)”, etc.).  By adding the % sign after the name, you are 
assured of finding all organizations that require appraisal 
processing as a result of your upload.  The following step will need 
to be followed for each organization. 

 
17 Select Preview button to make sure the right records are selected 

and they have the correct data in them.  To quickly identify all 
records selected for update, select F11 key to place activate query 
mode, select the “X” under the Appraisal column to deselect it and 
then re-select it to select it again. Then select both F11and CTRL 
keys to execute query.   The list will only have employees who 
were included in the load process. 

 
Continued on the Next Page 
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Processing Mass Appraisals Upload/Update Processes, 
Continued 

 
Processing a Mass Appraisal (continued) 

 
Step Action 
18 When you complete the form for the Load Mass Appraisals, you 

provided a default value for Rating of Record Level.  This value 
will need to be changed for employees whose Target Rating of 
Record Level does not match the default value.  To quickly 
identify and update these records, navigate to the Preview screen 
and use the F11 query function to identify the records based on 
their value in the Target Rating of Record column.  Update the 
Target Rating of Record Level value on the first employee and use 
your arrow down button to navigate to the next record. Copy the 
value from the first employee and continue using the arrow down 
button and pasting the new value until all records have been 
updated.  Save your changes.  Once all changes are made, exit 
window. 

 
19 Select the Validate button.  If there are errors, navigate to View 

Requests and review the error report that is generated and make 
any necessary corrections.  Once corrected or if there are no errors, 
select the Execute button.  You will receive a message providing 
the Request ID. 

 
 

Continued on next page 
 
 
 
 
 

Change Rating 
of Record 
Pattern and/or 
Rating of 
Record Level 
if required.  
Preview other 
data fields as 
well to insure 
data was 
correct in your 
file; i.e., Date 
Effective, etc. 
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Processing Mass Appraisals Upload/Update Processes, 
Continued 

 
Processing a Mass Appraisal (continued) 

 
Step Action 
19 
 

After the process has completed successfully, examine the 
employee’s records to verify they were updated with the right 
information.  You will need to look in the “Appr – DOD 
Acquisition Demo” SIT and in the “US Gov Perf Appraisal” SIT 
to verify the updates.  The demo appraisal SITs are: 
Demonstration Project Special Information Type 
Air Force Lab Demo Appr – Air Force Lab Demo 
Army Lab Demo Appr – Army Lab Demo 
DoD Acquisition Appr – DoD Acquisition Demo 
NRL Appr – Naval Research Lab Demo 
SPAWAR Appr – Space Nav Warfare Demo 
Warfare  Appr – Warfare Center Demo 

 
In addition to checking the appraisal SITs, for SPAWAR also 
verify the Exception to Midpoint.  Demo located in the Navy 
Unique Information DDF (People  Enter and Maintain Extra 
Information Navy Unique Information) updated correctly.  

 
 

Continued on next page 
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Processing Mass Appraisals Upload/Update Processes, 
Continued 

 
Processing a Mass Appraisal (continued) 

 
Sample Appraisal File Layouts 

The ASCII file format:   
 

Maximum 
Field 
Length 

 
 
Value 

11 SSN (Format 000-00-0000) 
 Comma Delimiter 
11 APPR_DATE_EFFECTIVE (Format:  DD-MMM-

YYYY) 
 Comma Delimiter 
1 RATING_OF_RECORD 
 Comma Delimiter 
1 APPRAISAL_TYPE 
 Comma Delimiter 
1 BONUS_INDICATOR (Navy Unique Data) 
 Comma Delimiter 
1 BONUS_REASON (Navy Unique Data) 
 Comma Delimiter 
1 FACTOR1 (Air Force Unique Data) 
 Comma Delimiter 
1 FACTOR2 (Air Force Unique Data) 
 Comma Delimiter 
1 FACTOR3 (Air Force Unique Data) 
 Comma Delimiter 
1 FACTOR4 (Air Force Unique Data) 
 Comma Delimiter 
1 FACTOR5 (Air Force Unique Data) 
 Comma Delimiter 
1 FACTOR6 (Air Force Unique Data) 
 Comma Delimiter 
1 FACTOR7 (Air Force Unique Data) 
 Comma Delimiter 
1 FACTOR8 (Air Force Unique Data) 
 Comma Delimiter 
1 FACTOR9 (Air Force Unique Data) 
 Comma Delimiter 
1 DEMO_LOCATION_CODE 
 Comma Delimiter 
1 Exception to Midpoint 
 Comma Delimiter 
11 DT Appr Period Start (Format: DD-MMM-YYYY) 

Note:  Insure there are no blank lines at the bottom of the file before loading the file for 
Air Force:  FACTOR1 through FACTOR 9 are concatenated (combined) into one field 
when updated to DCPDS. The Comma Delimiters between these factors are not 
mandatory; these factors will load correctly with or without the commas between 
FACTOR1 thru FACTOR9.  Insure all nine factors are input as required. 
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Continued on next page 
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Processing Mass Appraisals Upload/Update Processes, 
Continued 

 
Processing a Mass Appraisal (continued) 

 
 Sample Appraisal File Layouts  

(Non Demonstration Project) 
 Air Force 

000-00-0000,01-JUN-
2011,4,A,,,9,9,9,9,9,9,9,9,9 
    OR 
000-00-0000,01-JUN-2011,4,A,,,999999999 
 

Air Force – GS-15 (Performance Factors excluded): 
000-00-0000,01-JUN-2011,3,A 
 
All Other Components: 
000-00-0000,01-JUN-2011,3,A 

 Sample Appraisal File Layouts  
(Demonstration Project) 

 DoD Acq Demo (Air Force): 
000-00-0000,01-JUN-
2011,D,L,,,9,9,9,9,9,9,9,9,9,Q 
    OR 
000-00-0000,01-JUN-2011,D,L,,,999999999,Q 
 

DoD Acq Demo (Non-Air Force):  
000-00-0000,01-JUN-2011,D,L,,,,,,,,,,,,Q 
 

Navy – NAWC:      
000-00-0000,01-JUN-2011,A,A,J,1,,,,,,,,,,,7 
 

Navy – SPARWAR:   
000-00-0000,01-JUN-2011,D,A,,,,,,,,,,,,2,N 
 

Navy – Warfare:   
000-00-0000,01-JUN-2011,3,A,,,,,,,,,,,,3 
 

Navy – NRL :   
000-00-0000,01-JUN-2011,G,A,,,,,,,,,,,,4 
 

Air Force Lab Demo:   
000-00-0000,01-JUN-
2011,D,A,,,9,9,9,9,9,9,9,9,9,A 
    OR 
000-00-0000,01-JUN-2011,D,A,,,999999999,A 
 

Army Lab Demo: 
000-00-0000,01-JUN-2011,H,L,,,,,,,,,,,,R 
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Module 5 

Chapter 3 

Awards 
Chapter Overview  

  
Introduction 
 
 
 
 
 
 
 

The awards program for civilian employees is highly decentralized within 
DoD; e.g., each Component establishes and administers recognition systems.  
The purpose of this chapter is to provide steps for entering, correcting, and 
deleting information on Awards.  It also includes processing mass awards.   

• Monetary awards require a Request for Personnel Action (RPA) 
which automatically updates the employee’s award history. 

• Non-monetary awards, i.e., suggestion awards and recognition awards 
do not require an RPA and are entered into the employee’s record 
using the People Window.   

  
Chapter Contents  
 

 Topic Page 
Processing a Monetary Award  2 
Entering a Non-Monetary Award  5 
Correcting Award Data 9 
Deleting Award Data 10 
Processing a Mass Award 11 
            Creating a Mass Award File 12 

Previewing a Mass Award File 15 
Changing a Mass Award File 16 
Entering Legal Authority Codes and Remarks 16 
Executing a Mass Award File 17 
Viewing the Status of a Mass Award File 18 
Locating and Correcting Errors 20 

Processing Awards for Ex-Employees 21 
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Processing a Monetary Award 

    
Purpose This procedure provides the steps to process an RPA for a monetary award. 

     
Using the RPA   

Step Action 
1 Navigation Path > Request for Personnel Action > Award/One-Time 

Payment and select Open button. 
2 
 

 
 
 

 

The Requesting Info tab of the RPA opens with Part A, Block 1, 
Actions Requested data field populated.  Complete the remaining 
white data fields following the instructions in Module 3, Processing 
Requests for Personnel Actions. 
 
Note:  Request Number data field populates when you save the 
action.  

 
3 Complete Part B by typing the employee’s last name and press 

[Enter] to automatically populate the data field or if there is more 
than one employee with the same last name select from the LOV.  
The remaining employee data fields populate.  Enter the Effective 
Date in Block 4.  

 
4 
 
 
 

Place the cursor in the 5-A Code data field, use the LOV to select the 
First Nature of Actions or type in the correct code.  If there is a 
LAC associated with the NOAC, place cursor in the 5-B of the RPA 
to select the LAC from LOV or type in the correct code.  

 
Continued on next page 
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Processing a Monetary Award, Continued 

  
Using the RPA (continued) 
 

 Step Action 
5 Legal Authority Codes are not required for an award effective on 

or after 01-OCT-2000.  For actions effective before 01-OCT-2000, 
place your cursor in 5-C Code data field; use the LOV to display the 
First Legal Authority Codes 1 window or type in the correct code.  
Data fields’ 5-C Code and 5-D Legal Authority populate. 

6 Select Position Data tab (2nd tab on RPA).  Award and Unit of 
Measurement (UoM) data fields are open for entry.    

7 If the award has a known dollar amount, type in the amount in the 
Award data field.   
Note:  The field size for Award data field is five characters.  If an 
award is for $2,000.00, enter as 02000; for $100.00, enter 00100.   
On or after 01-OCT-2000, if the NOA is a Time Off Award, an “H” 
(Hours) will automatically be populated in the Unit of Measure 
(UoM) data field.  If the NOA is monetary related, a “M” (Money) 
will automatically be populated in the UoM.  Actions processed 
before 01-Oct-2000 will require the user to input a value in the 
UoM.      

8 Select Employee and Position Data tab.  No action is required.  
The data fields are populated.  Select Remarks tab. 

9 Place the cursor in Part F – Remarks for SF 50, select LOV icon to 
review list of remarks.  Select OK button, then select the Save icon.  
A Message Box appears asking if you wish save and the RPA.   
Select No button you need to complete the US Gov Award and 
Bonus Information prior to updating HR. 

10 
 
 

Select Extra Information button on the RPA.  If appraisal 
information is not in the record, select US Gov Performance 
Appraisal, update Appraisal information and Save.  
 
Notes:   

• Current appraisal information is required in the employee’s 
record for performance-based awards. 

• You can also select Award Salary on the Extra PA Request 
Information window to verify the award salary (the 
employee’s basic salary excluding locality pay).   
 

Award Salary is necessary if a percentage is given because the 
calculation will be based off the award salary for percentage. 

 
Continued on next page 
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Processing a Monetary Award, Continued 

  
Using the RPA (continued) 
 

Step Action 
11 On the Extra PA Request Information window, Select the US 

Gov Award and Bonus Information. Then Select in the Details 
data field to display Extra PA Request Information.  Enter needed 
information and select OK button.  

12 Select Save icon on any page.  A Forms box opens with the RPA 
Request Number.  Select the OK button to continue. 

13 A Message Box appears asking if you wish to route the request.  
Select the Yes button. 

14 
 
 
 

 

The Routing window opens. Select Update HR. and a printer ID in 
the Printer data field, if applicable Select the Approval box then 
select OK button. 

Note:  Follow your Component guidelines in routing the RPA for 
approval, updating the HR database, and printing the Notification 
of Personnel Action (NPA). 
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Entering a Non-Monetary Award 

  
Purpose  This procedure explains how to enter a non-monetary award. 

   
Accessing the Assignment Window  
 

Step Action 

1 
 

Navigation Path > People > Enter and Maintain and select Open 
button.  The Find Person window opens.   

 
2 Type the last name of the employee whose record you wish to 

update and select the Find button.  A list of names will appear in 
the LOV window select the employee whose record you wish to 
update and select OK button. 

3 The People window populates with the employee’s data.  Select 
Assignment button. 

 
 

 

 
 
 

Continued on next page 
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Entering a Non-Monetary Award, Continued 

  
Accessing Assignment window (continued) 
 

Step Action 
4 The Assignment window opens with many of the data fields 

populated and/or grayed out.  Select Entries button. 

 
5 The Element Entries window opens with the employee name on 

the Title Bar.  Your cursor will be on the first data field in the 

Element Name column.   
Select the Green Cross Icon on the toolbar or File/New Record 
on the main menu bar to create a blank data field. 

6 Select the LOV icon.  The Elements windows open select Federal 
Awards then Select the OK button.  

 
 
 

Continued on next page 
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Entering a Non-Monetary Award, Continued 

  
Accessing Assignment window (continued) 
 

Step Action 
7 The Elements window opens with the Federal Awards added to the 

Element Name Column with Processing Type as Nonrecurring. 

 
 

Continued on next page 
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Entering a Non-Monetary Award, Continued 

  
Accessing the Assignment Window (continued) 
 

Step Action 
8 
 
 
 
 
 
 
 
 
 
 
 

 
 

     
 
 

 
 
 
 
 

 
 

Select Entry Values button and when window opens, enter the 
appropriate award data in the white data fields or use the LOV and 
make selection from list of values.  Exit the window. 

 
Notes: 

• The Date Award Earned is completed only if the award 
you are entering is outside the current pay period. 
• The Date Earned field is embedded in the Oracle product 
and is not necessary to complete the action. 

9 Select Save icon to save entries made to this area and exit 
windows.  
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Correcting Award Data 

  
Purpose This procedure provides the steps to correct award data.  

• If the award is not within the current pay period, date track to 
the date needed on the Element Entries window and follow 
the steps.  See Module 1, Chap 4, Dated Information and Date 
Tracking. 

• If an RPA was used to create the award, you must do a 
Correction-Cancellation RPA to correct or delete it.  See 
Module 4, Chapter 7, Cancellations and Corrections. 

  
Accessing the Assignment Window  

 
Step Action 

1 Navigation Path > People > Enter and Maintain and select 
Open button.  The Find Person window opens.  

2 Enter the employee’s name then Select the Find button.   
3 Select the Assignment button in the People window. 
4 Select the Entries button to display the Element window. 
5 In the Element Entries window, select the first blank data field or 

Select the Green Cross  icon on the toolbar and type in 
Federal Awards.  Then Select the Entry Values button. 

6 
 
 
 

 

The Entry Values window opens.  Select in the data field(s) that 
needs correcting.  Use the LOV to select the correct information.  
Close the window and return to the Element Entries window. 

 
Note:  Only non-recurring awards that fall in the current pay 
period display in the Element Name data field.  If it is outside the 
current pay period, date track to the date needed and make the 
correction. 

7 Select Save icon and exit the windows.    
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Deleting Award Data 

   
Purpose This procedure explains the process for deleting award data.  

 
Before You 
Begin 

• If the award is not within the current pay period, date track to the date 
needed on the Element Entries window and follow the steps in this 
procedure.  

• If an RPA was used to create the award (usually a monetary award), then 
you must do a Correction-Cancellation RPA to delete it. 

 
Accessing the Assignment Window   
  

Step Action 
1 Navigation Path > People > Enter and Maintain and select Open 

button. 
2 Enter the employee’s name then Select the Find button.   
3 Select the Assignment button in the People window. 

  
Deleting the award  
 

Step Action 
4 Select the Entries button to display the Element window. 
5 Select the Award Element Name that you want to delete. 
6 In the Element Name data field, Select Edit from the Main Menu 

then Select Delete to delete the data field or Select the Red X on 

the Toolbar.   
7 

 

Select the Save icon and exit the windows. 
Note:  If you discover you deleted the Award Element Name data 
field by mistake, and you have not yet Selected Save; close the 
Element Entries window WITHOUT saving.  Select File > Close 
Form.  Select the No button when the dialog window asks if you 
want to save your data. 
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Processing a Mass Award 

  
Purpose This section provides information on how to process a mass award for 

efficient processing of a group of similar award actions.   
• A manager or supervisor may create and preview the action, and then 

notify the personnelist by phone or email with the file “name” created 
for the mass award. 

• A personnelist will then execute the mass award. 

   
Before You 
Begin 

• A Mass Award is a collection of individual awards processed en 
masse to save DCPDS users time, effort, and keystrokes.  The 
personnel actions required to document each award can be processed 
with an individual RPA when the following conditions are same:   
 

• Effective date 
• Nature of action. 

 

• You cannot change individual award amounts; i.e., percentage or 
salary amount, once you have “executed” the action.  

• If actions process without error, NPAs (SF 52s) are generated for the 
selected records as future actions in the Routing History Table.  If an 
error occurs with one of these selected records, the process routes the 
NPA to the group box assigned to the record’s registered Personnel 
Office Identifier (POI).  If the POI is not registered, then the process 
routes to the system’s default group box – GHRWFADMIN. 

• Legal Authority Codes/Remarks are not required for Mass Awards 
effective on or after October 1, 2000. 

   
Who Does It 

 

The capability to execute a mass award is only available in the CIVDOD 
Personnelist responsibility. 
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Processing a Mass Award, Continued 

 
Creating a 
Mass Award 
File 

Managers, supervisors, or personnelists may create a Custom Mass Award File.  
If a manager or supervisor creates the file, they need to notify the appropriate 
personnelist to “execute” it. 
 

Step Action 
1 
 

Navigation Path > Mass Actions > Mass Awards > Final Mass 
Awards and select Open. 

 
Notes:   
• The Mass Awards (Preview) window is available as a “rough 

draft” window.  It is exactly like the Mass Awards (Final) 
window, but without the Execute Task flow button.  You can 
create the Mass Award by selecting either menu item, but you can 
only process it in the Final Mass Awards window. 

• Components may want to use both forms, but limit the number of 
personnel who can run the final process for security reasons. 

 
Continued on next page 
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Processing a Mass Award, Continued 

 
Creating a Mass Award File (continued) 
 

Step Action 
2 The Custom Mass Awards (Final) window opens with four 

task flow buttons.  Each time the user utilizes one to navigate 
to another form, the system automatically saves the current 
entries. 

 
3 Place the cursor in the Name data field, type in a unique file 

name for the award you are creating.   
Ex:  2001 GS Performance Awards for Civil Engineering. 
Note:  This unique file name is used for executing the 
process.  If a manager creates the Mass Award, this file name 
must be provided to the personnelist to extract and then 
execute the mass award 

4 Place the cursor in the NOA Code data field, Select the LOV 
icon to select the code or type it in.  (OPM no longer requires 
LACs/Remarks for Mass Awards). 

5 
 

Select the LOV icon or type in a date in the Effective Date 
data field.  
Notes:   
• Name, NOA, and Effective Date are required fields which 

auto populates UoM, Award Type and Date of Award 
Earned on the Award Details DDF.  

• The Status data field is system-generated to show how far 
your award has progressed: e.g., Unprocessed, Submitted, 
etc.  No action is required. 

 
Continued on next page 
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Processing a Mass Award, Continued 

    
Creating a Mass Award File (continued) 
 

Step Action 
6 
 
 
 
 

In the Source Region, Select the LOV icon to choose either the 
Organization, or Personnel Office ID.  Agency Code and Agency 
/ Sub element Code data fields are optional.  However, there is an 
increase in system performance when you select an organization as 
one of the parameters. 
Note:  You can use wildcards to populate some data fields; e.g., 
(FP%) - to extract organization codes that begin with FP; (G%) - 
to get all pay plans beginning with a G, etc. 

7 Select the LOV icon or type in the information in the data fields. 
8 In the Mass Awards window, Select the Award Details button. 

The window opens with several of the data fields populated from 
the previous window.   

 
9 

 
 

Place the cursor in the Award Amount data field, type in the 
amount.  
     OR 
Select the Award Percentage data field and type in a percentage.  
For example, one and a half percent would be entered as 1.5 (no 
percent sign). 
 
Note:  The Award Percentage data field only applies to 
Performance Awards.   

10 Place the cursor in the Award Agency Code data field, type in the 
information or Select the LOV and Select the agency granting the 
award; e.g., AR for Army.   

11 Group Award Id is required if award is effective before Oct1, 
2000 - no longer required by OPM if the award is effective on or 
after Oct 1, 2000.  

  
Continued on next page 
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Processing a Mass Award, Continued 

 
Previewing a 
Mass Award 
File 
 

You may preview a file created on the Mass Awards (Preview) window and 
names can be viewed, selected, or deselected.   
Note:  Once you task flow to the Preview, all previously entered data cannot 
be modified (except for Award Amount which must be changed individually.)  
If other modifications of the data are necessary, a new Mass Award file must 
be created. 

 
Step Action 
12 Award Type populates for Time Off Awards, all others must be 

entered using the LOV or typed in. 
13 Date Award Earned populates with the current date or you can 

input another date. 
14 Type in dollar amount in Tangible Benefit Dollars data field, if 

required. 
15 Select OK to return to the Mass Awards (Final) window 
16 
 

On the Mass Awards (Final) window, Select the Preview button.  
The window opens with data elements populated from the previous 
windows. Name and SSN are included in the columns a second 
time so they will appear on the downloaded product, in the event 
you export the awards preview folder to a spreadsheet.  

 
Note:  The “X” in the Award checkbox indicates the name to be 
included in the mass award action.   

• Deselect the “X” if the name is not to be included.   
• If a large number of names appear on the window, but only 

a few are to be included, Select Select/Deselect All to 
remove the “X” from the checkboxes.  Then, select the few 
names to be included by individually selecting “X” in the 
checkbox next to the names. 

17 Select the Save icon on the Toolbar and exit the window. 
  

Continued on next page 
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Processing a Mass Award, Continued 

 
Changing a 
Mass Award 
File 

You have one option to change the file before it is “executed.”  You can only 
change the Target Award Amount to a dollar amount from a percentage.    

 
Step Action 
18 The personnelist will open the Mass Award (Final) window and 

Select the Preview button.   
19 The Mass Awards (Preview) window opens.   

To change the dollar amount, place your cursor in the Target 
Award Amount data field and substitute the desired dollar amount 
for the Percentage of Award Salary Amount. 
 
Note:  The system deletes the information in the Target Award 
Percentage data field when the dollar amount is input. 

• When all modifications of the Preview Folder are 
complete, the user must save the changes and exit the 
Preview Folder.   

• The Preview Folder can be changed and saved as many 
times as necessary by the user.   

 
Entering Legal 
Authority 
Codes and 
Remarks 

Legal Authority Code(s) and Remarks saved on this window will apply 
globally to the mass award. Legal Authority Codes and Remarks are no 
longer required for actions effective on or after Oct 1, 2000.   

 
Step Action 
20 

 
 

If actions prior to Oct 1, 2000, Select the LACs/Remarks buttons. 
Place the cursor in the Legal Authority Code 1 data field, Select 
the LOV.  

 
Notes:   
• At least one LAC is required, if award is effective before Oct 

1, 2000; but remarks are optional.  
• The Required Checkboxes are not used because there are no 

standard remarks required to be on all Mass Awards. 
 

Continued on next page 
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Processing a Mass Award, Continued 

 
Executing a 
Mass Award 
File 

This procedure shows the steps to process or “execute” a mass award file to 
update the database. 

 
Step Action 
21 Place the cursor in the Remarks Region Code data field, Select the 

LOV icon. The Remarks window populates with ZZZ and the PA 
Remarks Insertion Values window opens.  Type in your remark 
and Select the OK button. 

 
22 Select Save icon and exit the window.   
23 Select the Execute button.  A Message Box opens and says:  

“Mass Awards Final Process successfully submitted. 
24 
 
 
 

Select the OK button   
• If the actions process without an error, RPAs are created 

for the selected records as future actions in the Routing 
History Table.   

• If an error occurs with one of these selected records, the 
process routes the RPA to the group box assigned to the 
record’s registered POI.   

o If the POI is not registered, then the process routes 
to the system’s default group box – 
GHRWFADMIN. 

Notes:  
• Once you have “Executed” or “Processed” the action, The 

Preview button is grayed out on the Mass Awards 
window. 

• Individual award actions that do not successfully pass the 
business rules will create an RPA for the Award, and flow 
to the designated utility group box for failed automatic 
actions, normally “WGI Personnel.” 
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Processing a Mass Award, Continued 

 
Viewing the 
Status of a 
Mass Award 
File 

To view the status of the executed mass award file, use the Request ID in the 
message generated in the final step of processing.  For example:  “189415” in 
the previous step.  Follow these steps for viewing your requires: 
 

Step Action 
1 Navigation Path > Processes and Reports > View Request and 

select Open.  
The Find Request window opens, Select the Find button    

• The Requests window opens a listing of Request Ids with 
columns entitled Phase, Status, Program Name and 
Parameters.  The most recent request will be at the top of 
the list. 

Find the Request ID that was assigned in the previous note of 
successful completion.  In this example, it is “189415” which 
shows the Phase as Completed, and the Status as Normal. 

 
If the Status Column indicates “Pending” or “Running,” Select the 
Refresh button until the status column reads:  “Completed.” 

2 Select the View Log button to display a log of how a request ran. 
3 Select the View Output button to view the output of a 

successfully completed request on screen. 
4 Select the Diagnostics button.  The Request Diagnostics window 

opens for your review.  

 
 

Continued on next page 
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Processing a Mass Award, Continued 

  
Viewing the Status of a Mass Award File (continued) 
 

Step Action 
5 Select the View Details button for more detailed information on 

the file. The Concurrent Requests window opens: 

 
6 Contact your System Administrator for assistance in reviewing the 

Request Log or the Concurrent Manager Request Summary to 
locate and correct specific errors. 

 Continued on next page 
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Processing a Mass Award, Continued 

 
Locating and 
Correcting 
Errors 

The System Administrator completes this function.  However, the Systems 
Administrator may designate one or two individuals in a Region to help with 
this function. 

• The Process Log is a registry of successful and failed records 
processed with a concurrent program.   

• If there are errors in a record, the system opens a complete error 
message notifying the user of the error.   

• The user then knows to look for a routed RPA in the record’s group 
box or system’s default group box. 

 
Step Action 

1 Navigation Path > Federal Maintenance Forms > Process Log 
and select Open. 

2 The Process Log Errors window opens with the request number 
as the last part of the Program Name data field.  The Log Text 
Region opens the reason for the error(s).  Use the scroll bars to 
read the remaining information. 

3 The actions will be corrected as needed by the personnelist who 
executed the action. 

4 The System Administrator will then process “Futures,” which 
reprocesses all actions noted as future in the Routing History Table 
to update the database.  The Process Log referenced above will 
also contain the details on all records successfully completed and 
processed with errors. 
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Processing Awards for Ex-Employees 

 
Step Action 

1 Navigation Path > People > Enter and Maintain and select Open. 
The Find Person window opens.   

 
2 Type the last name of the employee whose record you wish to 

update and Select the Find button.  A list of names will appear in 
the LOV window select the employee whose record you wish to 
update and Select the OK button.  

3 Select the Special Info button in the People window. 

 

Continued on next page 
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Processing Awards for Ex-Employees, Continued 

 
Step Action 

4 Verification of Current Appraisal – If the award being processed is 
based on performance, the appraisal has to be current in the ex-
employees record.  Otherwise, you will encounter CPDF edit.  
Please verify prior to initiating RPA for Award. Exit form to return 
to the Navigator window  

 
5 Navigate to Req for Personnel Action  ∏ Award One/Time 

Payment to Create RPA for an Award 

 
Enter the Effective Date of separation or a prior date.  Then, enter 
the ex-employee’s social security number – the remaining data 
such as name will auto populate. 

 
Continued on next page 
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Processing Awards for Ex-Employees, Continued 

 
Step Action 

6 Navigate to Page 2 (Position Data) and Enter the Award Amount 
then Select the OK button 

 
7 Select the Extra Information button, Select US Fed Award and 

Bonus Information from the Type data field  

 
Select in the Details data field to open field 

8 Enter Award Type (9L for this example), Date Award Earned (the 
02-May-2003 auto populated date is driven by the effective date 
entered on Page 1 of RPA – manual change to this date can be 
made  -- for example:  if the award is based on performance and 
the end date of appraisal period is 31 Mar 03, then manually enter 
31 Mar 03 in this date area)   Date Ex Emp Award Paid:  Enter the 
pay period in which the award will be paid – in this example:  18 
May 03 date will be entered.  This is the date that will also print on 
the NPA. Save work, close screen to return to navigator window. 

 
  

Continued on next page 
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Processing Awards for Ex-Employees, Continued 

 
Step Action 

9 Navigation Path > People > Enter and Maintain and select Open 
button.   
The find  Person window opens Enter the employees name and 
Select the Find button  

10 The People window opens Select the Alter Effective date icon  
and Date track to the date of employee Separation.  

11 Select the <Assignment> button 

12 Select the <Entries> button, select Federal Awards in the Element 
Name data field 

 
13 Select the <Entry Values> button to Verify Award Type, Amount 

or hours and the Date Ex Emp Award Paid 

 
 

Continued on next page 



                                                                                                                R12                                                                           March 2012 

Workforce Relations:  Awards                                 Mod 5, Chap 3, Page 25 

 
Processing Awards for Ex-Employees, Continued 

 
Step Action 
14 Exit all windows and return to the navigator window and select 

Pay 500 
15 The Payroll window opens, Type the Social Security number in the 

Filter by data field, Then Select the Find button. Check for Award 
Amount and Effective Date    

 
16 Both the Effective Date and the Award Amount are correct 
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Module 5 

Chapter 4 

Adverse Actions and Reprimands 
Chapter Overview 

  
Introduction The purpose of this chapter is to provide the process to document adverse 

actions. 

  
Chapter Contents  
 

Topic Page 
Preparing a RPA for Adverse Actions 2 
Documenting Adverse Actions 6 
Documenting Reprimands 9 
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Preparing a RPA for Adverse Actions 

  
Purpose The following information provides you with the steps in preparing a RPA for 

an Adverse Action.  

   
Accessing the 
Request for 
Personnel 
Action 

Navigation Path > Req Personnel Action > Non Pay/Duty Status.  The Non 
Pay/Non Duty Status Adverse Action is used for illustration purposes. 

 Step Action 
1 The Requesting Info tab of the RPA provides Part A – Requesting 

Office and Part B – For Preparation of SF 50 for user input.  
Instructions for completing the RPA are in Module 3, Processing 
Personnel Actions Using DCPDS, Chapter 1, Processing a Request 
for Personnel Action. 

 
2 
 
 
 

 
 
 

Complete Part B by typing the employee’s last name and press 
[Enter] to automatically populate the data field or if there is more 
than one employee with the same last name select from the LOV.  
The remaining employee data fields populate. 
 
Note:  The HR Office completes the Effective Date data field. 

 
 

Continued on next page 
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Preparing a RPA for Adverse Actions, Continued 

  
Accessing the Request for Personnel Action (continued) 
 

Step Action 
3 

 
Type in the Nature of Action Code (NOAC)         
Or  
Select the LOV to display a listing of NOACs in the First 
Nature of Actions window.  Select the correct code and 
Select the OK button to populate the 5-A Code and Nature 
of Action data fields.  

 
4 
 
 

 
 
 

 

Type in the Legal Authority Code that you need for an 
Adverse Action.        
Or 
Select the LOV icon to display the appropriate authority 
code.  Select the appropriate code and select the OK button 
to populate the data fields. 
 
Note:  The authority codes in the LOV reflect those that are 
applicable to the family of the NOA selected in the Nature 
of Action data field.   
 
[Tab] to the next data field and continue this process until 
you have completed all the Legal Authority Code data fields 
that are needed to be complete. 

5 Select Position Data tab at the top of the RPA window.  
 
 
 

Continued on next page 
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Preparing a RPA for Adverse Actions, Continued 

  
Accessing the Request for Personnel Action (continued) 
 

Step Action 
6 The Position Data window is automatically populated with the 

correct information for the Adverse Action.  

 
Select Employee and Position Data tab at the top of the RPA 
window. 

7 The Employee and Position Data window is automatically 
populated with the correct information for the Adverse Action. 

 
Select Remarks and Address tab at the top of the RPA. 

 
Continued on next page 
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Preparing a RPA for Adverse Actions, Continued 

  
Accessing the Request for Personnel Action (continued) 
 

Step Action 
8 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

The Remarks and Address window is automatically populated 
with the correct information for the Adverse Action if there were 
remarks previously made. 

 
Note:  You can use the LOV for a listing of additional remarks to 
select for Part F – Remarks for SF 50. 

9 Select Save icon.  A Decision window appears asking if you wish 
to route the request, Select the Yes button. 

10 The Routing window opens.  Select Update HR then Select the 
OK button. Your adverse action is now processed and a part of the 
employee record.  Any of the options on the Routing window can 
also be selected.  Selection will be based on Component business 
rules. 

 
 

Continued on next page 
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Documenting Adverse Actions  

  
Entering 
Adverse Action 
Data 

Use the following steps to input adverse action data into an employee’s 
personnel record in DCPDS. 

 
Step Action 

1 
 

Navigation Path > People > Enter and Maintain and select Open.  
The Find Person window opens.  Type in the employee’s name 
and Select the Find button.  

 
2 The People window populates with the employee’s data.  Select 

the Special Info tab.   

 
 
 
 

Continued on next page 
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Documenting Adverse Actions, Continued 

  
Entering Adverse Action Data (continued) 
 

Step Action 
3 Use the left scroll bar to locate US Fed Conduct Perf.  Select in 

the Details data field to display window. 

 
4 The US Fed Conduct Perf window opens.  Complete each data 

field with the required information using the LOV in the window 
or type in the information. 

 
 
 
 

Continued on next page 
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Documenting Adverse Actions, Continued 

  
Entering Adverse Action Data (continued) 
 

Step Action 
5 
 

After you complete the data fields in the US Fed Conduct Perf 
window, Select the OK button.  The data populates the Details 
data field. 
 

 
6 Select the Save icon and close the window. 

 
 
 

Continued on next page 
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Documenting Reprimands  

  
Entering a 
Reprimand 

 

Step Action 
1  

 

 

Follow steps 1 – 4 used in Documenting Adverse Actions section 
to document a Reprimand. 
 
Note:  Only the first three fields on the US Fed Conduct Perf 
window are required.  A reprimand is not an Adverse Action.  

2 In the Adverse Action NOAC data field, Select the LOV icon to 
select the appropriate code.  (Example:  0920 - Reprimand).   

For the Cause of Disciplinary Action data field, type in the 
appropriate action or select from the LOV.  (Example: 81 - Misuse 
of Telephone). 

For the Date of Adverse Action field, input the effective date of 
the Reprimand.  Select the OK button to return to the Special 
Information window. 

3 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

In the Special Information window, the Start Date automatically 
generates.  Change the start date to match the effective date of the 
Reprimand, if required.  Insert the end date for the end of the 
Reprimand timeframe.  

 
Notes:  If you update the Reprimand through Special Info for 
historical purposes, no RPA is needed and no SF50 is sent to 
Payroll.   

If it is a current action and not for historical purposes, you must do 
an RPA action to alert Payroll (Pay 500). 

4 Select the Save icon and close the window. 
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Module 6 

 

Administering Pay, Benefits, and Entitlements  
Using the DCPDS 

 

Module Overview 

  
Purpose This module explains how to enter, maintain and retrieve information on 

employee pay, benefits, and entitlements.   
• Pay includes basic salary rate, locality rate, adjusted basic pay, and total 

pay.  It does not include payroll management, which is included in 
Module 8, Payroll Management Using the DCPDS. 

• Benefits and entitlements include Thrift Savings Plan (TSP), Federal 
Employees Government Life Insurance (FEGLI), Health Benefits, and 
Awards. 

 
Module Contents  
 

Chapter 1:  Viewing PB&E Data 
Viewing Current PB&E Data by Employee 2 
Viewing PB&E History 6 
Viewing a List of Employees by Element 10 
Chapter 2:  Updating PB&E Data 
Processing a Change in FEGLI (Using the RPA) 3 
Accessing the RPA and Completing the FEGLI Change 3 
Processing a Living Benefits Election 4 

Accessing the RPA and Completing the Living 
Benefits Election 

4 

Initiating or Updating a PB&E Element (Without an RPA) 6 
Initiating a New Element 6 
Updating an Element 8 

 
Continued on next page 
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Module Overview, Continued 

  
See Also 
     

Module 1, Fundamentals of the DCPDS 

Chapter 3, Navigating the DCPDS 

Chapter 5, Updating and Viewing Employee Records 

Chapter 6, Retrieving Records 

Chapter 7, Folders 

Chapter 8, Reports 

Module 3, Processing Requests for Personnel Actions Using the DCPDS 

Module 8, Payroll Management Using the DCPDS 

  
Term Element – Categories of pay, benefits, and entitlements data are called 

“elements”; e.g., basic pay, locality pay, FEGLI, retirement plan.  
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Module 6 

Chapter 1 

Viewing Pay, Benefits, and Entitlements Data 

Chapter Overview 

  
Introduction This chapter shows you how to view Pay, Benefits, and Entitlements (PB&E) 

data referred to as Elements in DCPDS.   
• To view current Elements, use the People window. 
• To view Element history information, use the Assignments Folder 

window that contains information on applicants, employees, and ex-
employees in the database. 

  
Chapter Contents  

Topic Page 
Chapter Overview 1 
Viewing Current PB&E Data by Employee 2 

Accessing the People Window 2 
Viewing Current Elements 2 

Viewing PB&E History  6 
Accessing the Assignments Folder Window 6 
Viewing PB&E 8 
Viewing Elements 9 

Viewing a List of Employees by Element 10 
Printing a List of Employees by Element 12 

      
Who Does It? 

        

• Personnelist  
• Manager/Supervisor 
• Employee 
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Viewing Current PB&E Data by Employee 

  
Purpose This procedure guides you through the steps to view an Employee’s current 

elements. 

  
Accessing the People 
Window 

 

Step Action 
1 Navigation Path →  People → Enter and Maintain → <Open>. 
2 The Find Person window opens Query for the employee by typing 

in the last name (or SSN) and clicking the <Find>button. 
3 The People window opens the employee data as described in the 

Chapter Overview.  Click the <Assignment> button. 

  
Viewing Current Elements   
 

Step Action 
1 The Assignment window opens with many of the data fields 

populated and/or grayed out. Click the <Entries> button. 

 
 

Continued on next page 
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Viewing Current PB&E Data by Employee, Continued 

  
Viewing Current Elements (continued) 
 

Step Action 
2 The Element Entries window opens.  Select the Element Name 

you want to view; e.g., Health Benefits. Click the <Entry Values> 
button.   

 
Note:  The <Others> Taskflow button is not used by DoD.  

3 The Entry Values flexfield for Health Benefits opens. 

 
 
 

Continued on next page 
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Viewing Current PB&E Data by Employee, Continued 

  
Viewing Current Elements (continued) 
 

Step Action 
4 If the Element Name you need does not appear, place your cursor 

in a blank data field of the Element Entries window and click the 
LOV icon ( ).  The Elements Flexfield opens select the element. 
Select the <OK> button  

 
 
 

Continued on next page 



                                                                                                  R12                                                                             March 2012 

PB&E:  Viewing PB&E Data   Mod 6, Chap 1, Page 5 

Viewing Current PB&E Data by Employee, Continued 

  
Viewing Current Elements (continued) 
 

Step Action 
5 The selected Element now appears in the Element Entries 

window: 

 
6 Click the <Entry Values> button to view the elements data fields 
7 When completed the viewing, exit the windows. 
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Viewing PB&E History 

  
Purpose This procedure shows you how to view the PB&E history information in the 

employee’s record using the Assignments Folder window. 

  
Accessing the Assignments 
Folder Window 

 

 
Step Action 

1 Navigation Path → View → Histories → Entries → <Open>. 
The Assignments Folder window opens.  The window contains 
three buttons (Current, Past, and Both) in the Assignments 
Region, Employee data fields, and an <Entry History> Taskflow 
Button. 

 
2 Click the Both button in the Assignments Region to access current 

and past history information.   
 

Continued on next page 
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Viewing PB&E History, Continued 

  
Accessing the Assignments Folder Window (continued) 
 

Step Action 
3 With your cursor in the Full Name data field, query using 

F11/CTRL +F11 to view a list of all employees with current and 
past element history information. 
 
Note:  If you want to look at one employee’s record, press F11, 
enter %, part of the employee’s last name, %, and press CTRL 
+F11.  The folder will populate with applicants, employees, and 
ex-employees beginning with the last name.  Scroll through the list 
of names.  Place the Current Record Indicator on the line of the 
desired name.  The columns in view are:  Full Name, Type, 
Assignment Number, Title, and Last Name.  Use the bottom scroll 
bar to view remaining columns. 

 
Select the<Entry History> button. 

 
Continued on next page 
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Viewing PB&E History, Continued 

   
Viewing PB&E  
 

Step Action 
1 The View Element History window opens with the cursor in the 

Classification data field.  Place the cursor in Element Name data 
field. 

 
2 Use the following decision logic to determine your next step: 

  IF you want to view THEN…  
  A specific element Press F11; enter the desired element; 

e.g., Health Benefits, %, and press 
CTRL +F11 to run the query.   

 

  All elements Press F11/CTRL + F11 to run a query 
to show all the elements in the 
employee’s record.   

 

3 The Effective Date and the Element Name populates if the 
employee’s record contains the element.  To view details of the 
element, click the <Entry Values> button. 

4 The Entry Values Flexfield window opens with the information.  
View the information as needed.  

5 Exit the window. 
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Viewing PB&E History, Continued 

   
Viewing Elements  
 

Step Action 
1 With the cursor in Element Name data field, press F11/ CTTRL + 

F11 to execute and run a query.  All elements populate with 
effective dates.  Select an each element, and click the <Entry 
Values> button to view the details. 

 
2 To exit each element, click the “X” in the top right corner. 
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Viewing a List of Employees by Element 

   
Purpose This procedure guides you through the steps of viewing a List of Employees 

by Element. 

  
Viewing a List of Employees  
 

Step Action 
1 Navigation Path →View → Lists → Employees by Element → 

<Open>. 
2 The List Employees by Element window opens. 

 

3 With your cursor in the Element Name data field, click the LOV 
and select the element needed, and click the<OK> button. 

 

  

Continued on next page 
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Viewing PB&E History, Continued 

  
Viewing a List of Employees (continued) 
 

Step Action 
4 The current date defaults in the To/From data fields.  Adjust to the 

dates needed. 
5 Select or deselect the checkboxes next to Current or Ex-

Employees. 
6 
 

With your cursor in the Employee data field, click the <Find> 
button to populate the data fields.  

  
Note:  The bottom scroll bar begins under Entry Type.  The 
Employee name and Assignment Number stay visible as you 
scroll through the data.  The Count on the Message Bar shows the 
number of records available for viewing.  

 
Continued on next page 
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Viewing PB&E History, Continued 

   
Printing the List 
of Employees by 
Element 

 

 
Step Action 

1 There are two options for printing:   
• Export the list into an Excel spreadsheet and print. 
     OR  
• Press the Print Screen button on the keyboard and print the 

list on each page.   
2 
 
 
 
 
 
 
 
 
 
 

 

To export the list to an Excel Spreadsheet, click File in the Main 
Menu bar, then click Export.  The Export Data window opens.   

 
 
Note: If more than 100 records have been retrieved, you will get 
this message. Select the desired response. 

  
3 Follow the Excel spreadsheet procedures for sorting and printing. 
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Module 6 

Chapter 2 

Updating Pay, Benefits, and Entitlements Data 

Chapter Overview 

  
Introduction This chapter shows you how to manage PB&E data. 

• You must use the RPA to update benefits that require the production of a 
NPA, such as:  
• Federal Group Life Insurance (FEGLI). 
• Retirement plan information (CSRS, FERS).  
• TSP. 

• You can update PB&E data through the People window  →  
<Assignment> for benefits that do not require an RPA, such as: 
• Health Insurance. 
• Government Awards. 

  
Chapter Contents  

Topic Page 
Processing a Change in FEGLI (Using the RPA) 3 
Accessing the RPA and Completing the FEGLI Change 3 
Processing a Living Benefits Election 4 

Accessing the RPA and Completing the Living 
Benefits Election 

4 

Initiating or Updating a PB&E Element (Without an RPA) 6 
Initiating a New Element 6 
Updating an Element 8 
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Chapter Overview, Continued 

 
Who Does It? You must be in the role of Personnelist. 

 
Before You 
Begin 

• PB&E is initialized upon an appointment action.  Some elements, such as 
life insurance and TSP have a waiting period before the elements can be 
updated or an initial entry made.   

• To enter an element for an employee: 
• If necessary, change the effective date to the correct date for making 

the element entry by DateTracking. 
• If the pay period is closed at the effective date, you cannot make any 

non-recurring entries of elements that process in payroll runs. 
• Use the Element Entries window to make and review manual entries to 

input values for individual employees. 
• If the element you need to add or change is not found in the Elements 

Entries window, you can select it from the Elements LOV. 
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Processing a Change in FEGLI (Using the RPA) 

  
Purpose This procedure guides you through the steps for updating the PB&E area in 

an employee’s record using the RPA.  The example is for a Change in FEGLI. 

   
Accessing the RPA 
and Completing the  
FEGLI Change  

 

Step Action 
1 Navigation Path  →  Request for Personnel Action:  Change 

Actions  →  Change in FEGLI  →  <Open> 

2 The RPA displays the Change in FEGLI populated in PART A – 
Requesting Office.  The Action Requested, Nature of Action Code, 
and Legal Authority populated with the NOA Code and clear text.  
Complete the following data fields: 

    

3 Select <Employee and Position Data> tab at the top of the RPA to 
advance No information is needed on the Position Data page. 

4 With your cursor in the FEGLI data field, select the LOV icon to 
select the information needed.  Select the<OK> button. 

 
5 Select <Remarks and Address> tab to advance to Page 4.  With 

your cursor in Part F, Remarks, select the LOV icon to select the 
appropriate remark then select the<OK> button Repeat the 
procedure if more remarks are needed. 

 
6 Select Save icon and route the request as required by Component 

business rules. 
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Processing a Living Benefits Election 

  
Purpose This procedure illustrates how to process full or partial Living Benefits 

Election by an employee.   

 
Accessing the  
RPA and  
Completing the  
Living Benefits  
Election 

 

Step Action 
1 Navigation Path → Request for Personnel Action → Living 

Benefits → <Open>.   
2 The RPA displays the Living Benefits populated in PART A – 

Requesting Office.  Complete the other data fields as required.  

 

3 With your cursor in the blank data fields of Part A - Requesting 
Office Region, use the LOV and make appropriate selections. Then 
select the <OK> button.  Or type in the information. 

4 With your cursor in Part B – For Preparation of SF-50 Region, 
retrieve the employee’s information by typing in either the last name 
or social security number to automatically populate the data fields.  
You can also use the LOV on the Toolbar. 

5 In the Effective Date data field, enter an effective date for the Living 
Benefits election. 
• Type in a date using the format:  DD-MMM-YYYY.  

Or 
• Select the LOV to display the calendar to select and enter a date. 

 
Continued on next page 
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Processing a Living Benefits Election, Continued 

   
Accessing the RPA and Completing the Living Benefits Election (Continued)  
 

Step Action 
6 Select in the 5-A Code data field then select the LOV icon. To 

display the First Nature of Action codes Select a code then select 
the <OK> button.   

 
The corresponding Nature of Action and Legal Authority data fields 
display in the appropriate data fields. 

7 Select <Remarks and Address> tab to access Part F – Remarks 
for SF-50 Region, select in the Code data field, then select the LOV 
icon to display a list of FEGLI related remarks. Select the 
appropriate remark and select the <OK> button. 

 
To add additional remarks, select the next Code data field and repeat 
the procedure. If there are more than four remarks, select the last 
Code data field and select the down arrow on your keyboard to 
insert additional remarks. 

8 
 

 

Insert any data required to complete a remark (indicated by a blank, 
underlined space). 
Note:  Do not include a period at the end of the inserted data; the 
system populates the data with a period.  If you do include the 
period, it will result in two periods on the NPA when it is printed. 

9 
      

 

Select Save and route the request as required by Component 
business rules. 
Note:  There is no change to the FEGLI data field on the Employee 
and Position Data tab 
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Initiating or Updating a PB&E Element (Without an RPA) 

  
Purpose This procedure illustrates how to initiate a new data element (for example, 

Living Quarters Allowance), or update an element when a NPA is not 
required.  

 
Initiating a New 
Element 

 

Step Action 
1 Navigation Path → People → Enter and Maintain → <Open>.   
2 The Find Person window opens. Type in the employee’s name or 

social security number the select the<Find> button. 
3 The People window opens.  If the effective date of the data change 

is not the current date, select Alter Effective Date    on the 
Toolbar and enter new effective date. 

4 Select the <Assignment> button.    
5 Select the <Entries> button.  

6 If no data displays in the Element Name data fields then: 
• Select in the first Element Name data field. 
• Press the F11 / Ctrl +F11 button 

If data displays in the Element Name data fields, go to step 7. 
7 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Select the first blank Element Name data field.   

 
Note:  If there are no blank fields, "arrow" down until a blank field 
displays. 
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Continued on next page 



                                                                                                     R12                                                                       March 2012 

Updating PB&E Data  Mod 6, Chap 2, Page 8 

Initiating or Updating a PB&E Element (Without an RPA), 
Continued 

  
Initiating a New Element (continued) 
 

Step Action 
8 Select the LOV icon to select the appropriate item, and then select 

the <OK> button.   

 
9 Select the <Entry Values> button and complete the data fields. 

 
 

Continued on next page 
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Initiating or Updating a PB&E Element (Without an RPA), 
Continued 

  
Initiating a New Element (continued) 
 

Step Action 
10 Select the Save  icon and exit the windows.   
11 If the effective date was altered, select the Alter Effective Date 

button on the Toolbar then select the <Reset> button on the Alter 
Effective Date window to return to the current date. 

  
Updating an Element  
 

Step Action 
1 Follow steps 1-6 of Initiating a New Data Element in this 

chapter. 
2 Select the appropriate Element Name  
3 Select the <Entry Values> button.   
4 Select in the data field you need to change. 
5 Select the LOV icon to select the new item then select the<OK> 

button. 
6 If you are changing existing data, an Option window will appear 

asking Update or Correction. 
• Select <Update> to change the record as of the effective 

date you specify.  When you update a record all previous 
information is preserved and can be viewed in history. 

• Select <Correction> if the previous data was incorrect.  
The new information will override the previous 
information back to the date the error occurred. 

7 Select Save icon and exit the window. 
The Message Line will indicate that the transaction is complete 
and has been applied and saved. 

8 If the effective date was altered, select the Alter Effective Date 
button on the Toolbar then select the <Reset> button to return to 
the current date. 
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                                     Module 7 

Employee Training and Development Using  
DCPDS 

Module Overview 

   
Purpose This Module Overview introduces you to CIVDOD HR-Training 

Administration.  You will access only one application to administer 
Employee Training and Development:  Oracle Human Resources (HR) for 
employee information.   

 
Note:  This module is also available for Nonappropriated Fund (NAF), 
National Guard Bureau (NGB), and Local National (LN) personnel. 

   
Module Contents  

Topic Page 
Assumptions 3 
Audience 3 
CIVDOD HR-Training   3 
Roles and Responsibilities 3 
Definitions 3 
Responsibility Window 5 
External User  6 
CIVDOD HR-Training Secure User View 6 
Owned vs. Serviced Rule 6 
Education Information 7 
Training Program Requirements 8 
Continued Service Agreement 9 
Tracking Degree Training  9 
CIVDOD HR-Training Workflow 9 
CIVDOD HR-Training Definitions 10 
Stages of Training Cycle 12 
OPM Training Type Codes and Sub-Type Codes 13 
Navigation List 14 
Training Request Form (TRF) 15 
SF Form 182 15 
Individual Development Plan (IDP) 18 
Workflow Inbox 18 
Reports and Career Briefs 18 
Navigation List with Associated Windows and Topics 19 
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Module Overview, Continued 

 
Module Contents (continued) 
 

Chapter 1:  Requesting Training  1-1 
Completing the Training Request Form  2 
            Printing the Training Request Form  8 
            Completing Additional Training Request Forms 9 
            Viewing the Training Request Routing History 10 
Processing HR-Training Actions in the Workflow Inbox 11 

Training Request Form Routing History 14 
Approving or Disapproving the Training Request Form 16 
Customizing Your WorkFlow Inbox 17 

Chapter 2: Recording Completed and Required Training 2-1 
Recording Completed Training 2 
Recording Required Training 7 
Retrieving Completed/Required Training 9 
Exporting Retrieved Data 12 
Chapter 3:  Mass Update to Completed Training 3-1 
Chapter 3, Subchapter 1:  Mass Update to Completed Training 
Spreadsheet 

3-S1 

Chapter 4:  Tracking Degree Program Training Courses 4-1 
Chapter 5:  Updating Education                      5-1 
Chapter 6:  Recording Certificates and Licenses  6-1 
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Module Overview, Continued 

 
Assumptions In order to use CIVDOD HR-Training, you should have a basic understanding 

of: 
• Oracle HR (People) Application  
• Federal Laws and regulations relating to training 
• DoD training policy, regulations, and processes 
• The OPM Training Policy Handbook 
• Requirements of your Component’s training policy 

  
Audience  

This module is written for And contains information for 
CIVDOD HR-Training users • Employees 

• Training Administrators and Personnelists 
• Training Resource Managers 
• Managers/Supervisors 
• Training Monitors/Coordinators 
• Personnel Generalists 
• System Administrators 

  
CIVDOD  
HR -Training 

You will be using Oracle HR to access the Special Information Type (SIT) 
such as Completed and Required Training, and Education on the Navigation 
List. 

  
Roles and 
Responsibilities 
       

Defined roles and responsibilities are determined by each Component.  
CIVDOD HR-Training allows managers/supervisors, training monitors and 
coordinators, and personnelists/administrators to request and process training.  
The roles and responsibilities within the training cycle may be performed by a 
number of people as determined by each Component, such as the Training 
Administrator within the HR office, or the organizational Training 
Monitor/Coordinator. 

  
Definitions The following definitions show the standard roles for each responsibility.  

Components can customize these roles as necessary. 
 

 Role Responsibility 
CIVDOD        
HR-TRNG 
PERSONNELIST 

Complete access to all training processes and reports.  
Can be limited to specific functions or organizations 
depending on Component/local decision.  (This is 
typically the personnelist/trainer in the CIVDOD HR 
training office.) 

 
Continued on next page 
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Module Overview, Continued 

  
Definitions (continued) 
 

Role Responsibility 
CIVDOD        
HR-TRNG 
ADMINISTRA-
TOR 

Complete access to all training processes and reports.  
Change the roles and responsibilities of users for 
CIVDOD HR-Training functions.  (In addition to all 
CIVDOD HR-Training Personnelist responsibilities, this 
person will also have the ability to handle some systems 
administration work associated with CIVDOD HR-
Training.) 

CIVDOD        
HR-TRNG 
MGR/SUPV 

Complete access to all records and reports for their 
assigned employees.  Capability of completing the 
Training Request Forms, and printing DD Form 1556.  
Also, allows access to Completed Training and Required 
Training areas in HR for assigned organization.  
Components may determine further restrictions as 
necessary.  This role should also include military 
supervisors of civilian employees. 

CIVDOD        
HR-TRNG ORG 
TNG MONITOR 

Access to training records and reports for their assigned 
organization.  Capability of completing the Training 
Request Forms, and Printing DD Form 1556.  Also, 
allows access to Completed Training and Required 
Training areas in HR for assigned organization.  
Components may determine further restrictions as 
necessary.  This is the person in each organization who is 
responsible for handling and monitoring training. 

CIVDOD        
HR-TRNG 
COORDINATOR 

Access to training records and reports for their assigned 
unit within the organization.  Capability of completing the 
Training Request Forms, and Printing DD Forms 1556. 
Also, allows access to Completed Training and Required 
Training areas in HR for assigned organization.  
Components may determine further restrictions as 
necessary.   

CIVDOD        
HR-TRNG       
FISC OFF 

Access to all cost information on individual, group, and 
total training costs.  (This could be a resource manager in 
the organization or an individual in the accounting and 
finance office.  More than one person could have this 
role).  Does not have access to employee records. 
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Module Overview, Continued 

 
Roles and Responsibilities Screen Access   
 
CIVDOD HR-Training 
Responsibility/Role 

CIVDOD HR 
TRNG 

COORDINA-
TOR 

CIVDOD HR 
TRNG 

MGR/SUPV 

CIVDOD HR 
ORG TRNG 
MONITOR  

CIVDOD HR 
TRNG FISC 

OFF 

CIVDOD HR 
TRNG 

PERSONNEL-
IST 

CIVDOD HR 
TRNG 

ADMINISTRA-
TOR 

CIVDOD HR-Training  
        Menu Option 

      

Training Requests X X X X X X 
Training Request History Details X X X X X X 
Civilian Inbox X X X X X X 
Workflow Inbox X X X X X X 
Completed Training X X X X X X 
Mass Process       
Mass Completed Training     X X 
Reports        
     Submit Report X X X X X  X 
     View Report     X X X X X X 
Special Information       
     People/SITs for Training X X X  X X 
     View Employees by SIT X X X  X X  
Federal Maintenance Forms       
     Routing Groups        X 
     Routing Lists      X 
       

Continued on next page 
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Module Overview, Continued 

 
Illustration The Responsibilities Window: 

 

 
 

 
 

External User Users who are not currently part of the Oracle database (e.g., military, 
contractors) can be given access to Oracle HR to primarily perform 
supervisory duties.  They can initiate a Training Request Form (TFR); and 
other tasks.  These users are defined as “External Users.”  Contact your 
Training Administrator or System Administrator to set up External Users or 
see Module 4, Chapter 2, Building External Users. 

    
CIVDOD  
HR-Training 
Secure User 
Views 

You must be assigned an CIVDOD HR-Training Secure User View by your 
System Administrator before you can see employee records based on the 
organization(s) you service or the position hierarchy.  Additionally, you must 
have an CIVDOD HR-Training Secure User View to process CIVDOD HR-
Training actions in your Civilian Inbox, initiate a Training Request Form, or 
request Training Reports. 

 
Owned vs. 
Serviced Rule 

If you service personnel belonging to another agency, the rules of the owning 
agency will apply to recording Completed Training.  
 
Example:  If Navy services an Air Force employee, Air Force rules will 
apply. 
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Module Overview, Continued 

 
Education 
Information 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                  

Employee education data may be accessed to check for course prerequisites, 
tuition assistance, and for other reasons.  To access Education data for an 
employee: 

Navigation Path > SIT > Open.  The Find Person window opens.  
Query for the employee and the People window opens.  Click Special 
Information.  The Special Information window opens.  Scroll to 
Education and click the Details data field for specific information (or 
click [F11], type Education, and click [CTRL +F11]).   
 
Note:  If the Information Exists Checkbox is not checked, then no 
data is stored in the Descriptive Flexfield.  

 

 
 

Completed Training and Required Training are also found under Special 
Information.  
 
Note:  Managers/Supervisors, Training Coordinators, and Training Monitors 
have “read only” access to employee education. 
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Module Overview, Continued 

 
Training 
Program 
Requirements 

Training Program Requirements (e.g., Supervisory Course Completed, 
Special Program Identifier, Date Training Obligation Expires, and other 
programs) are found under Extra Information.  To access this data for an 
employee: 

Navigation List > People > Enter and Maintain > Open.  The Find 
Person window opens where you can query for the employee.  When 
selected record appears, click Extra Information.  Scroll to Training 
Program Requirements or query for it and click the Details data field 
for specific information.    If you are logged in under a CIVDOD HR-
Training responsibility, Training Program Requirements will be the 
only DDF to appear.    

 
 

  
 

 



                                                                                                R12                                                                               March 2012 

Training:  Employee Training and Development Overview Mod 7, Overview, Page 9 

Module Overview, Continued 

 
 
Continued 
Service 
Agreement 

The Continued Service Agreement (CSA) is generated along with the 
DD Form 1556 when printed.  Follow your Component’s policy for 
completion.  The date the CSA expires is entered in the People Record 
> Extra Information > US Federal Person Service Obligation.  
Scroll to Training Program Requirements or query for it and click 
the Details data field for specific information.    If you are logged in 
under a CIVDOD HR-Training responsibility the US Federal Person 
Service Obligation will appear.   Select the Training Received (01) 
code from the LOV then enter the Service Obligation Start and End 
dates.   

 

 
 

 
 
Tracking 
Degree 
Training 
Courses 
 

 
 
See Chapter 4, Tracking Degree Program Training Courses, in this module 
for details. 
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Module Overview, Continued 

 
 
CIVDOD  
HR-Training 
Workflow 

The sequence from the initial request to the HR-Training Administrator: 
     Completion of the Training Request Form 

⇒ Routed for approvals 
⇒ TRF used as a contract with vendor (i.e., to document costs, 

training location information and as a ‘ticket’ to attend a class.) 
⇒ Only completed data is recorded in the employee record 
⇒ Printed copy can be offered for the employee 

  You will access one application to administer Employee Training and 
Development which is Oracle Human Resources (HR) for employee 
information.   

 
 

CIVDOD   
Training  
Definitions 
 

Term Definition 
Completed Training Training completed either on or off-duty. 
Continued Service 
Agreement (CSA) 

An employee selected for training agrees in writing 
before assignment to training to continue in federal 
service based on OPM and component policy. 

Total Direct Cost Tuition, materials and fees directly supporting 
training. 

External Users Supervisory personnel outside the database that may 
need to access their employee’s records. 

Extra Information Categories of information that reside on the People 
record such as Special Training Requirements.  
Only one entry per category can be input, such as 
TSP vs. a SIT where multiples can be input. 

Total Indirect Cost Travel costs to include travel and per diem. 
Individual 
Development Plan 
(IDP) 

Completed Training information extracted from 
employee’s record. 

Method Training received through a Seminar, Classroom, 
Multi-media, or other means. 

 
 

Continued on next page 
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Module Overview, Continued 

 
CIVDOD  Training Definitions (continued) 
 

Term Definition 
Notifications Notices in the Civilian Inbox that describes the 

nature of the actions (e.g., training request awaiting 
approval).  

Reports Standard reports, extracting the SF 182, the Training 
Request Form, and Ad Hoc Reports. 

Required Training Mandated by law, Executive Order, DoD, 
Component, installation, etc., stores this data in a 
separate area for reference.   

Responsibility Each responsibility lets you access a specific set of 
forms, menus, reports, and data to fulfill your 
business role.  Several users can share a 
responsibility, and a single user can have multiple 
responsibilities. 

Special Information 
Types (SIT) 

Categories of personal information that reside on the 
People record of Oracle HR such as Completed or 
Required Training, and Education where multiple 
occurrences can be stored. 

Training Request 
Form (TRF)  

Used to request training and forward through 
Civilian Inbox to approving offices.  It contains part 
of the information that system-generates a SF 182, 
from the employee’s record.  

Training Source Government, College/University, Other DoD, etc. 
Type A five-digit code used by Army, Navy, Air Force 

and NSPS for delineating their training types.   
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Module Overview, Continued 

  
Stages of the 
Training Cycle 

Using CIVDOD HR-Training, the main stages in the training cycle are as 
follows: 
 

Stage Description Application 
1 Identify Training Needs – Nominate students and 

request training.  
Completed 
Training and 
Required 
Training  

2 Approve Training – To be conducted by approving 
Training Request Forms (TRF). 
• Send TRFs through appropriate levels.  You 

must know who you are to send the request to as 
there is no specific routing list. 

CIVDOD 
HR-Training 

3 Manage Training  - Manage enrollments, 
cancellations, attendance and completions: 
• Handle enrollments through stages: 

• Nominations 
• Waiting Lists 
• Confirmations 
• Cancellations 
• Standard letters as required 
• Actual expenses tracked 

• Completed training recorded in the employee 
record. 

Components 
Choice of 
Software 
 
 
 
 
 
 
People 
(Special 
Information 
Type) 
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Module Overview, Continued 

  
OPM Training 
Type Codes 
and Sub-Type 
Codes 

OPM Training Type Codes and Sub-Type Codes will be used in the 
Completed Training.  Type Code must use only the associated Sub-Type 
Codes. 
 

Type Definition 
01 Training Program Area 
02 Developmental Training Area 
03 Basic Training Area 

Sub-
Type 

Definition 

NOTE: Only to be used with Type Code 01 
01 Legal 
02 Medical and Health 
03 Scientific 
04 Engineering and Architecture 
05 Human Resources 
06 Budget/Finance Business/Admin 
07 Planning and Analysis 

08 Information Technology 
09 Project Management 
10 Acquisition 
11 Logistic Specialty  
12 Security 
13 Clerical (Non-Supv clerical/administrative) 
14 Trade and Craft 
15 Foreign Affairs 
16 Leadership/Mgr/Communication Courses 

Sub-
Type 

Definition 

NOTE: Only to be used with Type Code 02 
20 Presupervisory Program 
21 Supervisory Program 
22 Management Program 
23 Leadership Development Program 
24 SES Candidate Development 
25 Executive Development 
26 Mentoring Program 
27 Coaching Program 

 
Continued on next page 
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Module Overview, Continued 

  
    

Sub-
Type 

Definition 

NOTE: Only to be used with Type Code 03 
30 Employee Orientation 
31 Adult Basic Education 
32 Mandated Training 
33 Work-Life 
34 Soft Skills 
35 Agency Specific 

 
  

 
Navigation List The following CIVDOD HR-Training functions will not be available to all 

users.  Functions are available based on assigned responsibilities as assigned 
by each component. 
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Module Overview, Continued 

 
Training 
Request Form 
(TRF)  
 
 
 
 
 
 
 
 
 

 
 

The Training Request Form (TRF) is a simplified method used to request 
training through CIVDOD HR-Training.  Employees, supervisors, training 
monitors, or training managers can complete the one-page window.  By 
clicking the List Of Values (LOV) (the ‘…’ellipsis at the end of the field) you 
can select basic employee data by choosing a name from the list.  Select the 
employee and the Organization, Title, Plan/Series/Step/Grade, SSAN, Office 
Phone, Handicapped, and Type of Appt fields will auto-populate.  The Course 
Code, Title, Source, Location, and Priority are free text form.  When the form 
is completed, it can be forwarded electronically to the next approving level.  
For more information, see Chapter 1, Requesting Training, in this module. 
 
Note:  A completed SF 182 can be printed after each stage of the TRF is 
completed.   
 

Illustration  The Training Request Form: 

 
 
 

  
 

SF 182 The SF182 is a method for requesting training. 
• It is an output form that can be printed when needed for written or 

official documentation.   

• The SF182 may be viewed and printed at each level in the approval 
process but will print only those portions that have been completed up to 
that point. 

 
Continued on next page 
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Module Overview, Continued 

  
SF 182 (continued)

 
Continued on next page 
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Module Overview, Continued 

  
SF 182 (continued) 
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Module Overview, Continued 

  
Individual 
Development 
Plan (IDP) 

The IDP information can be extracted from the Completed Training data 
fields in Oracle HR (People>Special Information) using your Component’s 
query tools.   

  
Workflow 
Inbox  
 
 
 
 
 
 
 

 

CIVDOD HR-Training uses the Workflow Inbox to display notifications 
initiated by you or routed to you.   
• Training Request Forms and other actions are stored and routed through 

the Workflow Inbox for approval or required follow-on action.   
• See Chapter 1, Requesting Training, Accessing the Workflow Inbox, in 

this module and Module 1, Fundamentals of the DCPDS, Chapter 7, 
Folders. 

 
Note:  Separate folders can be established for CIVDOD HR-Training actions 
versus Request for Personnel Actions (RPAs).  However, to process a 
Training Request, you must be in a role with CIVDOD HR-Training 
responsibility. 

 
Illustration A Work Flow Inbox window: 

 

 

 
 

Reports and 
Career Briefs 

All training-related career briefs and reports are available through Processes 
and Reports.  Additionally, managers and training coordinators may access 
specific budget reports on their employees. The Civilian Servicing Unit 
(CSU) can also be accessed to retrieve Employee Training History and career 
briefs on Education, Acquisition, and others. 
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Module Overview, Continued 

  
Navigation List 
With 
Associated 
Windows and 
Topics  

The Navigation List of the CIVDOD HR-TRNG Administrator with 
Associated Windows and Topics: 

 
Navigation List   Associated Window(s) Procedure Steps by Topic 

Training Requests Training Requests Completing the Training Request 
Form 

Training Req:  History  
   Details 

Training Request - 
Routing History 

Training Request Form Routing 
History 

Civilian Inbox   
Workflow Inbox Notifications Summary Processing training actions in the 

Civilian Inbox 
Completed Training Completed Training Completed training data stored by 

employee record 
Mass Process   
    Mass Completed    
Training 

Mass Completed Training Uploading training completions in 
a mass process from a spreadsheet 

Reports   
   Submit Report Submit Requests Printing a SF182 

Printing a Student Course Eval 
   View Report Completed Requests Viewing Reports and Forms 
Special Information    
   People/SITS for 
Training 

Find Person 
People 

Updating Required Training in HR 
Retrieving and Updating 
Completed Training 

  View Employees by 
SIT 

Select criteria from SIT View list of employees  

Federal Maintenance 
Forms 

  

   Routing Groups  Special Training Programs 
   Routing Lists  List of associated routing personnel 
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 Module 7 

Chapter 1 

Requesting Training  

Chapter Overview 

  
Introduction This chapter explains the processes related to requesting training.  It guides 

you through the steps to complete the Training Request Form (TRF) and 
route it to the next approving official/office.  The TRF will serve as a record 
of the request and can be printed at any level. 

 
Chapter Contents  

Topic Page 
Chapter Overview 1 
Completing the Training Request Form 2 
     Printing the Training Request Form 8 
     Completing Additional Training Request Forms 9 
     Viewing the Training Request Routing History 10 
Processing HR-Training Actions in the Workflow Inbox 11 
      Training Request Form - Routing History 14 
      Approving or Disapproving the TRF 16 
      Customizing Your Workflow Inbox 17 

  
See Also 
      

In this Module: 
Overview 

Continued Service Agreement (CSA) 
Roles and Responsibilities       

      Chapter 4, Training Completions and Evaluations 
Recording Completed Training in HR 

 
Continued on next page 
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 Completing the Training Request Form 
 

Purpose This section will guide you through the process for completing the Training 
Request Form (TFR). 

  
Who Has 
Access  

        

Components will determine the level of access to HR-Training.  Employees may 
submit their own TRF to their manager/supervisor if they have been granted 
access to HR-Training by their Component.  Components will also determine 
who the final approved TRF is routed to for information purposes, such as the 
initiator of the action or the supervisor. 

  
Before You 
Begin 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 

• You must be in an HR-Training Secure User view to access employee names 
to populate the TRF, to process actions in the Workflow Inbox, and to print 
Standard Form 182. 

• Use the TRF to submit a request for enrollment to request training at a future 
date.  The TRF is also the audit trail for approval of training and may be used 
as an invoice.  

• Personnel data in the TRF auto-populates some of the data fields in the 
Standard Form 182.  Data in the TRF does not flow and is only a tool. 

• The TRF is available for individual requests only; however, you can easily 
make additional copies following the procedure in this chapter.   

• If you do not complete the TRF, you can send it to your Workflow Inbox and 
return to it at a later time. 

• A TRF is not required if you want to record an employee’s self-development 
courses, or those completed at another agency.  

• HR-Training does not have a Routing List like the RPA.  A specific person’s 
name from the LOV must be selected for routing purposes. 

• Normally, the HR-Training Mgr/Supv or the HR-Training Org Trng Monitor 
will complete the TRF.  In some cases, it may be completed by the HR-
Training Personnelist if that office is centrally contracting or conducting the 
Event.   

• Employees can only route their TRFs; approval status buttons are grayed out. 
• The same person cannot create and approve the TRF. 
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Completing the Training Request Form, Continued 

 
Completing the Training Request Form  

Step Action 
1 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select the responsibility that you have been assigned by your 
Component on the Responsibilities window.   

 

 
Note:  See Roles and Responsibilities (Definitions and Access) in 
Module Overview. 

2 The Navigation List opens.  Select Training Requests.  

 
 

Continued on next page 
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Completing the Training Request Form, Continued 

  
Completing the Training Request Form (continued) 
 

Step Action 
3 The Training Request Form window opens. 

 
 

4 Click your cursor in each of the following data fields to complete: 
 

 Data Field Description/Action  
Employee Region:  
Name                       Type the name or select from the LOV 

on the Toolbar.  The NAME field is a 
required field.  The SSAN, 
Organization, and the remainder of the 
Employee Region will auto-populate 
from the HR database. 

Course Region:  
Code This is a free form text field where the 

OPM Training Type Code may be 
entered. 

Title This is a free form text field to allow the 
course Title to be entered.    

 
 

Continued on next page 
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Completing the Training Request Form, Continued 

  
Completing the Training Request Form (continued) 

  
Step Action 

4 
(contd.) 

 Data Field/Region Description/Action  

  Course Region: 
(contd.) 

  

  Source Type in the code (e.g., G for National 
Guard, 4 for Private Vendor, etc) or 
select from an attached List of Values. 

 

  Location Type in the location of the training or 
select from an attached List of Values. 

 

  Priority Select from an attached List of Values.  
  Start Date Type in the start date of the training 

(DD-MMM-YYYY). 
 

  End Date Type in the end date of the training 
(DD-MMM-YYYY). 

 

  Required       
Training 

Click the radio button for ‘Yes’ or ‘No’.  
You should also update the HR 
Required Training if this is one of your 
Component’s business rules. 

 

  Level Select the level of the person submitting 
the TRF from the drop-down menu, 
e.g., Employee, Supervisor, Training 
Coordinator.  The level is preset on the 
form to complete the signature blocks of 
the approving officials.   

 

  Training  
 Duty Hours 

Type in the total training hours 
accomplished during duty time.   

 

  Training Non- 
Duty Hours 

Type in the total training hours 
accomplished during off-duty time.   

 
 

  Total Training  
Hours 

Total Training Hours auto-calculated 
after duty and non-duty hours are 
entered. 

 
 

 
Continued on next page 
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Completing the Training Request Form, Continued 

 
Completing the Training Request Form (continued) 
 

Step Action 
4 

(contd.) 
 Data Field/Region Description/Action  

  Tuition & Fees Projected cost of tuition and fees.  
  Materials Projected cost for materials.    
  Total Direct Cost Projected costs for tuition & fees and 

materials calculated as total direct costs. 
 

  Travel Projected cost for travel.  
  Per Diem Projected cost for per diem.  
  Total Indirect 

Cost 
Projected costs for travel and per diem 
calculated as total indirect costs. 

 

  Approval Status 
Region:    

                     

Select one of the available buttons. 
 
Note:  All selections to which you do not 
have access will be grayed out. 

 

  Approved This action allows the HR Training 
Administrator to complete the 
registration process.  Components can 
determine their specific policy.   

 

  Disapproved This action stops the workflow process 
and sends a disapproved notification to 
the Civilian Inbox of the requestor.   

 

  Continue Routing Selection of this button allows the TRF 
to be changed or to be routed.   

 

  Approved and  
Continue Routing 

Selection of this button documents an 
approval level but does not stop the 
workflow process.  A notification will 
flow to the requestor that the TRF is 
approved.   

 

  Forward to Select the LOV to select the name of the 
next person to access the TRF.   

 

  Comments Type in comments up to 4 lines or 2000 
characters. 

 

 
Continued on next page 
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Completing the Training Request Form, Continued 

  
Completing the Training Request Form (continued) 
 

Step  Action 
5 Select Save    on the Toolbar.  The TRF will go to the inbox 

of the person “Forwarded To.”  The Message Bar at the bottom of 
the window will indicate the status of the TRF, “Transaction 
complete.  1 records applied and saved.” 

6 Continue routing the TRF until all approvals are received. 
Example of completed TRF:   

 

7 The TRF is forwarded to the Workflow Inbox of the person 
designated in the Forward to data field.   The Print SF 182 
button will allow the form to be printed at any state of the 
process. 
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 Printing the Training Request Form 

   
Printing the TRF  
 

Step Action 
1 
 

 

To print the TRF, select the Print SF 182 button.  

 
2 A NOTE is displayed saying “REPORT SUBMITTED.  

CONCURRENT REQUEST ID IS 9999999”.  The actual 
concurrent request ID will be displayed in place of 9999999.  
(Record this number for viewing the concurrent process.) 

3 To view the progress of the concurrent process click View/Requests 
from the menu bar.  Then click FIND. Enter the process number to 
locate the status. 

4 Meanwhile, the SF 182 will print automatically to the user’s default 
printer.  

5 Exit the window and return to the Navigation List. 
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Completing Additional Training Request Forms 

  
Completing 
Additional 
Training 
Request Forms 

 
Follow this procedure to complete additional training request forms:   

 
Step Action 

1 Select Training Request Form from the Navigation menu. 
2 A blank Training Request Form will open. 
3 With your cursor in the Name data field, select the employee name 

from the List of Values (LOV).  The remaining data in the 
Employee Region auto-populates. 

4 Complete the form as previously described.  The fields are open 
and data can be entered without the requirement of a course catalog.   
Select items from the LOVs when they are available.   

5 Complete the Level, Approval Status and person to Forward to. 
6 Save the request.  
7   To complete additional requests select New  from the Toolbar. 
8 Save the new request then repeat the process for each person or 

new course. 
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Viewing Training Request Routing History 

  
Viewing the 
Routing History 

 

Step Action 
1 From the Navigation menu select Training Req. History Details 

then <Open>.   
2 The Training Request Routing History window will open. 

With your cursor in the Person Name data field, press F11.  Type 
in the employee name or the first few letters of the last name, the 
% sign, then press CTRL + F11 or View, Query by Example then 
Run.   

 
 Data Field Description  

 Forward From Display 
Name 

This is the person who 
initiated the TRF. 

 

  Forward To Display Name This is the person who the 
TRF was routed to. 

 

  Action Taken Approved, Disapproved, etc.  
  Approval Level These are the Levels on the 

TRF. 
 

  Date Notification Sent A time stamp is included with 
the time of day. 
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Processing HR-Training Actions in the WorkFlow Inbox 

 
Purpose This procedure guides you through the steps for accessing and moving HR-

Training actions in the Workflow Inbox. 

  
Definition 
 
 
 
 
 

The Workflow Inbox opens notifications of actions initiated by you or routed 
to you.  Everyone who has an inbox (e.g., Supervisor, Training Official, 
Authorizing Official, Training Monitors, Training Managers, and Training 
Personnelist) can process training actions. 
As Training Requests are submitted, they will be forwarded to the appropriate 
Workflow Inbox to await further action.  

   
Who Can 
Access the 
Workflow 
Inbox  

     

Managers/supervisors, HR-Training Personnelist, Training Coordinators, and 
Training Monitors in the organization assigned to a Workflow Inbox with an 
HR-Training responsibility.  There is no specific routing list so one must 
know who they are forwarding the request to.   

  
Before You 
Begin 
 
 
 
 
 
 
 
 
 

 
 
 

• Before a Training Request action will display in your Workflow Inbox, a 
completed Training Request Form (TRF) must have been completed and 
forwarded by an employee, manager/supervisor, Training Monitor or 
Training Coordinator to you. 

• To process a TRF in your Workflow Inbox, you must have an HR-
Training Secure User View. No names display on the LOV if you do not 
have an HR-Training Secure View. 

• The TRF auto-populates the employee portion of the Standard Form 182.  
You must complete the TRF if you want to print the complete form. 

• Training Request Forms can be accessed from the Workflow Inbox; 
however, you must access the Inbox through a trainer role (HR-Training 
Administrator, Manager, Personnelist, Monitor, or Coordinator) before 
you can process actions.  If you are using any other role or responsibility 
and try to process a TRF, you will get an error message. 

• If you forward the TRF, it will not display in your inbox after you close 
and reopen it. 
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Processing HR-Training Actions in the WorkFlow Inbox, 
Continued 

 
Accessing the 
Workflow Inbox 

 

Step Action 
1 Ensure you are in the proper training role or responsibility.  Select 

the Navigation Path <Workflow Inbox> then <Open> or double-
click. 

2 The Notifications Summary window opens.  You can now see all 
actions sent to you (training and otherwise) that relate to your user 
roles and responsibilities. 
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Processing HR-Training Actions in the WorkFlow Inbox, 
Continued 

 
Accessing the 
Notifications Window 

 

 
Step Action 

1 Select an available action by clicking in the appropriate check-box, 
then select <Open> on the Notifications Summary window to 
display the Notifications Details window.  

 
 

2 
  

From the Notifications Details window, you can process the TRF 
action by clicking the Training Requests link in the Response 
section and displaying the TRF.  To view the history of the TRF, 
click the Routing History Form link in the References section. 

  Data Fields and Buttons Description/Action  
  Comment You can add additional information 

in this data field.  However, it stays 
with the request and does not go into 
history. 

 

  References This contains the Routing History 
Form link  
 

 

  Response This section contains the link to the 
Training Requests, which will open 
the TRF. 
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TRF Routing History 

 
Training Request – Routing 
History 

 
 

Step Action 
1 Select the Routing History Form link. 
2 The Training Request – Routing History window opens. Click 

Ctrl + F11 to view the TRF history 

 
Use the lower scroll bar to view the remaining columns. 

  
  Data Field Description/Action  
  Training Request 

Forwarded By 
This is the name of Supervisor, Training 
Monitor, etc., who forwarded the TRF. 

 

  Action Taken Self-explanatory – matches Approval 
Status Region of the TRF. 

 

  Level This is the Level of the person who 
submitted the TRF (e.g., supervisor). 

 

  Forward to Name The next person designated to take action.  
  Date Notification 

Sent 
Self-explanatory.  

  
 

Continued on next page 
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TRF Routing History, Continued 

  
Training Request – Routing History (continued) 
 

Step Action 
3 Once you have reviewed the columns, exit the window to return to 

the Notifications window. 
4 Select the Training Requests link on the Notifications window.                        
5 The TRF will open.  You will need to review the action then take 

appropriate action to Approve, Disapprove, or Continue Routing.  
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Approving or Disapproving the TRF 

 
Approving or 
Disapproving 
the TRF 

 
 

Step Action 
1 
 
 
 

 

 

Select the appropriate button, as determined by your role, in the 
Approval Status Region of the TRF. 
 

 
 
Note:  See information on Approval Status in Chapter 1 of this 
module. 

2  
  If you are the final Approving 

Official: 
If you are not the final 
Approving Official: 

 

  • Click <Approved> or 
<Disapproved>. 

• Click <Continue 
Routing> or <Approved 
and Continue Routing>. 

 

  • Click the Save button on 
the Toolbar. 

• Use the LOV to select the 
name to enter in the 
Forward to data field or 
type in the name. 

• Click the Save button on 
the Toolbar. 

 

 

    

 
Note:  If you disapprove the request, you will not complete the 
next step. 

3 Exit the windows.   
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Customizing Your Workflow Inbox  

 
Customizing 
Your Inbox 

On the Notifications window, click the Personalize button to customize 
folders in your inbox for your use.

 
 
Personalize Views will display a list of pre-configured and/or personalized 
views applicable to “Worklist” table on the previous screen. 
 

 

   
See Also 
     

Module 1, Fundamentals of the DCPDS 
Chapter 7, Folders 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



                                                                                                  R12                                                                             March 2012 

Training:  Requesting Training                                                             Mod 7, Chap 1, Page 18 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

THIS PAGE INTENTIONALLY LEFT BLANK 
 
 



                                                                                                               R12                                                                            March 2012 

Recording Completed and Required Training                                     Mod 7, Chap 2, Page 1 

Module 7 

Chapter 2 

Recording Completed and Required Training  

Chapter Overview 

 
Introduction This chapter explains the processes related to documenting training 

completions and required training to include updating the employee’s record.  
It also includes retrieving required and completed training from their record. 

      
Chapter Contents       

Topic Page 
Before You Begin 1 
Recording Completed Training  2 
Recording Required Training  7 
Retrieving Training for a List of Employees 9 
Exporting Retrieved Data 12 

      
Who Does It 

        

Components will determine who has this responsibility. 

    
Before You 
Begin 

Employee’s training history of both completions and non-completions will be 
recorded in Oracle HR, through the People window in Completed Training.   

    
Purpose This section will show you how completed certifications are processed and 

forwarded for inclusion in the employee’s record.   
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Recording Completed Training  

  
Recording  
Completed  
Training  

This procedure is for individually documenting completed training.    

 
Step Action 

1 From the Navigation Menu, select a responsibility of CIVDOD 
Personnelist, CIVDOD HR-Training Administrator or 
CIVDOD HR-Training Personnelist.  Then select Completed 
Training from the menu list.  

2 The Find People window will open.  With the cursor in the Full 
Name data field, input known data and click the <Find> button. 

 
3 A list of records to choose from will appear.  To view a particular 

record, place the cursor on the desired record and click the  
button.   

 
 

Continued on next page 
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Recording Completed Training, Continued 

Recording Completed Training (continued) 

  
Step Action 

4 To add a new entry, click the green plus sign (or scroll to the 
bottom of the list). A new line will appear. Input the Course Title, 
Training Start Date and Training End Date; then click the arrow at 
the end of the row. 

 
5 The Completed Training Form will appear with the Course Title, 

Training Start Date and Training End Date.  These fields cannot be 
changed without deleting the entry and starting again. 

 
 

Continued on next page 
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Recording Completed Training, Continued 

  
Recording Completed Training (continued) 
 

Step Action 
6 All highlighted fields are required and cannot be left blank.  The 

following lists each data field and its descriptions.  Fields with 
Lists of Values (LOV) contain an ellipsis box to select from. Use 
the Tab Key to move between fields. 
    
Training Details: 
Course Title Populated from previous screen 
Trng Duty Hours Enter duty hours 
Trng Non Duty Hours Enter non-duty hours 
Total Course Hours Total hours will calculate 
Trng Start Date Populated from previous screen 
Trng Grad Date Populated from previous screen 
Course Grade Enter grade received 
Date Withdrawn Use only if employee does not 

complete the course 
Reason for Withdrawal Click the LOV, select applicable 

reason 
Trng Type Select from LOV 
Trng Sub Type Select from LOV 
Trng Source Select from the LOV or type data 
Agency Type Code Select from the LOV.  The %  may be 

used as a wild card.  Select the 
applicable code. 

Trng Delivery Type Select applicable code from the LOV 

Acquisition School 
Source 

Select applicable code from the LOV. 
This is required for Acquisition 
schools. 

Priority Indicator Select applicable code from the LOV 

Decision Source Select applicable code from the LOV 

Trng Purpose Type Select applicable code from the LOV 
 

 
Continued on next page 
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Recording Completed Training, Continued 

  
Recording Completed Training in HR (continued) 
 

Step Action 
6 

(cont) 
Training Cost Details: 
 
Funding Source Select from the LOV  
Trng Travel Indicator Use the LOV 
Tuition and Fees Enter amount in dollars and cents 
Books & Materials Costs Enter amount in dollars and cents   
Direct Cost Total Calculates from the two previous 

DDFs 
Funded by Direct Select from the LOV  
Direct PEC ID Type in the ID number (Used by AF 

Only) 
Travel Enter amount in dollars and cents 
Per Diem Enter amount in dollars and cents 
Total  In-Direct Cost Calculates from the two previous 

DDFs 
Funded by Indirect Select from the LOV  
Indirect PEC ID Type in the ID number (Used by AF 

Only) 
Trng Costs Total Automatically calculates total based 

on total direct and indirect costs 
  

 

 
 

Continued on next page 
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Recording Completed Training, Continued 

  
Recording Completed Training in HR (continued) 
 

Step Action 
6 

(cont) 
        
   Other Details:  
 
Course Number Code Optional use, no LOV but able to 

type free text 
Local Code Optional use, no LOV (Used by 

DAU) 
Non-Gov Contribution Enter amount paid by other than 

government    
Cont Srvc Agrmnt Ind Select from LOV   
Cont Srvc Agrmnt Exp Dt If CSA is required, a date must be 

entered 
Trng Accreditation Ind Select from LOV   
Trng Credit If Training is accredited, credit 

hours must be entered 
Trng Credit Type If credit hours are entered, credit 

type must be entered 
Trng Dsgn Type Select from LOV for designated 

type of training 
Trng Update Source Use LOV for Self Certified or 

Verified 
  

 

7 Select Save on the Toolbar.  The message “TRANSACTION 
COMPLETED – 1 RECORD(S) APPLIED” will appear when 
action has been saved.   The Completed Training course data can 
be saved one record at a time or this form can be completed 
through the mass training update process.   
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Recording Required Training  

   
Purpose This section will show you how to record or update Required Training.  

Required training can be used for the Individual Development Plan (IDP) 
process.  It can be accessed by the Supervisor, Training Coordinator, or 
Training Monitor for input purposes.  Retrieving data is explained in the next 
process, Retrieving Completed/Required Training. 

  
Recording  
Required  
Training 

 

Step Action 
1 Navigation Path: Special Information >  People/SITs for Training 

2 Search for employee in Full Name field (click Find) 

3 Click Special Info button 

4 Scroll down to find Required Training, and click in the Detail flex 
field 

 
5 On the Required Training Descriptive Flexfield, complete the 

following data fields: 

 
 

Continued on next page 
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Recording Required Training, Continued 

 
  

Recording Required Training (continued) 
 

Step Action 
5 

(cont) 

The following lists the data fields and their descriptions.  Use the 
Tab Key to move between fields. 
Course Title (60 characters) - Type in the course title. The system 
will convert it to ALL CAPS.  This is a required field. 
Required Start Date - Type in the date.  This is a required field. 
Required End Date - Type in the date.  This is a required field. 
Projected Indirect Cost - Type in dollar amount.  Optional field. 
Projected Direct Cost - Type in dollar amount.  Optional field. 
Type - Click the LOV.  Optional field.  The % may be used as a 
wild card.   
Source - Click the LOV.  Optional field. 
Activity Type - Click the LOV to make a selection. The LOV lists 
the nine OPM training types. 
Course Name: Type in course name (option field) 

6 Click the <OK> button.  The Detail data field populates with a 
string of data. 

7 Save your action. 
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Retrieving Training for a List of Employees 

  
Retrieving 
Training for a 
List of Employees 

 

 
Step Action 

1 Navigation Path: Special Information > View Employees by SIT 
2 The Training Folder window opens: 

 
3 With your cursor in Special Information Type data field, click the 

LOV icon 
 

Continued on next page 
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Retrieving Training for a List of Employees, Continued 

  
Retrieving Training for a List of Employees (continued) 
 

Step Action 
4 Select desired Type from the LOV and click <OK>.  

 
5 The Special Information Type field populates with your selection, 

and the blank DDF opens.   
6 Fill in any desired search criteria and click <OK>.  This returns 

you to the Training Folder Window and creates the flexfield 
string for the Details data field.  This string is used as part of your 
query criteria.   

7 Click the <Find> button located next to the Special Information 
Type data field. 

 
 
 

Continued on next page 
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Retrieving Training for a List of Employees, Continued 

  
Retrieving Training for a List of Employees (continued) 
 

Step Action 
8 The data fields populate with the Full Name, Type, Employee 

Number, Start and End Date, and Details of employees who have 
completed the identified course. 

9 If you want to print a copy, you may want to export the names into 
an Excel spreadsheet following the procedure found below. 
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Exporting Retrieved Data  

  
Exporting 
Retrieved Data 

 

 
Step Action 

1 With the Training Folder window or other folder information 
displaying the information you want to export, click File on the 
Main Menu Bar then click Export.   

 
 

2 The File Download window opens.  Select Open (then File > Save 
As from the menu) or Save; select the location where you want the 
file stored.  Type in your file name under File name data field. 
Select Save. 

3 Change the Save as type to All Files, and the file extension to 
“.xls” and click Save; on the Download complete window, select 
Close 

4 Open an Excel spreadsheet, click File and Open.  Locate the file 
you saved.  

5 The information populates in the spreadsheet.  You may now 
format the data as needed, export to managers, etc. 
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Module 7 

Chapter 3 

Mass Update of Completed Training 

 
Purpose This process will guide you through the steps to mass update completed 

training courses.  Data can be collected and held on an Excel spreadsheet 
for later input.  This is also a tool for schools to update training for a 
group of students at one time.  The spreadsheet can be stored on a 
personal computer (PC) for mass processing. 
      

Who Does It This responsibility is limited to the CIVDOD HR-Training Personnelist and 
the CIVDOD HR-Training Adm.       
      

Before You 
Begin 

• First you must complete an Excel spreadsheet of the data completions to 
upload. Save the spreadsheet as a comma delimited file.  The file is 
“delimited” by a comma to mark its beginning and end.  The file extension 
name is .csv.  The CSV represents comma separated values and is the file 
format particular to saving training files for uploading into DCPDS.  A 
copy of the format is attached to the end of this Chapter.   

• The mass update process is available on the CIVDOD HR-Training 
Navigation Menu.  You must know the location of the spreadsheet you will 
access and the name you will use for the file.  Now you are ready to begin.   

Mass Update of Completed Training Courses 

Step Action 
1 Select a CIVDOD HR-Training Personnelist or CIVDOD HR-

Training Administrator Responsibility.  
2  On the Navigation List select Mass Completed Training (located 

under Mass Process).  Double click to Open the form. 
3 The Mass Completed Training window will appear.  Complete the 

following fields: 
    Mass Process Name – Unique name applied for locating the process. 
    Input File Name – Put the cursor in this line, click the Browse button   
    to select the file that has been stored on your PC.   

4 
 

Click Load ASCII File –to transfer the file from the PC into DCPDS. 
     Printer – Select the printer where you want the report to print out. 

 
Continued on next page 
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Mass Update of Completed Training, Continued 

 
Mass Update of Completed Training (continued) 

Step Action 
5 
 
 
 
 
 
 
 
 

Status will reflect Unprocessed because the file has not been processed.  
Status Details will reflect File Uploaded SUCCESSFULLY or Error in 
Upload File.   

• If you receive an Error, click Process Log to view the error 
details.   

• Close the Process Log to return to the Mass Completed Training 
window.   

• If the file is Uploaded Successfully, click Preview to preview the 
records and verify the uploaded data.  Close the Preview to 
return to the Mass Completed Training window.   
    

Note: To change the file data, click Delete Preview to delete the records 
contained in the current preview, save the necessary changes on your 
spreadsheet, and reload the file OR if records are available in the 
Preview, you may make changes directly on the preview window for the 
updatable fields.       

6 After the file has been successfully loaded, click Execute to 
process.  A Note window will appear advising whether or not the file 
was submitted and will identify a Request ID number.  Click OK to close 
the window.  Status will reflect Submitted.   

7 Refresh the page to determine if the status reflects Processed or Error.   
 
Tip: To Refresh the page, copy the Mass Process Name, select F11, 
paste the Mass Process Name, and select Ctrl F11.   

8 The Status Details Window is self explanatory.   
      If you receive an error, review the process log.  Refer to the step 5  
      Tip for information on how to change file data, then repeat steps 6-7. 

9 Click the Processed Records button.  The detail screen will offer 
complete information on the status of the records processed. 

10 Click the “X” in the upper right corner of the screen to close the 
window.  Or click File on the toolbar and select Close Form. 

11 Check the employee records to ensure the data processed correctly.  
From the Navigation menu, select Completed Training, enter the 
employee’s last name and click Find.  When the Completed Training 
form opens, locate the course data that was processed through Mass 
Completed Training.  
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Module 7 
 

Chapter 3 
 

Subchapter 1 
 

Mass Update of Completed Training Spreadsheet 

 
Terms ASCII File (American National Standard Code for Information Interchange) - 

A format in which to input and save data.  
 
Comma delimited file – Also referred to as a comma separated values (CSV) 
file.   An efficient format to store documents for transferring to DCPDS; each 
data field is “delimited” by a comma to mark its beginning and end.  The file 
extension name is csv.   
  
File name extensions - A system to name and identify files, e.g., .doc, .txt, 
.csv.  
 

 
 

 
Instructions 
for Creating 
the ASCII File 
for upload 
 

The record layout for the upload file is provided below.  It is critical to the 
process that you strictly adhere to this format. An Excel spreadsheet template 
identifying each value as a separate column is recommended (i.e., use column 
A for employee name, column B for SSAN, column C for Training Start 
Date, etc. 
 

 Continued on next page 
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Mass Update of Completed Training Spreadsheet, continued 

 
Instructions for Creating the ASCII File for upload (continued) 
 
Mass Update of Completed Training Spreadsheet 
MAXIMUM  
Field 
Length 

 
Value  

 
Type 

 
Remarks 

 
Required 

30 Employee Name VARCHAR2 Free text field (do not use commas)  
9 SSAN VARCHAR2 Format:  999999999 X 
11 Training Start Date VARCHAR2 Format:  DD-MMM-YYYY X 
11 Training End Date VARCHAR2 Format:  DD-MMM-YYYY X 
120 Course Title VARCHAR2 Free text field (do not use commas) X 
4 Training Duty Hours Number  X 
4 Training Non-Duty Hours Number  X 
4 Total Course Hours Number  X 
1 Course Grade* VARCHAR2 CIVDOD_COURSE_GRADE  
11 Date Withdrawn VARCHAR2 Format:  DD-MMM-YYYY  
3 Reason for Withdrawal* VARCHAR2 DELEGATE_FAILURE_REASON  
2 Training Type*  VARCHAR2 CIVDOD_OPM_TRAINING_TYPE X 
2 Training Sub Type* VARCHAR2 CIVDOD_ OPM_TNG_TYPE_SUB X 
1 Training Source* VARCHAR2 CIVDOD_TRAINING_SOURCE X 
5 Agency Type Code* VARCHAR2 CIVDOD_TRAINING_TYPE X 
2 Acquisition School Source* VARCHAR2 CIVDOD_ACQ_TRAINING_SOURCE  
1 Training Delivery Type* VARCHAR2 CIVDOD_TRAINING_METHOD X 
1 Priority Indicator* VARCHAR2 PRIORITY_LEVEL X 
1 Decision Source* VARCHAR2 CIVDOD_TNG_DECISION_SOURCE X 
1 Training Purpose Type* VARCHAR2 CIVDOD_TRAINING_PURPOSE X 
1 PCS Cost Indicator** VARCHAR2 CIVDOD_PCS_COST_INDICATOR  
1 Local Code VARCHAR2 Free text field (do not use commas)  
60 Course Number Code VARCHAR2 Free text field (do not use commas)  
3 Activity Type** VARCHAR2 CIVDOD_TRAINING_ACTIVITY_TYPE  
9 Tuition and Fees Number  X 
9 Books & Materials Costs Number  X 
10 Direct Costs Total Number Sum of Tuition &  Fees and Books &  

Materials Costs 
X 

1 Funded by Direct* VARCHAR2 CIVDOD_FUNDED_BY  
1 Direct PEC ID* VARCHAR2 CIVDOD_APPROP_PEC_ID  
9 Travel Number  X 
9 Per Diem Number  X 
10                                                                                                                                                                         Indirect Costs Total Number Sum of Travel and Per Diem X 
1 Funded by Indirect* VARCHAR2 CIVDOD_FUNDED_BY  
1 Funding Source* VARCHAR2 CIVDOD_TNG_FUNDING_SOURCE  
     
     

 
 Continued on next page 
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Mass Update of Completed Training Spreadsheet, continued 

 
Instructions for Creating the ASCII File for upload (continued) 
 
Mass Update of Completed Training Spreadsheet 
MAXIMUM  
Field 
Length 

 
Value  

 
Type 

 
Remarks 

 
Required 

1 Indirect PEC ID* VARCHAR2 CIVDOD_APPROP_PEC_ID  
10 Training Costs Total Number Sum of Direct and Indirect Costs X 
9 Non-Government  

Contribution 
Number  X 

2 Continued Service  
Agreement Indicator* 

VARCHAR2 CIVDOD_YES_NO_NA X 

11 Continued Service Agreement  
Expiration Date 

VARCHAR2   

2 Training Accreditation  
Indicator* 

VARCHAR2 CIVDOD_YES_NO_NA X 

4 Training Credit Number   
2 Training Credit Type* VARCHAR2 TRAINING_TYPE_HOURS  
2 Training Designation Type* VARCHAR2 TRAINING_DESIGNATOR_TYPE_CODE  
2 Training Travel Indicator* VARCHAR2 CIVDOD_YES_NO_NA X 
 Input Source VARCHAR2 Free text field (do not use commas)  
 
Notes: * Indicates a list of values table is available. 
          ** Indicates data for this field will not be viewable on the completed training form in DCPDS. 
 
Note:  For LN employees the name field (rather than the SSAN field) is used to identify the 
employee record.  In the name field, input the LN employee’s name exactly as it appears in 
DCPDS (list the last name first and do not use commas).  Leave the SSAN field blank.  

 
Instructions 
for Saving the  
File 

Delete the header names from the Excel spreadsheet then save the file as .csv 
(Comma delimited).      
 

Sample format for input file: 
 
Last First,000000000,28-Mar-11,28-Mar-11,BASIC TRAINING COURSE,4,0,4,,,,3,34,1, 
B34,,8,3,2,Z,,,,,150,50,200,,,0,0,0,,,,200,0,NA,,NA,0,4,,NA 
 

 
Edits and 
Business 
Rules 
 

• Ensure the data in fields supported by a list of values (LOV) have 
either null data or data that matches the LOV. 

• Ensure all required fields contain data. 
• Ensure date fields are configured properly DD-MMM-YYYY. 
• Check the process log for errors.   
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Module 7  

Chapter 4 

Tracking Degree Program Training Courses 

 
Purpose This process will guide you through the steps to track degree program training 

courses in an employee’s record that resides in Oracle HR –Extra 
Information.  The Training Programs DDF displays Special Program 
Identifier, Degree Program Level, and Instructional Program information, etc.   

      
Who Does It This responsibility is limited to the CIVDOD HR-Training Personnelist and 

the CIVDOD HR-Training Administrator.       

      
Before You 
Begin 

DCPDS will show Training Programs in the Extra Information DDF of the 
People record.  There is a shortcut to the SIT available on the HR-Training 
Navigation Menu.  Tracking Degree Program Training Courses are updated 
using a CIVDOD HR-Training responsibility. 

  

Tracking 
Degree 
Program 
Training 
Courses 
 

The steps below will assist you in updating DCPDS. 

 
Step Action 

1 Select a CIVDOD HR-Training Responsibility.  
2  From the Navigation List select Special Information then select 

People/SITs for Training. 
3 The Find Person window appears for you to query a record.  Enter 

info into the Full Name flex field and click Find  
4  When located, the person data appears.  Select the Extra 

Information button. 
 
 

Continued on next page 
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Tracking Degree Program Training Courses, Continued 

 
 

Step Action 
5 The Training Program Requirements DDF displays.  Click in the 

Details section. 
6 The Extra Person Information Window displays.  Complete the 

following data fields as appropriate using the Tab Key to navigate: 
Supervisory Course Completed – use the LOV to select the 
correct value 
Special Program Identifier - use the LOV to select the correct 
value 
Degree Program Level – Click the LOV to select A1-Associate, 
etc.  
Instructional Program – Click the LOV to select the Academic 
Discipline. 
Target Occ Series – type in the occupation series 
Date Journeyman Elig(NV) – Navy only 
Entry Step Apprentice(AF) – Air Force only 
Lifeboat Certification(NV) – Navy only 
Dt Nucl/Biomed/Chem Completed – enter date training 
completed 
Coop Funding Source - use the LOV to select the correct value 

7 Click OK and save your action. 
8 Close the form to exit. 
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Module 7 

Chapter 5 

Updating Education 

 
Purpose This process will guide you through the steps to update an employee’s 

education information which resides in the person record.  A shortcut is 
available on the Navigation Menu if you have a CIVDOD HR-Training 
Responsibility.       

      
Who Does It 

 

This responsibility is limited to the CIVDOD HR-Training Personnelist and 
the CIVDOD HR-Trng Adm.       

 
Before you 
Begin 

The system will show education in the highest order.  For reporting purposes, 
the CPDF Edit is set to select the highest degree.   
   

 
Updating Education  
 

Step Action 
1 Select the responsibility of CIVDOD HR-Training, CIVDOD HR-

Trng Adm, or CIVDOD Training Personnelist. 
2 From the Navigation Menu select Special Information > 

People/SITs for Training.  
3 When the Find Person window displays, click the LOV or query 

for the employee’s name. 
4 The People window will display the employee data.  Click Special 

Info. 
5 When the Special Information DDF displays, select Education 

from the list. 
6 Click in a Detail data field to view current Education data.  To 

add new education, scroll down to the bottom to get a new line, or 
with the cursor in the Details area, click the New Record button 

(  icon) on the Toolbar.  
  

Continued on next page 
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Updating Education, continued 

 
Updating Education (continued) 
 
 

 
 
 
 

Step Action 
7 Change the Start Date as needed, and click in the Detail data field. 

To avoid potential problems, do NOT use the same Start Date for 
identical levels of education.  
Use the LOV or type in the following data fields using the Tab key 
to navigate between fields:  
Education Level – Select from the LOV  

Instructional Program – Select from the LOV 

Year Degree/Cert Attained – YYYY 

Credit Hours – Type in number of hours 

Credit Type – Select from the LOV 

Type of School – Select from the LOV 

College-Major-Minor – Select from the LOV 

Academic Institution Name – Select from the LOV 
Coop Graduation Date – Type in DD-MMM-YYYY  
Education Update Source – Select ‘V’ for ‘Verified’ from the  
                                                LOV           

8 Click OK.  The Education course data string displays in the 
Details region of the Flexfield. 

9 Click Save on the Toolbar. 
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Module 7 

Chapter 6 

Recording Certifications and/or Licenses 

 
Purpose This process will guide you through the steps to track training courses 

toward receiving a certification or license.  Information is stored in an 
employee’s record that resides in Oracle HR –Extra Information.  The 
Certifications/Licenses DDF displays occupational certification code, date 
certification issued, whether or not training was taken to obtain a 
certification or license, and costs that were incurred.   

      
Who Does It 

 

This responsibility is limited to the CIVDOD HR-Training Personnelist and 
the CIVDOD HR-Training Adm.       

      
Before You 
Begin 

DCPDS will record Certifications/Licenses in the Special Information DDF 
of the People record.  There is a shortcut to the SIT available on the HR-
Training Navigation Menu.  Tracking Certifications/Licenses Training 
Courses is updated using an HR-Training responsibility.   
 

 
Steps for  
Recording  
Certifications/ 
Licenses 

Step Action 
1 Select an HR-Training Personnelist or HR-Training Administrator 

Responsibility.  
2  On the Navigation List: Special Information > People/SITs for 

Training. 
3 Query for the employee.  When the employee window appears, 

click Special Information. 
  

Continued on next page 
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 Recording Certifications and/or Licenses, continued 
 

Steps for Recording Certifications/Licenses, continued 
 

Step Action 
4 When the Certifications-Licenses DDF displays, click in the 

Detail section. 

 
5 When the Extra Information Window displays, complete the 

following data fields only one time for the life of the 
certification/license: 
Type of Occupational Cert - select the code from the LOV 
Date Certificate/License Issued – enter the date when issued or 
leave it blank until the certification or license is issued 
Certification/Lic Expiration Date - enter the expiration date or 
leave it blank as appropriate 
Initial Annual/Renewal - select the applicable response from the 
LOV  
Training to Obtain a License? – enter ‘Y’ for Yes and ‘N’ for 
No 
Training to Obtain a Cert? – enter ‘Y’ for Yes and ‘N’ for No 
Met Condition for Employment? – enter ‘Y’ for Yes and ‘N’ for 
No  
Cumulative Gov Cost – Do not enter data here.  This amount will 
flow from Certifications-Licenses Cost DDF 
Cumulative Actual Cost - Do not enter data here.  This amount 
will also flow from Certifications-Licenses Cost DDF 
Click OK. 
Cert/Lic Other Updates Source – enter “S” for self-certified, or 
“V” for verified 
 
Close this window and return to the Special Info DDFs. 

 
Continued on next page 
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Recording Certifications and/or Licenses, continued 
 

Steps for Recording Certifications/Licenses, continued 
 

Step Action 
6 Select the Certification-Licenses Cost DDF.  Click in the Detail 

section for the Extra Information window to display.   

 
7 Complete the following data fields for every training course taken.  

 Type of Occupational Cert – place your cursor in this field and 
the data will auto populate from the previous screen 
Date Occ Cert/License Issued – the date will also auto populate 
with the latest date stored in Certifications - Licenses DDF 
Course Title – enter course title if training is associated with this 
certification or license or leave blank if you are recording the cost 
of a license 
Class Graduation Date – enter date as appropriate or leave blank 
if you are recording cost of a license 
Date Paid – enter the date when paid or date when license was 
received 
Gov Amount Paid – enter the amount paid by the government 
Actual Amount Paid – enter the total amount paid (data flows 
from Actual Total Cost in Completed Training) 
Funding Source – select appropriate source from the LOV 
Agency Group – select appropriate agency group from the LOV 
Position Region – select appropriate region where position is 
located from the LOV 
Click OK. 
NOTE: If the training is associated with this entry, the data fields 
will auto populate when you type the Course Title as it is entered 
in Completed Training.   

 
Continued on next page 
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Recording Certification and/or Licenses, continued 
 

Steps for Recording Certifications/Licenses, continued 

Step Action 
8 
 

The Certifications –Licenses FY DDF is view only and for 
reporting purposes.  Data from the two previous DDFs will auto 
populate in this area. 

 
9 When the Conditions of Employment have been met, the 

Certifications –Licenses DDF can be changed to reflect this 
change.  Change the ‘No’ to ‘Yes’.   

 
10 When this change occurs and Conditions of Employment are Met, 

data will flow to the record and can be viewed in the person’s 
Special Information > US Fed Cndtn of Emplmt.  This area will 
not be updatable by other than an HR-Training responsibility.   

 
 
 

 Continued on next page 
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Recording Certification and/or Licenses, continued 
 

Steps for Recording Certifications/Licenses, continued 
 

Step Action 
11 
 

To view the HR record, close all windows in the person record, 
and return to the Navigation List.  Change your responsibility to 
CIVDOD Personnelist, then navigate to:  People > Enter/Maintain 
> query for person > Special Info > US Fed Cndtn of Emplmt.  
The occupational certification or license received will now appear 
to include the date the certification or license was received.  
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                                     Module 7 

Employee Training and Development Using  
DCPDS 

Module Overview 

   
Purpose This Module Overview introduces you to CIVDOD HR-Training 

Administration.  You will access only one application to administer 
Employee Training and Development:  Oracle Human Resources (HR) for 
employee information.   

 
Note:  This module is also available for Nonappropriated Fund (NAF), 
National Guard Bureau (NGB), and Local National (LN) personnel. 

   
Module Contents  

Topic Page 
Assumptions 3 
Audience 3 
CIVDOD HR-Training   3 
Roles and Responsibilities 3 
Definitions 3 
Responsibility Window 5 
External User  6 
CIVDOD HR-Training Secure User View 6 
Owned vs. Serviced Rule 6 
Education Information 7 
Training Program Requirements 8 
Continued Service Agreement 9 
Tracking Degree Training  9 
CIVDOD HR-Training Workflow 9 
CIVDOD HR-Training Definitions 10 
Stages of Training Cycle 12 
OPM Training Type Codes and Sub-Type Codes 13 
Navigation List 14 
Training Request Form (TRF) 15 
SF Form 182 15 
Individual Development Plan (IDP) 18 
Workflow Inbox 18 
Reports and Career Briefs 18 
Navigation List with Associated Windows and Topics 19 
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Module Overview, Continued 

 
Module Contents (continued) 
 

Chapter 1:  Requesting Training  1-1 
Completing the Training Request Form  2 
            Printing the Training Request Form  8 
            Completing Additional Training Request Forms 9 
            Viewing the Training Request Routing History 10 
Processing HR-Training Actions in the Workflow Inbox 11 

Training Request Form Routing History 14 
Approving or Disapproving the Training Request Form 16 
Customizing Your WorkFlow Inbox 17 

Chapter 2: Recording Completed and Required Training 2-1 
Recording Completed Training 2 
Recording Required Training 7 
Retrieving Completed/Required Training 9 
Exporting Retrieved Data 12 
Chapter 3:  Mass Update to Completed Training 3-1 
Chapter 3, Subchapter 1:  Mass Update to Completed Training 
Spreadsheet 

3-S1 

Chapter 4:  Tracking Degree Program Training Courses 4-1 
Chapter 5:  Updating Education                      5-1 
Chapter 6:  Recording Certificates and Licenses  6-1 
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Module Overview, Continued 

 
Assumptions In order to use CIVDOD HR-Training, you should have a basic understanding 

of: 
• Oracle HR (People) Application  
• Federal Laws and regulations relating to training 
• DoD training policy, regulations, and processes 
• The OPM Training Policy Handbook 
• Requirements of your Component’s training policy 

  
Audience  

This module is written for And contains information for 
CIVDOD HR-Training users • Employees 

• Training Administrators and Personnelists 
• Training Resource Managers 
• Managers/Supervisors 
• Training Monitors/Coordinators 
• Personnel Generalists 
• System Administrators 

  
CIVDOD  
HR -Training 

You will be using Oracle HR to access the Special Information Type (SIT) 
such as Completed and Required Training, and Education on the Navigation 
List. 

  
Roles and 
Responsibilities 
       

Defined roles and responsibilities are determined by each Component.  
CIVDOD HR-Training allows managers/supervisors, training monitors and 
coordinators, and personnelists/administrators to request and process training.  
The roles and responsibilities within the training cycle may be performed by a 
number of people as determined by each Component, such as the Training 
Administrator within the HR office, or the organizational Training 
Monitor/Coordinator. 

  
Definitions The following definitions show the standard roles for each responsibility.  

Components can customize these roles as necessary. 
 

 Role Responsibility 
CIVDOD        
HR-TRNG 
PERSONNELIST 

Complete access to all training processes and reports.  
Can be limited to specific functions or organizations 
depending on Component/local decision.  (This is 
typically the personnelist/trainer in the CIVDOD HR 
training office.) 

 
Continued on next page 
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Module Overview, Continued 

  
Definitions (continued) 
 

Role Responsibility 
CIVDOD        
HR-TRNG 
ADMINISTRA-
TOR 

Complete access to all training processes and reports.  
Change the roles and responsibilities of users for 
CIVDOD HR-Training functions.  (In addition to all 
CIVDOD HR-Training Personnelist responsibilities, this 
person will also have the ability to handle some systems 
administration work associated with CIVDOD HR-
Training.) 

CIVDOD        
HR-TRNG 
MGR/SUPV 

Complete access to all records and reports for their 
assigned employees.  Capability of completing the 
Training Request Forms, and printing DD Form 1556.  
Also, allows access to Completed Training and Required 
Training areas in HR for assigned organization.  
Components may determine further restrictions as 
necessary.  This role should also include military 
supervisors of civilian employees. 

CIVDOD        
HR-TRNG ORG 
TNG MONITOR 

Access to training records and reports for their assigned 
organization.  Capability of completing the Training 
Request Forms, and Printing DD Form 1556.  Also, 
allows access to Completed Training and Required 
Training areas in HR for assigned organization.  
Components may determine further restrictions as 
necessary.  This is the person in each organization who is 
responsible for handling and monitoring training. 

CIVDOD        
HR-TRNG 
COORDINATOR 

Access to training records and reports for their assigned 
unit within the organization.  Capability of completing the 
Training Request Forms, and Printing DD Forms 1556. 
Also, allows access to Completed Training and Required 
Training areas in HR for assigned organization.  
Components may determine further restrictions as 
necessary.   

CIVDOD        
HR-TRNG       
FISC OFF 

Access to all cost information on individual, group, and 
total training costs.  (This could be a resource manager in 
the organization or an individual in the accounting and 
finance office.  More than one person could have this 
role).  Does not have access to employee records. 
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Module Overview, Continued 

 
Roles and Responsibilities Screen Access   
 
CIVDOD HR-Training 
Responsibility/Role 

CIVDOD HR 
TRNG 

COORDINA-
TOR 

CIVDOD HR 
TRNG 

MGR/SUPV 

CIVDOD HR 
ORG TRNG 
MONITOR  

CIVDOD HR 
TRNG FISC 

OFF 

CIVDOD HR 
TRNG 

PERSONNEL-
IST 

CIVDOD HR 
TRNG 

ADMINISTRA-
TOR 

CIVDOD HR-Training  
        Menu Option 

      

Training Requests X X X X X X 
Training Request History Details X X X X X X 
Civilian Inbox X X X X X X 
Workflow Inbox X X X X X X 
Completed Training X X X X X X 
Mass Process       
Mass Completed Training     X X 
Reports        
     Submit Report X X X X X  X 
     View Report     X X X X X X 
Special Information       
     People/SITs for Training X X X  X X 
     View Employees by SIT X X X  X X  
Federal Maintenance Forms       
     Routing Groups        X 
     Routing Lists      X 
       

Continued on next page 
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Module Overview, Continued 

 
Illustration The Responsibilities Window: 

 

 
 

 
 

External User Users who are not currently part of the Oracle database (e.g., military, 
contractors) can be given access to Oracle HR to primarily perform 
supervisory duties.  They can initiate a Training Request Form (TFR); and 
other tasks.  These users are defined as “External Users.”  Contact your 
Training Administrator or System Administrator to set up External Users or 
see Module 4, Chapter 2, Building External Users. 

    
CIVDOD  
HR-Training 
Secure User 
Views 

You must be assigned an CIVDOD HR-Training Secure User View by your 
System Administrator before you can see employee records based on the 
organization(s) you service or the position hierarchy.  Additionally, you must 
have an CIVDOD HR-Training Secure User View to process CIVDOD HR-
Training actions in your Civilian Inbox, initiate a Training Request Form, or 
request Training Reports. 

 
Owned vs. 
Serviced Rule 

If you service personnel belonging to another agency, the rules of the owning 
agency will apply to recording Completed Training.  
 
Example:  If Navy services an Air Force employee, Air Force rules will 
apply. 
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Module Overview, Continued 

 
Education 
Information 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                  

Employee education data may be accessed to check for course prerequisites, 
tuition assistance, and for other reasons.  To access Education data for an 
employee: 

Navigation Path > SIT > Open.  The Find Person window opens.  
Query for the employee and the People window opens.  Click Special 
Information.  The Special Information window opens.  Scroll to 
Education and click the Details data field for specific information (or 
click [F11], type Education, and click [CTRL +F11]).   
 
Note:  If the Information Exists Checkbox is not checked, then no 
data is stored in the Descriptive Flexfield.  

 

 
 

Completed Training and Required Training are also found under Special 
Information.  
 
Note:  Managers/Supervisors, Training Coordinators, and Training Monitors 
have “read only” access to employee education. 
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Module Overview, Continued 

 
Training 
Program 
Requirements 

Training Program Requirements (e.g., Supervisory Course Completed, 
Special Program Identifier, Date Training Obligation Expires, and other 
programs) are found under Extra Information.  To access this data for an 
employee: 

Navigation List > People > Enter and Maintain > Open.  The Find 
Person window opens where you can query for the employee.  When 
selected record appears, click Extra Information.  Scroll to Training 
Program Requirements or query for it and click the Details data field 
for specific information.    If you are logged in under a CIVDOD HR-
Training responsibility, Training Program Requirements will be the 
only DDF to appear.    
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Module Overview, Continued 

 
 
Continued 
Service 
Agreement 

The Continued Service Agreement (CSA) is generated along with the 
DD Form 1556 when printed.  Follow your Component’s policy for 
completion.  The date the CSA expires is entered in the People Record 
> Extra Information > US Federal Person Service Obligation.  
Scroll to Training Program Requirements or query for it and click 
the Details data field for specific information.    If you are logged in 
under a CIVDOD HR-Training responsibility the US Federal Person 
Service Obligation will appear.   Select the Training Received (01) 
code from the LOV then enter the Service Obligation Start and End 
dates.   

 

 
 

 
 
Tracking 
Degree 
Training 
Courses 
 

 
 
See Chapter 4, Tracking Degree Program Training Courses, in this module 
for details. 
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Module Overview, Continued 

 
 
CIVDOD  
HR-Training 
Workflow 

The sequence from the initial request to the HR-Training Administrator: 
     Completion of the Training Request Form 

⇒ Routed for approvals 
⇒ TRF used as a contract with vendor (i.e., to document costs, 

training location information and as a ‘ticket’ to attend a class.) 
⇒ Only completed data is recorded in the employee record 
⇒ Printed copy can be offered for the employee 

  You will access one application to administer Employee Training and 
Development which is Oracle Human Resources (HR) for employee 
information.   

 
 

CIVDOD   
Training  
Definitions 
 

Term Definition 
Completed Training Training completed either on or off-duty. 
Continued Service 
Agreement (CSA) 

An employee selected for training agrees in writing 
before assignment to training to continue in federal 
service based on OPM and component policy. 

Total Direct Cost Tuition, materials and fees directly supporting 
training. 

External Users Supervisory personnel outside the database that may 
need to access their employee’s records. 

Extra Information Categories of information that reside on the People 
record such as Special Training Requirements.  
Only one entry per category can be input, such as 
TSP vs. a SIT where multiples can be input. 

Total Indirect Cost Travel costs to include travel and per diem. 
Individual 
Development Plan 
(IDP) 

Completed Training information extracted from 
employee’s record. 

Method Training received through a Seminar, Classroom, 
Multi-media, or other means. 

 
 

Continued on next page 
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Module Overview, Continued 

 
CIVDOD  Training Definitions (continued) 
 

Term Definition 
Notifications Notices in the Civilian Inbox that describes the 

nature of the actions (e.g., training request awaiting 
approval).  

Reports Standard reports, extracting the SF 182, the Training 
Request Form, and Ad Hoc Reports. 

Required Training Mandated by law, Executive Order, DoD, 
Component, installation, etc., stores this data in a 
separate area for reference.   

Responsibility Each responsibility lets you access a specific set of 
forms, menus, reports, and data to fulfill your 
business role.  Several users can share a 
responsibility, and a single user can have multiple 
responsibilities. 

Special Information 
Types (SIT) 

Categories of personal information that reside on the 
People record of Oracle HR such as Completed or 
Required Training, and Education where multiple 
occurrences can be stored. 

Training Request 
Form (TRF)  

Used to request training and forward through 
Civilian Inbox to approving offices.  It contains part 
of the information that system-generates a SF 182, 
from the employee’s record.  

Training Source Government, College/University, Other DoD, etc. 
Type A five-digit code used by Army, Navy, Air Force 

and NSPS for delineating their training types.   
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Module Overview, Continued 

  
Stages of the 
Training Cycle 

Using CIVDOD HR-Training, the main stages in the training cycle are as 
follows: 
 

Stage Description Application 
1 Identify Training Needs – Nominate students and 

request training.  
Completed 
Training and 
Required 
Training  

2 Approve Training – To be conducted by approving 
Training Request Forms (TRF). 
• Send TRFs through appropriate levels.  You 

must know who you are to send the request to as 
there is no specific routing list. 

CIVDOD 
HR-Training 

3 Manage Training  - Manage enrollments, 
cancellations, attendance and completions: 
• Handle enrollments through stages: 

• Nominations 
• Waiting Lists 
• Confirmations 
• Cancellations 
• Standard letters as required 
• Actual expenses tracked 

• Completed training recorded in the employee 
record. 

Components 
Choice of 
Software 
 
 
 
 
 
 
People 
(Special 
Information 
Type) 
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Module Overview, Continued 

  
OPM Training 
Type Codes 
and Sub-Type 
Codes 

OPM Training Type Codes and Sub-Type Codes will be used in the 
Completed Training.  Type Code must use only the associated Sub-Type 
Codes. 
 

Type Definition 
01 Training Program Area 
02 Developmental Training Area 
03 Basic Training Area 

Sub-
Type 

Definition 

NOTE: Only to be used with Type Code 01 
01 Legal 
02 Medical and Health 
03 Scientific 
04 Engineering and Architecture 
05 Human Resources 
06 Budget/Finance Business/Admin 
07 Planning and Analysis 

08 Information Technology 
09 Project Management 
10 Acquisition 
11 Logistic Specialty  
12 Security 
13 Clerical (Non-Supv clerical/administrative) 
14 Trade and Craft 
15 Foreign Affairs 
16 Leadership/Mgr/Communication Courses 

Sub-
Type 

Definition 

NOTE: Only to be used with Type Code 02 
20 Presupervisory Program 
21 Supervisory Program 
22 Management Program 
23 Leadership Development Program 
24 SES Candidate Development 
25 Executive Development 
26 Mentoring Program 
27 Coaching Program 

 
Continued on next page 
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Module Overview, Continued 

  
    

Sub-
Type 

Definition 

NOTE: Only to be used with Type Code 03 
30 Employee Orientation 
31 Adult Basic Education 
32 Mandated Training 
33 Work-Life 
34 Soft Skills 
35 Agency Specific 

 
  

 
Navigation List The following CIVDOD HR-Training functions will not be available to all 

users.  Functions are available based on assigned responsibilities as assigned 
by each component. 
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Module Overview, Continued 

 
Training 
Request Form 
(TRF)  
 
 
 
 
 
 
 
 
 

 
 

The Training Request Form (TRF) is a simplified method used to request 
training through CIVDOD HR-Training.  Employees, supervisors, training 
monitors, or training managers can complete the one-page window.  By 
clicking the List Of Values (LOV) (the ‘…’ellipsis at the end of the field) you 
can select basic employee data by choosing a name from the list.  Select the 
employee and the Organization, Title, Plan/Series/Step/Grade, SSAN, Office 
Phone, Handicapped, and Type of Appt fields will auto-populate.  The Course 
Code, Title, Source, Location, and Priority are free text form.  When the form 
is completed, it can be forwarded electronically to the next approving level.  
For more information, see Chapter 1, Requesting Training, in this module. 
 
Note:  A completed SF 182 can be printed after each stage of the TRF is 
completed.   
 

Illustration  The Training Request Form: 

 
 
 

  
 

SF 182 The SF182 is a method for requesting training. 
• It is an output form that can be printed when needed for written or 

official documentation.   

• The SF182 may be viewed and printed at each level in the approval 
process but will print only those portions that have been completed up to 
that point. 

 
Continued on next page 
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Module Overview, Continued 

  
SF 182 (continued)

 
Continued on next page 
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Module Overview, Continued 

  
SF 182 (continued) 
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Module Overview, Continued 

  
Individual 
Development 
Plan (IDP) 

The IDP information can be extracted from the Completed Training data 
fields in Oracle HR (People>Special Information) using your Component’s 
query tools.   

  
Workflow 
Inbox  
 
 
 
 
 
 
 

 

CIVDOD HR-Training uses the Workflow Inbox to display notifications 
initiated by you or routed to you.   
• Training Request Forms and other actions are stored and routed through 

the Workflow Inbox for approval or required follow-on action.   
• See Chapter 1, Requesting Training, Accessing the Workflow Inbox, in 

this module and Module 1, Fundamentals of the DCPDS, Chapter 7, 
Folders. 

 
Note:  Separate folders can be established for CIVDOD HR-Training actions 
versus Request for Personnel Actions (RPAs).  However, to process a 
Training Request, you must be in a role with CIVDOD HR-Training 
responsibility. 

 
Illustration A Work Flow Inbox window: 

 

 

 
 

Reports and 
Career Briefs 

All training-related career briefs and reports are available through Processes 
and Reports.  Additionally, managers and training coordinators may access 
specific budget reports on their employees. The Civilian Servicing Unit 
(CSU) can also be accessed to retrieve Employee Training History and career 
briefs on Education, Acquisition, and others. 
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Module Overview, Continued 

  
Navigation List 
With 
Associated 
Windows and 
Topics  

The Navigation List of the CIVDOD HR-TRNG Administrator with 
Associated Windows and Topics: 

 
Navigation List   Associated Window(s) Procedure Steps by Topic 

Training Requests Training Requests Completing the Training Request 
Form 

Training Req:  History  
   Details 

Training Request - 
Routing History 

Training Request Form Routing 
History 

Civilian Inbox   
Workflow Inbox Notifications Summary Processing training actions in the 

Civilian Inbox 
Completed Training Completed Training Completed training data stored by 

employee record 
Mass Process   
    Mass Completed    
Training 

Mass Completed Training Uploading training completions in 
a mass process from a spreadsheet 

Reports   
   Submit Report Submit Requests Printing a SF182 

Printing a Student Course Eval 
   View Report Completed Requests Viewing Reports and Forms 
Special Information    
   People/SITS for 
Training 

Find Person 
People 

Updating Required Training in HR 
Retrieving and Updating 
Completed Training 

  View Employees by 
SIT 

Select criteria from SIT View list of employees  

Federal Maintenance 
Forms 

  

   Routing Groups  Special Training Programs 
   Routing Lists  List of associated routing personnel 
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Module 8 
 

Chapter 1 
 

Maintaining the Payroll System Code and Payroll 
Office Identification 

  
Purpose To provide the steps to access the Position window to verify or modify the 

payroll system code and/or Payroll Office Identification (POID). 

     
Before You 
Begin 

Insure appropriate servicing payroll system identification is resident in the 
position record before assigning the employee to the position.  
 

(1) Payroll System:  All Appropriated Fund positions are established 
with payroll system default value of “D” indicating DCPS payroll 
servicing.  Default value can be overwritten as needed in the 
Additional Position Details area of the Position Window.  Positions 
that are not paid by the DCPS should reflect a value of “0”.  

(2) Payroll Office ID (POID):  DCPS maintains all DoD Appropriated 
Fund employee pay accounts in one of nine separate payroll 
databases.  Each database is identified in the employee’s DCPDS 
record by a two-character code that identifies the servicing payroll 
database.   

 

POID 
DCPS 

Database ID 
Payroll Office 

Number 
 

Location / Database Type 
CH ZGT 97380600 Cleveland, OH (Navy) 
CY ZL0 97380700 Cleveland, OH (Shipyard)  
DE CP1 97380100 Indianapolis, IN (Air Force & 

NGB) 
EN ZPD 97381400 Cleveland, OH (Dept of Energy) 
EP ZPA 97381700 Indianapolis, IN (EPA) 
FA ZFA 97381100 Indianapolis, IN (Overseas Army, 

Alternate) 
FF ZFR 97381000 Indianapolis, IN (Overseas 

Regular) 
HE ZPH 97381500 Cleveland, OH (HHS) 
IB ZPB 97381800 Cleveland, OH (BBG) 
OA OMA 97380800 Indianapolis, IN (Army) 
PE ZKA 97380500 Indianapolis, IN (DD Agencies) 
RE ZKE 97381200 Indianapolis, IN (EOP)  
VA ZPV 97381600 Indianapolis, IN (VA) 
00 N/A N/A Other Agency/Payroll  
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Continued on next page 
 
Maintaining the Payroll System Code and Payroll Office 
Identification, Continued 
 

 
 
Before You Begin (continued) 

 
 (3) The combination of Servicing Office ID (SOID) and Payroll Office ID 

(POID) is maintained on table CIVDOD_CCPO_POID.  Insure 
SOID/POID combination exists on the table before updating POID in 
the position. 

 
 

Caution:  The process provided in this chapter is intended only for correction 
of erroneously assigned payroll office ID or payroll system or redesignation of 
payroll office ID PRIOR to assigning an employee to the position.  Gain and 
loss transactions will be written to the affected payroll database when 
encumbered positions are modified.  Realignment of servicing payroll office 
may only be accomplished following approval of Component designated office 
of primary responsibility (OPR) and DFAS authorities through DCPAS.   
 

If an individual is assigned to a position with the incorrect SOID, the user will 
need to cancel the action, correct the position, and reprocess the transaction. 

 
Step Action 

1 Navigation Path > Work Structures > Position > Description > 
<Open> 

2 The Position window opens. Query the Position and Date Track to 
the effective date of the POID change or the date the employee 
entered the position.  Click the DDF that contains the SOID 
(adjacent to the Further Info data field). 

 
 

Continued on next page 
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Maintaining the Payroll System Code and Payroll Office 
Identification, Continued 
 

 
 
Before You Begin (continued) 
 

 Step Action 
3 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

The Additional Position Details window opens.  Click in the Payroll 
System data field and either select the appropriate value from the 
LOV or type in the information to populate the data field.  Click 
<OK>.  
  

 
 
Note:  The Payroll System data field is a required data field.  All 
Appropriated Fund positions are established with payroll system 
default value of “D” indicating DCPS payroll servicing.  Default 
value can be overwritten as needed.  Positions that are not paid by 
the DCPS should reflect a value of “0”.   
 

 
 
 

Continued on next page 
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Maintaining the Payroll System Code and Payroll Office 
Identification, Continued 
 

 
 
Before You Begin (continued) 
 

Step Action 
4 
 
 
 
 
 
 
 
 
 
 
 
 
 

In the Position window, click <Extra Information>.   The Extra 
Position Information window opens.  Select US Federal Position 
Group 1 and click in the Details data field.  

 

5 The Extra Position Information window opens.  Scroll down and 
place cursor in the Payroll Office ID data field and click the LOV. 
 

 
 

Continued on next page 
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Maintaining the Payroll System Code and Payroll Office 
Identification, Continued 
 

 
 
Before You Begin (continued) 

  Step Action 
6 The Extra Position Information window opens.  Scroll down and 

place cursor in the Payroll Office ID data field and click the LOV. 
 

 
 

 
 

Continued on next page 
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Maintaining the Payroll System Code and Payroll Office 
Identification, Continued 
 

 
 
Before You Begin (continued) 

Step Action 
7 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

 

 
 

Select the appropriate POID value from the LOV and click <OK>.   
Only those entries identified as DOD Payroll Office are appropriate 
for DCPS. 

 
 
Note:   In most cases the Payroll Office ID is determined based on 
the owning Component of the position.  With the exception of 
overseas positions and Navy shipyard locations, most Component 
payroll is managed in a single database.  Some agencies have opted to 
include their overseas positions in the one rather than utilizing the 
overseas specific databases identified as “FF” and “FA.” 

8 Save action. 
9 

 
 
 

 

Change of Payroll System Code or POID will invalidate the position.  
Return to the Position window, Date Track to the correct effective 
date of the correction, and click <Validate> to complete the position 
change.   
Note:  Reset Date Track. 
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Module 8 
 

Chapter 2 
 

PAY500 Record View, Print, Regeneration, and Pay Status Report 
 

Chapter Overview 

 
Purpose This procedure will guide the user through the steps to locate, read, and print 

payroll interface transactions created by DCPDS.  It will also provide 
guidance for creating a repeat transaction or a corrected interface format as 
appropriate.   

   
Who Does It?  Most HR office users have access to view and print the PAY500 formats.  

Personnelist responsibility is required to produce the PAY500 Report.  A 
special responsibility is required for Regeneration processing and is limited to 
designated HR users.    

   
Chapter Contents 

Topic Page 
Chapter Overview 1 
Accessing and Printing the PAY500 Record 2 
Producing a DCPS Payroll Interface Report 6 
Sample DCPS Payroll Interface Report 10a 
Payroll Transaction Regeneration Process 11 
Producing a Payroll Regeneration Activity Report 16 
DFAS PAY500 Processing Status Reverse Interface 20 
Exporting of Pay Status File 23 
Producing a Personnel/Payroll Interface DCPDS 
Processing Status (PAYSTA) Report 

27 

DCPS 500 Character Interface Format 29 
DCPDS/DCPS Non-Numeric NOACs 37 
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Chapter Overview, Continued 
 

 
Before You 
Begin 
 
 
 
 
 
 
 
 

 

• DCPDS creates a PAY500 transaction automatically when a personnel 
action is consummated or a data field or element that is shared by DCPS 
is updated.  

• PAY500 transactions are maintained in DCPDS for 27 pay periods and 
may be viewed, printed, or resent to payroll.  

• Payroll interface transactions are created upon consummation of RPA 
processed actions on or after the effective date.  

• PAY500 formats are created immediately upon update of data element or 
position fields regardless of the effective date.   

• Transactions with projected effective dates do not “flow” to DCPS until 
the effective date is reached.   

• Projected PAY500 formats cannot be deleted from the system or removed 
from the interface flow. 

• Interface transaction packaging and transmission to DCPS is discussed in 
topic “Interface Package Tracking.”   

   
 
 

Accessing and  
Printing the  
PAY500 
Record 

 

An illustration of the DCPS 500 Character Interface Format can be found 
on page 26. 

Step Action 
1 Navigation Path > PAY500 > <Open> 
2 The PAY500 window opens with five taskflow buttons. 

Button Definition 
Clear Clears all information in the Search Criteria.  User 

can then type in the new Search Criteria.  
Count Provides a count of PAY500 records defined in the 

Search Criteria. 
Find Populates the view with all transactions defined in 

the search criteria. 
View Opens a clear text view of the Pay500 elements. 
Print Opens the selected PAY500 action in a print 

friendly format. 
Exit Returns user to the Navigation List 
  

 

 
  Continued on next page 
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Accessing and Printing the PAY500 Record, Continued 

 
 

 

Step Action 
3 The PAY500 window opens with no transactions reflected.  

Click <Find> to display all available PAY500 transactions. 
Records are sorted by Transaction Date with the most recent at 
the top. 

 
The following control information is displayed for the PAY500 
transactions listed in the scroll box on the screen. 

Data Field Description/Action 
SOID Servicing Office ID 
Transaction Date Date and time the transaction was created 
SSAN Self Explanatory 
NOA Nature of Action Code 
Eff Date Transaction Effective Date 
POI Payroll Office ID 
Agency Servicing Agency 
Regeneration Flag Regeneration Flag (Y or N) 

 

 

 
Continued on next page 



                      R12 March 2012 

PAY500 Record View, Print, Regeneration, and Pay Status Report                                                     Module 8, Chapter 2, Page 4    

Accessing and Printing the PAY500 Record, Continued 
 

 
Step Action 

4 To search for PAY500 transactions, users may enter any or all 
fields in the Search Criteria.  These fields include:  SOID, 
Transaction Date, SSAN, NOA, Effective Date, POI, Agency or 
Regeneration Flag.  Users should enter dates as DD-MMM-
YYYY, i.e., 24-Aug-2011, and SSAN can be with or without the 
hyphens.  For example, to search for transactions by SSAN, place 
cursor in the SSAN data field, type in a SSAN (with or without the 
hyphens) and click <Find>.  All of the PAY500 formats stored for 
the employee will appear. 

 
 

The complete PAY500 format opens for the selected transaction 
entry.  Use the up and down arrow or mouse click to navigate and 
see other transactions in the list.  

5 To print the record, click <Print>.    

 
 
 

Continued on next page 
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Accessing and Printing the PAY500 Record, Continued 
 

 
Step Action 

6 The Print window will open. If there are no changes to be made, 
click <PRINT>.  

 
 

7 For the best quality print, click <Page Setup>, then select 
Landscape from the Orientation list, and click <PRINT>. 

 
8 Clicking <OK> on the Print screen will send the format to the 

printer.   
 

Continued on next page 
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Accessing and Printing the PAY500 Record, Continued 
 

 
Step Action 

9 The system will display a Forms window and request 
acknowledgment.  Clicking <OK> will return user to the main 
PAY500 transaction screen. 
 

 
 

10 By clicking <Return>, user may exit the print screen without 
printing the PAY500 format. 

11 The PAY500 format may be read using the DCPS 500 Character 
Interface Format provided on page 26.   
 
The format is reflected in five 100 character lines with positions 
grids above the transaction data.   

  
 
Producing a  
DCPS Payroll  
Interface 
Report 

 

• The PAY500 Report is produced by Servicing Office ID (SOID)/ 
Payroll Office ID (POID) /Servicing Agency and is separate for each 
sequenced package that is sent to payroll.   

• The report reflects all PAY500 formats included in the package 
transmission. 

• The DCPS 500 Character Interface Format located on page 26 will be 
used to assist with reading the PAY500 Report.   

• Creating this report is not a system management requirement, but may 
be recommended by user’s Component.  It is NOT required for 
interface tracking at the region level.  

 
 
 

Continued on next page 
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Producing a DCPS Payroll Interface Report, Continued  
 

 
Step Action 

1 Navigation Path > Processes and Reports > Submit Processes 
and Reports > <Open> 
 

2 The system will ask if the request is a Single Request or a Request 
Set.  The default is Single Request and is appropriate for this 
specific report.   Click <OK> to continue. 
 

 
 

3 The screen opens with the cursor in the Name data field.  Click the 
LOV icon to select DCPS PAYROLL INTERFACE REPORT 
FOR 500 CHARACTER.   
 

 
 

 
 

Continued on next page 
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Producing a DCPS Payroll Interface Report, Continued 
 

 
Step Action 

4 The Parameters screen opens.  The START_DATE and 
END_DATE fields are critical as ALL daily reports on the region 
instance will be produced if not limited by date.  Report may be 
limited by POID and or SOID.  
 

 
 

5 Complete the remainder of the Processes and Reports setup screen 
to include the desired At these times and Upon Completion 
sections.   
 

 
 

 
 
 

Continued on next page 
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 Producing a DCPS Payroll Interface Report, Continued 
 

 
Step Action 

6 If an electronic copy is desired, click <Options> and change the 
number of copies to 0.  Click <OK> to continue. 

 
 

7 When all options and parameters are set, click <Submit> to execute 
or schedule the report.  

8 Requests log will appear reflecting the current status of the user’s 
request.  The <Refresh Data> is used to check for completion of 
the report run.  
 

 
 
User may exit from this log without affecting the report run.  To 
retrieve the screen at a later time, click <View Requests> from the 
taskbar and click on <Find>.  The screen will open with the current 
status.  

 
Continued on next page 
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 Producing a DCPS Payroll Interface Report, Continued 
 

 
Step Action 

9 When the process shows Completed, user may view the electronic 
report by clicking <View Output>.  The report will be opens as a 
MS WORD document and may be saved in the desired file type. 

10 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The following definition of the report content is provided: 
 

Data Title Description 
PREPARED ON:  Date the report was executed. 
CREATION DATE: Date the interface package was created 
CREATION TIME: Local region time the package was created 
SERVICING OFFICE ID: Self Explanatory 
SEQUENCE NUMBER: This is the package sequence number used to 

track the package to DCPS.  The first three 
digits is the last sequence sent, the second three 
digits reflects the current sequence.   

AGENCY CODE: This field reflects the SERVICING Agency  
PAYROLL OFFICE: Two character Payroll Office ID 
PACKAGE NUMBER: System generated package sequence.  Not used 

for tracking. 
 PAY500 formats are reflected in five lines of 

100 characters each.  Each transaction is 
separated by a blank line.  The PAY500 
Interface Transaction Format provided at the 
end of this chapter will assist in reading the 
transactions. 

RECORD COUNT: Reflects the number of PAY500 formats 
included in the package being reported. 

REPORT ID: DCPSIN - This is the system report identifier. 
 

 

Continued on next page 
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Sample of DCPS Payroll Interface Report 

 
PERSONNEL DATA - PRIVACY ACT OF 1974 

DCPS PAYROLL INTERFACE 
 

                                                                                               PREPARED ON: 03 JUN 2007 
 

 
 
      CREATION DATE:   02 JUN 2003      SERVICING OFFICE ID:  DR       AGENCY CODE:  DD     PAYROLL OFFICE:   PE 
      CREATION TIME    18:05:02         SEQUENCE NUMBER: 559560                             PACKAGE NUMBER:   1030 
 
              XXXXXXXXXEMPLOYEE1                  55072710 950605DD01K02950605893030601GS0185  1110PA11001000 
         1 1274       F0               88889E020113 0000104000000000           DRACMACM       00012  G0 
                    61330                     001369030601      PE                  950605960107Y960107 
                        05587300DD     Y    1369  0000 
                         07118000000000000000                                            40     2030602053056 
 
 
              XXXXXXXXXEMLOYEE2                   49042510 021007DD01K02021007893030601WG7408  0302PH11001000 
         1 0000       P0               00159N021007 0020ZZX000000000           DRBWA          00000  C0031006 
                    53122                     001369030601      PE                  021007030601Y030601 
                        00001172DD     Y    13692 0027 
                         00000000000000000000                                            20     2030602053127 
 
 
              XXXXXXXXXCORRECT FORMAT T                           DD01         002030419 
           1274                                                                DR 
                    63110                     001369            PE 
             352                DD          1369 
                         02586                                                                  2030602110902 
 
 
 
 
   
 
 
 
 
    RECORD COUNT: 3                                                                             REPORT ID: DCPSIN 
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Payroll 
Transaction 
Regeneration 
Process 
 

• Payroll regeneration process is restricted to Component 
designated users.  Payroll Regeneration Responsibility is 
required to access the process. 

• It is critical to remember that date fields are in YYMMDD 
format.   

• THIS PROCESS IS NOT INTENDED TO BE A PAY500 
VIEW.   Payroll Regeneration process is appropriate when 
(1) a DCPAS- issued official workaround designates the 
process as solution to a system deficiency or (2) the original 
transaction rejected at payroll, reject was not worked, and 
transaction subsequently dropped from the payroll system 
suspended transaction area.  In the second event, the 
transaction must be retransmitted as originally sent and will 
again reject.  The resulting reject must be resolved in a 
timely manner. 

  
 

Step Action 
1 

  Select the CIVDOD Payroll Regeneration Responsibility.  As 
there are no other processes associated with this responsibility, the 
processing screen will be opened when the responsibility is selected. 

2 The Payroll entry window opens the same view as the PAY500 view 
discussed in Topic 1, Accessing and Printing the PAY500 Record.  
Please refer to that topic for description of the views and instructions 
for finding transactions.   After locating the transaction requiring 
retransmission, click <Regenerate>. 

 
 
 

Continued on next page 
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Payroll Transaction Regeneration Process, Continued 

 
 
 

Step Action 
3 The Payroll Regeneration process opens the transaction by individual 

data fields in a scroll screen.  All of the fields are open allowing for 
modification, if appropriate.   
 
CAUTION:  There are no validity edits or business rules applied to 
this process.  User must be extremely careful to ensure valid 
information when altering the original transaction.  

 
 
 
 

Continued on next page 
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Payroll Transaction Regeneration Process, Continued 
 

 
 
 

Step Action 
3 

(cont) 

 
 
 

Continued on next page 
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Payroll Transaction Regeneration Process, Continued 
 

 
 

Step Action 
3 

(cont) 
 

 
 

4 
 
 

Change any data field by clicking in the field and typing in the new 
data.  It is critical to remember that date fields are in YYMMDD 
format.  
   
Note:  There are no LOVs active for making changes. 

5 Following completion of review and modification, click <Save> to 
create the new PAY500 interface transaction.  If, after review, user 
determines that the transaction should NOT be resent to DCPS, click 
<Return> to go back to the payroll screen. 

 
Continued on next page 
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Payroll Transaction Regeneration Process, Continued 
 

 
 

Step Action 
6 If a record has been regenerated, an “R” will be displayed on the 

Pay500 screen in the Regeneration Flag box next to Agency. 
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Producing a 
Payroll 
Regeneration 
Activity 
Report 
 

This request identifies those PAY500 transactions that were generated by a 
user with CIVDOD Payroll Regeneration Responsibility. 
 
 
 
 

 
Step Action 

1 
  Select the US Federal HR Manager Responsibility    

Navigation Path > Processes and Reports  >  Submit Processes 
and Reports <Open> Single Request <OK> 

2 The screen opens with the cursor in the Name data field.  Click the 
LOV icon to select Payroll Regeneration Activity. 

 
Input the date parameters required (this should be based on the 
transaction date, not the effective date).  If no parameters are input, all 
PAY500 transactions that have been regenerated to payroll will be 
pulled.  

 
 

Continued on next page 
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Producing a Payroll Regeneration Activity Report, Continued 
 

 
 

Step Action 
3 Click <Submit>. 

 
4 When the report has finished running, click <View Output>. 

 

 
 
 

The report will display all the interface transactions created by 
regeneration resident on the Pay500 table or those that fall within 
specified creation dates. 
 

 
 

Continued on next page 
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Producing a Payroll Regeneration Activity Report, Continued 
 

 
 

Step Action 
5 Go to File > Save As and save the report as a text file (.txt).  Be sure 

to designate the hard drive designation where the file should be saved 
to. 

 
 

6 Through Excel, open the Payroll Regeneration text file that was saved.  
At Step 1 of Text Import Wizard, hit <Next>.  At Step 2, uncheck 
“Tab” delimiter, check “Other” and put in the tilde character “~” for 
the delimited, then hit <Next>. 
 

 
 
 

Continued on next page 
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Producing a Payroll Regeneration Activity Report, Continued  
 

 
 

Step Action 
7 At Step 3, to ensure all data exports correctly in the Data preview, 

change the data format for each column from “General” to “Text,” 
then click <Finish>. 
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DFAS 
PAY500 
Processing 
Status Reverse 
Interface 
 

• This interface provides information on “what happened” to each 
PAY500 transaction submitted to DCPS.  Many conditions can cause 
PAY500 transactions to reject or drop to reports in the payroll system 
rather than update the payroll records.   

• This interface eliminates the manual effort of tracking PAY500 
interface transactions, resolve those “missing” interface transactions, 
and the time and effort expended to locate and resolve those actions.   

• Users will be able to view this information in DCPDS through a Pay 
Status window (similar to the PAY500).   

• Users can also export the Pay Status File from the Pay Status window 
into an Excel spreadsheet or request a hard-copy PAY500 DFAS 
Processing Status Report through DCPDS. 

 
 
 

Step Action 
1 To view the information through the Pay Status Window, click “Pay 

Status” on the navigation menu. 
 

 
 

 
Continued on next page 
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DFAS PAY500 Processing Status Reverse Interface, Continued 

 
 
 

Step Action 
2 Users can view the transactions two ways:  (1) click <Find> to display 

all transactions listed in SSN order; or (2) type a value in one search 
field or combination of fields (i.e., user can search just by SSN only, 
or Eff Date only, or a combination of SOID and POID, etc.), then 
click <Find>.   

 
3 User can check the processing status found in the Payroll Status 

Description Field for each PAY500.  There are seven Payroll Status 
Descriptions. 

Description Meaning Action 
Prior reject 
deleted – error 
not corrected 
by HR 

Transaction originally rejected back to 
Personnel.  It was stored as a DCPS 
SF50-HOLD-TRAN “returns” record 
and has been held awaiting a 
correction action from Personnel for 
two pay periods with none being 
received.  The transaction has been 
deleted from the SF50-HOLD-TRAN 
and Personnel are notified. 

Payroll – None 
 
Personnel – A new 
original transaction 
must be sent to 
payroll. 

Eff Date > 
DCPS pay 
period – 
placed on hold 

Transaction has a future effective date 
and was stored as a SF-HOLD-TRAN 
“future” record 

Payroll – None 
 
Personnel – None 

Rejected to 
Payroll Invalid 
Report 

Transaction has an error or situation 
that will not allow it to be processed 
systematically (e.g., Effective Date 
offline).  The transaction rejected and 
written to payroll’s Personnel 
Interface Reject Report for review. 

Payroll – Must 
determine the 
problem and contact 
Personnel, if 
necessary.  Enter 
transaction manually. 
 
Personnel – Depends 
on the circumstances. 

 

 
Continued on next page 
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DFAS PAY500 Processing Status Reverse Interface, Continued 

 
 
 

Step Action 
3 

cont 
 

Description Meaning Action 
Rejected to 
Payroll Missing 
Org Report 

Organization code on the 
transaction can not be found on the 
DCPS database.  The transaction is 
written to Payroll’s Missing 
Organization Report (P6606R04). 

Payroll – Must 
research and 
determine if Org 
record needs to be 
built.  If code is 
incorrect, contact 
Personnel. 
 
Personnel – Must 
correct org code if in 
error. 

Rejected to 
Personnel 
PAYNEW 

Received an error that caused the 
transaction to be returned to 
Personnel (P6606R03). 

Payroll – None 
 
Personnel – Must 
correct error. 

Rejected to 
PAYNEW/ 
PROC pay 
action processed 

Transaction generates more than 
one action and the primary action 
(e.g., NOAC 108) was processed 
but the secondary action (TSP data) 
encountered an error and is returned 
to Personnel. 

Payroll – None 
 
Personnel – Must 
review error and send 
transaction to 
correctly update 
secondary 
information. 

Processed 
successfully 

Transaction processed successfully Payroll/Personnel – 
No action required. 

 

 
 

4 Click <Exit> to exit the Pay Status screen. 
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Exporting  
of Pay  
Status File  
 

Step Action 
1 To export the Pay Status File from the Pay Status Window, click 

anywhere inside the detail information on the screen. 

 
 

2 Click File/Export 

 
 

3 Click <Save> in the File Download Window. 

 
 

 
 

Continued on next page 
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Exporting of Pay Status File, Continued 

 
 
 

Step Action 
4 Enter a file name (e.g. paystatus_export 3-15-07).  Leave the .tsv 

extension as the file type, click <Save>. 

 
5 Click <Close> when the download is complete. 

 

6 Open Microsoft Excel, select File / Open and choose the saved file 
paystatus_export_3-15-07.tsv.  Change the “Files of type:” to All 
Files to see .tsv files. 
 

 
 

Continued on next page 



                      R12 March 2012 

PAY500 Record View, Print, and Regeneration                                                                                                     Module 8, Chapter 2, Page 25 

 

Exporting of Pay Status File, Continued 

 
 
 

Step Action 
7 The text import wizard appears.  This is a delimited file, click <Next>. 

 
8 This is TAB delimited file, click <Next>. 

 
9 All the columns have a type of “General.”  This will cause leading 

zeroes to be dropped.  User will need to click the column and change 
the radio button for column data format to “Text.”  After changing the 
columns, click <Finish>. 

 
 
 

Continued on next page 
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Exporting of Pay Status File, Continued 

 
 
 

Step Action 
10 Notice that the column width causes some of the data to be truncated.   

 

 
 

Click in the uppermost left-had box of the grid to highlight the entire 
spreadsheet, and then select Format / Column / AutoFit Selection. 

 
 

11 Add the Auto filter by selecting Data / Filter / AutoFilter.  This 
allows users to search for data by filtering the columns. 

12 To save these changes, select File / Save As.  In the Save As box, 
change “Save as type:” from Text (Tab delimited) to Microsoft Excel 
spreadsheet, click <Save>. 
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Producing a 
Personnel/Payroll 
Interface DCPDS 
Processing Status 
(PAYSTA) Report  

 

 
Step Action 

1 Click Process and Reports >Submit Process & Reports 
2 When the Submit a New Request window opens, accept the Single 

Request Default and click <OK>. 

 
 

3 Select Personnel/Payroll Interface DCPDS Processing Status 
Report, click <OK>. 

 
 

 
 

Continued on next page 
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Producing a Personnel/Payroll Interface DCPDS Processing Status 
(PAYSTA) Report, Continued 

 
 

Step Action 
4 A Parameter window will open – these fields are optional.  Input one 

or all of the following fields to receive specific reports:  SOID, POID, 
DCPS Process Date, NOA Code, and/or Effective Date.  <Clear> will 
remove values from fields.  <Cancel> will close the parameters with 
no values saved. 
 
NOTE:  To run the entire instance, leave the data fields blank and 
click <OK>. 
 

 
 

5 Click <Submit> to execute the report process. 

 

Sample of a Personnel/Payroll Interface DCPDS Processing Status (PAYSTA) Report  

 

 
 

Continued on next page 
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DCPS 500 Character Interface Format 
 

 
RCD-POSN 

 
FIELD NAME 

 
SIZE 

CONT 
FLD 

SPECIAL 
INSTRUCTIONS/ 

REMARKS 
1-5 FILLER 5   
6-14 Social Security 9 Y SEE NOTE 5 
15-41 Last Name, First Name, MI, & Suffix 27 Y  
42 Drawdown Action ID 1   
43-48 Birth Date 6  YYMMDD 
49 Citizenship 1   
50 NAF Retirement Indicator 1   
51 Category (SMA) 1 T  
52-57 SCD Leave 6  YYMMDD 
58-59 Servicing Agency 2 Y  
60 Performance System Certification 1   
61 Retirement Plan 1   
62-63 Agency Group - Sub Element 2   
64-69 Date Arrived Personnel Office 6  YYMMDD 
70-72 Nature Of Action Code 3 Y SEE NON-NUMERIC 

NOA LIST  
73-78 Effective Date 6 Y YYMMDD 
79-80 Pay Plan  2   
81-84 Job  (Occupational Series)  4   
85 Temps Total Cost   (FEHB) 1   
86 FEHB Pre-Tax Waiver Indicator 

(Official Workaround 05-0009) 
1  Pending DCPS 

Implementation 
(SCR X8939) 

87-88 Grade  2   
89-90 Step or Rate 2   
91-92 Pay Basis 2   
93-101 Location   (GSA GEOLOC) 9   
102 Payment Option 1 T  
103-106 Position Locality Percent 4   
107-110 Retained Locality Percent 4   
111-113 Purchase Currency OR 

Rent Currency 
3 T  

114 Work Schedule 1   
115 Pay Rate Determinant 1   
116-117 Title Code 2  FOR VA USE ONLY 
118-119 Leave Accrual Rate 2  APPLIES TO SES/SL/ST 

EQUIV PAY PLANS 
120-128 Pseudo SSN 9   
129-130 UH-Faculty-Rank-IND OR 

EOP-Leave-Earner-IND 
2   

131-134 Bargaining Unit Status 4   
135 Annuitant Indicator 1   

 
 

Continued on next page 
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DCPS 500 Character Interface Format, Continued 

 
 

RCD-POSN 
 

FIELD NAME 
 

SIZE 
CONT 
FLD 

SPECIAL 
INSTRUCTIONS/ 

REMARKS 
136 FLSA Category 1   
137-142 FEHB Start Date 6  YYMMDD 
143 FILLER 1   
144-147 TSP/Roth Amount 4   
148-149 Health Plans 2   
150 Health Plans Enrollment 1   
151-156 SCD Retirement 6   
157-159 FILLER 3   
160 Award – Special Handling Indicator 1   
161-170 Purchase Amount (LQA)    OR 

Rent Amount (LQA) 
10 T AMOUNT IS REFLECTED 

IN FOREIGN CURRENCY 
151-156 SCD Retirement 6   
157-159 FILLER 3   
160 Award – Special Handling Indicator 1   
161-170 Purchase Amount (LQA)    OR 

Rent Amount (LQA) 
10 T AMOUNT IS REFLECTED 

IN FOREIGN CURRENCY 
171-172 Servicing Office ID   (SOID) 2 Y  
173-175 Current Appointment Auth (1) 3   
176-178 Current Appointment Auth (2) 3   
179 BRAC Indicator 1   
180 FILLER 1   
181-185 Amount Award  5 T WHOLE DOLLARS ONLY 
186 LEO Position Indicator 1   
187-188 Duty Status 2   
189-190 TSP/Roth Rate 2   
191-192 Agency Code Transfer To       OR 

Agency Code Transfer From  
2 T FOR NOA 352 

FOR NOAs 130/132 
193-194 FEGLI 2   
195-200 Date Prob/Trial Period Ends 6  YYMMDD 
201 Quarters Type (LQA) 1 T  
202 Payroll Office Gain/Loss Indicator 1 T SEE NOTE 1 
203-206 Hours Left to Work 4  FOR VA USE ONLY 
207-209 Civilian Type 3  FOR ARMY/NGB/VA USE 

ONLY 
210 Entitlement Code  1 T  
211 Summer Recess Indicator 1 T (DODEA) 
212-218 Organization Structure ID 7 Y SEE NOTE 4 FOR 

AGENCY UNIQUE 
REQUIREMENTS 

219-225 Entitlement Amount / Percent OR 
Amount (Imminent Danger Pay) 

7 T  

226-227 Retained Pay Plan 2   
 
 

Continued on next page 
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DCPS 500 Character Interface Format, Continued 

 
 

 
RCD-POSN 

 
FIELD NAME 

 
SIZE 

CONT 
FLD 

SPECIAL 
INSTRUCTIONS/ 

REMARKS 
228-229 Retained Grade 2   
230-231 Retained Step or Rate 2   
232-237 Retained Date To 6  YYMMDD 
238-243 PAS/UIC 6 Y SEE NOTE 4 FOR 

AGENCY UNIQUE 
REQUIREMENTS 

244-249 Date Last Equivalent Increase  6  YYMMDD 
250-251 Previous Payroll Office Id 2 T  
252 MSC Ship Type 1  Pending DCPS/DCPDS 

implementation 
253-255 MSC Employee Position 3  Pending DCPS/DCPDS 

implementation 
256-257 Payroll Office ID 2 Y  
258-263 Title 38 Physicians/Dentists Special Pay 6   
264 US Code Indicator (T38 Indicator) 1   
265-266 FILLER 2   
267-275 Incorrect Social Security  9 T OUTPUT ONLY FROM 

SSN CORRECTION (SEE 
NOTE 5) 

276-281 TSP SCD  6  YYMMDD 
282-287 TSP Eligibility Date 6  YYMMDD 
288 TSP Status 1   
289-294 TSP Status Date 6  YYMMDD 
295-302 Salary Left to Earn 8  FOR VA USE ONLY 
303 T38 Saturday Pay 1   
304 T38 Sunday Pay 1   
305-307 Corrected Nature Of Action Code 3 Y 

T 
REFLECTS NOA BEING 
CANCELED OR 
CORRECTED 

308-313 Location (LQA)                      OR 
Location (Post Allowance)     OR 
Location (Danger Pay)            OR 
Location (Post Differential)     OR 
Location (Imminent Danger Pay) 

6 T FIRST 6 CHARACTERS 
OF APPROPRIATE GSA-
GEOLOC:  RESIDENCE 
LOCATION FOR LQA; 
DUTY LOCATION FOR 
ALL OTHER 
ENTITLEMENT TYPES 

314-315 No. Family Members (LQA)    OR 
No. Family Members (Post Allowance) 

2 T  

316-323 Salary 8   
324-325 Agency Group – Agency Code 2 Y  
326-330 TSP/Roth Catch-up Biweekly Amount 5 T  
331 Reserve Category 1   
332 Quarters Group (LQA) 1 T  
333-335 Organization Function Code 3  FOR ARMY USE ONLY 

 
 

Continued on next page 
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DCPS 500 Character Interface Format, Continued 

 
 

 
RCD-POSN 

 
FIELD NAME 

 
SIZE 

CONT 
FLD 

SPECIAL 
INSTRUCTIONS/ 

REMARKS 
336-339 Personnel Office ID (POI) 4 Y  
340 Part-Time Indicator 1   
341 Premium Pay Ind 1   
342-345 Pay Table ID 4   
346-349 Retained Pay Table ID 4   
350 RESERVED FOR NSA USE 1   
351-356 Retirement Annuity Sum 6  WHOLE DOLLARS ONLY 
357-358 Shared Percent (LQA) 2 T  
359-366 Severance Pay Amount/ 

Recruitment-Relocation Lump Sum Amt/ 
VSIP Biweekly Amount 

8 T  

367-372 Severance Pay Weekly Amount/ 
Recruitment-Relocation Biweekly Amt/ 
Retention Incentive Percentage 

6 T  

373-378 Temp Appt NTE 6  YYMMDD 
379-384 Limited Appt NTE 6  YYMMDD 
385-390 Temp Prom NTE 6  YYMMDD 
391-396 Assignment NTE 6  YYMMDD 
397-402 NTE DATE/3R Service Agreement End Date 6  YYMMDD (SEE NOTE 2) 
403-405 Utility Currency (LQA) 3 T  
406-411 Title 38 Physician/Dentist 6   
412-415 FILLER 5   
416-421 Locality Pay 5   
422-426 Original/Incorrect Award Amount 5 T  
427-431 Amount (Supervisory Differential) 5   
432-436 Retention Allowance 5   
437 Aggregate Limit Indicator  1   
438 Overtime Computation Indicator 1  NSPS PAY PLANS YA-YZ 

ONLY 
439 Premium Pay Limit Indicator 1   
440 EMT Indicator 1   
441-446 Date Earliest NOA Effective 6  YYMMDD (SEE NOTE 3) 
447-452 Payroll Org Code  6   
453-462 Utility Amount (LQA) 10 T AMOUNT REFLECTED 

IN FOREIGN CURRENCY 
463 T38 Holiday Pay 1   
464 T38 OT 1   
465 T38 Night/Tour Differential 1   
466 T38 On-Call 1   
467-471 Army Wage Leader Salary 5  ARMY COE USE ONLY 
472-476 Army Wage Supervisory Salary 5  ARMY COE USE ONLY 
477-480 FILLER 4   
481-482 Weekly Hours 2  SEE NOTE 6 

 
Continued on next page 
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DCPS 500 Character Interface Format, Continued 

 
 

 
RCD-POSN 

 
FIELD NAME 

 
SIZE 

CONT 
FLD 

SPECIAL 
INSTRUCTIONS/ 

REMARKS 
483-484 Fraction Hours 2  SEE NOTE 6 
485-487 FILLER 3   
488 Format Change Indicator 1 Y  
489-500 Processing Time Stamp/Seq 12 Y YYMMDDHHMMSN 

 
Control Field Values: 
 

Y = These data fields are part of the record control data for the payroll system 
processing.  The appropriate value for these fields must be present in all interface 
transactions.  
 
T = These fields are transaction specific.  Data will be included in the interface 
format only when applicable to the transaction being processed.   For example, 
LQA data fields will only be present when the transaction is update to LQA 
authorization.  Severance pay information will be reflected only when included in 
separation action. 

 
Note 1:  The value reflected in PAYROLL OFFICE LOSS FLAG is generated when there is a 
change in servicing payroll office and the employment is continued with the DoD agency.  An 
appropriate action flows to the gaining payroll office with a value of “G” in the field and another 
to the losing payroll office with a value of “L”.   Input of TYPE-OF-PAY-CHG, with a value of  
 “R” in a separation transaction, NOA 3##, will signal DCPS to stop payment of lump sum 
annual leave and closure of the employee retirement record.  The separation action should only 
contain the value when the employee will be rehired within a few days.  
 
Note 2:  This field is used to flow various not to exceed dates that would not be appropriate for 
use with any other not to exceed date, i.e., unique to a specific NOAC and not appropriate for 
dual action processing.  The following table reflects the logic for determining the value of the 
field. 
 

IF THE NOA INPUT IS: FIELD WILL CONTAIN VALUE OF 
 DATA NAME 

430 LWOP NTE 
450 (More than 30 days) Date Suspension Over 30 Days 
450 (Less than 30 days) Date Suspension Under 30 Days 

452 Date Suspension Over 30 Days 
460 LWOP NTE 
472 Furlough NTE 
473 LWOP NTE  
480 Sabbatical NTE 

 
Continued on next page 
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DCPS 500 Character Interface Format, Continued 

 
 

IF THE NOA INPUT IS: FIELD WILL CONTAIN VALUE OF 
772 Furlough NTE (New value) 
773 LWOP NTE  (New Value) 
815 Service Agreement End Date/Biweekly 

End Date  
816 Service Agreement End Date/Biweekly 

End Date  
921/923 Date Temporary Reassignment Expires 

 
Note 3:  EARLIEST EFFECTIVE DATE must be input with correction RPAs if the correction 
applies to more than the most recent SF-50 and is changing the SAME data element(s) to the 
SAME value.  This signals payroll to initiate the retroactive correction process that will apply the 
correction to all appropriate pay records and allow for automated processing of adjustments to 
pay or withholdings/deductions.  This field should only be included as long as there is no change 
in salary.  If changes to salary occur due to the correction, then individual correction(s) must be 
coded for each different salary instead of using this field.  If the correction applies to only the 
latest SF-50, this field should not be included in the input. 
 
Note 4:  UIC and Organization data will be written to the PAY500 record based on owning 
agency rules.  Following table provides the information necessary to ensure the correct values 
are input to cross-serviced records and written in the interface.  
 

UIC/PAS   ORG 

COMPONENT MODERN  COMPONENT MODERN 

AF## (Air Force) PAS AUTH 5,4  AF## (Air Force) 
ORGANIZATION 
STRUCTURE ID 

AR## (Army) UNIT ID CODE  AR## (Army) 
ORGANIZATION 
STRUCTURE ID 

DD01 (OSD) 

UNIT ID CODE 3,4 (if 
WHS) 
UNIT ID CODE (if not 
WHS)  DD01 (OSD) 

ORGANIZATION 
STRUCTURE ID 

DD02 (Joint Chiefs) UNIT ID CODE 3,4  DD02 (Joint Chiefs) 
ORGANIZATION 
STRUCTURE ID 

DD04 (DISA) UNIT ID CODE  DD04 (DISA) 
ORGANIZATION 
STRUCTURE ID 

DD06  (DEF SEC) 

UNIT ID CODE 3,4 (if 
WHS) UNIT ID CODE (if 
not WHS)  DD06 (DEF SEC) 

ORGANIZATION 
STRUCTURE ID 

DD07 (DLA) UNIT ID CODE 1,2  DD07 (DLA) 
ORGANIZATION 
STRUCTURE ID 

 
Continued on next page 
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DCPS 500 Character Interface Format, Continued 

 
 

 
UIC/PAS   ORG 

COMPONENT MODERN  COMPONENT MODERN 
DD08 (Court Appeals 
Armed Svcs) UNIT ID CODE 3,4  

DD08 (Court Appeals 
Armed Svcs) 

ORGANIZATION 
STRUCTURE ID 

DD09 (AFIS) UNIT ID CODE 3,4  DD09 (AFIS) 
ORGANIZATION 
STRUCTURE ID 

DD10 (DCAA) UNIT ID CODE 1,2  DD10 (DCAA) 
ORGANIZATION 
STRUCTURE ID 

DD11 (NIMA) UNIT ID CODE 3,4  DD11 (NIMA) 
ORGANIZATION 
STRUCTURE ID 

DD12 (DSS) DSS Unique: ACTIVITY  DD12 (DSS) OFFICE SYMBOL 

DD13 (DARPA) UNIT ID CODE 3,4  DD13 (DARPA) 
ORGANIZATION 
STRUCTURE ID 

DD16 (DODEA) OFFICE SYMBOL 1,6  DD16 (DODEA) DODEA ACTING CD 

DD21 (WHS) UNIT ID CODE 3,4  DD21 (WHS) 
ORGANIZATION 
STRUCTURE ID 

DD23 (OEA) UNIT ID CODE 3,4  DD23 (OEA) 
ORGANIZATION 
STRUCTURE ID 

DD25 (DLSA) UNIT ID CODE 3,4  DD25 (DLSA) 
ORGANIZATION 
STRUCTURE ID 

DD26 (DODIG) UNIT ID CODE 3,4  DD26 (DODIG) 
ORGANIZATION 
STRUCTURE ID 

DD27 (MDA) UNIT ID CODE 3,4  DD27 (MDA) 
ORGANIZATION 
STRUCTURE ID 

DD28 (NSA) UNIT ID CODE  DD28 (NSA) 
ORGANIZATION 
STRUCTURE ID 

DD29 (DTSA) UNIT ID CODE 3,4  DD29 (DTSA) 
ORGANIZATION 
STRUCTURE ID 

DD34 (DECA) UNIT ID CODE 1,2  DD34 (DECA) 
ORGANIZATION 
STRUCTURE ID 

DD35 (DFAS) UNIT ID CODE 1,2  DD35 (DFAS) 
ORGANIZATION 
STRUCTURE ID 

DD48 (DHRA) UNIT ID CODE 1,2  DD48 (DHRA) 
ORGANIZATION 
STRUCTURE ID 

DD58 (DPW) UNIT ID CODE 3,4  DD58 (DPW) 
ORGANIZATION 
STRUCTURE ID 

DD60 (TRICARE) UNIT ID CODE 3,4  DD60 (TRICARE) 
ORGANIZATION 
STRUCTURE ID 

DD60 (DDAAFE, 
DDAAFF, 
DDAAFG) UNIT ID CODE  

DD60 (DDAAFE, 
DDAAFF, DDAAFG) 

ORGANIZATION 
STRUCTURE ID 

 
Continued on next page 
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DCPS 500 Character Interface Format, Continued 

 
 

 
UIC/PAS   ORG 

COMPONENT MODERN  COMPONENT MODERN 

DD61 (DTRA) UNIT ID CODE  DD61 (DTRA) 
ORGANIZATION 
STRUCTURE ID 

DD63 (DCMA) UNIT ID CODE 1,2  DD63 (DCMA) 
ORGANIZATION 
STRUCTURE ID 

DD65 (PFPA) UNIT ID CODE 3,4  DD65 (PFPA) 
ORGANIZATION 
STRUCTURE ID 

DD66 (CIFA) UNIT ID CODE  DD66 (CIFA) 
ORGANIZATION 
STRUCTURE ID 

DD68 (DoDTRMA) UNIT ID CODE 3,4  DD68 (DoDTRMA) 
ORGANIZATION 
STRUCTURE ID 

DD69 (NDU) UNIT ID CODE  DD69 (NDU) 
ORGANIZATION 
STRUCTURE ID 

DD74 (DTIC) UNIT ID CODE  DD74 (DTIC) 
ORGANIZATION 
STRUCTURE ID 

DD77 (BTA) UNIT ID CODE 3,4  DD77 (BTA) 
ORGANIZATION 
STRUCTURE ID 

NGAF (NGB-AF) PAS AUTH 5,4  NGAF (NGB-AF) 
FUNCT ACCT AND 
SHRED 

NGAR (NBG-AR) UNIT ID CODE  NGAR (NBG-AR) 
ORGANIZATION 
STRUCTURE ID 

NGZG (NGB-ZG) PAS AUTH 5,4  NGZG (NGB-ZG) 
FUNCT ACCT AND 
SHRED 

NV## (Navy) UNIT ID CODE  NV## (Navy) PAYROLL ORG CODE 

EOP UNIT ID CODE 5,2  EOP 
ORGANIZATION 
STRUCTURE ID 

BBG UNIT ID CODE  BBG 
ORGANIZATION 
STRUCTURE ID 

ZZ01  UNIT ID CODE  ZZ01 
ORGANIZATION 
STRUCTURE ID 

 
 
Note 5:  When corrections to SSANs are processed, the incorrect SSAN should flow in record 
positions 267-275 and the correct SSAN should flow in record positions 6-14 with NOA 499.   
 
Note 6:  Stored in DCPDS as one data element called Weekly Hours 
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DCPDS/DCPS Non-Numeric NOACs, Continued 

 
 

• This list contains those data elements (with their appropriate non-numeric NOAC) that 
will product a Pay500 transaction when updated. 

• Users should ensure they are Date-Tracked to the correct effective date before updating 
these data elements. 

 
 

DATA NAME 
NOAC 

OUTPUT 
 

REMARKS 
Foreign Allowances / Entitlements 5EN/5EC/ 5ED  
PAS Code BCA  
Servicing Office ID BCB  
BRAC Ind BRC  
Duty Status C5E  
TSP Catch-up for NAF CNN/CNC/CND  
LWOP Contingency COA/COT  
TSP Catch-Up Regular New. Change/Delete CUN/CUC/CUD  
TSP Catch-Up Roth New/Change/Delete CRN/CRC/CRD Future Codes 
Civilian Type GBB ARMY and NGB ONLY 
FEHB Pre-Tax Waiver Indicator 
(Official Workaround 05-0009) 

HBP Pending DCPS Implementation 
(SCR X8939) 

Weekly Hours J4B  
Part-time Indicator J4D  
Date Prob/Trial Period Ends J5G  
Agency Code Transfer To J6P  
Payroll Org Code JAR NAVY ONLY 
Organization Structure ID JEJ AF/AR/ANGB 
LEO Position Indicator JPW ANGB 
Pay Table ID JQN  
Premium Pay Ind JQU  
Leave Accrual Rate LAR  
Health Plan M2B  
Temps Total Cost M2H  
Severance Pay Amount M5K  
Performance Certification  MSC  
Aggregate Limit Indicator MSC  
Overtime Computation Indicator MSC NSPS ONLY 
Premium Pay Limit Indicator MSC  
EMT Indicator MSC  
Citizenship Code PA3  
Payroll Office ID Transfer PON Not recognized by DCPS 
SCD Retirement RCD  
Auto-Roll ROL DCPS Code Only 
TSP Roth ROT Future Code 
Date Arrived Personnel Office R2B  
Reserve Category S1B  
Date Last Equivalent Increase S1F  
Overtime Rate Update  TBL DCPS Code Only 
TSP Regular TSP  
Unit ID Code UIC  
T38 Indicator X8G  
EOP Leave Indicator X8G EOP ONLY 
Wage Leader Salary Hr XCI ARMY ONLY 
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Wage Supv Salary Hr XCJ ARMY ONLY 
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Module 8 

Chapter 3 

Payroll Reject Reports 

 

Chapter Overview 

 
Purpose This procedure will guide the user through the steps to access, run, print, 

and read the Payroll Reject report. 
 

 
Who Does It? 
 
 
Chapter Contents 

CIVDOD Personnelist 

 
 

 
 
 
  

 
 
 

 
 

Before You Begin • Payroll Reject notifications are returned to DCPDS on the day the 
transaction rejects at DCPS.  The notifications are updated to the 
affected region when received by the EXITS server.    

• A daily recurring report process should be established to execute at the 
same time each day.  The process will produce PAYNEW report 
formats for reject notifications that have been received since the last 
execution of the report.  

• Also known as “Returns to Personnel”, the reject notifications process 
against the employee’s DCPDS record to allow inclusion of current 
related information on the report. 

• Reports that were missed or lost may be recreated by executing a one-
time execution with specific date parameters.  

 
 

 

Topic Page 
Chapter Overview 1 
Processing the Payroll Reject Report 2 
Sample Payroll Reject Report 6 
Reading the Payroll Reject Report  7 
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Processing the Payroll Reject Report 
 
 

Step Action 
1 Navigation Path > Processes and Reports > Submit Processes 

and Reports > <Open> 
 

2 Submit a New Request window opens, accept the Single Request 
default and click <OK>. 
 

 
 

3 Submit Request window opens with cursor in the Name data field, 
click the LOV icon.  
 

 
 

4 Select Payroll Reject (PAYNEW), and then click <OK>.  A 
parameter box will open.  
 

 
 

 
 

Continued on next page 
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Processing the Payroll Reject Report, Continued 
 
 

Step Action 
5 Leave both fields blank if setting up the daily pre-scheduled report 

for the region.  If not, input the SOID and the date received for the 
specific rejects to be reprinted.  Click <OK>.  <Clear> will 
remove values from fields.  <Cancel> will close the parameters 
with no values saved. 
 

 
 

6 If processing with SOID and date parameters, the process may be 
executed with the default “As Soon as Possible” schedule.  To 
setup a recurring run or specify the process execution date or time, 
click <Schedule>. 
 

 
 

 
 
 

Continued on next page 
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Processing the Payroll Reject Report, Continued 
 

Step Action 
7 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select the desired scheduling options in the Run the Job box.  The 
parameters needed for each option will be provided as displayed in 
the screen views below.  Complete the parameter values and click 
<OK>.  <Cancel> will return user to the Submit Request screen 
without changing the At These Times parameter. 
  

 
 

 
 

 
 

 
 

Continued on next page 

Once 
 
 

Periodically 

As Soon as 
Possible 

On Specific Days 
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Processing the Payroll Reject Report, Continued 
 
 

Step Action 
8 Upon Completion parameters will allow printer designation and 

number of report copies desired.  Click <Options> to open the 
parameter screen. 
 

 
 
Select a printer from the LOV by clicking in the block reflecting 
the default printer.  Set the number of copies required and click 
<OK>.  As with other reports, changing the number of copies to 0 
will allow for electronic storage of the selected reports. 
 

 
 

9 When all parameters are set as desired, click <Submit> to execute 
the report process. 
 

 
  

Continued on next page 
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Sample of Payroll Reject Report 

 
PERSONAL DATA - PRIVACY ACT OF 1974 

K02416K0   42192   1012                       REPORT ON INDIVIDUAL PERSON (PA) 
                                                                                                             

AS OF: 03 JUN 2007 
 

The following transaction has rejected or processed at payroll as indicated below. If the reason for error is PROC, the 
action was processed by payroll, but the data element in error must still be corrected via data element update or NOA, as 
appropriate. If the reason for error shows the action has been deleted, then the action must be input as if it were a new 
action.  If the error message is other than PROC or a deletion, then correct or cancel. Ensure rejects are cancelled, 
corrected, or reinput immediately to ensure the employee is paid correctly and on time. 
 
 
NAME/SSAN/                  NOA/CORR-NOA/DT-PAY-PROCSD      DATA ELEMENT IN ERROR/                               PAYROLL 
RECORD STATUS               EFF-DT/CORRECTED-EFF-DT         VALUE FLOWED TO PAYROLL                              OFF ID 
UIC/ORG STR CODE 
 
First MI Last          TSP /     / 02 JUN 2003        #1  73-TSP Rate                                          CH 
XXX-XX-XXXX                 07-APR-2002 /                  #1     00 
APPR                                                       #2  74-TSP Empl Amt 
42192/1012                                                 #2     0000 
 
 
REASON FOR ERROR 
#1  9001-Required Field(s) Not Entered 
#2  9001-Required Field(s) Not Entered 
 
RELATED DATA ELEMENTS     RELATED DATA ELEMENTS 
FROM CURRENT EMPLOYEE     FROM CURRENT EMPLOYEE 
RECORD ERROR#1:           RECORD ERROR#2: 
 
RetireCod: K              RetireCod: K 
TSPStatus: Y              TSPStatus: Y 
TSPStatDt: 07-APR-2002    TSPStatDt: 07-APR-2002 
SCD TSP: 11-MAY-1991      SCD TSP: 11-MAY-1991 
TSP Rate: 6               TSP Rate: 6 
TSPEmpAmt:                TSPEmpAmt: 
TSP RateC:                TSP RateC: 
TSP RateF:                TSP RateF: 
TSP RateG:                TSP RateG: 
TSPEligDt:                TSPEligDt: 
 
 
   REPORT NAME: PYREJ                                        1 
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Reading the Payroll Reject Report 

 
A sample of the PAYNEW report is provided below. 

 
Field Heading Description 
NAME/SSAN Self Explanatory.  If this field reflects a SSAN with no name, 

the reject has not found a matching employee record on the 
region database.  This could occur when an erroneous SOID 
or agency is entered in the payroll record. 

RECORD STATUS Identifies the type of record, appropriated, technician, etc. 
PAS/OFFICE SYMBOL Reflects the Air Force PAS Code or other agency Unit 

Identification Code (UIC) and the office symbol to which the 
employee is assigned.  Data is from the current assignment. 

NOA NOA of the PAY500 transaction that rejected 
CORR-NOA Reflects the NOA being corrected or cancelled when the 

NOA value is 001 or 002. 
DT-PAY-PROCSD Date the transaction attempted to process to the payroll 

system 
EFF-DT Effective date of the PAY500 transaction that rejected. 
CORRECTED-EFF-DT This field is NOT used.  DCPDS does not allow for 

correction of effective date. 
DATA ELEMENT IN 
ERROR 

Identifies the data field(s) that caused the transaction to reject.  
The two digit number is used in the reject format and allows 
for translation to the data field name.   The reject report is 
formatted to reflect up to five data fields. 

VALUE FLOWED TO 
PAYROLL 

Directly under the identification of the data field causing the 
reject is the value that was resident in the PAY500 
transaction.   

PAYROLL OFFICE ID Self Explanatory. 
REASON FOR ERROR Reflects up to five separate error messages, one for each of 

the data elements in error.  The data fields and error messages 
are numbered to associate the data element with the cause.  
The four character code is used in the reject format and allows 
for translation of the error message. 

RELATED DATA 
ELEMENTS FROM 
CURRENT EMPLOYEE 
RECORD  ERROR#  

Reflects current employee record information that is 
associated with the data field that caused the error condition.  
Each data field has a specific list of related information that 
will assist in researching the cause of the problem.  Up to five 
entries of related data will be reflected, one for each data field 
in error.  

 
Continued on next page 
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Reading the Payroll Reject Report, Continued 

 
Payroll Reject Error Message Numbers and Definitions 

Error 
Message 
Number 

 
 
Translation:  Further Explanation 

1005 EMPLOYEE IS INELIGIBLE 
An attempt was made to input data for which an employee is not eligible.  Verify 
associated elements.  Examples: 

 Post Differential – No valid for GEOLOC 
 Severance Pay – Not valid for annuitant status 
 FEGLI/FEHB participation not valid for citizenship code 
 Thrift Savings Plan (TSP) or TSP eligibility date is not valid for 

employee’s retirement code or citizenship code. 
 Disability retirement not valid for retirement codes 2, 4, or 5. 

1006 EXCEEDS MAXIMUM AMOUNT/PERCENTAGE 
The amount/percentage field exceeds the maximum amount or percentage allowed 
for the entitlement. 

1016 CODE/NUMBER NOT FOUND 
The code or number (NOAC, FEHB, etc.) does not exist.  Verify the entry.  If code is 
valid, contact Component systems representative. 

1051 CANNOT PROCESS – FUTURE EFFECTIVE DATE 
If this message is received, contact user’s Component system representative 
immediately.  DCPDS is not supposed to write projected transaction to DCPS. 

2035 INVALID TSP STATUS CODE-ELIGIBILITY DATE COMBINATION 
TSP status code and eligibility date combination is invalid.  TSP eligibility dates 
must always be the 1st day of a pay period (unless it's the EOD date due to the 
employee being eligible upon new hire).  Take corrective action to ensure correct 
flow to payroll. 

3004 UNABLE TO PROCESS – NOA NOT COMPATIBLE WITH PRIOR 
TRANSACTION/DUPLICATE PERSONNEL TRANSACTION 
The input NOAC does not correspond with any prior transaction:  Most commonly 
received as a result of a subsequent extension or termination action.  General, payroll 
maintains 13 pay periods in their current database.  If the effective date on a non-
permanent action was prior to the 13 pay period timeframe, it may no longer be on 
the active pay file.  EXAMPLE: 

If the error is no NOAC 932 (Termination of Detail), DCPS does not have 
this employee on a detail NTE.  If the 932 is valid, contact the payroll office 
for manual assistance. 

Duplicate transaction:  The combinations of NOAC and effective date have already 
been processed in the payroll file.  Validate via on-line query for DCPS and DCPS 
view and/or contact payroll office for verification. 

 
 

Continued on next page 
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Reading the Payroll Reject Report, Continued 

 
Payroll Reject Error Message Numbers and Definitions 

Error 
Message 
Number 

 
 
Translation:  Further Explanation 

3005 UNABLE TO PROCESS – NO MATCHING TRANSACTION FOUND 
The original NOAC being Cancelled (001) or Corrected (002) was either never 
processed via payroll interface or is beyond the 13 pay period window on the file. 

3006 UNABLE TO PROCESS – SEPARATION ALREADY PROCESSED 
Separation transaction has already processed.  An additional separation NOAC with 
a different effective date is being received by DCPS.  If this error message is 
received and the action was not produced by PTI 1PI, contact user’s Component 
system representative immediately. 

3007 TSP DEDUCTION INCREASE NOT ALLOWED – TAX DEBT EXISTS 
Employee is indebted to IRS and IRS has requested a garnishment against the 
employee’s pay.  Employee cannot increase TSP deduction until the tax levy is 
satisfied.  Transaction CANNOT be resent to DCPS.  DCPDS must be changed back 
to previous deduction amounts and the employee notified. 

3008 SUSPENDED TRANSACTION HAS BEEN DELETED 
Transactions are “held” for two pay cycles when rejects occur.  When no corrective 
action is sent to cause subsequent consummation on the DCPS file, the action id 
deleted.  Verify DCPDS personnel data for accuracy – taking corrective action as 
necessary.  Reflow the initial transaction. 
 
If action was correct on the personnel side, contact payroll technician to coordinate 
manual update by payroll. 

3023 EMPLOYEE CURRENTLY SERVICED BY ANOTHER AGENCY 
DCPS will not accept a transaction from a different servicing Component unless the 
transaction is a specific NOAC.  This edit was added to DCPS to prevent employees 
from separating if a late separation comes in, and the employee was already rehired 
on the same database.  Personnel should notify the payroll office of the action as they 
are being done for employees transferring from one DD to another DD. 

9000 INVALID VALUE IN FIELD(S) 
Input is not valid for field(s) listed.  For example, during FEHB Open Season, code 
values may change for a given carrier.  DCPDS table values are changed centrally 
via system patch or release.  DCPDS effect corresponding changes to payroll table 
values.  FEHB mass converters are not possible in DCPDS.  Individual record 
updates are necessary to reflect new code values.  If these changes are not effected, 
invalid FEHB codes will flow to DCPS on the next and subsequent transactions. 

 
 

Continued on next page 
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Reading the Payroll Reject Report, Continued 

 
Payroll Reject Error Message Numbers and Definitions 

Error 
Message 
Number 

 
 
Translation:  Further Explanation 

9001 REQUIRED FIELD(S) NOT ENTERED 
Transaction is missing necessary data to correctly process.  Data fields most likely 
contained spaces or zeroes in error.  Verify DCPDS record for accuracy.  Take 
corrective action if necessary to ensure correct flow to payroll. 

9002 EMPLOYEE SSAN NOT FOUND 
No records exist for this employee SSAN.  Either the employee is not in the payroll 
database or an incorrect employee SSAN has been entered.  Verify the correct 
SSAN.  If the SSAN is in error on the personnel file, take corrective action 
immediately.  Also check to ensure the record contains the correct Payroll Office ID 
(DIN JAP).  If the personnel record is correct, contact the payroll technician to 
identify the cause of the problem and coordinate the appropriate corrective action. 

9003 INVALID DATE(S) 
An invalid date has been entered in a date field.  For all dates, entry must be numeric 
YYMMDD format and compatible (month 01 to 12 and day 01 to 28/31, depending 
on the month).   
 
In addition, certain actions/data elements require a pay period beginning or ending 
date or a prior, current, or future pay period date.  EXAMPLE: 

 Start TSP Contribution – Must be a pay period beginning date 
 Termination of TSP – Must be a pay period ending date 
 TSP Eligibility Date – Must be the first pay period in January or July 

(Open Season) 
9004 INVALID ATTEMPT TO ADD CHANGE DELETE OR VIEW 

A “LOSS” transaction has attempted to process to DCPS with both a gaining and 
losing DCPS Payroll Office ID included in the transaction and the NOAC is not 5##, 
702, 713, 721, 740, 790, 792 or PON.  This edit was established to ensure that DCPS 
employee records are not closed erroneously by CAO actions. 

9007 EMPLOYEE SSAN ALREADY EXISTS 
An employee record exists with this employee SSAN.  Verify the correct SSAN.  If 
the SSAN is in error on the personnel file, take corrective action immediately.  If the 
personnel record is correct, contact the payroll technician to identify the cause of the 
problem and coordinate the appropriate corrective action. 

 
 

Continued on next page 
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Reading the Payroll Reject Report, Continued 

 
Payroll Reject Error Message Numbers and Definitions 

Error 
Message 
Number 

 
 
Translation:  Further Explanation 

PROC NOA HAS PROCESSED FOR PAY; HOWEVER, THE FOLLOWING FIELDS 
WERE FOUND TO BE INVALID 
This message indicates that the NOAC being sent has processed for pay purposes, 
however, an error exists with an unrelated TSP or FEHB data element.  EXAMPLE: 

 NOAC 893 for a FERS employee flowed to payroll.  The TSP-SCD or 
TSP-ELIGIBILITY-DATE was missing or invalid.  The 893 is not related 
to the TSP error condition so it will be processed, but the TSP date field 
that caused the error must still be corrected in DCPDS using PTI 1TS. 

 If the NOAC is “TSP” or the retirement code changes to FERS (K, L, M, 
N) the entire transaction will reject to personnel. 

DCPDS Table Name:  CIVDOD_PAYROLL_ERROR_MESSAGE 
 

Continued on next page 
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Reading the Payroll Reject Report, Continued 
 

Payroll Reject Error Codes – Data Element In Error 
Data Field 
Number 

 
Data Field 

01 UIC 
02 SSAN 
03 Name 
04 DOB 
05 Citizenship 
06 SCD-Leave 
07 FEGLI 
08 Retirement Code 
09 Nature of Action Code 
10 Eff Date of Action 
11  Pay Plan 
12  Occupational Series 
13 Grade 
14 Step 
15 Pay Basis 
16 GSA Geoloc 
18 Work Schedule 
19  Pay Rate Determinant 
21 Annuitant Indicator 
22 FLSA 
23 Hours Scheduled/Wrk Hrs Wk Fraction 
24 Health Benefits Plan/Status 
25 FEHB Tot Cost Temps Ind 
26 SOID ID 
27 Cash Award Amount 
28 Dt FEHB Eff 
29 Duty Status 
31 Retained Pay Plan 
32 Agcy Cd Transferred To/From 
34  Supplemental Empl Status Code (DCPS) 
42 Corrected SSAN 
43 TSP Vesting Svc Compt Dt 
44 TSP Elig Dt 
45 TSP Status Code 
46 Dt Last Equiv Increase 
47 Corrected Nature of Act CD 

 
 

Continued on next page 
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Reading the Payroll Reject Report, Continued 
 
  

Payroll Reject Error Codes – Data Element In Error 
Data Field 
Number 

 
Data Field 

50 Basic Salary 
51 Sal Left to Earn 
52 Payroll Off Id 
53 Pers Off Ident 
54 Part Time Indicator 
55 Premium Pay Indicator 
56 Pay Table Ident 
57 Org Structure/Payroll Org-Cd 
58 Retir Annuity Sum Flag 
59 Severance Pay Sum Flag 
60 Sev Pay Weekly Amt Flag 
61 Temp Appt Expire 
62 Dt Limited Appt Expire 
63 Dt Temp Promotion Expire 
64 Dt Temp Posn Chg Expire 
65 NTE Date 
66 Locality Adjustment 
67 Original/Incorrect Award Amount 
68 Retention Allowance 
69 Supervisory Diff Pay 
70 Hours Left to Work 
71 Curr Appt Auth Cd 1 
72 Curr Appt Auth CD 2 
73 TSP Rate 
74 TSP Empl Amt 
75 TSP Status Date 
76 TSP Empl Rate C 
77 TSP Empl Rate F 
78 TSP Empl Rate G 
79 Dt Prob Tri Prd Ends 
80 Servicing Agency 
81 Agency Code 
82 Dt Ariv Svcg SOID 
83 NAF Retirmnt Pin Indicatr 
84 Drawdown-Action-Ind 
85 TSP Catch-Up Contribution Amount 
86 Locality Percent 

 
 
 
 

Continued on next page 
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Reading the Payroll Reject Report, Continued  
 
 

Payroll Reject Error Codes – Data Element In Error 
Data Field 
Number 

 
Data Field 

87 Retained Locality Percent 
89 LEO Indicator 
90 Retained Grade 
91 Retained Step 
92 Previous Payroll Off Id 
93 Reserve Category 
94 Retained Pay Table Ident 
95 Dt Earliest NOA Eff 
97 Empl-Entitlement 
98 Empl-Entitlement-Amt-Pct 
A0 IP Number 
A1 AR-WG-LDR-SRY-HR 
A2 AR-WG-SPV-SRY-HR 
A3 LQA-Amt-Purchase 
A4 LQA-Amt-Rent 
A5 LQA-Amt-Utility 
A6 LQA-Purch-Crncy-Type 
A7 LQA-Rent-Crncy-Type 
A8 LQA-Util-Crncy-Type 
A9 LQA-Location 
B1 LQA-Quarters-Type 
B2 LQA-Shared-Pct 
B3 LQA-Nr-Fam-Mbrs 
B4 LQA-Summer-Rec-Ind 
B5 LQA-Quarters-Group 
B6 PAL-Nr-Fam-Mbrs 
B7 PAL-Location 
B8 DPY-Location 
B9 SMA-Cat 
C1  PDF-Location 
C3 Faculty-Rank-Ind 
C6 Performance System Certification 
C7  Payment Option 
C8 Leave Accrual Rate 
C9 SCD Retirement 
D0 Aggregate Limit Indicator 
D1 Overtime Computation Indicator 

 
 
 

Continued on next page 
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Reading the Payroll Reject Report, Continued  
 
 
 

Payroll Reject Error Codes – Data Element In Error 
Data Field 
Number 

 
Data Field 

D2 Premium Pay Limit Indicator 
D4 VSIP Biweekly Amount 
D5  BRAC IDC 
D6 Entitlement NTE Date 
D7 Severance Pay Sum 
D8 Severance Pay Weekly 
D9 Loss Gain Flag 
E0 T38 Indicator 
E1 T38 Saturday Pay 
E2 T38 Sunday Pay 
E3 T38 Holiday Pay 
E4 T38 Overtime 
E5 T38 Tour Diff 
E6 T38 On-Call 
E7 EMT Indicator 

DCPDS Table Name:  CIVDOD_DCPS_PAYROLL_REJ_XVAL 
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Module 8 

Chapter 4 

Payroll Reverse Interface 
 
Chapter Overview 

 
Purpose This chapter guides the user through the processes that accomplish update of 

time and attendance and separation package tracking information returned by 
DCPS.  The chapter also provides navigation to Personnel/Payroll Accounting 
Data (PAD) information.   

________________________________________________________________ 
 

Chapter Contents 
 

Topic Page 
Chapter Overview 1 
Reverse Interface Processes 1 
Viewing Reverse Interface Data 5 
Payroll Reverse Interface Reports 7 
Recreating Reverse Interface Reports – Replay Reports 9 
Pay Application Data (PAD) - Payroll Financial Data   12 
Pay Application Data (PAD) Record Format 20 
Employee Address Update 29 
Sample of Payroll Reports  30 

  
Reverse Interface Processes 
 
 • Data maintained through payroll reverse interface include such items as 

non-pay hours impacting within grade increase (WGI) dates; non-pay 
days that impact service computation date, probationary periods, and 
attainment of tenure; intermittent days/hours worked; part time hours 
worked to alert need for schedule change; and retirement package 
tracking. 

• A payroll reverse interface file is provided by DFAS following 
completion of pay processing for each pay period.   

• Reverse interface files are processed through the EXITS server to the 
appropriate regional database upon receipt.   

 
 
 

Continued on next page 
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Reverse Interface Processes, Continued 
 
 
 • Reverse interface files are sequence controlled at the EXITS level to 

ensure receipt of all packages and correct processing sequence. 
• Separation tracking information is returned for update to DCPDS on the 

day entered to the DCPS. 
• A single PAD file is received bi-weekly at the EXITS server from each 

payroll database.  The records within the file are then routed to the 
appropriate regional database for update. 

• Employee mailing addresses are received from DCPS bi-weekly and are 
updated to DCPDS on a changes only basis.   

• PAD processing is scheduled for the second Friday of the pay period for 
all regions.  All PAD files must be received before the process may begin. 

• The following table identifies the reverse interface transactions updated to 
DCPDS.  Transaction Identification Code (TIC) is used in the reverse 
format to invoke the appropriate DCPDS update processes.  Identification 
of TICs is essential to working rejected reverse interface transactions. 

 
 

TIC 
 

Data Description 
Updates to 

Element / Data 
Field 

1JR Organization Code:  This information is passed when the 
organization code is updated through the DCPS on-line 
employee update program (Department of Navy employees 
only). 

Position / Extra 
Information / 
Multiple Agency 
Information / 
Payroll Org Code 

1MB Intermittent Hours Worked:  The hours an intermittent 
employee has worked to enable adjustment to the service 
computation date. 

Combined Person 
& Assignment 
Form / Assignment 
/ Entries / 
Intermittent 
Accrual / Hours 
SCD 

1MC 
 

Intermittent Days Worked:  The number of days an 
intermittent employee has worked. 
 
Note:  Days Worked update value will be added to totals 
for Days Worked SCD.  Value will also be added to Days 
Worked Career, Probation, WGI, and VRA only when 
applicable to the individual record.  

Combined Person 
& Assignment 
Form / Assignment 
/ Entries / 
Intermittent 
Accrual / Days 
Worked  

 

 
Continued on next page 
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Reverse Interface Processes, Continued 
 
 

 
TIC 

 
Data Description 

Updates to 
Element / Data 

Field 
1MF Part-Time Hours Worked Pay Period:  The total number 

of hours a part-time employee has worked during the pay 
period.   A notification is produced when there is a 
difference between hours scheduled and hours worked for 
three consecutive pay periods.   

Combined Person 
& Assignment 
Form / Assignment 
/ Entries / Part 
Time Hours 
Worked 

1MN 
 

Non-pay Work Days VRA:  The number of full non-pay 
days are passed for employees under a VRA appointment 
(except intermittent).  Non-pay days for Workers 
Compensation and Military LWOP are not included. 
 
Note:  Applies only to those employees on a VRA 
appointment. 

Combined Person 
& Assignment 
Form / Assignment 
/ Entries / Non Pay 
Days / Non Pay 
Days VRA 

1MY Non-pay Hours Within Grade Increase:  The total 
number of non-pay hours for an employee entitled to 
Within Grade Increases is passed to personnel.  For 
employees who are not entitled to Within Grade Increases, 
non-pay hours are not passed.  When the CCPO ID 
changes, a transaction is passed to the gaining CCPO ID 
reflecting the cumulative non-pay hours with an overlay 
indicator. 

Combined Person 
& Assignment 
Form / Assignment 
/ Entries / Non Pay 
Hours WGI 

1RZ Date Retirement Package Sent To OPM:  The processed 
date of the transmittal register (SF2807/3103).  This date is 
transferred to DMDC to be used for the Aging of 
Separation reporting. 

Combined Person 
& Assignment 
Form / Extra 
Information / US 
Federal Separation 
and Retirement / 
Date Ret pkg to 
OPM 

3MC Separation Payroll Office Number:  The Payroll Office 
Number of the Losing Payroll Office 

Combined Person 
& Assignment 
Form / Extra 
Information / US 
Federal Separation 
and Retirement / 
Separate Payroll 
Office Number 

3MD Retirement Register Number Assigned:  The Register 
number on which the employee's retirement information 
was listed when sent to OPM.  This information is also sent 
to DMDC to be used for the Aging of Separation reporting. 

Combined Person 
& Assignment 
Form / Extra 
Information / US 
Federal Separation 
and Retirement / 
Separate pkg 
Register Number 

 
 

Continued on next page 
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Reverse Interface Processes, Continued 
 
 

 
TIC 

 
Data Description 

Updates to 
Element / Data 

Field 
5ED Entitlement NTE/Stop Date:  The date an entitlement is 

terminated due to a change in eligibility. 
Combined Person 
& Assignment 
Form / Assign-
ment / Entries 

REP Representational Time:  The number of hours and the 
associated rate of pay (regular and overtime) are passed for 
employees who have reported time for Negotiations, 
Labor/Management, and Grievance/Appeals through T&A.  
Retroactive changes are not passed to personnel for this 
element. 

Combined Person 
& Assignment 
Form / Assign-
ment / Entries 
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Viewing Reverse Interface Data 
 

The following steps will guide the user through viewing and, if necessary, 
modifying data updated to DCPDS through reverse interface. 

  
Step Action 

1 Navigation Path > People > Enter and Maintain > <Open> 
2 The Find Person window opens. Type in the employee’s name or 

SSN click <Find> or use the LOVs.  Once the People window 
opens, click <Assignment>.  Once Assignment window opens, 
click <Entries>. 
 

 
 

3 When the Element Entries window opens, click in the Element 
Name column to select the Element Name, i.e., Total Pay, Basic 
Salary Rate, etc., and then click <Entry Values>.  The example 
provided reflects Intermittent Accrual. 
 

 
 

 
 

Continued on next page 
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Viewing Reverse Interface Data, Continued 
  

Step Action 
4 The Entry Values window opens.  If modification to any of the 

data fields is required, Date Track to the element start date or to 
the new end date of the pay period in order to make the update of 
new information.  Place cursor in the data field to be modified and 
enter the correct value.   

 
 

5 Close the form by clicking on the  , then click the Save icon 
6 The system will default an option window with correction or 

update.  Select <Update> to complete the action. 
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Payroll Reverse Interface Reports  
 

Reverse Interface processes create reports that reflect the records and information 
updated.  There is NO action required on the part of the user to produce the 
reports.   

 
Notes:   

 Samples of each reverse interface report are provided following the table 
of definitions. 

 Reports may be reproduced using the Replay Reports processes defined at 
the end of this section. 

 
Report 
Name 

 
Definition 

INTM1 This report documents updates of intermittent hours/days for 
employees on Intermittent work schedule.  The report includes 
hours worked for adjustment of Service Computation Date and 
days worked for Probationary Period completion, Career Tenure, 
VRA Conversion, and WGI Due Date.  Report is produced by 
processing of TICs 1MB and 1MC.  Sample report is at page 30.   

PTFU2 This report identifies part time employees who have worked other 
than their scheduled number of hours for three consecutive pay 
periods.  The report is provided to the employee’s supervisory 
suggesting a change in hours be accomplished by the HR office.   
Produced from TIC 1MF.  The values under PART-TIME 
HOURS WORKED reflect a combination of pay period number 
(first two characters) and hours worked. Sample report at page 36.  

FTPT1 This report documents updates of non-pay days for full time and 
part time employees.  The report includes non-pay days that may 
impact Service Computation Date, Probationary Period 
completion, and VRA Conversion date.   Produced from TICs 
1MJ, 1MK, and 1MN.  Sample report is at page 30. 

NPMJR This report is produced at the end/beginning of the calendar year 
when non-pay days SCD being reported are split between two 
years.  The report identifies employees that were at or near the 
maximum nonpay days for SCD on 31 December.  It advises that 
the records affected must be reviewed to determine if SCD change 
actions are appropriate.   Produced from TIC 1MJ.  Sample report 
is at page 35. 

 
 

Continued on next page 
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Payroll Reverse Interface Reports, Continued 
 
 

Report 
Name 

 
Definition 

NPHRR This report identifies rejects of non-pay hours updates.  The rejects 
should be reviewed to ensure the cause is valid.  If the non-pay 
hours should have been applied to the record, the data that caused 
the reject should be resolved followed by manual update of the 
non-pay hours.  Produced from TIC 1MY.   

NPHR2 This report documents the non-pay hours that processed to the 
affected employee records.  Produced from TIC 1MY.  Sample 
report is at page 33. 

UPDRJ This report identifies reverse interface transactions that error out 
of the process – other than standard business rule failure.  A reject 
message is associated with each entry to describe why the data 
could not be updated.  In some cases, the SSAN reflected on the 
reverse interface transaction is not on the region to which the 
update was sent.  Sample report is at page 32. 

RETNT This report is produced when Separation Tracking information is 
updated from DCPS to the separated DCPDS record.  The report 
identifies status of the separation package and the transmittal 
number used to forward the package to OPM.   Produced from 
TICs 1RZ, 3MC, 3MD, and 3ME.  Sample report is at page 34.  

RPAY1 This report reflects updates to Payroll Org Code for Navy ONLY.   
Produced from TIC 1JR.  Sample report is at page 37. 
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Recreating Reverse Interface Reports – Replaying Reports 
 

• This procedure allows for creation of reverse interface reports that were 
misplaced or lost because of print problems.    

• Date parameters are critical in this function to pull only the specific 
reports that need to be recreated. 

 
Step Action 

1 Navigation Path > Processes and Reports > Submit Processes 
and Reports > <Open> 

2 When Submit a New Request window opens, click <OK> to 
accept the Single Request. 
 

 
 

3 When Submit Request window opens, click the LOVs icon to 
invoke the LOV form, select Report Replay from the list, and 
click <OK>. 
 

 
 

 
 
 

Continued on next page 
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Recreating Reverse Interface Reports – Replay Reports, Continued 

 
Step Action 

4 The Parameters window will open. 
 

 
5 Complete the data fields in the Parameters window. 

 
Parameter Name Value To Be Input 

Date From *  
Date To *  
Report Group * LOV is provided.  Reverse Interface 

reports are grouped under PAYREV   
Report Name LOV is provided.  Select the report 

name needed or leave blank to run all 
reports that were created for the dates 
specified. 

Criteria Column #  * Five places are provided to allow for 
additional criteria.  Criteria Column 1 
and corresponding value are required 
entry.  If no additional criteria is 
needed, select “N/A” from the LOV. 

Criteria Value # Key in the value applicable to the 
criteria column value selected.  Not 
required for N/A or Count.  At present, 
only SOID is available for report 
reduction. 

*Required Entry (highlighted bars only) 
 

 
 

Continued on next page 



       R12                                                                             March 2012 

Payroll Reverse Interface                                                                                                                          Mod 8, Chap 4, Page 11            

Recreating Reverse Interface Reports – Replay Reports, Continued 
 

Step Action 
5a In the Report Name data field, click the LOV icon to select the 

Report Name from the list. 
 

 
 

5b In the Criteria Column 1 data field, if desired, limit the reports 
to a specific SOID.  When using this limitation, a separate report 
execution is required for EACH SOID.  More than one SOID may 
not be entered in a report run.   
 

 
 

5c In the Criteria Column 2 data field, user may request a count as 
to the number of jobs that will be created.  This option allows the 
user to determine the need for additional criteria before recreating 
large numbers of unnecessary reports.  The count criteria will 
have to be removed from the run to actually produce the reports. 
The completed Parameters form will be saved by clicking <OK>. 

6 Click <Options> to verify the printer, to which the reports will be 
printed, click <Submit> to commit. 
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Pay Application Data (PAD) - Payroll Financial Data   

Before you 
Begin 

• Personnel/Payroll Accounting Date (PAD) file is produced each pay 
period following completion of DFAS pay calculation processes.  

• The financial and leave data that is populated to the Financial Data 
screens in DCPDS and subsequently the CSU are obtained from the PAD 
file.   

• The PAD file is a separate file from the reverse interface file that updates 
Time & Attendance data in the personnel records.   

• PAD data includes pay period and year to date information for pay and 
leave.   

• All of the payroll files must be available before the PAD load to the 
regional database can begin.   

• The PAD processing is scheduled at the end of the second week of the pay 
period.  That means, for example, that financial information for pay 
period ending 16 July 2011 was not scheduled to load to the regions until 
29 July 2011.   

•  PAD data is maintained in DCPDS with most data fields replicated in the 
CSU file.  For access to pre-defined Financial Management reports, users 
should refer to The Civilian Servicing Unit (CSU) Application Desk 
Guide. 

   
Who Does It? Personnelists as well as managers based on their secure view access. 

  
Viewing PAD Data  
 

 

Step Action 
1 Navigation Path  > People > Enter and Maintain > <Open> 

 
When the Find Person window opens, type in the employee’s name 
or SSN and click <Find> or use the LOVs. 

 
 
 

Continued on next page 
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Pay Application Data (PAD) - Payroll Financial Data, Continued 

 
Step Action 

2 When the People window opens, click <Others> button.  
  

 
 

3 When the Navigation Options window opens, select Finance 
Information from the list, and then click <OK>. 
 

 
 
 

 
 
 

Continued on next page 



       R12                                                                             March 2012 

Payroll Reverse Interface                                                                                                                          Mod 8, Chap 4, Page 14            

Pay Application Data (PAD) - Payroll Financial Data, Continued 

 

Step Action 
4 The Finance Special Information window will open. In the Name 

data field, use the scroll bar to select the proper Information Type, 
i.e., Earnings and Pay, etc., then click in the Details data field.  
 

 
 

5 Entries are stored by pay period end date with the most recent 
entry on the top.  Select the desired Start Date entry and click in 
the Detail column.  

 

6 Identification of data fields available for each data group are 
provided below. 
 

 
Continued on next page 
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Pay Application Data (PAD) - Payroll Financial Data, Continued 

Data 
Groups 

Description 

Additional 
Leave Info 

 

 
Allowances 
and Special 
Pay 

 

 
 

 
Continued on next page 
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Pay Application Data (PAD) - Payroll Financial Data, Continued 

Data Groups Description 
Contributions 
Info 

 
 

Cost Budget 
Info 

 
 

 
 

Continued on next page 
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Pay Application Data (PAD) - Payroll Financial Data, Continued 

Data Groups Description 
Earnings and 
Pay 

 
 

 
 

Continued on next page 
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Pay Application Data (PAD) - Payroll Financial Data, Continued 

 

Data 
Groups 

Description 

Employee 
Leave Info 

 
 

 
Continued on next page 
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Pay Application Data (PAD) - Payroll Financial Data, Continued 

Data Groups Description 
Employee Org Dues 
Deduction 

 
 

Special Leave Info  
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Pay Application Data (PAD) Record Format 
 
This reflects the current PAD File Format and where the data is stored in DCPDS. 
 
Data Field Posn Size Comments Where Stored in 

Finance Info 
Additional 
Information 

Servicing Agency 1 2  --  
CCPO-ID 3 2  --  
Social Security Number 5 9  --  
Responsibility 
Center/Cost Center 

14 6 RCCC Cost Budget Info  

Sign Indicator 20 1  --  
Regular Earnings 21 9 Dollar Amount Earnings and Pay  

Sign Indicator 30 1  --  
Overtime Earnings 31 9 Dollar Amount Earnings and Pay  

Sign Indicator 40 1  --  
Holiday Premium Pay 41 9 Dollar Amount Earnings and Pay  

Sign Indicator 50 1  --  
Standby Premium/AUO/ 
Availability Premium 
Pay 

51 9 Dollar Amount Earnings and Pay  

Sign Indicator 60 1  --  
Sunday Premium Pay 61 9 Dollar Amount Earnings and Pay  

Sign Indicator 70 1  --  
Night Differential Pay 71 9 Dollar Amount Earnings and Pay  

Sign Indicator 80 1  --  
Lump Sum Leave Pay 81 9 Dollar Amount Allowances and Special Pay  

Sign Indicator 90 1  --  
Hazardous Duty Pay 91 9 Dollar Amount Earnings and Pay  

Sign Indicator 100 1  --  
Environmental Pay 101 9 Dollar Amount Earnings and Pay  

Sign Indicator 110 1  --  
Award Amount 111 9 Dollar Amount Allowances and Special Pay  

Sign Indicator 120 1  --  
Annual Leave Ending 
Balance 

121 7 Hours Employee Leave Info  

Sign Indicator 128 1  --  
Sick Leave Used YTD 129 7 Hours Employee Leave Info  

Sign Indicator 136 1  --  
Sick Leave Ending 
Balance 

137 7 Hours Employee Leave Info  

Sign Indicator 144 1  --  
Employer Contribution – 
FEGLI 

145 9 Dollar Amount Contributions Info  

Sign Indicator 154 1  --  
Employer Contribution – 
FEHB 

155 9 Dollar Amount Contributions Info  

Sign Indicator 164 1  --  
Employer Contribution – 
CSRS 

165 9 Dollar Amount Contributions Info  

Sign Indicator 174 1  --  
Employer Contribution – 
FERS 

175 9 Dollar Amount Contributions Info  

 
Continued on next page 
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Pay Application Data (PAD) Record Format, continued 
 
 
Data Field Posn Size Comments Where Stored in 

Finance Info 
Additional 
Information 

Sign Indicator 184 1  --  
Employer Contribution – 
TSP Matching 

185 9 Dollar Amount Contributions Info  

Sign Indicator 194 1  --  
Employer Contribution – 
TSP C Fund (Reported 
as Zeroes) 

195 9 Dollar Amount Contributions Info  

Sign Indicator 204 1  --  
Employer Contribution – 
TSP F Fund (Reported as 
Zeroes) 

205 9 
 

Dollar Amount Contributions Info  

Sign Indicator 214 1  --  
Employer Contribution – 
FERS Basic 1% 

215 9 Dollar Amount Contributions Info  

Sign Indicator  224 1  --  
Employer Contribution – 
Medicare / OASDI 

225 9 Dollar Amount Contributions Info  

Pay Period Ending Date 234 6 YYMMDD --  
Sign Indicator 240 1  --  

Net Pay 241 9 Dollar Amount Earnings and Pay  
Sign Indicator 250 1  --  

Gross Pay 251 9 Dollar Amount Earnings and Pay  
PAS/UIC 260 6  --  
Organization 266 7  Cost Budget Info  
BRAC Indicator 273 1  Special Leave Info  

   Sign Indicator 274 1  --  
Regular Hours 275 9 Dollar Amount Earnings and Pay  

   Sign Indicator 284 1  --  
Overtime Hours 285 9 Dollar Amount Earnings and Pay  

   Sign Indicator 294 1  --  
Night Differential Hours 295 9 Dollar Amount Earnings and Pay  

   Sign Indicator 304 1  --  
Environmental/Hazard 
Hours 

305 9 Dollar Amount Earnings and Pay  

   Sign Indicator 314 1  --  
Holiday Premium Hours 315 9 Dollar Amount Earnings and Pay  

   Sign Indicator 324 1  --  
Standby Premium/AUO/ 
Availability Premium 
Pay Hours 

325 9 Dollar Amount Earnings and Pay  

   Sign Indicator 334 1  --  
Sunday Premium Hours 335 9 Dollar Amount Earnings and Pay  

   Sign Indicator 344 1  --  
Administrative Leave 
Hours 

345 5 Hours Earnings and Pay  

   Sign Indicator 350 1  --  
Sick Leave Accrued 351 5 Hours Employee Leave Info  

   Sign Indicator 356 1  --  
 

Continued on next page 
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Pay Application Data (PAD) Record Format, continued 
 
Data Field Posn Size Comments Where Stored in 

Finance Info 
Additional 
Information 

Compensatory Time 
Earned 

357 5 Hours Employee Leave Info  

   Sign Indicator 362 1  --  
Compensatory Time 
Used 

363 5 Hours Employee Leave Info  

   Sign Indicator 368 1  --  
Compensatory Time 
Ending Balance 

369 7 Hours Employee Leave Info  

   Sign Indicator 376 1  --  
Religious Compensatory 
Time Earned 

377 5 Hours Special Leave Info  

   Sign Indicator 382 1  --  
Religious Compensatory 
Time Used 

383 5 Hours Special Leave Info  

   Sign Indicator 388 1  --  
Religious Compensatory 
Time Ending Balance 

389 7 Hours Special Leave Info  

   Sign Indicator 396 1  --  
Credit Hours Earned 397 5 Hours Special Leave Info  

   Sign Indicator 402 1  --  
Credit Hours Used 403 5 Hours Special Leave Info  

   Sign Indicator 408 1  --  
Credit Hours Ending 
Balance 

409 7 Hours Special Leave Info  

FILLER 416 1  --  
FILLER 417 3  --  
BCN/ASN/OBAN 420 6  Cost Budget Info  

   Sign Indicator 426 1  --  
Cola 427 9 Dollar Amount Earnings and Pay  

   Sign Indicator 436 1  --  
Re-Employed Annuitant 
Offset Amount 

437 9 Dollar Amount Allowances and Special Pay  

   Sign Indicator 446 1  --  
Recruitment Incentive 
(Foreign Language) 

447 9 Dollar Amount Allowances and Special Pay  

   Sign Indicator 456 1  --  
Interest Amount 457 9 Dollar Amount Allowances and Special Pay  

   Sign Indicator 466 1  --  
Tropical Differential  467 9 Dollar Amount Earnings and Pay  

   Sign Indicator 476 1  --  
Foreign Language 
Proficiency Pay (FLPP) 

477 9 Dollar Amount Allowances and Special Pay  

   Sign Indicator 486 1  --  
Physicians Allowance 487 9 Dollar Amount Allowances and Special Pay  

   Sign Indicator 496 1  --  
Remote Site Allowance 497 9 Dollar Amount Earnings and Pay  

   Sign Indicator 506 1  --  
Severance Pay 507 9 Dollar Amount Allowances and Special Pay  

   Sign Indicator 516 1  --  
 

 
Continued on next page 
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Pay Application Data (PAD) Record Format, continued 
 
Data Field Posn Size Comments Where Stored in 

Finance Info 
Additional 
Information 

Danger Pay 517 9 Dollar Amount Earnings and Pay  
   Sign Indicator 526 1  --  

Extracurricular Pay 
(Educators) 

527 9 Dollar Amount Earnings and Pay  

Sign Indicator 536 1  --  
Extra Duty Pay (Dorm 
Supervisors) 

537 9 Dollar Amount Earnings and Pay  

Sign Indicator 546 1  --  
Transfer Allowance Pay 547 9 Dollar Amount Allowances and Special Pay  

Sign Indicator 556 1  --  
Education Allowance / 
Travel Pay 

557 9 Dollar Amount Allowances and Special Pay  

Sign Indicator 566 1  --  
Time Off Award Used 
YTD 

567 9 Dollar Amount Employee Leave Info  

Sign Indicator 576 1  --  
Time Off Award Ending 
Balance 

577 9 Dollar Amount Employee Leave Info  

Agency Code 586 2  Cost Budget Info  
Accounting Activity 588 6  Cost Budget Info  
Employee Name 594 27  --  
Employee Status Code 621 1  Cost Budget Info  
Payroll Office Identifier 622 6  Cost Budget Info  
Appropriation 628 13  Cost Budget Info  
US Code IDC 641 1  --  
Assigned JON/CC/PC 642 18  Cost Budget Info  
Fiscal Year 660 1  Cost Budget Info  
Program Year 661 1  Cost Budget Info  
Fund Code 662 2  Cost Budget Info  

Sign Indicator 664 1  --  
Military Leave Balance 665 5 Hours Employee Leave Info  

Sign Indicator 670 1  --  
Military Leave Earned 
YTD 

671 5 Hours Employee Leave Info  

Sign Indicator 676 1  --  
Annual Leave Hours 
Earned PP 

677 5 Hours Employee Leave Info  

Sign Indicator 682 1  --  
PP Non-Pay Used 683 5 Hours Special Leave Info  

Sign Indicator 688 1  --  
PP Annual Leave 
 Used 

689 5 Hours Employee Leave Info  

Sign Indicator 694 1  --  
Annual Leave Forfeit 
Balance 

695 7 Hours Employee Leave Info  

Sign Indicator 702 1  --  
Shore Leave Balance 703 7 Hours Special Leave Info  

Sign Indicator 710 1  --  
 

Continued on next page 
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Pay Application Data (PAD) Record Format, continued 
 
Data Field Posn Size Comments Where Stored in 

Finance Info 
Additional 
Information 

Home Leave Balance 711 7 Hours Special Leave Info  
Sign Indicator 718 1  --  

Law Enforcement Leave 
Balance 

719 7 Hours Special Leave Info  

Sign Indicator 726 1  --  
Donated Leave/Leave 
Bank Balance 

727 7 Hours Special Leave Info  

Sign Indicator 734 1  --  
PP Donated Leave/Leave 
Used 

735 5 Hours Special Leave Info  

Sign Indicator 740 1  --  
Time Off Award Oldest 
Hours 

741 7 Hours Employee Leave Info  

Time Off Award Oldest 
Date 

748 6 YYMMDD Employee Leave Info  

Sign Indicator 754 1  --  
Comp Time Oldest 
Unused Hours 

755 7 Hours Employee Leave Info  

Comp Time Oldest Date 762 6 YYMMDD Employee Leave Info  
Sign Indicator 768 1  --  

Comp Time Oldest Rate 769 5 Hours Employee Leave Info  
Sign Indicator 774 1  --  

Separation Incentive 775 9 Dollar Amount Allowances and Special Pay  
Sign Indicator 784 1  --  

Supervisory Differential 
Pay 

785 9 Dollar Amount Earnings and Pay  

Sign Indicator 794 1  --  
Recurring Allowances 795 9 Dollar Amount Allowances and Special Pay  

Sign Indicator 804 1  --  
One Time Bonuses 805 9 Dollar Amount Earnings and Pay  

Sign Indicator 814 1  --  
PP NAF Retirement 815 9 Dollar Amount Contributions Info  

Sign Indicator 824 1  --  
PP 401 K 825 9 Dollar Amount Contributions Info  

Sign Indicator 834 1  --  
PP State Employee 
Retirement 

835 9 Dollar Amount Contributions Info  

Program Element Code 844 10  Cost Budget Info  
Sign Indicator 854 1  --  

FEGLI – Basic 855 9 Dollar Amount Contributions Info  
Sign Indicator 864 1  --  

FEGLI – Optional 865 12 Dollar Amount Contributions Info  
Sign Indicator 877 1  --  

FEHB 878 9 Dollar Amount Contributions Info  
Sign Indicator 887 1  --  

CSRS 888 9 Dollar Amount Contributions Info  
Sign Indicator 897 1  --  

FERS 898 9 Dollar Amount Contributions Info  
Sign Indicator 907 1  --  

 
Continued on next page 
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Pay Application Data (PAD) Record Format, continued 
 
Data Field Posn Size Comments Where Stored in 

Finance Info 
Additional 
Information 

Non Pay Hours YTD 908 7 Hours Special Leave Info  
Sign Indicator 915 1  --  

Annual Leave Used YTD 916 7 Hours Employee Leave Info  
Sign Indicator 923 1  --  

Sick Leave – FERS 924 7 Hours Special Leave Info  
Sign Indicator 931 1  --  

Gross Pay YTD 932 9 Dollar Amount Earnings and Pay  
Address Street (1) 941 27  Address  
Address Street (2) 968 27  Address  
Address City 995 13  Address  
Address State 1008 2  Address  
Address Zip 1010 9  Address  
Employee Organization 
Code 

1019 3 Occurrence 1 Employee Org Dues 
Deduction 

 

Employee Org 
Deduction Amount 

1022 9 Dollar Amount    
Occurrence 1 

Employee Org Dues 
Deduction 

 

Remarks Indicator
  

1031 1 Occurrence 1 Employee Org Dues 
Deduction 

 

Employee Organization 
Code 

1032 3 Occurrence 2 Employee Org Dues 
Deduction 

 

Employee Org 
Deduction Amount 

1035 9 Dollar Amount   
Occurrence 2 

Employee Org Dues 
Deduction 

 

Remarks Indicator
  

1044 1 Occurrence 2 Employee Org Dues 
Deduction 

 

Employee Organization 
Code 

1045 3 Occurrence 3 Employee Org Dues 
Deduction 

 

Employee Org 
Deduction Amount 

1048 9 Dollar Amount   
Occurrence 3 

Employee Org Dues 
Deduction 

 

Remarks Indicator
  

1057 1 Occurrence 3 Employee Org Dues 
Deduction 

 

Employee Organization 
Code 

1058 3 Occurrence 4 Employee Org Dues 
Deduction 

 

Employee Org 
Deduction Amount 

1061 9 Dollar Amount   
Occurrence 4 

Employee Org Dues 
Deduction 

 

Remarks Indicator
  

1070 1 Occurrence 4 Employee Org Dues 
Deduction 

 

Employee Organization 
Code 

1071 3 Occurrence 5 Employee Org Dues 
Deduction 

 

Employee Org 
Deduction Amount 

1074 9 Dollar Amount  
Occurrence 5 

Employee Org Dues 
Deduction 

 

Remarks Indicator
  

1083 1 Occurrence 5 Employee Org Dues 
Deduction 

 

Employee Organization 
Code 

1084 3 Occurrence 6 Employee Org Dues 
Deduction 

 

Employee Org 
Deduction Amount 

1087 9 Dollar Amount   
Occurrence 6 

Employee Org Dues 
Deduction 

 

Remarks Indicator
  

1096 1 Occurrence 6 Employee Org Dues 
Deduction 

 

Sign Indicator 1097 1  --  
 

Continued on next page 
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Pay Application Data (PAD) Record Format, continued 
 
Data Field Posn Size Comments Where Stored in 

Finance Info 
Additional 
Information 

Military Leave Used 
YTD 

1098 5 Hours  Employee Leave Info  

Sign Indicator 1103 1  --  
Market Pay 1104 9 Dollar Amount Allowances and Special Pay  

Sign Indicator 1113 1  --  
Recruitment Incentive 
Amount (NOA 815) 

1114 9 Dollar Amount Allowances and Special Pay  

Sign Indicator 1123 1  --  
Relocation Incentive 
Amount (NOA 816) 

1124 9 Dollar Amount Allowances and Special Pay  

Sign Indicator 1133 1  --  
Retention Incentive 
Amount (NOA 827) 

1134 9 Dollar Amount Allowances and Special Pay  

Sign Indicator 1143 1  --  
Comp Time for Travel 
Earned 

1144 5 Hours Employee Leave Info  

Sign Indicator 1149 1  --  
Comp Time for Travel 
Used 

1150 5 Hours  Employee Leave Info  

Sign Indicator 1155 1  --  
Comp Time for Travel 
Balance 

1156 7 Hours Employee Leave Info  

Sign Indicator 1163 1  --  
BRAC Restored Begin 
Balance 

1164 6 Hours Special Leave Info  

Sign Indicator 1170 1  --  
BRAC Restored Added 
YTD 

1171 6 Hours Special Leave Info  

Sign Indicator 1177 1  --  
BRAC Restored Used 
Pay Period 

1178 5 Hours Special Leave Info  

Sign Indicator 1183 1  --  
BRAC Restored Used 
YTD 

1184 6 Hours Special Leave Info  

Sign Indicator 1190 1  --  
BRAC Restored Paid 
YTD 

1191 6 Hours Special Leave Info  

Sign Indicator 1197 1  --  
BRAC Restored Ending 
Balance 

1198 6 Hours Special Leave Info  

Sign Indicator 1204 1  -  
Frozen Annual Leave 
Used PP 

1205 5 Hours Employee Leave Info  

Sign Indicator 1210 1  -  
Frozen Annual Leave 
Used YTD 

1211 5 Hours Employee Leave Info  

Sign Indicator 1216 1  -  
Frozen Annual Leave 
End Balance 

1217 5 Hours Employee Leave Info  

Sign Indicator 1222 1  -  
 

Continued on next page 
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Pay Application Data (PAD) Record Format, continued 
 
Data Field Posn Size Comments Where Stored in 

Finance Info 
Additional 
Information 

Nurse Executive Pay  1223 9 Dollar Amount Allowances ad Special Pay  
FEHB Military Excused 
(MIL EXC) IDC 

1232 1  Contributions Info  

Sign Indicator 1233 1  -  
Prepaid FEHB Premiums 1234 5 Dollar Amount Contributions Info  

Sign Indicator 1239 1  -  
#1/LR – Restored 
Annual LV Balance 

1240 7 Hours   

Sign Indicator 1246 1  -  
#1/LR – Restored 
Annual LV Used PPD 

1247 5 Hours   

Sign Indicator 1252 1  -  
#2/LR – Restored 
Annual LV Balance 

1253 7 Hours   

Sign Indicator 1259 1  -  
#2/LR – Restored 
Annual LV Used PPD 

1260 5 Hours   

Sign Indicator 1265 1  -  
#3/LR – Restored 
Annual LV Balance 

1266 7 Hours   

Sign Indicator 1272 1  -  
#3/LR – Restored 
Annual LV Used PPD 

1273 5 Hours   

Sign Indicator 1278 1  -  
FMLA – DA, DB, DC & 
DD 

1279 5 Hours Additional Leave Info  

Sign Indicator 1284 1  -  
FFLA – DE & DF 1285 5 Hours Additional Leave Info  

Sign Indicator 1290 1  -  
FMLA – DM 1291 5 Hours Additional Leave Info  

Sign Indicator 1296 1  -  
Telework – 
Environmental Hrs – TW 

1297 5 Hours Additional Leave Info  

Sign Indicator 1302 1  -  
Telework – 
Environmental Hrs - TS 

1303 5 Hours Additional Leave Info  

Sign Indicator 1308 1  -  
Telework – 
Environmental Hrs – TM 

1309 5 Hours Additional Leave Info  

Sign Indicator 1314 1  -  
Military Deposit Owed 
(Balance) 

1315 9 Dollar Amount   

Sign Indicator 1324 1  -  
 
 

Continued on next page 
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Pay Application Data (PAD) Record Format, continued 
 
Data Field Posn Size Comments Where Stored in 

Finance Info 
Additional 
Information 

Military Deposit Paid 
(Pay Period) 

1325 9 Dollar Amount   

Sign Indicator 1334 1  -  
PP Sick Leave Used 1335 5 Hours Employee Leave Info  
Alternate Work Schedule 

Code 
1340 1  Additional Leave Info  

FILLER 1341-
1400 

  --  

 
Explanation of Comments: Dollar Amount (9 characters) = 000000.00 (zeros filled to left of amount), i.e., Regular 
Earnings = 049136.00; Hours, (5, 6 & 7 characters) = 00.00, 000.00 & 0000.00 (zeroes filled to left of hours), i.e., 
Annual Leave Ending Balance (7) = 0240.00, BRAC Restored Ending Balance (6) = 080.00 and Sick Leave 
Accrued (5) = 04.00. 
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Employee Address Update Process 

• Mailing address is maintained in DCPDS for each appropriated fund 
employee paid by DCPS. 

• Address information may be entered by HR users, but is not required. 
• Employee addresses flow to DCPDS from DCPS (payroll) with the PAD 

files bi-weekly. 
• DCPDS process updates changes only, including addresses for new 

employees.   
• Updates are accomplished on the same schedule established for PAD 

processing. 

Step Action 
1 To view employee address, navigate to People > Enter and 

Maintain > <Open> 
2 When the People window opens, click <Address> at the bottom 

left of the screen. 
 

 
 

 
 

Continued on next page 
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Employee Address Update Process, Continued 

Step Action 
3 The address window opens.  Clicking in the Address data field 

will open the block for editing.  Style must not be modified.  If 
update is being accomplished, be sure to Date Track to the 
appropriate effective date.   

 
 

4 View and/or modify employee address from the opened window. 
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Sample of Payroll Reports 

 
PERSONNEL DATA  -  PRIVARY ACT OF 1974 

AS OF:  1 JUN 2007 
 
RECD ID: 
 
SUBJECT:  Payroll Reverse Interface Full/Part Time Days 
 
TO: 
 
A payroll reverse interface was received on the following employee(s) which updated the non-pay days listed below.  If the pay period is not 
the most recent, review the Official Personnel Folder (OPF) to determine if there is an impact on a personnel action.  If a personnel action 
was affected by the change, please take corrective action.  
 
        
       OLD    OLD    OLD 
       NON NON   NON NON   NON NON 
NAME    PAY   PAY PAY   PAY PAY   PAY PAY 
SSAN    END   DAYS DAYS DT-PROB  DAYS DAYS DT-VRA  DAYS DAYS 
ORGANIZATION         NR/DT   SCD SCD   EXP  PROB PROB CONV DUE VRA VRA 
 
First MI. Employee         11/17-MAY-2003      29 37 21-JUN-2003  39  37 20-JUN-2004 29 37 
XXX-XX-XXXX 
7X2405252100A Main Base Support 
  
First MI. Worker         11/17-MAY-2003      21 28  
XXX-XX-XXXX 
7X2405252100A Main Base Support 
 
 
 
 
 
 
 
 
 
 
 
REPORT NAME:   FTPT1       1 
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Sample of Payroll Reports, Continued 

 
7X41997X  HE2405 252100           AS OF:  23 MAY 2007 

PERSONAL DATA  -  PRIVACY ACT OF 1974 
 

 
RECD ID:   APPR 
 
SUBJECT:  Payroll Reverse Interface – Intermittent 
 
TO:    7XXINTM12 
 
Payroll reverse interface was received on the following intermittent employee(s) which updated Hours Intermittent Worked SCD and/or Days 
Intermittent Worked.  If the transaction was not from the most recent pay period, review the Official Personnel Folder  (OPF)  to determine if 
there was an impact on a personnel action.  If there was an impact, please take corrective action. 
 
       PREV 
       HRS  PREV       INTM 
NAME   PAY    WRKD    HRS DAYS      TYPE WORK 
SSAN   END    SCD WRKD PROB   DAYS    DAYS  DAYS   DAYS   DAYS  OF DAY 
ORGANIZATION  NR/DT             SCD-LV OLD SCD OLD WRKD   PROB  CAREER  VRA    WGI      EMPLMT  APPR 
 
First MI. Employee    11/17-MAY-2003    2002/08/26   146 226  0  76         76   D     76 
XXX-XX-XXXX 
7X2405252100A Main Base Support 
 
First MI. Worker    11/17-MAY-2003    2001/04/26   230    300     0       127         127   D     127 
XXX-XX-XXXX 
7X2405252100A Main Base Support 
 
 
 
 
 
 
 
 
 
 
 
 
REPORT NAME:    INTM1       1 
         

 
 



       R12                                                                             March 2012 

Payroll Reverse Interface                                                                                                                          Mod 8, Chap 4, Page 32            

Sample of Payroll Reports, Continued 

 
PERSONAL DATA  -  PRIVACY ACT OF 1974 

 
AS OF:  23 MAY 2007   

SUBJECT: Payroll Interface Update Rejects 
 
The following update(s) received through the biweekly reverse payroll interface for nonpay time, intermittent time worked, etc., has (have) 
failed the update process for the reason(s) shown below.  Please ensure that the reject is researched and resolved as soon as possible.  If the 
employee has transferred to another agency or another Human Resources Office within your agency, ensure this information is provided to the 
gaining activity so that the proper adjustments/corrections can bed made to the employee’s record.  
 
 
 
SSAN      TRANSACTION INFORMATION     PP-END-DT 
SOID    TIC EFFECTIVE-DATE PAY-OFF PAY-PRD 
 
 
XXXXXXXXX   1MY EFF-DT =  ,         PO = PE,   PP# = 11    17 MAY 2003 
7X    NON PAY HOURS:   000050 
REASON FOR REJECT:   PROCESS FAILED TO UPDATE PERSON IN HR.  ERROR IS : actual error message is displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
REPORT NAME:   UPDRJ       1 
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Sample of Payroll Reports, Continued 

 
PERSONAL DATA – PRIVACY ACT OF 1974 

AN2306BX  W2DHAA  XG12F 
             AS OF:  23-MAY-2007 
 
    SUBJECT:  Non-Pay Hours Received From Payroll 
 
     TO:     BXXNPHR22 
 
 A payroll reverse interface action was received on the following employee(s) which changed the Date the  Within  Grade Increase 
 (WGI is due.  It may also have affected WGI Pay Date.  WGI Pay Date is systematically updated 14  days prior to the Date WGI  Due.  
You must immediately review the dates in Date WGI Due and WGI Pay Date.  If the WGI is due within the next fourteen (14)  days, take 
immediate action to update WGI Pay Date to correct the effective date.  
 
NAME 
SSAN     PAY-PERIOD   DT-LAST  DT-WGI   OLD-NON  CURR-NON WGI-PAY 
ORGANIZATION  RECD ID: NR/END-DATE PP-GR-ST  EQUIV   DUE  PAY HOURS PAY HOURS  DATE 
 
First MI Last             11/17-MAY-2003 GS-05-07    20-OCT-2002    16-OCT-2005   146    154   
XXX-XX-XXXX  APPR 
ANMCW2DHAAXYNC 
 
First MI Last             11/17-MAY-2003 GS-07-06    21-APR-2002    18-APR-2004     0    160 
XXX-XX-XXXX  APPR 
ANMCW2DHAAXG12F 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
REPORT NAME:  NPHR2     BXXNPHR22         1 
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Sample of Payroll Reports, Continued 

 
 

PERSONAL DATA – PRIVACY ACT OF 1974 
AN2306BX  W2DHAA  XG12F 

AS OF:  23-MAY-2007 
 
RECD ID:   APPR 
 
SUBJECT:  Payroll Reverse Interface Separation Package Update 
 
TO:    H1XRETNT2 
 
 
A reverse interface transaction(s) has processed to update retirement package data on the following employee(s): 
 
 
NAME 
SSAN      DT-RT-PKG DT-RT-PKG DT-RT-PKG SEP-PKG  SEP-PAY 
ORGANIZATION     CIV-PAY-OPM HRO-CIV-PAY RCVD-CIVPAY REGISTER-NR OFC-NR 
 
First MI. Retiree    30-MAY-2003 25-APR-2003 27-APR-2003 0300396  97380500 
XXX-XX-XXXX 
ANMCW2DHAAXYQB 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
REPORT NAME:   RETNT        1 
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Sample of Payroll Reports, Continued 

 
AN2306BX     PERSONAL DATA - PRIVACY ACT OF 1974  
 
 
 
 
 
 
    RECD ID: APPR    
           AS OF: 14 MAY 2007                                             
    SUBJECT: Non-Pay Days SCD Rejects 
 
        TO:  BXXNPMJR2 
 
 
    A reverse payroll interface action was received on the following employee(s) which 
    rejected because the pay period ending date for Non-Pay Days SCD is in a previous 
    calendar year. Review the Official Personnel Folder (OPF) to determine the new SCD for 
    employee(s) with more than 6 months non-pay in the aggregate during the calendar year 
    and input an NOAC 882, Chg in SCD, if needed. Ensure that the Non-Pay Days SCD 
    rejected is included in your calculations. Refer to report named "NPMJY", Non-Pay Days 
    SCD Total. 
 
 
    NAME 
    SSAN                                              CURRENT         NONPAY DAYS 
    ORGANIZATION               PP-END-DT/PP#          SCD-LV          SCD REJECTED 
     
    First MI Last              30-NOV-2002/06       03-OCT-1994            001 
    XXX-XX-XXXX 
    ANMCW2DHAAXYQB 
 
 
 
 
 
 
 
    REPORT NAME: NPMJR                           1 
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Sample of Payroll Reports, Continued 

 
PERSONAL DATA – PRIVACY ACT OF 1974 

 
AN2306BX  W2DHAA  XG12F 

AS OF:  23-MAY-2007 
 
SUBJECT:  Change In Part-Time Work Hours 
TO:  H1XPTFU22 
 
 
The following employee(s) has a change in the number of hours worked.  If the effective date of 
the pay period number is other than the most recent, review the Official personnel Folder to 
determine if there is an impact.  If the number of hours worked per pay period has been different 
for the scheduled work hours contained in Hours Scheduled Week, for three consecutive pay 
periods, the Human Resources Office should process a Change in Work Hours, NOA 782, in accordance 
with the Guide to Processing Personnel Actions.   
 
NAME    
SSAN     PART-TIME HOURS WORKED  PT HRS SCH PAY PERIOD 
ORGANIZATION  RECD-ID   OCC #1 OCC #2 OCC #3  BI WEEKLY END DT/NR 
 
 
First MI Last1          APPR    1252  1138 1048     72.00 31-MAY-2003/12 
XXX-XX-XXXX 
ANMCW2DHAAXYQB 
 
First MI Last2          APPR        1268  1154 1052     56.00 31-MAY-2003/12 
XXX-XX-XXXX   
ANMCW2DHAAXG12F 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
REPORT NAME:  PTFU2   H1XPTFU22      1 
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Sample of Payroll Reports, Continued 

 
NOTE:  THIS REPORT IS APPLICABLE TO NAVY ONLY 
 
 

PERSONAL DATA – PRIVACY ACT OF 1974 
Q02416Q0     00251     003 

AS OF:  24 JUN 2007 
 
RECD ID:    APPR 
 
SUBJECT:    Payroll Org Code Updated Via Reverse Payroll Interface 
 
     TO:    QOXRPAY12 
 
 
Payroll Org Code has been updated for the following employee(s).  If the pay period ending date 
is other than the most recent, review the Official Personnel Folder to determine if there is an 
impact.  
 
 
NAME 
SSAN     PRIOR PAYROLL  CURR PAYROLL  PAYPERIOD 
ORGANIZATION      ORG CODE    ORG CODE       NO DATE 
 
First MI Last1                VVVVV     AAAAA       13     14-JUN-03 
XXX-XX-XXXX 
00251/003 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
REPORT NAME:    RPAY1                                         1 



                                                                                          R12                                                                        December 2011 

Payroll Reconciliation (RECON) Processing                                                                                                Mod 8, Chap 5, Page 1           

Module 8 

Chapter 5 

Payroll Reconciliation (RECON) Processing 

 

Chapter Overview 

  
Introduction This chapter explains the steps related to processing personnel and payroll 

reconciliation.   

    
Chapter Contents  

Topic See Page 
Chapter Overview 1 
RECON Data Extraction 3 
Population of the PAYROLL RECON Data 5 
RECON T&A Extract 5 
Processing Match Reports 6 

                 RECON Statistical Recap Report 6 
                 RECON Individual Mismatch Report 6 
                 RECON on Personnel not on Payroll 8 
                 RECON on Payroll not on Personnel 8 
                 RECON T&A Statistical Recap Report 9 
                 RECON T&A Data Mismatch Report 9 

Sample Cover Letter to Send Reconciliation Products 
to Payroll 

13 

Cover Letter for Organizational Mismatch Listing  14 
Mailing Addresses for DCPS Payroll Offices 
(Reconciliation Files Only) 

15 

RECON Schedule 16 
Sample of Reconciliation Reports 18 

 
Who Does It? 

 
Extract process requires US Federal HR Manager Responsibility.  Match 
reports may be executed by CIVDOD Personnelist or US Federal HR 
Manager Responsibilities. 
 
 

Continued on next page 
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Chapter Overview, Continued 
 

 
Before you 
Begin 

• The recurring accomplishment of reconciliation between the Defense 
Civilian Personnel Data System (DCPDS) and the Defense Civilian Pay 
System (DCPS) is essential to ensuring the accuracy of employee pay and 
benefits.  The processes used to accomplish reconciliation can also assist 
in identifying system shortfalls for both the personnel and payroll 
systems.  

• General Accounting Office (GAO) and Department of Defense Inspector 
General Office (DoD-IG) requires that this process be completed at least 
three times each calendar year for all employees. 

• Scheduling RECON with DCPS is accomplished at the Component level.   
• A schedule is published by payroll which outlines when the reconciliation 

is required to be executed for each Component (see page 16).  Contact 
Component Payroll Interface POC for schedule changes or to report 
missing payroll RECON files. 

• The following calendar provides processing timings for the reconciliation 
reports processing.   

 

 
               
            

 
Note:  DCPS (payroll) automatically produces reconciliation files as of the pay 
period ending date in the months scheduled.  Payroll files are received one to 
two weeks after the effective date of the ‘data’ snapshot.  Payroll provides an 
extract file for each combination of Submitting Office ID (SOID) and Payroll 
Office ID (POID). The personnel office must ensure that all payroll files, 
regular and alternate pay date databases, have been received before executing 
the RECON mismatch reports.  
 

SUN MON TUE WED THU FRI SAT 
      End of 

Pay 
Period 
 
HR 
Extract 
Runs 

Begin 
Pay 
Period 

   Payroll 
Files Ready 
T&A 
Extract 
Runs 
Execute 
Reports 

PAY 
DAY 

 

 Alternate 
Payroll Files 
Ready  
T&A 
Extract 
Runs 
Execute 
Reports 

  Alternate 
PAY DAY 
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RECON Data Extraction 

 
 

Purpose This procedure provides steps for the US Federal HR Manager user to create 
the extract of personnel information for the reconciliation.  It also discusses 
population of the payroll data staging table. 

    
CAUTION! 
 
 
 

It is critical to pay close attention while executing the personnel extract.  
Execution of the personnel extract replaces the prior cycle personnel table and 
clears the prior cycle payroll table, which is appropriate when starting a new 
RECON.  However, if a RECON has been initiated and the Extract process is 
executed erroneously, it wipes out all the payroll files that were sent by DFAS 
for the current RECON. Although the personnel extract will be re-created, the 
payroll file cannot be recovered.  On the last Saturday of the pay period in the 
scheduled month, the personnel office will capture personnel data by 
executing the Extract HR for Payroll RECON Report.   

 
 The extract process should be scheduled for Saturday, end of pay period, 

following completion of all suspense and futures processes for that day.  This 
schedule allows for an actual end of pay period data match with the payroll 
system data.  NOTE: The process can be set up on Friday to execute on 
Saturday. 
 

Step Action 
1 Navigation Path > Processes and Reports > Submit Processes 

and Reports <Open> 
2 Click <OK> to accept the Single Request option. 

 

 
 

 
 

Continued on next page 
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RECON Data Extraction, continued 
 

 
 

Step Action 
3 The Submit Request window opens.  With cursor in the Name data 

field, click the LOV icon to select Extract HR for Payroll 
RECON from the list. 
 

 
 

4 There are no parameters for this report.  Other than population of 
data to the HR RECON staging table, there is no output. 
Therefore, no other setup steps are required.  The process will 
include all active appropriated fund employee records paid by 
DCPS and reflect current record information as of the time of 
execution. 
 

 
 

5 In the Submit Requests window, click <Submit>. 
 
 

 



                                                                                          R12                                                                        December 2011 

Payroll Reconciliation (RECON) Processing                                                                                                Mod 8, Chap 5, Page 5           

 
Population of the PAYROLL RECON Data 
 

 
Payroll data used for the RECON process is extracted following final pay 
processing for the scheduled pay period and is usually received one to two 
weeks after the effective date of the ‘data snapshot.’  NO steps are required 
by the HR user to populate the payroll data.  The steps included in this 
section are provided for information in the event problems arise with the 
payroll RECON files being ready for use. 
 

Step Action 
1 DCPS (payroll) automatically produces reconciliation files as of 

the pay period ending date in the months scheduled.  Payroll files 
are received one to two weeks after the effective date of the ‘data’ 
snapshot.  Payroll provides an extract file for each combination of 
SOID and POID.   

2 As RECON files are received at the EXITs server, they are 
separated by region using the SOID reflected in each record.  

3 Payroll data is populated to the servicing region database by 
EXITS processes.  Each of the payroll data files are added to the 
RECON staging table as they are received.   

4 The Payroll Data table for RECON is purged when the next 
Extract HR for Payroll RECON is executed.   

5 
 

Missing payroll data files should be reported through Component 
Payroll Interface POC.  CAUTION:  Duplicate payroll files will 
load to the table resulting in double report output.  Requests for 
payroll file resend must be carefully coordinated to ensure 
duplicate files are not loaded to the DCPDS table. 

 
 
RECON T & A Extract 
 

 
• T&A data must be extracted separately from other HR data to allow for 

completion of reverse interface processing for the end of pay period being 
reconciled.   

• Execution of this process will NOT affect either the HR RECON data 
staging table or the DCPS staging table. 

• Follow the same instructions as used to create the Extract HR for Payroll 
RECON, selecting Extract T&A for Payroll RECON from the list of 
process names.  CIVDOD Personnelist or US Federal HR Manager 
responsibilities may execute this process. 
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Processing Match Reports 
 
 

 
 
 Purpose This procedure guides the user through the steps to accomplish the match 

process and produce the reconciliation reports.   
 
 
RECON 
Statistical 
Recap Report 
 
 
 
 
 
 
 
 
 
 
RECON 
Individual 
Mismatch 
Report 

______________________________________________________________                                                                                                                        

• A calendar is provided at the beginning of this chapter to aid in planning 
RECON processing schedule.  

• At the time that all payroll files should be loaded, it is recommended that 
the Statistical Recap Report be executed first to verify the presence of all 
expected HR and payroll records. 

• This report provides in-depth statistical information about the number of 
records being matched and the number of data field mismatches identified 
by the process.  The report is separated by POID and SOID.   

See Example Report PAYRE05, page 22 

  
This process matches the HR and Payroll data to identify mismatched data. 
• Some matches are done conditionally, based on a specified record 

condition or value in other data fields.  
• Two report types are generated from this process:   

− Organization Mismatch Report – identifies records that have a 
mismatch of UIC/PAS and/or Payroll Organization Code.  Any 
mismatches on either, or both of these data elements will be listed.   
 Validation of the Organizational Mismatch listing is not required.   
 Distribute this portion of the report as specified for the Individual 

Report format with the cover letter provided (see page 13).  DCPS 
payroll offices will use this listing to validate and update their 
Organization Table and correct the employee’s payroll record.   

See Example Report PAYRE04, page 21 
 

− Individual Mismatch Report – provides a single sheet for each 
employee that contains one or more mismatched data fields.  All data 
elements compared are reflected on the format.  An (*) preceding the 
data element(s) indicates a mismatch.   
 Data fields that have an obvious mismatch of data, but are not 

preceded by an asterisk (*) require no further action.  Because of 
data storage and use differences between DCPDS and DCPS, 
some fields are not being identified as mismatches and are not 
included in the reconciliation effort.  These fields will be included 
in the process at a later time and, therefore, remain on the report 
formats. 

 
Continued on Next page 
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Processing Match Reports, Continued 
 
 

 
 Personnel should determine the correct value for the mismatched 

field(s), using the appropriate source document.  If the value 
shown in the personnel record is correct, the user should, on the 
report, underline the data element name, CORRECT the data in 
RED, and annotate the EFFECTIVE DATE of the data value. The 
user should try to identify when/where the error was created 
(which transaction and when).  Supporting documentation is not 
required as the properly-annotated report format is deemed as the 
official document for making the change.  If the value shown in the 
payroll record is correct, accomplish the appropriate corrective 
action in DCPDS and annotate the report with the corrective action 
taken and the date of input in DCPDS.   

 Note:  Users should ignore the following mismatches. 
o Date of Birth mismatches if the employee record reflects a 

birth date earlier than 1915. 
o DCPS does not send the Employee Status NTE Date on the 

recon file when the teachers are in an employee status of “E” 
during the summer. 

o The Pay Table ID will mismatch if the employee’s position is 
entitled to SSR table and pay calculation routines determine 
that the locality rate is higher than the SSR rate.  The system 
will set Calculation Pay Table ID to 0000 which flows to 
DFAS. 

o Pay Plan “EX” with PRD “S” (Retained SES Benefits) – DCPS 
will reflect Grade ‘00’ when Pay Plan equals EX and PRD 
equals S and DCPDS will reflect Grade 01-05, when Pay Plan 
equals EX and PRD equals S.    

o BRAC Commission Members with Pay Plan SR – DCPS will 
reflect Pay Plan ‘AD’ and DCPDS will reflect Pay Plan ‘SR’.  

o Highly Qualified Experts (Pay Plan EE) – DCPS will reflect 
Pay Plan ‘SL’ and DCPDS will reflect Pay Plan ‘EE’.  

o SES Employees with PRD 2 – DCPS will reflect PRD ‘C’ 
when Pay Plans equal ES, IE, and FE and DCPDS will reflect 
PRD ‘2’ when Pay Plans equal ES, IE, and FE. 

   
 Payroll only needs those pages that have errors that payroll must 

correct.  Personnel should make a copy of each annotated 
individual report that payroll would need to correct and send only 
those pages to the payroll office.  It is not necessary to hold the 
entire reconciliation package until all individual records have been 
validated and annotated. For large packages, send a transmittal 
letter for the completed portion of the reconciliation reports to the 
 

 
Continued on next page 
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Processing Match Reports, Continued 
 

 
payroll office on a weekly basis. A sample cover letter is provided 
to allow for identification of transmittal number and page numbers 
(see page 13). 

 Mail the original reports to the appropriate payroll office with a 
cover letter. Mark the outside of the mailing envelope or container 
with the word “RECON” in large red letters and annotate what 
SOIDs are contained in the package.  The copy of the file sent to 
payroll should be retained and used in the comparison of the next 
reconciliation products.  Payroll addresses are annotated on page 
15.   

See Example Report PAYRE03, page 20 
 ______________________________________________________________ 

 
RECON on 
Personnel not 
on Payroll  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
RECON on 
Payroll not on 
Personnel 

• This report identifies the employee accounts that were found on DCPDS, 
but did not match an active record on DCPS. 

• The list will contain employees who were recently appointed to DCPDS 
and have not yet been established in DCPS.   

• Personnel office staff should determine if any of the records on the 
PAYRE01 list also appear on the PAYRE02 list with a mismatch of 
SSAN.  This condition can exist if a SSAN was transposed or erroneously 
keyed on input in either the personnel or payroll file.  The list should be 
annotated with the appropriate information and forwarded to the payroll 
office for their research.  If the Payroll Office ID in the record is wrong, 
immediate action must be taken to correct the error in DCPDS and the 
listing annotated to indicate the correct Payroll Office ID.  

See Example Report PAYRE01, page 18 
______________________________________________________________ 
 
• This report identifies the employee accounts that were found on the 

Payroll system, but did not match an active record on DCPDS. 
• The list will contain employees who were separated from DCPDS and 

have not yet been dropped from DCPS. 
• Personnel should determine if any of the records on the PAYRE02 list 

should be active in the personnel database or if any of the records were 
erroneously separated in personnel. It’s also possible that the records were 
coded incorrectly in either the personnel or payroll record.  The mismatch 
listing should be annotated with findings and corrective action should be 
taken if necessary in DCPDS.  The listing should then be forwarded to the 
payroll office for their research and resolution.  Please note that separated 
records may continue to show as “active” for the payroll file for a pay 
period or two because of late payments of accrued leave, awards, etc.  The 
payroll office should validate these conditions. 

See Example Report PAYRE02, page 19  
 

 
Continued on next page 



                                                                                          R12                                                                        December 2011 

Payroll Reconciliation (RECON) Processing                                                                                                Mod 8, Chap 5, Page 9           

Processing Match Reports, Continued 

 
 

 
RECON T&A 
Statistical 
Recap Report 
 
 
RECON T&A 
Data Mismatch 
Report 
 
 

A statistical array of T&A data mismatches  
Example Report Not Available 
 
______________________________________________________________ 
 
The report identifies mismatches between HR and DCPS for data that is 
updated through reverse interface, i.e. Non-Pay Hours, Non-Pay Days, 
Intermittent Day and Hours.   
Example Report Not Available 
 

 
 

Step Action 
1 Navigation Path > Processes and Reports > Submit Processes 

and Reports > <Open> 
2 The Submit a New Request window opens, click <OK> to accept 

the Single Request option. 

 
3 When the Submit Request window opens, click LOV icon in the 

Name data field to invoke the Reports List. 

 
 
 
 

Continued on next page 



                                                                                          R12                                                                        December 2011 

Payroll Reconciliation (RECON) Processing                                                                                                Mod 8, Chap 5, Page 10           

 
Processing Match Reports, Continued 
 
 

 
Step Action 

4 Select the specified report and click <OK>. 

 
5 The Parameters window will automatically open. RECON may be 

limited to specific agency code or SOID by input of the 
appropriate value(s).  To run the entire instance, leave the data 
fields blank and click <OK>. 
 

 
 

6 Under Upon Completion, click on <Options>. 
 

 
 
 

Continued on Next page 
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Processing Match Reports, Continued 

 
 

 
Step Action 

7 
 
 
 
 
 
 
 
 

In the Print the Output To: specify the number of copies desired 
and select printer and click <OK>. 
                       OR 
Change the number of copies to zero and delete the printer name 
in the data field and click <OK>. 
This stops the printing of the report and allows it to be opened in 
Word. 
 
CAUTION:  The Word format of the RECON products requires a 
great deal of editing and reformatting.  This option is not 
recommended for other than the initial look at the statistical data. 
 

 
 

 
 
 
 
 

Continued on Next page 
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Processing Match Reports, Continued 
 

 
 

Step Action 
8 Click <Submit>.  Report prints or allows it to be opened in Word. 

 

 
 

 
 
 
 
Example 
Reports 

 
 
______________________________________________________________ 
 
• Example Reports begin on page 18. 
• Following are illustrations of the RECON Reports as they appear when 

printed by the process.   
• One additional view of the Individual Mismatch Report is provided to 

display the report as it appears in Word format.  Changes were made to 
this copy only to allow proper fit on the display page. 
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Sample Cover Letter to Send Reconciliation Products to Payroll 
 
 
MEMORANDUM FOR CIVILIAN PAYROLL OFFICE, DEFENSE FINANCE AND 
ACCOUNTING  
SERVICE, DENVER, CO 
 
SUBJECT:  DCPS/DCPDS Reconciliation 
 
     The recurring accomplishment of reconciliation between the Defense Civilian Personnel Data 
System (DCPDS) and the Defense Civilian Pay System (DCPS) is essential to ensuring the 
accuracy of employee pay and benefits participation.  The processes used to accomplish 
reconciliation can also assist in the identification of system shortfalls for both the personnel and 
payroll systems.  Enclosed are the output products from the DCPS/DCPDS Reconciliation that 
require attention by the payroll office staff. 
 
     Mismatched data fields are identified on the individual report products by an asterisk 
preceding the data name.  The appropriate values for each of the fields mismatched have been 
validated with the original source document, maintained in the employee Official Personnel 
Folder, by the personnel office staff.  Those values that were found to be erroneous in the 
personnel data system have been corrected as indicated by the annotations on the product. 
 
     It is the responsibility of the payroll office to correct those data field values that are erroneous 
in the payroll system.  The data fields requiring payroll office action have been underlined in red 
for easy identification.  Unless otherwise annotated, the value that is reflected in the "DCPDS 
VALUE" column is the correct value for the field. The annotated individual report product is the 
official source document to accomplish the changes in the payroll system.  It is not necessary to 
return the individual employee prints to the personnel office upon completion; however, the 
Time and Attendance Mismatch list must be annotated to reflect the correct values for each 
record and returned to the personnel office as soon as possible for corrective action required by 
personnel office staff.  It is essential that Time and Attendance related data be corrected before 
the next pay calculation cycle. 
 
     The Civilian Personnel Office point of contact for reconciliation is ***INSERT NAME, 
MAILING ADDRESS, DSN PHONE #, AND DSN FAX #.*** 
 
 (     This is a partial transmittal of reconciliation products. 
 (     This is the final transmittal of partial packages 
 (     This is a complete package transmittal 
  
MEMORANDUM SHOULD BE SIGNED BY COMPONENT PERSONNEL OFFICER OR 
DELEGATED REPRESENTATIVE 
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Cover Letter for Organizational Mismatch Listing  
 
 
 
MEMORANDUM FOR CIVILAN PAYROLL OFFICE, DEFENSE FINANCE AND 
ACCOUNTING SERVICE, DENVER, CO 
 
SUBJECT:  DCPS/DCPDS Reconciliation, Organizational Data Mismatches 
 
The attached listing contains employee records that were identified as having a mismatch of 
organizational data between the Defense Civilian Personnel Data System (DCPDS) and the 
Defense Civilian Payroll System (DCPS).  There were no other data fields mismatched for these 
employees during the current reconciliation process. To expedite these differences, we have 
provided a separate listing for records that fall in this category broken out by organization to aid 
in appropriate distribution within the payroll office.   
 
Please take immediate action to ensure the organizational data is recognized by DCPS tables and 
the employee’s payroll records are updated with the values reflected in the personnel records.  As 
part of the mandated reconciliation process, please provide notification to the submitting 
personnel office when updates have been completed.   
 
The Civilian Personnel Office point of contact for reconciliation is  
***INSERT NAME, MAILING ADDRESS, DSN PHONE#, AND DSN FAX####.  
MEMO SHOULD BE SIGNED BY COMPONENT PERSONNEL DIRECTOR 
 



                                                                                          R12                                                                        December 2011 

Payroll Reconciliation (RECON) Processing                                                                                                Mod 8, Chap 5, Page 15           

Mailing Addresses for DCPS Payroll Offices (Reconciliation Files Only) 
 

CLEVELAND OFFICE   
 
DFAS Cleveland 
Attn:  Gordon Green 
1240 E 9th Street - Code JFVAA 
Cleveland, OH  44199  
 

DCPDS 
POID 

DCPS 
Database ID 

 
Location/Database Type 

CY ZL0 Navy Shipyard 
CH ZGT Navy 
IB ZPB BBG 

N/A ZPH HHS 
N/A ZPD DOE 

 
************************************************************ 
INDIANAPOLIS OFFICE 
 
DFAS JFV/IN 
CivPay – 6200 (Recons) 
Attn: Toni Gooding 
8899 East 56th Street 
Indianapolis IN 46249-6200 

  
DCPDS 
POID 

DCPS 
Database ID 

 
Location/Database Type 

OA OMA Army 
DE CP1 Air Force 
PE ZKA DoD 
RE ZKE EOP 
FA ZFA Army Overseas 
FF ZFR Overseas Regular 

N/A ZPA EPA 
N/A ZPV VA 

 
************************************************************ 
 
INDIANAPOLIS OFFICE 
 
DFAS JFV/IN 
CivPay – 6200 (Recons) 
Attn: Toni Gooding 
8899 East 56th Street 
Indianapolis IN 46249-6200 
          
************************************************************ 
 

 IMAGING NUMBER  
 (866) 401-5849 
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RECON Schedule 
 
MEMORANDUM TO DCPS OPERATIONS 
 
FROM:  DFAS-HTSBAB/PE 
 
SUBJ:  PAYROLL/PERSONNEL RECONCILIATION (2008 - ANNUAL) 
 
 The following schedule of when the Payroll/Personnel Reconciliation (NR2D0) is 
required to be executed for each Servicing Agency/CCPO-ID is provided.  The execution of this 
job should be accomplished during the specified pay periods once NB060 has been executed.  
The Servicing Agency/CCPO-ID selection criteria should be executed against each DCPS 
database to ensure an employee coded with an erroneous value is identified for correction. 
 
MONTH PAY PERIOD SERVICING AGENCY/CCPO-ID 

 
January First PPE Date (01-05-2008) DN/**, EP/**, IB/**, VA/**, 11/** 
January First Full Second PPE Date (01-19-2008) DN/**, EP/**, VA/**, 16/** 
February First PPE Date (02-02-2008) AF/**, AR/**, DN/**, EP/**, IB/**, 

NV/**, RE/**, VA/**, 07/**, 11/**, 
34/** 

February First Full Second PPE Date (02-16-2008) DD/DG, DD/DI, DD/DK, DN/**, 
EP/**, NG/**, VA/**, 04/**, 10/**, 
12/**, 35/**, 61/** 

March First PPE Date (03-01-2008) AF/**, AR/**, DN/**, EP/**, VA/**, 
11/** 

March First Full Second PPE Date (03-15-2008) DN/**, EP/**, VA/** 
March Third PPE Date (03-29-2008) AF/**, AR/**, DN/**, EP/**, HE/**, 

VA/**, 11/** 
April First Full First PPE Date (04-12-2008) DN/**, EP/**, NG/**, VA/** 
April Second PPE Date (04-26-2008) DN/**, EP/**, VA/** 
May First PPE Date (05-10-2008) AR/**, DN/**, EP/**, IB/**, RE/**, 

VA/**, 11/** 
May First Full Second PPE Date (05-24-2008) DN/**, EP/**, VA/** 
June First PPE Date (06-07-2008) AF/**, AR/**, DD/DG, DD/DI, 

DD/DK, DN/**, EP/**, VA/**, 07/**, 
11/**, 12/**, 34/**, 61/** 

June First Full Second PPE Date (06-21-2008) DN/**, EP/**, NG/**, VA/**, 04/**, 
10/**, 16/**, 35/** 

July First PPE Date (07-05-2008) AF/**, AR/**, DN/**, EP/**, VA/**, 
11/** 

July First Full Second PPE Date (07-19-2008) DN/**, EP/**, HE/**, VA/** 
August First PPE Date (08-02-2008) AF/**, AR**, DN/**, EP/**, IB/**, 

NV/**, VA/**, 11/** 
August First Full Second PPE Date (08-16-2008) DN/**, EP/**, NG/**, RE/**, VA/** 
August Third PPE Date (08-30-2008) DN/**, EP/**, VA/** 
September First PPE Date (09-13-2008) AR/**, DN/**, EP/**, VA/**, 11/** 
September First Full Second PPE Date (09-27-2008) DN/**, EP/**, VA/**, 16/** 
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MONTH PAY PERIOD SERVICING AGENCY/CCPO-ID 

 
October First PPE Date (10-11-2008) AF/**, AR/**, DD/DG, DD/DI, 

DD/DK, DN/**, EP/**, VA/**, 07/**, 
11/**, 12/**, 34/**, 61/** 

October First Full Second PPE Date (10-25-2008) DN/**, EP/**, NG/**, VA/**, 04/**, 
10/**, 35/** 

November First PPE Date (11-08-2008) AF/**, DN/**, EP/**, IB/**, NV/**, 
VA/**, 11/** 

November First Full Second PPE Date (11-22-2008) AR/**, DN/**, EP/**, HE/**, RE/**, 
VA/** 

December First PPE Date (12-06-2008) AF/**, AR/**, DN/**, EP/**, VA/**, 
11/** 

December First Full Second PPE Date (12-20-2008) DN/**, EP/**, NG/**, VA/** 
 
LEGEND:   
04/**     DISA (Serviced by DFAS) 
07/**    DLA 
10/**    DCAA (Serviced by DFAS) 
11/**     NGA (Formerly NIMA)  
12/**    DSS (Serviced by WHS) 
16/**     DODEA (Serviced by DLA) 
34/**    DECA (Serviced by DLA) 
35/**    DFAS (Including DODIG, NDU, DTIC) 
61/**    DTRA (Serviced by WHS) 
AF/**     AIR FORCE 
AR/**    ARMY 
DD/DG, DI, DK  WHS (Serviced by DLA) 
DN/**    DOE 
EP/**    EPA 
HE/**    HHS 
IB/**    BBG 
NG/**    NATIONAL GUARD 
NV/**     NAVY (including USUHS) 
RE/**    EOP  
VA/**    VA 
 
** All CCPO-IDs 
 
NOTES:  Do not run the recon for DD/**. 
 
WHS is the recon point of contact for WHS, DSS, and DTRA. 
 
A DCPS Action Request (DAR) should be submitted to request one-time changes using the drop-
down title “REQUESTING RECONS”. 
 
Permanent changes to this schedule should be coordinated through this office by submitting a 
DAR using the drop-down title “PERSONNEL ISSUES”. 
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Sample of Reconciliation Reports 

 
 
 
 
PERSONAL DATA – PRIVACY ACT OF 1974 

 
AS OF:   02 NOV 2006 

 
SOID:  H2  POI:    1932 
 
       Extract As Of Dates: 
       Payroll:   01-NOV-2006 
       Personnel:   28-OCT-2006 
 
 
As a result of the data reconciliation, some records were found in one system but not 
the other.  Please review the following and determine what action, if any, should be 
taken.  If action is required by Payroll, immediately annotate and forward this 
listing to the appropriate pay center.  
 
Part I – On Personnel/not on Payroll 
 
 
          LAST ACTION    DT-TRANS PAYROLL  
NAME       SSAN  INPUT  INPUT  OFF-ID 
 
EMPLOYEE, FIRST NAME Z   XXXXXXXXX   894  20-AUG-06 PE 
LAST NAME, FIRST NAME T   XXXXXXXXX   100  03-SEP-06 PE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
REPORT NAME:   PAYRE01   1 
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Sample of Reconciliation Reports, continued 

 
 

 
PERSONAL DATA – PRIVACY ACT OF 1974 

 
AS OF:   02 NOV 2006 

 
SOID:  H2  POI:    1932 
 
       Extract As Of Dates: 
       Payroll:   01-NOV-2006 
       Personnel:   28-NOV-2006 
 
 
As a result of the data reconciliation, some records were found in one system but not 
the other.  Please review the following and determine what action, if any, should be 
taken.  If action is required by Payroll, immediately annotate and forward this 
listing to the appropriate pay center.  
 
Part II – On Payroll/not on Personnel  
 
 
          PAYROLL  
NAME        SSAN    OFF-ID 
 
EMPLOYEE, FIRST NAME S    XXXXXXXXX    PE 
LAST NAME, FIRST NAME T    XXXXXXXXX    PE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
REPORT NAME:   PAYRE02   1 
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Sample of Reconciliation Reports, continued 
 

PERSONAL DATA - PRIVACY ACT OF 1974 
                                   CIVILAN PERSONNEL/PAYROLL RECONCILIATION INDIVIDUAL REPORT  As of:  26 Feb 2008 
 
A comparison between the payroll and personnel files was made on the following employee. As a result of data reconciliation, some data 
element inconsistencies were identified between the Personnel/Payroll files. These inconsistencies are identified by a "*" in front of 
the data element. Please review the following personnel data against the Official Personnel Folder or the appropriate source document(s). 
If personnel data is in error, please take immediate corrective action. If DCPS is in error, annotate the listing with as much relevant 
information as possible (Ex: NOAC and effective date of change) and send this listing to the servicing payroll center by the most 
expeditious method for corrective action. 
 
    NAME:                                SSAN:                   CPDF SSAN: 
    SOID:  VO                        PAS/UIC: W6D5AA                       PAYROLL OFFICE ID: IB 
    LAST TRANS/EFF_DATE:  894/24-AUG-2006      PERSONNEL EXTRACT DATE: 16-MAY-2007     PAYROLL EXTRACT DATE:  15-NOV-2006 
 
      DATA ELEMENT        DCPDS VALUE       PAYROLL VALUE        DATA ELEMENT            DCPDS VALUE       PAYROLL VALUE 
 
      AGENCY CODE         IB                IB                   NAF RET IND             0                 0 
      PERS OFC ID         4452              4452                 DT LAST EQUIV           24-AUG-2006       21-MAR-2004 
    * PAS/UIC             W6D5AA            062478               CURR APPT AUTH-1        QWM               AYM 
    * ORG STRUCT          SWA2              W645                 CURR APPT AUTH-2        ZLM 
    * GSA GEOLOC          201826061         152400003          * TSP STAT CD             Y                 E 
      WORK SCHED          F                 F                    TSP STAT DT             01-JUL-2001       17-JAN-1999 
      PART TIME IND                                              TSP VEST SCD            25-SEP-2000 
      HOURS SCHED         40                40                   TSP RATE                11                00 
      PREM PAY IND                                               TSP AMOUNT              0000              0000 
      FLSA                E                 E                    AGGREGATE LIMIT IDC 
    * OCC SERIES          0201              0028               * OVERTIME COMP IDC       N 
    * PAY PLAN            YA                GS                   PREMIUM PAY LIMIT IDC 
    * GRADE               02                11                   TSP - ELIG DT           01-JUL-2001 
    * STEP                00                07                   PROB PERIOD END 
      PAY BASIS           PA                PA                   RTND PAY PLAN 
      PAY TABLE ID        0000              0000                 RTND GRADE 
      LOCALITY PCT        0000              0000                 RTND STEP 
      LEO IND             0                 0                    RTND PAY TBL ID                           0000 
      PAY RATE DETERM     0                 0                    RTND LOCALITY PCT       0000              0000 
    * BASIC SALARY        05149900          05542900             RTND GRADE EXP 
    * LOCALITY ADJ        06448             00000                APPOINTMENT EXP 
      SUPV DIFF           00000             00000                PROMOTION EXP 
      RETEN ALLOW         00000             00000                POSN CHANGE EXP 
      DUTY STAT           00                                     REASSIGNMENT EXP 
    * DOB                 18-MAR-1955       18-AUG-1953          DETAIL EXP 
      CITIZENSHIP         1                 1                    NON-PAY EXP 
    * SCD-LEAVE           13-MAY-2000       22-FEB-1972        * RESERVE CAT             2                 Y 
      FEGLI               Z5                Z5                 * ARMY CIVILIAN TYPE      101 
    * RETMNT CODE         K                 1                    PAY BLOCK NUMBER                          350 
    * ANNUITANT IND       3                 9                  * RECON NAME              HAKANSON          DEMELLO 
    * FEHB PLANS          ZZ                63                   ACCRUAL RATE 
    * FEHB STAT           Y                 2                  * SCD RET                 25-SEP-2000       22-FEB-1972 
      FEHB TEMP IND                                              BRAC IDC 
 
 
 
       REPORT NAME: PAYRE03                                PAGE 1  
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Sample of Reconciliation Reports, continued 

 
 
 

PERSONNEL DATA – PRIVACY ACT OF 1974 
 

AS OF:   02 NOV 2006 
 

               PAY BLOCK:   14 
 
Provide this listing to the appropriate DCPS Payroll office for action.  DCPS organization table may require update  
before records can be corrected.  
 
             PAS/UIC  PAS/UIC     ORG-STR  ORG-   
NAME      SSAN  PERS  PAYROLL PERS  PAYROLL SOID POID 
EMPLOYEE, FIRST NAME S    XXXXXXXXX Z69482  0A7003  ZBZB  ZBZB  H1 PE 
LAST NAME, FIRST NAME T   XXXXXXXXX 0A7773  0A4705  70AQ  ZAZAB  H1 PE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
REPORT NAME:  PAYRE04       PAGE 1 
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Sample of Reconciliation Reports, continued 
PERSONAL DATA - PRIVACY ACT OF 1974 

 Prepared 26 February 2008                                                                         As Of:   26 FEB 2008 
                                  H R O    R E C O N C I L I A T I O N    R E C A P    R E P O R T 
 
 
    SOID:    VO                    POI: 4452                 PAY OFFICE: IB               DATE OF MATCH:  26 FEB 2008 
 
    Extract As of Dates: 
    DCPDS:   16 MAY 2007 
    PAY OFFICE: 15 NOV 2006 
    Total Personnel Records:  50               Total Number of Matched Records:   2 
    Total Payroll Records:    2 
    Total Number of Data Differences Found: 39 
 
    SSAN On Pay /Not On Pers: 0                               SSAN on Pers/Not on Pay:    48 
 
    DATA ELEMENT                 ERRORS                        DATA ELEMENT                         ERRORS 
 
    Agency Code                    0                           DOB                                    2 
    Pers Off Id                    0                           Citizenship                            0 
    PAS/UIC                        2                           SCD Leave                              2 
    Org Struct                     2                           FEGLI                                  0 
    GSA Geoloc                     2                           Retmnt Cod                             1 
    Work Sched                     0                           Annuint Ind                            1 
    Part Time Ind                  0                           FEHB Plan                              2 
    Hours Sched                    0                           FEHB Status                            2 
    Prem Pay Ind                   0                           FEHB Temp Ind                          0 
    Flsa                           0                           NAF Ret Ind                            0 
    Occ Series                     2                           Dt Last Equiv                          0 
    Pay Plan                       2                           Curr Appt Auth-1                       0 
    Grade                          2                           Curr Appt Auth-2                       0 
    Step                           2                           TSP Stat Cd                            2 
    Pay Basis                      0                           TSP Stat Dt                            0 
    Pay Table Id                   0                           TSP Vest Scd                           0 
    Locality Pct                   0                           TSP Rate                               0 
    LEO Ind                        0                           TSP Amount                             0 
    Pay Rate Det                   0                           Aggregate Limit                        0 
    Basic Salary                   2                           Overtime Comp I                        2 
    Locality Adj                   2                           Premium Pay Limit Id                   0 
    Supv Diff                      0                           TSP Elig Dt                            0 
    Retention Allow                0                           Prob Period End                        0 
    Duty Stat                      0                           Name                                   2 
    Rtnd Pay Plan                  0                           Appointment Exp                        0 
    Rtnd Grade                     0                           Promotion Exp                          0 
    Rtnd Step                      0                           Posn Change Exp                        0 
    Rtnd Pay Table Id              0                           Reassignment Exp                       0 
    Rtnd Locality Pc               0                           Details Exp                            0 
    Rtnd Grade Exp                 0                           Non-Pay Exp                            0 
    BRAC ID                        0                           Reserve Cat                            1 
                                                               Army Civilian Type                     2 
                                                               Accrual Rate                           0 
                                                            SCD Ret                                2 
 
REPORT NAME:  PAYREO5    PAGE 1 
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Module 8 

Chapter 6 

Foreign Allowances and Non-Foreign Entitlements 

 
Chapter Overview 

   
Introduction This chapter provides guidance for authorizing specific foreign allowances and 

entitlements in DCPDS to flow via the automated interface to DCPS to ensure 
accurate and consistent maintenance of allowance and entitlement data across the 
Department of Defense (DoD). 

   
CAUTION 
 
 
 

The documentation and information provided here does not constitute policy nor 
does it relieve the user of responsibility to obtain current authorization 
information from the Department of State Standardized Regulation (DSSR), 
DoD instructions and guidance, or agency policy determinations.  As necessary, 
information is quoted from the DSSR to clarify the intent of a given data field or 
input value.  The quotations are affected by changes to the DSSR, but may not 
be immediately updated in this document. 

   
Chapter Contents 
 

Topic See Page 
Chapter Overview 1 
General Processing Information for Foreign Allowances and 
Entitlements 

4 

Foreign/Overseas Allowances 8 
Civ Living Quarters Allowance (LQA) 8 
Post Allowance 11 
Danger Pay 12 
Imminent Danger Pay (IDP) 13 
Separate Maintenance Allowance (SMA) 
(Voluntary) 

14 

Separate Maintenance Allowance (SMA) 
(Involuntary) 

15 

Post Differential (PDF) 16 
 

Continued on next page 
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Chapter Overview, Continued 

   
Topic See Page 

Home Leave (HML) 17 
Foreign Transfer Allowance (FTA) 18 

Special Processing for Foreign Allowances 22 
Payroll Interface Specifications for Foreign Allowances 23 

Non-Foreign Entitlements 26 
Creating an Authorization 26 
Correcting an Existing Authorization 30 
Modifying an Existing Authorization 31 
Terminating an Existing Authorization 32 
Creating or Correcting a Historical Entitlement 
Entry 

34 

Payroll Interface Specifications for Entitlements 35 
Automated LQA Reconciliation Process 36 

Situation 1 38 
Situation 2 39 
Situation 3 41 
Situation 4 44 
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Chapter Overview, Continued 

   
Before You 
Begin 

• Not all foreign allowance types are supported by DCPDS and DCPS 
interface processing.  Authorized allowances not included in this chapter are 
manually entered into the payroll system from the completed Foreign 
Allowances Application, Grant and Report, SF-1190, and appropriate 
worksheets.  The following payment types must be submitted via FAX to the 
appropriate payroll center. 

 
 Temporary Quarters Subsistence Allowance (TQSA) 
 Advance of TQSA 
 Advance of FTA 
 Advance of Living Quarters Allowance (LQA) 
 Transitional Separate Maintenance Allowance (TSMA) 

 
• Entitlements processes allow for authorizations of additional pay 

entitlements that are not reflected on the Notification of Personnel Action, 
SF-50, or through foreign allowances processes.  Some of the special pay 
types are authorized based on the location of the assignment while others are 
related to the type of work the employee does.  Most of the entitlements are 
documented in 5 CFR 591 and should not be confused with those authorized 
by the Department of State Standardized Regulation (DSSR). 

 
• New processes may be defined for inclusion in the automated interface 

process only after coordination between DCPAS functional requirements 
staff, and Defense Finance and Accounting Service (DFAS), Systems 
Management Division (SMD) to ensure methods, values, and results are 
appropriate for system compatibility.  This essential coordination is also 
required for temporary workaround processes that may be required because 
of unique record conditions or system functionality interruptions. 

 
• New procedures have been implemented for foreign allowance authorizations 

resulting from TDY events after completion of the TDY period.  Payroll 
centers have provided a new Remedy form to be used specifically for 
authorizing TDY Danger Pay and Post Differential beginning and end dates 
AFTER the employee returns from TDY.  HR members with DFAS Remedy 
access will enter the information on the form and submit it to the payroll 
center for payment.  The transactions will not be recorded in DCPDS, but the 
authorizing SFs-1190 must be maintained as usual.  Waiting to authorize the 
payments after return from TDY is not policy and agencies may elect to 
process the actions at the beginning of the TDY period.  Authorizations that 
are to be paid during the period of TDY must be entered in DCPDS as 
 
 
 

Continued on next page 
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Chapter Overview, Continued 
 

 
 
Before You Begin (Continued) 
 

instructed in this document.  Ensuring that the authorizations are terminated at the 
end of the TDY period is the responsibility of the servicing HR.  Processing must 
be completed in a timely manner to prevent overpayment to the employee 
resulting in a debt to the Component or Agency. 

 
 
See Also 
    
 

Department of State Standard Regulation (DSSR) at http://aoprals.state.gov/ 

 
General Processing Information for Foreign Allowances and Non-Foreign 
Entitlements 

• The effective date of the authorization is set by date tracking to the 
appropriate effective date before beginning the update process.  The 
authorization effective date will be reflected under the Effective Dates From 
column of the entry as shown in the examples that follow.  For further 
information about date tracking, please refer to the Defense Civilian Personnel 
Data System User Guide, Module 1, Chapter 4. 

 
• DCPS does not send a reverse interface transaction to DCPDS to delete 

certain entitlements when Department of State changes the authorized 
percentages to zero.  HR will need to manually terminate Post Differential 
and Danger Pay on each affected employee when authorized percentage is 
changed to zero by Department of State.   

 
• Entry of a Foreign Allowance authorization that resides in the payroll record, 

but NOT DCPDS will require careful coordination with the payroll office.  
The capability to update DCPDS without payroll interface of the information 
is not available.  User must determine the start date of the entitlement in the 
payroll system and the location code that applies.  Date track to the payroll 
system entry start date and enter the allowance as usual.  A Pay500 will be 
produced with NOA 5EN.  If subsequent modifications or termination of the 
authorized allowance is needed, process the follow-on actions in the order of 
their occurrence, date tracking to control the effective dates.   

 
Continued on next page 
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General Processing Information for Foreign Allowances and Non-Foreign 
Entitlements, Continued 
 

 
• There are instances when user must manually terminate and end-date Foreign 

Allowance authorizations and the elements that store them.  The following 
scenarios and procedures are provided for clarification of the required 
processing steps.   

 
 DCPDS automated processes provide for transfer of records between DoD 

agencies as well as change in appointing office (CAO) transactions and 
include the movement of employee information.  The gaining HRO must 
carefully check to ensure previous authorizations are end-dated in the 
person’s assignment entries following completion of the personnel action that 
accomplished the assignment change.  If the entry continues, user must 
terminate the authorization through the update and end-date of the element.  
User must date-track to the appropriate effective date, change the Last Action  
Code to “Terminate”, save and the entry, and then immediately click the 
Red-X to end-date the element. 

 
 Payroll will continue to automatically terminate allowance payments based 

upon specific auto-delete logic for each entitlement type when changes are 
made to the personnel data that will make the employee ineligible for the 
entitlement.  For example, HR processes a personnel transaction (e.g. 
Promotion) on an individual receiving COLA that moves the employee to 
San Diego, California.  When payroll receives the NOA transaction, based on 
auto-delete logic for COLA, they will automatically terminate the COLA 
payment (to prevent an overpayment), even though HR has not yet 
terminated COLA in DCPDS.   

 
 In some cases, it will be necessary to terminate the entitlement prior to the 

actual departure date.  The appropriate effective date for earlier termination 
of the authorization must reflect the day following the day the payment is to 
be stopped.  For example: employee is returning to CONUS but moves from 
permanent to temporary living quarters a month before the actual departure 
from country.  If the payment is to be made through 10 July, the termination 
action processed should reflect an effective date of 11 July.  This will ensure 
the employee receives the proper allowance amounts for 10 July.  The 
procedures reflected above for terminating and end dating the authorization 
and element should be followed in this scenario as well.   

 
 

 
Continued on next page 
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General Processing Information for Foreign Allowances and Non-Foreign 
Entitlements, Continued 
 

 
 

Step Action 
1 Navigation Path: People/Enter and Maintain  Assignment  

Entries  
2 Navigate to the entries screen and place cursor in the first available 

Element Name Field.  If no field is available, add a new field by placing 
cursor on any existing field and clicking the green plus button. 

 
 

Or             
3 Click on LOV and select Element Name to be processed (i.e., 

LQA, Home Leave, Hazard Pay, Entitlement, etc.). 
 

 
 

Continued on next page 
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General Processing Information for Foreign Allowances and Non-Foreign 
Entitlements, Continued 
 

 
 

Step Action 
4 A separate element is provided for each type of allowance or 

entitlement supported by automated interface processes.   
Historical allowance authorization information is viewable through 
the DCPDS date-track feature.  Allowances and entitlements are 
identified in DCPDS as “Recurring” or “Non-Recurring”.  The 
screen also reflects the pay period dates based on the date to which 
the system is date tracked.  The user may view the entries by 
Processing Types, selecting Recurring, Nonrecurring, or Both.  

 

 
 

  
 



                                                                   R12  December 2011 

Foreign Allowances and Non-Foreign Entitlements                                                                           Module 8, Chapter 6, Page 8 

Foreign/Overseas Allowances 
 

 
 

  Civ Living Quarters Allowance (LQA)  
"A quarters allowance granted to an employee for the annual cost 
of suitable, adequate, living quarters for the employee and his/her 
family.” 
 
• With the Element entry highlighted, click <Entry Values> to 

open the window for data entry.   
 

 
 
 

• A brief description of each data field and specific instructions 
as to value input or intent is provided. 

 
DATA NAME DEFINITION 
Purchase 
Amount 

Records the purchase price of home.  Amount recorded 
in US dollars converted from the foreign amount by 
the conversion rate in effect on the date of purchase; 
spaces if not applicable. DO NOT REDUCE FOR CO-
OWNED QUARTERS - DCPS WILL COMPUTE 
SHARED AMOUNT.  Input whole currency amount 
only, no decimal numbers. 

Purchase Date Date 10-year period for purchased quarters begins.  
DD-MMM-YYYY 

 
 

 
Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
  

DATA NAME DEFINITION 
Rent Amount Rental amount authorized.  Amount reflects the total 

authorization for one year. Rent is to be computed for a 
12-month period, multiply the monthly rate by 12, and 
entered as an annual amount regardless of the term of 
lease. Enter foreign currency amount; LEAVE 
BLANK if not applicable.  (See Note 1 for further 
guidance.)  DO NOT REDUCE FOR SHARED 
QUARTERS - DCPS WILL COMPUTE SHARED 
AMOUNT.  Input whole currency amount only, no 
decimal numbers.  (See Note 2 Below for DSSR 
Definition of “RENT”)  

Utility Amount Total authorized for all utilities for one year.  Enter 
foreign currency amount. DO NOT REDUCE FOR 
SHARED QUARTERS - DCPS WILL COMPUTE 
SHARED AMOUNT.  Input whole currency amounts 
only, no decimal numbers.   If no utility amount is 
requested, the field must be updated with zeroes. 

Last Action 
Code 

Values and uses are described in Special Processing 
for Foreign Allowances section listed below.  LOV is 
attached to the field. 

Location Post location as defined in DSSR Section 920.  LOV is 
attached to the field. 

Quarters Type Quarters owned, co-owned, rented, or shared.  LOV is 
attached to the field. 

Shared Percent Percentage of rent/utilities paid by the employee in 
shared quarters.   No value need be entered if the 
quarters are not shared. 

Num Family 
Members 

Number of family members included in the 
authorization.  This entry does not include the 
employee.  May be 00 if appropriate. 

Summer 
Recess Ind 

FOR DoDEA USE ONLY:  Specifies whether LQA 
payments do or do not continue during summer recess 
period.  LOV is attached to the field. 

Quarters Group Identifies the quarters group for LQA defined by 
Department of State.  LOV is attached to the field. 

Rent Currency Type of currency recorded in RENT AMOUNT field; 
spaces if not applicable.  LOV is attached to the field. 

Utility 
Currency 

Type of currency recorded in UTILITY AMOUNT; 
spaces if not applicable.  LOV is attached to the field. 

Purchase 
Currency 

Type of currency recorded in PURCHASE AMOUNT 
field; spaces if not applicable.  DSSR requires 
Purchase amount to be recorded in US Dollars.  LOV 
is attached to the field. 

 

 
 

Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
 

 
 
 
 
 

 

Note 1:  Annual rental amount authorized must be recorded to 
this field whether or not the amount has been paid to the 
employee in advance.  DCPS will determine the pay period 
advance reimbursement amount based on the annual authorized 
amount.  
 
Note 2:  Extract from DSSR Definition of “RENT”:  “When 
approved by the head of agency as necessary to provide such 
living quarters, rent may include in addition to the basic annual 
rental, the cost of:  (1) rental of garage space for one car only for 
each employee, at not to exceed 25 percent of the employee’s 
applicable maximum annual quarters allowance rate, regardless of 
whether such space is included with the quarters; (2) separate 
rental of necessary furniture at not-to-exceed 25 percent of the 
applicable maximum annual quarters allowance rate, meaning 
rental of necessary basic furniture and/or equipment, etc., but 
exclusive of pianos, other musical instruments, radios, television 
sets, etc. from source other than the landlord (rental of furniture 
and/or space from the same source under two agreements or 
contracts is considered to be rental of “furnished quarters”);  (3) 
insurance on the property and/or furnishings so rented, if such 
insurance is required by local law to be paid by the lessee; (4) 
agent’s fee with authorizing officer certifying that fee is 
customary, reasonable, and legal under local law; (5) interest on a 
loan from an American institution to finance “key money” paid to 
a landlord; (6) garbage and trash disposal; and (7) mandatory as 
opposed to optional fees required for maintenance of common 
areas (“condominium fees”).”   Based on this definition, annual 
amounts for these rentals/fees should be included in the LQA-
AMT-RENT field.  If one-time payments are appropriate, the 
payment will be made from the SF-1190 with no entry into 
DCPDS. 
 

 
Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
 

 Post Allowance   
“A cost-of-living allowance granted to an employee officially 
stationed at a post in a foreign area where the cost of living, 
exclusive of quarters costs, is substantially higher than in 
Washington, D.C.” 
 

 

 
 

  
• A brief description of each data field and specific instructions 

as to value input or intent is provided. 
 

DATA NAME DEFINITION 
Amount THIS FIELD MUST BE LEFT BLANK ON ALL 

ACTIONS.  FIELD IS NOT USED BY DCPDS. 
Last Action 
Code 

Values and uses are described in Special Processing 
for Foreign Allowances section listed below.  LOV is 
attached to the field. 

Location Post location as defined in DSSR Section 920.  LOV is 
attached to the field. 

Num Family 
Members 

Number of family members included in the 
authorization.  This figure includes the employee and 
must be at least equal 01. 

 

 
 

Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Danger Pay   
“The additional compensation of up to 35 percent over basic 
compensation granted to employees for service at designated 
danger pay posts.” 
 

 
 

Note:  Danger Pay is paid to full-time employees, temporary 
employees assigned for four consecutive hours or longer, and 
part-time and intermittent employees.  For part-time regularly 
scheduled employees and intermittent employees, the DPY shall 
be computed at the prescribed percentage of basic compensation 
earned during the applicable period.  DPY is not subject to any 
ceiling that would provide less than the full percentage rate 
authorized for the post. 

  
• A brief description of each data field and specific instructions 

as to value input or intent is provided. 
 

DATA NAME DESCRIPTION 
Last Action 
Code 

Values and uses are described in Special Processing 
for Foreign Allowances section listed below.  LOV 
is attached to the field. 

Location Post location as defined in DSSR Section 920.  
LOV is attached to the field. 

 

 
 

Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Imminent Danger Pay (IDP)   
“This element records “Danger Pay under DSSR 652g” 
commonly referred to as “Imminent Danger Pay.”  This 
allowance is granted to civilian employees who accompany US 
military forces designated by the Secretary of Defense as eligible 
for imminent danger pay.” 
 

 
 
Note:  Imminent Danger Pay is a non-recurring one-time whole 
dollar amount payment.  IDP may be paid only to employees who 
are on temporary duty or detail of 42 days or less, or for the first 
42 days of a longer assignment.  On the 43rd day, the employee 
becomes eligible for post differential. 
 
Imminent Danger Pay (IDP) shall be the same monthly flat rate 
amount paid to uniformed military personnel ($225.00).  IDP will 
not be paid for period of time that the employee either receives 
danger pay authorized under DSSR, chapter 650, or post 
differential that would duplicate political violence credit.  The 
IDP will be calculated as a daily rate and paid on a monthly basis.  
Daily rates will be determined by dividing the monthly amount by 
the number of days in a month.  This rate will change based on 
the number of days in a month.  For periods of less than a month, 
an employee is entitled to the daily rate times the number of days 
in the month the employee is in the allowance area.   
 
 

Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
 

 Historical IDP authorizations may be accessed in element 
“Imminent Danger Pay Obsolete.”  Corrections may be made to 
those entries as necessary.  The obsolete entry may not be used for 
new IDP authorizations. 

 • A brief description of each data field and specific instructions 
as to value input or intent is provided. 

 
DATA NAME DESCRIPTION 
Amount Amount is reflected as whole American dollars.   
Location Post location as defined in DSSR Section 920.  LOV 

is attached to the field. 
Last Action 
Code 

Values and uses are described in Special Processing 
for Foreign Allowances section listed below.  LOV is 
attached to the field. 

 

 
 
 

 
 
Separate Maintenance Allowance (SMA) (Voluntary)   
 
SMA is an allowance that may be granted to an employee 
whenever the head of agency determines that the employee is 
compelled to maintain any or all members of family elsewhere 
than at the post of assignment because of the following 
circumstances: 
When an employee requests SMA for special needs or hardship 
prior to or after arrival at posts for reasons including but not 
limited to career, health, educational, or family considerations for 
the spouse or domestic partner, children or other family member. 
(DSSR 262.2) 
 

 • A brief description of each data field and specific instructions 
as to value input or intent is provided. 

 
DATA NAME DESCRIPTION 
Amount The amount field is not to be updated by DCPDS 

users.  Amount of payment is determined in the 
payroll system based on the Category code and 
current Department of State tables. 

Last Action 
Code 

Values and uses are described in Special Processing 
for Foreign Allowances section listed below.  LOV is 
attached to the field. 

Category LOV is attached to the field. 
 

Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
 
 

Separate Maintenance Allowance (SMA) (Involuntary)   
 

SMA is an allowance that may be granted to an employee 
whenever the head of agency determines that the employee is 
compelled to maintain any or all members of family elsewhere 
than at the post of assignment because of the following 
circumstances:  For the convenience of the U.S. Government when 
dangerous notably unhealthful, or excessively adverse living 
conditions warrant the exclusion of family from accompanying an 
employee to the post of assignment. 

 
Department of State published guidelines for SMA in the 
Department of State Standardization Regulations dated May 15, 
2005 and effective May 1, 2005.  The involuntary SMA is paid 
from a new table category with different rates than the voluntary 
SMA tables that DCPS maintains.  Therefore, until a system 
change can be implemented, a manual workaround is required to 
pay the new amounts. 
 
HR will flow an entitlement record for voluntary SMA with the 
family category and reduction percentage, if required. 
HR will provide a paper copy of the SF1190 to the applicable 
payroll office that indicates the SMA entitlement is for 
‘Involuntary SMA.’ 
 
The payroll office upon receipt of the SF1190 will make a manual 
pay adjustment for the difference between the Voluntary and 
Involuntary SMA each pay period.  The difference between the 
Voluntary and Involuntary will be determined by the SMA family 
category in the employee’s entitlement record and the annual 
amount on the DSSR table under 267.1(a). 

 
 

Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
 

  Example to determine the pay amount difference: To determine 
the difference for ‘Involuntary SMA,’ find the annual amount 
under the applicable family category and divide by the number 
of days in the calendar year and then multiple the daily amount 
by the number of days the employee is in a pay status for the 
pay period.  Example:  Involuntary SMA annual amount is 
$8,700 (family category 2, for two or more children).  Divide 
$8,700 by 365 (equals 23.84 rounded from 23.8356) and 
multiply by number of days in the pay period (14 x 23.84 = 
$333.76).  This pay period amount is then subtracted from the 
system generated amount and the difference is input with a 
manual pay adjustment each payment period with pay detail 
code YH.  The pay period system generated amount in this 
example will be $7,350/365 = 20.54 x 14 = $287.56.  The 
difference is 46.20 

 
 
 

Post Differential   
“The additional compensation of 5, 10, 15, 20, 25, 30 or 35 
percent over basic compensation granted pursuant to Title II, Part 
D of the Overseas Differentials and Allowances Act (P.L. 86-707) 
to employees at differential posts.” 

 

 
 

 • A brief description of each data field and specific instructions 
as to value input or intent is provided. 

 
Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
 DATA NAME DESCRIPTION 

Percentage THIS FIELD MUST BE LEFT BLANK ON ALL 
ACTIONS.   FIELD IS NOT USED BY DCPDS.  
Note:  The percentage is not recorded as it is 
updated by DCPS based on Department of State 
increases and decreases on a pay period basis. 

Last Action 
Code 

Values and uses are described in Special Processing 
for Foreign Allowances section listed below.  LOV 
is attached to the field. 

Location Post location as defined in DSSR Section 920.  LOV 
is attached to the field. 

Entitlement 
Code 

THIS FIELD MUST BE LEFT BLANK ON ALL 
ACTIONS.  FIELD IS NOT USED BY DCPDS. 

 

  
Home Leave   
 
This element records the Home Leave accrual rate authorized for 
an employee.  

 
 

 • A brief description of each data field and specific instructions 
as to value input or intent is provided. 

 
 

 
Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
 
 
 
 
 
 
 
 
 

 
DATA NAME DESCRIPTION 
Eligibility Date Date the employee will be eligible to begin using 

Home Leave YYMMDD 
Accrual Days 
Per Year 

Number of days of Home Leave accrued each year. 

Last Action 
Code 

Values and uses are described in Special Processing 
for Foreign Allowances section listed below.  LOV 
is attached to the field. 

Days 
Authorized 

THIS FIELD MUST BE LEFT BLANK ON ALL 
ACTIONS.  FIELD IS NOT USED BY DCPDS. 

 

 
  

Foreign Transfer Allowance (FTA)   
“Allowance under 5 U.S.C. 5924(2) (A) for extraordinary, 
necessary and reasonable expenses, not otherwise compensated 
for, incurred by an employee incident to establishing him or 
herself at any post of assignment in a foreign area, including costs 
incurred in the United States, its territories, possessions, the 
Commonwealth of Puerto Rico and the Commonwealth of the 
Northern Mariana Islands prior to departure for such post.”  
 
FTA is a non-recurring lump sum amount and is composed of four 
elements: 
 
 Miscellaneous Expense  
 Wardrobe Expense  
 Pre Departure Subsistence Expense 
 Lease Penalty Expense  

 

 
  

 
Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 

• A brief description of each data field and specific instructions 
as to value input or intent is provided. 

 
DATA 
NAME 

DEFINITION 

Last Action 
Code 

Values and uses are described in Special 
Processing for Foreign Allowances section 
listed below.  Only codes “Initiate,” “Correct,” 
and “Cancel” may be used for Foreign Transfer 
Allowance.  LOV is attached to the field. 

Number 
Family 
Members 

Number of family members included in the 
authorization.  This entry does not include the 
employee.  May be 00 if appropriate.   

Miscellaneous 
Expense 

The dollar amount to assist with certain 
extraordinary costs as defined in DSSR Section 
240 

Wardrobe 
Expense 

The dollar amount of the wardrobe portion of 
the foreign transfer allowance granted to an 
employee shall be determined by the zone 
classification of the respective posts to which 
and from which the employee is transferred that 
are in effect on the date of arrival at the new 
post and by family size.  Not authorized for 
DoD civilians living in the foreign area. 

Per Departure 
Sub Expense 

The dollar amount of pre departure subsistence 
expense granted to an employee for expenses in 
departing a post in the United States for a post 
in a foreign area shall be determined according 
to the maximum per diem rate for the U.S. 
locality from which transferred and according to 
family status. 

Lease Penalty 
Expense 

The dollar amount to help offset the expense of 
a lease penalty unavoidably incurred by an 
employee. The amount of reimbursement shall 
not exceed the amount required by the specific 
terms of a rental contract signed by the 
employee as a prior condition of obtaining the 
lease, or the equivalent of three months' rent, 
whichever is less. 

Amount Total amount of all expenses. 
 
Note:  The total amount will not be auto-populated.  User will 
have to input the total in the Amount field.  If Amount field is not 
entered, user will receive an error message to enter the dollar 
amount in the Amount field.   
 

Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 

                                           
 

 Only Last Action Codes “Initiate,” “Correct” and “Cancel” may 
be used for Foreign Transfer Allowance.  Because it is a one-time 
payment, the other Last Action Code values are not applicable to 
the processing of the authorization. 
 
If user selects Last Action Code “Modify”, “Restart”, 
“Suspend”, or “Terminate”, they will receive the following error 
message. 
 

 
 

If Last Action Code “Cancel” or “Correct” is selected, user must 
date track to the Effective Date From date of the element being 
canceled or corrected.  If not date tracked, user will receive an 
error message. 
 
 
 
 

Continued on next page 
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Foreign/Overseas Allowances, Continued 
 

 
 
 

 

 
 
 
 
 
 
 
 
 
 
 

 

When user corrects the dollar amount in the Foreign Transfer 
Allowance element (while still in the pay period of the initial 
input), DCPS will overlay and only pay the amount of the last 002 
received for that pay period.  DCPS will not allow more than one 
payment (adjustment record) for FTA in any pay period.  DCPS 
stores the PP Ending Date instead of effective date of the 
entitlement on the adjustment record.  To cancel the entitlement 
(while still in the pay period of the initial input), user must cancel 
the Foreign Transfer Allowance element and NOA 001/5EN 
Pay500 will be generated.  Once DCPS has paid the FTA amount 
to the employee, DCPS does not retain the FTA amount in the 
system.   
 
Note:  IF HR user must change the total dollar amount after the 
initial dollar amount has been paid by DCPS, and 
 

• HR needs to increase the total dollar amount; user should 
update the Foreign Transfer Allowance element in the 
current amount and reflect only the additional amount to be 
paid to the employee.  OR  

• HR needs to decrease the total dollar amount; HR should 
cancel the Foreign Transfer Allowance element and then 
re-input the Foreign Transfer Allowance element with the 
correct amounts.  The cancellation action will reject at 
DCPS and will require the payroll technician to manually 
offset against the new entitlement.   
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Special Processing for Foreign Allowances 
 

 
 

• Each Foreign Allowance type that is authorized based on location includes a six-
character location code to record the location applicable to Section 920 of DSSR.  
A List of Values (LOV) is attached to the location field that reflects six characters 
of the GSA-GEOLOC to the Section 920 location name. 

 
• The following table contains the action codes that will be used to control editing 

and payroll interface information.  The action code (available in an LOV), are 
stored in the element entry, and control the results of subsequent actions.  The 
table includes an expanded definition and usage explanation for each of the action 
codes applicable to allowance processes. 

 
LOV VALUE USAGE/DEFINITION 
CANCEL Used to cancel an erroneous authorization.  User must date-track to the 

effective date of the authorization being cancelled.  Any payment of 
the allowance based on the action being canceled will be collected 
from the employee via the payroll debt process.   

INITIATE Identifies the initial establishment of the allowance authorization.  An 
existing element for the same allowance type may not exist when this 
action is specified.    

MODIFY Allows for changes to the allowance information with an effective date 
that is later than the initial authorization.  Only the data fields needing 
change should be input.  Used following reconciliation, when the 
employee moves to a new residence, changes number of dependents, 
etc.  Not to be used to correct data back to the last action effective date 
(See CORRECT below). 

RESTART Used to restart the allowance following suspension of payment for out 
of country or other temporary suspensions of payment.  Last Action 
Code stored in the record must reflect "SUSPEND" before selecting 
RESTART.  The effective date being restarted must be later than the 
entitlement Effective Date From date stored in the record.  If changes 
are required to authorization information, they can be accomplished at 
the same time.   

SUSPEND Allows for temporary suspension of allowance payment when the 
employee is out of country or for other reasons not entitled to the 
allowance payment for a short period of time.  Not to be used to 
document termination of the allowance because of relocation of the 
employee’s duty assignment.  Last Action Code stored in the record 
must reflect INITIATE, MODIFY, RESTART or CORRECT before 
selecting SUSPEND.  The effective date for the SUSPEND must be 
later than the entitlement Effective Date From date stored in the record.  
The authorization will not terminated in DCPDS.  

 
 
 

Continued on next page 
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Special Processing for Foreign Allowances, Continued 
 

 
 

LOV VALUE USAGE/DEFINITION 
TERMINATE Used to discontinue the allowance when the employee is no longer 

entitled to the payment because of changes in the authorizing 
conditions.    The effective date for the TERMINATE must be later 
than the entitlement Effective Date From date stored in the record.   

CORRECT Corrects authorization information previously entered in DCPDS.  
User must date-track to the effective date of the authorization being 
corrected.  May not be used to correct the effective date.  If the 
effective date of the authorization is incorrect, the action must be 
canceled and re-input.   

 
 

Payroll Interface Specifications for Foreign Allowances 
 

 
• Foreign allowance data is provided to payroll through electronic interface using 

the standard 500-character format.  This data writes to the format only for 
transactions that update the specific allowance group and will be blank for all 
other interface transactions.  The following table reflects the format positions used 
for foreign allowance data. 
 

FORMAT 
POSITION 

 
SIZE 

 
DATA NAME 

51 1 Category (SMA) 
 

111-113 
 

3 
Purchase Currency (LQA) OR Rent Currency 
(LQA) 

 
161-170 

 
10 

Purchase Amount (LQA) OR Rent Amount  
(LQA) 

201 1 Quarters Type (LQA) 
211 1 Summer Recess Indicator (LQA)  

 
219-225 

 
7 

Entitlement Amount / Percent OR Amount 
(Imminent Danger Pay and Foreign Transfer 
Allowance) 

 
 
 
 

308-313 

 
 
 
 

6 

Location (LQA) OR 
Location (Post Allowance) OR 
Location (Danger Pay) OR 
Location (Post Differential) OR 
Location (Imminent Danger Pay) 

 
314-315 

 
2 

No. Family members (LQA) OR 
No. Family members (Post Allowance) 

332 1 Quarters Group (LQA) 
357-358 2 Shared Percent (LQA) 
403-405 3 Utility Currency (LQA) 
453-462 10 Utility Amount (LQA) 

 

 
 

Continued on next page 
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Payroll Interface Specifications for Foreign Allowances, Continued 
 

 
 

• The LAST ACTION CODE entry determines the Nature of Action Code (NOAC) 
to be used (see table below). 

 
IF LAST ACTION CODE IS: THEN NOAC WILL BE: 
Initiate or Restart 5EN – Establish a new authorization  
Modify  5EC – Modify an authorization with a new 

effective date 
Terminate or Suspend 5ED – Terminate an authorization 
Cancel 001 – Cancel an authorization 

*See Note 1 
Correct 5EC – Correct an authorization 
Correct – Foreign Transfer Allowance 002 –Correct the authorization 

*See Note 1 
 

 

 
*Note 1:  When a Cancellation is processed, the Pay500 will flow 001 for the 
NOA in positions 70-72 and 5EN for the corrected NOA in positions 305-307.  
When a Correction is processed for Foreign Transfer Allowance, the Pay500 
will flow 002 for the NOA in positions 70-72 and 5EN for the corrected NOA 
in positions 305-307. 

 

 

 
*Note 2:  When a retroactive entitlement is input, the NOAs 5EN/5EC will 
auto-roll in the payroll system from the effective date to current pay period.  
When NOA 5ED is received at payroll, it will auto-roll entitlement 
transactions for COLA, Non-Foreign Post Differential, Living Quarters 
Allowance, Post Allowance, Foreign Post Differential, Separate Maintenance 
Allowance and Danger Pay.  The NOA 5ED auto-roll process will stop 
deleting subsequent entitlement records as follows:  Cost of Living 
Allowance, Non-Foreign Post Differential, and Separate Maintenance 
Allowance if the Supplemental Geographical Location Code (GLO) State 
changes; Living Quarters Allowance if the Living Quarters Allowance (LQA) 
Location changes;  Post Allowance if the Post Allowance (PAL) Location 
changes; Foreign Post Differential if the Foreign Post Differential (PDF) 
Location changes; and Danger Pay if Danger Pay (DPY) Location changes.    
 
When a modification or correction is made to entitlements that have already 
ended or modified with a subsequent effective date, NOA 5EC will be sent to 
payroll and will auto-roll through the original 5ED action or the inappropriate 
inclusion of corrected data in later authorizations.  Immediately following 
completion of the intervening correction or modification, all subsequent 
Pay500 formats for the same allowance type must be sent to payroll again, in 
the proper processing sequence, using the Payroll Regeneration capability.  
This will ensure NO overpayment to the employee.   

Continued on next page 
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Payroll Interface Specifications for Foreign Allowances, Continued 
 

 
 

• DCPDS also generates the appropriate value for payroll interface 500-character 
format position 210, EMPL-ENTITLEMENT.  The foreign allowance type 
determines the value that will be provided to DCPS. 

 
IF ELEMENT UPDATED IS: THEN EMPL-ENTITLEMENT WILL BE: 

Civ Living Quarters Allowance E 
Post Allowance F 
Danger Pay R 
Separate Maintenance Allowance H 
Post Differential G 
Imminent Danger Pay B 
Home Leave W 
Foreign Transfer Allowance 1 
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Non-Foreign Entitlements  
 

 
 

Before You 
Begin 

Date track is critical to control of the effective date and update result.   

 
 

Creating an Authorization 
 

Step Action 
1 Navigation Path: People/Enter and Maintain  Assignment  

Entries 
2 With the Entitlement element highlighted, click <Entry Values> 

button (bottom left) to open the window for data entry. 

 
 

3 Click the LOV for the Code field and select the appropriate 
entitlement type being authorized. 

 
 

 
Continued on next page 
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Non-Foreign Entitlements, Continued  
 

 
Step Action 

4 Each Entitlement Type will be authorized as EITHER a percentage 
or amount.  Enter the amount or percentage using the table below 
to determinate the appropriate number of characters and format.  
When amounts are entered, it may be whole dollars or dollars and 
cents, depending on the entitlement type.  Amounts should be 
reflected as annual or hourly based on the employee’s pay basis.  
The table below identifies the value format required for each 
entitlement type and maximum entry size, if applicable.  
Percentages are reflected with two decimal places in most cases. 
 

 
ENTITLEMENT 

NAME 

 
INPUT FORMAT 

EXAMPLE 
(maximum field 
size is indicated) 

Benefit Allowance 
GTMO 

Annual Amount  
or  
Hourly Amount based 
on assigned Pay Plan. 

DDDDD.CC 
 
DD.CC 
 

COLA   Percentage ##.## 
Extra Duty (Dorm 
Supervisor) 
 

Annual Whole Dollar 
Amount 

DDDDD 

Extra Curricular 
Activity/Stipend 

US Dollar Amount DDD.CC 

Fringe Benefits  Hourly Amount DDDDD.CC 
 

Non-Foreign Post 
Differential 

Percentage ##.## 

Physicians 
Comparability 
Allowance 

Annual Dollar 
Amount 

DDDDD.CC 

Recruitment Incentive Percentage ##.## 
Remote Site-Offshore 
Allowance 

Daily Dollar Amount DDDDD.CC 

Special Retention 
Allowance  

Annual Amount DDDDD.CC 

Subsistence Expense 
Allowance (SEA) 

Daily Dollar Amount DDDDD.CC 
 

Temporary Quarters 
Subsistence Allowance 
(TQSA) 

Daily Dollar Amount DDDDD.CC  

 

 
• Some entitlement types described in this section are for the specific use 

for a single agency.  Edits may be in place to ensure that only employees 
assigned to the authorized agency are granted the entitlement; however, 
users must take care to select appropriate types for their agency.  Where 
possible, the table provides the applicable agency(s).  

Continued on next page 
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Non-Foreign Entitlements, Continued  
 

 
• A brief description of each Entitlement and specific instructions as intent is 

provided. 
 

 ENTITLEMENT NAME DESCRIPTION AGENCY 
Benefit Allowance GTMO Allowance for employees in Cuba 

only.  Citizenship must be “5.”   
Navy 

COLA Cost of Living Adjustment 
authorized by 5 CFR Part 591.  
Locations covered include Alaska, 
Puerto Rico, Virgin Islands, Guam 
and Commonwealth of the Northern 
Mariana Islands, and Hawaii. 
Authorized as a percentage based 
on Comparative Index ranges.   

 

Education Allowance 
Education Travel 
 
 

DO NOT USE:  This entitlement 
type is not supported by automated 
process in DCPS.  Manual 
submission is required. 

 

Extra Duty (Dorm Supervisor) Annual pay amount given to 
teachers who also have 
responsibilities as Dormitory 
Supervisors.   

DoDEA 

Extra Curricular 
Activity/Stipend 

Annual Pay amount granted to 
teachers who also sponsor extra 
curricular activities.   

DoDEA 

Foreign Language Proficiency 
Pay (FLPP) 

DO NOT USE:  Authorization 
must be processed with NOA 926 
or 873.  Will be removed from the 
LOV.  

 

Foreign Transfer Allowance 
(FTA) 

DO NOT USE:  Use the Element 
entry for FTA instead. 

 

Fringe Benefits This entitlement is for the exclusive 
use of Army Corp of Engineers.  
Refer to Army documentation for 
further information. 

 
Army 

Inconvenience/Hardship 
Allowance 

DO NOT USE:  This entitlement 
type is not supported by DCPS.  
Will be removed from the LOV. 

 

Non-Foreign COLA DO NOT USE:  Use the Element 
for COLA instead.  Will be 
removed from the LOV. 

 

Non-Foreign Post Differential Cost of Living Adjustment 
authorized by 5 CFR Part 591.  
Locations covered include 
American Samoa, Guam, Northern 
Mariana Islands, Johnston Island, 
Midway Atoll, and Wake Atoll. 

 

 

 
 

Continued on next page 
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Non-Foreign Entitlements, Continued  
 

 
 ENTITLEMENT NAME DESCRIPTION AGENCY 

Physicians Comparability 
Allowance 
 

Authorized by 5 CFR 595, additional 
pay granted Physicians and Dentists 
for recruitment and retention 
purposes.  The entitlement is 
intended to ensure DoD employees’ 
pay is comparable to private industry 
professionals in the area. 

 

Recruitment Incentive Special recruitment incentive 
authorized for Guam, American 
Samoa, Navassa Island, Northern 
Mariana Island, Marcus Island, Jarvis 
Island, Baker Island, Howland Island, 
Johnston Atoll, Kingman Reef, 
Palmyra Atoll, Midway Islands, 
Puerto Rico, Virgin Islands, and 
Wake Island only.  The second 
character of the Location Code must 
be “Q”. 

 

Remote Site-Offshore 
Allowance 

Remote worksite allowances are 
authorized by 5 CFR 591, Subpart C.   

 
Navy 

Separate Maintenance 
Allowance (SMA) 

DO NOT USE:  Use the SMA 
Element instead.  This item is being 
removed from the entitlements fields. 

 

Special Retention Allowance This entitlement is authorized for 
University of Health Sciences 
(NV18) employees only.  Refer to 
Navy guidance for additional 
information. 

 
Navy 

Subsistence Expense 
Allowance (SEA) 

DO NOT USE:  Subsistence 
Expense is a portion of Foreign 
Transfer Allowance.  Use the FTA 
Element instead.  Will be removed 
from the LOV.  

 

Temporary Quarters 
Subsistence Allowance 
(TQSA) 

Authorized by DSSR, TQSA is 
authorized in 30 day increments upon 
arrival at a new post or immediately 
preceding departure from a post.  
Note:  This entitlement type should 
not be used to authorize a non-
recurring (one-time or lump sum 
amount) payment authorization. 

 

Transportation Allowance DO NOT USE:  This entitlement 
type is not supported by DCPS. Will 
be removed from the LOV. 

 

 

 
 

Continued on next page 
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Non-Foreign Entitlements, Continued  
 

 
 

 

 
 
Note:  Some of the entitlement types are intended for specific agencies.  
Business rules have been provided to minimize erroneous 
authorizations.  If the user’s agency is not authorized use of an 
entitlement, the following error message will be provided: 
 

 
 
 

Correcting an Existing Authorization 
 

• “Correct” means that the original authorization reflected either a wrong 
entitlement type or amount/percent value.  The absence of an action indicator in 
the Entitlement area requires that the user be accurate in the process being done to 
ensure the appropriate NOAC to the payroll interface. 

 
Step Action 

1 Navigate to the Assignment  Entries and date track to the 
Effective Date From value reflected for the Entitlement being 
corrected. 
 

 
 

 
 

Continued on next page 



                                                                   R12  December 2011 

Foreign Allowances and Non-Foreign Entitlements                                                                           Module 8, Chapter 6, Page 31 

Non-Foreign Entitlements, Continued  
 

 
 

Step Action 
2 When the new value(s) are entered, the system will ask the user to 

specify whether the action being taken is a correction or update.  
Click <Correction> and save the entry. 
 

 
 

 
  

Modifying an Existing Authorization 
 

• “Modify” means that the authorization is being changed to reflect a different 
amount/percent value at a point in time AFTER the original authorization.  The 
absence of an action indicator in the Entitlement area requires that the user be 
accurate in the process being done and the intent of the change. 

 
Step Action 

1 
 

Navigate to the Assignment  Entries and date track to the 
Effective Date From value reflected for the new value being 
entered.   
   

 
 

 
 

Continued on next page 
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Non-Foreign Entitlements, Continued  
 

 
 

Step Action 
2 When the new values are entered, the system will ask the user to 

specify whether the action being taken is a correction or update.  
Click <Update> and save the entry. 
 

 
 

 
Terminating an Existing Authorization 
 

• “Terminate” means that the authorization is being ended at a point in time 
AFTER the original authorization.  The absence of an action indicator in the 
entitlement area requires that the user be accurate in the process being done to 
ensure the appropriate NOAC to the payroll interface.  The appropriate effective 
date for earlier termination of the authorization must reflect the day 
following the day the payment is to be stopped.  If the payment is to be made 
through 10 July, the termination action processed should reflect an effective 
date of 11 July.  This will ensure the employee receives the proper allowance 
amounts for 10 July.  The intent of the termination is to close the existing entry 
and NOT start a new one.   

 
Step Action 

1 Navigate to the Assignment  Entries and date track to the 
Effective Date From value to the effective date of the entitlement 
termination.   

 
 

Continued on next page 
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Non-Foreign Entitlements, Continued  
 

 
 

Step Action 
2 The element entry will not be opened to accomplish the 

termination.  The values in the entry should remain for historical 
purposes.  After selecting the entry to be terminated, click the 
RED X. 

 
 

3 The system will question the user’s intent to delete the entry with 
the following message.  Click the Yes button. 
 

 
 

4 User will be prompted to specify whether the entry is to be end-
dated or purged.  Select the End Date button to accomplish the 
termination.  Pay affecting entries may not be purged and business 
rules are provided to prohibit use of the Purge button for 
Entitlement entries.  
 

 
 
 

 

Continued on next page 



                                                                   R12  December 2011 

Foreign Allowances and Non-Foreign Entitlements                                                                           Module 8, Chapter 6, Page 34 

Non-Foreign Entitlements, Continued  
 

 
 

Step Action 
5 The Entitlement entry disappears from the screen 

temporarily.  Click the save button to complete the 
termination action and refresh the view (CNTL F11) to 
view the end-dated Entitlement entry.  

 

 
 

 
Creating or Correcting a Historical Entitlement Entry 

 
• The processes and procedures documented for current entitlement entry 

management apply to historical or missing entries as well.  There is one 
significant consideration that will impact the ability to successfully process.  
The employee record must reflect an assignment history as of the date of the 
entitlement action being entered.  The scenarios described here should only 
apply rarely as most agencies have been in DCPDS for a significant enough 
time to have assignment history in place to support entitlement authorizations.  
An exception may be the recently centralized databases that were processed 
through the DCPDS M2M procedures. 

 
• Creating an entry that should have existed in the record previously must be 

evaluated to determine the impact on the payroll system as well as how 
DCPDS history must be stored.   

 
 If the entry has never been updated at the payroll system, normal entry to 

DCPDS with payroll interface flow is necessary.  The employee’s 
assignment history may have to be created through the DoD reconstruct 
process before the entitlement authorization can be accomplished. 

 If the entry has already been populated to the payroll system and the 
employee has been properly paid, the entry may be stored in DCPDS as of 
the earliest assignment start date.  The payroll system will not be 
adversely impacted by this update because the 5EN transaction will simply 
overlay the existing authorization with the new effective date.   

 
Continued on next page 
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Non-Foreign Entitlements, Continued  
 

 
 
• Correcting an entry that carries an effective date earlier than the earliest 

assignment start date also requires review to determine impact to both DCPDS 
and the payroll system. 

 
 If the corrected value must be interfaced to payroll for retroactive 

processing, the employee’s assignment history will have to be created 
through reconstruct followed by the corrective action. 

 If the correction is not needed at payroll, the action may be handled in 
DCPDS as a modification with an effective date equal to that of the 
earliest assignment.   

 
Payroll Interface Specifications for Entitlements 
 

• Entitlement data is provided to payroll through electronic interface using the 
standard 500-character format.  The entitlement code will flow in position 210, 
EMPL-ENTITLEMENT.  The entitlement name selected from the LOV 
determines the value that will be provided to DCPS.  

 
 

ENTITLEMENT NAME 
 
THEN EMPL-ENTITLEMENT WILL BE: 

Benefit Allowance GTMO L 
COLA C 
Education Allowance Education Travel 2 
Extra Duty (Dorm Supervisor) Z 
Extra Curricular Activity/Stipend Y 
Foreign Language Proficiency Pay (FLPP) X 
Fringe Benefits A 
Non-Foreign Post Differential D 
Physicians Comparability Allowance M 
Recruitment Incentive O 
Remote Site-Offshore Allowance N 
Special Retention Allowance S 
Subsistence Expense Allowance (SEA) I 
Temporary Quarters Subsistence Allowance (TQSA) J 

 

 
• The LAST ACTION CODE entry determines the Nature of Action Code (NOAC) 

to be used (see table below). 
 

IF LAST ACTION CODE IS: THEN NOAC WILL BE: 
Initiate 5EN – Establish a new authorization 
Modify 5EN -  Modify an existing authorization 

Terminate 5ED - Terminate an authorization 
Correct 5EC - Correct an existing authorization 

 

 
 

Continued on next page 
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Non-Foreign Entitlements, Continued  
 

 
 
Automated LQA Reconciliation Process 
 

1. In accordance with Department of State Standardized Regulation (DSSR) Section 
077.2, reconciliation of the amounts paid to an employee for Living Quarters Allowance 
to the amounts the employee has actually expended is required for the following 
circumstances:   

 
a. Employee initially occupies economy quarters in the preceding twelve-month 

period. 
 

b. Employee changes economy quarters in the preceding twelve-month period. 
 

c. Employee may request reconciliation at any time. 
 

d. More frequent reconciliation may be deemed necessary as indicated in Section 
134.16 of the DSSR because of excessive fluctuation in utilities or other quarters 
costs. 

2. When authorizations are established for utilities and other quarters expenses, the 
amounts are estimated based on previous histories of the quarters or other reasonably 
reliable comparisons to similar quarters in the area.  The reconciliation process allows for 
review of actual expenditures to equalize the authorizations after the first year.  
Generally, there will be no change in the rent amounts authorized if the original 
authorization was based on a lease that covered the term of residence.  
 
3. BEFORE BEGINNING:  Ensure the LQA authorization is present in the employee’s 
DCPDS record with the appropriate beginning date reflected in the element Effective 
Date From date.  Proceed with the appropriate instructions in paragraph 4.  
  
4. Following the procedures outlined will accomplish electronic submission of actual 
expended amounts.   The payroll technician must intervene to roll the amounts forward.  
The process allows for electronic adjustments to determine over or under payment during 
the previous authorization period resulting in faster payment of amounts due the 
employee and debt processing when necessary.   

 

Continued on next page 
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Non-Foreign Entitlements, Continued  
 

 

a. The period of reconciliation will be from the date of current authorization 
reflected in the element entry and the end of pay period (see Note 1) in which the 
reconciliation is completed.  If the period of reconciliation covers more than one 
authorization period, each element entry will be corrected to reflect the re-determined 
authorization amounts.  
 
b. Upon completion of a review of appropriate receipts or statements and 
compilation of expended amounts select the appropriate situation and complete the 
steps as indicated.   
 

Note 1:  Accomplishing reconciliation through the end of pay period may not be 
appropriate for LQA termination reconciliation.  In that case, the last date of LQA 
payment will be appropriate.  In addition, a reconciliation that results from occupation of 
a different residence will be through the day before the authorization for the new 
residence is effective.   
 

Note 2:   Reverse interface processes that accumulated LQA payment amounts in 
DCPDS for use in the reconciliation process are no longer required with implementation 
of the electronic reconciliation procedures provided in this section.  System changes will 
be requested in both DCPDS and DCPS to discontinue the processes.  Documentation of 
related items has been removed from this processing guide.  
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LQA Reconciliation Processing Steps, Situation 1 
 
 

“Partial Year Reconciliation” for Rent and Utilities (Expenses have to be prorated to a yearly 
amount for input into DCPDS).  LQA reconciliation in this situation requires that the employee’s 
expense be totaled up for the period being reconciled and divided by the number of days in that 
reconciliation period.  Then that daily rate is multiplied by the number of days in the year 
(affected by Leap Years).  This gives a “grossed up” amount that will represent what the total 
expenses would have been for the full year.  This is so that the daily rate that DCPS pays will 
cover the expenses that the employee would have incurred during the period that the employee is 
eligible for LQA.  DCPS ensures that employees don’t earn more than the maximum LQA 
authorized, based on the location of the employee.  This is required for both Rent and Utilities.   
 
Employee is entitled to LQA in a foreign area.  The employee’s entitlement ends on July 15.  
The employee submits supporting paperwork for a final reconciliation covering the period from 
January 1 – July 15. 
 
1.  Calculate the number of calendar days included in the reconciliation period (January 1 – July 
15): 
 
 196 days - regular calendar year 
 197 days – leap year 

 
2. Calculate the daily LQA rate for the reconciliation period  

 
 $40.82 per day – regular calendar year ($8,000 divided by 196 = $40.82) 
 $40.61 per day – leap year ($8,000 divided by 197 = $40.61) 

 
3. Calculate the full annual rate of LQA expense: 
 
 365 days – regular calendar year ($40.82 x 365 = $14,899.30) 
 366 days - leap year ($40.61 x 366 = $14,863.26) 

 
4. Compare the amount calculated in Step 3 with authorized LQA maximum. 
 
5. Process the LQA transaction with the calculated rate or the maximum rate, whichever is less. 
 
DCPS will use the annual rate entered to calculate the daily rate and generate the appropriate 
entitlement for the dates authorized. 
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LQA Reconciliation Processing Steps, Situation 2 
 
The employee assignment date is earlier than the LQA authorization date.  This record converted 
to DCPDS before the system repair was made to store the entry with the actual LQA beginning 
date, thus requiring an additional step to resolve the authorization date issue first.  The example 
provided below reflects dates used for the example record only.  User must insert the correct 
dates for the employee record being reconciled.  
 
 Example Record Considerations: 
 
 Employee assignment date is 30 July 1999 
 LQA authorization origination date is 1 Oct 1999 
 Authorization has not been modified or changed since initiated 

Conversion from legacy system to DCPDS, established the LQA entry with a start date of 
30 Jul 1999 

Step 1:  Resolve the erroneous element start date 
 

• Navigate to People / Combined Person & Assignment Form / Assignment / Entries / Civ 
Living Quarters Allowance 

• Date track to the erroneous element start date (30-Jul-1999) use CTRL F11 to refresh the 
entries 

• Change the Last Action Code to “CANCEL” 
• When decision box appears click “CORRECTION” 
• Click Save - - Save will produce PAY500 with NOA 001, effective date of 30 July 1999 

and Corrected NOA 5EN 
• Click the RED X to delete the entry.  
• When asked if the user really wants to delete the record click YES 
• When asked “End Date” or “Purge”, select “End Date” 
• Again click Save to store the end-dated entry  
• Date Track to the ACTUAL LQA Authorization Start Date (1-Oct-1999), use CTRL F11 

to refresh the entries 
• Select the first empty entry line on the screen, open the LOV, and select Civ Living 

Quarters Allowance 
• Click Entry Values to open the DDF 
• Populate the correct data for the entry. (Show the last action value as Initiate) 
• Save the entry by clicking the Save button.  PAY500 with NOA 5EN and actual effective 

date will be created   
• Reset the date-track to the current date, refresh the entries screen (CTRL F11) and verify 

the Civ Living Quarters Allowance entry values and Effective Date From date.  
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LQA Reconciliation Processing Steps, Situation 2, Continued 
 
Step 2:  Correct the original authorization data based on the receipts provided by 
employee 

 
• Reconciliation update is done as of the date of the authorization.  Date track to 1-Oct-

1999 and hit CTRL F11 to refresh the entries.  
• Select Civ Living Quarters Allowance and open the Entry Values 
• Key in the corrected Rent or Utilities amount and hit TAB key 
• When option box appears, select “Correction” 
• Change Last Action Code to “Correct” 
• Save the entry.  PAY500 will be produced with NOA 002 and effective date equal to the 

date to which date-tracked.  Corrected NOA reflects 5EN. 
  

Step 3:  Establish the revised authorization effective immediately following the 
reconciliation period   

 
• Date track to 1 April 2001 and hit CTRL F11 to refresh the view  
• Last Action value will be “Modify” 
• Update the fields that require revision to newly authorized amounts (rent and/or utilities) 
• Save the entry 
• The modification will set the record for the next payment and reconciliation period 

 
 
 

END OF SITUATION 2 PROCESSING 
 

------------------------------------------------------------------------------------------------------------ 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



                                                                   R12  December 2011 

Foreign Allowances and Non-Foreign Entitlements                                                                           Module 8, Chapter 6, Page 41 

LQA Reconciliation Processing Steps, Situation 3 
 
 
The employee assignment is later than the LQA authorization date.  Deployment to DCPDS took 
place after the assignment start date and the previous assignment does not already exist in the 
modern database.  This record converted to DCPDS before the system repair was made to store 
the entry with the actual LQA beginning date, thus requiring an additional step to resolve the 
authorization date.  The example provided below reflects dates used for the example record only.  
User must insert the correct dates for the employee record being reconciled.  
  

Example Record Considerations: 
 

Employee assignment date is 25 Feb 2001 
LQA authorization origination date is 1 Jan 2000 
Reconciliation Period is 1 Jan 2000 thru 31 Dec 2000 
Authorization has been modified or changed since initiated 1 Sep 2000 
Conversion from legacy to modern established the LQA entry with a start date of 25 Feb 
2001 

 

Step 1:  Establish the employee assignment that existed on 1 Jan 2000 
 

• Identify or establish a position record matching the position of assignment as of the 2000 
date  

• Using the 911 Record Reconstruct capability, create the assignment that was in effect on 
the date of the LQA authorization  

 
Step 2:  Insert the LQA Authorization as it existed on 1 Jan 2000 

  
• Navigate to People Combined Person & Assignment Form / Assignment / Entries 
• Date Track to 1 Jan 2000, press CTRL F11 to refresh the entries   
• Click into the first available entry field and select Civ Living Quarters Allowance from 

the LOV 
• Last Action value will be “Initiate” 
• Update all fields with the values that applied as of 1 Jan 2000.  If the values were a result 

of reconciliation rather than a new authorization, be sure to put in the newly authorized 
amounts determined by the reconciliation process. 

• Save the entry.  NOAC 5EN will be written to payroll and should not modify the existing 
authorization.  Action accuracy is critical in this process.  

  

Step 3:  Resolve the erroneous element start date 
 

• Navigate to People / Combined Person & Assignment Form / Assignment / Entries / Civ 
Living Quarters Allowance 
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LQA Reconciliation Processing Steps, Situation 3, Continued 
 

 
• Date track to the erroneous element start date (25 Feb 2001).  Use CTRL F11 to refresh 

the entries 
• Change the Last Action Code to “CANCEL” 
• When decision box appears, click “CORRECTION” 
• Click Save - - Save will produce PAY500 with NOA 001, effective date of 25 Feb 2001 

and Corrected NOA 5EN 
• Click the RED X to delete the entry  
• When asked if the user really wants to delete the record click YES 
• When asked “End Date” or “Purge”, select “End Date” 
• Again click Save to store the end-dated entry 
• Date Track to the ACTUAL LQA Authorization Start Date (1-Sep-2000).  Use CTRL 

F11 to refresh the entries 
• Select the first empty entry line on the screen, open the LOV, and select Civ Living 

Quarters Allowance 
• Click Entry Values to open the DDF 
• Populate the correct data for the entry. (Show the last action value as Modify) 
• Save the entry by clicking the Save button.  PAY500 with NOA 5EC and actual effective 

date will be created.  
• Reset the date-track to the current date, refresh the entries screen (CTRL F11) and verify 

the Civ Living Quarters Allowance entry values and Effective Date From date. 
• This action will end date the 1 Jan 2000 entry.   

 
Step 4:  Correct the original authorization data based on the receipts provided by 
employee  

 
• Reconciliation update is done as of the date of the authorization.  Date track to 1-Jan-

2000 and hit CTRL F11 to refresh the entries.  
• Select Civ Living Quarters Allowance and open the Entry Values 
• Key in the corrected Rent or Utilities amount and TAB to the next field 
• When option box appears, select “Correction” 
• Change Last Action Code to “Correct” 
• Save the entry.  PAY500 is produced with NOA 002 and effective date equal to the date 

to which date-tracked Corrected NOA reflects 5EN. 
• Date track to the modification entry date (1-Sep-2000) and use CTRL F11 to refresh the 

entries  
• Select Civ Living Quarters Allowance and open the Entry Values 
• Key in the corrected Rent or Utilities amount and hit TAB key 
• When option box appears, select “Correction” 
• Change Last Action Code to “Correct” 
• Save the entry 
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LQA Reconciliation Processing Steps, Situation 3, Continued 
 
 

All entries applicable to the reconciliation period must be updated in this fashion.  Be sure 
the sequence of update is oldest to newest.  

 
Step 5:  Establish the revised authorization effective immediately following the 
reconciliation period   

 
• Date track to 1-Jan-2001 and use CTRL F11 to refresh the view 
• Last Action value will be “Modify” 
• Update the fields that require revision to newly authorized amounts (rent and/or utilities) 
• Save the entry 
• The modification will set the record for the next payment and reconciliation period 

 
 
 

END OF SITUATION 3 PROCESSING 
------------------------------------------------------------------------------------------------------------ 
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LQA Reconciliation Processing Steps, Situation 4 
 
 
The employee assignment is later than the LQA authorization date.  Deployment to DCPDS took 
place after the assignment start date and the previous assignment does not already exist in the 
database.  This record converted to DCPDS after the system repair was made to store the entry 
with the actual LQA beginning date.  The example provided below reflects dates used for the 
example record only.  User must insert the correct dates for the employee record being 
reconciled.  
  

Example Record Considerations: 
 

Employee assignment date is 25 Feb 2001 
LQA authorization origination date is 1 Jan 2000 
Reconciliation Period is 1 Jan 2000 thru 31 Dec 2000 
Conversion from legacy to modern established the LQA entry with a start date of 1 Jan 
2000. 

 
Step 1:  Establish the employee assignment that existed on 1 Jan 2000 

 
• Identify or establish a position record matching the position of assignment as of the 2000 

date 
• Using the 911 Record Reconstruct capability, create the assignment that was in effect on 

the date of the LQA authorization 
 

Step 2:  Correct the original authorization data based on the receipts provided by 
employee  

 
• Reconciliation update is done as of the date of the authorization.  Date track to 1-Jan-

2000 and use CTRL F11 to refresh the entries.  
• Select Civ Living Quarters Allowance and open the Entry Values 
• Key in the corrected Rent or Utilities amount and TAB to the next field 
• When option box appears, select “Correction” 
• Change Last Action Code to “Correct” 
• Save the entry.  PAY500 is produced with NOA 002 and effective date equal to the date 

to which date-tracked Corrected NOA reflects 5EN 
• Date track to the modification entry date (1-Sep-2000) and hit CTRL F11 to refresh the 

entries 
• Select Civ Living Quarters Allowance and open the Entry Values 
• Key in the corrected Rent or Utilities amount and hit TAB key 
• When option box appears, select “Correction” 
• Change Last Action Code to “Correct” 
• Save the entry 
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LQA Reconciliation Processing Steps, Situation 4, Continued 

 
 
Step 3:  Establish the revised authorization effective immediately following the 
reconciliation period   

 
• Date track to 1-Jan-2001 and use CTRL F11 to refresh the view 
• Last Action value will be “Modify” 
• Update the fields that require revision to newly authorized amounts (rent and/or utilities)  
• Save the entry 
• The modification will set the record for the next payment and reconciliation period 

 
 

END OF SITUATION 4 PROCESSING 
------------------------------------------------------------------------------------------------------------ 
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Module 8 

Chapter 7 

Foreign Language Proficiency Pay (FLPP) 

 
Chapter Overview 

   
Introduction This chapter provides guidance for updating Foreign Language Proficiency Pay 

(FLPP) in DCPDS to flow via the automated interface to DCPS to ensure 
accurate and consistent maintenance of entitlement data across the Department 
of Defense (DoD). 
 
On July 26, 2005, DoD issued a memorandum that revised DoD’s policy for 
Foreign Language Proficiency Pay (FLPP) for Department of Defense (DoD) 
civilian employees performing intelligence duties (10 USC 1596).  The revision 
changed the maximum amount of FLPP an employee could receive per pay 
period from $150 to $500.  The five different pay rates established in the July 20, 
1993, policy memorandum has been eliminated in this revision.  Now 
supervisors can authorize any amount up to $500 per pay period based on one or 
more of the following language skills, difficulty in recruiting or retaining 
employees with the same proficiencies, extent to which employee performs tasks 
requiring proficiency, number of critical languages employee is proficient in and 
other criteria DoD determines are significant. 
 
On November 3, 2006, DoD issued a memorandum that established DoD’s 
policy and delegated authority for payment of FLPP to eligible DoD employees 
assigned non-intelligence duties requiring proficiency in foreign languages 
identified as necessary for national security interests provided in 10 USC 1596a. 
This policy does not apply to Intel DoD employees. FLPP shall be calculated as 
a percentage of the employee’s adjusted rate of basic pay not to exceed five 
percent.  
 

   
 
CAUTION! 
 
 
 

The documentation and information provided here does not constitute policy nor 
does it relieve the user of responsibility to obtain current authorization 
information, DoD instructions and guidance, or agency policy determinations.   
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Chapter Overview, Continued 
  
   
Chapter Contents 

 
Topic See Page 

Chapter Overview 1 
General Processing Information for Foreign Language 
Proficiency Pay (FLPP)  

3 

      Payroll Interface Specifications for Entitlements 9 

 
 
Before You 
Begin 
 
 
 
 
  
 
 
 
 
 
 

 
 

 Before FLPP can be awarded, the employee’s position data element 
‘Language Required’ must reflect a valid value and the employee’s US Fed 
Language SIT must reflect a valid language. 

 
 FLPP can only be created, changed, or terminated via the Foreign Language 

Proficiency Pay RPA NOAs 0926, 0927, and 0928 for Appropriated and 
Tech employees. 

 
 Users should enter the FLPP amounts on page 2 of the RPA only.  The 

amount will then flow to the RPA  Extra Information  Foreign 
Language Proficiency Pay DDF. 

 
 Users are allowed to update only the FLPP certification date (outside of the 

RPA process) through the People  Enter and Maintain  Assignment  
Entries  Foreign Language Proficiency Pay.  Changes to FLPP amounts 
must be done via NOA 0927 Chg in Foreign Language Proficiency Pay or 
NOA 002 Correction to the NOA 0926 action.   

 
 Employees are not eligible to continue FLPP payments when moving from 

Intel to Non-Intel positions.  If employee receiving FLPP under one policy 
(i.e. Intel) changes positions that would fall under a different FLPP policy 
(i.e. Non-Intel), the original FLPP authorization must be terminated via NOA 
0928 Termination Foreign Language Proficiency Pay one day prior to the 
new position change.  If FLPP is authorized under the new position, a new 
FLPP authorization must be started with NOA 0926 Foreign Language 
Proficiency Pay.   

 
 

Continued on next page 
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Chapter Overview, Continued 
 

 

Note:  Caution notice to the user that FLPP should be reviewed for accuracy 
and applicability when there is a change in position.  Therefore, when an 
employee’s position is changed via a Request for Personnel Action (RPA), user 
will receive a Caution notice to review the employee’s continued eligibility for 
FLPP.   

 
 

 
 

 
General Processing Information for Foreign Language Proficiency Pay 
(FLPP) 

 
 

 
Step Action 

1 
 
 
 
 
 

 
 
 
 

Navigation Path: Request for Personnel Action  Foreign Language Prof Pay 
 
To start an employee’s entitlement to Foreign Language Proficiency Pay (FLPP), 
users must process a NOA 0926, Foreign Language Proficiency Pay. 
 
To change an employee’s entitlement to Foreign Language Proficiency Pay (FLPP), 
users must process a NOA 0927, Chg in Foreign Language Proficiency Pay. 
 
To terminate an employee’s entitlement to Foreign Language Proficiency Pay (FLPP), 
users must process a NOA 0928, Termination Foreign Language Proficiency Pay. 
 

 
 

 
Continued on next page 

NOAs 0926, 
0927, and 
0928 
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General Processing Information for Foreign Language Proficiency Pay 
(FLPP), Continued 
 

 
 

 
Step Action 

2 Enter the appropriate NOA in block 5A of the RPA AFTER entering the effective 
date and employee name. 
  

 
3 
 

 

Different Legal Authority Codes (LACs) are used to document FLPP for Intel and 
Non-Intel employees  
 
Note:  Business edits are in place to ensure the correct LACs are entered for each 
condition. 
  

 
  

IF AND THEN AND 
NOA 

equals: 
 1st LAC 

equal: 
2nd LAC 
equal: 

0926, 
0927 

or 
0928 

Intelligence Position Indicator equals 1 (Non-Intel) 8IV  

0926, 
0927 

or 
0928 

Intelligence Position Indicator equals 2 (Intel) UAM 8IU 

 

 
 

Continued on next page 
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General Processing Information for Foreign Language Proficiency Pay 
(FLPP), Continued 
 

 
 

 

Step Action 
4 
 
 
 
 
 
 
 
 
 

Users are required to enter the bi-weekly FLPP amount in the Award window in the 
RPA. 
 

IF NOA 
equals 

AND THEN  
 

0926 or 0927 Intelligence Position 
Indicator equals 2 (Intel) 

User must enter an amount not to exceed $500 

0926 or 0927 Intelligence Position 
Indicator equals 1 (Non-
Intel) 

User must enter an amount not to exceed 5% of the bi-
weekly Adjusted Basic Pay  

0928  User must enter 0 in the Award Amount 
   
For NOAs 0926 Foreign Language Proficiency Pay and 0927 Chg in Foreign 
Language Proficiency Pay: 

 
 
For NOA 0928 Termination Foreign Language Proficiency Pay: 
 

 

 
 

Continued on next page 

Users will need 
to enter M for 
Money 

Award Amount must reflect a 
zero before update to HR is 
processed.  This will ensure that 
the FLPP element is end-dated 
and the NPA shows $0.00 in 
Block 20. 
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General Processing Information for Foreign Language Proficiency Pay 
(FLPP), Continued 
 

 
 

 

Step Action 
5 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Once the dollar amount has been entered in the Award window, it is automatically 
populated to the RPA  Extra Information  Foreign Language Proficiency Pay 
DDF.  For NOA 0926, user will be required to enter the Certification Date.  For NOA 
0927, the FLPP Certification Date from the employee’s record will populate into the 
RPA  Extra Information  Foreign Language Proficiency Pay DDF.  User has the 
capability to over-ride the Certification Date in this DDF. 
 
Note:  Users should not update the Amount data element in the RPA  Extra 
Information  Foreign Language Proficiency Pay DDF.  If the FLPP amount needs to 
be changed, user should go back to page 2 of the RPA and enter the correct amount. 

 

 
 

 
 

Continued on next page 
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General Processing Information for Foreign Language Proficiency Pay 
(FLPP), Continued 
 

 
 

 

Step Action 
6 
 

 
 
 
 
 
 
 
 

The table below describes what remarks are auto-populated or required inputs by user. 
 
 
Note: There are business edits in place to ensure the correct remarks are entered for 
each condition. 
 

IF NOA 
equals: 

AND 
Remark 
equals 

AND THEN  
Remark  is: 

0926 or 
0927 

Z28  Auto-populated 

0926  Z29 Intelligence Position Indicator equals 2 (Intel) Required input by 
user 

0926  Z30  Auto-populated 
0926 or 
0927 

Z31 Intelligence Position Indicator equals 2 (Intel) Required input by 
user 

0927 Z33  Auto-populated 
0928 Z36  Auto-populated 
0926 or 
0927 

Z74 Intelligence Position Indicator equals 1 (Non-
Intel) 

Required input by 
user 

 
Remark 
Codes 

Condition Description 

Z28 All FLPP is not a part of basic pay and is not counted towards 
retirement, insurance, or other benefits related to basic pay. 

Z29 Intel Foreign Language Proficiency Pay (FLPP) in the amount of 
$_____ per pay period authorized in accordance with 10 USC 
1596. 

Z30 All Foreign Language Proficiency Pay based on _____. 
Z31 Intel FLPP will terminate effective _____ unless proficiency is 

recertified IAW OSD Memorandum of 26 Jul 2005. 
Z33 All Foreign Language Proficiency Pay (FLPP) adjusted from $_____ 

to $_____ per pay period. 
Z36 All Termination of Foreign Language Proficiency Pay effective 

_____. 
Z74 Non-Intel FLPP will terminate effective _____ unless proficiency is 

Recertified IAW OSD Memorandum of 3 NOV 2006. 
 

 
 

Continued on next page 
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General Processing Information for Foreign Language Proficiency Pay 
(FLPP), Continued 
 

 
 

 

Step Action 
7 Upon Update to HR, DCPDS will create a Recurring Assignment Element – Foreign 

Language Proficiency Pay (NOA 0926), create a new Foreign Language Proficiency 
Pay Element and end-date the old element (NOA 0927) or end-date the existing 
Foreign Language Proficiency Pay Element (NOA 0928).   
 
For NOAs 0926 and 0927, the Foreign Language Proficiency Pay element effective 
date will be the RPA effective date.  For NOA 0928, the Foreign Language 
Proficiency Pay element will be end-dated as of the RPA effective date.   
 
Navigation Path: People  Enter and Maintain  Assignment  Entries 
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Payroll Interface Specifications 
 

 
 
A separate Pay500 will generate for NOAs 926, 927, and 928.  The effective date in columns 73-
78 will be the RPA effective date.  The FLPP amount will flow in columns 181-185 (Amount 
Award) for NOAs 926 and 927; for NOA 928, these columns will be blank. 
 

 
 

 
 
 

 
 

 

 

FLPP amount 
flows in Positions 
181-185  
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Module 9 

Non-Appropriated Funds (NAF)  
Using the DCPDS 

Module Overview 

  
Purpose This module introduces the information you need to process actions for Non-

Appropriated Fund (NAF) Employees.  Currently, the DCPDS only includes 
NAF employees serviced by Army, Air Force and the Defense Logistics 
Agency. 

  
Module Contents  

Topic Page 
Module Overview 1 
            Before You Begin 2 
            Terms 2 
            NAF Categories of Responsibilities 2 
            NAF Personnelist Navigation List 3 
Chapter 1:  Building NAF Positions 1-1 
            Building a NAF Position 2 
            Building a NAF Position’s Organization Address              19 
Chapter 2:  Building NAF Applicants 2-1 

Building a NAF Applicant  3 
Deleting or Purging a NAF Applicant 11 

Chapter 3:  NAF RPA 3-1 
            NAF RPA 2 
            Saving and Routing the RPA 7 
            Printing the RPA/NPA 12 
Chapter 4:  Updating and Viewing NAF Employee 
Records 

 
4-1 

Updating NAF Records 2 
Chapter 5:  NAF Mass Actions 5-1 

Processing NAF Mass Appraisals 2 
Processing NAF Mass Salary (Pay Adjustment) 9 
Processing NAF Mass Position Change Actions 16 

 
 
 

Continued on next page 
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Module Overview, Continued 

 
Before You 
Begin 
 

• The format for processing NAF actions is the same as processing 
appropriated fund employee actions, except a different RPA is used.    

• All the fundamentals of the system as explained in Module 1, 
Fundamentals, apply to NAF, i.e., Logging On, Navigation List, 
Switching Your User Responsibility, Changing Your Password, etc. 
• Your system administrator will set up your account and access 

privileges (“responsibility” categories). 
  

 
Terms  
 

Term  Definition 
Responsibilities  Designations of your system privileges and access.  A  

system administrator establishes your user account with 
one or more “responsibilities” assigned to access only 
those functions, forms, and data necessary to perform 
your duties.  Example:  CIVDOD NAF HR Manager and 
CIVDOD NAF Personnelist 

Roles Designations that describe each member’s workflow 
activities within a routing group or groupbox.  You can 
be assigned multiple roles in a routing group.  
 Example:   A user who can initiate RPAs might also be 
able to approve them.  You can use workflow routing 
regardless of your role(s). 

 
NAF  
Categories of 
Responsibilities 

Categories of responsibilities include (but are not limited to): 
• CIVDOD NAF HR Manager (Air Force) (Army) 
• CIVDOD NAF Personnelist (Air Force) (Army) 
• CIVDOD NAF Supervisor (Air Force) (Army) 

 
 

Continued on next page 
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Module Overview, Continued 

  
NAF 
Personnelist 
Navigation List 
 
 

The Navigation List shown below reflects the Air Force view.  There will be 
slight differences between the Air Force and Army. 
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Module 9 

Chapter 1 

Building NAF Positions  

Chapter Overview 

  
Introduction This chapter explains the position structures used in building NAF positions.  

It outlines data fields and flexfields unique to NAF-unique flexfields and also 
describes the data to be entered and maintained.     

   
Chapter Contents  

Topic Page 
Overview 1 
Building a NAF Position  2 
          Navigating to the Position Window 3 
          Completing the Position Window and Flexfields 4  
          Completing Extra Information 11 
          Validating the Position 18 
           Exiting the Position 18 
           About this Position 18 
Building a NAF Position’s Organization Address (POA) 19 
          Accessing and Completing the Organization Window 19 
          Completing the Additional Organization Information  22 
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 Building a NAF Position 
  

Purpose This section guides you through the steps of building a NAF position. A key 
responsibility of an HRO is the function of building positions in a serviced 
organization.  A position is required before an applicant can be appointed.   

  
Before You 
Begin 
 

• Business rules related to specific types of positions will dictate required 
data fields. 

• Some data items NOT used by NAF will auto-populate.  In those 
instances, you must open the flexfield, close, and save the information in 
order to pass the edits necessary to validate the position. 

• Some of the most frequently used data auto-populates from a previous entry 
when you open the flexfields.  
• In most cases, you have the ability to override the information if 

incorrect or if you need to change it.  
• In order for the information to store in the system, the flexfield must be 

opened, closed, and saved even if no changes are made. 
• You must validate the position at the main position window once all the 

required data has been input. 
• If a new position address is required, you must build it before you build 

your position.  See Building a Position’s Organization Address (POA). 
• CAUTION:  The position will validate without the POA, but you 

are unable to view the position if the Security List Maintenance is 
run, and will require System Administration assistance. 

• For new positions below the PAS Code (AF) or UIC (Army/DLA) level, 
the Position’s Organization (POA) is updated locally.  This 
information opens in the “TO” and “FROM” data fields on the RPA.  
All NAF POA’s begin with “NAF” 
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Building a NAF Position 

 
Navigating to the Position Window  
 

Step Action 
1 Select your responsibility from the Responsibilities window; i.e., 

CIVDOD NAF Personnelist (AF).  
2 Click the <OK> button.  The Navigator List opens. 
3 Navigation Path →Work Structures → Position → Description 
4 The Find Position window opens.  Use this window to query 

(Find) a position or begin (New) building a position.  

 
5 In the Position window, the cursor is in the Start Date data field 

and the current date is displayed.  If you need to change the date, 
use the Alter Effective Date Method (Date Track): 
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Building a NAF Position, Continued 

  
Completing 
the Position 
Window and 
Flexfields 
 

Examples provided are used for building an AF NAF position.  Army, AF 
and DLA NAF are different in some cases due to the unique requirements 
of each Component. 
 
Note:  For consistency, use all caps (upper case) to complete the data 
fields. 

 

Step Action 
1 
 
 
 
 
 
 
 
 
 
 

Select the Alter Effective Date  icon on the Toolbar.  The 
Alter Effective Date window opens with the cursor in the Effective 
Date data field: 

 
Change the Effective Date data field to a prior date by deleting the 
displayed date and entering a new date (DD-MMM-YYYY) or use 
the LOV. 
Note:  Once you save the position, you cannot go back and change           
the Start date. 

2 
 
 
 
 
 
 
 
 
 
 
 

 

Select the <OK> button.  The Position window opens with the new 
Start Date and the Altered Effective Date is show at the top of the 
screen. 

 
Click in the Date Effective Name data field.   

 
Continued on next page 
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Building a NAF Position, Continued 
Completing the Position Window and Flexfields (continued) 
 

Step Action 
3 
 
 
 
 
 
 
 

 

 
The Position flexfield window opens. [Tab] to each data field using 
the LOV to select the appropriate information then select the <OK> 
button. 

 
4 
 

The Position window opens with the Date Effective Name data 
field populated with the values created separated by a period.  

 
 

Continued on next page 
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Building a NAF Position, Continued 

  
Completing the Position Window and Flexfields (continued) 
 

Step Action 
5 
 

Click in the Organization data field then click the LOV to select 
the Organization.  To avoid a long delay accessing this long list, 
enter reduction criteria.  (Example:  %31%). 

 
 

6 After selecting the Organizations select the <OK> button. 

. 
 

Continued on next page 
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Building a NAF Position, Continued 

  
Completing the Position Window and Flexfields (continued) 
 

Step Action 
7 The Position window opens with Organization and Location data 

fields populated. 

 
Organizations are centrally maintained at the PAS Code or UIC 
Level.  Contact your component for adding an organization to the 
list. 
 
The Location data field (GSA Location) automatically populates 
from the organization selected and prints on the NPA. 
Note:  If the duty location is different from the organization 
location, you can override it with the correct duty location. 

8 Click in the Job data field and enter the four digits of the 
occupational series (Ex:  0189, 3566, etc.).  Tab to display the 
description or select the LOV icon to invoke the jobs window enter 
a % then click the <Find> button select the job and select the 
<OK> button. 

 
 

Continued on next page 
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Building a NAF Position, Continued 

  
Completing the Position Window and Flexfields (continued) 
 

Step Action 
9 Click in the Status data field then select the LOV icon for the 

availability status list. 

 
Ensure that ‘Active’ is highlighted and select the <OK> button. 

 
10 Click in the Descriptive Flexfield  (after the Status Box) to 

add additional position details. 
 

Continued on next page 
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Building a NAF Position, Continued 

  
Completing the Position Window and Flexfield (continued) 
 

Step Action 
11 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

The Additional Details window opens.  Use the LOVs or type the 
information in the data fields.     

 
Notes: 
1:  Army and DLA use the Unit ID Code.  AF uses the PAS Code. 
2:  The Servicing Office ID and Region must be consistent to enable 
automatic population of Personnel Office ID in the US Government 
Position Group 1 Flexfield. 
3:  Product Distr Instructions and Report Distr Instructions are 
based on Servicing Office ID and automatically populate during the 
initial entry with the ability to override.   
Caution:  If you override either of the Product Distr Instructions and 
Report Distr Instructions elements, and later change the Servicing 
Office ID, you must ensure the codes are correct and make changes if 
required. 

 
Select the<OK> button.   

 
Continued on next page 
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Building a NAF Position, Continued 

  
Completing the Position Window and Flexfield (continued) 
 

Step Action 
12 The Position window opens with the Descriptive flexfield populated. 

 
13 

Select the Save   icon on the Toolbar. The message line at the 
bottom indicates:  “Transaction complete: 1 records applied and 
saved.” 

 
The Status field shows “Invalid” at this point. 
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Building a NAF Position, Continued 

  
 
Completing 
Extra 
Information 
 

Examples provided are used for building an AF NAF position.  Army, AF, 
and DLA NAF are different in some cases due to the unique requirements 
of each Component. 
 
 

Step Action 
1 
 
 
 
 

Select the <Others>  button at the bottom of the 
Position window and select your specific function (Air Force 
Nonappropriated Fund, Army Nonappropriated Fund) in order to 
filter the results visible under Extra Information. 
Notes:   
1.  DLA Nonappropiated Fund will use Army Nonappropriated 
Fund for this field.  

2.  Directly selecting the <Extra Information>  
button at the bottom of the Position window will retrieve all 
position extra information data fields, to include those not required 
by NAF. 

2 The Extra Position Information window opens with position data 
on the Title Bar.  Under ‘Type’, select <Multiple Agency 
Information>  then click in ‘Details’.  
(The Details box will be blank.) 

 
 

Continued on next page 
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Building a NAF Position, Continued 

  
Completing Extra Information (Continued)  
 

Step Action 
3 Click in Details.  The <Multiple Agency Information>  

  flexfield opens with some fields 
populated. 

 
Note:  Status and Gun-Ammo Access ID are required data fields in 
order to successfully validate your position. 

4 Type in the information in the data fields or use the LOVs. 
5 Select the <OK> button then the Save icon. 

 
Continued on next page 

 
 



                                                                                                    R12                                                                         March 2012 

Building NAF Positions                            Mod 9, Chap 1, page 13 

 

Building a NAF Position, Continued 

  
Completing Extra Information (Continued)  

 
Step Action 

6 The Extra Position Information window opens again.  Select 
<Non-Appropriated Fund> from the list. Type 
in the information or use the LOVs to make a selection. 

 
Note:  There are a number of required data fields located in this 
area of DCPDS.  Each Component may have fields that differ from 
one another to successfully validate your position.  Check with the 
appropriate individuals to determine the additional data fields 
required for your agency. 

7 Select the <OK> button then the Save icon.  The message bar will 
indicate:  “1 records applied and saved.” 

 
 

Continued on next page 
 
 



                                                                                                    R12                                                                         March 2012 

Building NAF Positions                            Mod 9, Chap 1, page 14 

 

 

Building a NAF Position, Continued 

  
Completing Extra Information (Continued)  

 
Step Action 

8 The Extra Position Information window opens again.  Select 
 from the list.  Click in the Telework Indicator and 

select the applicable value from the LOV. 

 
9 Select the <OK> button then the Save icon.  The message bar will 

indicate:  “1 records applied and saved.” 
 

Continued on next page  
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Building a NAF Position, Continued 

  
Completing Extra Information (Continued)  
 

Step Action 
10 
 
 
 

The Extra Position Information window opens again.  Use the 
scroll bar to select .  Click in Details data 
field.   Type the information in the data fields or use the LOVs to 
select the appropriate data.  All NAF positions require a value of 
“Y” in Work Schedule. 

 
Notes:   
1.  Some data fields are auto-populated and should be changed if 
not correct for this position, or ignored, if not used.  Do not delete 
the data. There are a number of required data fields located in 
flexfield.  Each Component may have fields that differ from one 
another to successfully validate your position.  Check with the 
appropriate individuals to determine the additional data fields 
required for your agency. 
2.  The Servicing Office ID and Region entered earlier on the 
Additional Position Details window will give you a reduced list to 
make your selection for the Personnel Office ID.  If the two data 
items are not consistent, it will not populate or provide you with a 
reduced list.  You must go back to the Position window, 
Descriptive flexfield [  ] and review previous input. 

 
Continued on next page  
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Building a NAF Position, Continued 

  
Completing Extra Information (Continued)  
 

Step Action 
10 

(cont) 
Caution:  The position will validate without the Position’s 
Organization (POA), however; you will be unable to view the 
position if the Security List Maintenance is run, and will require 
System Administration assistance. 

11 Select the Save icon. 
12 On the Extra Position Information window, 

select . 
13 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click in the Details data field. The flexfield opens.  Use LOVs or 
type the information in the data fields.  Select <OK> and Save. 

 
Note:  Position Type will initially appear with the value of “APPR.”  
You will need to change the value to “NAF.” 

 
 

Continued on next page 
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Building a NAF Position, Continued 

  
Completing Extra Information (Continued)  
 

Step Action 
14 On the Extra Position Information window, select <US Federal 

Valid Grade Info> .  Using the LOVs, select 
the appropriate data.   Valid Grade, Pay Table ID, and Pay Basis 
are required data fields for all NAF positions. 

 
15 Select Save.   
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Building a NAF Position, Continued 

  
Validating the 
Position 

All positions must be validated prior to use. 

Step Action 
1 Close the Extra Position Information window to return to the 

Position window. 
2 Select the  button. 
3 If the position does not validate, you will receive a dialog box with 

an error message of data fields to fix.   
• Retrieve the Extra Position Information Flexfield(s) and 

make the corrections. 
• After correcting, return to the Position window to save your 

changes and validate the data. 
• Repeat until the Position window opens “Valid” in the 

Status Box. 
4 If the position validates, the Status Box on the Position window 

opens “Valid.” 

 
Exiting the 
Position 

Returning to the Navigation List. 
 

Step Action 
1 
 

Caution:  If you used the Alter Effective Date window to change 
the effective date of this position, click it again and click “Reset” 
to change the system date back to the current date. 

2 Click Action and Close Form on the Toolbar, or click the X at the 
top right-hand corner on the Position window to return the 
Navigation List. 

 
About this  
Position 

Information on who created the position and when, the table name, who 
updated the position and when, etc. is contained in ‘About This Record.’ 

 
Step Action 

1 Follow these steps to retrieve additional information about the 
position.  Click Help on the toolbar and click About This Record. 

2 The About This Record dialog box opens.  It provides information 
on who created the position and when, the table name, who updated 
the position and when, etc.  

3 Click the<OK> button to return to your action. 
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Building a NAF Position’s Organization Address (POA) 

 
Purpose 
 
 

This section explains how to build a NAF Position’s Organization Address 
(POA).  
Note:   This procedure will be required when a new organization has been 
added to the Position Hierarchy at the local level. 

 
Definition Position’s Organization Address (POA) - populates the “TO” and “FROM” 

data fields on the Request for Personnel Action (RPA) for Army, Air Force 
and DLA NAF, and the Notification for Personnel Action (NPA) for Army 
and DLA NAF. 
• When you build the position address, it will be available in building a 

position for a new organization.  
• To access the address, use the Building a NAF Position procedure after 

you have completed Building a NAF POA. 
• The Position’s Organization data field is located in the Extra Position 

Information window in the US Government Position Group 1 flexfield 
window. 

   
Accessing and Completing the Organization Window  
 

Step Action 
1 Navigation Path → Work Structures → Organization → Custom 

→ <Open>. 
2 The Find Organization window opens, select the <New> button. 

 
 

 
Continued on next page 
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Building a NAF Position’s Organization Address (POA), 
Continued 

 
Accessing and Completing the Organization Window (Continued)  
 

Step Action 
2 

con’t 
The Organization window opens with the From Date data field 
populated with the current date, or your date tracked dated.  
Internal or External data field autopopulates with Internal.   
In the Name data field of the Organization window, enter the 
unique name to identify the position’s address and select the Save 
icon. 
 

Examples:   
 

For AF NAF:  NAFWT1CF1YQSVBME equates to a NAF 
record:  

WT1CF1YQ = PAS Code 
SVBME = Office Symbol 
 

For Army and DLA NAF:   NAFW6D206DP1RHNPG3 equates to 
NAF record:                 
            W6D206 = UIC (must match the UIC entered into the 
position for which the POA will be used); 
 DP1RHNPG3 = Standard NAFI (must match the Standard 
NAFI entered into the position for which the POA will be used) 
             
Note:  If you built the position earlier, or will be effecting the 

action prior to the current date, set the Alter Effective Date   
to match; otherwise, the new POA will not be available on the 
LOV for Position’s Organization. 
Location and Location Address are not required.  Select the Save 
icon. 

 
Continued on next page 
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Building a NAF Position’s Organization Address (POA), 
Continued 

  
Accessing and Completing the Organization Window (Continued) 
 

Step Action 
3 
 
 
 
 
 
 
 
 
 

     

In the Name data field under Organization Classifications select 
Position’s Organization.  

 
 
This will cause the HR Organization to populate.   

 

4 Select the Save icon. 
5 Select the <Others> button and select US Federal Org Report 

Info.  Select the <OK> button.   
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Building a NAF Position’s Organization Address (POA), 
Continued  
Completing the Additional Organization Information Flexfield  
 

Step Action 
1 
 
 
 
 
 
 
 
 
 
 
 
 

 

The Additional Organization Information window opens. Click 
in the US Federal Org Report Info block and the US Federal Org 
Report Info flexfield window opens.  

 
 
Caution:  The first two data fields must be left blank.  (They are 
not connected to any other data fields, nor are they usable once you 
leave this form.) 

2 Type in the organization address information in the Org Info Lines 
1-3 in accordance with your agency’s instructions.  Each line 
allows up to 38 characters.  Select the <OK> button 

3 
 
 

The Additional Organization Information Detail is populated 
with the Organization Address. 

 
Select the Save icon, and then the<OK> button. When building 

another POA click on the  New icon to begin a new POA.  
4 The Organization window opens.  The new Position’s 

Organization Address (POA) is now available in the position by 
clicking the LOV for Position’s Organization in US Federal 
Position Group 1 flexfield window.  

5 Select File on the Main Menu then Close Form 
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Module 9 

Chapter 2 

Building NAF Applicants 

Chapter Overview 

  
Introduction To process an appointment action in the DCPDS, you must first enter the 

person as an applicant.   
 

   
Chapter Contents  
 

Topic Page 
Before You Begin 2 
Building NAF Applicants 3 
    Building a NAF Applicant  3 
    Building an Address 6 
    Accepting a NAF Applicant 7 
Deleting or Purging a NAF Applicant 11 

 
Continued on next page 
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Chapter Overview, Continued 

  
Before You 
Begin 

The system requires a two-day interim period between the date an applicant is 
entered and the date the person can be assigned to a position: 

• Day 1:  Build applicant (enter applicant data). 
• Day 2:  Change the applicant’s status to “Accepted.” 
• Day 3:  Appoint the applicant. 

Example:  To appoint an applicant to a position effective August 19, a prior 
date of at least two days must be used for entering the applicant (e.g., 17 
August or earlier).   
 
How to work around:  Use the DateTrack feature to work around this 
business rule, to input and appoint the applicant on the same workday.  Using 
DateTrack you: 

• Alter the effective date back at least two days to “enter” or build the 
applicant.   

• Alter the effective date again to at least one day forward from the date 
used to enter the applicant, and at least one-day before the 
appointment date; then, change the applicant’s status to “Accepted.” 

• Reset the effective date to the current date to “appoint” the applicant.   
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Building NAF Applicants  

  
Building a 
NAF 
Applicant 

The following procedures describe how to build a NAF Applicant.  Only the 
required data fields are described. 

 
Step Action 

1 Navigation Path → People → Enter and Maintain → <Open>.  
The Find Person window opens.  Select the<New> button. 

 
2 The People window opens: 

 
 

Continued on next page 
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Building NAF Applicants, Continued 

  
Building a NAF Applicant (continued) 
 

Step Action 
3 If you plan to appoint the applicant within the next two days, you 

need to alter the effective date in the system to meet the business 
rules described in the introduction.  To do this:  

• Select Alter Effective Date    on the Toolbar.   
• Alter the effective date so that it is at least two days prior to the 

date you wish to appoint the applicant.  There are two ways to 
alter the effective date; you can either: 

• Type over the highlighted data in the Effective Date data 
field (which opens the current date).  Use the format:  DD-
MMM-YYYY.  Then select the<OK> button 

• Click in the Effective Date data field and enter a date or 
select the LOV to display the calendar.  Select a date, then 
the <OK> button 

The altered effective date opens on the Title Bar of the People 
window. 

4 
 

 

Your cursor will be in the LAST data field of the NAME Region.  
Enter the applicant data, as described below. 
Note:  For consistency, use mixed case (upper and lower case) to 
complete the name data fields. 

Caution:  Press [Tab] each time you want to navigate to the next 
data field.  Do not use [Enter]. 

  
  Data Field Action  
  Last • Type in the last name of the applicant.  Press 

[Tab]. 
 
 

  First • Type in the applicant’s first name. 
• Press [Tab] several times until your cursor is 

in the Middle data field. 

 
 
 
 

 
Continued on next page 
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Building NAF Applicants, Continued 

  
Building a NAF Applicant (continued) 
 

Step Action 
4   Data Field Action  

(cont)  Middle 

 

• Type in a middle name or initial 
• Press [Tab]. 
Note:  If no middle name or initial, leave blank. 

 
 

  Gender • Select either Male or Female. 

 
Press [Tab]. 

 

  Action 
        

• Select Create Applicant from the LOV. 

 
• Select Applicant from the Person Types 

box. 

 

 

  Social 
Security 
Number 
 

 

• Type in the applicant’s SSN. 
• Use format NNN-NN-NNN (you must 

type in the dashes). 
• Press [Tab]. 

Note: If an employee holds two positions, each 
person record should be built with the correct 
SSN in this area.  Follow component guidance for 
building dual SSNs for entry into the 
Appointment.  

 

  Birth Date • Type in the applicant’s birth date, using the 
format:  DD-MMM-YYYY.  
• Press [Tab].  

 

     
 

Continued on next page 
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Building NAF Applicants, Continued 

 
Building a NAF Applicant (continued) 
 

Step Action 
5 
 
 
 

 

Save your action.  

The Message Line at the bottom of the window indicates 
“Working…” followed by “Transaction complete:  1 Records 
applied and saved.” 
Note:  The system calculates the applicant’s age and populates an 
Applicant Number in the Applicant data field. 

 
Building an 
Address 

It is optional to enter an applicant’s address when building an applicant.  
Component business rules will determine if it is required. 

 
Step Action 

6 In the People window, select the<Address> button.  The Address 
window opens.  Click in the Address block. 

 
 

Continued on next page 
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Building an Applicant, Continued 

  
Building an Address (continued) 
 

Step Action 
6 

cont 
 
 
 
 
 
 
 
 
 
 

Enter the Address Information into Line 1. Press [Tab] to the City field. 
Enter the City data field and press [Tab] to move to the State data field. 
Enter the State or select from the LOV to select the state from the list. 
Enter the Zip Code 
Select the <OK> button. 

 
7 The system automatically fills a “check” in the box to indicate this is a 

primary residence.  
Save your work and close the window. 

 
 
Accepting a 
NAF Applicant 

You are now ready to “Accept” the applicant. 
 

Step Action 
8 On the People window, select the Alter Effective Date    button on 

the Toolbar, and change the effective date to one day after the date you 
input the applicant data.  Select the<OK> button. 

9 Select the <Others> button.   
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Building NAF Applicants, Continued 

  
Accepting a NAF Applicant (continued) 
 

Step Action 
10 The Navigations Options window opens.  Select “Application” from 

the LOV then the <OK> button. 

 
11 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The Application window opens with the applicant’s name in the Title 
Bar.  

 
 
Note:  The Received Date data field populates.  

 
Continued on next page 
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Building NAF Applicants, Continued 

  
Accepting a NAF Applicant (continued) 
 

Step Action 
12 In the Assignment Region of the Application window, override the 

Organization data field with the employee’s correct organization.  
This allows you to see the applicant after Security List 
Maintenance runs.   Click in the Status data field (it will display 
“Active Application” as the status). From the LOV, select 
“Accepted” from the LOV then select the <OK>. 

 
13 The Status data field now opens “Accepted” and an Option 

window appears  asking to <Update> (keep the history) or 
<Correction>  (correct existing information).  Select the<Update> 
button. 

 
 

Continued on next page 
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Building NAF Applicants, Continued 

  
Accepting a NAF Applicant (continued) 
 

Step Action 
14 Select the Save icon. The From date in the Effective Dates Region at 

the bottom of the window changes (from the date used to enter the 
applicant to the date currently used to accept the applicant). 

15 The applicant is ready to be assigned to a position via the RPA. Return 
to the People window and reset the system date.   

• Select the Alter Effective Date    button on the Toolbar. 

• Select the<RESET> button.  This resets the effective date to the 
current date. Select the <OK> button. 

16 Close the window and process the appointment action. 

 
  



                                                                                                  R12                                                                            March 2012 

NAF:  Building NAF Applicants   Mod 9, Chap 2, page 11 

 

Deleting or Purging a NAF Applicant 

  
Introduction This section explains the steps for deleting applicants. 

  
Deleting or 
Purging a NAF 
Applicant 

You can delete an “accepted” applicant using DateTrack or you can 
completely remove or "purge" an applicant from the database. 

 
Step Action 

1 Navigation Path → People → Enter and Maintain → <Open>.  
The Find Person window opens.  Enter the applicants and select 
<Find>. 

2 The People window opens with the applicant data populated. 
Select the<Others> button. 

3 The Navigations Options window opens.  Select Application 
from the list and select the <OK> button. 

4 The Application window opens with the applicant’s name in the 
Title Bar.  With your cursor in the From data field (Effective 
Dates Region), alter the effective date to the day before this date.  
For example, if the From date is 02-Jul-2001, DateTrack to 30-
Jun-2001. 

5 
Select the Delete Record    icon on the Toolbar 

6 A dialog box opens asking if you are sure you want to delete this 
record.  Select the <Yes> button. 

7 A decision box opens, select the - <Next> button to remove the 
next change, or the <All> button  - to remove all scheduled 
changes, or select the <Purge> button -  to completely remove 
from the database. 

8 Select the Save icon  
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Module 9 

Chapter 3  

NAF RPA 

Chapter Overview 

  
Introduction This chapter describes the NAF RPA and the taskflow buttons to access 

unique NAF Descriptive Data Fields (DDF)s. 

   
Chapter Contents  
 

Topic Page 
Overview 1 
NAF RPA 2 
          Navigation 2 
          Taskflow Buttons 4 
                History 5 
                Extra Information  5 
                      Accessing the Extra Information Flexfields 6 
          Remaining Taskflow Buttons 7 
                Person  7 
                Position 7 
                Others 7 
Saving and Routing the RPA 7 

Saving the RPA 7 
Routing the RPA 7 
Routing Window 8 

Printing the RPA/NPA 12 
Printing from the Routing Window 12 
Printing from the Menu Bar or the Toolbar 13 

  
Before You 
Begin  

The NAF RPA within DCPDS prints on the SF 52.  The NAF NPA for Army 
and DLA produces the Army DA Form 3434 and the NPA for Air Force 
produces the Air Force Form 2545.   
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NAF RPA 

  
Purpose This section provides an overview of the unique features of the NAF RPA.   

Consult your Component for specific information. 

  
Navigation Army and Air Force have a separate RPA Navigation List.  DLA currently 

utilizes the Army RPA Navigation list.   
 
 Responsibilities and navigation for Army and DLA: 

 
CIVDOD NAF HR Manager (Army) 
CIVDOD NAF Personnelist (Army) 
 

 Navigation Path →  Req for NAF Personnel Action → Appointment → 
<Open> 

 
 Responsibilities and navigation for Air Force: 

 
CIVDOD NAF HR Manager (AF) 
CIVDOD NAF Personnelist (AF) 
 

 Navigation Path →  Req for NAF Personnel Action → Appointment → 
<Open> 

 
Continued on next page 
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NAF RPA, Continued 

 
Navigation 
(Cont) 

Page 1 of 4 of a Army or DLA NAF Appointment – Requesting Info: 

 
 

 Page 2 of 4 of a Army or DLA NAF Appointment – Position Data: 

 
 

 
Continued on next page 
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NAF RPA, Continued 

  
Navigation 
(Cont) 

  
Page 3 of 4 of a Army or DLA NAF Appointment – Employee And Position 
Data: 

 
 

 Page 4 of 4 of a Army or DLA NAF Appointment – Remarks and Address: 

 
   

Continued on next page 
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NAF RPA, Continued 

 
Taskflow 
Buttons  

There are five Taskflow Buttons at the bottom of the NAF RPA:  History, 
Extra Information, Person, Position, and Others.   

 

   
 <History>:  Scroll to the right to continue viewing the history of the RPA: 

 
  

<Extra Information>:  These are single occurring fields and store most of 
the employee information.  You will only see the fields associated with the 
type of NOA being processed.   

 
 

 
 

 
Continued on next page 

 

NAF RPA, Continued 
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Accessing the Extra Information Flexfields  

Step Action 
1 Select US Fed Payroll Type from the Extra Information list. 
2 
 

Click in the Details Box.  The US Fed Payroll Type window 
opens. 

3  Use the LOV icon to make a selection.  Select the <OK> button to 
update the flexfield. 

4 

 

Repeat process for those fields required by your Component. 
 
Note:  As you complete the Extra Information flexfields, save 
the RPA to your in box at least one time. 
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NAF RPA, Continued 

  
Remaining 
Taskflow 
Buttons 

<Person>:  Displays the People window.  There are five taskflow buttons 
which can be used to view information only.  To update these flexfields, refer  
to: 

• Module 1, Fundamentals: 
o Chap 5, Updating and Viewing the Employee Record 

• Module 9, Non-Appropriated Funds (NAF) Using DCPDS: 
o Chapter 4, Updating and Viewing NAF Employee Records 

 
<Position>:  Displays the Position window for viewing position data.  Refer 
to Module 2, Chapter 1, Building Positions for updating position data and 
Chapter 2, Building a NAF Position in this module. 
 
<Others>:  Army NAF/DLA NAF utilizes “Event History” found for 
tracking “Recruit/Fill” data.  Not Applicable for Air Force NAF. 

  
Saving and Routing the RPA 

  
Saving the RPA 
 Select the Save   icon to save the request for personnel action.  

      Or 
On the Main Menu Bar, select File → Save. 
      Or 
Select File → Save and Proceed. 

   
Routing the 
RPA 
 
 
 
 
 
 
 
 
 
 

Once you have saved your RPA, a dialog box displays. 

 
 
Select <Cancel> to stop the process and return to the RPA. 
      Or 
Select <No> to save your action to this point and return to the RPA.  
      Or 
Select <Yes> to display the Routing window.  
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Saving and Routing the RPA, Continued 

 
Routing 
Window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The Routing Window provides several options for processing your RPA.  
Select the option based on your role in the routing of your RPA. 
 

 
 

Notes:   
• The application defaults to the Save and Hold in Personal Inbox 

option. 
• Some of the options in the Routing window may be grayed out 

based on your role and responsibility. 
 

Continued on next page 
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Saving and Routing the RPA, Continued 

  
Routing Window (continued) 
 

Routing To Region Description/Function 
Select Routing List Select Select Routing List then select the LOV icon to 

display a Routing Lists window.  The listing defines 
the order in which a personal inbox or groupbox 
receives the workflow notification.   

 
 
Select the correct routing list then select <OK> to 
populate the data field. Then select <OK> on the 
Routing window to route the action. 

Select Person Select Select Person then select the LOV icon to display 
a Routing People window to route the action with a 
listing of individuals based on their role.   
Select the correct individual to route the action too.  
Select <OK> to populate the data field, then select 
<OK> on the Routing window to route the action to the 
correct person. 

 
 

Continued on next page 
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Saving and Routing the RPA, Continued 

  
Routing Window (continued) 
 

Routing To Region Description/Function 
Select Groupbox Click the Select Groupbox then select the LOV icon to 

display Routing Groupboxes window.  A groupbox 
contains a group of people who share a common 
function in the RPA process.  The Groupbox could 
contain members of an office, branch, workgroup, etc.  
Each Groupbox member’s role is individually defined 
and may or may not be identical to the roles of other 
Groupbox members. 

 
Select the correct Groupbox for routing the action based 
on its role in the RPA process.  Select <OK> to 
populate the data field, then select <OK> on the 
Routing window to route the action. 

Save and Hold in 
Personal Inbox 
 
 
 

 

Select this option if you have not finished working on 
the RPA.  It will be saved in your Civilian Inbox.  You 
can then select and complete the RPA action at a later 
time.   
Select <OK> to save the RPA to your workflow Inbox. 
Note:  The system automatically defaults to the Save 
and Hold in Personal Inbox option. 
You must save the action to your Inbox in order to 
query the RPA from your Inbox after the action has 
processed. 

 
Continued on next page 
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Saving and Routing the RPA, Continued 

  
Routing Window (continued) 
 

Routing To Region Description/Function 
Update HR 
 
 
 
 

 
 
 
 
 

 
 

You can select Update HR only if you have the 
assigned role and responsibility of updating the DCPDS 
database.  This procedure will generate a Notification of 
Personnel Action (NPA).  DCPDS applies the RPA data 
to the appropriate position and personnel records, 
replacing existing information with the new 
information. 
Selecting Update HR automatically places a “√” in the 
Print Notification box if the effective date on the RPA 
is a current or past date.   
 
Note:  DCPDS does an edit on the RPA when the 
Update HR option is selected; notifying you of 
corrections that need to be made before any Update HR 
can occur. 

Print Notification Discussed in the next procedure of this chapter. 
Approval 
 

Select the Approval box on the Routing Window if you 
are assigned the role of Approver.   

Interim Approval Not applicable for NAF. 
<Cancel> Select <Cancel> to stop the process and return to the 

RPA. 
<OK> 
 

 

Select <OK> to process the action and Update HR or to 
route the action to another inbox. 
Note:  Follow the instructions if an Error Message 
occurs. 
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Printing the RPA/NPA 

  
Printing There are several methods you can use to print the RPA or NPA.   

1. Print a Request for Personnel Action or a Notification of Personnel 
Action from the Routing window. 

2. On the Main Menu Bar select File → Print. 
3. Select the Print button on the Toolbar. 

 

   
Printing from the 
Routing Window 

This print action is performed when you Update HR from the Routing 
Window. 
 
Step Action 

1 Select the box next to Print Notification.  The system places an 
“X” in the box and the Printer data field is highlighted. 

2 
 

Click in the Printer data field, a Printers window opens listing all 
the printers that the system administrator has made available.  

3 Select the correct printer and <OK> to automatically populate the 
printer data field.   

4 

 

Select <OK> on the Routing window to print the action. 
Note:  You cannot print a future action with a future effective 
date. 

 
Continued on next page 
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Printing the RPA/NPA, Continued 

   
Printing from 
the Menu Bar 
or the Toolbar 

 

  
Step Action 

1 Select File →Print on the Main Menu Bar or select the Print 
button on the Toolbar.   

2 
 

The Printing window displays.  You have the option of printing 
the Request for Personnel Action (RPA).  The Notification of 
Personnel Action (NPA) is grayed out until on or after the 
effective date of a finalized personnel action.   

3  Make your selection based on the action you are completing.   
4 
 

Select the Printer data block to display a listing of printer options.  
Select the correct printer and <OK> to automatically populate the 
Printer data field. 

5 Select <OK> on the Printing window to print the action.  A Note 
window displays with information about your printing request. 

6 Select <OK>. 
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Module 9 

Chapter 4 

Updating and Viewing NAF Employee Records 

Chapter Overview 

  
Introduction This chapter explains the process for updating and viewing NAF employee 

records without using an RPA, i.e., education and appraisals.  Descriptive 
flexfields display data fields used for NAF personnel. 

   
Chapter Contents  

Topic Page 
Overview 1 
      Before You Begin 1 
      Updating NAF Records 2 
           Accessing the People Window 2 
           Updating an Employee’s Address 3 
           Updating and Viewing Assignment Information  5 
           Updating Extra Person Information  9 
           Updating Special Information 10 

   
Before You 
Begin 

The People window is used to update NAF employee information when an 
RPA/NPA is not required.  Taskflow buttons to access the DDFs and SITs 
are: 

• Assignment  (Links the Person record with the Position record for                    
                                   viewing only) 

• Extra Information (Single occurrence data) 
• Special Info (Multiple occurring data) 
• Others (Additional pay data)  

 
Note:  These DDFs reflect Army, Air Force and Defense Logistics 
Agency(DLA) data.  While the flexfields are the same, each component 
determines which data fields are to be completed. 
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Updating NAF Records 

 
Accessing the 
People Window 

This window is used to update an employee’s record with data that does not 
require an NPA, i.e., appraisals, non-monetary awards, training, etc. 

    
Step Action 

1 Navigation Path → People →Enter and Maintain → <Open>.  
The Find Person window opens.   

2 Query for the employees by their name.  The People window 
opens with five taskflow buttons: 

• Address 
• Assignment  
• Extra Information 
• Special Information 
• Others 

 
  

 

  



                                                                                                  R12                                                                             March 2012 

NAF:  Updating and Viewing NAF Records Mod 9, Chap 4, page 3 

 

Updating NAF Records, Continued 

 
Updating an 
Employee’s 
Address  

The Address window is available for updating and maintaining addresses.   

 
Step Action 

1 To update the employee’s address, select the <Address> button.  
The Address window opens.  

 
2 
 
 
 
 
 

Click in the Address data field.  The Personal Address 
Information window opens.  Enter the address information.    

 
Select <OK>. 

3 The Address window opens with the address information.   

 
 

Continued on next page 
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Updating NAF Records, Continued 

  
Updating a NAF Employee’s Address (continued) 
 

Step Action 
4 To include the type of address, click the LOV icon in the Type 

data field to select.  

 
There is only one Primary address.  You must deselect the check 

mark in the Primary Box for other addresses.   
5 
 

Select <OK> then the Save icon.  Exit the window.   
Note:  Normally Date Track is not used for updating addresses.  In 
those rare cases where there is a compelling reason to do so, be 
sure to reset the system back to the current date. 
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Updating NAF Records, Continued 

 
Updating and 
Viewing 
Assignment 
Information 

The Assignment window identifies the employee’s position data and 
position number.  You use this number when querying the Position to view 
and update other position data.  A simple method is:  Highlight the entire 
Position data field, and copy it (Ctrl C or Edit-copy from the menu), then 
paste the number into the Position window to run a query. 

 
Step Action 

1 In the People window, select the <Assignment> button.  The 
window opens showing position data.  There are three taskflow 
buttons.  NAF uses Entries and Extra Information only. 

• <Entries> 
• <Extra Information>  
• <Others>   

 
 

 
Continued on next page 
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Updating NAF Records, Continued 

  
Updating and Viewing Assignment Information (continued) 
 

Step Action 
2 
 
 
 
 

Select the <Entries> button.  The window contains pay, benefits, 
and entitlements and the Period data field contains current pay 
period information.  The data can be recurring or non-recurring.   
 
Note:  If you need to see prior information, date track to that pay 
period.  You can update some of the information if it does not 
require an NPA. 

 
3 In the Element Name column, select the element to view then    

The <Entry Values> button.  

 
 

Continued on next page 
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Updating NAF Records, Continued 

  
Updating and Viewing Assignment Information (continued) 
 

Step Action 
4 To add new element entries, place your cursor in the first blank 

Element Name line.  Select the LOV icon for the element entry 
you want to add.  (As a reminder, you may need to use Date Track 
to reflect the correct pay period.) 

5 Select the <Entry Values> button.  The associated Entry Values 
window opens.   

6 Enter the information then select the Save icon.   
7 Close the window.   
8 On the Assignment window, select the <Extra Information> 

button.  Assignment Extra Information contains read-only data for 
NAF.  To update the information contained in these fields, an RPA 
is required. 

9 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Extra Assignment Information window opens: 

 
 
Note:  The File ID Flag DDF is not used for NAF, even though it 
has NAF descriptions. 

 
Continued on next page 
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Updating NAF Records, Continued 

  
Updating and Viewing Assignment Information (continued) 
 

Step Action 
10 To view information contained in these fields, select the field then 

click in the Details data field.   

 
 

11 After making the selection select the <Cancel> button. 
12 Repeat these steps to view the remaining Extra Assignment 

Information types. 
 13 Close the Assignment window to return to the People window. 
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Updating NAF Records, Continued 

  
Updating Extra 
Person 
Information 

Extra Person Information displays as <Extra Information> on the People 
window.  Normally this stores information that occurs one time in an 
employee’s record.  If it is updated, the new information replaces the old 
values.  Use the following steps to access the different Types: 

Step Action 
1 In the People window, select the <Extra Information> button  

 
2 Use the scroll bar to move the Record Indicator to select the Type 

to be viewed or updated, Click in the Details data field to open 
window. 

 
 

3 Use the LOVs to select data or type in the required data, and then 
select <OK>. 

4 Repeat the previous steps to go through all of the required Extra 
Person Information Types.   

5 Upon completion, select the save icon and exit the Extra Person 
Information window.   
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Updating NAF Records, Continued 

 
Updating 
Special 
Information 

Special Information stores multi-occurrence information, i.e., appraisals, 
training, etc.  Use the following steps to access them: 

 
Step Action 

1 In the People window, select the<Special Info> button.  The 
Special Information - Query window opens. 

 
2 There are two methods to query for specific a Special Information 

Type (SIT).  The first is method to query is by title with a 
particular word or acronym such as “NAF”.   Place the cursor in 
the first Name field.  Press F11, then type in %NAF%. Followed 
by pressing both the CTRL + F11 buttons to execute the query.  

  
 

Continued on next page 
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Updating NAF Records, Continued 

  
Updating Special Information (continued) 
 

Step Action 
3 All Special Information types with NAF in the name will appear. 

Use the Scroll bar to view all the flexfields.  Select the record 
Name then double click in the Detail Box to bring up the flexfield.   

 
4 The second method to query is by “Information Exists”.  Query 

SITs that contain information from the record by placing the 
cursor in the first Name field and Press F11.   Check (√) the 
Information Exists block then press both the CTRL + F11 
buttons to execute the query.  

 
 

 
 

Continued on next page 
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Updating NAF Records, Continued 

  
Updating Special Information (continued) 
 

Step Action 
5 All Special Information types with information contained in the 

employee record appear. Notice that the Start Date is 11-Sep-
2003 in the example shown.  This is the last input date for the 
employee Appraisal – Non-Appr Fund.  Select the record Name 
then double click in the Detail Box to bring up the flexfield.   

 
6 To add new information in the SIT, click in the gray block under 

the Start Date.  In the example, the space under 11-Sep-2003 was 
used. 

 
This new Start Date autopopulates. 

 
 

Continued on next page 
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Updating NAF Records, Continued 

  
Updating Special Information (continued) 
 

Step Action 
7 Click in the yellow Detail block to add information. 

 
8 Enter the required data.  Then select<OK>. 
9 Upon completion, exit the Special Information window and 

return to the People window.  Select Save and Exit the window. 
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Module 10 

Local Nationals in the DCPDS 

Module Overview 

  
Purpose This module introduces the information you need to process actions for 

Department of Defense Local Nationals (LNs) located in overseas areas.  
Currently, there are 12 countries that have unique LN roles and 
responsibilities.  They are: 
 

Azores Japan 
Belgium Korea 
Cuba Saudi Arabia 
Egypt Germany 
Iceland Turkey 
Italy United Kingdom 

 
An LN generic role is used for non-specified countries; e.g., LN Personnelist, 
LN Classifier, etc.  

 
Module Contents  
  

Topic Page 
Module Overview  1 

LN Responsibility List 3 
LN Personnelist Navigation List - Generic 4 
LN Personnelist Navigation List  - Italy 5 
LN RPA Navigation List  6 

Chapter 1:  Building Local National Positions 1 
Overview 1 
Building an LN Position 2 

Chapter 2:  Building Local National Applicants 1 
Building LN Applicant    3 
Deleting or Purging an LN Applicant 9 

 
 

Continued on next page 
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Module Overview, Continued 

  
Module Contents (continued) 
 

Topic Page 
Chapter 3:  Local National Request for Personnel  Action 1 

Local National RPA 3 
Taskflow Buttons 6 
Local National NOAs 9 
Local National NOA Families 9 
Local National Request for Personnel Action 
Navigation List 

9 

LN Forms 10 
Chapter 4:  Updating and Viewing Local National 
Employee Records  

1 

Updating LN Records 2 
Accessing the People Window 2 
Updating an LN Employee’s Address 3 
Viewing Assignment Information 4 
Updating Extra Person Information 7 
Updating Special Information 9 
Updating Others 10 

Chapter 5:  Local National Mass Actions 1 
Processing LN Mass Appraisals 3 
Processing LN Mass Awards 11 
Processing LN Mass Realignment  22 
Processing LN Mass Salary 29 
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Module Overview, Continued 

  
Before You 
Begin 

The format for processing LN actions is the same as processing Appropriated 
Fund employee actions.  However, each country has unique data fields and 
Descriptive Data Fields (DDFs) to simplify the processes.   

• The Request for Personnel Action (RPA) is the same except: 
• Some of the data fields are grayed out. 
• The SSAN is not auto-populated.  (The data field is grayed out.) 
• The SSAN is input via the Extra Information Taskflow Button, 

selecting the Local National Unique Data Type and typing the 
SSAN in Employee ID Number data field. 

• There are only two Authority Codes on appointment actions, the 
remaining are grayed out. 

• Extra Information Taskflow Button will contain most of the 
employee information. 

   
LN 
Responsibility 
List  

Designated users will only see the roles and responsibilities for their country 
on the Navigator Window.  For example, a user in Germany may see one or 
more of the following responsibilities: 
 

CIVDOD LN HR MGR – GERMANY 
LN Classifier – Germany 
LN Personnelist – Germany 
LN Resource Manager – Germany 
LN Supervisor – Germany  

 
Continued on next page 
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Module Overview, Continued 

 
LN Personnelist 
Navigation List - 
Generic   

Below is an example of the Navigation List that is displayed when the 
generic LN Personnelist responsibility is selected. 
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Module Overview, Continued 

 
 
LN Personnelist 
Navigation List 
– Italy  

Each specified country has a distinct LN Personnelist Navigation List.  This 
is an example of the LN Personnelist – Italy Navigation List. 

 

 
Continued on next page 
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Module Overview, Continued 

   
RPA LN 
Navigation List  

Each specified country has a distinct RPA LN Navigation List.  This is an 
example of Italy’s expanded LN RPA Navigation List.  
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Module 10 

Chapter 1 

Building Local National Positions 

Chapter Overview 

  
Introduction This chapter explains the position structures used for Local National (LNs) 

positions in the DCPDS.  It outlines the unique data fields required for LNs.   

  
Chapter Contents  
 

Topic Page 
Overview 1 
Building an LN Position 2 

Accessing the Position Window 2 
Building an LN Position 2 

    
Before You 
Begin 

Building an LN position is the same as an Appropriated position, except there 
are unique LN Descriptive Data Fields (DDFs) that are used when 
appropriate.   
 
Note:  Some position fields are auto-populated by the system.  Users 
determine if the value that is auto-populated is appropriate or should be 
changed. 
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Building an LN Position 

  
Purpose This section explains how to build an LN position. 

  
Accessing the Position Window   
 

Step Action 
1 Select your responsibility from the Responsibilities window, i.e., 

LN Classifier, LN Personnelist, etc. 
2 Navigation Path → Work Structures  →  Position  →  

Description  →  <Open> 

  
Building an LN Position  
 

Step Action 
1 
 

In the Position window, follow the steps in Module 2, Chapter 1, 
Building Positions, starting with the section, “Completing the 
Position window and flexfields.”  

2 Continue the steps in section, “Completing the Additional Details 
window”, in Module 2, Chapter 1.   

3 Click the<Others> button at the bottom of the Position window.  
The Navigation Options window opens. 

4 Select the appropriate Agency (Ex:  Air Force Local National, 
Army Local National, and Navy Local National). 

5 Click the<OK> button.  The Extra Position Information window 
with position type (DDFs) displays. 

6 Complete the Extra Position Information data fields as described 
in Module 2, Chapter 1, section “Completing the Extra Position 
Information  

7 Continue following the steps in Module 2, Chapter 1, Section 
“Completing the Multiple Agency Information window, through 
“Validating the Position.”  

8 <Validate> the position. 
9 Select the<Save> button.  You can now use the validated position 

in your actions. 
 Note:  The Position Organization Address (POA) build is what 

prints on the RPA. 
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Module 10 

Chapter 2 

Building Local National Applicants 

Chapter Overview 

  
Introduction To process an appointment action in DCPDS, the person must be an 

applicant.  You can do this using one of the following methods. 

1. If a Talent Acquisition System (TAS) (e.g., USA Staffing or Resumix) 
is used for the recruitment and selection process, information about 
the applicant may automatically flow from the system to DCPDS. 

2. If a TAS is not used, enter the applicant data through the process 
explained below (referred to as “building” an applicant in the 
DCPDS). 

   
Chapter Contents  
 

Topic Page 
Before You Begin 2 
Building LN Applicants 3 

Accepting an LN Applicant 6 
Deleting or Purging an LN Applicant 9 

 
Continued on next page 
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Chapter Overview, Continued 

  
Before You 
Begin 

DCPDS requires a three-day process to have an applicant built, accepted, and 
assigned to a position: 

• Day 1:  Build applicant (enter applicant data). 
• Day 2:  Change the applicant’s status to “Accepted.” 
• Day 3:  Appoint the applicant to a position. 

Example:  To appoint an applicant to a position effective 10 February, a prior 
date of at least three days must be used for entering the applicant (e.g., 8 
February or earlier).   
 
How to work around:  Use the DateTrack  feature to work around this 
business rule, to build, accept, and appoint the applicant on the same 
workday.  Using DateTrack you: 

• Alter the effective date back at least two days to “enter” or build the 
applicant.   

• Alter the effective date again to at least one day forward from the date 
used to build the applicant, and at least one day before the 
appointment date; then, change the applicant’s status to “Accepted.” 

• Reset the effective date to the current date to “appoint” the applicant.   
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Building LN Applicants  

  
Building an 
LN Applicant 

The following procedures describe how to build an LN Applicant.  Only the 
required data fields are described. 

 
Step Action 

1 Navigation Path → People → Enter and Maintain → <Open>.  
The Find Person window opens.  Select the <New> button. 

 
2 The People window opens: 

 
 

Continued on next page 
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Building LN Applicants, Continued 

  
Building an LN Applicant (continued) 
 

Step Action 
3 If you plan to appoint the applicant within the next two days, you need 

to alter the effective date in the system to meet the business rules 
described in the introduction.  To do this:  

• Click the Alter Effective Date   icon on the Toolbar.   
• Alter the effective date so that it is at least two days prior to the 

date you wish to appoint the applicant.  There are two ways to alter 
the effective date; you can either: 

• Type over the highlighted data in the Effective Date data field 
(which opens the current date).  Use the format:  DD-MMM-
YYYY.  Then click <OK>. 

Or 

• Click in the Effective Date data field and click the LOV to 
display the calendar.  Click a date, and then click <OK>. 

The altered effective date appears on the Title Bar of the People 
window. 

 
4 
 

 

Your cursor will be in the LAST data field of the NAME Region.  
Enter the applicant data, as described below. 

Caution:  Press [Tab] each time you want to navigate to the next data 
field.  Do not use [Enter]. 

  Data Field Action  

  Last • Type in the last name of the applicant.  
Hyphens may be used.  The system accepts 
mixed case (e.g., Smith not SMITH) and data 
converted from the legacy DCPDS system 
will be in mixed case.  Follow your business 
rules entering the applicants’ name. 

 
 

 
Continued on next page 
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Building LN Applicants, Continued 

  
Building an LN Applicant (continued) 
 

Step Action 
4 

(Cont) 
 Data Field Action  

  First • Type in the applicant’s first name. 
• Press [Tab] several times until your cursor is in 

the Middle data field. 

 

  Middle • Type in a middle name or initial, if appropriate. 
• Press [Tab]. 

 
 

  Unknown 
Gender 

• Select the “M” key for Male or “F” for Female 
or make your selection from the LOV. 

 
Press [Tab] or click in the Action data field. 

 

  Action Select the LOV icon and select Create Applicant. 

 

 

  Person Type 
for Action 
        

• Click the LOV and select Applicant.   
• Click the<OK> button.  

 

 

  Social 
Security 
Number 

Note:  Leave this data field blank.  It will be 
entered in the appointment process.   

 

  Employee • No action – automatically populated.  
  Applicant • No action – automatically populated   

 
Continued on next page 
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Building LN Applicants, Continued 

  
Building an LN Applicant (continued) 
 

Step Action 
4 

(Cont) 
 Data Field Action  

  Birth Date • Type in the applicant’s birth date, using the 
format:  DD-MMM-YYYY.   

 

5 
 
 

 

Click the Save icon.  
The spinning Internet globe indicates the system is working, followed 
by “Transaction complete:  1 Records applied and saved.:, bottom left 
of screen. 
Note:  The system calculates the applicant’s age and populates an 
Applicant Number in the Applicant data field. 

 
Accepting an 
LN Applicant 

You are now ready to “Accept” the applicant. 
 

Step Action 

6 On the People window, click the Alter Effective Date   icon on the 
Toolbar, and change the effective date to one day after the date you 
input the applicant’s data.  Select the <OK> button. 

7 Select the <Others> button.   
8 The Navigations Options window opens.  Select “Application” from 

the list and click the <OK> button.   

 
 
 

Continued on next page 
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Building LN Applicants, Continued 

  
Accepting an LN Applicant (continued) 
 

Step Action 
9 
 
 
 
 
 
 
 
 
 
 
 
 

 

The Application window opens with the applicant’s name in the Title 
Bar.  

 
Note:  The Received Date data field populates. 

10 In the Assignment Region of the Application window, click in the 
Status data field (Active Application will be displayed). 
Select the LOV icon then select “Accepted” from the list and click the 
<OK> button. 

 
The Status data field now displays “Accepted”. 

 
Continued on next page 
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Building LN Applicants, Continued 

  
Accepting an LN Applicant (continued) 
 

Step Action 
11 An Option window opens, asking you to choose <Update> or 

<Correction>.  Select the <Update> button. 

 
12 Select the Save icon The From date in the Effective Dates Region at 

the bottom of the window changes (from the date used to enter the 
applicant to the date currently used to accept the applicant). 

Exit the windows and return to the People window to reset the system 
date.   

13 The applicant is ready to be assigned to a position via the RPA. 

• Select the Alter Effective Date   icon on the Toolbar. 

• Select the<RESET> button this resets the effective date to the 
current date  

• Select the<OK> button. 
14 Close the window and process the appointment action. 
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Deleting or Purging an LN Applicant 

  
Introduction This section explains the steps for deleting LN applicants. 

  
Deleting or 
Purging an LN 
Applicant 

You can delete an “accepted” LN applicant using DateTrack or you can 
completely remove or "purge" an applicant from the database. 

Step Action 
1 Navigation Path → People → Enter and Maintain → <Open>.  

The Find Person window opens.  Query for the LN applicant. 
Then Click the <Find> button. 

2 The People window opens with the LN applicant data populated. 
Click the<Others> button. 

3 The Navigations Options window opens.  Select Application 
from the list then click the<OK>button 

4 The Application window opens with the LN applicant’s name in 
the Title Bar.  With your cursor in the From data field, alter the 
effective date to the day before this date.  For example, if the 
From date is 02-Jul-1998, DateTrack to 30-Jun-1998. 

 
 

Continued on next page 
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Deleting or Purging an LN Applicant, Continued 

  
Deleting or Purging an LN Applicant (continued) 
 

Step Action 
5 

Click the Delete Record    on the Toolbar. 
6 A popup dialog box opens asking, “Do you really want to delete 

this record?” If you are sure you want to delete this record.  Click 
the <Yes> button. 

7 A decision box opens, asking which action to perform: 
<Next>   -   to remove the next change, or 
<All>      -   to remove all scheduled changes, or 
<Purge>  -  to completely remove from the database. 

  To Remove Acceptance of 
the LN Applicant. 

To Purge the LN Applicant 
Record. 

 

  1.  Select <Next>.  This will 
remove acceptance of the LN 
applicant. 

Select <Purge>.  This will 
remove the LN applicant from 
the database. 

 

  2.  Select Save.   
  3.  Reset the DateTrack date.   
  4.  Close the Application 

Window.  The People 
Window opens. 

  

  5.  Select the Delete Record 
button on the Toolbar. 

  

  6.  A Dialog Box opens, 
asking if you are sure you 
want to delete the record.  
Select the<Yes> button. 

  

  7.  Select the Save icon.   
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Module 10 

Chapter 3  

Local National Request for Personnel Action 

Chapter Overview 

  
Introduction This chapter describes the Local National (LN) Request for Personnel Action 

(RPA) and the taskflow buttons to access unique LN Descriptive Data Fields 
(DDF)s. 

   
Chapter Contents  
 

Topic Page 
Overview 1 
Before You Begin 2 
Local National Request for Personnel Action 3 

Taskflow Buttons 6 
History 6 
Extra Information  6 
Accessing the Extra Information DDFs 7 
DDFs Used with Most Local National Actions 8 
Remaining Taskflow Buttons 9 

Local National NOAs  9 
Local National NOA Families 9 
Local National Request for Personnel Action 
Navigation List 

9 

Local National Forms 10 
 
 

Continued on next page 
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Chapter Overview, Continued 

 
Before You 
Begin  

• The LN RPA process is the same as the Appropriated Fund RPA, 
except: 
• Some of the data fields are grayed out and the information must be 

input through the Extra Information Taskflow Button DDFs, i.e. 
Awards, Separations, etc. 

• A SSN is not used by local national employees, therefore the SSN 
is not auto-populated on page 1 of the RPA.  Local National 
records use the Employee ID number instead located by selecting 
the Extra Information Taskflow Button.  Select the Local 
National Unique Data Type.  Click the Details area and input the 
Employee ID Number in the Employee ID Number data field. 

• There are unique NOAs for each country.  Those prefixed with an 
“X” must only be used with a correction action. 

• There are three Authority Codes for LN actions, which may be 
optional depending on the country. 

• Extra Information Taskflow Button contains most of the 
necessary employee information in the DDFs. 

• Special Information (SITs) Taskflow Button contains multiple 
occurrence fields, i.e., training, appraisals, language, etc. 

• Italy and Germany users must refresh the RPA (use the Refresh 
Button at the top of the RPA) prior to update to invoke salary 
computations. 

 
Note:  Just as with the Appropriated Fund actions, the <Person>, <Position>, 
and <Others> Taskflow Buttons are used only to view information.  You 
cannot update this information through the RPA.  Most updates must be 
processed separately on the Position or People Windows. 

  
See also 
      

Follow the process for completing an RPA as described in Module 3, 
Processing Requests for Personnel Actions Using the Modern DCPDS, 
Chapter 1, Processing a Request for Personnel Action. 
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Local National Request for Personnel Action  

 
Purpose This section illustrates the LN RPA using an Appointment Action. 

 
LN Request for 
Personnel 
Action Window 
 
 
 
 
 
 
 
 
 
 
 

Navigation Path → Req for LN Personnel Action →LN Appointment →       
< Open> 
The Request for Personnel Action - Page 1 of 4: 

 
 
SSN is not available for LN records in this format.  It is entered in the Employee ID 
Nbr on the Extra Information → LN Unique Data DDF. 

Continued on next page 
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Local National Request for Personnel Action, Continued 

   
LN Request for 
Personnel 
Action Window 
(Cont) 

The Request for Personnel Action - Page 2 of 4:   

 

  
 The Request for Personnel Action - Page 3 of 4:   

 
 

Continued on next page 
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Local National Request for Personnel Action, Continued 

    
 The Request for Personnel Action - Page 4 of 4: 

 
   

Continued on next page 
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Local National Request for Personnel Action, Continued 

 
Taskflow 
Buttons  

There are five Taskflow Buttons at the bottom of the LN RPA:  History, 
Extra Information, Person, Position (B), and Others…(D).  They work the 
same as those on the Appropriated Fund RPA.   

 

 
   

 
History  
 
 
 
 
 
 
 
 
 

 

<History>:  Use the scroll bar at the bottom of the window to scroll to the 
right to view additional information on the LN RPA. 

 
 

 
Extra 
Information  

There are 12 Extra Information Types (DDFs) that are used by all countries.  
There may be additional DDFs that are component and country unique.   
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Local National Request for Personnel Action, Continued 

 
Accessing the  
Extra  
Information  
Appointment  
Types  

Step Action 
1 Place the Current Record Indicator next to Extra Information 

Type.  It will be highlighted.  For example, the Local National 
Unique Data Type.  

2 
 
 
 
 
 
 

Click in the Details area to display the Extra PA Request 
Information window 

 
3 Enter data, select <OK> and <Save>. 

 

 
DDFs Used 
with Most LN 
Actions 

Use the above steps to access and input information in the required data 
fields.  Examples of the remaining Extra Information Types follow. 
 

 US Fed Payroll Type:  Use the LOV to populate the Payroll Type, by selecting the 
appropriate pay cycle (monthly, biweekly, etc.). Must complete all data types on new 
appointments  

 LN Additional Information 
 Local National Unique Data 
 Print Auto-Generated Reports 
 LN Army Unique Information 
 LN Education Information for 1/5/7/9 NOAs 
 LN Other Information 
 LN Security Information 
 LN Other Information 
 LN Supplemental Pay:  This DDF allows input of more than one entry.  After completing 

the DDF, place the cursor on the next available line on the Extra PA Request Information 
window and click to add another supplement type 

 LN Global Information 
 LN Optional Information 
 LN Pay & Hours Information:  Fill in the Weekly Hours data field on Appointment and 

Conversion actions, so it will print on the RPA and NPA. 
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Local National Request for Personnel Action, Continued 

   
Remaining 
Taskflow 
Buttons 

<Person>:    Only used for viewing the person data, cannot be updated on the  
          RPA.  (See Chapter 4, Updating and Viewing LN Employee 
          Records in this module.) 

<Position>:  Only used for viewing position data.  (See Chapter 1, Building  
          LN Positions in this module.) 

<Others>:    Not used on the RPA for LNs. 

 
LN NOA s All LN NOAs will have 4 characters i.e. 170B, 5955, or 59CI.  The  

X-prefixed NOAs are used only on correction actions.   

 
LN NOA 
Families  

The LN NOA Families are listed below in the order as displayed on the RPA 
Navigation List.  Generic LN RPAs are used as an example.  These families 
are the same as those used by other countries. 
 
Note:  The X prefixed NOAs are not used with these actions.  They are used 
only on correction actions through the DoD correction process. 

 
 

LN Request 
for Personnel 
Action 
Navigation 
List 

 
 

Continued on next page 
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Local National Request for Personnel Action, Continued 

  
LN Forms The following forms are used for LNs processing. 
 

Country Forms 
Local Nationals Belgium SF 52 
Local Nationals Germany AE690-60B – Notification of Employment 

Status Army 
 AF Form 825 - Notification of Personnel 

Action Air Force (Non-US) 
 AE690-60A - RPA Army 
 USAFE Form 52 - RPA Non-US Air Force 
Local Nationals Italy SF 50  (Italian Version) 
 SF 52  (Italian Version) 
Local Nationals Japan USFJ Form 11EJ 
Local Nationals Korea SF 50 (Korean Version) 
 SF 52 (Korean Version) 
Local Nationals Generic –
(All other  

SF 50 

countries that are not 
specifically identified above) 

SF 52 
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Module 10 

Chapter 4 

Updating and Viewing Local National Employee Records 

Chapter Overview 

  
Introduction This chapter explains the process for updating and viewing Local National 

(LN) employee records without using an RPA, i.e., training, education, 
appraisals, etc.  Most countries use the Descriptive Data Fields (DDFs) 
illustrated.  Germany LN DDFs are used as examples.  Unique DDFs used by 
other specified countries are also illustrated.   

   
Chapter Contents  

Topic Page 
Before You Begin 1 
Updating Local National Records 2 

Accessing the People Window 2 
Updating an LN Employee’s Address 3 
Viewing Assignment Information  4 
Updating Extra Person Information  7 
Updating Special Information 9 
Updating Others 10 

  
Before You 
Begin 

The People window is used to update LN employee information when an LN 
RPA/NPA is not required.  Taskflow Buttons used are:  

• Address 
• Assignment  (Links the Person record with the Position record for 

viewing purposes only) 
• Extra Information (Contains single occurrence data) 
• Special Info (SITs) (Allows for multiple occurrences of data) 
• Others (Additional pay data - used only by Cuba – There is no 

payroll interface for other LN employees.)  
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Updating LN Records 

 
Accessing the 
People Window 

This window is used to update an employee’s record with data that does not 
require an NPA; e.g., appraisals, non-monetary awards, training, etc. 

    
Step Action 

1 Navigation Path → People → Enter and Maintain → <Open>.  
The Find Person window opens.   

 
2 Query for the employee by name, Sequence Number, Applicant 

Number, or Employee ID number.  The People window opens with 
the employee data populated and five Taskflow Buttons. 

• Address 
• Extra Information 
• Assignment  
• Special Info 
• Others…  
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Updating LN Records, Continued 

 
Updating an LN 
Employee’s 
Address  

The Address window is used by those countries that maintain LN address 
information.  The address is not updated by payroll as for Appropriated Fund 
records. 

 
Step Action 

1 In the People window, determine if you need to change the current 
date.  If the effective date of the change is not the current date, click 

Alter Effective Date   on the Toolbar and input the correct 
date.   

2 To update the employee’s address, select the<Address> button.  
The Address window opens with the Federal International 
defaulting in the Style data field.  

 
3 Click in the Address data field to enter the address information.  

Use the LOV to select the country. 

 
4 After entering the address information, select the <OK> button and 

then the Save icon.   
5 
 

Exit the window.   
Note:  If you Altered the Effective Date, you must reset the date 
to the current date. 
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Updating LN Records, Continued 

 
Viewing 
Assignment 
Information 

The Assignment window identifies the employee’s position data and position 
number.  You can use this number to retrieve the Position to view and update 
other position data.  A simple method is to highlight the entire Position data 
field, copy it (Ctrl C or Edit – Copy from the Main Menu Bar), then paste the 
number into the blank Position window to execute a query. 

 
Step Action 

1 In the People window, select the<Assignment> button the window 
opens showing position data.  There are three Taskflow Buttons on 
this window.      

• <Entries>  
• <Extra Information> 
• <Others>  
   

 
 

Continued on next page 
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Updating LN Records, Continued 

  
Viewing Assignment Information (continued) 
 

Step Action 
2 Select the<Entries> button.  The window opens.  It contains pay-

related information for the current pay period.  Use DateTrack if 
you need to view past data.  You can update some of the 
information or add an element, if RPA/NPA is not required. 

 
3 In the Element Name column select the element to view, i.e., LN 

Within Grade Increase.  Select the<Entry Values> button.  The 
Entry Values window opens. 

 
 

Continued on next page 
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Updating LN Records, Continued 

  
Viewing Assignment Information (continued) 
 

Step Action 
4 Save work and close both windows to return to the <Assignment> 

window 
5 On the Assignment window, click the <Extra Information> 

button.   
6 The Extra Assignment Information window opens.   

 
7 Use the scroll column to select the Type needed then click in the 

Details data field.  Repeat this step for each Type to be viewed. 
Examples of Types: 
Assignment NTE Dates  
File Flag ID 
LN Additional Assignment Information 
LN Assignment NTE Dates 
LN Assignment Non SF52 
US Federal Assignment RPA 

8 Save work after inputting data in each of the data fields.  Select the 
<OK> button to return to the Assignment window.  Close the 
windows and return to the People window. 
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Updating LN Records, Continued 

  
Updating Extra 
Person 
Information 

Extra Person Information stores information that occurs one time in an 
employee’s record.  If it is updated, the new information replaces the old 
values.  Use the following steps to access the different Types. 

 
Step Action 

1 In the People window, select the<Extra Information> button.   

 
2 Use the scroll column to select the Type to be viewed or updated. 
3 Select in the Details data field.  To open window (DDF)  

4 View or enter any required data. Into the field then select the 
<OK> button 

5 Repeat the above Steps for each required Type and DDFs.   
 

Continued on next page 
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Updating LN Records, Continued 

  
Updating Extra Person Information (continued) 
 

Step Action 
5 

(cont) 
These are the examples of remaining Type: 
Army Local National 
Handicapped Additional Info 
LN Military/Veteran Information 
Information Assurance Basic Data 
LN Person Group 1 
LN Person Group 2 
LN Probations 
LN SCD Information 
LN Security Information 
LN Separation and Retirement 
Local National Conduct/Performance 
Navy Security Information 
Personnel Contingency Area 
US Federal Retained Grade 

6 Upon completion, exit the Extra Person Information window and 
return to the People window. 
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Updating LN Records, Continued 

 
Updating 
Special 
Information 

The Special Information (SIT) Taskflow Button stores multi-occurrence 
information; e.g., appraisals, training, etc.  The following steps are used to 
access the SIT. 

  
Step Action 

1 In the People window, click the<Special Info> button.  The 
Special Information window opens with the employee’s name.  

2 Query for the LN SITs.  Press the F11 key to clear the Name data 
field enter %LN% then press CTRL + F11 keys together The LN 
Special Information Types display. 

 
Note:  There are other SITs that may not begin with “LN” that 
may be necessary to use. 

3 Select the Name of the SIT and click in the Detail data field to 
open window.   Examples: 

LN Adverse Action Info  
LN Appraisal Information 
LN Conditions of Employment 
LN Conduct/Performance Army 
LN Education Information 
LN Language Information 

4 Upon completion, exit the Special Information window and 
return to the People window.  Save your work.  
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Updating LN Records, Continued 

  
Updating 
Others 

The <Others> Taskflow Button is used only to accept applicants.  See this 
module, Chapter 2, Building Local National Applicants, section, “Accepting 
an LN Applicant.”  

   
Step Action 

1  
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Module 10 

Chapter 5 

Local National Mass Actions 

Chapter Overview 

  
Introduction This chapter explains how to process Local National (LN) mass actions. 

• Mass Awards; preview and final 
• Mass Appraisals; preview and final 
• Mass Realignment; preview and final 
• Mass Salary; preview and final 

  
Topic Page 

Processing LN Mass Appraisals 3 
Before You Begin 3 
Processing a Mass Appraisal 4 

Previewing Your Action 5 
Validating the Mass Appraisal 8 
Executing the Mass Appraisal 10 

Processing LN Mass Awards 11 
Before You Begin 11 
Creating a Mass Awards File 12 

Previewing a Mass Award File 15 
Changing a Mass Award File 17 
Executing a Mass Award File 18 
Viewing the Status of a Mass Award File 19 
Locating and Correcting Errors 21 

Processing LN Mass Realignment 22 
Before You Begin 22 
Processing a Realignment 23 

Previewing and Executing the Realignment 27 
 
 

Continued on next page 



                                                                                                   R12                                                                            March 2012 

Local National Mass Actions                                    Mod 10, Chap 5, Page 2 

Chapter Overview, Continued 

  
Topic Page 

Processing LN Mass Salary 29 
Before You Begin 29 
Processing a Mass Salary  30 

Previewing Your Action 33 
Executing the Mass Salary 35 
Viewing the Status of a Mass Salary File 36 
Locating and Correcting Errors 38 
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Processing LN Mass Appraisals 

    
Purpose This section explains how to process LN mass appraisals for a group of 

similar appraisals. 

    
Before You 
Begin 

• Use mass appraisals when you want to update multiple records at one 
time. 

• When you process LN mass appraisals, the People Record in HR is 
updated.   
• An RPA is not produced as it is with other mass actions.  
• There is no NPA (LN SF 50 equivalent form) generated. 

• You can export the data from the Preview window to an Excel 
spreadsheet. 

  
Who Does It 

       

The capability to create and execute a mass appraisal is available only in the 
LN Personnelist or CIVDOD LN MGR responsibility. 
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Processing LN Mass Appraisals, Continued 

  
Processing a Mass Appraisal (Continued)  
 

Step Action 
1 
 

Navigation Path → Mass Actions → Mass Appraisal Final → 
<Open>. 
 
Notes:   
• The Mass Appraisal (Preview) window is available as a 

“rough draft” window.  It is exactly like the Mass Appraisal 
(Final) window. Mass appraisals can only be processed in this 
window. 

• Components may want to use both forms; however, for 
security reasons, limit the number of personnel who can run 
the final process.  

2 The Mass Appraisal (Final) window opens with three taskflow 
buttons.  With your cursor in the Name data field, type in a unique 
name for the appraisal action you are creating. 

 
 
Note:  The Status data field is system-generated to show how far 
your mass appraisal has progressed when you save your action; 
e.g., Unprocessed, Submitted, etc.  No action is required. 

 
Continued on next page 



                                                                                                   R12                                                                            March 2012 

Local National Mass Actions                                    Mod 10, Chap 5, Page 5 

Processing LN Mass Appraisals, Continued, Continued 

  
Processing a Mass Appraisal (Continued) (continued) 
 

Step Action 
3 • The Description data field is free text you type in to describe 

your action and can accommodate 100 characters.   
• The Source Criteria Region allows you to enter data to define 

the employees to be included in the Mass Appraisal process.   
• The Organization data field must be completed.  
• The other data fields merely allow you to further define the 

select criteria, if desired. 
• The Appraisal Details Region must be completed for 

Appropriated Fund actions, because of OPM CPDF edits.  LNs 
are not subject to the edits, however some data fields are 
required: 

  Data Field Description  
  Appraisal Type Automatically populates with 

Code A.  You can overwrite it 
with codes on the LOV. 

 

  Rating of Record As required by SOFA  
  Rating of Record Pattern Not required for LNs.  
  Rating of Record Level As required by SOFA  
  Date Appraisal Due Required for LNs.  
  Date Effective Required for LNs.  
  Appraisal Period End Date Not required for LNs.  

 
Previewing Your 
Action 

Clicking the <Preview> button on the Mass Appraisals (Final) window 
opens the Mass Appraisals (Preview) window.  Based on the information 
input in the Source Criteria on the previous window, employees are 
identified and displayed in alphabetical order, along with their SSAN.  The 
names for the mass appraisal can be viewed and selected or deselected.  
Follow the steps below to preview the action. 

 
Continued on next page 
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Processing LN Mass Appraisals, Continued, Continued 

  
Previewing Your Action (continued) 
 

Step Action 
4 In the Mass Appraisals (Final) window, click the <Preview> 

button.  The Preview window opens with data elements populated 
from the previous window.   

 
Note:  The check mark in the Appraisal checkbox indicates the 
name on the line is included in the mass appraisal action.  Deselect 
the check mark if the name is not to be included.   
• If a large number of names appear on the window, but only a 

few are to be included: 
• Click the <Select/Deselect All> button to remove the 

check mark from the checkboxes.   
• Then select the names to be included by individually 

placing a check mark in the checkbox next to the 
names. 

 
Continued on next page 
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Processing LN Mass Appraisals, Continued, Continued 

  
Previewing Your Action (continued) 
 

Step Action 
4 

(Cont) 
The Appraisal checkbox opens next to the Name and SSN 
columns.  The LN ID appears in the SSN column.  You can scroll 
through the remaining columns with the Name and LN ID always 
visible.  Information may or may not populate the columns.  The 
remaining columns are provided below with annotations. (N/A) 
means not required for LNs. 

            Column                                       Column 
  Org Structure ID Target Bonus Indicator 

(Demo) (N/A) 
 

  Office Symbol Target Bonus Reason 
(Demo) (N/A) 

 

  PAS Code (Air Force only) Target Appraisal Type 
(Since user can overwrite the 
default code in the Appraisal 
Details, it may vary among 
selected records.) 

 

  PAS Code Description Target Rating of Record 
(Required input from LOV) 

 

  Unit Id Code (Army or Navy 
only) 

Target Rating of Record 
Level  (N/A) 

 

  Unit Id Code Description Target Rating of Record 
Pattern (N/A) 

 

  Employing NAFI  (N/A) Target Factor (AF) (N/A)  
  NAF Activity (AR)  (N/A) Target Date Appraisal Due  
  Pay Plan Target Date Effective  
  Pay Plan Description Target Appraisal Period 

End Date (N/A) 
 

  Grade Comments (free form for 
your use only - Optional)  

 

  Performance Constraint 
Indicator (Demo) (N/A) 

Name   

   National Identifier  
 

Continued on next page 
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Processing LN Mass Appraisals, Continued, Continued 

  
Previewing Your Action (continued) 
 

Step Action 
5 Click the Save icon and exit the window to return to the Mass 

Appraisals (Final) window. 
6 Click the<Execute> button to run the business rules for the process 

and identify any errors that occurred.   
• You can check the Process Log to determine if errors or 

warnings occurred, and make any necessary corrections. 
• The business rules in effect for individual update of a 

record (direct update of the SIT) also apply to the mass 
process. 

 
Validating the 
Mass Appraisal  

Clicking the <Validate> button on the Mass Appraisals (Final) window 
opens a Message Box.  Click the <Validate> button after Preview has been 
completed to ensure there are no rejects before Executing the action. 

 
Step Action 

7 Click the <Validate> button on the Mass Appraisals (Final) 
window to display a Message Box with the following “Validation 
process completed successfully.” 

 
Click the <OK> button. If an Error Message Box does not appear 
move to step 12 

8 If an Error Message Box appears it indicates that required data 
items that have not been entered. Follow the next 2 steps to correct    

9 Navigate to Process and Reports → View Request <Open> the 
find request window opens click the <Find> button The Requests 
window opens with a listing of Request Ids with columns entitled 
Phase, Status, Program Name and Parameters.  The most recent 
request will be at the top of the list.  

 
Continued on next page 
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Processing LN Mass Appraisals, Continued, Continued 

  
Validating the  Mass Appraisal (continued) 
 

Step Action 
10 Find the Request ID that was assigned in the previous note of 

successful completion.   
Click the <View Log> button to error message window, view the 
message 

 
11 Return to Mass Appraisals (Final) window Correct the actions, 

then Save your work. 
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Processing LN Mass Appraisals, Continued, Continued 

  
Executing the 
Mass 
Appraisal 

Clicking the <Execute> button on the Mass Appraisals (Final) window 
processes your action by submitting it to update the database.  

 
Step Action 
12 Select the <Execute> button on the Mass Appraisals (Final) 

window a Message Box will appear indicating “Mass Appraisals 
Final Process successfully submitted.” 

 
Select <OK>.  The Mass Appraisals (Final) window opens. 
Note:  Once you have “Executed” or “Processed” the action, a 
new row of data is entered into each employee’s record (LN 
Appraisal Information SIT) if the record validated. 
The Taskflow Buttons (Execute, Validate, and Preview) are 
grayed out. 
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Processing LN Mass Awards  

 
Purpose 
 
 

This section explains how to process LN mass awards for a group of similar 
award actions.  The process is available for all countries. 

• A manager, supervisor, or designated organizational person may 
initiate and preview the action, and then notify the personnelist by 
phone or email with the file “name” created for the mass award. 

• A personnelist will then execute the mass award. 

  
Before You 
Begin 

• A Mass Award is a collection of individual awards processed en masse to 
save Modern DCPDS users time, effort, and keystrokes.  The personnel 
actions required to document each award can be processed with an 
individual RPA when the following conditions are the same:   

• Effective date. 
• Nature of action.  
• Authority code.    

• For LNs, certain fields must be completed on the Award Details DDF, 
before you can initiate the preview process. 

• You cannot change individual award amounts; i.e., percentage or salary 
amount, once you have “executed” the action.  

• If actions process without error, NPAs (SF 50, or the country equivalent 
of the SF 50) are generated for each employee record included in the mass 
process as future actions in the Routing History Table.   

• If an error occurs with one of these selected records, the process routes the 
RPA to the groupbox assigned to the record’s registered Personnel Office 
Identifier (POI).  If the POI is not registered, then the process routes to the 
system’s default groupbox – GHRWFADMIN. 

• Legal Authority Codes/Remarks are not required for Mass Awards.  
 
If an RPA was used to create the award (usually a monetary award), then you 
must do a Correction-Cancellation RPA to delete it. 

   
Who Does It 

 

The capability to execute a mass award is only available in the LN 
Personnelist or CIVDOD LN HR MGR responsibility. 
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Processing LN Mass Awards, Continued 

 
Creating a 
Mass Award 
File 

Managers, supervisors, or personnelists may initiate a Mass Award File.  If a 
manager or supervisor creates the file, they need to notify the appropriate 
personnelist to “execute” it.  If the award is not within the current pay period, 
date track to the date needed on the Element Entries window and follow the 
steps in this procedure.  

 
Step Action 

1 Navigation Path → Mass Actions →Mass Awards Final → <Open>. 
2 The Mass Awards (Final) window opens with four taskflow buttons.  

Each time the user utilizes a taskflow button, the system automatically 
saves the current entries. 

 
  Taskflow Buttons Description  
  Delete Preview .  
  LACs/Remarks Not required for LNs.  
  Award Details The same entries used on the individual 

RPA Award DDF. 
 

  Preview Begins the selection criteria process. 
Once you select to Preview, all previous 
data entered cannot be modified.  If 
modification is necessary, you must create a 
new Mass Award file. 

 

 
Continued on next page 
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Processing LN Mass Awards, Continued 

  
Creating a Mass Award File (continued) 
 

Step Action 
3 
 
 

With your cursor in the Name data field, type in a unique file name 
for the award you are creating.   
 
Note:  This unique file name is used for executing the process.  If a 
manager initiates the Mass Award, this file name must be provided 
to the personnelist to extract and then execute the mass award. 

4 With your cursor in the NOA Code data field, click the LOV to 
select the code or type it in.  (OPM no longer requires 
LACs/Remarks for Mass Awards). 

5 
 

Type in a date in the Effective Date data field (or use the LOV).  
Note:   
• Name, NOA, and Effective Date are required fields which auto 

populate the Award Details DDF: 
• UoM,  
• Award Type and 
• Date of Award Earned.  

6 
 

The Status data field is system generated to show the progress of 
your Mass Award once executed.  No action is required in this data 
field. 

7 
 
 
 
 

In the Source Region, click the LOV to choose either the 
Organization, or Personnel Office ID.  Agency Code and 
Agency/Subelement Code data fields are optional.  However, there 
is an increase in system performance when you select an 
organization as one of the parameters. 
Note:  You can use wildcards to populate some data fields; e.g., 
(FP%) - to extract organization codes that begin with FP; (G%) - to 
get all pay plans beginning with a G, etc. 

8 Select the LOV icon or type in the information in the following 
(Optional) data fields:  Position Title, Occupational Series, Grade 
or Level, Organization Structure ID, Office Symbol, Rating of 
Record, Pay Plan, and Duty Station ID data fields.   

9 Select the<Award Details> button. 
 

Continued on next page 
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Processing LN Mass Awards, Continued 

  
Creating a Mass Award File (continued) 
 

Step Action 
10 The Mass Awards (Award Details) window opens data fields are 

populated depending on the NOA Code selected from the previous 
window.  For example, if the NOA Code is 840A, the following 
Awards Detail DDF opens: 

 
In this example, the UOM is M (Money). The Award Type is 9L, 
which you can overwrite, if needed. 
 
• UoM, Award Type, Date Award Earned automatically 

populate based on the information entered on the Mass Award 
Form.  

• User must enter: 
• Award Amount or Award Percentage (not both) 
• Group Award ID (leave blank) 
• Award Agency Code 
• Tangible Benefit Dollars (when required) 

 
Note:  If NOA Code of 846A, 847A, or 846B_ (Korea unique) is 
selected, UOM will be H (Hours).  Award Type will be 80  

11 
 

With your cursor in the Award Amount data field, type in the 
amount,  
OR 
Select the Award Percentage data field and type in a percentage.  
For example, one and a half percent would be entered as 1.5 (no 
percent sign). 
Note:  The Award Percentage data field only applies to 
performance Awards.   

 
Continued on next page 
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Processing LN Mass Awards, Continued 

  
Creating a Mass Award File (continued) 
 

Step Action 
12 With your cursor in the Award Agency Code data field, type in the 

information or click the LOV and click the agency granting the 
award; e.g., AR for Army.   

13 Group Award Id is required if award is effective before 1 Oct 
2000 - no longer required by OPM if the award is effective on or 
after 1 Oct 2000.  

14 Award Type automatically populates for Time Off Awards.  Use 
the LOV or type in the correct information, if needed. 

15 Date Award Earned populates with the current date or you can 
input another date. 

16 Type in dollar amount in Tangible Benefit Dollars data field, if 
required. 

17 Select the <OK> button to return to the Mass Awards (Final) 
window. 

 
Previewing a 
Mass Award 
File 
 

You may preview a file created on the Mass Awards (Preview) window and 
names can be viewed, selected, or deselected.   
 
Note:  Once you select Preview, all previously entered data cannot be 
modified (except for Award Amount which must be changed individually.)  If 
other modifications of the data are necessary, a new Mass Award file must be 
created. 

 
Continued on next page 
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Processing LN Mass Awards, Continued 

  
Previewing a Mass Award File (continued) 
 

Step Action 
18 In the Mass Awards (Final) window, click the <Preview> button.  

The window opens with data elements populated from the previous 
windows.  

 Name and SSN are included in the columns a second time so they 
will appear on the downloaded product, in the event you export the 
awards preview folder to a spreadsheet.  

 
19 
 

You can scroll through the remaining columns with the Name and 
SSN always visible by using the scroll bar at the bottom of the 
window.  The Award Salary data field must be identified in all 
records for the percentage to calculate properly. 
Note:  If you change the Target Award Amount, the cumulative 
Total Award Amount at the upper right hand corner of the 
window (beneath Effective Date) changes, too.  

20 Save your action by clicking Save icon on the Toolbar and exit the 
window. 
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Processing LN Mass Awards, Continued 

  
Changing a 
Mass Award 
File 

You have one option to change the file before it is “executed.”  You can only 
change the Target Award Amount to a dollar amount from a percentage.    

 
Step Action 

1 The personnelist will open the Mass Award (Final) window and 
click the <Preview> button.   

2 The Mass Awards (Preview) window opens.   
To change the dollar amount, place your cursor in the Target 
Award Amount data field and substitute the desired dollar amount 
for the Percentage of Award Salary Amount. 
 
Note:  The system deletes the information in the Target Award 
Percentage data field when the dollar amount is input. 

• When all modifications of the Preview Folder are 
complete, the user must save the changes and exit the 
Preview Folder.   

• The Preview Folder can be changed and saved as many 
times as necessary by the user. 

• The Preview Folder contains all records in the database that 
meet the selected criteria 

• Total Award Amount is the total of all award amounts for the 
records selected based on the initial source criteria.  (It will not 
change when selections are altered.) 

• You may deselect or select all records or individually. 
• You may modify Award Amount, and it must be done 

individually.   
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Processing LN Mass Awards, Continued 

  
Executing a 
Mass Award 
File 

This procedure shows the steps to process or “execute” a mass award file to 
update the database. 

 
Step Action 

1 Click the <Execute> button.  A Message Box opens and states  
“Mass Awards Final Process successfully submitted, Request ID is  

 
2 
 
 
 

Click the<OK> button.   
• If the actions process without an error, RPAs are created 

for the selected records as future actions in the Routing 
History Table.   

• If an error occurs with one of these selected records, the 
process routes the RPA to the groupbox assigned to the 
record’s registered Personnel Office Identifier (POI) or to 
the GHRWFADMIN Groupbox.   

Notes:  
• Once you have “Executed” or “Processed” the action, the 

<Preview> button is grayed out on the Mass Awards (Final) 
window. 

• Individual award actions that do not successfully pass the 
business rules will create an RPA for the Award, and flow to 
the designated utility groupbox for failed automatic actions, 
normally “WGI Personnel.” 
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Processing LN Mass Awards, Continued 

 
Viewing the 
Status of a 
Mass Award 
File 

To view the status of the executed mass award file, use the Request ID in the 
message generated in the final step of processing.  For example:  “137688” in 
the previous step.  Follow these steps for viewing your requests: 

 
Step Action 

1 Navigate to Process and Reports → View Request <Open> the 
find request window opens click the <Find> button  
The Requests window opens with a listing of Request Ids with 
columns entitled Phase, Status, Program Name and Parameters.  
The most recent request will be at the top of the list. 

2 
 

Find the Request ID that was assigned in the previous note of 
successful completion.  

  
 

If the Status Column indicates “Pending” or “Running,” use the 
click to Refresh Data button until the status column reads:  
“Completed.” 

3 Select the<View Log> button to display a log of how a request 
ran. 

4 Select the <View Output> button to view the output of a 
successfully completed request on screen. 
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Processing LN Mass Awards, Continued 

 
Viewing the Status of a Mass Award File, (Continued)  
 

Step Action 
5 Select the <Diagnostics> button.  The Request Diagnostics 

window opens for your review.   

 
10 Select the <View Details> for more detailed information on the 

file. The Concurrent Requests window opens: 

 
11 Contact your System Administrator for assistance in reviewing the 

Request Log or the Concurrent Manager Request Summary to 
locate and correct specific errors. 
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 Processing LN Mass Awards, Continued 

  
Locating and 
Correcting 
Errors 

The System Administrator completes this function.  However, the Systems 
Administrator may designate one or two individuals in a Region to help with 
this function. 

• The Process Log is a registry of successful and failed records 
processed with a concurrent program.   

• If there are errors in a record, the system opens a complete error 
message notifying the user of the error.   

• The user then knows to look for a routed RPA in the record’s 
groupbox or system’s default groupbox. 

 
Step Action 

1 Navigation Path → Federal Maintenance Forms →Process Log 
→ <Open>. 

2 The Process Log Errors window opens with the request number 
as the last part of the Program Name data field.  The Log Text 
Region opens the reason for the error(s).  Use the scroll bars to 
read the remaining information. 

 
3 The actions will be corrected as needed by the personnelist who 

executed the action. 
4 The System Administrator will then process “Futures,” which 

reprocesses all actions noted as future in the Routing History Table 
to update the database.  The Process Log referenced above will 
also contain the details on all records successfully completed and 
processed with errors. 
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Processing LN Mass Realignment 

 
Purpose This section explains how to process LN Mass Realignment for NOA Code 

790A, Realignment.  An LN Mass Realignment occurs when: 
• A group of employees and their positions move due to an 

organization change, such as a reorganization; 
• The employees stay in the same agency, i.e., Army; and  
• There is no change in the employees’ position, grade or pay.   

When a mass realignment occurs, all employees assigned to the affected 
function or organization are assigned to the new organization. 

    
Before You 
Begin 

• Use Mass Realignment when you want to update multiple records at one 
time for the NOA Code 790A, Realignment. 

• When you process LN Mass Realignment, the People and Position Record 
in HR is updated.   

• You can export the data from the Preview window to an Excel 
spreadsheet. 

  
Who Does It 

       

The capability to create and execute a Mass Realignment is available only in 
the LN Personnelist or CIVDOD LN MGR responsibility. 
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Processing LN Mass Realignment 

  
Processing a  
Realignment 

 

Step Action 
1 
 

Navigation Path →Mass Actions → Mass Realignment Preview → 
<Open>. 
The Mass Realignment window opens. 

 
Or, Navigate To →Mass Actions → Mass Realignment Final → 
<Open>.  The Mass Realignment (Final) window opens. 

 
Note:  The Mass Realignment window is available as a “rough 
draft” window.  It is exactly like the Mass Realignment (Final) 
window, You can create the LN Mass Realignment by clicking 
either menu item.  Mass Realignment can only be processed in the 
Mass Realignment (Final) window.  Components may want to use 
both forms; however, for security reasons, limit the number of 
personnel who can run the final process. 

 
Continued on next page 
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Processing LN Mass Realignment, Continued 

  
Processing a Realignment (continued) 
 

Step Action 
2 The Mass Realignment window opens with four Taskflow 

Buttons:  <Delete Preview>, <LACs/Remarks>, <Position 
Details>, and <Preview>. 

 
3 With your cursor in the Name data field, type in a unique name for 

the Mass Realignment action you are creating. 
Note:  The Status data field is system-generated to show the 
progress of your Mass Realignment, once executed; e.g., 
Unprocessed, Submitted, Processed.  No action is required in the 
data field. 

 
 

 
 

Continued on next page 
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Processing LN Mass Realignment, Continued 

  
Processing a Realignment (continued) 
 

Step Action 
4 Enter data in the remaining data fields: 

• Effective Date 
• Description 

The Source Area allows you to enter data to define the employees 
to be included in the Mass Realignment. 

• Enter data in the following or use the LOV: 
• Organization 
• Target Organization 
• Organization Hierarchy (Optional) 

The Additional Source Criteria is optional, but input allows you 
to further refine the records to be included in the Mass 
Realignment. 

• Organization Structure ID 
• Office Symbol 
• Personnel Office ID 
• Agency Code/SubElement 

5 Select the<LACs/Remarks> button.  The Legal Authority Codes 
and Remarks window opens complete the data fields as required  

 
 

Continued on next page 
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Processing LN Mass Realignment, Continued 

  
Processing a Realignment (continued) 
 

Step Action 
6 Click the<Position Details> button. The Mass Realignment 

(Position Details) window opens. 

 
7 Enter information ONLY to those data fields that will change as a 

result of the Mass Realignment.   
8 Select the<Additional Details> button The Mass Realignment 

(Position Additional Details) window opens.  Again, enter 
information only into those data fields that will be changing as a 
result of the Mass Realignment. 

Select the <OK> button A message Box opens with “No changes to 
apply.”  Select the<OK> button  

 
Continued on next page 
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Processing LN Mass Realignment, Continued 

  
Processing a Realignment (continued) 
 

Step Action 
9 The Mass Realignment Position Details window reopens.   
10 Click the <OK> button. To return to the Mass Realignment 

window. 

 
Previewing and 
Executing the 
Realignment 

Selecting the <Preview> button on the Mass Realignment (Final) window 
opens the Mass Realignment (Preview) window.   

• Based on the information input in the Source area on the previous 
window, employees are identified and displayed in alphabetical order, 
along with their SSAN.   

• The names for the Mass Realignment can be viewed and selected or 
deselected. 

Follow the steps below to preview the action.  Some edits are country 
specific.   
 
Step Action 

1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In the Mass Realignments (Final) window, click the<Preview> 
button.  The Mass Realignment (Preview) window opens with 
data elements populated from the previous window.   

 
Note:  You can scroll through the remaining columns with the 
Name and LN ID always visible by using the scroll bar on the 
bottom of the Preview Window.  Information may or may not 
populate the columns.   

 
Continued on next page 
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Processing LN Mass Realignment, Continued 

  
Previewing and Executing the Realignment (continued) 
 

Step Action 
2 Select the Save icon and exit the window to return to the Mass 

Realignment (Final) window. 

 

3 Select the<Execute> button on the Mass Realignment (Final) 
window a Message Box indicates “Mass Realignment Final 
Process successfully submitted.” 

  
4 Select <OK>.  The Mass Realignment (Final) window opens. 
5 Select Save.   

 
Note:  Once you have “Executed” or “Processed” the action: 

• Each employee’s position record updates. 
• RPAs are produced.   

6 Viewing the Status and locating errors is the same as in the Mass 
Awards section of this chapter. 
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Processing LN Mass Salary 

 
Purpose This section explains how to process LN mass salary for NOA Code 894A, 

Pay Adjustment and the NOA Code 893A, Within Grade Increase (WGI).  
It is not country specific and is available for LN use. 

    
Before You 
Begin 

• Use mass salary when you want to update multiple records at one time for 
the NOA Code 894A, Pay Adjustment or the NOA Code 893A, WGI. 

• When you process LN mass salary, the People Record in HR is updated.   
• An RPA is not produced as it is with other mass actions.  
• If actions process without error, NPAs (SF 50), or the country 

equivalent of the SF 50) are generated for each employee record 
included in the mass process as future actions in the Routing History 
Table. 

• You can export the data from the Preview window to an Excel 
spreadsheet. 

  
Who Does It 

       

The capability to create and execute a mass salary is available only in the LN 
Personnelist or CIVDOD LN HR MGR responsibility. 
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Processing LN Mass Salary 

  
Processing a  
Mass Salary  

 

 
Step Action 

1 
 

Navigation Path → Mass Actions → Mass Salary Preview → 
<Open>. 
Notes:   
• The Mass Salary window is available as a “rough draft” 

window.  It is exactly like the Mass Salary (Final) window, 
but without the <Execute> Taskflow Button.  You can create 
the LN Mass Salary by clicking either menu item.  Mass Salary 
can only be processed in the Mass Salary (Final) window. 

• Components may want to use both forms; however, for 
security reasons, limit the number of personnel who can 
execute.  

2 The Mass Salary window opens with four Taskflow Buttons: 
<Delete Preview>, <LACs/Remarks>, and <Preview>.  
<Execute> is grayed out.   

 
 

 
 

Continued on next page 
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Processing LN Mass Salary, Continued  
Mass Salary (continued) 
 

Step Action 
3 
 

With your cursor in the Name data field, type in a unique name for 
the mass salary action you are creating. 
Note:  The Status data field is system-generated to show the 
progress of your mass salary once you save your action; e.g., 
Unprocessed, Submitted, etc.   

 
4 Enter data in the remaining data fields: 

• NOA Code 
• Pay Table ID (Unless a WGI is the action) 
• Effective Date 
• Date WGI Due (if a WGI is the action) 
• Additional Criteria Area allows you to enter data to define 

the employees to be included in the Mass Salary process. 
Notes:  These areas are optional. 
• WGIs:  If you need to limit the select process to more than just 

the DT WGI Due.  Usually, you process all WGIs due on the 
same date. 

• Pay Adjustments:  If you need to limit the select process to 
more than just the Pay Table ID.  Usually you process all pay 
adjustments required by a pay table change. 
• Enter data in the following, if needed: 

• Organization  
• Personnel Office ID  
• Agency Code/Subelement 
• Duty Station 

 
Continued on next page 



                                                                                                   R12                                                                            March 2012 

Local National Mass Actions                                    Mod 10, Chap 5, Page 32 

Processing LN Mass Salary, Continued 

  
Mass Salary (continued) 
 

Step Action 
5 Select the LACs/Remarks button and input using the LOV 

provided. 
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Processing LN Mass Salary, Continued 

 
Previewing Your 
Action 

Clicking the<Preview> button on the Mass Salary (Preview) window opens 
the Mass Salary (Preview) window.   

• Based on the information input in the Additional Criteria on the 
previous window, employees are identified and displayed in 
alphabetical order, along with their SSAN.   

• The names for the Mass Salary can be viewed and selected or 
deselected. 

 
 

 
Step Action 

1 On the Mass Salary (Preview) window, select <Preview>.  The 
Mass Salary (Preview) window opens with data elements 
populated from the previous window.   

 
The Mass Salary checkbox opens next to the Name and SSN 
columns.  You can scroll through the remaining columns with the 
Name and LN ID always visible.  Information may or may not 
populate the columns. 

2 Select the Save icon and exit the window to return to the Mass 
Salary (Final) window. 

 

Continued on next page 
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Processing LN Mass Salary, Continued 

 
Previewing Your Action (Continued)  
 

Step Action 
3 Select the<LACs/Remarks>button.  The window opens.  Input 

the proper data needed. It must be completed prior to executing the 
Mass Salary.  

 
Select Save to return to the LN Mass Salary Preview window. 
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Processing LN Mass Salary, Continued 

 
Executing the 
Mass Salary 

Follow these steps to execute the LN Mass Salary Final and update the 
database.   

    
Step Action 

1 Select the <Execute>button on the Mass Salary (Final) window. 
 

 
 

2 A Message Box states “Mass Salary Final Process successfully 
submitted.” 

 
3 Select the <OK>button.  The Mass Salary (Final) window opens. 
4 
 

Select the Save icon.   
Note:  Once you have “Executed” or “Processed” the action: 

• A new row of data is entered into each employee’s record 
(Element Name). 

The <Preview>button is grayed out on the Mass Salary (Final) 
window. 
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Processing LN Mass Salary, Continued 

   
Viewing the 
Status of a 
Mass Salary 
File 

To view the status of the executed mass salary file, use the Request ID in the 
message generated in the final step of processing.  For example:  “4388542” 
in the previous step.  Follow these steps for viewing your requests: 
 

 
Step Action 

1 Navigate to Process and Reports → View Request <Open> the 
find request window opens.  Select the <Find> button.  
The Requests window opens with a listing of Request Ids with 
columns entitled Phase, Status, Program Name and Parameters.  
The most recent request will be at the top of the list. 

2 
 

Find the Request ID that was assigned in the previous note of 
successful completion.  

 
If the Status Column indicates “Pending” or “Running,” use the 
click to Refresh Data button until the status column reads:  
“Completed.” 

3 Select the<View Log> button to display a log of how a request 
ran. 

4 Select the <View Output> button to view the output of a 
successfully completed request on screen. 

 
 

Continued on next page 
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Processing LN Mass Salary, Continued 

   
Viewing the Status of a Mass Salary File (Continued)  
 

Step Action 
5 Select the <Diagnostics> button.  The Request Diagnostics 

window opens for your review.   
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Processing LN Mass Salary, Continued 

    
Locating and 
Correcting 
Errors 

The System Administrator completes this function.  However, the Systems 
Administrator may designate one or two individuals in a Region to help with 
this function. 

• The Process Log is a registry of successful and failed records 
processed with a concurrent program.   

• If there are errors in a record, the system opens a complete error 
message notifying the user of the error.   

• The user then knows to look for a routed RPA in the record’s 
groupbox or system’s default groupbox. 

 
 

Step Action 
1 Navigation Path → Federal Maintenance Forms →Process Log 

Federal →<Open>. 
2 The Process Log Errors window opens with the request number 

as the last part of the Program Name data field.  Search the 
Program Name with %4388542% and F11.  The Log Text Region 
opens the reason for the error(s).  Use the scroll bars to read the 
remaining information. 

 
3 The actions will be corrected as needed by the personnelist who 

executed the action. 
4 The System Administrator will then process “Futures,” which 

reprocesses all actions noted as future in the Routing History Table 
to update the database.  The Process Log referenced above will 
also contain the details on all records successfully completed and 
processed with errors. 
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Module 11 

Reports 

Module Overview 

  
Purpose The purpose of this module is to familiarize you with DCPDS and how to use 

it.  A report generates a summary or display of information.  This chapter 
addresses predefined, user requested reports.  It also explains the tools and 
functionality common to all users of the system. 

   
Module Contents 
 

 

Module Overview  
Responsibilities 2 
Terms 2 
Report Types 4 
List of Reports 6 
Submitting the Report 7 

Accessing the Submit Requests Window 7 
Report Options 10 

Viewing a Requested Report 13 
Navigating to the Concurrent Requests 
Window 

13 

Viewing Information in the Concurrent 
Requests Window 

14 

Reprinting Requests 20 
Chapter 1:  EEOC_FIRES Reporting Capability  

Creating an EEOC_FIRES Status Report 2 
Creating an EEOC_FIRES Dynamics Report 5 
Viewing and Saving the EEOC_FIRES Status and 
Dynamics Reports 

8 
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Module Overview, Continued 

 
Responsibilities Your access to reports is based on your assigned responsibility and business 

rules. 
 

 

 
 

 
Terms  

Term Definition Example 
Ad Hoc User-created reports using a query tool. List of Vacant 

Positions 
Batch Print Process which causes daily execution of 

hard copy NPAs based on effective date 
following Futures.  May be executed any 
time during the day to produce an 
individual NPA.  Performed by the 
System Administrator. 

Promotion 
Change to Lower 
Grade 
Termination of 
Detail 

 
 

Continued on next page 
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Module Overview, Continued 

  
Terms (continued) 
 

Term Definition Example 
Concurrent 
Processing 

A feature that allows you to run a report 
or application at the same time you are 
using the system to process actions.   

It runs reports and applications as 
concurrent processes.  Your system 
administrator may control the scheduling 
of long-running processes; e.g., big 
reports to avoid overloading your 
system. 

 

Futures Process which causes other reports to be 
executed.  Should run nightly. 

RPA Processing 
Mass Pay 
WGI 

EUL End User Layer.  Encapsulates 
complicated sequel statements normally 
required to get the data into a user-
friendly ad hoc query tool. 

 

Parameter A report variable whose values you can 
change each time you run a report. 

 

SQL Standard Query Language is an inquiry 
language used to access relational 
databases. 

 

Standard 
Request 
Submission 

Predefined reports you can choose by 
entering a set of parameters when you 
submit the report.  These reports run in 
batch mode, through concurrent 
processing. 

Date Position 
Obligation Expires 

Suspense Managed by system administrator to 
produce daily transactions due on that 
date.  Performed by the System 
Administrator.  

NPA-Conversion 
Dates 
NPA-Termination 
of Appointment 
LWOP Expiration 

 
 

Continued on next page 
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Module Overview, Continued 

  
Report Types  The table below outlines the main categories of inquiry and reporting tools 

available. 
 

Type  Explanation 
Ad Hoc You can create your own ad hoc reports by using DCPDS-

compatible query tools.  These techniques are not addressed in 
this User Guide.  Talk with your system administrator for more 
information on creating ad hoc reports. 

Civilian 
Serving 
Unit 
Application 
Database 

You can also access the Civilian Serving Unit Application 
Database (CSU) database for predefined reports. 

Date Track 
History 

You can view the changes to date tracked information over time 
through Dated Information and Date Tracking (described in 
Module 1, Chapter 4). 

Inquiry 
Windows 

These are primarily used for on-line viewing such as the RPA.  
Folders (described in Module 1, Chapter 6) are included in this 
category. 

System 
Generated 
Reports 

These run automatically, based on business rules.  Your system 
administrator determines when systems generated reports run 
(i.e., during the day, overnight, etc.).  These reports include: 

• Suspense 
• RPA Processing 
• Auto WGI 
• Payroll Reverse Interface 
• Mass Pay Process 
• Specific Record Conditions 

 
 

Continued on next page 
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Module Overview, Continued 

  
Report Types   
 

Type  Explanation 
User 
Requested 
Reports 
 
 
 
 
        
 
 
 
 
 
 
 
 
 
 
 

 
 
 
  

These are predefined reports available to you through a list 
based on your logon responsibility (access privileges) and 
include: 

• Individual Record Information 
• Payroll Interface Report 
• Personnel/Payroll Reconciliation Reports 

Select ‘Submit Processes and Reports’ to begin.  Select ‘Single 
Request’ and then the OK button. 

 
 
Note:  Some reports are both suspense generated and user 
requested, i.e., Notification of Expiration of Overseas Tour.  The 
‘Submit Request’ window becomes available.  Select the ellipsis 
to review list of available reports. 

 
  

Continued on next page 
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Module Overview, Continued 

  
 
List of Reports  

 
 

Continued on next page 
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Submitting the Report 

 
Accessing the Submit 
Requests Window   

 

Step Action 
1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Navigation Path Processes and Reports > Submit Processes and 
Reports.   

The Submit New Requests window Opens: Accept default of 
Single Request and select <OK> button. 

 

2 
 

It is in this window you select the request you wish to run and then 
set Parameters, Schedule, and Completion Options for it. With the 

cursor in the ‘Request Name’ field, Select the ellipsis button  on 
the right to display the report menu.   

 
 
 

Continued on next page 
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Submitting the Report, continued  

 
 
Accessing the Submit Request Window (Continued) 
 

Reports Action 
             
 
 
 
         
 
 
 
 
 
 
 
 
 
 
 
 
         
            
 

              

 

Select the Report you wish to run by utilizing the scroll bar to 
the right to make the selection. Then Select <OK> button 

 
Note:  The list of reports and programs from which you can 
select is based on your log-on responsibility. 

 
Continued on next page 
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Submitting the Report, continued  

 
Accessing the Submit Request Window (Continued) 
 

Steps Action 
          3    
 
 
 
         
 
 
 
           
 
         
            
 
 
 
 

 

If you selected a report that requires parameter values, a 
Parameters window automatically opens.  Parameters are 
values that restrict information displayed in your report request. 

 

Use the ellipsis button  in the parameters window to select a 
value for each data field. Then Select <OK> button. 

Note: Depending on the report selected the parameter window 
data fields will vary. 

4 The Parameters window closes and the parameter values 
display in the data field. 

 
5 
 
 
 

 

Select the <Submit>  button to process request. 
If the print options and scheduled times do not need to be 
changed skip steps 6 and 7 and go to the Viewing a Requested 
Report section.   

Note:  Steps 6 and 7 are Optional for submitting a request. 
Follow these steps only if changes to the Print Style and 
Scheduled Time need to be changed. 

Continued on next page 
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Submitting the Report, continued  

 
Report Options  

Reports Action 
6 

Select <Options> button  to open the Print 
Options window. 

 
 
 

Continued on next page 
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Submitting the Report, continued 

 
Report Options (Continued) 
 

Print Option 
Window 

Options 

Save Output 
 A Check Mark in the Save all Output 

Files box allows you to view your report on-line.  If you do 
not wish to view the report on-line, Select the check box to 
deselect this option. 

Printer Select the ellipsis button   if you want to select a printer 
other than that which is displayed. 

Copies Field If you want to print more than one copy, type in the number 
of copies you want to print.  

Style Place your cursor in box and the ellipsis button    will be 
available to select a print style other than that which is 
displayed (some requests may have a required style option 
that you cannot change). 
Select OK button to continue. 

 
 

 
 

Continued on next page 
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Submitting the Report, continued 

 
Report Options (Continued) 
 

Step Action 
7 

On Specific Days - If Specific Days value is selected a new data 
field window will open.  

The Start At defaults to the current Date and Time to indicate 
when to submit the request.  You can either type in a date and time 
or you can Select the ellipsis button to use the calendar feature. 

 
To select a specific period of time Select and Highlight the Date 
or Days the request will run every day at the specified time until 
you cancel the request or enter a date and time in the End AT data 
field. 

Select <OK> button to close window. 
 Select <Submit> button.  After submitting the Report Oracle will 

take you to the Request window. 

 
Please refer to the Viewing a Requested Report Section. 
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Viewing a Requested Report 

  
Navigating to  
the Concurrent  
Requests 
Window 

Use the Requests Window to view a list of all of your concurrent requests 
that are scheduled to run in the next 24 hours, have completed within the 
past 24 hours, or are currently running. 

 
Step Action 

1 Navigation Path   Processes and Reports > View Requests > 
<Open>.   Since all reports, programs, and requests are run as 
concurrent requests in Oracle Applications, you can navigate to the 
Requests window to view the progress of all of your concurrent 
requests 

2 The Find Requests window opens.  Enter either specific criteria in 
the Find Requests window and Select <Find> button, or accept the 
default “All My Requests” to search for all the reports submitted. 

 
3 The Request window will open displaying a Request ID, Phase, 

Status, Report Name, and Parameters used to run the request. 

 
 
 

Continued on next page 
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Viewing a Requested Report, Continued 

 
Viewing 
Information in 
the Concurrent 
Requests 
Summary 
Window 

The Requests window displays with Six columns.   
 

  
Columns Information Displayed 

Request ID The Request ID field represents a number generated by 
Oracle to distinguish each request  

Name The name field is a description of the request 

Phase A concurrent request has a life cycle consisting of the 
following phases: 

• Pending 
• Running 
• Completed 
• Inactive   

Status The status column indicates normal completion or will give 
an error indicator  

Parameters Parameter selections used to run the concurrent request.  

 
 

Continued on next page 
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Viewing a Requested Report, Continued 

 
Viewing Information in the Concurrent Requests Summary Window (continued) 
 

Phase Status Meaning 
Pending Normal Request is waiting in queue to run.   
 Standby Program to run the request is incompatible with 

other program(s) currently running. 
 Scheduled Request is scheduled to start at a future time or 

date. 
 Waiting A “child” request is waiting for its “parent” 

request to mark it ready to run.  For example, a 
request in a request set that runs sequentially 
must wait for a prior request to complete. 

Running Normal Request is running normally. 
 Paused “Parent” request pauses for all its “child” 

requests to finish running.   
 Resuming All requests submitted by the same “parent” 

request (in a request set) have completed 
running.  The parent request resumes running. 

 Terminating Request has been canceled (via Cancel Request 
button). 

Completed Normal Request completed successfully. 
 Error Request failed to complete successfully.   
 Warning Request completed with warnings. 
 Canceled Pending or inactive request has been canceled 

(via Cancel Request button). 
Inactive Disabled Program to run request is not enabled.  Contact 

your system administrator. 
 On Hold Pending request has been placed on hold (via 

Hold Request button). 
 No Manager No manager is defined to run the request.  

Check with your system administrator. 

Continued on next page 
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Viewing a Requested Report, Continued 

 
Viewing Information in the Concurrent Requests Summary Window (continued) 
 

Task Flow 
Buttons 

Information Displayed 

Refresh Data Use this button to refresh the data in order to display updated 
progress of your requests. 

Find Request  Use this button to search for additional requests 
Submit new 
Request 

Use this button to submit a new request. 

View Detail Use this button to view detailed information about your 
requests, for example, submission date and scheduling. 

Diagnostic Displays diagnostic information such as when it ran and if it 
completes successfully. 

View Output Displays an online view of your report. 

View Log Displays the log file containing information regarding 
arguments used and other technical information. 

Old Request While a report is pending the “Hold Request” button will 
allow the request to be help out of the processing pool.  

Cancel Request When a report begins running the “Cancel Request” button 
will allow a request to be cancelled. 

 
Continued on next page 



                                                                                                  R12                                                                             March 2012 

Reports:  Overview                                                                  Mod 11, Overview, Page 17 

Viewing a Requested Report, Continued 

 
 Viewing Information in the Concurrent Requests Summary Window (continued) 
 

Step Action 
4 Select the report to view then Select <View Output> button to 

open the report. 

 
Within this screen you can use the scroll bar to view the report or 
use the buttons at the bottom of the screen. The functions are 
Listed:  

   
Task Flow 

Buttons 
Information Displayed 

Go To Allows you to enter a particular page and Select <OK> 
button  

 

First Returns you to the first page of the report. 
Previous Takes you to the previous page.  

Next Moves you to the next page in the report. 

Last Takes you to the last page of the report. 

 
Continued on next page 
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Viewing a Requested Report, Continued 

 
Viewing Information in the Concurrent Requests Summary Window (continued) 
  

Step Action 
5  To view the Log file Select <View Log> button to open window. 

The log file will show any errors that may have occurred with the 
PL/SQL scripts ran to produce the report. The task flow button 
works the same as in viewing the report. 

 
6 Select the report you wish to view the details on and Select <View 

Details> button.  This window will display all the information 
about the report such as Parameters, Requestor and Date and time.  

 
 

Continued on next page 
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Viewing a Requested Report, Continued 

 
Viewing Information in the Concurrent Requests Summary Window (continued) 
 

Step Action 
7 Select the report you wish to view the Diagnostics details on and 

Select < Diagnostics> button. This window will display the 
diagnostics as to why the report did not complete its run.  
 

 
8 Select the  button to display the initial 

find request screen to change you search criteria or view more 
requests that have been run. 

9 Select the  button to 
submit a new request. 

10 Select  button to update Status. 
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Reprinting Requests 

    
Reprinting a 
Request 

To provide information to reprint the output, after a request is run. 

Step Action 
1 Navigate to the Concurrent Requests Summary window: 

Navigation Path > Processes and Report > View Requests > 
<Open>.  

2 You are directed to the Find Requests window. Use this window to 
specify the types of requests you want to reprint by Selecting 
<FIND> button and retrieving all request. Or enter specific criteria 
into the data fields on the find request window.  

 
3 Move your cursor to the request you want to reprint. 

 
4  Select <Tools> <Reprint/Republish> from the main menu 

 

 
 
 

Continued on next page 
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Reprinting Requests, Continued 

    
Reprinting a Request 
 

 

Step Action 
5 
 
 
 
 
 

 
 
 
 

 

When you choose Reprint/Republish, a window appears allowing 
you to enter a printer, print style and number of copies for 
reprinting of the request. Select <OK> button in the Republish and 
Reprint Request window to reprint the request. 

 
Note: This menu entry is disabled if the request has not yet run. 
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Module 11 

Chapter 1 

EEOC_FIRES Reporting Capability 

Chapter Overview 

  
Introduction This chapter explains how to create two reports – EEOC_FIRES Status 

Report and EEOC_FIRES Dynamics Report.  These reports, once generated, 
reports will only be available in a pipe-delimited text file.  These reports will 
be available only through US Federal HR Manager and CIVDOD EEO 
responsibilities.  This user’s guide and the screen shots associated with it 
were created using the CIVDOD EEO responsibility.   

 
 

Background The EEOC_FIRES Status and Dynamics Reports were created in DCPDS to 
provide a new reporting capability for EEOC.  Once the reports are generated, 
Components will submit the reports following guidance. 

  
Chapter  
Contents 

 

Topic Page 
Creating an EEOC_FIRES Status Report 2 
Creating an EEOC_FIRES Dynamics Report 5 
Viewing and Saving the EEOC_FIRES Status and Dynamics 
Reports 

8 

 
Before you 
Begin 

Components will determine access to the responsibilities needed to create the 
reports.   
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Creating an EEOC_FIRES Status Report 

  
Creating an  
EEOC_FIRES  
Status Report 

This section guides you through the steps needed to create an EEOC_FIRES 
Status Report.   

  
 

Step Action 
1 On the Navigation List  →  Submit Processes and Reports  →   

 

 
 

2 On the Submit a New Request Screen, click OK 

 
3 On the Submit Request Page, type ‘EEOC Status Report’ in the 

NAME field and press the TAB Key 
 

 
 

Continued on next page 
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Creating an EEOC_FIRES Status Report, Continued 

  
Creating an EEOC_FIRES Status Report (continued)  
 

Step Action 
4 EEOC Status Report Parameters Screen 

 
The following data fields will be available for update in the EEOC 
Status Report Parameters Screen.  All fields highlight in yellow 
are required 
(1) Report Name – free flowing text 
(2) Report Date – typically the end of the fiscal year (30-Sep-

2011) 
(3) Agency Code – Use the ellipses associated with the field to 

select the correct code.  (i.e., AF) 
(4) Sub Element – Once the Agency Code is input, the Sub 

Element field will become available and only the codes 
associated with the Agency Code will be available.  (i.e., 
09) 

(5) Business Group – Use the ellipses associated with the field 
to select a value if appropriate. 

(6) Generating File – defaults to Text – use the ellipses to 
change the value to HML. 

(7) Submitting Agency/Sub Element Code – Use the ellipses to 
select the correct value, only those values identified by 
EEOC will be available to select from (AF00).   

 
Once all fields have been updated, select the OK Button to return 
to the Submit Request Page 

 
 

Continued on next page 
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Creating an EEOC_FIRES Status Report, Continued 

  
Creating an EEOC_FIRES Status Report (continued)  
 

Step Action 
5 From the Submit Request Screen, click the Submit Button to 

generate the report. 

 
6 The user will be directed to the Requests Screen.  Click the 

Refresh Data Button until the Phase shows Completed.   

 
Generating the report may take up to an hour.   
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Creating an EEOC_FIRES Dynamics Report 

  
Purpose This section guides you through the steps needed to create an EEOC_FIRES 

Status Report.   

 
Creating an EEOC_FIRES 
Dynamics Report 

 

 
Step Action 

1 On the Navigation List  →  Submit Processes and Reports     

 
 

2 On the Submit a New Request Screen, select OK. 

 
3 On the Submit Request Page, type ‘EEOC Dynamics Report’ in 

the NAME field and press the TAB Key 

 
 

Continued on next page 
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Creating an EEOC_FIRES Dynamics Report, Continued 

  
 

Step Action 
4 EEOC Dynamics Report Parameters Screen 

 
The following data fields will be available for update in the EEOC 
Dynamics Report Parameters Screen.  All fields highlight in 
yellow are required 

• Report Name – free flowing text 
• Report Start Date – typically the beginning of the fiscal 

year of the reporting year (1-Oct-2010) 
• Report End Date – typically the end of the fiscal year of the 

report year (30-Sep-2011) 
• Agency Code – Use the ellipses associated with the field to 

select the correct code.  (i.e., AF) 
• Sub Element – Once the Agency Code is input, the Sub 

Element field will become available and only the codes 
associated with the Agency Code will be available.  (i.e., 
09) 

• Business Group – Use the ellipses associated with the field 
to select a value if appropriate. 

• Generating File – defaults to Text – use the ellipses to 
change the value to HML. 

• Submitting Agency/Sub Element Code – Use the ellipses to 
select the correct value, only those values identified by 
EEOC will be available to select from (AF00).   

Once all fields have been updated, click the OK Button to return to 
the Submit Request Page 

 
 

Continued on next page 
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Creating an EEOC_FIRES Dynamics Report, Continued 

  
 

Step Action 
5 From the Submit Request Screen, click the Submit Button to 

generate the report. 

 
6 The user will be directed to the Requests Screen.  Click the 

Refresh Data Button until the Phase shows Completed.   

 
Generating the report may take up to an hour.   
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Viewing and Saving the EEOC_FIRES Status and Dynamics 
Report 

  
Purpose This section guides you through the steps needed to view and save the 

EEOC_FIRES Status and Dynamics Report 
 

 
View and Saving the EEOC_FIRES 
Status and Dynamics Report 

 

 
Step Action 

1 On the Navigation List  →  Submit Processes and Reports   
 

 
 

2 On the Submit a New Request Screen, click Cancel 

 
 
 

Continued on next page 
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Viewing and Saving the EEOC_FIRES Status and Dynamics 
Report, Continued 

  
 

Step Action 
3 On the toolbar, click View and then Requests 

 
4 At the Find Requests Screen, click the Find Button 

 
 
 

Continued on next page 
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Viewing and Saving the EEOC_FIRES Status and Dynamics 
Report, Continued 

  
 

Step Action 
5 On the Request Screen, locate your report.  If the Phase does not 

read Completed, click the Refresh Data Button.  You may have to 
click it several times, until the phase changes to Completed. 

 
6 One the Phase reads Completed, to view and save the report, click 

the View Output Button 

 
7 Upon click the View Output Button, the user will be directed to a 

web page that contains the report.   
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Continued on next page 

Viewing and Saving the EEOC_FIRES Status and Dynamics 
Report, Continued 

  
 

Step Action 
8 To save the report, click File on the Toolbar and then Save As 

 
And then navigate to the directory where you want to save the 
report and click the Save Button.   

 
Your reports are now ready to be submitted to EEOC through your 
normal reporting channels.   
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Module 12 

Demonstration Projects Using the DCPDS 

Module Overview 

  
Purpose This module provides information you need to manage the demonstration projects 

that test new ideas in human resource management.  Currently, there are seven 
DoD Demo Projects in effect as outlined in the Chapter Titles of this Module. 

 
Module Contents  
 

Topic Page 
Module Overview  

Terms 6 
Before you Begin 6 
Demo Project Location Codes 7 
Demo Project Pay Plans 8 

Chapter 1:  Air Force Laboratory Personnel Demonstration  
          Air Force Lab Demo - Position Builds 2 
          Air Force Lab Demo - Personnel Actions 3 
          Air Force Lab Demo - Appraisal Input 4 
          Air Force Lab Demo - CCAS Appraisal Input 6 
          Air Force Lab Demo Payout 7 
          Air Force Lab Demo Bonus 9 
          Air Force Lab Demo - Mass Processes                10 

AF Mass Salary Payout 10 
AF Mass CCS Update 12 
Demo Bonus Payout 13 

 
 
 

Continued on next page 
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Module Overview, Continued 

  
Module Contents (continued) 
 

Chapter 2:  Army Laboratory Personnel Demonstration  
          Army Lab Demo - Position Builds 2 
          Army Lab Demo - Personnel Actions 5 
          Army Lab Demo - Appraisal Input 6 
          Army Lab Demo – Demo Payout 8 
          Army Lab Demo – Demo Bonus 11 
Chapter 3:  Office of Naval Research (ONR)  

ONR Demo - Position  3 
ONR Demo – Request for Personnel Action 8 
Distinguished Contribution Allowance - RPA 10 

Initiating an RPA 10 
Incentive NOAs 815, 816, 827 12 
Pay Adjustment 13 

ONR Demo – Person Record (Special Information and Extra 
Information) 

14 

Appraisal Input 14 
CCS 15 
DCA Data 16 

ONR Demo – Mass Appraisals 17 
ONR Demo - Mass Payout 18 

 
 
 
 

Continued on next page 
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Module Overview, Continued 

  
Module Contents (continued) 
 

Chapter 4:  Science and Technology Reinvention Laboratory 
Personnel Demonstration (NSWC/NUWC) 

 

NSWC/NUWC Demo - Position Actions 3 
NSWC/NUWC Demo - Personnel Actions 7 
NSWC/NUWC Demo - Appraisal Input 8 
NSWC/NUWC Demo - Mass Appraisals 11 
NSWC/NUWC Demo - Mass Payout Mass Payout for Bonus, 
Merit, and Comparability Payout 

12 

Mass Bonus Payout 12 
NSWC NUWC Demo Merit Payout 16 
NSWC NUWC Demo Comparability Payout 19 

NSWC NUWC Demo  - Mass Update “Date Last Equiv”  20 
NSWC/NUWC Demo - Individual Payouts 21 

     Bonus Payout                21 
     Merit/Comparability Increase  24 

Chapter 5: Space & Naval Warfare System Command (SPAWAR) 
Demonstration 

 

          SPAWAR - Position Actions 3 
          SPAWAR - Personnel Actions 7 
          SPAWAR - Appraisal Input 8 
          SPAWAR - Mass Appraisals 10 
          SPAWAR Bonus, Merit, and Comparability 11 
          SPAWAR - Individual Pay Adjustment 14 

 
 
 

Continued on next page 
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Module Overview, Continued 

  
Module Contents (continued) 
 

Chapter 6: Naval Research Laboratory (NRL) Demonstration  
Naval Research Laboratory (NRL) - Position  3 
Naval Research Laboratory (NRL) - Personnel Actions 8 

Distinguished Contribution Allowance 9 
NRL Demo – Person Record (Special Information and Extra 
Information 

12 

Appraisal Input 12 
Contribution Based Compensation System (CCS) 14 
DCA Data 15 

NRL Demo – Mass Appraisals 16 
NRL Demo - Mass Payout 18 
NRL Demo - Individual Payouts 25 

Performance Awards 26 
Merit Increase 29 
Pay Adjustment 30 
Step Adjustment 32 

 Chapter 7:  Department of Defense Acquisition Demonstration   
DoD Acq Demo – Position Builds 2 
DoD Acq Demo – Personnel Actions 4 

Pay Adjustment 5 
DoD Acq Demo – Person Record Updates 7 

CCAS Appraisal Data Input 7 
Appraisal Input 8 

DoD Acq Demo - Mass Actions 10 
Bonus Payout 10 
CCAS Update 13 
 Mass Salary Payout 16 

 
 
 

Continued on next page 
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Module Overview, Continued 

  
Module Contents (continued) 
 

Chapter 8: Naval Air Warfare Centers (NAWC)  
Science and Technology Reinvention Laboratory Personnel 
Demonstration Project 

 

NAWC - Position Actions 3 
NAWC - Personnel Actions 7 
NAWC - Appraisal Input 9 
Processing NAWC Mass Appraisals Upload Process 12 
Processing NAWC Mass Payout for Bonus, Merit and 
Comparability Payout 

17 

NAWC - Extraordinary Achievement Allowance (EAA) 19 
EAA Bi-Weekly Payment Option RPA Process 19 
EAA Lump-sum Payment Option RPA Process 22 

Chapter 9:  Space & Naval Warfare System Command 
(SPAWAR 1105) 1105 (SSC Atlantic/Pacific) Scientific and 
Technical Reinvention Laboratory (STRL) Demonstration Project 

 

SPAWAR 1105- Position Actions 3 
SPAWAR 1105 - Personnel Actions 8 
SPAWAR 1105 - Appraisal Input 9 
SPAWAR 1105 - Mass Appraisal 11 
SPAWAR 1105 – Mass Processes for Bonus, Contribution, and 
Comparability Payout  

12 

Mass Payout 12 
Bonus and Contribution Payout 14 

Distinguished Contribution Allowance (DCA) RPA Process 16 
Bi-Weekly 16 
Lump Sum 19 
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Module Overview, Continued 

  
Terms  

Term Definition 
CCAS Contribution-Based Compensation and Appraisal System  
CCS Contribution-Based Compensation System  
FEPCA Federal Entitlement, Pay, and Compensation Act 
GPPA Guide to Processing Personnel Actions 

   
Before You 
Begin 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Demo Projects: 
• Provide a structure for testing change in the government’s personnel 

management system.   
• Are the vehicles an agency or organization uses to obtain the authority 

to waive existing personnel law and regulations in order to propose 
and test interventions for its own personnel management system.   

• Have rules for personnelists that can be very different from those 
applying to civil service positions in general. 

• Have unique pay plans.  
• Have the same Demo Project - CCAS Flexfield, if they use the CCAS 

area. 
 
Employees in Demo Projects: 

• Are Appropriated Fund employees. 
• Are not entitled to pay retention. 
• Are entitled to maintain their existing rate of pay if affected by a 

Reduction in Force (RIF) or placed through the Priority Placement 
Program (PPP). 

• Are entitled to all FEPCA entitlements (e.g., relocation and 
recruitment bonuses, retention allowances, and supervisory and 
staffing differentials). 

• Have a step of “00” in their records. 
• Can be placed on a Detail (See Processing a Detail, in Module 4, 
Staffing Using the DCPDS). 

 
Continued on next page 
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Module Overview, Continued 

 
 
Before You Begin (continued) 
 
   

Employee actions: 
• Have all normal RPA processes and NOAs used, except NOAs 892 (QSI) 

and 893 (WGI). 
• Have one customized NPA (SF-50) that that can be used by any or all demo 

projects.  This custom SF50 was established for printing roman numerals in 
the “Grade” block. 

• Will print customized NPAs, but you must deselect the check box on the 
Routing Window of the RPA. 

• Should reflect the Demo Pay Plan instead of the GS Pay Plan in the From 
and To Regions; and the Grade may print as a Roman numeral in the From 
and To Regions instead of a number; e.g., “II” vs. “02,” on some Demo 
NPAs. 

  
Demo Project Location Codes  
 

Code Description 
2 SPAWAR Demo Project 
3 NSWC/NUWC Warfare Centers Demo Project 
4 NRL Demonstration Project 
5 Office of Naval Research (ONR) Demo Project 
6 SPAWAR 1105 Demo Project 
7 NAWC Demo Project 
A  AF Laboratory Personnel Demo Project 
R Army Laboratory Personnel Demo Project 
Q Department of Defense Acquisition Demo Project 

 
Continued on next page 
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Module Overview, Continued 

 
Demo Project Pay Plans  
 

Demo Pay Plan Description 
DA Demonstration Administration (Navy) 
DB Demonstration Engineers and Scientists (Army) 
DE Demonstration Engineers and Scientists Technician (Army) 
DG Demonstration General (Navy) 
DJ Demonstration Administration (Army) 
DK Demonstration General Support (Army) 
DO Business Management and Professional Career Path, AF 

Research Lab. AF Only 
DP Demonstration Professional (Navy) 
DR Demonstration Scientists and Engineers (Air Force) 
DS Demonstration Specialist (Navy) 
DT Demonstration Technical (Navy) 
DU Mission Support Career Path. AF Research Laboratory. Air 

Force Only 
DV Demonstration Artisan (Army) 
DX Technician Career Path.  Air Force Research Laboratory.  Air 

Force Only 
DZ Demonstration Artisan Supervisor (Army) 
NC NRL Administrative Support 
ND Demonstration Scientific and Engineering 
NG Demonstration General Support 
NH Business Management and Technical Management Professional 
NJ Technical Management Support 
NK Administration Support 
NO NRL Administrative Specialist/Professional 
NM Supervisor/Manager 

NP NRL Science and Engineering Professional 
NR NRL Science and Engineering Technical 
NT Demonstration Administrative & Technical (Navy) 
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Module 12 

Chapter 1 

Air Force Laboratory Personnel Demonstration 

Chapter Overview 

  
Introduction This chapter explains how DCPDS is used to manage the personnel assigned to 

the Air Force Laboratory Personnel Demo Project.  

   
Chapter Contents  
 

Topic Page 
Overview 1 
Air Force Lab Demo - Position Builds 2 
Air Force Lab Demo - Personnel Actions 3 
Air Force Lab Demo - Appraisal Input 4 
Air Force Lab Demo – CCS Appraisal Input 6 
Air Force Lab Demo Payout 7 
Air Force Lab Demo Bonus 9 
Air Force Lab Demo - Mass Processes 10 

AF Mass Salary Payout 10 
AF Mass CCS Update 12 
Demo Bonus Payout 13 

   
Conversion into AF Lab Demo:  All current employees are converted into Lab Demos using 
NOA 890, with authority code Z2U.  As of 27-Jun-2010 Air Force Lab can now utilize the Army 
Mass Conversion into Demo process.  This process does not include a position build for Air 
Force, nor does it include a WGI Buy-in.  The mass process outputs NOA 890 SF50s. 
 
Elements 
Unique to  
AF Lab Demo 

• AF Demo Pay Plan (values DR, DO, DU, DX) 
• Position: Demo Broadband, Demo Pay Plan 
• Details: Demo Broadband, Demo Pay Plan 
• Person Special Information: Demo Bonus Amount, Demo Bonus Year 

(Also used by DoD Acquisition Demo) 
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Air Force Lab Demo - Position Builds 

  
Purpose This section explains the steps for building Air Force Lab Demo Positions. 

 
Note:  The Pay Table ID is “PD01” for these employees.   

   
Position Actions  

Step Action 
1 Refer to Module 2, Position Management and Classification Using the 

DCPDS, Chapter 1, Building a Position to build a Demo Project position 
following the steps in the Section, Building a Position.   

2 When completing the Extra Position Information window, select Demo 
Project Information.  Click the Details data field. 

 
3 
 
 

The Extra Position Information Flexfield opens.  Type in the data or use 
the LOV.  The Demo Location Code for this project is A.  Enter the 
Demo Pay Plan and Demo Broadband.  Click the <OK> button. Then 
click Save icon on the Toolbar. 

 
Note:  Ensure the Demo Pay Plan and Grade are built in the Extra 
Position Information window - US Government Valid Grade Info in 
the Details data field.  Business rules require Valid grade and Target 
grade information to match the Broadband and Demo Pay Plan. 

  
Continued on next page 
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Air Force Lab Demo - Personnel Actions 

  
Purpose This section explains the steps for processing personnel actions for Air Force 

(AF) Lab Demo employees (Demo Location Code = A; Pay Plan = DR, DO, 
DU, DX; and Step = 00). 

  
Personnel 
Actions 

All RPA processes and GPPA NOAs are used for this demo, except for the 
NOAs identified below as “Not Eligible.”  The Authority Code is usually 
Z2U (Public Law 103-337), applies to NOAs 001, 002, 1##, 3##, 5##, 7##, 
8## (except 885 and 892), and 991. 

 
NOAs Explanation 

Not Used:  
885 Performance Awards – Not Eligible 
892 Quality Salary Increase - Not Eligible 
893 WGI - Not Eligible 
888 WGI Denial - Not Eligible  

Used:  
877 Special Act or Service Award - Dollar limits do not apply for 

the AF Lab demo, so it accepts any amount. 
816 Relocation Bonus - no percent limits. 
991 Demo Bonus 

  
Entitlements The following describes the eligibility and non-eligibility of AF Lab Demo 

employees.  
 

Eligible for: Not Eligible for: 
Locality Pay  Pay Retention except for RIF and PPP (but have no 

consideration) 
All FEPCA Entitlements Premium Pay 
 Administratively Uncontrollable Overtime (AUO) 
 Supervisory Differential 
 Special Pay Rates 
 Staffing Differential 
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Air Force Lab Demo - Appraisal Input 

   
Purpose This section explains how appraisal data is input into the employee’s record.  

See Module 5, Workforce Relations Using the DCPDS, Chapter 2 
Performance Appraisal Information. 

  
Appraisal Input Upon accessing an employee to the system, the US GOV PERF 

APPRAISAL will automatically populate only the date the first appraisal is 
due. 
• When it is time to input the appraisal, you will not enter it in the US 

GOV PERF APPRAISAL Flexfield.   
• You will enter the appraisal in the Appr - Air Force Lab Demo name 

data field using the steps in Module 1, Fundamentals of the DCPDS, 
Chapter 5, Updating and Viewing the Employee Record, Section, Using 
Special Information Type. 

 
 

Step Action 
1 In the populated People window, click the <Special Info> button.  

To open the Special Information window. 

 
Scroll down and select Appr - Air Force Lab Demo.  Click in the 
Detail data field.   

 
Continued on next page 
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Air Force Lab Demo - Appraisal Input, Continued 

  
Appraisal Input (continued) 
 

Step Action 
2 The Appr - Air Force Lab Demo window opens.  Type in the 

data or use the LOV.  Click the <OK> button.  The Detail data 
field populates with the data. 

 
 

3 Save your action by clicking Save icon on the Toolbar. 
Note:  Using the data from Appr - Air Force Lab Demo, the 
system automatically populates the Fed appraisal area.  The 
appraisal rating code; however, is converted from Air Force alpha 
values to the equivalent OPM numeric values in order to flow to 
CPDF properly. 
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Air Force Lab Demo - CCS Appraisal Input 

  
Purpose This section explains how the CCS appraisal data is input into the employee’s 

record. 

   
CCS Appraisal 
Data Input 

After accessing an employee to the system, and entering the appraisal data, 
which in turn automatically populates the US GOV PERF APPRAISAL, 
enter the CCS/CCAS data when needed using the following steps. 

  
Step Action 

1 In the populated People window, click the<Special Info> button.  
To open the Special Information window. 

 
2 Scroll down and select Demo Project – CCS/CCAS.  Click in the 

Detail Data Field to open the Demo Project – CCS/CCAS 
Flexfield: 

 
3 Type in data or use the LOV to enter data.  Click the<OK> button.  

The Details data field populates with the information. 
4 Save your action by clicking Save icon on the Toolbar. 
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Air Force Lab Demo Payout 

  
Purpose This section explains how to process a Demo Payout. 

  
Demo Payout NOA 894, Gen Adj, is used with Authority Code Z2U.  Each demo payout 

can be done individually or in Mass.  When input individually, there is no 
salary calculations performed automatically.  Salary is calculated manually.  
Mass salary calculations are computed by the system (See the Mass Process 
Procedures in this chapter for details).  To input the payout manually, one by 
one, follow the steps in Module 3, Processing Requests for Personnel Actions 
Using the DCPDS, Chapter 1, Processing a Request for Personnel Action. 

 
Step Action 

1 
 

Navigation Path → Request for Personnel Action → Salary 
Change → Pay Adjustment <Open>.  The RPA opens. 
Note: Pay Adjustments that include a Broad Band select Pay 
Adjustment-Position Change to open the RPA. 

2 
 

Type in the Effective Date of the action.  With the cursor in the 
Name data field in Part B of the RPA, click the LOV, and select 
the employee’s name or type in the information. 
• Type 894 in 5-A Code data field.  Data field 5-B-Nature of 

Action automatically populates with “Pay Adj.” 
•   Type Z2U in 5-C Code data field.  Data field 5-D Legal 

Authority automatically populates with PL 103.337: 

 

3 Continue completing the RPA data fields as required.  Click the 
Save icon on the Toolbar. 

  
Continued on next page 
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Air Force Lab Demo Payout, Continued 

  
Demo Payout (continued) 
 

Step Action 
4 Remark Code used is 9A2 on all actions.  Actions including a 

Broadband move use additional remark of 9A3. 
5 To print the NPA (CUSTOM DEMO SF-50), you must: 

• Click the “X” in the Box next to Print Notification to deselect 
Fed version NPA.   

• Not select a printer.   
• Select “Approval.”  Click the <OK> button to automatically 

print the custom NPA. 
 
 

Note:  The following applies to NPA (CUSTOM DEMO SF-50). 
• The Demo Pay Plan should print on the NPA FROM and 

TO INFORMATION Regions of the Pay Plan data fields 
as appropriate for the NOA.   

• The Broadband should print as a roman numeral in the 
FROM and TO INFORMATION Regions of the Grade or 
Level data fields as appropriate for the NOA. 

• Some reject messages on demo-unique items; e.g., “You 
are not authorized to use an NOA 892 or 893,” will not 
appear until you get to this point.  You must: 
• First, complete all four pages of the RPA. 
• Complete the <Extra Information> flex field. 
• Route the RPA, save the RPA, and Update HR. 

When you delete the “X” in the Print Notification area and click 
the <OK> button for approval, you will finally see the reject 
messages appear. 
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Air Force Lab Demo Bonus 

  
Purpose This section explains the steps for processing an Air Force Lab Demo Bonus. 

  
Demo Bonus NOA 0991 is used for the Bonus pay out, with Authority Code Z2U.  There is no 

dollar limit on the amount of a monetary award except for meeting Component 
business rules.  For information on completing the RPA to input the bonus, refer 
to these modules: 

• Module 3, Processing Personnel Actions Using the DCPDS, Chapter 1, 
Processing a Request for Personnel Action. 

• Module 5, Workforce Relations Using the DCPDS, Chapter 3, Awards, 
Section, Entering a Monetary Award. 

 
Step Action 

1 Navigation Path → Request for Personnel Action → Award/One-
Time Payment  →  <Open>. 

2 The RPA opens.  In Part B, enter the name of the employee 
receiving the bonus.  

 
3 Enter the Effective Date, in data field 4 of PART B – For 

Preparation of SF 50 Region. 
4 With the cursor in the 5-A Code data field, select the LOV for the 

Nature of Action Code.  Select 0991, Air Force Demo Bonus 
Award.  Type Z2U in 5C Code data field to populate the Legal 
Authority. 

5 Page 2 of the RPA is automatically populated except for Award 
and Unit of Measurement (UoM) data fields.  Type in the amount 
of the bonus in the Award data field and an “M” for Money in the 
UoM data field. 

6 Complete the remainder of the RPA. 
7 Remark code used is 9AE. 
8 Route the RPA.  Save it and Update HR. 
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Air Force Lab Demo - Mass Processes 

  
Purpose This section explains the procedures for Mass Processes: 

• Air Force Demo Mass Salary Payout. 
• Air Force Demo Mass CCS Update. 
• Air Force Demo Bonus Payout.  

Mass Process occurs outside the RPA (SF-52) process, through the Reports 
function.  Each November, an updated guide to processing Demo Payouts is 
provided to components. 

 
 
AF Demo Mass 
Salary Payout 

For detailed information, follow the steps outlined in Module 1, 
Fundamentals of the DCPDS, Chapter 8, Reports, and Submitting Report 
Requests. 

 
Step Action 

1 Responsibility CIVDOD Demo Administrator. Navigation Path → 
Demo Mass Processes → <Open>.  The Mass Processes window 
opens. 

 
2 Place your cursor in the Mass Process Name data field and enter a 

name.   
3 Select a process from the list of values.  Example: Air Force Demo 

Salary Payout. 
4 Type in the file name to be uploaded or use the Browse button. 
5 Enter the Process Date (DD-MON-YYYY). (Hint: this is actual date 

that process will be executed). 
6 Select a printer name: 
7 Select the <Load Ascii File> button.  The system will load the 

records to the staging table and generate a message for failure or 
successful load. 
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8 Select the <Preview> button. 
Note:  The system retrieves the data for all employees from the 
staging tables, and displays the From and To data in the Preview 
window. 

• User can select or deselect records. 
• Review the data displayed.  

9 Select the <Execute> button. 
The system…. 

• Creates an RPA process. 
• Outputs the customized NPA (SF 50) instead of the Fed 

(NPA). 
• Outputs a payroll record and any other required interface 

records. 
• Updates the employee record. 

Once the process has completed, the Demo NPAs can be printed.   
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Air Force Lab Demo - Mass Processes, Continued 

   

AF Demo Mass 
CCS Update 

Also see Chapter 8: Demo Mass Pay Adjustment Guidance - 2011. 

 

Step Action 
1 Using the CIVDOD Demo Process Administrator responsibility, 

navigate to Mass Demo Processes.     

 
2 Provide a name in the Mass Process Name field. 
3 Select Air Force Demo CCS Update type from the drop down. 
4 Enter the name of the file to be uploaded, or use the Browse button to 

select the file name.  
5 Enter the Process Date (DD-MON-YYYY) (Hint: this is not the 

effective date, it is date the process will be executed). 
6 Select Printer (0-Default) No printer settings are needed since this 

process does not output an NPA. 
7 Click the<Submit> button. 
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Air Force Lab Demo - Mass Processes, Continued 

   
  
AF Demo 
Bonus Payout 

For details, follow the steps outlined in Module 1, Fundamentals of the 
DCPDS, Chapter 8, Reports, Section, and Submitting Report Requests. 

 
Step Action 

1 Repeat the steps outlined on the preceding page for AF Demo Mass 
Salary Payout, except for the Mass Process Type field, select Air 
Force Demo Bonus Payout. 

2 Select the<Preview> button and select or deselect any records.  
3 Click the<Execute> button 

Note:  The process: 
• Creates an RPA with NOA 991 and Authority Code Z2U. 
• Outputs the Customized NPA (not Fed version). 
• Outputs a payroll record and any other required interface 

records. 
• Updates the employee record: creates US Fed Award entry, 

with award type “1M”, and Special Information “Air Force 
Demo Bonus Info” Bonus Year and Bonus Amount. 

Once the process completes, you may print the NPAs.   

The award amount prints in the “To Salary” data field and all other 
data for salary is blank.   
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Module 12 

Chapter 2 

Army Laboratory Personnel Demonstration 

Chapter Overview 

  
Introduction This chapter explains how DCPDS is used to manage the personnel assigned to 

the Army Laboratory Personnel Demonstration Project. 

  
Chapter Contents  
 

Topic Page 
Overview 1 
Army Lab Demo - Position Builds 2 
Army Lab Demo - Personnel Actions 5 
Army Lab Demo - Appraisal Input 6 
Army Lab Demo – Demo Payout 8 
Army Lab Demo – Demo Bonus 11 

 
 



       R12  March 2012 

Demo Projects:  Army Lab Demo  Mod 12, Chap 2, Page 2 
 

Army Lab Demo - Position Builds 

  
Purpose This section explains the steps for building Army Lab Demo Positions. 
 

  
  Step Action 

1 This section explains the steps for building Army Lab positions.  The 
Army Lab Demo has a total of 9 Laboratory demonstration projects.  
Position extra information Demo Project Information contains a field 
342B Demo ID to identify each lab: 

Lab Demo Acronym 342B 
Demo 
ID 

Army Research Laboratory ARL AR 
Engineer Research and Development Center ERDC ER 
Medical Research and Material Command MRMC MR 
Aviation and Missile Research, Development & Engineering 
Center 

AMRDEC AM 

Communications Electronics Research, Development, and 
Engineering Center 

CERDEC CE 

Natick Soldier Research, Development and Engineering 
Center 

NSRDEC NS 

Edgewood Chemical Biological Center ECBC EC 
Armament Research, Development and Engineer Center ARDEC AE 
Tank-Automotive Research, Development and Engineer 
Center 

TARDEC TA 
 

2 Refer to Module 2, Position Management and Classification Using 
the DCPDS, Chapter 1, Building a Position to build a Demo Project 
position following the steps in the Section – Building a Position.   

 

Continued on next page 
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Army Lab Demo - Position Builds, Continued 

  
Purpose (Continued)  

  Step Action 
3 When completing the Extra Position Information window, select 

Demo Project Information Type.  Click in the Details data field.  

 
4 
 
 

The Extra Position Information Flexfield opens.  Type in R or use 
the LOV in Demo Location Code.  Do not input Demo Pay Plan and 
Demo Broadband.  Select the <OK> button then click the Save icon 
on the Toolbar.   

 
342B Demo ID must also be input for all Army Lab Demo positions 
to identify the specific Army Lab Demonstration Project. 

 
 
 

Continued on next page 
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Army Lab Demo - Position Builds, Continued 

  
Purpose (Continued)  

  Step Action 
5 
 

Note:  Demo Pay Plan and Demo Broadband are left blank.  Pay 
Plans and Grades are maintained in US Gov Valid Grade 
Information. 
Ensure the GS Pay Plan(s) applicable to this demo are built in the 
Extra Position Information window – US Government Valid 
Grade Info Type in the Details data field. 

6 Open the US Government Valid Grade Info Type.  Enter the pay 
plan and grade.  Enter Pay Table ID value 0000, except for the 
following:  ARDEC = RAED, TARDEC = RTAR, ECBC = 
RECB, NSRDEC = RNSR.  Click Ok and save. 

7 Continue with this section in the User Guide, to include Validating 
the Position section. 
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Army Lab Demo – Personnel Actions 

   
Purpose This section explains the steps for processing personnel actions for Army Lab 

Demo employees (Demo Location Code = R; Pay Plan = DB, DE, DJ, DK, 
DV, DZ; and Step = 00). 

 
Personnel 
Actions 

All RPA processes and GPPA NOAs are used for this demo: 
NOA 892 is used with Auth code Z2U – P.L. 103-337.  When the TO step 00 
is input in block 19 open fields for TO Basic Pay, To Locality, To Adjusted 
and To Total Pay fields in order for salary to be manually input.  See Demo 
Pay Information DDF in Extra RPA Information.  Only award types 84 and 8E 
are allowed.  However, 8E will default in the DDF for award type.   
 
For all pay actions, the Authority Code is usually Z2U (Public Law 103-337).  
On some NOAs, it is used as the 2nd Authority Code and not the first.   

  
NOAs Explanation 

Not Used:  
885 Performance Awards – Not Eligible 
893 WGI - Not Eligible 
888 WGI Denial - Not Eligible  

Used:  
877 Special Act or Service Award - Dollar limits do not apply for 

the AF Lab demo, so it accepts any amount. 
816 Relocation Bonus - no percent limits. 
991 Demo Bonus 
892 Irreg Performance Pay 
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Army Lab Demo – Appraisal Input   

  
Purpose This section explains how appraisal data is input into the employee’s record.  

See Module 5, Workforce Relations Using the DCPDS, Chapter 2 
Performance Award Information. 

   
Appraisal Input 
 
 

Upon accessing an employee to the system, the US GOV PERF 
APPRAISAL will auto populate only the date the first appraisal is due. 
Note:  When it is time to input the appraisal, you will not enter it in the US 
GOV PERF APPRAISAL Flexfield.   
You will enter the appraisal in the Appr - Army Lab Demo Name data 
field using the steps in Module 1, Fundamentals of the DCPDS, Chapter 5, 
Updating and Viewing the Employee Record:  Using the Special 
Information Type. 

  
Step Action 

1 In the populated People window, select the <Special Info> button 
to open the  Special Information Flexfield  

   
Scroll down and select Appr - Army Lab Demo.  Click in the 
Details data field.   

  
 

Continued on next page 
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Army Lab Demo – Appraisal Input, Continued   

   
Appraisal Input  (continued)  
 

Step Action 
2 The Appr – Army Lab Demo Flexfield opens.  Type in the data or 

use the LOV.   

 
 

Select the <OK> button.  The Detail data field populates with the 
data. 

3 Select the Save icon on the Toolbar to save your action. 
4 Using the data input, the system automatically populates the Fed 

appraisal area using the Appr - Army Lab Demo Flexfield.   
Note:  The appraisal rating code is converted from Army alpha 
values to the equivalent OPM numeric values to flow to CPDF 
properly.  
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Army Lab Demo – Demo Payout 

  
Purpose This section explains how to process a Demo Payout. 

  
Demo Payout NOA 894, Gen Adj, is used with Authority Code Z2U.  Each demo payout is 

done individually, not in mass.  There are no salary calculations performed 
automatically.  Salary is calculated manually.  To input the payout manually, 
one by one, use the steps in Module 3, Processing Personnel Actions Using the 
DCPDS, Chapter 1, Processing a Request for Personnel Action.  

 
Step Action 

1 Navigation Path    Request for Personnel Action    Salary 
Change    Pay Adjustment <Open>.   The RPA opens. 

 
2 With the cursor in the Name data field, click in the LOV, and select 

the employee’s name or type in the information. 
3 • Type 894 in the 5-A Code data field.  Data field 5-B Nature of 

Action automatically populates with “Gen Adj.” 
• Type Z2U in data field 5-C Code.  Data field 5-D Legal 

Authority automatically populates with PL 103.337. 

 
4 Continue completing the RPA data fields as required.  Select the 

Save icon on the Toolbar. 
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Army Lab Demo – Demo Payout, continued 

  
Demo Payout, continued 
 

Step Action 
5 
 

Note:  Two new fields have been added to DCPDS for tracking 
Staffing Supplement: 

1) Staffing Supplement – Stored in People Enter & 
Maintain>Assignment>Entries.  This field is to identify 
employees receiving a special rate supplement instead of 
locality Pay.  The field is the same size and length as 
Locality Pay field. 

 
2)  Staffing Factor – Stored in Assignment Extra Information.  

This field is to hold the staffing factor percentage used to 
calculate the staffing supplement, and is a numeric field 
with a length of 3 places.  

 
6 Navigate to Extra Information – Review the DDF Demo Pay 

Information.   Determine if Staffing Factor should be input for the 
record.  This field is also available for the following RPA actions: 
1##, 5##, 713, 702, 703, 894 and 890. 

 
Continued on next page 
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Army Lab Demo – Demo Payout, continued 

   
Demo Payout, continued  
 

Step Action 
7 
 

To print the NPA (CUSTOM DEMO SF-50), you must: 
• Click the “X” in the Box next to Print Notification to deselect 

the Fed version NPA.   
• Not select a printer.   
• Select “Approval.” 
• Then select <OK> to automatically print the custom NPA. 
Note:  The following applies to NPA (CUSTOM DEMO SF-50). 

• The Demo Pay Plan should print on the NPA FROM and 
TO INFORMATION Regions of the Pay Plan data fields as 
appropriate for the NOA.   

• The Broadband should print as a roman numeral in the 
FROM and TO INFORMATION Regions of the Grade 
data fields as appropriate for the NOA. 

• Some reject messages on demo-unique items; e.g., “You are 
not authorized to use an NOA 892 or 893,” will not appear 
until you get to this point.  You must: 
• First, complete all four pages of the RPA. 
• Complete the <Extra Information> flex field. 
• Route the RPA, save it, and Update HR. 

When you delete the “X” in the Print Notification area and select 
the <OK> button for approval, you will finally see the reject 
messages appear. 
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Army Lab Demo – Demo Bonus 

 
Purpose This section explains the steps for processing an Army Lab Demo Bonus. 

  
Demo Bonus NOA 840 is used for the Bonus pay out.  The dollar limit is $10,000.  To 

input the bonus, refer to these modules: 
• Module 3, Processing Personnel Actions Using the DCPDS, Chapter 

1, Processing a Request for Personnel Action. 
• Module 5, Workforce Relations, Chapter 3 Awards Section:  Entering 

a Monetary Award. 
 

Step Action 
1 Navigation Path    Request for Personnel Action   

Award/One-Time Payment    <Open>. 
2 The RPA opens.  In Part B, enter the name of the employee 

receiving the bonus.  
3 Enter the Effective Date, in Block 4. 
4 With the cursor in the 5-A Code data field, click the LOV for the 

Nature of Action Code.  Select 840, Performance Award.  Leave 
the Authority code blank. 

5 Page 2 of the RPA is automatically populated except for Award 
and Unit of Measurement (UoM) data fields.  Type in the amount 
of the bonus in the Award data field and an “M” for Money in the 
UoM data field. 

6 Complete the remainder of the RPA. 
7 Route the RPA.  Save it and Update HR. 
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Module 12 

Chapter 3 

Office of Naval Research (ONR) Demonstration 

Chapter Overview 

  
Introduction This chapter explains how DCPDS is used to manage the personnel assigned to 

the ONR Demo Project.  

   
Chapter 
Contents 

 

 
Topic Page 

Overview 1 
ONR Demo - Position  3 
ONR Demo – Request for Personnel Action 8 
Distinguished Contribution Allowance - RPA 10 

Initiating an RPA 10 
Incentive NOAs 815, 816, 827 12 
Pay Adjustment 13 

ONR Demo – Person Record (Special Information and Extra 
Information) 

14 

Appraisal Input 14 
CCS 15 
DCA Data 16 

ONR Demo – Mass Appraisals 17 
ONR Demo - Mass Payout 18 
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Chapter Overview, Continued 

  
Before You 
Begin The ONR Demo Project: 

• Uses Demo Location Code = 5. 

• Uses Pay Plans: NP, NO, NC. 

• Valid Pay plan/Grade combinations: NP 01-05, NO 01-05, NC 01-03. 

• Does not use the Demo Pay Plan and Demo Broadband located in 
the Demo Project Information DDF. 

• Grade is printed as-is on the Standard SF50.   

• ONR Demo uses legal authority code “Z2U” for all pay transactions, 
conversion into Demo, and appointment actions.  Z2U is used as it 
exists on current tables. 

• Pay rules for ONR Demo employees:  
 

- Base pay will be manually entered and DCPDS will auto-populate 
the locality rate associated with the position Geographic Location 
Code.     

 
- DCPDS will calculate the Adjusted and Total Pay rates.  

 
- The pay cap for this demo will be the EX level IV.   

 
- The aggregate limit pay cap would be EX level I.   

 
- Pay Rate Determinates will follow the same rules as NRL. 

• ONR will use Pay Rate Determinants 0 for “Other” and 2 for 
“Maintained Pay”.  NRL employees are not entitled to special salary 
rate. 

• ONR Demo employees are entitled to premium pay, administratively 
uncontrollable overtime (AUO), availability pay, recruitment bonus, 
retention allowance, distinguished contributions, and relocation bonus. 
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Office of Naval Research (ONR) - Position 

  
Purpose This section explains the steps for building ONR Demo Positions.  ONR Demo 

code is 5.  ONR uses the following pay plan grade combinations: NP 01-05, NC 
01-03, NO 01-05.  Pay Table ID is “R001”; however “0000” is flowed to DFAS.   

   
Building an ONR Demo Position   
 

Step Action 
1 Refer to Module 2, Position Management and Classification in the 

DCPDS, Chapter 1, Building a Position, and follow the steps 
starting on Page 25 to build a position.  

2 
 

When completing the Extra Position Information Flex fields, 
select Demo Project Information first.  Click in the Details data 
field. 

  
3 The Extra Position Information window Opens.  Enter the Demo 

Location Code (5 for ONR), the only field needed for this Demo.  
Do not fill in the Demo Pay Plan or Demo Broadband data fields 
which are only used with the Acquisition Workforce Demo.  Select 
<OK>. 

 
 

Continued on next page 
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Office of Naval Research (ONR) - Position, Continued 

  
Building an ONR Demo Position (continued) 
 

Step Action 
4 In the Extra Position Information Flexfield, select Multiple 

Agency Information and click in the Details data field.  

  
 

5 The Extra Position Information window opens.  Enter the 
appropriate data.  Note:  These data fields will use the same values 
as GS Appropriated Fund positions.  There is no Demo-unique 
information in this window.  Select the <OK> button. 

 
 

 
Continued on next page 
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Office of Naval Research (ONR) - Position, Continued 

  
Building an ONR Demo Position (continued) 
 

Step Action 
6 In the Extra Position Information Flexfield, select Navy and click 

in the Details data field.  

 
7 
 
 

The Extra Position Information window opens.  Fill in the 
appropriate data.  
Note:  These data fields will use the same values as the GS 
Appropriated Fund positions.  There is no Demo unique 
information in this window.   
In the Demo OGC data field, type in the data or use the LOV.   

 
 

Continued on next page 
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Office of Naval Research (ONR) - Position, Continued 

  
Building an ONR Demo Position (continued) 
 

Step Action 
8 If you use the LOV in Demo OGC data field, the Demo OGC 

Flexfield opens. Select an Occupational Group Code for the 
position. Select the <OK> button. 

 
9 The Extra Position Information window opens with Demo OGC 

and Sensitivity Criterion data fields populated.  Enter the SAC 
(Specialty Area Code) if applicable.   

10 If you want to change the default in Sensitivity Criterion, click in 
the LOV and make a selection; e.g. “A.”  Select the <OK> button. 

 
 

Continued on next page 
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Office of Naval Research (ONR) - Position, Continued 

  
Building an ONR Demo Position (continued) 

Step Action 
10 

(cont) 
The Sensitivity Criterion is changed.   

 
Select  <OK> and Save. 

11 
 
 

In the Extra Position Information Flexfield, select US Federal 
Position Group1 and US Federal Position Group2 and fill in the 
appropriate data fields. 
Note:  Use the same values as GS positions.  No Demo unique 
information is used except for Functional Code.  Demo uses a 
subset of the OPM functional codes; so, be sure to use the one on 
the position description.   

12 In the Extra Position Information Flexfield, click US Federal 
Valid Grade Info.  Click the Details data field to input ONR pay 
plans, Grades, and Pay Table ID. 

  
Note:  Valid Pay Plan and Grade combinations are: NP 01, 02, 03, 
04, 05; NO 01, 02, 03, 04, 05; NC 01, 02, 03.  GS data is 
inappropriate.  All data must be Demo Pay Plan(s) applicable to 
this demo.  Enter R001 for Pay Table ID for ONR. 

13 Continue completing position build by following this section in the 
User Guide, to include Validating the Position section. 
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Office of Naval Research (ONR) – Request for Personnel 
Action 

  
Purpose This section explains the steps for processing personnel actions unique to 

ONR Demo employees. 

   
See Also Module 3, Chap 1, Completing the RPA 

Module 4, Chap 4, Processing Actions 

  
Personnel 
Actions 

• All RPA processes and OPM NOAs are used for this demo: 
•    Appointments 
•    Awards: all except  

• 885 (Performance Award), 
•    Conversion to Appointments 
•    LWOP 
•    Change Actions 
•    Pay Actions (Pay Adjustment, Promotion, Change to Lower Grade, 
•    Temporary Promotion, Other Pay D810 Distinguished Contributions 

Allowance) 
•    Excluding the following actions: 

• 892 (WGI). 
• 893 (WGI). 
• 888 (WGI Denial). 

• Pay Plans are equal to NP, NO, and NC. 
• Any actions affecting pay (permanent or temporary) are documented 

using an RPA.   
• The Standard SF50 is produced. 
• The following NOAs are specifically used by ONR to document actions.  

The Authority Code for these NOAs is usually Z2U (P.L. 103-337).  
 

NOAs Explanation 
D810 Change in Distinguished Contributions Allowance 
815    Recruitment bonus 
816 Relocation bonus 
827 Retention 
894    Pay Adjustment   

Continued on next page 
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Office of Naval Research (ONR) – Request for Personnel 
Action, Continued 

  
Personnel Actions (Continued) 
 

NOAs Explanation 
3## Separations:  

Note:  When a demo employee separates, OPM requires they be 
separated under the demo pay plan and that the separation action, 
no matter what type, documents the demo information.  GS 
equivalencies are recorded in the remarks on these NPAs (SF50s). 
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Distinguished Contributions Allowance – RPA 

 
Purpose This section explains how to process a contribution allowance for an ONR 

Demo employee.  NOA D810 is found in the Salary Change NOA family, 
Other Pay actions.  

  
Explanation 
 
 

NOA D810:  This RPA process is used to document the Distinguished 
Contributions Allowance.  After completing the RPA, enter the DCA data in 
the RPA extra information DDF Navy NRL Demo Projects DCA Data. 

  
 
Initiating an 
RPA 

 
Follow these steps to process NOA D810 for an ONR Demo employee. 

Step Action 
1 Navigation Path → Request for Personnel Action → Salary 

Change → Other Pay <Open>. 

.    
2 Enter the Effective Date, then select employee name. 
3 Enter the NOA in Block 5-A Code, i.e., D810.  Block 5-B Nature 

of Action populates with Change in Distinguished Contributions 
Allowance.   

 
 

4 Enter the Legal Authority Code Z2U in Block 5-C Code. 
 
 

Continued on next page 
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 Distinguished Contributions Allowance - RPA, Continued 

  
Initiating an RPA (Continued)  

Step Action 
5 Select the <Extra Information> button at the bottom of the RPA.  

The Extra PA Request Information window opens.    
 

6 Scroll down and select Navy lab Demo DCA-EAA Data – Click 
in the Details data field.  The Extra PA Request Information 
window opens.  Enter the DCA Data (amount or percent, 
effective date, review date).   

  
Select the <OK> button. 

7 Save and route the RPA to the Approving Official. 
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Distinguished Contributions Allowance - RPA, Continued 

 
 
Incentive NOAs  
815, 816, 827         This RPA process is used to document the incentive allowances. 
 

Step Action 
1 Navigate to Request for Personnel Actions <Incentives>.  The PA 

Request form opens. 
2 Enter the Effective Date and Employee 
3 Select one of the following NOAs: 

815  Recruitment Incentive 
816  Relocation Incentive 
827  Retention Incentive 

4 Enter the LAC. 
5 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

On Tab 2, select in the Total Pay field.  A popup window will open 
for entering the payment options:  Select the payment option and 
complete the incentive category information. 

 
 
Note: For NOA 815 and 816, only option M is available. 

6 For NOA 827, go to Extra Information and enter the Retention 
Review Date in the US Fed Retention Incentive information type. 

7 Update the action.  Then go to People/Enter & Maintain to verify 
record data. 
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Distinguished Contributions Allowance - RPA, Continued 

 
Pay  
Adjustment           This RPA process is used to document the Annual Payout manual process 
 

Step Action 
1 Navigate to Request for Personnel Actions → Salary Change 

→Pay Adjustment <Open>.   
2 Enter the Effective Date in block 4. 
3 Click in the Name data field of Part B – For Preparation of SF50 

Region.  Click the LOV and select the employee’s name or type in 
the information 

4 Type 894 in Block 5-A of the FIRST ACTION Region.   
 

 
5 Continue to complete the RPA and Save it. 
6 To print the NPA (CUSTOM DEMO SF-50), you must: 

• Check the box to select the Fed Standard SF50 NPA.  
• Select “Approval.”   
• ONR does not use Roman numerals for grades. 
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ONR Demo – Person Record (Special Information and Extra 
Information) 

  
Purpose This section explains how data is input into the employee’s record.  See 

Module 5, Workforce Relations Using the DCPDS, Chapter 2 Performance 
Award Information. 

  
Appraisal Input The ONR Demo utilizes the US Gov Appraisal.  Upon accessing an employee 

to the system, the US GOV PERF APPRAISAL automatically populates only 
the date the first appraisal is due and rating.  The first appraisal is due 
immediately upon appointment. 
• All employees entering into the Demo (whether a new hire or a current 

non-Demo employee moving into a Demo position) require input of a 
Demo performance rating at the time they enter.  This entry rating is 
always an “X” (Not Rated) rating effective the same day as the entry into 
Demo. 

• When it is time to input the appraisal, enter it in the US GOV PERF 
APPRAISAL Flexfield.   

• Using the steps in Module 1, Fundamentals of the DCPDS, Chapter 5, 
Updating and Viewing the Employee Record, Section, Using Special 
Information Type. 
 

Step Action 
1 In the populated People window, select the <Special Info> button   

Scroll down and select US Fed Perf Appraisal.  Click in the Details 
data field.   

 
 
 

Continued on next page 
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ONR Demo – Person Record (Special Information and Extra 
Information), Continued 

  
Appraisal Input (Continued) 
 

Step Action 
2 This will then open up the SIT for input.  Input all the 

appropriate elements for this demo and for your agency, then 
select OK, then SAVE the record. Below is a copy of what the 
screen looks like: 

 
 

 
Contribution-
Based 
Compensation 
System (CCS)  

 

Step Action 
1 You will find the CCS data by navigating to People  Enter 

and Maintain  Special Info   Navy Lab Demos - CCS.  
This data is updated with the January Payout file.  It is not 
updated directly in the record. 

 
 
 

Continued on next page 
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ONR Demo – Person Record (Special Information and Extra 
Information), Continued 

  
Contribution-Based Compensation System (CCS) (Continued) 
 

Step Action 
2 The LOV associated with the CCS RIF Category has these values: 

CCS RIF 
Category 

Code 

 
Description 

 
0 

RIF YRS AVAIL = 0 – Employees within the 
over-compensated range without any portion of a 
General Increase 

 
1 

RIF YRS AVAIL = 1 – Employees receiving 
Maintained Pay or any portion of a General 
Increase but no Merit Increase or Contribution 
Award 

2 RIF YRS AVAIL = 2 – Employees receiving a 
Merit Increase or Contribution Award 

3 RIF YRS AVAIL = 3 – Employees receiving both 
a Merit Increase and Contribution Award or with a 
capped salary and receiving a Contribution Award 
and/or a Distinguished Contributions Allowance 

 

 
  

DCA Data 
Step Action 

1 Distinguished Contribution Award Data.  This data can be found 
by navigating to People –> Enter and Maintain  Special Info  
Navy Lab Demos – DCA-EAA Data.  This data is updated with 
NOA D810 NOA in the Other Pay family. 
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ONR Demo – Mass Appraisals 

  
Purpose See Module 5 Chapter 2 for the steps for processing mass appraisals for ONR 

Demo employees.  The ONR Demo uses the US Fed Perf Appraisal SIT. 

  
Before you 
Begin 

HR personnelists at ONR and HRSC-SW (San Diego, CA) are jointly 
responsible for the input and execution of the mass appraisal load process:   

• The HRSC-SW is responsible for the execution of the mass appraisal 
process. 

• The ONR HRO is responsible for providing the ASCII file of 
performance data necessary for the HRSC-SW to process the mass 
appraisal upload. 

   
Mass Appraisal 

Step Action 
1 This data can be found by navigating to Mass Actions →Mass 

Appraisals →Preview Mass Appraisals.  

 
2 The Mass Appraisal Form opens.   

 

   



                                                                                                    R12                                                                          March 2012     

Demo Projects:  Office of Naval Research                                   Mod 12, Chap 3, Page 18 

ONR Demo – Mass Payout 

  
Purpose 
 
 
 
 
Before you 
Begin 

This section explains how to process a Mass Payout for an NRL Demo 
employee.  The intent of the NRL Demo is to produce a multitude of possible 
actions with the input of a single DCPDS process and to document all parts of 
the payout on a single or limited number of SF-50(s).  The SF50 should print 
a single NOAC 894 with legal authority code Z2U, or dual action 894/702 if 
promotion is indicated. 

  

 DCPDS payroll output is consolidated to a possible 4 NOACs.  894, 895, 
and 891 actions may be consolidated in a single output with NOAC 894.  
Promotion 702, Contribution Award 885, and Distinguished Contribution 
Award 810 must be output separate payroll transactions.   
 
The following NOAs are used to document Payout actions.  The Legal 
Authority Code for these NOAs is Z2U. 

 
NOAs Explanation 
894 Gen Adj (ONR Demo Payout)   
895  Gen Adj/Promotion (ONR ) 
891  Pay Adjustment   
702  Step Adjustment 
810 Distinguished Contribution Award (DCA) 

 
The format for upload file contains an element called RIF Category.  This 
data element determines the following Merit increase and/or awards: 
 

0 Employees within the over-compensated range without any 
portion of a General Increase. 
 

1 Employees receiving Maintained Pay or any portion of a 
General Increase but no Merit Increase or Contribution Award. 
 

2 Employees receiving a Merit Increase or Contribution Award. 
 

3 Employees receiving both a Merit Increase and Contribution 
Award or with a capped salary and receiving a Contribution 
Award and/or a Distinguished contribution Allowance. 
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ONR Demo – Mass Payout, Continued 

 
Follow these steps for NRL/ONR Mass Payout, using responsibility CIVDOD 
Demo Process Administrator. 

Step Action 
1 
 
 
 

Click on Process Date to identify the date and time the user wishes to 
execute the process.  User can select a past or future date.  
Note: This date is not the RPA effective date, but a date that 
determines when the process has to run.  Remember to schedule 
process to run during non-peak hours.  

 
2 

 
Select the Printer where the NPAs would print to. This field 
provides a drop down list of printers available for selection to the 
user. 

3 

 
Select the Load Ascii File button, to upload the file into the preview 
table. 

 
 

Continued on next page 
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ONR Demo – Mass Payout, Continued 

  
Step Action 

4 

  
The Status of the upload file is displayed on the Status Details 
block.  This   block provides the number of records that loaded 
successfully and the number of records that rejected. If records had 
rejected, user can click on the Process Log Button and it will take 
the user directly to the process log and provide the reason for reject. 

 
Continued on next page 
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ONR Demo – Mass Payout, Continued 

 
 

Step Action 
5 
 
 

 

 
Select the Preview button to see the data for the records that loaded 
successfully. If the user finds errors in the preview and would like 
to correct the file, then use the Delete Preview button on main 
page. This will delete the preview and allow for a new preview.  
User can then access the file, make the appropriate changes, and 
reload by clicking on the Load Ascii File again.   
 
Note:  There is no check box to Select/Unselect records for this 
mass process. All records in the preview will be processed. 

 
6 
 
 

If the file is ready to be executed, click the Execute button to 
submit the process. DCPDS will provide a Request ID.   
Note:  The Status will change from “Unprocessed” to “Submitted”. 

 
 
 

Continued on next page 
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ONR Demo – Mass Payout, Continued 

 
 

Step Action 
7 

 
The user can go to View>Request, to see the progress of the file 
execution. DCPDS defaults to All My Request, but a specific 
Request can be reviewed by identifying the Request ID Number.  
User can review the file execution phase (i.e., Completed, 
Competed with Warning, or Warning) and if the status has not 
completed, select the Refresh button until the status changes to 
Completed.   

 
 

Continued on next page 
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ONR Demo – Mass Payout, Continued 

  
 

Step Action 
8 

 
 

Click the To get the final execution Details, close the Request 
screen and the user will be back at the Process screen.  Requery on 
the Mass Demo Name and a summary of the Process is displayed on 
the Status Details block. There are 3 types of record status: 

• P – Record processed to HR (UPDATE HR COMPLETE). 
• E – Record processed but routed to Inbox due to error (RPA 

Created). 
U – Record did not process due to a fatal error (RPA Not Created).  
The Unprocessed Records will only remain in the Preview Table for 
checking/debugging purposes and the rest will be deleted out of the 
Preview table as they are processed successfully. 
 

9 Demo Upload Formats.  The following lists the Demo Upload 
layout formats for the demo salary payouts, demo bonus payouts, 
demo CCS updates, demo CCAS update, and Acq Demo Conversion 
for the different demonstration projects.  Where SSAN is displayed 
in the examples, the actual SSAN with dashes should be in place. 

 
Continued on next page 
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ONR Demo – Mass Payout, Continued 

  
 

Step Action 
10 Select the <Submit> button. 

Note:  The system retrieves the data for all employees and: 
• Creates an RPA process. 
• Outputs the customized NPA (SF 50) instead of the Fed 

(NPA). 
• ONR does not use Roman numerals for the grade. 
• Outputs a payroll record and any other required interface 

records. 
• Updates the employee record. 

Once the process has completed, the Demo NPAs can be printed.   
11 
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Module 12 

Chapter 4 

Science and Technology Reinvention Laboratory Personnel 
Demonstration (NSWC/NUWC)  

Chapter Overview 

  
Introduction This chapter explains how DCPDS is used to manage the personnel assigned to 

the Navy’s Warfare Demonstration Project.  

   
Chapter 
Contents 

 

 
Topic Page 

Overview 1 
NSWC/NUWC Demo - Position Actions 3 
NSWC/NUWC Demo - Personnel Actions 7 
NSWC/NUWC Demo - Appraisal Input 8 
NSWC/NUWC Demo - Mass Appraisals 11 
NSWC/NUWC Demo - Mass Payout Mass Payout for 
Bonus, Merit, and Comparability Payout 

12 

     Mass Bonus Payout 12 
     NSWC NUWC Demo Merit Payout 16 
     NSWC NUWC Demo Comparability Payout 19 

NSWC NUWC Demo  - Mass Update “Date Last Equiv”  20 
NSWC/NUWC Demo - Individual Payouts 21 

     Bonus Payout                21 
     Merit/Comparability Increase  24 
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Chapter Overview, Continued 

  
Before you 
Begin 

NSWC/NUWC Demo: 
• Uses specific requirements for the position “Title,” (unlike DoD 

Acquisition who does not). 
• Uses Demo Location Code = 3. 
• Only uses the Demo OGC data field on the Navy DDF. 
• Uses the Functional Class for Technicians as well as S&Es on the US 

Government Position Group 1 DDF. 
• Stores the Demo Pay Plan and Grade in the US Government Valid 

Grade Info DDF. 
• Uses Pay Plans: ND, NT, and NG. 
• Does not use the Demo Pay Plan and Demo Broadband located in the 

Demo Project Information DDF. 
• Grade is printed same as the GS grade on the Federal SF50.   
• This Demo does not require the custom SF50. 
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NSWC/NUWC Demo - Position Actions 

  
Purpose This section explains the steps for building NSWC/NUWC Demo Positions. 

   
Building a NSWC/NUWC Demo Position   
 

Step Action 
1 Refer to: 

• Module 2, Position Management and Classification in the 
DCPDS, Chapter 1, Building a Position, and follow the steps for 
building a position.  

2 
 

When completing the Extra Position Information Flex fields, select  
Others/Navy and enter the Demo Project Information first.  Click 
in the Details data field. 

 
  

3 The Extra Position Information window Opens.  Enter the Demo 
Location Code (3 for Warfare).  Do not fill in the Demo Pay Plan or 
Demo Broadband data fields which are only used with the 
Acquisition Workforce Demo.  Select <OK> button. 

 
 

Continued on next page 
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NSWC/NUWC Demo - Position Actions, Continued 

  
Building a NSWC/NUWC Demo Position (continued) 
 

Step Action 
4 In the Extra Position Information Flexfield, select Multiple 

Agency Information and click in the Details data field.  

  
5 The Extra Position Information window opens.  Enter the 

appropriate data.  Note:  These data fields will use the same values as 
General Schedule positions.  There is no Demo-unique information in 
this window.  Select the <OK> button. 

 
 

Continued on next page 
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NSWC/NUWC Demo - Position Actions, Continued 

  
Building a NSWC/NUWC Demo Position (continued) 
 

Step Action 
6 In the Extra Position Information Flexfield, select Navy and click 

in the Details data field.  

 
7 
 
 

The Extra Position Information window opens.  Fill in the 
appropriate data.  

 
 

Continued on next page 
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NSWC/NUWC Demo - Position Actions, Continued 

  
Building a NSWC/NUWC Demo Position(continued) 
 

Step Action  
8 Enter Sensitivity Criterion in the Navy DDF. 
9 
 
 

In the Extra Position Information Flexfield, select US 
Federal Position Group1 and US Federal Position Group2 
and fill in the appropriate data fields. 
Note:  Use the same values as GS positions.   

10 In the Extra Position Information Flexfield, click US Federal 
Valid Grade Info.  Click in the Details data field to input 
Warfare Demo pay plans and grades. 

 
 
Note:  Valid Pay Plan and Grade combinations are: ND 01-06; 
NT 01-06; NG 01-05.   

11 Continue completing position build by following Module 2, 
Position Management and Classification in the DCPDS, 
Chapter 1, Building a Position to include Validating the 
Position section. 
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NSWC/NUWC Demo – Personnel Actions 

  
Purpose This section explains the steps for processing personnel actions unique to 

Warfare Demo employees. 

   
See Also Module 3, Chap 1, Completing the RPA 

Module 4, Chap 4, Processing Promotions/Change to Lower Grade (CLG) 

  
Personnel 
Actions 

• All RPA processes and OPM NOAs are used for this demo except: 
• 885 (Performance Award) 
• 892 (QSI) 
• 893 (WGI) 
• 888 (WGI Denial) 

• Pay Plans are equal to ND, NT, and NG. 
• The following NOAs are used to document actions for Demo Code 3.  The 

Authority Code for these NOAs is Z2U.  
 

NOAs Explanation 
894 Gen Adj (Merit Increase Payout)  

D891   Bonus Payout (See Mod 5, Chap 3) 
894    Gen Adj (Comparability Increase)   
3## Separations:  

Note:  When a demo employee separates, OPM requires they be 
separated under the demo pay plan and that the separation action, 
no matter what type, documents the demo information.  GS 
equivalencies are recorded in the remarks on these NPAs (SF50s). 
Z2U is not used for these actions. 
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NSWC/NUWC Demo – Appraisal Input 

  
Purpose This section explains how appraisal data is input into the employee’s record.  

See Module 5, Workforce Relations Using the DCPDS, Chapter 2 Performance 
Award Information. 

  
Appraisal  
Input 

Upon accessing an employee to the system, the APPRAISAL is not 
automatically populated.  The first appraisal record is due at the time of 
appointment, and must be created by navigating to ‘People/Enter and Maintain, 
Special Information Types.  All employees newly entered into the Demo 
(whether a newly hired employee or a current non-Demo employee moving into 
a Demo position) require input of a Demo performance rating at the time they 
enter.  This entry rating is always an “X” (Not Rated) rating effective the same 
day as the entry into Demo.  
 
Enter the appraisal in the Appr – Warfare Center Demo SIT using the steps in 
Module 1, Fundamentals of the DCPDS, Chapter 5, Updating and Viewing the 
Employee Record, Section, Using Special Information Type. After the appraisal 
record is entered and saved, the US GOV PERF Appraisal will be updated 
automatically.  There is no conversion of data required from the Warfare SIT to 
the US Gov SIT, they use the same values. 
 

Step Action 
1 In the populated People window, select the <Special Info> button   

   
Scroll down and select Appr – Warfare Center Demo.  Click in the 
Details data field.   

 
Continued on next page 
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NSWC/NUWC Demo – Appraisal Input, Continued 

  
Appraisal Input (continued) 
 

Step Action 
2 The Appr – Warfare Center Demo window opens.  Type in data 

or use the LOV.  Select the <OK> button.  The Detail data field 
populates with the data. 

 
3 Following is a brief description of the  fields: 

Appraisal Type = A (annual Appraisal). 
Rating of Record – enter rating. 
Date Effective – enter effective date of appraisal. 
Rating of Record Pattern = 3 (Summary levels 1 and 3, use for 
pass/fail programs). 
Rating of Record Level – same as Rating of Record field above. 
Date Appraisal Period Starts – enter start date of appraisal period. 
Date Appraisal Period End – enter date end 
Unit – enter UIC 
Organization Structure ID – enter org code. 
Office Symbol – Leave blank. 
Pay Plan – enter pay plan. 
Grade – enter pay plan. 
Date Due – enter the same date as the Date Effective field above. 
Appraisal System Identifier – Leave blank. 
Date initial Appraisal Due – Leave blank. 

 
 

Continued on next page 



                                                                                                    R12                                                                March 2012     

Demo Projects:  NSWC/NUWC Demo                                          Mod 12, Chap 4, Page 10 

NSWC/NUWC Demo – Appraisal Input, Continued 

  
Appraisal Input (continued) 
 

Step Action 
4 Select the Save icon on the Toolbar.  Using the data input, the 

system automatically populates the Fed appraisal area.  The 
appraisal rating code however, is converted from your 
component’s alpha values to the equivalent OPM numeric values 
so that it can be flowed to CPDF properly.   
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NSWC/NUWC Demo – Mass Appraisals 

  
Purpose Updating multiple employee records at one time, eliminating the need to enter 

individual employee records manually. 

  
Before you 
Begin 

HR personnelists at HRSC are responsible for the input and execution of the 
mass appraisal load process.  The HRO is responsible for providing the 
ASCII file of performance data necessary for the HRSC to process the mass 
appraisal upload. 

   
Step Action 

1 From the navigator menu, select Mass Actions → Mass 
Appraisals.  Select Preview Mass Appraisals to set up the process. 

 
2 See Module 5 Chapter 2 for the steps for processing mass 

appraisals for Warfare Demo employees. 
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NSWC/NUWC Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout 

  
Purpose 
 
 
 
 

This section explains how to process a Mass NSWC NUWC Demo Bonus 
Payout, and a Mass NSWC NUWC Demo Merit Payout.  The yearly Demo 
Mass Payout process occurs outside the RPA process.   

• The HRO is responsible for providing the up-dated pay information 
necessary for the HRSC to process the manual payout actions. 

• The HRSC is responsible for the execution of the mass payout 
process.  

Note:  All bonuses will generate with NOA 891 and Auth Code Z2U.  All Merit 
Increases will generate with NOA 894 and Auth Code Z2U.  An award entry can 
be generated with the Merit increase Action. 

  

  
Mass Bonus 
Payout 

Using the CIVDOD Demo Process Administrator responsibility, select Mass 
Demo Processes from the navigator menu. 

 
Step Action 

1 Navigation Path Mass Demo Processes.  The Mass Processes 
window opens.  

2 Enter a Name of your choice in the Mass Process Name data field.  

 
 

Continued on next page 
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NSWC/NUWC Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout, Continued 

 
Mass Bonus Payout (continued) 
 

Step Action 
3 For the bonus payout, select NSWC NUWC Demo Bonus Payout 

from the list of values. See the Demo Mass Pay Adjustment Guide 
for format layouts. 

4 Complete the parameter Input File Name by using the Browse 
button.  Retrieve the file, which should be stored on the hard drive 
of the PC being used. 

. 
5 Complete the rest of the parameter fields: Process Date, Printer.   

 
6 Select the Load Ascii File button to load the file.  A message will 

be displayed to indicate if the file was loaded successful or if there 
were errors. 

 
 

Continued on next page 
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NSWC/NUWC Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout, Continued 

 
Mass Bonus Payout (continued) 
 

Step Action 
7 Select the Preview button.  View records selected.  If you need to 

change criteria and rerun, then you may select the Delete Preview 
button and create another one. 

 
8 Select the Execute button to submit the mass process. 

 
9 To view the status, select View > Requests > from the menu bar.  

Select Find to retrieve all and view status, or enter the Request ID 
and select Find.   

 
 

Continued on next page 
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NSWC/NUWC Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout, Continued 

 
Mass Bonus Payout (continued) 
 

10 For individual record status, go to the Process Log from Federal 
Maintenance Forms. 

11 The bonus NOA 891 will be produced.  The employee record will be 
updated with Bonus Amount and Bonus Point Value found in 
Special Information Demo Project – NV Warfare Labs. 
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NSWC/NUWC Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout, Continued 

 
NSWC NUWC DEMO Merit Payout  
 

Step Action 
1 Navigation Path Mass Demo Processes.  The Mass Processes 

window opens.  
2 Enter a Name of your choice in the Mass Process Name data field.  

 
3 For the Merit Increase, select NSWC NUWC Demo Merit Payout 

from the list of values. See the Demo Mass Pay Adjustment Guide 
for format layouts. 

4 Complete the parameter Input File Name by using the Browse 
button.  Retrieve the file, which should be stored on the hard drive of 
the PC being used. 

. 
 

Continued on next page 
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NSWC/NUWC Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout, Continued 

 
NSWC NUWC DEMO Merit Payout (continued) 
 

Step Action 
5 Complete the rest of the parameter fields: Process Date, Printer.   

 
6 Select the Load Ascii File button to load the file.  A message will be 

displayed to indicate if the file was loaded successful or if there were 
errors. 

 
7 Select the Preview button.  View records selected.  If you need to 

change criteria and rerun, then you may select the Delete Preview 
button and create another one. 

 
8 Select the Execute button to submit the mass process. 

 
 
 

Continued on next page 
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NSWC/NUWC Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout, Continued 

 
NSWC NUWC DEMO Merit Payout (Continued) 
 

Step Action 
9 To view the status, select View > Requests > from the menu bar.  

Select Find to retrieve all and view status, or enter the Request ID 
and select Find.   

 
10 For individual record status, go to the Process Log from Federal 

Maintenance Forms. 

 

11 NOA 894 is produced on the SF50 for pay increase.  If Incentive 
amount was included in flat file, then a US Fed Award entry is 
created: payroll entry for NOA 87D is generated with award type 
“1M” and group award ID 00, Date Award Earned is effective date of 
NOA. 
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NSWC/NUWC Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout, Continued 

 
NSWC NUWC DEMO Comparability Payout  
 

Step Action 
1 Navigation Path Processes and Reports>Submit Processes and 

Reports.  The Submit a New Request window opens.  Select the 
OK button.  The Submit Request window opens. 

2 Enter the process name Navy Demo Comp Payout, or a partial 
value.   Select the process name from the Find window. 

 
3 Complete the Parameters for the process.  

 
4 Select Submit.  This process will produce an SF50 with NOA 894 

for pay increase.  DCPDS calculates all salary fields by multiplying 
basic pay and Increase Percent variable.  Date last Equivalent is 
updated. 
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NSWC/NUWC Demo – Mass Update “Date Last Equiv” 

 
Purpose 
 
 
 
 

This section explains how to process a Mass update of the “Date Last Equivalent 
Increase” (DLEI) date on Demo employees. This update does not generate any 
RPA action.   

Note:  This process is required due to the Mass processes for Bonus and Merit 
does not include update of DLEI. 

  

  
Mass Update Using a responsibility other than the CIVDOD Demo Process Administrator, 

select Processes and Reports from the navigator menu. 
 

Step Action 
1 Navigation Path → Processes and Reports → Single Request 

<OK> → Submit Requests → The Submit Request window opens.  
2 Enter the Name of your request in the Name data field.  

 
3 The following fields are required: 

Demo Location Code 
Last Increase Date 
Unit ID Code 

4 Select <OK> button. 
5 Complete the Printer options in the “Upon Completion” section 
6 Select <Submit> button.   
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NSWC/NUWC Demo – Individual Payouts 

 
Purpose This section explains the three types of individual payout actions that may be 

necessary for Warfare Demo employees: 
 

Type of Individual 
Payouts 

Explanation 

D891 Bonus Used for Bonus Performance Award with Authority 
Code of Z2U.   

894 Gen Adj Used for the Merit Increase salary increases based on 
the current year’s performance rating. 

894 Gen Adj Used for the Comparability salary increases that occur 
in January. 

 
Before you 
Begin 

To input the payout actions manually, one at a time: 
• Complete all four pages of the RPA first. 
• Complete the Extra Information last. 
• Route the RPA and save it to HR. 
• Click the checkbox in the Print Notification area, select a printer 

name, and select the <OK> button for approval. 

Note:  Some reject messages on demo-unique items display at this point:  
Example:  “You are not authorized to use an NOA 892 or 893.”  Follow the 
steps in Module 3, Processing Personnel Actions Using the DCPDS, Chapter 
1, Completing the RPA, or use the following quick guide:   

      
Bonus Payout  Follow these steps to process a Bonus for a Warfare Demo employee: 
 

Step Action 
1 To process a Bonus, navigation Path → Request for Personnel 

Action → Award/One-Time Payment → Bonus Payout <Open> 
2 The following extra information fields are used with a Bonus 

(Award) action (optional input): 
Bonus Amount, Bonus Point Value.  An award entry is populated 
with Award Type “1M”, Award group ID “00”, and effective date 
is populated in Date Award Earned. 

 
Continued on next page 
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NSWC/NUWC Demo – Individual Payouts, Continued 

 
Bonus Payout (continued) 
 

Step Action 
3 Page 1 of the RPA opens with Actions Requested data field 

populated with Award/One-Time Payment.  Complete the 
remaining white data fields following the instructions in Module 3, 
Processing Requests for Personnel Actions. 

 
4 In Part B- First Action 5-A Code, enter D891 or use the LOV 

and select D891 Bonus Payout: 

 
5 Page 2 opens.  Enter the amount of the bonus in the Award data 

field, i.e., dollar amount and M (for money) in the Unit of Measure 
data field. 

 
 

Continued on next page 
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NSWC/NUWC Demo – Individual Payouts, Continued 

 
Bonus Payout (continued) 
 

Step Action 
6 The two data fields populate and Page 3 opens.  No action is 

required.  The data fields are populated.  Click the Remarks and 
Address tab to display Page 4.  With your cursor in Part F – 
Remarks for SF 50, click the LOV.  Select the appropriate Code.  
Select the <OK> button. 

 
7 Save and route the RPA.  A message Box opens with the assigned 

RPA Request Number.  Select <OK> 
8 Select <Extra Information> button on the RPA.  The Extra PA 

Request Information Flexfield opens.  Verify the Bonus data and 
enter any information needed, then return to RPA to update HR. 
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NSWC/NUWC Demo – Individual Payouts, Continued 

 
Merit/ 
Comparability 
Increase  

Follow these steps to process a Merit or Comparability Increase for a 
Warfare Demo employee: 

Step Action 
1 To process a Merit, navigation Path → Request for Personnel 

Action → Salary Change → Pay Adjustment → Gen Adj <Open> 
2 The following extra information fields are used with a Merit action 

(optional input): 
Cont Pay Eff Date, Cont Pay Amount, Cont Pay Point Value, Cont 
Pay Point. 

3 To process a Comparability increase, navigation Path → Request 
for Personnel Action → Salary Change → Pay Adjustment → Gen 
Adj <Open> 

4 The following RPA fields are used with a comparability increase 
action to enter new salaries: 
New basic pay, locality adjustment, adjusted basic pay. 

5 
 
 
 
 
 

Navigation Path → Request for Personnel Action → Salary 
Change → Pay Adjustment <Open>.  The RPA opens with Pay 
Adjustment in Block 1 Actions Requested: 

 
6 Complete Part A – Requesting Office Region. 
7 Click in the Name data field, click the LOV, and select the 

employee’s name or type in the information. 
8 Type the NOA 894 in Block 5- A.  Block 5-B populates with “Gen 

Adj”. 
 

Continued on next page 
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NSWC/NUWC Demo – Individual Payouts, Continued 

  
Merit/Comparability Increase (continued) 
 

 
Step Action 

9 Type the Legal Authority Code Z2U in Block 5-C. Block 5-D 
autopopulates with “P.L. 103-337”. 

 
10 Continue to complete the RPA and Save it. 
11 To print and update the RPA, you must click the save icon in the 

Forms toolbar: 
• Select “Yes” for the Decision popup “Do you wish to route….” 
• Select “Update HR”. 
• Click the check box next to Print Notification and enter a 

printer name. Warfare does not use Roman numerals for grades 
on the SF50, so no need to print custom Demo SF50. 

• Select “Approval.”   
• Select the <OK> button to automatically print the NPA.   
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Module 12 

Chapter 5 

Space & Naval Warfare System Command (SPAWAR) 
Demonstration 

Chapter Overview 

  
Introduction This chapter explains how DCPDS is used to manage the personnel assigned to 

the Navy’s SPAWAR Demonstration Project.  

   
Chapter 
Contents 

 

 
Topic Page 

Overview 1 
SPAWAR Demo – Position Actions 3 
SPAWAR Demo – Personnel Actions 7 
SPAWAR Demo – Appraisal Input 8 
SPAWAR Demo – Mass Appraisals 10 
SPAWAR Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout 

11 

SPAWAR Demo – Individual Payouts 14 
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Chapter Overview, Continued 

  
 
Before You 
Begin 

 
SPAWAR Demo: 

• Uses specific requirements for the position “Title,” (this is unlike DoD 
Acquisition). 

• Uses Demo Location Code = 2. 

• Only uses the Demo OGC data field on the Navy DDF. 

• Uses the Functional Class for Technicians as well as S&Es on the 
US Government Position Group 1 DDF. 

• Uses Pay Plans: DA, DG, DP, DS, and DT. 

• Does not use the Demo Pay Plan and Demo Broadband located in 
the Demo Project Information DDF. 

• Grade is printed same as the GS on the Federal SF50. 

• When NOA 894 is used, you must navigate to the SPAWAR Bonus 
Payroll Type DDF and select the appropriate payout type.  This action 
assures the appropriate PAY500 records are generated and used for 
correction and cancellation processes. 
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SPAWAR Demo - Position Actions 

  
Purpose This section explains the steps for building SPAWAR Demo Positions. 

   
Building a SPAWAR Demo Position   
 

Step Action 
1 Refer to:  Module 2, Position Management and Classification in the 

DCPDS, Chapter 1, Building a Position, and follow the steps to 
build a position.  

2 
 

When completing the Extra Position Information Flex fields, 
select Others/Navy and enter the Demo Project Information 
first.  Click in the Details data field. 

  
3 The Extra Position Information window Opens.  Enter the Demo 

Location Code (2 for SPAWAR).  Do not fill in the Demo Pay 
Plan or Demo Broadband data fields which are only used with the 
Acquisition Workforce Demo.  Select <OK>. 

 
 

Continued on next page 
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SPAWAR Demo - Position Actions, Continued 

  
Building a SPAWAR Demo Position (continued) 
 

Step Action 
4 In the Extra Position Information Flexfield, select Multiple 

Agency Information and click in the Details data field.  

  
5 
 

The Extra Position Information window opens.  Enter the 
appropriate data.  Note:  These data fields will use the same values 
as General Schedule positions.  There is no Demo-unique 
information in this window.  Select the <OK> button. 

 
 

Continued on next page 
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SPAWAR Demo - Position Actions, Continued 

  
Building a SPAWAR Demo Position (continued) 
 

Step Action 
6 In the Extra Position Information Flexfield, select Navy and click 

in the Details data field.  

 
7 
 
 

The Extra Position Information window opens.  Fill in the 
appropriate data.  

 
 

 
Continued on next page 
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SPAWAR Demo - Position Actions, Continued 

  
Building a SPAWAR Demo Position (continued) 
 

Step Action  
8 Enter Sensitivity Criterion in the Navy DDF. 
9 
 
 

In the Extra Position Information Flexfield, select US Federal 
Position Group 1 and US Federal Position Group 2 and fill in the 
appropriate data fields. 
Note:  Use the same values as GS positions.   

10 In the Extra Position Information Flexfield, select US Federal 
Valid Grade Info.  Click the Details data field to input Spawar 
Demo pay plans and grades.  

 
Note:  Valid Pay Plan and Grade combinations are: DA 01-03, DG 
00-04, DP 00-04, DS 00-03, and DT 00-03.   

11 Continue completing position build by following Module 2, 
Position Management and Classification in the DCPDS, Chapter 1, 
Building a Position to include Validating the Position section. 
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SPAWAR Demo – Personnel Actions 

  
Purpose This section explains the steps for processing personnel actions unique to 

SPAWAR Demo employees. 

   
See Also Module 3, Chap 1, Completing the RPA 

Module 4, Chap 4, Processing Promotions/Change to Lower Grade (CLG) 

  
Personnel 
Actions 

• All RPA processes and OPM NOAs are used for this demo except: 
• 840 (Performance Award) 
• 892 (QSI) 
• 893 (WGI) 
• 888 (WGI Denial) 

• Pay Plans are equal to DA, DG, DP, DS, and DT. 
• The following NOAs are used to document actions for Demo Code 2.  

The Legal Authority Code for these NOAs is ZLM “Demo Project title 6 
CSRA 1978”. 
 

NOAs Explanation 
894 Gen Adj (Bonus Payout)  
894   Gen Adj (Salary Payout) 
894    Gen Adj (Merit Payout)   
3## Separations:  

Note:  When a demo employee separates, OPM requires they be 
separated under the demo pay plan and that the separation action, 
no matter what type, documents the demo information.  GS 
equivalencies are recorded in the remarks on these NPAs (SF50s). 
ZLM is not used for these actions. 
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SPAWAR Demo – Appraisal Input 

  
Purpose This section explains how appraisal data is input into the employee’s record.  

See Module 5, Workforce Relations Using the DCPDS, Chapter 2 
Performance Award Information. 

  
Appraisal Input • Upon accessing an employee to the system, the APPRAISAL is not 

automatically populated.  When it comes time to input the appraisal, you 
will need to enter it in Appr – Space Nav Warfare Demo.  The entry rating 
is always an “X” (Not Rated) rating effective the same day as the entry 
into Demo.  

• Enter the appraisal in the Appr – Space Nav Warfare Demo SIT using the 
steps in Module 1, Fundamentals of the DCPDS, Chapter 5, Updating and 
Viewing the Employee Record, Section, Using Special Information Type. 
After the appraisal record is entered and saved, the US GOV PERF 
Appraisal will be updated automatically.  The agency unique alpha codes 
will be converted to the equivalent OPM numeric values so that it can be 
flowed to CPDF properly.   
 

Step Action 
1 In the populated People window, select the <Special Info> button.  

Scroll down and select Appr – Space Nav Warfare Demo.  Click 
in the Details data field.    

 
  

Continued on next page 
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SPAWAR Demo – Appraisal Input, Continued 

  
Appraisal Input (continued) 
 

Step Action 
2 The Appr – Space Nav Warfare Demo window opens.  Type in 

data or use the LOV.  Select the <OK> button.  The Detail data 
field populates with the data. 

 
Following is a brief description of the  fields: 
Appraisal Type = A (annual Appraisal). 
Rating of Record – enter rating: if new hire or employee moving 
into Demo, code as “V”. 
Date Effective – enter effective date of appraisal, if new hire or 
employee moving into Demo, use the effective date of the 
assignment action. 
Rating of Record Pattern = H (Summary levels 1-5). 
Rating of Record Level – Leave blank. 
Date Appraisal Period Starts – enter date start 
Date Appraisal Period End – enter 30 June of current Performance 
    Year (e.g., EOD of 02-Oct-2002 = “30-Jun-2003”). 
Unit – enter UIC 
Organization Structure ID – enter org code. 
Office Symbol – Leave blank. 
Pay Plan – enter pay plan. 
Grade – enter pay plan. 
Date Due – enter the same date as the Date Effective field above. 
Appraisal System Identifier – Leave blank. 
Date initial Appraisal Due – Leave blank. 

3 Select the Save icon on the Toolbar.  Using the data input, the 
system automatically populates the Fed appraisal area. 
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SPAWAR Demo – Mass Appraisals  

  
Purpose Updating multiple employee records at one time, eliminating the need to enter 

individual employee records manually. 

  
Before you 
Begin 

HR personnelists at HRSC are responsible for the input and execution of the 
mass appraisal load process.  The HRO is responsible for providing the 
ASCII file of performance data necessary for the HRSC to process the mass 
appraisal upload. 

   
Step Action 

1 From the navigator menu, select Mass Actions →Mass Appraisals.  
Select Preview Mass Appraisals to set up the process. 

 
2 See Module 5 Chapter 2 for the steps for processing mass appraisals 

for SPAWAR Demo employees. 
 Notes:   

• The system supplies a default value (H) for the Rating of Record 
Pattern and a default value (5) for the Rating of Record Level.  
You can change them as needed. (For the Rating of Record 
Pattern, use A for Pass/Fail, H for 5 level rating system, etc.) If 
the Rating of Record Level is left blank on this screen, the 
preview screen will auto populate this field with same value that 
is provided in the ASCII file for Rating of Record except for the 
following demonstration project records which will be populated 
as follows: 

• If the Demo Location Code = 2 (SPAWAR) and the Rating of 
Record Level is blank, the Rating of Record Level in the 
preview screen will also be blank. Rating of Record Level is not 
applicable to this Demonstration Project. 
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SPAWAR Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout 

  
Purpose 
 
 
 
 

This section explains how to process a SPAWAR Comparability Increase, a 
SPAWAR Mass Bonus Payout, and a SPAWAR Merit Payout.  The yearly 
Demo Mass Payout process occurs outside the RPA process.   

• The HRO is responsible for providing the up-dated pay information 
necessary for the HRSC to process the manual payout actions. 

• The HRSC is responsible for the execution of the mass payout 
process.  

Note:  All three actions will generate with NOA 894 Gen Adj and Legal Auth 
Code Z2U.  All Merit Increases will generate with NOA 894 and Legal Auth 
Code ZLM “Demo Project Title 6 CSRA 1978”. 

  

  
Mass 
Comparability 
Payout 

Using a responsibility other than the CIVDOD Demo Process Administrator, 
navigate to Processes and Reports. 

 
Step Action 

1 Navigation Path → Processes and Reports → Submit Processes and 
Reports and select <Ok>.   Enter the name of the Mass process in the 
Name field. (Or partial value SPAWAR% and click the Tab key.  
The Mass Processes names appear for selection.  

2 Select the Mass Process Type from the list of values.  
 

 
Continued on next page 
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SPAWAR Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout, Continued 

 
Mass Comparability Payout (continued) 
 

Step Action 
3 Complete the parameters for the process: 

. 
4 
 

For Comparability enter Effective Date, Rating Effective Date, and 
Comparability Rate.  
 For Bonus or Merit enter Effective Date, Rating Effective Date, 
and Pre-NSPS Payout. 
Note: Records are selected based on the Demo code and Rating 
Effective Date in the appraisal SIT. 

5 Select the <OK> button. 
6 Select the Options button in the “Upon Completion block to enter 

printer options.   

 
 

Continued on next page 
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SPAWAR Demo – Mass Payout for Bonus, Merit, and 
Comparability Payout, Continued 

 
Mass Comparability Payout (continued) 
 

Step Action 
7 Select the Printer from the list of values, enter “0” in the Copies 

data field, and select the <OK> button. 

 
8 Select the <Submit> button. 
9 Mass Payout 

Actions 
Explanation 

894 Gen Adj Used for SPAWAR Bonus Payout with 
Authority Code of ZLM “Demo Project Title 6 
CSRA 1978”.   

894 Gen Adj Used for the SPAWAR Salary Payout with 
Authority Code of ZLM “Demo Project Title 6 
CSRA 1978”. 

894 Gen Adj Used for SPAWAR Merit Payout with 
Authority Code of ZLM “Demo Project Title 6 
CSRA 1978”.   

 
The system retrieves the data for all employees and: 
Creates an RPA for 894, documenting the bonus or pay increase in 
the remarks, and outputs the Fed SF 50 (NPA).   
Outputs a payroll record and any other required interface records; 
Updates the employee record. 
Once the process has completed, the NPAs can be printed.   
Note:  SPAWAR Demo does not use Roman numerals for the 
grade.   
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SPAWAR Demo – Individual Payouts 

 
Purpose This section explains the three types of individual payout actions that may be 

necessary for SPAWAR Demo employees: 
Type of Individual Payouts Explanation 

894 Gen Adj Used for SPAWAR Bonus Payout with 
Authority Code of ZLM “Demo Project 
Title 6 CSRA 1978”.   

894 Gen Adj Used for the SPAWAR Salary Payout with 
Authority Code of ZLM “Demo Project 
Title 6 CSRA 1978”. 

894 Gen Adj Used for SPAWAR Merit Payout with 
Authority Code of ZLM “Demo Project 
Title 6 CSRA 1978”.   

 
Before you 
Begin 

To input the payout actions manually, one by one: 
• Complete all four pages of the RPA first. 
• Input the Extra Information last. 
• Route the RPA and save it to HR. 
• Select the checkbox in the Print Notification area, select a printer name, 

and select the <OK> button for approval. 
Note:  Some reject messages on demo-unique items display at this point:  
Example:  “You are not authorized to use an NOA 892 or 893.”  Follow the steps 
in Module 3, Processing Personnel Actions Using the DCPDS, Chapter 1, 
Completing the RPA, or use the following quick guide:   

      
Performance 
Award  

Follow these steps to process a Bonus, Salary, or Merit action for a SPAWAR 
Demo employee: 

 
Step Action 

1 To process a Bonus, navigation Path  Request for Personnel 
Action  Salary Change  Pay Adjustment <Open>.   

2 Enter the effective date, and complete the remaining white data fields 
following the instructions in Module 3, Processing Requests for 
Personnel Actions.   

 
 

Continued on next page 
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SPAWAR Demo – Individual Payouts, Continued 

 
Bonus Payout (continued) 
 

Step Action 
3 In Part B- First Action 5-A Code, enter 894 or use the LOV and 

select 894 Bonus Payout: 

 
4 Page 2 opens.  Enter the new salaries in blocks 20A through 20C. 

 
5 The “to” Total pay populates and Page 3 opens.  No action is 

required.  The data fields are populated.  Select the Remarks and 
Address tab to display Page 4.  With your cursor in Part F – 
Remarks for SF 50, click the LOV.  Select the appropriate Code.  
Select the <OK> button. 

 
 

Continued on next page 
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SPAWAR Demo – Individual Payouts, Continued 

 
Bonus Payout (continued) 
 

 6 Complete the REMARKS AND ADDRESS Tab of the RPA for 
Bonus or Salary action: 
• Part F – Remarks for SF-50 – enter appropriate Remarks: 
YYK Continuing Points ............._____. 
YYL Point Value ...........……..$_____. 
YYM Salary Increase ....……..$_____. 
YYN Total ..............………… $_____. 
YYJ Beginning Salary ....……$_____. 
If applicable (Bonus included): 
YYE An Employee Cannot Exceed Mid-Point of the Pay Range. 
YYF A Cash Payment in excess of Maximum Payable Salary of 
$_____. 
Complete the REMARKS AND ADDRESS Tab of the RPA for 
Comparability: 
• Part F – Remarks for SF-50 – enter appropriate Remarks: 
YYJ Beginning Salary ....……....$_____. 
YYP Comparability ...........… .…._____%. 
YYM Salary Increase ....…  .......$_____. 
YYN Total ..............…………....$_____. 

7 Save and route the RPA.  A message Box opens with the assigned 
RPA Request Number.  Select the <OK> button. 
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Module 12 

Chapter 6 

Naval Research Laboratory (NRL) Demonstration 

Chapter Overview 

  
Introduction This chapter explains how DCPDS is used to manage the personnel assigned to 

the NRL Demo Project.  

   
Chapter 
Contents 

 

 
Topic Page 

Overview 1 
Naval Research Laboratory (NRL) - Position  3 
Naval Research Laboratory (NRL) - Personnel Actions 8 

Distinguished Contribution Allowance 9 
NRL Demo – Person Record (Special Information and Extra 
Information 

12 

Appraisal Input 12 
Contribution Based Compensation System (CCS) 14 
DCA Data 15 

NRL Demo – Mass Appraisals 16 
NRL Demo - Mass Payout 18 
NRL Demo - Individual Payouts 25 

Performance Awards 26 
Merit Increase 29 
Pay Adjustment 30 
Step Adjustment 32 

Appendix A:  NRL Demo – Mass Process Format 33 
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Chapter Overview, Continued 

  
Before You 
Begin NRL Demonstration: 

• Uses Demo Location Code = 4. 

• Uses Pay Plans: NP, NO, NR, NC. 

• Valid Pay plan/Grade combinations: NP 01-05, NO 01-05, NR 01-05, 
NC 01-03. 

• Does not use the Demo Pay Plan and Demo Broadband located in 
the Demo Project Information DDF. 

• Grade is printed as Roman Numerals on the Demo SF50.   

• NRL Demo uses legal authority code “Z2U” for all pay transactions, 
conversion into Demo, and appointment actions.   

• Pay rules for NRL Demo employees:  

• Base pay will be manually entered and DCPDS will auto-populate 
the locality rate associated with the position’s Geographic Location 
Code.       

• DCPDS will calculate the Adjusted and Total Pay rates.  
 

• The pay cap for this demo will be the EX level IV.   
 
• The aggregate limit pay cap would be EX level I.   

 
• Pay Rate Determinants will follow the same rules as NRL. 

• NRL will use Pay Rate Determinants 0 for “Other” and 2 for 
“Maintained Pay”.  NRL employees are not entitled to special salary 
rate. 

• NRL Demo employees are entitled to premium pay, administratively 
uncontrollable overtime (AUO), availability pay, recruitment bonus, 
retention allowance, distinguished contributions, and relocation bonus. 

   
 

  



                                                                                             R12                                                                              March 2012     

Demo Projects:  Naval Research Laboratory                               Mod 12, Chap 3, Page 3 

Naval Research Laboratory (NRL) - Position 

  
Purpose This section explains the steps for building NRL Demo Positions.  NRL Demo 

code is 4.  NRL uses the following pay plan grade combinations: NP 01-05, 
NC 01-03, NO 01-05, NR 01-05.  Pay Table ID is “R000”, however “0000” is 
flowed to DFAS.   

   
Building an NRL Demo Position   
 

Step Action 
1 Refer to Module 2, Position Management and Classification in the 

DCPDS, Chapter 1, Building Positions and follow the steps starting 
to build a position.  

2 
 

When completing the Extra Position Information Flex fields, 
select Demo Project Information first.  Click the Details data field. 

  
3 The Extra Position Information window Opens.  Enter the Demo 

Location Code (4 for NRL).  Demo Location Code is the only field 
needed in this DDF for NRL Demo.  Do not fill in the Demo Pay 

Plan or Demo Broadband data fields.  Select <OK>. 

 
 

Continued on next page 
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Naval Research Laboratory (NRL) - Position, Continued 

  
Building an NRL Demo Position (continued) 
 

Step Action 
4 In the Extra Position Information Flexfield, select Multiple 

Agency Information and click in the Details data field.  

  
5 The Extra Position Information window opens.  Enter the 

appropriate data.   
Note:  These data fields will use the same values as GS 
Appropriated Fund positions.  There is no Demo-unique 
information in this window.   
Select the <OK> button. 

 
 

Continued on next page 
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Naval Research Laboratory (NRL) - Position, Continued 

  
Building an NRL Demo Position (continued) 
 

Step Action 
6 In the Extra Position Information Flexfield, select Navy and click 

in the Details data field.  

 
7 
 
 

The Extra Position Information window opens.  Fill in the 
appropriate data.  
Note:  These data fields will use the same values as the GS 
Appropriated Fund positions.  There is no Demo unique 
information in this window.   

 
 

Continued on next page 
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Naval Research Laboratory (NRL) - Position, Continued 

  
Building an NRL Demo Position (continued) 
 

Step Action 
8 If you want to change the default in Sensitivity Criterion, click the 

LOV and make a selection; e.g. “A.”  Select the <OK> button. 

 
9 The Sensitivity Criterion is changed.   

 
Select <OK> and Save. 

10 
 
 

In the Extra Position Information Flexfield, select US Federal 
Position Group 1 and US Federal Position Group 2 and fill in the 
appropriate data fields. 
Note:  Use the same values as GS positions.  No Demo unique 
information is used except for Functional Code.  Demo uses a 
subset of the OPM functional codes; so, be sure to use the one on 
the position description.   

 
Continued on next page 
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Naval Research Laboratory (NRL) - Position, Continued 

  
Building an NRL Demo Position (continued) 

Step Action 
11 In the Extra Position Information Flexfield, select US Federal Valid 

Grade Info.  Click the Details data field to input NRL pay plans,   
Grades, and Pay Table ID. 

  
Note:  Valid Pay Plan and Grade combinations are: NP 01, 02, 03, 04, 
05; NO 01, 02, 03, 04, 05; NC 01, 02, 03.  GS data is inappropriate.  All 
data must be Demo Pay Plan(s) applicable to this demo.  Enter R001 for 
Pay Table ID for NRL. 

12 Continue completing position build by following this section in the User 
Guide, to include Validating the Position section. 
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Naval Research Laboratory (NRL) – Personnel Actions 
  

Purpose This section explains the steps for processing personnel actions unique to 
NRL Demo employees. 

   
See Also Module 3, Chap 1, Completing the RPA 

Module 4, Chap 4, Processing Actions 

  
Personnel 
Actions 

All RPA processes and OPM NOAs are used for this demo: 
• Appointments 
• Awards: all except 885 (Performance Award), 
•  Conversion to Appointments 
•  LWOP 
•  Change Actions 
•  Pay Actions (Pay Adjustment, Promotion, Change to Lower Grade, 
•  Temporary Promotion, Other Pay D810 Distinguished Contributions    

Allowance) 
•  Excluding the following actions: 

• 892 (WGI). 
• 893 (WGI). 
• 888 (WGI Denial). 

• Pay Plans are equal to NP, NO, and NC, and NR. 
• Any actions affecting pay (permanent or temporary) are documented 

using an RPA.   
• The Standard Form 50 is produced. 
• The following NOACs are specifically used by NRL to document actions.  

The Authority Code for these NOAs is usually Z2U (P.L. 103-337).  
NOAs Explanation 
D810 Change in Distinguished Contributions Allowance 
815    Recruitment bonus 
816 Relocation bonus 
827 Retention 
810 Chg in Diff (used for supervisory differential) 
894    Pay Adjustment   
890   Misc Pay Adj (used for conversion into Demo) 
3## Separations:  

Note:  When a demo employee separates, OPM requires they be 
separated under the demo pay plan and that all separation actions 
document the Demo Information.  GS equivalencies are recorded 
in the remarks on these NPAs (SF50s). 
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Naval Research Laboratory (NRL) – Personnel Actions, 
continued 
 

 
Distinguished  
Contribution  
Allowance 
 

This section explains how to process a contribution allowance for an NRL 
Demo employee.  NOA D810 is found in the Salary Change NOA family, 
Other Pay actions.  

  
Explanation 
 
 

NOA D810:  This RPA process is used to document the Distinguished 
Contributions Allowance.  After completing the RPA, enter the DCA data in 
the RPA extra information DDF Navy NRL Demo Projects DCA Data. 
 

 
 Follow these steps to process NOA D810 for an NRL Demo employee. 

Step Action 
1 Navigation Path → Request for Personnel Action → Salary 

Change →  Other Pay <Open> 

.    
 

Continued on next page 
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Naval Research Laboratory (NRL) – Personnel Actions, 
continued 

  
Distinguished Contribution Allowance (continued) 
 
 

Step Action 
2 Navigate to Request Personnel Action > Salary Change family > 

Other Pay.   

 
3 Enter the Effective Date, then select employee name. 
4 Enter the NOA in Block 5-A Code, i.e., D810.  Block 5-B Nature 

of Action populates with Change in Distinguished Contributions 
Allowance.   

 
 

5 Enter the Legal Authority Code Z2U in Block 5-C Code. 
6 Select the <Extra Information> button at the bottom of the RPA.  

The Extra PA Request Information window opens.    
 

 
 
 

Continued on next page 
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Naval Research Laboratory (NRL) – Personnel Actions, 
continued 

  
Distinguished Contribution Allowance (continued) 
 

 

Step Action 
7 Scroll down and select Navy Lab Demo DCA-EAA Data – Click 

in the Details data field.  The Extra PA Request Information 
window opens.  Enter the DCA Data (amount or percent, 
effective date, review date).   

  
Select the<OK> button. 

8 Save and route the RPA to the Approving Official. 
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NRL Demo – Person Record (Special Information and Extra 
Information) 

  
Purpose This section explains how data is input into the employee’s record.  See 

Module 5, Workforce Relations Using the DCPDS, Chapter 2, Performance 
Appraisal Information. 

  
Appraisal 
Input 

The NRL Demo utilizes the “Appr – naval Research Lab Demo” appraisal 
SIT.   
 
• All employees newly entered into the Demo (whether a new hire or a 

current non-Demo employee moving into a Demo position) require input 
of a Demo performance rating at the time they enter.  This entry rating is 
always an “X” (Not Rated) rating effective the same day as the entry into 
Demo. 

• To input the appraisal, enter it in the Appr – Naval Research Lab Demo 
Flexfield.   

• Using the steps in Module 1, Fundamentals of the DCPDS, Chapter 5, 
Updating and Viewing the Employee Record, Using Special Information 
Type. 
 

Step Action 
1 In the populated People window, click the <Special Info> button   

Scroll down and select Appr – Naval Research Lab Demo.  Click in 
the Details data field.   

 
 
 

Continued on next page 
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NRL Demo – Person Record (Special Information and Extra 
Information), Continued 

  
Appraisal Input (continued) 
 
 

Step Action 
2 This will open up the SIT for input.  Input all the appropriate 

elements for this demo and for your agency, then HIT OK, then 
SAVE the record. Below is a copy of what the completed screen 
looks like: 
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NRL Demo – Person Record (Special Information and Extra 
Information) 

  
Contribution-
Based 
Compensation 
System (CCS) 

 

   
Step Action 

1 You will find the CCS data by navigating to People  Enter and 
Maintain  Special Info   Navy Lab Demos - CCS.  This 
data is updated with the January Payout file.  It is not updated 
directly in the record. 

 
 

2 The LOV associated with the CCS RIF Category has these values: 
CCS RIF 
Category 

Code 

 
Description 

 
0 

RIF YRS AVAIL = 0 – Employees within the over-
compensated range without any portion of a 
General Increase 

 
1 

RIF YRS AVAIL = 1 – Employees receiving 
Maintained Pay or any portion of a General 
Increase but no Merit Increase or Contribution 
Award 

2 RIF YRS AVAIL = 2 – Employees receiving a 
Merit Increase or Contribution Award 

3 RIF YRS AVAIL = 3 – Employees receiving both a 
Merit Increase and Contribution Award or with a 
capped salary and receiving a Contribution Award 
and/or a Distinguished Contributions Allowance 
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NRL Demo – Person Record (Special Information and Extra 
Information), continued 

  
DCA Data 

Step Action 
1 Distinguished Contribution Award Data.  This data can be found 

by navigating to People –> Enter and Maintain  Special Info  
Navy Lab Demos – DCA-EAA Data.  This data is updated with 
NOA D810 NOA in the Other Pay family. 
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NRL Demo – Mass Appraisals 

  
Purpose See Module 5, Chapter 2 for the steps for processing mass appraisals for NRL 

Demo employees.  The NRL Demo uses the Appr – Naval Research Lab 
Demo SIT. 

  
Before you 
Begin 

HR personnelists at NRL and HRSC-SW (San Diego, CA) are jointly 
responsible for the input and execution of the mass appraisal load process:   

• The HRSC-SW is responsible for the execution of the mass appraisal 
process. 

• The NRL HRO is responsible for providing the ASCII file of 
performance data necessary for the HRSC-SW to process the mass 
appraisal upload. 

   
Mass Appraisal 

Step Action 
1 This data can be found by navigating to Mass Actions → Mass 

Appraisals → Preview Mass Appraisals. 

 
 

Continued on next page 
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NRL Demo – Mass Appraisals, Continued 

  
Mass Appraisal (continued) 
 
 

Step Action 
2 The Mass Appraisal Form opens.   

 
3 See Module 5, Chapter 2 for complete instructions.  Upon update, 

the NRL Demo SIT will be updated and the US Fed Appraisal SIT 
will also be updated. 
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NRL Demo – Mass Payout 

  
Purpose 
 
 
 
 
 
Before you 
Begin 
   

This section explains how to process a Mass Payout for an NRL Demo 
employee.  The intent of the NRL Demo is to produce a multitude of possible 
actions with the input of a single DCPDS process and to document all parts of 
the payout on a single or limited number of SF-50(s).  The SF50 should print 
a single NOAC 894 with legal authority code Z2U, or dual action 894/702 if 
promotion is indicated. 

  

DCPDS payroll output can be consolidated to 4 possible NOACs.  894, 895, 
and 891 actions may be consolidated in a single output with NOAC 894.  
Promotion 702, Contribution Award 885, and Distinguished Contribution 
Award 810 must be output as separate payroll transactions.   

 
The following NOACs are used to document Payout actions.  The Legal 
Authority Code for these NOAs is Z2U. 

 
NOACs Explanation 

894 Gen Adj (NRL Demo Payout)   
895  Gen Adj/Promotion (NRL ) 
891  Pay Adjustment   
702  Step Adjustment 
810 Distinguished Contribution Award (DCA) 

 
The format for upload file contains an element called RIF Category.  This 
data element determines the following Merit increase and/or awards: 
 

Data 
Element 

Merit Increase and/or Award 

0 Employees within the over-compensated range without any 
portion of a General Increase. 

1 Employees receiving Maintained Pay or any portion of a 
General Increase but no Merit Increase or Contribution Award. 

2 Employees receiving a Merit Increase or Contribution Award. 
3 Employees receiving both a Merit Increase and Contribution 

Award or with a capped salary and receiving a Contribution 
Award and/or a Distinguished Contribution Allowance. 
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NRL Demo – Mass Payout, Continued 

 
Follow these steps for NRL/NRL Mass Payout, using responsibility CIVDOD 
Demo Process Administrator. 
 

Step Action 
1 
 
 

Click in Process Date to identify the date and time the user wishes to 
execute the process.  User can select a past or future date.  
Note: This date is not the RPA effective date, but a date that 
determines when the process has to run.  Remember to schedule 
process to run during non-peak hours.  

 
2 Click in the Printer and identify the printer where the NPAs would 

print to. This field provides a drop down list of printers available for 
selection to the user. 

 
 

 
 

Continued on next page 
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NRL Demo – Mass Payout, Continued 

 
 

Step Action 
3 
 

 
Select the Load Ascii File button to upload the file into the preview 
table. 

4 

 The Status of the upload file is displayed on the Status Details block.  
This block provides the number of records that loaded successfully 
and the number of records that rejected. If records had rejected, user 
can click on the Process Log Button and it will take the user directly 
to the process log and provide the reason for reject. 

 
 

Continued on next page 
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 NRL Demo – Mass Payout, Continued 

 
 

Step Action 
5 
 
 

 
Select the Preview button to see the data for the records that loaded 
successfully. If the user finds errors in the preview and would like to 
correct the file, then use the Delete Preview button on main page. 
This will delete the preview and allow for a new preview.  User can 
then access the file, make the appropriate changes, and reload by 
clicking on the Load Ascii File again.   
Note:  There is no check box to Select/Unselect records for this mass 
process. All records in the preview will be processed. 

 
 
 
 

Continued on next page 
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 NRL Demo – Mass Payout, Continued 

 
 

Step Action 
6 
 
 

If the file is ready to be executed, click the Execute button to submit 
the process. DCPDS will provide a Request ID.   
Note:  The Status will change from “Unprocessed” to “Submitted”. 

 
7 

 
The user can go to View>Request, to see the progress of the file 
execution. DCPDS defaults to All My Requests, but a specific 
Request can be reviewed by identifying the Request ID Number.  
User can review the file execution phase (i.e., Completed, Completed 
with Warning, or Warning) and if the status has not completed, click 
on the Refresh button until the status changes to Completed.   

 
 

Continued on next page 
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 NRL Demo – Mass Payout, Continued 

 
 

Step Action 
8 

 
Click the To get the final execution Details, close the Request 

screen and the user will be back at the Process screen.  Requery on 
the Mass Demo Name and a summary of the Process is displayed 

on the Status Details block. There are 3 types of record status: 
• P – Record processed to HR (UPDATE HR COMPLETE). 
• E – Record processed but routed to Inbox due to error (RPA 

Created). 
• U - Record did not process due to a fatal error (RPA Not 

Created).  The Unprocessed Records will remain in the 
Preview Table for checking/debugging purposes and the rest 
will be deleted out of the Preview table as they were 
processed successfully. 

 

9 • Demo Upload Formats.  See Appendix A for the NRL Demo 
Upload layout.  Where SSAN is displayed in the examples, the 
actual SSAN with dashes should be in place. 

 
Continued on next page 
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NRL Demo – Mass Payout, Continued 

 
Step Action 
10 Select the <Submit> button. 

Note:  The system retrieves the data for all employees and: 
• Creates an RPA process; 
• Outputs the customized NPA (SF 50) instead of the Fed 

(NPA); 
• Prints Roman numerals for the grade; 
• Outputs a payroll record and any other required interface 

records; 
• Updates the employee record. 

Once the process has completed, the Demo NPAs can be printed.   

   
 

NRL Demo – Individual Payouts 

 
Purpose This section explains the four types of individual payout actions that may be 

necessary for NRL Demo employees: 
 
Type of Individual Payouts Explanation 
L889 Performance Award Used for Bonus Performance Award with 

Authority Code of ZLM 45 FR26504.  These 
are only given at the time of the October 
payout. 

L891 Merit Increase Used for the salary increases associated with 
performance ratings of A, B, C, D, or E which 
occur in January and October. 

894 Pay Adjustment Used for the salary increases associated with 
performance rating of H which occurs in 
January. 

899 Step Adjustment Used to set the step of an employee who 
receives a performance rating of G to 00 when 
no change in salary occurs as a result of the 
January payout. 
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Before you 
Begin 

To input the payout actions manually, you must do the following: 
• Complete all four pages of the RPA first. 
• Do the Extra Information last. 
• Route the RPA and save it to HR. 
• Take out the “X” in the Print Notification area and select the <OK> 

button for approval. 

Note:  Some reject messages on demo-unique items display at this point:  
Example:  “You are not authorized to use an NOA 892 or 893.”  Follow the steps 
in Module 3, Processing Personnel Actions Using the DCPDS, Chapter 1, 
Processing a Request for Personnel Action, or use the following quick guide:   

      



                                                                                             R12                                                                              March 2012     

Demo Projects:  Naval Research Laboratory                               Mod 12, Chap 3, Page 26 

NRL Demo - Individual Payouts, Continued 

 
Performance 
Award  

Follow these steps to process a Bonus Performance Award for a NRL Demo 
employee: 

 
Step  Action  

1 Navigation Path → Request for Personnel Action →Salary 
Change → Pay Adjustment <Open> 

 

2 Page 1 of the RPA opens with Actions Requested data field 
populated with Pay Adjustment.  Complete the remaining white 
data fields following the instructions in Module 3, Processing 
Requests for Personnel Actions Using the DCPDS.   

 
3 In Part B- First Action 5-A Code, enter the appropriate NOA or use 

the LOV and select the NOA. 

 
 
 
 

Continued on next page 
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NRL Demo - Individual Payouts, Continued 

  
Performance Award (continued) 
 

Step Action 
4 Page 2 opens.  Enter the amount of the Performance Award in the 

Award data field, i.e., dollar amount and M (for money) in the Unit 
of Measure data field. 

 
5 The two data fields populate and Page 3 opens.  No action is 

required.  The data fields are populated.  Select the Remarks and 
Address tab to display Page 4.  With your cursor in Part F – 
Remarks for SF 50, click the LOV.  Select the appropriate Code.  
Select the<OK> button. 

 
 
 

Continued on next page 
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NRL Demo - Individual Payouts, Continued 

 
Performance Award (continued) 
 

Step Action 
6 Fill in the Year and Bonus Amount (no dollar sign) data fields on 

the PA Remarks Insertion Values window and select <OK>. 

 
7 Part F – Remarks for SF 50 is populated.  

 
8 Save and route the RPA.  A message Box opens with the assigned 

RPA Request Number.  Select <OK>. 
9 Select <Extra Information> on the RPA.  The Extra PA Request 

Information Flexfield opens. 
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NRL Demo - Individual Payouts, Continued 

  
Merit Increase  Follow these steps to process a Merit Increase for a NRL Demo employee. 

 
Step Action 

1 
 
 
 
 
 

Navigation Path → Request for Personnel Action →Salary 
Change → Pay Adjustment <Open>.  The RPA opens with Pay 
Adjustment in Block 1 Actions Requested: 

 
2 Complete Part A – Requesting Office Region. 
3 Click in the Name data field, click the LOV, and select the 

employee’s name or type in the information. 
4 Type L891 in Block 5- A.  Block 5-B populates with “Merit 

Increase.” 
5 Type ZLM in Block 5-C .With the cursor still in Block 5C, press 

the [Tab] key.  The PA Request First LA 1 Insertion Values 
window opens.  In the Other Citation data field, type “45 
FR26504.”  Select <OK>. 

 
Data field 5-D Legal Authority populates: 

 
6 Continue with the remaining steps to complete the RPA. 
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NRL Demo - Individual Payouts, Continued 

  
Pay  
Adjustment 

Follow these steps to process a pay adjustment for a NRL Demo employee. 

Step Action 
1 Navigation Path  →  Request for Personnel Action  →  Salary 

Change  →  Pay Adjustment <Open>.  The RPA opens with Pay 
Adjustment in Block 1 Actions Requested data field of PART A – 
Requesting Office Region: 

 
2 Complete Part A – Requesting Office Region. 
3 Click in the Name data field of Part B – For Preparation of SF50 

Region.  Select the LOV and select the employee’s name or type in 
the information 

4 Type 894 in Block 5-A of the FIRST ACTION Region.   
 

 
5 Continue to complete the RPA and Save it. 

 
 

Continued on next page 
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NRL Demo - Individual Payouts, Continued 

  
Pay Adjustment (continued) 
 

Step Action 
6 To print the NPA (CUSTOM DEMO SF-50), you must: 

• Click the “X” in the Box next to Print Notification to deselect 
Fed version NPA.  

• Select “Approval.”   
• Click the <OK> button to automatically print the custom NPA.   
• The Demo Pay Plan should print on the NPA FROM and TO 

INFORMATION Region, Pay Plan data fields as appropriate 
for the NOA. 

• The grade should print as an Arabic numeral in the FROM and 
TO INFORMATION Region, Grade data fields as appropriate 
for the NOA. 

• NRL does not use Roman numerals for grades; Grade “00” 
prints on the NPA as “0A.” 
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NRL Demo - Individual Payouts, Continued 

 
Step  
Adjustment 

Follow these steps for processing a Step Adjustment for a NRL  
Demo employee: 
 
Step Action 

1 Navigation Path → Request for Personnel Action → Salary 
Change → Step Adjustment <Open>. The RPA open with 5-B 
Nature of Action populated with “Step Adj”.  Type ZLM in 5-C 
Code data field.  With the cursor still in data field Block 5-C, press 
the [Tab] key.  The PA Request First LA 1 Insertion Values 
window opens.   

 
In the Other Citation data field, type 45 FR26504. 
 
Select the <OK> button.  Data field 5-D Legal Authority 
populates. 

 
2 On Page 2 of the RPA, type in the new step in data field 19 – Step 

or Rate. 
3 Continue with the remaining steps to complete the RPA.   
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Appendix A: NRL Demo Mass Process Formats 
 
1. NRL Mass Payout: ONR and NRL share the same process and format shown below: 
 

a. Pay cap for NRL and ONR is Executive Level IV.   
 

  b. This process can produce a combination of up to Five separate payroll records for NOACs: 
810, 846, 885, 702, 894.   

   1. Send 810 when there is DCA data, col 90-96, for contribution allowance 
   2. Send 885 with value “TJ” for DCA data 
   3. Send 702 when there is new CPCN 
   4. Send 894 for the pay increase for all records 
   5. Send 846 for Time Off Award 
 
  c. This process can produce a combination of SF50s for NOACs:  
   810 for Contribution Allowance; 
   702 when “To” CPCN.Sequence # is included in record 
   894 for General Increase 
 
  d. The following remarks will be produced on the SF50s base on conditions: 
     

Remark YC2 NOA 894 SF50 will be generated for the General Increase. 
Remark YC3 NOA 894 SF50 will be generated for the Locality increase. 
Remark YC4 NOA 702 SF50 will be generated for a Promotion. 
Remark YC6 NOA 894 SF50 will be generated for merit increase.  
Remark YC7 NOA 894 SF50 will be generated for a Contribution award. 
Remark YCK NOA 894 SF50 will be generated for a Time Off Award. 
Remark YC8 and YC9 NOA 810 SF50 will be generated for a Contribution Allowance 

  
e.  Award entry for award type “1M“ is created and stored in US Fed Awards for the 810 

Contribution. 
 

f. Award entry is created when there is Time Off Award hours. 
 

 
g.   Award entry for DCA is created with award type “TJ”. 
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Appendix A: NRL Mass Process Formats (Continued) 
 

 
 

Maximum 
Field 
Length 

 
Value 

 
Type 

 
Remarks 

11 SSAN VARCHAR2 Required Input w/dashes 
1 ,  Delimiter 
 
 
30 

 
EMPLOYEE NAME  
 

 
 
VARCHAR2 

Optional Input (Note: a  
comma in the employee  
name is not allowed) 

8 UIC VARCHAR2 Required Input 
1 ,  Delimiter 
6 ORG_CD VARCHAR2 Required Input 
1 ,  Delimiter 
1 RIF_CATEGORY VARCHAR2 Required Input 
1 ,  Delimiter 
2 OVRALL_CONT_SCORE VARCHAR2 Required Input 
1 ,  Delimiter 
2 PAY_PLAN VARCHAR2 Required Input 
1 ,  Delimiter 
2 GRADE VARCHAR2 Required Input 
1 ,  Delimiter 
6 OLD_BASIC NUMBER Required Input 

(Cents Not Included) 
1 ,  Delimiter 
4 GEN_INC_PERCENT NUMBER Required Input 
1 ,  Delimiter 
5 GEN_INC_DOLLARS NUMBER Required Input 

(Cents Not Included) 
1 ,  Delimiter 
6 MERIT_DOLLARS NUMBER Optional Input 
1 ,  Delimiter 
6 NEW_BASIC_SALARY NUMBER Required Input 

(Cents Not Included) 
1 ,  Delimiter 
6 LOCALITY_PERCENT NUMBER Required Input 
1 ,  Delimiter 
5 LOCALITY_AMOUNT NUMBER Required Input 

(Cents Not Included) 
1 ,  Delimiter 
6 NEW_ADJUSTED_PAY NUMBER Required Input 
1 ,  Delimiter 
5 CASH_DOLLARS NUMBER Optional Input 
1 ,  Delimiter 
3 TIME_OFF_AWARD VARCHAR2 Optional Input 
1 ,  Delimiter 
2 DCA_PERCENT NUMBER Optional Input 
1 ,  Delimiter 
5 DCA_DOLLARS NUMBER Optional Input 
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Appendix A: NRL Demo Mass Process Formats (Continued) 
 
 

Maximum 
Field 
Length 

 
Value 

 
Type 

 
Remarks 

1 ,  Delimiter 
31 CPCN.Sequence VARCHAR2 Optional Input 
1 ,  Delimiter 
6 EFFECTIVE_DATE DATE Required Input 

(Format YYMMDD) 
 

SSAN,Demo Sue,K900173E,34110,3,56,NC,03,042342,0000,00500,000000,042842,0000,05000, 
047842,,,,,,030601 
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Module 12 

Chapter 7 

Department of Defense Acquisition Demonstration 

 

Chapter Overview 

  
Introduction This chapter explains how DCPDS is used to manage the personnel assigned to 

the Department of Defense (DoD) Acquisition Personnel Demonstration 
Project. 

  
Chapter Contents  
 

Topic Page 
Overview 1 
DoD Acq Demo – Position Builds 2 
DoD Acq Demo – Personnel Actions 4 
     Pay Adjustment 5 
DoD Acq Demo – Person Record Updates 7 
Contribution-based Compensation and Appraisal System 
(CCAS) Appraisal Data Input 

7 

      Appraisal Input 8 
DoD Acq Demo - Mass Actions 10 
     Bonus Payout 10 
     CCAS Update 13 
     Mass Salary Payout 16 
Appendix A: DoD Acq Demo Appraisal Rating Crosswalk  
Appendix B: DoD Acquisition Demo Mass Process Formats  
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DoD ACQ Demo - Position Builds 

  
Purpose This section explains the steps for building ACQ Demo Positions. 
 

 
  Step Action 

1 Refer to Module 2, Building Positions using the DCPDS, Chapter 1, 
Building a Position to build a Demo Project position following the 
steps in the Section – Building a Position.   

2 When completing the Extra Position Information window, select 
Demo Project Information Type.  Click the Details data field.  

 
3 
 
 

The Extra Position Information Flexfield opens.  Type in Q (Dod 
Acquisition Personnel Demo) or use the LOV in Demo Location 
Code.   

 
 

 
 
 

Continued on next page 
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 DoD ACQ Demo - Position Builds, Continued 

 
 

Step Action 
4 
 

 

Input the Demo Broadband: NH 01-04, NJ 01-04, NK 01-03. 
 Select the <OK> button then click the Save icon on the Toolbar. 

Note:  The Demo Pay Plans and Grades are also maintained in US 
Gov Valid Grade Information. 

5 Open the US Government Valid Grade Info Type.  Enter the pay 
plan and grade (NH, NJ, and NK).  Enter Pay Table ID value 0000.  
Select Ok and save. 

6 Continue with this section in the User Guide to include Validating the 
Position section. 
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DoD ACQ Demo – Personnel Actions 

   
Purpose This section explains the steps for processing personnel actions for ACQ 

Demo employees (Demo Location Code = Q; Pay Plan = NH, NJ, NK and 
Step = 00). 

 
Personnel 
Actions 

All RPA processes and GPPA NOAs are used for this demo, except for 892 
(WGI), and 888 (WGI Denial).  The Authority Code is usually Z2W (P.L. 
104-106).  On some NOAs, it is used as the 2nd Authority Code.   

  
NOAs Explanation 

892 WGI - Not used 
888 WGI Denial - Not used 
840 Performance Award (Used for manual Bonus Payout) 
894 Pay Adjustment (used for manual Salary Payout) 
816 Relocation Bonus - no percent limits. 
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DoD ACQ Demo – Personnel Actions, Continued 

  
Purpose This section explains how to process an Annual Salary Payout. 

  
Pay Adjustment NOA 894, Gen Adj, is used with Authority Code Z2W.  Each demo payout is 

done individually, not in mass.  There are no salary calculations performed 
automatically.  Salary is calculated manually.  To input the payout manually, 
one by one, use the steps in Module 3, Processing Personnel Actions Using the 
DCPDS, Chapter 1, Processing a Request for Personnel Action.  

 
Step Action 

1 Navigation Path → Request for Personnel Action → Salary 
Change → Pay Adjustment <Open>.   The RPA opens. 

2 With the cursor in the Name data field, click the LOV, and select 
the employee’s name or type in the information. 

3 • Type 894 in the 5-A Code data field.  Data field 5-B Nature of 
Action automatically populates with “Gen Adj.” 

• Type Z2W in data field 5-C Code.  Data field 5-D Legal 
Authority automatically populates with PL 104-106. 

 
4 Continue completing the RPA data fields as required.  Click the 

Save icon on the Toolbar. 
 
 
 

Continued on next page 



         R12            March 2012 

Demo Projects:  DoD Acquisition      Mod 12, Chap 7, Page 6 
 

DoD ACQ Demo – Personnel Actions, Continued 

   
Pay Adjustment (continued)  
 

Step Action 
5 To print the NPA (CUSTOM DEMO SF-50), you must: 

• Click the “X” in the Box next to Print Notification to deselect 
the Fed version NPA.   

• Not select a printer.   
• Select “Approval.” 
• Then click <OK> to automatically print the custom NPA. 
Note:  The following applies to NPA (CUSTOM DEMO SF-50). 

• The Demo Pay Plan should print on the NPA FROM and 
TO INFORMATION Regions of the Pay Plan data fields as 
appropriate for the NOA.   

• The Broadband should print as a roman numeral in the 
FROM and TO INFORMATION Regions of the Grade 
data fields as appropriate for the NOA. 

• Some reject messages on demo-unique items; e.g., “You are 
not authorized to use an NOA 892 or 893,” will not appear 
until you get to this point.  You must: 
• First, complete all four pages of the RPA. 
• Complete the <Extra Information> flex field. 
• Route the RPA, save it, and Update HR. 

When you delete the “X” in the Print Notification area and click 
the <OK> button for approval, you will finally see the reject 
messages appear. 
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DoD Acq Demo – Person Record Updates 

  
Purpose This section explains how data is input into the employee’s record.  See 

Module 5, Workforce Relations Using the DCPDS, Chapter 2 Performance 
Appraisal Information. 

 
 

CCS Appraisal 
Data Input 

When the appointment NOA is processed, the appraisal record is created.  
You must go to the employee record and manually update the CCS/CCAS 
data when needed using the following steps. 

  
Step Action 

1 In the populated People window, click the<Special Info> button.  
To open the Special Information window. 

 
2 Scroll down and select Demo Project – CCS/CCAS.  Click in the 

Details to open the Demo Project – CCS/CCAS Flexfield: 

 
3 Type in data or use the LOV to enter data.  Click the<OK> button.  

The Details data field populates with the information. 
4 Save your action by clicking Save icon on the Toolbar. 
  



         R12            March 2012 

Demo Projects:  DoD Acquisition      Mod 12, Chap 7, Page 8 
 

DoD Acq Demo – Person Record Updates, Continued 

  
Purpose This section explains how appraisal data is input into the employee’s record.  

See Module 5, Workforce Relations Using the DCPDS, Chapter 2 
Performance Award Information. 

   
Appraisal Input 
 

 

When appointing an employee to the system, the US GOV PERF 
APPRAISAL will auto populate the date the first appraisal is due.  No other 
data will be populated for the appraisal record. 
Note:  When it is time to input the appraisal, you will not enter it in the US 
GOV PERF APPRAISAL Flexfield.   See Dod Acq Demo Appraisal Rating 
Codes crosswalk at Appendix A. 
You will enter the appraisal in the Appr – DOD Acquisition Demo Name 
data field using the steps in Module 1, Fundamentals of the DCPDS, Chapter 
5, Updating and Viewing the Employee Record:  Using the Special 
Information Type. 

  
Step Action 

1 In the populated People window, select the <Special Info> button 
to open the  Special Information Flexfield  

   
Scroll down and select Appr – DOD Acquisition Demo.  Click in 
the Detail data field.   

  
 Continued on next page 
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DoD Acq Demo – Person Record Updates, Continued   

 
Appraisal Input (continued)  
 

Step Action 
2 The Appr – DOD Acquisition Demo Flexfield opens.  Type in the 

data or use the LOV.   

 
 

Select the <OK> button.  The Detail data field populates with the 
data. 

3 Select the Save icon on the Toolbar to save your action. 
4 Using the data input, the system automatically populates the Fed 

appraisal area using the Appr – DOD Acquisition Demo 
Flexfield.   
Note:  The appraisal rating code is converted from Demo values to 
the equivalent OPM numeric values to flow to CPDF properly.  
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DOD ACQ Demo – Mass Actions 

 
Purpose This section explains the steps for processing a DOD ACQ Demo Bonus mass 

Payout. 

  
Bonus Payout Produces NOA 840 with Authority Code Z2W.  This action generates an 

award entry for award type “Performance Award”. 
 
 

Step Action 

1 Using the CIVDOD Demo Process Administrator, Navigation 
Path → Mass Demo Processes.  The Mass process window opens.   

2 Provide a Name of your choice to identify the Mass Process 
3 In the Mass Process Type field, select DoD Acq Demo Bonus 

Payout from the LOV. 

 
4 Select the Input File Name from the Browse button or type in the 

file name to be uploaded. 
5 Enter the Process Date.  This is not the Effective date, but is the 

date in which the process will be executed. 
 
 

Continued on next page 
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DOD ACQ Demo – Mass Actions, Continued 

  
Bonus Payout (continued) 
 

Step Action 
6 Select the Load Ascii File Button.  A message will appear in the 

Status Details window indicating the file loaded successfully or 
otherwise. 

 
7 Select the Preview button to view the records that were loaded.  

Close the window when review is complete.  

 
 

Continued on next page 
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DOD ACQ Demo – Mass Actions, Continued 

  
Bonus Payout (continued) 
 

Step Action 
8 Select the Execute button.  View the Process Log for status of 

records processed.   
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DOD ACQ Demo – Mass Actions, Continued 

 
Purpose This section explains the steps for processing a DOD ACQ Mass CCAS 

Update. 

  
CCAS Update Produces record entry in Special Information Type Demo Project – 

CCS/CCAS. 
 

Step Action 

1 Using responsibility CIVDOD Demo Process Administrator, 
navigate to Mass Demo Processes.  The Mass Processes window 
opens.    

2 Provide a Name of your choice to identify the Mass Process 
3 In the Mass Process Type field, select DoD Acq Demo CCAS 

Update from the LOV. 

 
4 Select the Input File Name from the Browse button or type in the 

file name to be uploaded. 
5 Enter the Process Date.  This is not the effective date, but is the 

date in which the process will be executed. 
 
 

Continued on next page 
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DOD ACQ Demo – Mass Actions, Continued 

  
CCAS Update (continued)  
 

Step Action 
6 Select the Load Ascii File Button.  A message will appear in the 

Status Details window indicating the file loaded successfully or 
otherwise. 

 
7 Select the Preview button to view the records that were loaded.  

Close the window when review is complete.  

 
8 
 

Select the Execute button.  A message will display to provide the 
Request ID.  View the Process Log for status of records processed.   

 
Note: Naviage to Federal Maintenance Forms > Process Log 
(Federal) to view more details after execution. 

 
 

Continued on next page 
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DOD ACQ Demo – Mass Actions, Continued 

  
CCAS Update (continued)  
 

Step Action 
9 Using the Request ID enter a query to find the process details. 

 
The Mass CCAS Process details will be displayed: 

 
10 Proceed to verify employee records by navigating to People/Enter 

& Maintain > Special Info >Demo Project – CCS/CCAS 
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DOD ACQ Demo – Mass Actions, Continued 

 
Purpose This section explains how to process a Mass Payout.  The yearly Demo Mass 

Payout process occurs outside the RPA process and is processed by the 
personnel office.   

• This process produces the Demo SF50 with NOAC 894, and with 
legal authority code Z2U and  

• A Pay500 record output.  
• The format for the output file is found at Appendix B. 

 

  
Mass Salary 
Payout 

 

 
 
 

Step Action 

1 Using the CIVDOD Demo Process Administrator responsibility, 
navigate to ∏  Mass Demo Processes.  The Mass Processes window 
opens.   There is no specific order that the processes (Appraisal, 
Payout, CCS) must be run. 

 
 

 Continued on next page 
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DOD ACQ Demo – Mass Actions, Continued 

 
Mass Salary Payout (Continued) 
  

Step Action 
2 Select the Mass Process Name field and assign a unique name to 

the process.  User should keep track of this name as it may need to 
be used in a query at a later time.  

3  Select Mass Process Type and type in the Mass Process Name OR 
click on the drop down button to view the LOV and select the 
appropriate process. 

 
 

4  

 
Select Input File Name and type the appropriate file name and path to find 
the upload file and location.  If the file name is unknown, select the 
“Browse” button to locate the appropriate file.  Select Open.   
 
 

 
  

Continued on next page 
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DOD ACQ Demo – Mass Actions, Continued 

 
Mass Salary Payout (Continued) 
 

Step Action 
5 

c.  
Click on Process Date to identify the date and time the user wishes to 
execute the process.  User can select a past or future date. Note: This 
date is not the RPA effective date, but a date that determines when 
the process has to run.  Remember to schedule process to run 
during non-peak hours.  

6 

 
Click Printer and identify the printer where the NPAs would print to. 
This field provides a drop down list of printers available for selection 
to the user. 

 
7 

 
Click the Load Ascii File button, to upload the file into the preview 
table. 

 

Continued on next page 
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DOD ACQ Demo – Mass Actions, Continued 

 
Mass Salary Payout (Continued) 
 

Step Action 
8 The Status of the upload file is displayed on the Status Details block.  

This block provides the number of records that loaded successfully 
and the number of records that rejected. If records had rejected, user 
can click on the Process Log Button and it will take the user directly 
to the process log and provide the reason for reject. 

 
 

Continued on next page 
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DOD ACQ Demo – Mass Actions, Continued 

 
Mass Salary Payout (Continued) 
 

Step Action 
9 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Select the Preview button in order to see the data for the records that 
loaded successfully. If the user finds errors in the preview and would 
like to correct the file, user should click on the Delete Preview 
button. This will delete the preview and allow for a new preview.  
User can then access the file, make the appropriate changes, and 
reload by clicking on the Load Ascii File again.   
Note:  There is no check box to Select/Unselect the records user 
wants to process. All records in the preview will be processed. 

   
10 

 

If the file is ready to be executed, select the Execute button to submit 
the process. DCPDS will provide a Request ID.   
Note:  The Status will change from “Unprocessed” to “Submitted”. 

 
 
 

Continued on next page 
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DOD ACQ Demo – Mass Actions, Continued 

 
Mass Salary Payout (Continued) 
 

Step Action 
11 

 
 
 

 
User can go to View>Request, to see the progress of the file 
execution. DCPDS defaults to All My Request, but a specific 
Request can be reviewed by identifying the Request ID Number.  
User can review the file execution phase (i.e., Completed, Competed 
with Warning, or Warning) and if the status has not completed, click 
on the Refresh button until the status changes to Completed.   

 
Note:  The system retrieves the data for all employees and: 

• Creates an RPA process. 
• Outputs the customized NPA (SF 50) instead of the Fed 

(NPA). 
• ONR does not use Roman numerals for the grade. 
• Outputs a payroll record and any other required interface 

records. 
• Updates the employee record. 

Once the process has completed, the Demo NPAs can be printed.   
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Appendix A: 
DoD Acquisition Demo Rating of Record Crosswalk 

 
 AF Rating of 

Record  
Convert to 
OPM 
Rating of 
Record 

 Navy Rating 
of Record 

Convert 
to OPM 
Rating of 
Record 

 Army Civ 
Perf Rating 

Convert to 
OPM Rating 
of Record 

OPM Code-Rating of Rec Cleartext 

Code   Code   Code    
A Superior 

Level 5 
5 A Superior 5    5 Exceptional, Outstanding, Superior, 

Successful Level 1 or Equiv 
          
D Excellent 

Level 4 
4 D Excellent 4    4 Exc Fully Succ, Excellent, High-Succ, 

High Effec, High Succ, Succ Lvl 
      E Exceptional 5  
G Fully 

Successful 
Level 3 

3 G Fully 
Successful 

3    3 Acceptable, Fully Successful, Pass, Sat, 
Successful, Successful Level 

      H Highly 
Successful 

4 2 Fair, Min or Marg Acceptable, Min or 
Mang Sat, Min or Marg Successful 

K Minimally 
Acceptable 
Level 2 

2 K Minimally 
Acceptable 

2    1 Fail, Fails to Meet Requirements, 
Unacceptable, Unsat, Unsuccessful 

      L Fully 
successful 

3  

         X Not Rated 
      M Marg/Mini 

Successful 
2  

         Z Exluded or Exempted by Law or OPM 
N Unacceptable 

Level 1 
1 N Unacceptable 1     

          
      U Unasatisfact

ory 
1  

          
X Presumptive 

Level 3 
3 X Presumptive 3 X Cannot Be 

Rated 
X  

          
Z Excluded fm 

Coverage 
Z Z Excluded fm 

Coverage 
Z Z Exclusion Z  
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Appendix B: DoD Acquisition Demo Mass Process Formats 
 

a. Acquisition Demonstration Payout Process:  
  1. The POC list for accessing the files is updated annually.  CPMS will request 
updates from the components beginning in October with suspense of 31 October.   
  2. For the Acquisition Demo community, the upload files reflect a header that 
helps the user read the file for review.  Users MUST remember to remove the header row before 
uploading the source file.  The upload will not work if the header row has not been removed. 
  3. DoD Acq Demo Bonus Payout: NOA 885 is used for the Bonus payout, with 
authority code Z2W.  There is no dollar or percent limit on the amount.  The bonus payout 
produces a US Fed Award entry (Defaults agency code, award type “1M”, and group award ID 
“00”. 

 
Maximum 
Field 
Length 

 
Value 

 
Type 

 
Remarks 

2 SOID VARCHAR2 Required Input 
1 ,  Delimiter 
11 SSAN VARCHAR2 Required Input w/dashes 
1 ,  Delimiter 
 
 
30 

 
EMPLOYEE NAME  
 

 
 
VARCHAR2 

Optional Input (Note: a  
comma in the employee  
name is not allowed) 

1 ,  Delimiter 
 
6 

 
EFFECTIVE DATE 

 
DATE 

Required Input 
(Format YYMMDD) 

1 ,  Delimiter 
 
5 

 
DEMO BONUS AMOUNT 

 
NUMBER 

Required Input 
(Cents Not Included) 

1 ,  Delimiter 
3 SF50_CODE VARCHAR2 Optional Input for Remark 

Code 
1 ,  Delimiter 
 
 
150 

 
 
 
SF50_Remarks 

 
 
 
VARCHAR2 

Optional Input for Remark 
Insertion (Note: a 
comma in the insertion 
value is not allowed) 

 
AG,SSAN,Mtwc Wrjt,060103,0050000,07722900,7DC 
Remark 7DC will automatically print - it is not required as an entry. 
 
 



         R12            March 2012 

Demo Projects:  DoD Acquisition  Mod 12, Chap 7, Appendix B 
 

b.   DoD Acq Demo CCAS Update 
 

Maximum 
Field 
Length 

 
Value 

 
Type 

 
Remarks 

2 SOID VARCHAR2 Required Input 
1 ,  Delimiter 
11 SSAN VARCHAR2 Required Input w/dashes 
1 ,  Delimiter 
 
 
0 

 
 
Employee Name  
 

 
 
 
VARCHAR2 

 
Optional Input (Note: a  
comma in the employee  
name is not allowed) 

1 ,  Delimiter 
 
6 

 
CCS Effective Date 

 
Date 

Required Input 
(Format YYMMDD) 

1 ,  Delimiter 
3 CCS Actual Score Number Optional input 
1 ,  Delimiter 
3 CCS Expected Score Number Optional input 
1 ,  Delimiter 
5 CCS Salary Increase Number Optional input 
1 ,  Delimiter 
5 CCS Salary Contribution Number Optional input 
1 ,  Delimiter 
4 CCS Delta X VARCHAR2 Optional input 

 
6Z,SSAN, Johnson Richard,030715,60,70,05000,00000,005P 
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 c.  DoD Acq Mass Salary Payout: Produces NOA 894 SF50.  Authority code is Z2W.   
 

Maximum 
Field 
Length 

 
Value 

 
Type 

 
Remarks 

2 SOID VARCHAR2 Required Input 
1 ,  Delimiter 
11 SSAN VARCHAR2 Required Input w/dashes 
1 ,  Delimiter 
 
 
30 

 
 
Employee Name  
 

 
 
 
VARCHAR2 

 
Optional Input (Note: a  
comma in the employee  
name is not allowed) 

1 ,  Delimiter 
 
6 

 
Effective Date 

 
Date 

Required Input 
(Format YYMMDD) 

1 ,  Delimiter 
 
6 

 
New Basic Salary 

 
Number 

Required Input 
(Cents Not Included) 

1 ,  Delimiter 
 
6 

 
Date Last Increase 

 
Date 

Optional Input 
(Format YYMMDD) 

1 ,  Delimiter 
3 Remark_Code_1 VARCHAR2 Optional Input 
1 ,  Delimiter 
 
 
150 

 
 
Remark_1_Insertion 

 
 
VARCHAR2 

Optional Input (Note: a  
comma in the insertion  
value is not allowed) 

1 , VARCHAR2 Delimiter 
3 Remark_Code_2 VARCHAR2 Optional Input 
1 ,  Delimiter 
 
 
150 

 
 
Remark_2_Insertion 

 
 
VARCHAR2 

Optional Input (Note: a  
comma in the insertion  
value is not allowed) 

1 , VARCHAR2 Delimiter 
3 Remark_Code_3 VARCHAR2 Optional Input 
1 , VARCHAR2 Delimiter 
 
 
150 

 
 
Remark_3_Insertion 

 
 
VARCHAR2 

Optional Input (Note: a  
comma in the insertion  
value is not allowed) 

 
6Z,SSAN,Demo James,030507,071656,030507,9Q1 
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Module 12 

Chapter 8 

Naval Air Warfare Centers (NAWC)  
Science and Technology Reinvention Laboratory 

Personnel Demonstration Project  

Chapter Overview 

  
Introduction This chapter explains how DCPDS is used to manage the personnel 

assigned to the Navy’s Warfare Demonstration Project.  

  
Chapter 
Contents 

 

 
Topic Page 

Overview 1 
NAWC - Position Actions 3 
NAWC - Personnel Actions 7 
NAWC - Appraisal Input 9 
Processing NAWC Mass Appraisals Upload Process 12 
Processing NAWC Mass Payout for Bonus, Merit and 
Comparability Payout 

17 

NAWC - Extraordinary Achievement Allowance (EAA) 19 
EAA Bi-Weekly Payment Option RPA Process 19 
EAA Lump-sum Payment Option RPA Process 22 
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Before you 
Begin 

NAWC Demonstration Project: 
• Uses specific requirements for the position “Title,” (unlike DoD 

Acquisition who does not). 
• Uses Demo Location Code = 7 – Naval Air Warfare Centers 

STRL (NAWC). 
• Stores the Demo Pay Plan and Grade in the US Government 

Valid Grade Info DDF. 
• Uses Pay Plans: DP 01-05, DT 01-05, DS 01-06, DA 01-06, DG 

01-06, and NM-02-06. 
• Does not use the Demo Pay Plan and Demo Broadband located 

in the Demo Project Information DDF. 
• Grade is printed in the same format as the GS grade on the 

Federal NPA (SF-50).   
 

 



 R12 March 2012 

Demo Projects:  NAWC  Mod 12, Chap 4, Page 3 

NAWC Demo - Position Actions 

  
Purpose This section explains the steps for building Warfare Demo Positions. 

   
Building an NAWC Demo Position   
 

Step Action 
1 Refer to Module 2, Position Management and Classification in 

the DCPDS, Chapter 1, Building a Position, and follow the steps 
for building a position.  

2 
 

When completing the Extra Position Information Flex fields, 
first select Others/Navy and enter the Demo Project 
Information.  Click the Details data field. 

  
3 The Extra Position Information window Opens.  Enter the 

Demo Location Code (7- Naval Air Warfare Centers).  Do not 
fill in the Demo Pay Plan or Demo Broadband data fields which 
are only used with the Acquisition Workforce Demo.  Select 
<OK>. 

 
 

Continued on next page 
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NAWC Demo – Position Actions, Continued 
  

  
Building an NAWC Demo Position (continued) 
 

Step Action 
4 In the Extra Position Information Flexfield, select Multiple 

Agency Information and click in the Details data field.  

  
5 The Extra Position Information window opens.  Enter the 

appropriate data.  Note:  These data fields will use the same 
values as General Schedule positions.  There is no Demo-unique 
information in this window.  Select <OK> button. 

 
6 In the Extra Position Information Flexfield, select Navy and 

click in the Details data field.  
 

Continued on next page 
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NAWC Demo – Position Actions, Continued 

  
Building an NAWC Demo Position (continued) 
 

Step Action 
7 
 
 

The Extra Position Information window opens.  Fill in the 
appropriate data.  The NAWC Demo utilizes both Demo OGC 
and Demo SAC data fields. 

 
8 Enter Sensitivity Criterion in the Navy DDF. 
9 
 
 
 

In the Extra Position Information Flexfield, select US 
Federal Position Group 1 and US Federal Position Group 2 
and fill in the appropriate data fields. 
Note:  Use the same values as GS positions.   

10 In the Extra Position Information Flexfield, click US Federal 
Valid Grade Info.  Click the Details data field to input Warfare 
Demo pay plans and grades.    The Pay Table ID for Warfare 
Demo is RN01. 

 
 Note:  Valid Pay Plan and Grade combinations are: DP 01-

05, DT 01-05, DS 01-06, DA 01-06, DG 01-06, and NM-02-06. 
 

Continued on next page 
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NAWC Demo – Position Actions, Continued 

  
Building an NAWC Demo Position (continued) 
 

Step Action  
11 Continue completing position build by following Module 2, 

Position Management and Classification in the DCPDS, 
Chapter 1, Building a Position to include Validating the 
Position section. 
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NAWC Demo – Personnel Actions 

  
Purpose This section explains the steps for processing personnel actions unique to 

Warfare Demo employees. 

   
See Also Module 3, Chap 1, Completing the RPA 

Module 4, Chap 4, Processing Promotions/Change to Lower Grade (CLG) 
 
 

Personnel 
Actions 

• All RPA processes and OPM NOAs are used for this demo except: 
• 885 (Performance Award), 
• 892 (QSI) 
• 893 (WGI) 
• 888 (WGI Denial). 

• Pay Plans are equal to DP, DT, DS, DA, DG and NM. 
 

Pay Setting Rules: 
• Basic Pay will be manually entered on RPA actions. 
• Locality Rate will automatically calculate on RPA actions. 
• Other Pay will automatically calculate on RPA actions. 
• EAA Biweekly is part of other Pay.  If Other Pay is recalculated, EAA 

biweekly must appear in the “other pay” popup window. 
• EAA Biweekly must be recalculated if basic pay changes, and must be 

added to Other Pay. 
• Adjusted Pay will automatically calculate.  
• Total Pay will automatically calculate. 

 
When PRD equals J or Y: 
• Basic Pay will be manually entered on RPA actions. 
• Locality rates will equal zero “0”. 
• Other Pay will be automatically calculated (EAA, AUO, availability 

pay, supervisory differential). 
• Adjusted Pay will be automatically calculated. 
• Total Pay will be automatically calculated. 
 
The NOAs on the following page are used to document actions for Demo 
Code 7.  The Authority Code for these NOAs is Z2U.  

Continued on next page 
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NAWC Demo – Personnel Actions, Continued 

  
Personnel Actions (Continued) 
 

NOAs Explanation 
E810 Extraordinary Achievement Allowance (EAA).   
891 Reg Perf Pay for all records.   

D891   Generated from the Awards family for all records that have a 
bonus amount in the upload file, generates award entry with 
Award type of 1M.  Flow 87D for Pay500.  Produces NPA with 
“Bonus Payout” for NOA clear text. 

E887 Extraordinary Achievement Allowance (Lump Sum) 
3## Separations:  

Note:  When a demo employee separates, OPM requires they 
be separated under the demo pay plan and that the separation 
action, no matter what type, documents the demo information.  
GS equivalencies are recorded in the remarks on these NPAs 
(SF50s). Z2U is not used for these actions. 
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NAWC Demo – Appraisal Input  

  
Purpose This section explains how appraisal data is input into the employee’s record.  

See Module 5, Workforce Relations Using the DCPDS, Chapter 2 
Performance Award Information. 

  
Appraisal Input Upon accessing an employee to the system, the APPRAISAL is 

automatically populated with “X” for Rating of Record.  An RPA DDF 
has been established to allow the first appraisal record to be created in 
the appointment process.  All employees newly entered into the Demo 
(whether new hire or a current non-Demo employee moving into a Demo 
position) require input of a Demo performance rating at the time they 
enter.  This entry rating is always an “X” (Not Rated) rating effective the 
same day as the entry into Demo.  
 

Step Action 
1 From the Appointment RPA, navigate to Extra Information. 
2 The “X” will automatically be generated when the Extra 

Information is clicked from the RPA screen.  Click on the 
NAWC Lab Demo Appraisal to view the data in extra 
information.  

  
3 To enter Appraisal from the employee record navigate to 

People/Enter and Maintain > Special Information.  
 
 

Continued on next page 
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NAWC Demo – Appraisal Input, Continued 

 
 

Step Action 
4 Enter the appraisal in the Appr – Warfare Center Demo Special 

Information Type (SIT) using the steps in Module 1, Fundamentals 
of the DCPDS, Chapter 5, Updating and Viewing the Employee 
Record, Section, Using Special Information Type.  

5 In the populated People window, select the <Special Info> button   

   
Scroll down and select Appr – Warfare Center Demo.  Click in 
the Details data field.   

6 The Appr – NAWC Lab Demo window opens.  Type in data or 
use the LOV.  Select the <OK> button.  The Detail data field 
populates with the data. 

 
 
 

Continued on next page 
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NAWC Demo – Appraisal Input, Continued 

  
Step Action 

7 Following is a brief description of the  fields: 
Appraisal Type = A (annual Appraisal). 
Rating of Record – enter rating. 
Date Effective – enter effective date of appraisal. 
Rating of Record Pattern = Default to “H”. 
Rating of Record Level – same as Rating of Record field 
above. 
Date Appraisal Period Starts – The year is equal to the 
Appraisal period end year minus 1. 
Date Appraisal Period End – enter date end 
Unit – enter UIC 
Organization Structure ID – enter org code. 
Office Symbol – Leave blank. 
Pay Plan – enter pay plan. 
Grade – enter pay plan. 
Date Due – enter the same date value as “Dt appraisal period 
ends”. 
Appraisal System Identifier – Leave blank. 
Date initial Appraisal Due – Leave blank.    

8 
 

Select the Save icon on the Toolbar.   
Note:  After the appraisal record is entered and saved, the US 
GOV PERF Appraisal will be updated automatically.  There is 
automatic conversion of data from the NAWC SIT to the US 
Gov SIT. 
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Processing NAWC Mass Appraisals Upload Processes 

 
Purpose This section outlines the steps to be taken to update appraisal information 

for Navy NAWC Demo Project employees.  

 
Who Does It 

       

The capability to process mass appraisal is available to the CIVDOD 
Personnelist and US Federal HR Manager. 

  
Step Action 

1 
 

Navigation Path   Mass Actions → Mass Appraisals → Load 
Mass Appraisals → <Open>. 

2 The Mass Appraisals Load window will open. 

 
 

3 
 

Under “File Name” you will need to type in the complete path 
to the file you copied to your hard drive (e.g., c:\Appr_bk.txt).   
The name of the file must be in the standard DOS format; 
therefore, please be sure that it does not exceed 8 characters.  It 
is best to put the file in either the root directory or the Temp 
directory.  If the path to the file is too long it may not be found. 
 
Note:  When copying the file containing the appraisal 
transactions to your hard drive noting the subdirectory you are 
placing it in.  The appraisal file must be in the exact format as 
specified in Appendix A of this document.  Insure there are no 
blank lines at the bottom of the file before loading the file. 

 
 

Continued on next page 
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Processing NAWC Mass Appraisals Upload Processes, 
Continued 

 
Step Action 

4 Provide an appropriate name for the “Mass Appraisal Name”.  
Make a note of the name you type in – you will use it later in 
the process. 

5 Provide a description of the process in the “Description” field. 

6 For Rating of Record Pattern, use value H, Enter value for 
Rating of Record Level, Enter Date Appraisal Due, enter 
Appraisal Period Start Date which is same as Appraisal 
Period End Date minus one year.   Enter Date Due as the same 
value provided for Appraisal Period End. 

7 Save the record by clicking on the yellow Floppy Icon on the 
top line menu. 

8 Click on the “Load” button in the lower right corner of the 
screen. 

 
9 Once the load process has completed, you will receive a pop-

up message providing you with the Request ID number and the 
number of records that processed. 

10 To check the status of the load process, navigate to Processes 
and Reports → View Requests <Open>.  

11 The Find Request window opens click the <Find> button to 
query your request.  

 
  

Continued on next page 
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Processing NAWC Mass Appraisals Upload Processes, 
Continued 

 
Step Action 
12 
 
 

Select the <Refresh Data> button to help bring the Phase to 
Completed.  
Note:  Depending on how many organizations you have in your 
file this may take a little time.  When your original job ID says 
“completed”, all requests are completed. 

13 Select the <View Output> button to review the reports 
generated.  You will receive a report listing any records that 
could not be loaded (i.e., the employee did not have an 
assignment as of the effective date of the appraisal) as well as a 
report indicating successful loading of records for each 
Organization included in your file. Exit window.  

 
14 
 

From the Navigation window select Final Mass Appraisals 
<Open>. 

 
Note: Insure that the “Phase” reflects “Completed” for your 
“Start Automatic Mass Appraisal Load Process” entry before 
proceeding with these steps. 
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Continued on next page 

Processing NAWC Mass Appraisals Upload Processes, 
Continued 

 
Step Action 
15 The Mass Appraisals Final window will open. Press the F11 

key then type in the name of the load you provided in step 5 
followed by the wildcard character (%) then Press both F11and 
the CTRL buttons to execute the query.   If your upload file 
contains employees from different organizations, the system 
will append a number after the name you provided in step 5 for 
each of the various organizations (i.e., “Test Appraisal Update 
(Org 1)”, “Test Appraisal Update (Org 2)”, etc.).  By adding 
the % sign after the name, you are assured of finding all 
organizations that require appraisal processing as a result of 
your upload.  The following steps will need to be followed for 
each organization. 
 

 
 

16 Select the <Preview> button to make sure the right records are 
selected and they have the correct data in them.  To quickly 
identify all records selected for update, Press the F11 button to 
place you in query mode, click the “X” under the Appraisal 
column to deselect it and then re-click it to select it again. Then 
Press both F11and the CTRL buttons to execute the query. 
Your list now will only have employees who were included in 
the load process. 

 
Continued on the Next Page 
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Processing NAWC Mass Appraisals Upload Processes, 
Continued 

 
Step Action 
17 Select the Validate button.  If there are errors, navigate to View 

Requests and review the error report that is generated and 
make any necessary corrections.  Once corrected or if there are 
no errors, click the Execute button.  You will receive a 
message providing the Request ID. 
 

 
 

18 After the process has completed successfully, examine the 
employee’s records to verify they were updated with the right 
information.  You will need to look in the “Appr – NAWC Lab 
Demo” SIT and in the “US Gov Perf Appraisal” SIT to verify 
the updates.    
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Processing NAWC Mass Payout for Bonus, Merit, and 
Comparability Payout 

  
Purpose 
 
 
 
 

This section explains how to process a Mass NAWC Demo Bonus 
Payout, and a Mass NAWC Demo Merit Payout.  The yearly Demo Mass 
Payout process occurs outside the RPA process.   

• The HRO is responsible for providing the up-dated pay 
information necessary for the HRSC to process the manual 
payout actions. 

• The HRSC is responsible for the execution of the mass payout 
process.  

Note:  NAWC will use an external performance tool to calculate the 
payouts.  The PAA system will not be utilized.   

All bonuses will generate with NOA 891 and Auth Code Z2U.  All Merit 
Increases will generate with NOA 894 and Auth Code Z2U. 

  
Mass Payout Using the CIVDOD Demo Process Administrator responsibility, select Mass 

Demo Processes from the navigator menu. 
 

Step Action 
1 Navigation Path   Mass Demo Processes → <Open>.  The 

Mass Processes window opens.  
2 Enter a Name of your choice in the Mass Process Name data 

field.  

 
 

 
Continued on next page 
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Processing NAWC Mass Payout for Bonus, Merit, and 
Comparability Payout, Continued 

 
Mass Payout (continued) 
 

Step Action 
3 For the bonus payout, select NAWC Demo Mass Payout 

Process from the list of values.  
4 Complete the parameter Input File Name by using the Browse 

button.  Retrieve the file, which should be stored on the hard 
drive of the PC being used. 

 
. 

5 Complete the rest of the parameter fields: Process Date, 
Printer.   

6 Select the Load Ascii File button to load the file. 
7 Select the Preview button.  View records selected.  If you need 

to change criteria and rerun, then select the Delete Preview 
button and create another one. 

8 
 

Select the Execute button to submit the mass process and close 
the form to return to the Navigator menu.  The process 
generates pay adjustment NOA 891 and/or bonus/award NOA 
885. 
Note:  The system retrieves the data for all employees and: 

• Creates an RPA process. 
• Outputs the SF 50 (NPA).   
• Outputs a payroll record and any other required 

interface records. 
• Updates the employee record. 
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NAWC – Extraordinary Achievement Allowance (EAA) 

  
Purpose 
 
 
 
 

This section explains how to process the Extraordinary Achievement 
Allowance (EAA) for NAWC employees.  There are two separate types of 
EAA: 

• Bi-weekly Payment Option uses the NOA E810 
• Lump Sum Payment Option uses the NOA E887 

 
Note:  EAA is limited to 25% of basic salary.   

  
EAA Bi-Weekly 
Payment 
Option RPA 
Process 

Using the CIVDOD Personnelist responsibility, select Salary Change from 
the navigator menu. 

 
Step Action 

1 Navigation Path  Request for Personnel → Salary Change → 
Other Pay → <Open>.   

2 Populate the first page on the RPA, Part B with the Name, SSAN, 
and effective date of the action.  Use NOA E810 in block 5-A and 
Local Authority Code Z2U in block 5-C. 

 
3 Click in Block 20D Other Pay 

 
 

Continued on next page 
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NAWC – Extraordinary Achievement Allowance (EAA), 
Continued 

 
EAA Bi-Weekly Payment Option RPA Process (continued) 
 

Step Action 
4 Input the award percentage in the Percentage field.  The dollar 

amount will automatically populate in the Entitled Other Pay 
and the Amount fields.  Remember that EAA is limited to 25% 
of the basic salary rate. 

 
Select the <OK> button to continue. 

5 Remarks YR1 and YR2 automatically populate in Part F of the 
RPA. 

 
 
 

Continued on next page 
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NAWC – Extraordinary Achievement Allowance (EAA), 
Continued 

 
EAA Bi-Weekly Payment Option RPA Process (continued) 
 

Step Action 
6 
 

The information input on the RPA flows to the Navy Lab Demo 
DCA-EAA Data in Extra Information. 

 
 
Note: An employee can have multiple NOAs processed for EAA 
to allow for combination of payment types.  When updating Navy 
Demo Projects DCA-EAA Data, if a record exists with same 
effective date, then append the record with the additional data.  A 
record may contain either biweekly (E810), or lump sum (E887), 
or both.  

7 Continue processing the RPA as referenced in Module 3, Chapter 
1 - Processing A Request for Personnel Action. 
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NAWC – Extraordinary Achievement Allowance (EAA), 
Continued 

  
EAA Lump 
Sum Payment 
Option RPA 
Process 

Using the CIVDOD Personnelist responsibility, select Award/One Time 
Payment from the navigator menu. Use Nature of Action Code E887 - 
Extraordinary Achievement Allowance (Lump Sum). 

 
Step Action 

1 Navigation Path:  Request for Personnel Action → 
Award/One-Time Payment → <Open>.   

2 On Page 1 of the Request for Personnel Action (RPA), use NOA 
E887. 

 
3 On page 2 of the RPA, the Award field opens for update. 

 
4 When the Award block is selected, a popup window appears. 

 
5 
 

Enter either the Amount or the Percentage.  DCPDS will 
computer the five character dollar amount with the following 
rules: 
• When using a 2 character percentage, EAA is limited to 25% 

of basic salary. 
• If rounding causes the amount to exceed 25%, the amount 

will round down to the nearest dollar. 
Note:  Award amounts cannot exceed 25% of the basic salary. 

 
 

Continued on next page 
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NAWC – Extraordinary Achievement Allowance (EAA), 
Continued 

 
EAA Lump Sum Payment Option RPA Process (continued) 
 

Step Action 
6 Remark YR4 automatically populates in Part F of the RPA. 

 
7 Proceed to Extra Information.  From Extra Information, select 

the Navy Lab Demo DCA-EAA Data DDF.  The information 
input on the RPA flows to the Navy Lab Demo DCA-EAA Data 
DDF.  

 
 

Note: An employee can have multiple NOAs processed for EAA 
to allow for combination of payment types.  When updating Navy 
Demo Projects DCA-EAA Data, if a record exists with same 
effective date, then append the record with the additional data.  A 
record may contain either biweekly (E810), or lump sum (E887), 
or both. 

8 
 

Continue processing the RPA as referenced in Module 3, Chapter 
1 - Processing A Request for Personnel Action. 
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Module 12 

Chapter 9 

Space & Naval Warfare System Command (SPAWAR 1105) 
1105 (SSC Atlantic/Pacific) Scientific and Technical 

Reinvention Laboratory (STRL) Demonstration Project 

Chapter Overview 

  
Introduction This chapter explains how DCPDS is used to manage the personnel assigned to 

the Navy’s SPAWAR 1105 (SSC/Atlantic/Pacific) STRL Demonstration 
Project.  

   
Chapter 
Contents 

 

Topic Page 
Overview 1 
SPAWAR 1105- Position Actions 3 
SPAWAR 1105 - Personnel Actions 8 
SPAWAR 1105 - Appraisal Input 9 
SPAWAR 1105 - Mass Appraisal 11 
SPAWAR 1105 – Mass Processes for Bonus, Contribution, 
and Comparability Payout  

12 

Mass Payout 12 
Bonus and Contribution Payout 14 

Distinguished Contribution Allowance (DCA) RPA Process 16 
Bi-Weekly 16 
Lump Sum 19 
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Before You 
Begin 
 
 
 
 
 
 
 
 
 
 
 
 
 

SPAWAR 1105 Demo Project: 

• Uses specific requirements for the position “Title,” (this is unlike DoD 
Acquisition). 

• Uses Demo Location Code = 6. 

• Uses Pay Plans: ND, NG, NR, NO, NM. 

• Stores the Demo Pay Plan and Grade in the US Government Valid 
Grade Info DDF. 

• Does not use the Demo Pay Plan and Demo Broadband located in 
the Demo Project Information DDF. 

• Grade is printed in the same format as the GS grade on the Federal 
NPA (SF-50).   

• When NOA 894 is used, you must navigate to the SPAWAR 1105 
Bonus Payroll Type DDF and select the appropriate payout type.  This 
action assures the appropriate PAY500 records are generated and used 
for correction and cancellation processes. 
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SPAWAR 1105 Demo - Position Actions 

  
Purpose This section explains the steps for building SPAWAR 1105 Demo Positions. 

   
Building a SPAWAR 1105 Demo Position   
 

Step Action 
1 Refer to Module 2, Position Management and Classification in the 

DCPDS, Chapter 1, Building a Position, and follow the steps to build 
a position.  

2 
 

When completing the Extra Position Information Flex fields, select  
Others/Navy and enter the Demo Project Information first.  Select 
the Details data field. 

 
  

 
 

 Continued on next page 
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 SPAWAR 1105 Demo - Position Actions, Continued 

  
Building a SPAWAR 1105 Demo Position(continued) 
 

Step Action 
3 The Extra Position Information window Opens.  Enter the Demo 

Location Code of 6 for SSC Atlantic/Pacific Scientific and 
Technical Reinvention Lab (SPAWAR 1105-1105).  Do not fill in 
the Demo Pay Plan or Demo Broadband data fields which are only 
used with the Acquisition Workforce Demo.  This demo utilizes a 
“Staffing Indicator” which is considered part of the Adjusted and 
Total Pay based on individual basis.  Enter Staffing Indicator Code 
of SS00 New Orleans, LA Engrs, 30.00.   Select <OK>. 

 
4 In the Extra Position Information Flexfield, select Multiple 

Agency Information and select the Details data field.  

 
 

  
  

Continued on next page 
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SPAWAR 1105 Demo - Position Actions, Continued 

  
Building a SPAWAR 1105 Demo Position(continued) 
 

Step Action 
5 The Extra Position Information window opens.  Enter the 

appropriate data.  Note:  These data fields will use the same values 
as General Schedule positions.  There is no Demo-unique 
information in this window.  Select the <OK> button. 

 
6 In the Extra Position Information Flexfield, select Navy and the 

Details data field.  

 
 

 
Continued on next page 
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SPAWAR 1105 Demo - Position Actions, Continued 

  
Building a SPAWAR 1105 Demo Position (continued) 
 

Step Action 
7 
 
 

The Extra Position Information window opens.  Enter Sensitivity 
Criterion in the Navy DDF.  

 
8 
 
 

In the Extra Position Information Flexfield, select US Federal 
Position Group1 and US Federal Position Group2 and fill in the 
appropriate data fields. 
Note:  Use the same values as GS positions.   

 
Continued on next page 
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SPAWAR 1105 Demo - Position Actions, Continued 

  
Building a SPAWAR 1105 Demo Position (continued) 
 

Step Action  
9 In the Extra Position Information Flexfield, select US Federal 

Valid Grade Info.  Select the Details data field to input SPAWAR 
1105 Demo pay plans and grades.   The Pay Table ID for 
SPAWAR 1105 Demo is RS00. 

 
 
Note:  Valid Pay Plan and Grade combinations are: ND – 01-05 
(Warfare), NG – 01-05 (Warfare), NR – 01-05 (NRL), NO – 01-06 
(NRL), and NM – 02-06.   
 

 
10 Continue completing position build by following Module 2, 

Position Management and Classification in the DCPDS, Chapter 1, 
Building a Position to include Validating the Position section. 
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SPAWAR 1105 Demo – Personnel Actions 

  
Purpose This section explains the steps for processing personnel actions unique to 

SPAWAR 1105 Demo employees. 

   
See Also Module 3, Chap 1, Completing the RPA 

Module 4, Chap 4, Processing Promotions/Change to Lower Grade (CLG) 

  
Personnel 
Actions 

• All RPA processes and OPM NOAs are used for this demo except: 
• 885 (Performance Award) 
• 892 (QSI) 
• 893 (WGI) 
• 888 (WGI Denial) 

• Pay Plans are equal to ND, NG, NR, NO, and NM. 
• The following NOAs are used to document actions for Demo Code 6.  The 

Authority Code for these NOAs is ZLM “Demo Project title 6 CSRA 
1978”. 

NOAs Explanation 
D810 Distinguished Contribution Allowance (DCA) 
D887  Distinguished Contribution Allowance (DCA) 
D891 BONUS PAYOUT 
894   Gen Adj (Salary Payout) 
3## Separations:  

Note:  When a demo employee separates, OPM requires they be 
separated under the demo pay plan and that the separation action, 
no matter what type, documents the demo information.  GS 
equivalencies are recorded in the remarks on these NPAs (SF50s). 
ZLM is not used for these actions. 
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SPAWAR 1105 Demo – Appraisal Input 

  
Purpose This section explains how appraisal data is input into the employee’s record.  

See Module 5, Workforce Relations Using the DCPDS, Chapter 2 
Performance Award Information. 

  
Appraisal Input Upon accessing an employee to the system, the APPRAISAL is 

automatically populated with “X” for Rating of Record.  An RPA DDF has 
been established to allow the first appraisal record to be created in the 
appointment process.  All employees newly entered into the Demo (whether 
new hire or a current non-Demo employee moving into a Demo position) 
require input of a Demo performance rating at the time they enter.  This entry 
rating is always an “X” (Not Rated) effective the same day as the entry into 
the Demo position.  
 

Step Action 
1 In the populated People window, select the <Special Info> button.    

Scroll down and select Appr – Space Nav Warfare Demo.  Select 
the Details data field. 

 
  

Continued on next page 



                                                                                                    R12                                                                           March 2012 

Demo Projects:  SPAWAR 1105 Demo                                              Mod 12, Chap 9, Page 10 

SPAWAR 1105 Demo – Appraisal Input, Continued 

  
Appraisal Input (continued) 
 

Step Action 
2 The US Fed Perf Appraisal window opens.  Type in data or use 

the LOV.  Select the <OK> button.  The Detail data field populates 
with the data.  SPAWAR-1105 Demo uses Appraisal Type “Q”, 
and Appraisal Pattern of A. 

 
3 Select the Save icon on the Toolbar.   
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SPAWAR 1105 Demo – Mass Appraisal  

  
Purpose Updating multiple employee records at one time eliminates the need to enter 

individual employee records manually. 

  
Before you 
Begin 

HR personnelists at HRSC are responsible for the input and execution of the 
mass appraisal load process.  The HRO is responsible for providing the 
ASCII file of performance data necessary for the HRSC to process the mass 
appraisal upload. 

   
Step Action 

1 From the navigator menu, select Mass Actions → Mass Appraisals.  
Select Preview Mass Appraisals to set up the process. 

 

2 See Module 5 Chapter 2 for the steps for processing mass 
appraisals. 
Note:  The system supplies a default value (H) for the Rating of 
Record Pattern and a default value (5) for the Rating of Record 
Level. 
You can change them as needed. (For the Rating of Record Pattern, 
use A for Pass/Fail, H for 5 level Rating of Record rating system, 
etc.) If the Rating of Record Level is left blank on this screen, the 
preview screen will auto populate this field with same value that is 
provided in the ASCII file for Rating of Record Level. 
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SPAWAR 1105 Demo – Mass Processes for Bonus, 
Contribution, and Comparability Payout 

  
Purpose 
 
 
 
 

This section explains how to process a SPAWAR 1105 Comparability Increase, 
a SPAWAR 1105 Mass Bonus Payout, and a SPAWAR 1105 Merit Payout.  The 
yearly Demo Mass Payout process occurs outside the RPA process.   

• The HRO is responsible for providing the updated pay information 
necessary for the HRSC to process the manual payout actions. 

• The HRSC is responsible for the execution of the mass payout 
process.  

  

  
Mass Payout Navigate to Processes and Reports to request the SPAWAR 1105 Mass Payouts. 
 

Step Action 
1 Navigation Path → Processes and Reports → Submit Process & 

Report <Open>.   

 
Select Single Request. 

2 The Submit Request window appears.  Enter Navy Demo Comp 
Payout in the Name field.  
 

 
 

`Continued on next page 
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SPAWAR 1105 Demo – Mass Processes for Bonus, 
Contribution, and Comparability Payout, Continued 

 
Mass Payout (continued) 
 

Step Action 
3 Enter values for the parameters Increase Percent, Effective Date, 

and Demo Location Code.  Select <OK>. 

 
4 This will bring you back to the Submit Request window.  Be sure to 

identify on this window when you want the request to run and which 
printer you want the actions to print. 
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SPAWAR 1105 Demo – Mass Processes for Bonus, 
Contribution, and Comparability Payout, Continued 

 
Bonus and 
Contribution 
Payout 

Using the CIVDOD Demo Process Administrator, navigate to 
the Mass Demo Processes 

  

 
Step Action 

1 Navigation Path → Mass Demo Processes <Open>.   

 
2 In the Mass Process Name field, compose a name for your process. 
3 In the Mass Process Type field, you can use the LOV to select: 

• SSC Atlantic-Pacific Bonus for the bonus payout 
• SSC Atlantic-Pacific Contribution Payout for the 

contribution payout 

 
 

Continued on next page 
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SPAWAR 1105 Demo – Mass Processes for Bonus, 
Contribution, and Comparability Payout, Continued 

 
Bonus and Contribution Payout (continued) 
 

Step Action 
4 Complete the parameter Input File Name by using the Browse button.  

Retrieve the file which should be stored on the hard drive of the PC 
being used. 

. 
5 Complete the rest of the parameter fields: Process Date, Printer.   
6 Select the Load Ascii File button to load the file. 
7 Select the Preview button.  View records selected.  If you need to 

change criteria and rerun, then you may select the Delete Preview 
button and create another one. 

8 Select the Execute button to submit the mass process. 
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SPAWAR 1105 Demo – Distinguished Contribution Allowance 
(DCA) RPA Processes 

 
Purpose This section explains the  Request for Personnel Action (RPA) process for the 

Distinguished Contribution Allowance (DCA)  

 
Before you 
Begin 

To input the DCA actions: 
• Complete all four pages of the RPA first. 
• Input the Extra Information last. 
• Route the RPA and save it to HR. 
• Select the checkbox in the Print Notification area, select a printer 

name, and select the<OK> button for approval. 

Note:  Some reject messages on demo-unique items display at this point:  
Example:  “You are not authorized to use an NOA 892 or 893.”  Follow the 
steps in Module 3, Processing Personnel Actions Using the DCPDS, Chapter 1, 
Completing the RPA. 

      
Distinguished 
Contribution 
Allowance 
(DCA)  
 
 
 
Bi-Weekly 
Payout 

The Distinguished Contribution Allowance (DCA) for a SPAWAR 1105 
Demo employee can be paid Bi-weekly or as a lump sum.  If paying bi-
weekly, use NOA D810 found using the Other Pay family of RPAs.  If 
paying lump sum, use NOA D887 in the Awards family of RPAs.  Refer to 
Module 3, Processing Requests for Personnel Actions, for additional 
information.   
 

Step Action 
1 To process a Bonus, navigation Path → Request for Personnel 

Action → Salary Change → Other Pay <Open>.   
2 Fill in the Effective Date and employee information in Part B of the 

Other Pay RPA.  In Block 5A, select D810 from the LOV. 

 
 

Continued on next page 
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SPAWAR 1105 Demo – Distinguished Contribution Allowance 
(DCA) RPA Processes, Continued 

 
Bi-Weekly Payout (continued) 
 

Step Action 
3 Proceed to the next page of the RPA (Position Data tab).  Here you 

will find that the Other Pay field is open. 

 
4 Click on the Other Pay open field and a small window will appear 

as shown below. 

 
5 You will insert the Amount or Percentage of the DCA in the 

Retention Allowance fields.  When entering the percentage, the 
amount will automatically calculate.  The information will populate 
on the RPA. 

6 No action is required on Page 3 of the RPA (Employee and Postion 
Data).  Proceed to Page 4, Remarks and Addresses.  Notice that 
remark codes YC8 and YC9 populate automatically based on the 
Nature of Action Code from Page 1 of the RPA.  Add additional 
remarks as required. 

 
 
 

Continued on next page 
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SPAWAR 1105 Demo – Distinguished Contribution Allowance 
(DCA) RPA Processes, Continued 

 
Bi-Weekly Payout (continued) 
 

Step Action 
7 Select the Extra Information button at the bottom of the screen. 

 
8 You will receive a Decision message. 

 
Select Yes.  Another message will appear providing the generated 
request number. Select OK. 

9 The Extra PA Request Information window appears. 

 
Scoll down to Navy Lab Demo DCA-EAA Data and select that 
DDF. 

10 The information you input on Page 2 of the RPA automatically 
populates in this DDF. 

 
11 Select OK and return to the RPA.  Follow instruction provided in 

Module 3, Processing Requests for Personnel Actions. 
 
 

Continued on next page 
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SPAWAR 1105 Demo – Distinguished Contribution Allowance 
(DCA) RPA Processes, Continued 

 
Lump Sum 
Payout 

 

Step Action 
1 To process a Bonus, navigation Path → Request for Personnel 

Action → Award/One-Time Payment <Open>.   
2 Fill in the Effective Date and employee information in Part B of the 

Award/One-Time Payment- RPA.  In Block 5A, select D887 from 
the LOV. 

 
3 Proceed to the next page of the RPA (Position Data tab).  Here you 

will find that the Award and Unit of Measure (UoM) fields are 
open. 

 
4 Click on the Award open field and a small window will appear as 

shown below. 

 
5 You will insert the Amount or Percentage of the DCA in the fields 

provided.  When entering the percentage, the amount will 
automatically calculate.  The information will populate on the RPA. 

6 No action is required on Page 3 of the RPA (Employee and Postion 
Data).  Proceed to Page 4, Remarks and Addresses.  Notice that 
remark codes YC0 populates automatically based on the Nature of 
Action Code from Page 1 of the RPA.  Add additional remarks as 
required. 

 
 

Continued on next page 
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SPAWAR 1105 Demo – Distinguished Contribution Allowance 
(DCA) RPA Processes, Continued 

 
Lump Sum Payout (continued) 
 

Step Action 
7 Select the Extra Information button at the bottom of the screen. 

 
8 You will receive a Decision message. 

 
Select Yes.  Another message will appear providing the generated 
request number. Select OK. 

9 The Extra PA Request Information window appears. 

 
 

Select the Navy Lab Demo DCA-EAA Data DDF. 
10 The information you input on Page 2 of the RPA automatically 

populates in this DDF. 

 
 

11 Select OK and return to the RPA.  Follow instruction provided in 
Module 3, Processing Requests for Personnel Actions. 

 
 



                                                                                                  R12                                                                            March 2012 

DCPDS Related Advisories: Overview                                                   Mod 13, Overview, Page 1 

Module 13 

DCPDS Related Advisories 

Module Overview 
 

  
Purpose The purpose of this module is to provide a central location for all DCPDS 

related advisories.   

  
Module Contents  
 

Module Overview 1 
Chapter 1:  Highly Qualified Expert - Senior Mentor (HQE-
SM) 

 

Appointment to Senior Mentor Position 2 
Adding the second LAC required for Highly Qualified 
Expert – Senior Mentor (HQE-SM) Position 

 
6 

Conversion of Highly Qualified Expert (HQE) to Senior 
Mentor Position 

 
10 

 
Continued on next page 
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Module 13 

Chapter 1 

Highly Qualified Expert - Senior Mentor (HQE-SM) 

 
Chapter Overview  

  
Introduction 
 
 
 
 
 
 
 

Highly Qualified Experts (HQEs) are eminent experts who possess expert 
knowledge and skills needed to perform certain high profile assignments of 5 
years or less.  They are in fields such as engineering, technology, human 
resources, business, education, medicine, language and logistics.  They 
generally gained their uncommon level of expertise in private industry or 
academia.  Senior Mentors (SMs) are a type of HQE that provide expert 
mentoring, teaching and advice to senior military officers, staffs and students 
as they participate in war games, war fighting courses, and combat operations.  
They are generally retired general officers or retired Senior Executive Service 
(SES) individuals.   
 
In the past, Senior Mentor services were obtained through a contract or from a 
defense contractor.  On April 2010, Secretary of Defense directed that all 
current “contract” Senior Mentors be converted to HQEs and that all new 
Senior Mentor appointments be accomplished under the same hiring authority 
as HQEs, e.g., NOA ‘171’ (Excepted Appointment NTE), Legal Authority 
Code (LAC) ‘ZLM – 5 U.S.C. 9903’.  
 
NDAA FY11 and further guidance in DoDI 1400.25, V922 (dated April 1, 
2010) directed that all Senior Mentor individuals be hired under the following 
authorities:  

• Excepted appointments NTE 5 years 
• Pay Plan ‘EE’ (like HQEs) 
• 1st LAC ‘ZLM – 5 U.S.C. 9903’ (like HQEs) 
•  2nd LAC ‘903 – NDAA 2010, Section 1102’ 

 
Continued on next page 
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Chapter Overview, Continued  

  
Chapter Contents  
 

 Topic Page 
Appointment to Senior Mentor Position 2 
Adding the second LAC required for Highly Qualified Expert – 
Senior Mentor (HQE-SM) Position 

 
6 

Conversion of Highly Qualified Expert (HQE) to Senior Mentor 
Position 

 
10 

 
 

Who Does It? 

        

• Personnelist  

   
 

See also 
      

• Module 3, Processing Requests for Personnel Actions Using the DCPDS 
• Module 4, Staffing 

    
 Appointment to Senior Mentor Position   

  
Purpose This procedure provides the steps to process an appointment of a Senior 

Mentor. 

          
Before You 
Begin 

You will need to build or quick copy a position using pay plan ‘EE.’   
   
Note:  The Position must be in Pay Plan ‘EE’ (Expert), the Tenure must equal 
‘3’ (Indefinite), the Position Occupied must equal ‘2’ (Excepted Service) and 
the ‘Appointment Type’ must equal ‘3C’ (Excepted Appointment-NTE). 

 
Continued on next page 
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Appointment to Senior Mentor Position, Continued  

  
Step Action 

1 Navigation Path > Request for Personnel Action > Conversion to 
Appointment and select Open button. 

2 
 

 
 
 

 

The Requesting Info tab of the RPA opens with Part A, Block 1, 
Actions Requested data field populated.  Complete the remaining 
white data fields following the instructions in Module 3, Processing 
Requests for Personnel Actions. 
Note:  Request Number data field populates when you save the 
action.  

 
3 
 
 
 
 
 

Place the cursor in the 5-A Code data field, use the LOV to select 
the NOA Code 5-A ‘171’.   
Select ‘ZLM – 5 U.S.C. 9903’ from the List of Values (LOV) in 
block 5-C.   
Select ‘903 – NDAA 2010, Section 1102’ from the LOV in block 5-
E. 
Note:  You must select the LACs from the LOV. 

 
 

Continued on next page 
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Appointment to Senior Mentor Position, Continued 

 
 

 Step Action 
4 
 
 
 

Select the ‘Position Data’ Tab and enter the position and salary 
information on the ‘TO’ side of the screen if changes need to be 
made to the current position and salary information. 

 
Note:  The position must be in Pay Plan ‘EE’. 

5 Select the ‘Employee and Position Data’ tab to enter employee data 
if changes need to be made to the current employee information.  
The Tenure Group (in block 24) must equal ‘3’ (Indefinite) and the 
‘Position Occupied’ must equal ‘2’ (Excepted Service.) 

 
 

Continued on next page 
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Appointment to Senior Mentor Position, Continued  

  
Step Action 

6 Select the ‘Remarks and Address’ tab to capture the appropriate 
remarks for this action. 

7 Save your information and Select the ‘Extra Information Tab’.  Enter 
data as required under the appropriate DDFs if changes need to be 
made to the current employee information.  The Appointment Type 
under the US Fed Conversion to Appointment DDF must equal ‘3C’. 

 
8 Select Save icon on any page.  A Forms box opens with the RPA 

Request Number.  Select the OK button to continue. 
9 A Message Box appears asking if you wish to route the request.  

Select the Yes button. 
10 
 
 
 

 

The Routing window opens. Select Update HR. and a printer ID in 
the Printer data field, if applicable Select the Approval box then 
select OK button. 

Note:  Follow your Component guidelines in routing the RPA for 
approval, updating the HR database, and printing the Notification of 
Personnel Action (NPA). 
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Adding the Second LAC Required for Highly Qualified Expert - Senior 
Mentor position 

    
Purpose This procedure provides the steps to process an appointment of a Senior 

Mentor. 

          
Before You 
Begin 

You will need to have a current record of an employee appointed to a HQE 
position.  Coordinate with the organization as to whether you will need to use 
a different ‘EE’ position or the existing one. 

       
  

Step Action 
1 Navigation Path > Request for Personnel Action > 

Cancellation/Correction and select Open button. 
2 Query the name of the HQE employee whose record needs to be 

corrected.  Select the ‘Find’ button. 

 
 
 

Continued on next page 
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Adding the Second LAC Required for Highly Qualified Expert - Senior 
Mentor position, Continued 

    
Step Action 

3 Select the ‘Correction’ button. 

 
 

4 Select ‘903 – NDAA 2010, Section 1102’ from the LOV in block 6-
E. 

 
 
 

Continued on next page 
  



                                                                                                                R12                                                                           March 2012 

DCPDS Related Advisories:   
Highly Qualified Expert - Senior Mentor (HQE-SM)                   Mod 13, Chap 1, Page 8 

 

Adding the Second LAC Required for Highly Qualified Expert - Senior 
Mentor position, Continued 

    
Step Action 

5 
 
 
 
 
 
 
 
 
 
 
 

 

Select the Position Data tab to enter the position and salary 
information on the ‘TO’ side of the screen (if changes need to be 
made to the current position and salary information.)   
 

 
Note:  The position must be in Pay Plan ‘EE’.   

6 
 

 

Select the Employee and Position Data tab to enter employee data if 
changes need to be made to the current employee information. 
   
Note:  The Tenure Group (in block 24) must equal ‘3’ (Indefinite) 
and the ‘Position Occupied’ must equal ‘2’ (Excepted Service.) 

 
 
 

Continued on next page 
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Adding the Second LAC Required for Highly Qualified Expert - Senior 
Mentor position, Continued 

    
Step Action 

7 Select the Remarks and Address tab to capture the appropriate 
remarks for this action. 

8 
 
 

 

Save your information and Select the Extra Information tab.  Enter 
data as required under the appropriate DDFs (if changes need to be 
made to the current employee information.).   
 
Note:  The Appointment Type under the US Fed Appointment 
Information DDF must equal ‘3C’. 

 
 

9 Select Save icon on any page.  A Forms box opens with the RPA 
Request Number.  Select the OK button to continue. 

10 A Message Box appears asking if you wish to route the request.  
Select the Yes button. 

11 
 
 
 

 

The Routing window opens. Select Update HR. and a printer ID in 
the Printer data field, if applicable Select the Approval box then 
select OK button. 

Note:  Follow your Component guidelines in routing the RPA for 
approval, updating the HR database, and printing the Notification of 
Personnel Action (NPA). 
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Conversion to Senior Mentor Position 

    
Purpose This procedure provides the steps to process an appointment of a Senior 

Mentor. 

          
Before You 
Begin 

You will need to have a current record of an employee initially appointed as a 
HQE that needs to be converted to a Senior Mentor appointment. Coordinate 
with the organization as to whether you will need to use a different ‘EE’ 
position or the existing one.   
 
Note:  The Position must be in Pay Plan ‘EE’ (Expert), the Tenure must equal 
‘3’ (Indefinite), the Position Occupied must equal ‘2’ (Excepted Service) and 
the ‘Appointment Type’ must equal ‘3C’ (Excepted Appointment-NTE). 

       
  

Step Action 
1 Navigation Path > Request for Personnel Action > Conversion to 

Appointment and select Open button. 
2 
 

 
 
 

 

The Requesting Info tab of the RPA opens with Part A, Block 1, 
Actions Requested data field populated.  Complete the remaining 
white data fields following the instructions in Module 3, Processing 
Requests for Personnel Actions. 
 
Note:  Request Number data field populates when you save the 
action.  

 
 
 

Continued on next page 
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Conversion to Senior Mentor Position, Continued  

  
Step Action 

3 Complete Part B by doing a query of the employee name (currently 
on the HQE position).  Input the effective date, and other required 
information. 

 
4 
 
 
 
 
 

Place the cursor in the 5-A Code data field, use the LOV to select the 
NOA Code 5-A ‘571’.   
Select ‘ZLM – 5 U.S.C. 9903’ from the List of Values (LOV) in 
block 5-C.   
Select ‘903 – NDAA 2010, Section 1102’ from the LOV in block 5-
E. 
Note:  You must select the LACs from the LOV. 

5 
 
 
 

Select the ‘Position Data’ Tab and enter the position and salary 
information on the ‘TO’ side of the screen if changes need to be 
made to the current position and salary information. 

 
Note:  The position must be in Pay Plan ‘EE’. 

 
 

Continued on next page 
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Conversion to Senior Mentor Position, Continued 

  
 Step Action 

6 Select the ‘Employee and Position Data’ tab to enter employee data 
if changes need to be made to the current employee information.  
The Tenure Group (in block 24) must equal ‘3’ (Indefinite) and the 
‘Position Occupied’ must equal ‘2’ (Excepted Service.) 

 
7 Select the ‘Remarks and Address’ tab to capture the appropriate 

remarks for this conversion action. 
8 Save your information and Select the ‘Extra Information Tab’.  

Enter data as required under the appropriate DDFs if changes need 
to be made to the current employee information.  The Appointment 
Type under the US Fed Conversion to Appointment DDF must equal 
‘3C’. 

 
 

Continued on next page 
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Conversion to Senior Mentor Position, Continued 

  
 

 Step Action 
9 Select Save icon on any page.  A Forms box opens with the RPA 

Request Number.  Select the OK button to continue. 
10 A Message Box appears asking if you wish to route the request.  

Select the Yes button. 
11 
 
 
 

 

The Routing window opens. Select Update HR. and a printer ID in 
the Printer data field, if applicable Select the Approval box then 
select OK button. 

Note:  Follow your Component guidelines in routing the RPA for 
approval, updating the HR database, and printing the Notification of 
Personnel Action (NPA). 
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